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Introduction
What you will find in this chapter:What you will find in this chapter:What you will find in this chapter:What you will find in this chapter:

•  Product, Guide, and Documentation Suite Overview

•  Intended Audience

•  DbProtect Components

•  Logging Into the DbProtect Console (and DbProtect Console Login 
Troubleshooting)

•  Global Navigation in DbProtect

•  DbProtect Administration: Content/Compliance Packs, Data Sources, and 
System Information

•  DbProtect Organizations, Users, and User Roles

•  Customer Support.
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Product, Guide, and 
Documentation Suite 
Overview
What you will find in this section:What you will find in this section:What you will find in this section:What you will find in this section:

•  About DbProtect

•  What you will find in this guide

•  If you need more help.

About
DbProtect

The Industry’s Only Complete Database Security SolutionThe Industry’s Only Complete Database Security SolutionThe Industry’s Only Complete Database Security SolutionThe Industry’s Only Complete Database Security Solution

A centrally-managed enterprise solution for comprehensive database security, 
DbProtect combines discovery, vulnerability scanning, real-time audit and threat 
management to help organizations reduce risk and enhance compliance. The 
integrated suite is comprised of the company’s flagship solutions for database 
vulnerability management and real-time database audit and threat management 
which protect enterprise organizations around the world from all internal and external 
threats, while also ensuring that those organizations meet or exceed regulatory 
compliance requirements.

Applying the proven security industry best practices of vulnerability managementvulnerability managementvulnerability managementvulnerability management and 
real-time audit and threat managementaudit and threat managementaudit and threat managementaudit and threat management, coupled with extensive enterprise features 
(including fine-grained access controls, and centralized management and reporting), 
DbProtect delivers comprehensive security and auditing capabilities to complex, 
diverse enterprise database environments.

Address Database Threats and Provide Protection with Proven TechnologyAddress Database Threats and Provide Protection with Proven TechnologyAddress Database Threats and Provide Protection with Proven TechnologyAddress Database Threats and Provide Protection with Proven Technology

•  Tamper Evident Privileged Audit and Threat ManagementTamper Evident Privileged Audit and Threat ManagementTamper Evident Privileged Audit and Threat ManagementTamper Evident Privileged Audit and Threat Management defends against 
misuse, fraud and abuse from internal and external users.

•  Comprehensive Vulnerability Management Comprehensive Vulnerability Management Comprehensive Vulnerability Management Comprehensive Vulnerability Management identifies and reduces risk.

•  Real-Time Monitoring and Intrusion DetectionReal-Time Monitoring and Intrusion DetectionReal-Time Monitoring and Intrusion DetectionReal-Time Monitoring and Intrusion Detection immediately identifies database 
attacks or misuse.

•  Compensating ControlsCompensating ControlsCompensating ControlsCompensating Controls, including Patch Gap management, assists with 
prioritizing of database security patches and defending against attack.

•  Improved IntegrationImproved IntegrationImproved IntegrationImproved Integration enables reporting on security patch progress, risk 
mitigation impact, and overall compliance status.

•  Application Awareness Application Awareness Application Awareness Application Awareness provides critical insight into IT infrastructure enabling 
organizations to better understand their database inventory, and thereby 
mitigate compliance risk factors, as well as addressing database security needs.
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•  Industry-leading KnowledgebaseIndustry-leading KnowledgebaseIndustry-leading KnowledgebaseIndustry-leading Knowledgebase utilizes the most comprehensive catalog of 
database-specific threats, many discovered by Team SHATTER, our own 
research and development team.

•  DbProtect’s ASAP Update DbProtect’s ASAP Update DbProtect’s ASAP Update DbProtect’s ASAP Update mechanism ensures protection remains up to date. 
This allows users to immediately identify and detect worms, buffer overflows, 
and privilege escalation exposures and attacks enabling a timely, informed, and 
fast response.

Enhance Regulatory Compliance EffortsEnhance Regulatory Compliance EffortsEnhance Regulatory Compliance EffortsEnhance Regulatory Compliance Efforts

DbProtect enables enterprises to ground compliance efforts in the database 
applications that house regulated data – be it material financial transactions, critical 
intellectual property, or sensitive personal information. The solution also supports 
forensic investigations and analysis. This approach to database security includes:

•  Robust access and authentication controls

•  Privileged and non-privileged user monitoring

•  Vulnerability management

•  Audit and threat management with proactive real-time alerts

•  Defined security Policies to guide user activity.

These security components collectively facilitate regulatory compliance and create 
active and intelligent protection mechanisms for databases. By grounding efforts in 
the databases where sensitive data spends the bulk of its existence, the suite helps 
customers comply with a variety of business and regulatory requirements including the 
PCI Data Security Standard, HIPAA, GLBA, California Security Breach Information Act 
(SB 1386), Sarbanes-Oxley Act, Basel II, ISO 27001/17799, DISA-STIG, FISMA, NIST 
800-53, PIPEDA, Canada’s Bill 198, and MITS.

What you will
find in this

guide

This guide consists of the following high-level chapters:

•  Vulnerability Management

•  Audit and Threat Management.

If you need
more help

You can contact Application Security, Inc. Customer Support any time by emailing 
support@appsecinc.com, or by calling 1-866-9APPSEC or 1-212-912-4100.
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Intended Audience
This guide intended for persons responsible for day-to-day usage of Db Protect. 
Typically, those responsible for installing DbProtect have the following (sometimes 
overlapping) job roles:

•  system administrators; for more information, see System administrators

•  network administrators; for more information, see Network administrators

•  database administrators; for more information, see Database administrators.

System
administrators

The system administratorsystem administratorsystem administratorsystem administrator maintains and operates a computer system and/or network. 
System administrators are often members of an Information Technology (IT) 
department. Their duties are wide-ranging, and vary from one organization to another. 
System administrators are usually charged with installing, supporting, and maintaining 
servers or other computer systems, and planning for and responding to service 
outages and other problems. Other duties may include scripting or light 
programming, project management for systems-related projects, supervising or 
training computer operators, and being the consultant for computer problems beyond 
the knowledge of technical support staff.

Network
administrators

The network administrator network administrator network administrator network administrator is a professional responsible for the maintenance of 
computer hardware and software that comprises a computer network. This normally 
includes the deployment, configuration, maintenance and monitoring of active 
network equipment.

Network administration commonly includes activities and tasks such as network 
address assignment, assignment of routing protocols and routing table configuration, 
as well as configuration of authentication and authorization-directory services. A 
network administrator’s duties often also include maintenance of network facilities in 
individual machines, such as drivers and settings of personal computers, as well as 
printers and so on.

Network administration also sometimes entails maintenance of certain network 
servers, e.g., file servers, VPN gateways, intrusion detection systems, etc. Network 
specialists and analysts concentrate on the network design and security, particularly 
troubleshooting and/or debugging network-related problems. Their work can also 
include the maintenance of the network's authorization infrastructure, as well as 
network backup systems.
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In addition, the network administrator is responsible for the security of the network 
and for assigning IP addresses to the devices connected to the networks. Assigning IP 
addresses gives the subnet administrator some control over the professional who 
connects to the subnet. It also helps to ensure that the administrator knows each 
system that is connected and who personally is responsible for the system. When 
network administrators give a system an IP address, they also delegate certain security 
responsibilities to the system administrator.

Database
administrators

A database administratordatabase administratordatabase administratordatabase administrator (DBA) is responsible for the environmental aspects of a 
database. In general, these include:

•  Recoverability.Recoverability.Recoverability.Recoverability. Creating and testing backups.

•  Integrity.Integrity.Integrity.Integrity. Verifying or helping to verify data integrity.

•  Security. Security. Security. Security. Defining and/or implementing access controls to the data.

•  Availability.Availability.Availability.Availability. Ensuring maximum uptime.

•  Performance. Performance. Performance. Performance. Ensuring maximum performance.

•  Development and testing support.Development and testing support.Development and testing support.Development and testing support. Helping programmers and engineers to 
efficiently utilize the database.

The role of a DBA has changed according to the technology of database management 
systems (DBMSs), as well as the needs of the database owners.
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DbProtect Components
What you will find in this section:What you will find in this section:What you will find in this section:What you will find in this section:

•  Conceptual diagram

•  Console

•  Scan Engines

•  Sensors.

Conceptual
diagram

The following conceptual diagramconceptual diagramconceptual diagramconceptual diagram illustrates how the DbProtect components interact, 
and indicates which standard listen ports must be open in order for DbProtect to work.
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Console The ConsoleConsoleConsoleConsole is the web browser-based, graphical component of DbProtect that allows 
you to navigate to the various features of the two DbProtect portals: DbProtect Audit DbProtect Audit DbProtect Audit DbProtect Audit 
and Threat Managementand Threat Managementand Threat Managementand Threat Management and DbProtect Vulnerability AssessmentDbProtect Vulnerability AssessmentDbProtect Vulnerability AssessmentDbProtect Vulnerability Assessment.

Accordingly, this guide refers to the Console as the DbProtect Audit and Threat 
Management UI and/or the DbProtect Vulnerability Assessment UI, depending which 
part of the enterprise product you are using.

If you are working with:

•  DbProtect Vulnerability Assessment DbProtect Vulnerability Assessment DbProtect Vulnerability Assessment DbProtect Vulnerability Assessment see Vulnerability Management

•  DbProtect Audit and Threat ManagementDbProtect Audit and Threat ManagementDbProtect Audit and Threat ManagementDbProtect Audit and Threat Management, see Audit and Threat Management.

Note:Note:Note:Note: In previous versions of DbProtect, you could use the Configuration Configuration Configuration Configuration 
Manager ToolManager ToolManager ToolManager Tool to modify the Console’s logging level. Now, you must 
manually change logging level values in the log4j.properties files; for 
more information, see Appendix H: Manually Changing the Logging Level 
for the Console by Modifying the log4j.properties File.

For information on minimum system requirements and installation instructions for the 
Console, see the DbProtect Installation Guide.

Scan Engines DbProtect’s network-based, vulnerability management Scan Engines  Scan Engines  Scan Engines  Scan Engines discover 
database applications within your infrastructure and assesses their security strength. 
Backed by a proven security methodology and extensive knowledge of application-
level vulnerabilities, DbProtect locates, examines, reports, and fixes security holes and 
misconfigurations. Scan Engines scan your databases for vulnerabilities, and allow you 
to perform Penetration (Pen) Tests and Audits against them.

Target databases (on Windows) include:

•  Oracle

•  Oracle Application Server

•  SQL Server

•  Lotus Notes/Domino

•  Sybase

•  DB2

•  DB2 on the Mainframe

•  MySQL.

For information on minimum system requirements and installation instructions for the 
Sensors, see the DbProtect Installation Guide.
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Sensors SensorsSensorsSensorsSensors deliver database-specific protection and alerting for best-in-class protection 
of enterprise organizations. You can fine-tune your event detection parameters and 
customize which audit and security events to monitor. This helps you focus security 
efforts on information that is relevant while bypassing false positives and irrelevant 
events. DbProtect’s ASAP Update mechanism ensures protection remains up-to-date 
as new vulnerabilities are identified and patches are released. Comprehensive Policies 
and rules definitions informed by industry best practices enable security auditing and 
documentation specific to enterprise environments.

There are two types of SensorsSensorsSensorsSensors available:

•  Host-based Sensors, which monitor SQL Server, Oracle, Sybase, or DB2 
databases on the host server

•  Network-based Sensors, which monitor your Oracle, DB2 or Sybase databases 
on the network.

Sensors fire Alerts when they detect a violation of rules, and a monitored event occurs. 
For more information on Sensors and Alerts, see Sensors and Alerts, respectively.

HOST-BASED SENSORS

Host-based SensorsHost-based SensorsHost-based SensorsHost-based Sensors allow you to monitor the following databases on a host server:

•  SQL ServerSQL ServerSQL ServerSQL Server on Windows

•  OracleOracleOracleOracle on Solaris, AIX, HP-UX, and Linux

•  DB2DB2DB2DB2 on Linux, Windows, Solaris, and AIX

•  Sybase Sybase Sybase Sybase Solaris and AIX.

The table below lists all supported host-based database/OS combinations, and links 
you to the installation steps. 

DB OS

SQL SERVER WINDOWS

DB2 LINUX

SOLARIS

AIX

WINDOWS
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For information on specificspecificspecificspecific supported database and operating system versions -- as 
well as minimum system requirements and installation instructions for the Sensors -- 
see the DbProtect Installation Guide.

NETWORK-BASED SENSORS

Network-based SensorsNetwork-based SensorsNetwork-based SensorsNetwork-based Sensors allow you to monitor Windows-based SybaseSybaseSybaseSybase, OracleOracleOracleOracle, and 
DB2DB2DB2DB2 on the network. If you want to install a network-based Sensornetwork-based Sensornetwork-based Sensornetwork-based Sensor, the table below lists 
supported database/OS combinations, and links you to the installation steps. 

For information on specificspecificspecificspecific supported database and operating system versions -- as 
well as minimum system requirements and installation instructions for the Sensors -- 
see the DbProtect Installation Guide.

ORACLE LINUX

SOLARIS

AIX

HP-UX

WINDOWS

SYBASE SOLARIS

AIX

DB OS

DB2 WINDOWS

SYBASE

ORACLE

DB OS
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Logging Into the DbProtect 
Console (and DbProtect 
Console Login 
Troubleshooting)
What you will find in this section:What you will find in this section:What you will find in this section:What you will find in this section:

•  Logging Into the DbProtect Console

•  Logging Into the DbProtect Console Using SSO

•  DbProtect Console Login Troubleshooting.

Logging Into the
DbProtect Console

Caution! Some older versions of Google Desktop (5.1 and earlier) may 

cause problems when loading the DbProtect Console applet in 

Internet Explorer. You should turn off Google Desktop, or re-

install a newer (5.2 or greater) version.

Note:Note:Note:Note: You must have the Java Runtime Environment (JRE) SE 6 Update 11 
installed in order to connect to the DbProtect Console via a web browser.

To log into the DbProtect Console:

1. Do one of the following:

•  Open Internet Explorer 6.0 or greater with JavaScript enabled, and the screen 
resolution set to a minimum of 1024x768.

•  Enter https://YourMachineName: InstallPort in the AddressAddressAddressAddress line, where:

-YourMachineName is the computer name of your Console machine

-InstallPort is the port number entered during installation.

A Security AlertSecurity AlertSecurity AlertSecurity Alert pop up displays, prompting you to accept a security certificate from 
Application Security, Inc. DbProtect uses this certificate to communicate with users 
over a secure channel.
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Note:Note:Note:Note: If you experience difficulty logging into the DbProtect Console and 
connecting to DbProtect, you may need to troubleshoot the Java Runtime 
Environment (JRE) security settings on your Internet Explorer 6 or greater 
web browser. For more information on a workaround, see Troubleshooting 
the Java Run Time Environment (JRE) Security Settings on Internet 
Explorer 6 or Troubleshooting the Java Run Time Environment (JRE) 
Security Settings on Internet Explorer 7.

Another possible solution is to clear your Java cache. For more 
information, see Appendix O: Clearing Your Java Cache in the DbProtect 
Installation Guide.

2. Click the OKOKOKOK button to display the DbProtect Console login page.

FIGURE: DbProtect Console login page

3. Do the following:

•  In the Username:Username:Username:Username: field, enter your DbProtect user name. You can use any of the 
following formats:

-username: local user

-<computername>\username

-<netbios domain name>\username

-<dns domain name>\username

-username@<dns domain name>

•  In the Password:Password:Password:Password: field, enter your DbProtect password.
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•  Use the Domain:Domain:Domain:Domain: drop-down to select your domain, or manually enter a domain 
in the Domain:Domain:Domain:Domain: field.

Note:Note:Note:Note: DbProtect is designed to use only Secure Sockets Layer (SSL) 
communication, which encrypts your user name and credentials prior to 
transmission to DbProtect. DbProtect then uses the Windows 
Authentication subsystem to verify the credentials.

Hint: You can check the Remember settings on this computerRemember settings on this computerRemember settings on this computerRemember settings on this computer checkbox to store 
your Username:Username:Username:Username:, Password:Password:Password:Password: and Domain: Domain: Domain: Domain: login values. You can click the  
button to reset the entered Username:Username:Username:Username:, Password:Password:Password:Password: and Domain: Domain: Domain: Domain: login 
values.

4. Click the LoginLoginLoginLogin button to display the DbProtect Console. For more 
information on navigating the DbProtect Console, see Global Navigation 
in DbProtect.

FIGURE: DbProtect Console (Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management / DashboardDashboardDashboardDashboard selected)

Every DbProtect Console page includes global navigation elements. They are:

•  Application tabsApplication tabsApplication tabsApplication tabs (in the upper portion of every Console page) which allow you 
to toggle between the different components of DbProtect. Specifically, you can 
click the:

-Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management tab to display and use DbProtect Vulnerability 
Management; for more information, see Vulnerability Management

-Audit & Threat ManagementAudit & Threat ManagementAudit & Threat ManagementAudit & Threat Management tab to display and use DbProtect Audit & 
Threat Management; for more information, see Audit and Threat 
Management

-Analytics & Reporting Analytics & Reporting Analytics & Reporting Analytics & Reporting tab to use DbProtect Analytics and run DbProtect 
reports; for more information, see DbProtect Analytics

-Asset Management tab Asset Management tab Asset Management tab Asset Management tab to view and manage all your database assets; for 
more information, see Asset Management

-Administration tab Administration tab Administration tab Administration tab to use Content Packs and view your DbProtect system 
information; for more information, see DbProtect Administration: Content/
Compliance Packs, Data Sources, and System Information
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-User/Organization informationUser/Organization informationUser/Organization informationUser/Organization information, i.e., your logged-in user IDuser IDuser IDuser ID and your 
associated “effective” OrganizationOrganizationOrganizationOrganization (in the upper right portion of every 
DbProtect Console page). If you are a Super User or an Admin User, and your 
User ID is associated with multiple Organizations, you can toggle between 
Organizations. For more information, see Setting Your “Effective” 
Organization

•  help help help help and logout logout logout logout links (in the upper right portion of every DbProtect Console 
page). Clicking these links allows you to display the DbProtect online help and 
log out of DbProtect, respectively.

Logging Into the
DbProtect Console

Using SSO

Starting with version 6.1, DbProtect allows you to use Windows authentication to log 
into the DbProtect Console using a login mechanism known as single sign-on single sign-on single sign-on single sign-on (SSO)(SSO)(SSO)(SSO).

Note:Note:Note:Note: SSO capability only works on Microsoft Windows systems.

If Windows authentication is properly configured, you can log into the DbProtect 
Console via Internet Explorer 6.0 or greater without having to enter a username and 
password. For security purposes, SSO is ideally combined with strong authentication 
methods like smart cards or one-time password tokens.

There are numerous benefits to implementing SSO. For example, SSO reduces the 
proliferation of user accounts and passwords and enables a more secure environment. 
SSO also eliminates the need for DbProtect users to remember an additional 
password. Other benefits include:

•  reducing time spent re-entering passwords for the same identity

•  reducing IT costs due to lower number of IT help desk calls about passwords

•  security on all levels of entry/exit/access to systems without the inconvenience 
of re-prompting users

•  centralized reporting for compliance adherence.

In order to implement SSO, you (or your administrator) must modify several 
configuration files. For more information, see the DbProtect Administrator’s Guide.

To log into the DbProtect Console using SSO:

1. Do the following:

•  Open Internet Explorer 6.0 or greater with JavaScript enabled, and the screen 
resolution set to a minimum of 1024x768.

•  Enter https://YourMachineName: InstallPort in the AddressAddressAddressAddress line, where:

-YourMachineName is the computer name of your DbProtect Console machine

-InstallPort is the port number entered during installation.

A Security AlertSecurity AlertSecurity AlertSecurity Alert pop up displays, prompting you to accept a security certificate from 
Application Security, Inc. DbProtect uses this certificate to communicate with users 
over a secure channel.
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Caution! If an “access denied” pop-up displays, prompting you to enter 

your credentials, this means you don’t have access to the 

DbProtect system, even though you’re a valid Windows user. If 

this happens, contact your DbProtect administrator to obtain 

access to the DbProtect system.

Hint: If you experience difficulty logging into the DbProtect Console and 

connecting to DbProtect, you may need to troubleshoot the Java Runtime 

Environment (JRE) security settings on your Internet Explorer 6 or greater 

web browser. For more information on a workaround, see 

Troubleshooting the Java Run Time Environment (JRE) Security 

Settings on Internet Explorer 6 or Troubleshooting the Java Run Time 

Environment (JRE) Security Settings on Internet Explorer 7.

Another possible solution is to clear your Java cache. For more 

information, see Clearing Your Java Cache.

2. The DbProtect Console displays; more information on navigating the 
Console, see Global Navigation in DbProtect.

FIGURE: DbProtect Console (Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management / DashboardDashboardDashboardDashboard selected)

Every DbProtect Console page includes global navigation elements. They are:

•  Application tabsApplication tabsApplication tabsApplication tabs (in the upper portion of every DbProtect Console page) which 
allow you to toggle between the different components of DbProtect. 
Specifically, you can click the:

-Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management tab to display and use DbProtect Vulnerability 
Management; for more information, see Vulnerability Management

-Audit & Threat ManagementAudit & Threat ManagementAudit & Threat ManagementAudit & Threat Management tab to display and use DbProtect Audit & 
Threat Management; for more information, see Audit and Threat 
Management

-Analytics & Reporting Analytics & Reporting Analytics & Reporting Analytics & Reporting tab to use DbProtect Analytics and run DbProtect 
reports; for more information, see DbProtect Analytics

-Asset Management tab Asset Management tab Asset Management tab Asset Management tab to view and manage all your database assets; for 
more information, see Asset Management



DbProtect 6.1 User’s Guide

Application Security, Inc. 18

-Administration tab Administration tab Administration tab Administration tab to use Content Packs and view your DbProtect system 
information; for more information, see DbProtect Administration: Content/
Compliance Packs, Data Sources, and System Information

-User/Organization informationUser/Organization informationUser/Organization informationUser/Organization information, i.e., your logged-in user IDuser IDuser IDuser ID and your 
associated “effective” OrganizationOrganizationOrganizationOrganization (in the upper right portion of every 
DbProtect Console page). If you are a Super User or an Admin User, and your 
User ID is associated with multiple Organizations, you can toggle between 
Organizations. For more information, see Setting Your “Effective” 
Organization.

•  help help help help and logout logout logout logout links (in the upper right portion of every DbProtect Console 
page). Clicking these links allows you to display the DbProtect online help and 
log out of DbProtect, respectively.

DbProtect Console
Login

Troubleshooting

This topic consists of the following sub-topics:

•  Troubleshooting the Java Run Time Environment (JRE) Security Settings on 
Internet Explorer 6

•  Troubleshooting the Java Run Time Environment (JRE) Security Settings on 
Internet Explorer 7

•  Clearing Your Java Cache

•  Adding the DbProtect URL to Your List of Trusted Intranet Sites In Internet 
Explorer.

TROUBLESHOOTING THE JAVA RUN TIME ENVIRONMENT 

(JRE) SECURITY SETTINGS ON INTERNET EXPLORER 6

If you are experiencing difficulty logging into the DbProtect Console, you may need to 
troubleshoot the Java Runtime Environment (JRE) security settings on your Internet 
Explorer (IE) 6 or greater web browser.

If your web browser is IE 6If your web browser is IE 6If your web browser is IE 6If your web browser is IE 6,    Active X controls and “enable third-party browser 
extensions” security settings may not be enabled on your IE 6 browser. If this is the 
case, you will encounter an error message you attempt to authenticate, and you can’t 
log in to the DbProtect Console.

Note:Note:Note:Note: The following security settings shouldshouldshouldshould be the default values in your IE 6 
web browser. You should only change the settings if you’re experiencing 
difficulty logging into the DbProtect Console.
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To enable proper Active X controls and “enable third-party browser extensions” 
security settings on IE 6, do the following:

1. Launch IE 6.

2. Do the following to display the Security Settings Security Settings Security Settings Security Settings dialog box:

•  Choose: Tools > Internet OptionsTools > Internet OptionsTools > Internet OptionsTools > Internet Options.    

•  Click the Security tab.

•  Click the Custom LevelCustom LevelCustom LevelCustom Level button.

3. Set the following security settings to EnableEnableEnableEnable or PromptPromptPromptPrompt:

•  Download signed ActiveX controlsDownload signed ActiveX controlsDownload signed ActiveX controlsDownload signed ActiveX controls

•  Run ActiveX controls and plug-insRun ActiveX controls and plug-insRun ActiveX controls and plug-insRun ActiveX controls and plug-ins.

4. Click the OKOKOKOK button.

5. Click the Advanced Advanced Advanced Advanced tab.

The Security Settings Security Settings Security Settings Security Settings dialog box displays.

FIGURE: Internet Explorer Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings dialog box

6. Check Enable Third-party browser extensions (requires restart)Enable Third-party browser extensions (requires restart)Enable Third-party browser extensions (requires restart)Enable Third-party browser extensions (requires restart).

7. Click the OKOKOKOK button.

8. Close and re-launch IE 6.

Try to log back into the DbProtect Console. If you continue to experience trouble, 
contact Application Security, Inc. Customer Support at support@appsecinc.com.
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TROUBLESHOOTING THE JAVA RUN TIME ENVIRONMENT 

(JRE) SECURITY SETTINGS ON INTERNET EXPLORER 7

If your web browser is IE 7, JRE 1.6 may be disabled and/or multiple JREs may be 
enabled on your client (i.e., the location from which your IE 7 IE 7 IE 7 IE 7 browser is running). JRE 
1.6 mustmustmustmust be enabled in order for you to connect to the DbProtect Console. If JRE 1.6 is 
disabled, or if multiple JREs of different versions are enabled on your client, then you 
will encounter an error message when you attempt to authenticate, and you can’t log 
in to the DbProtect Console.

To ensure JRE 1.6 is enabled, and to temporarily disable multiple JREs on your client 
machine (using IE 7), do the following:

1. Launch IE 7.

2. Do the following to display the Settings Settings Settings Settings dialog box:

•  Choose: Tools > Internet OptionsTools > Internet OptionsTools > Internet OptionsTools > Internet Options.    

•  Click the AdvancedAdvancedAdvancedAdvanced tab.

3. Scroll down to the Java (Sun) portion of the dialog box and verify the 
following:

•  JRE 1.6 is enabled (i.e., the box must be checked)

•  multiple JRE installations are listed.

JRE 1.6 mustmustmustmust be enabled in order for you to connect to the DbProtect Console. If it is 
notnotnotnot, check the JRE 1.6 box.

If JRE 1.6 is enabled, and otherotherotherother JRE versions are also enabled, then you must 
temporarily disable them by un-checking the boxes.

4. Click the ApplyApplyApplyApply button.

5. Click the OKOKOKOK button.

6. Close and re-launch IE 7.

Try to log back into the DbProtect Console. If you continue to experience trouble, 
contact Application Security, Inc. Customer Support at support@appsecinc.com.

CLEARING YOUR JAVA CACHE

If you are experiencing difficulty logging into the DbProtect Console, you may need to 
clear your Java cache. Application Security, Inc. also recommends you clear your Java 
cache after an upgrade. The Java cache does notnotnotnot get automatically cleared following a 
reboot.

To clear your Java cache:

1. Choose Start > Control Panel to display the Control Panel.

2. Double click the Java Java Java Java icon to display the Java Control PanelJava Control PanelJava Control PanelJava Control Panel dialog box.
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3. With the default General General General General tab selected, click the Settings... Settings... Settings... Settings... button (in the 
Temporary Internet FilesTemporary Internet FilesTemporary Internet FilesTemporary Internet Files section of the dialog box) to display the 
Temporary Files SettingsTemporary Files SettingsTemporary Files SettingsTemporary Files Settings dialog box.

4. Click the Delete Files... Delete Files... Delete Files... Delete Files... button to clear your Java cache.

Close your web browser and attempt to log into the DbProtect Console again.

ADDING THE DBPROTECT URL TO YOUR LIST OF TRUSTED 

INTRANET SITES IN INTERNET EXPLORER

In order for single sign-on (SSO) to function properly, you may need to configure 
Internet Explorer by adding the DbProtect URL to your list of trusted intranet sites.

Note:Note:Note:Note: The following steps explain how to configure Internet Explorer 7. Steps 
may vary slightly for other browser versions.

In Internet Explorer, do the following:

1. Choose Tools > Internet Options to display the Internet Options dialog box.

2. Select the SecuritySecuritySecuritySecurity tab.

3. Select Local Intranet Local Intranet Local Intranet Local Intranet from the list of zone sites (at the top of the Internet Internet Internet Internet 
Options Options Options Options dialog box).

4. Click the SitesSitesSitesSites button to display a Local intranet Local intranet Local intranet Local intranet pop up.

5. Click the AdvancedAdvancedAdvancedAdvanced button to display a second Local intranet Local intranet Local intranet Local intranet pop up.

6. Add https://<dbprotecturl> to the Add this website to the zone: Add this website to the zone: Add this website to the zone: Add this website to the zone: field, 
where <dbprotecturl> is the DbProtect Console URL; for more 
information, see Logging Into the DbProtect Console Using SSO.

7. Click the AddAddAddAdd button to add DbProtect to your list of trusted local intranet 
sites.

8. Click the CloseCloseCloseClose button to close the second Local intranet Local intranet Local intranet Local intranet pop up.

9. Click the CloseCloseCloseClose button to close the first Local intranet Local intranet Local intranet Local intranet pop up.

10.Click the ApplyApplyApplyApply button on the Internet OptionsInternet OptionsInternet OptionsInternet Options dialog box to apply your 
changes.

11.Click the OKOKOKOK button to close the Internet Options Internet Options Internet Options Internet Options dialog box.
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Global Navigation in 
DbProtect
What you will find in this section:What you will find in this section:What you will find in this section:What you will find in this section:

Every Console page includes global navigation elementsglobal navigation elementsglobal navigation elementsglobal navigation elements. They are:

•  Application Tabs

•  User ID and Associated “Effective” Organization

•  Help and Logout Links.

Application Tabs Application tabsApplication tabsApplication tabsApplication tabs display in the upper left portion of every DbProtect Console page. 
These tabs allow you to toggle between the different components of DbProtect.

FIGURE: Application tabs

You can click the:

•  Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management tab to display and use DbProtect Vulnerability 
Management; for more information, see Vulnerability Management

•  Audit & Threat ManagementAudit & Threat ManagementAudit & Threat ManagementAudit & Threat Management tab to display and use DbProtect Audit & Threat 
Management; for more information, see Audit and Threat Management

•  Analytics & Reporting Analytics & Reporting Analytics & Reporting Analytics & Reporting tab to use DbProtect Analytics and run DbProtect 
reports; for more information, see the DbProtect Analytics User’s Guide

•  Asset Management tab Asset Management tab Asset Management tab Asset Management tab to view and manage all of your database assets; for 
more information, see Asset Management.

•  Administration tab Administration tab Administration tab Administration tab to import content packs and enable compliance pack 
functionality in DbProtect, to view your DbProtect system information; for more 
information, see DbProtect Administration: Content/Compliance Packs, Data 
Sources, and System Information.
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User ID and
Associated
“Effective”

Organization

The upper right portion of every Console page displays your User/Organization User/Organization User/Organization User/Organization 
informationinformationinformationinformation, i.e., your logged-in user IDuser IDuser IDuser ID and your associated “effective” Organization. Organization. Organization. Organization. 

Every User ID is associated with at least one Organization. An OrganizationOrganizationOrganizationOrganization is a logical 
grouping of applications that allows you to manage User rights and capabilities within 
DbProtect. If you are a DbProtect Super Admin, DbProtect Admin, Vulnerability 
Management Admin, or an Audit and Threat Management Admin, then DbProtect 
allows you to create Organizations    and define a set of IP ranges and Policies for each 
Organization (which you can override at the User or Group level). For more 
information, seeDbProtect Organizations, Users, and User Roles.

If you are a DbProtect Super Admin, DbProtect Admin, Vulnerability Management 
Admin, or an Audit and Threat Management Admin -- and your User ID is associated 
with multiple Organizations -- you can click the “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector icon 
(labeled below) to display the “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector dialog box and 
change your “effective” Organization. 

FIGURE: User/”effective” Organization info

For more information, on:

•  using the “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector “Effective” Organization Selector dialog box to change your 
“effective” Organization, see Setting Your “Effective” Organization

•  how Organizations work in DbProtect, see DbProtect Organizations, Users, and 
User Roles

•  user roles in DbProtect, see DbProtect Organizations, Users, and User Roles.

Help and Logout
Links

The upper right portion of every Console page displays HelpHelpHelpHelp and LogoutLogoutLogoutLogout links, which 
allow you to display the online help and log out of DbProtect, respectively.

FIGURE: HelpHelpHelpHelp and LogoutLogoutLogoutLogout links

“Effective”    
Organization Selector

icon

Logged-in as 
user ID “Effective” Organization
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DbProtect Administration: 
Content/Compliance Packs, 
Data Sources, and System 
Information
What you will find in this section:What you will find in this section:What you will find in this section:What you will find in this section:

•  Displaying, Understanding, and Navigating the DbProtect Administration Page

•  Working with Content and Compliance Packs

•  Working with Data Sources

•  Viewing Your DbProtect System Information.
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Displaying,
Understanding,

and Navigating the
DbProtect

Administration
Page

When you click the AdministrationAdministrationAdministrationAdministration application tab from any DbProtect Console page 
(for more information, see Application Tabs), the DbProtect AdministrationAdministrationAdministrationAdministration page 
displays. This page allows you to import content packs and enable compliance pack 
and data source functionality in DbProtect, and to view your DbProtect system 
information.

For more information on:

•  content packs and compliance packs, see Working with Content and 
Compliance Packs

•  data sources, see Working with Data Sources

•  viewing your DbProtect system information, see Viewing Your DbProtect 
System Information.

FIGURE: AdministrationAdministrationAdministrationAdministration page

The AdministrationAdministrationAdministrationAdministration page consists of two panes: the navigation panenavigation panenavigation panenavigation pane and the viewing viewing viewing viewing 
panepanepanepane.

The navigation panenavigation panenavigation panenavigation pane allows you to select whether you want to work with Content Content Content Content 
PacksPacksPacksPacks, Data SourcesData SourcesData SourcesData Sources, or view your DbProtect SystemSystemSystemSystem information.

Hint: In the navigation pane, you can click the Expand All link to expand all 

viewable content pack and system information, or click the Collapse All 

link to collapse viewable content pack and system information.

The viewing paneviewing paneviewing paneviewing pane displays information about:

•  Your imported content packscontent packscontent packscontent packs (if you click the Content Packs > View Content Content Packs > View Content Content Packs > View Content Content Packs > View Content link 
in the navigation pane); for more information, see Viewing Your Available 
Imported Compliance Content Packs.

The viewing pane also allows you to import content packs (if you click the 
Content Packs > Import Content Content Packs > Import Content Content Packs > Import Content Content Packs > Import Content link in the navigation pane); for more 
information, see Importing a Compliance Content Pack.
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•  Data SourcesData SourcesData SourcesData Sources, such as Oracle Audit Vault; for information, see Working with 
Data Sources. The viewing pane also allows you to register data sources (for 
example, you can register Oracle Audit Vault by clicking the Data Sources > Data Sources > Data Sources > Data Sources > 
Audit Vault Audit Vault Audit Vault Audit Vault link in the navigation pane); for more information, see Registering 
Oracle Audit Vault as a DbProtect Data Source.

•  The specific versions of your installed DbProtect suite components (if you click 
the System > About DbProtect System > About DbProtect System > About DbProtect System > About DbProtect link in the navigation pane); for more 
information, see Viewing Your DbProtect System Information.

Working with
Content and

Compliance Packs

Compliance packsCompliance packsCompliance packsCompliance packs are optional DbProtect add-ons that contain regulatory 
compliance-level views of your database environment designed to help you track, 
manage, and meet compliance requirements. Compliance packsCompliance packsCompliance packsCompliance packs work in conjunction 
with DbProtect Analytics (version 1.3 or higher of which mustmustmustmust be installed), allowing 
you to review and analyze compliance progress with additional high-level Dashboards 
and report the results of testing of database security controls in the correct 
compliance language context (e.g., information assurance controls and identifiers).

Compliance packs    simplify the mapping between established test controls and the 
automated methods and procedures within DbProtect, which helps to save a 
tremendous amount of analysis time. Moreover, content packs offer additional 
Policies, Dashboards, reports, export formats, and independent resource information 
where applicable.

In order to enable compliance packs within DbProtect, you must first obtain and 
import content packscontent packscontent packscontent packs, Application Security, Inc.-provided.zip files that, when 
successfully imported into DbProtect, add reports geared toward helping you achieve 
regulation-specific compliance (for example, DISA-STIG). Once you import a content 
pack, a new displays on the DbProtect Console; for more information on the 
application tabs, see Application Tabs.

The Compliance Packs chapter provides detailed information about importing content 
packs, working with compliance packs, running compliance pack reports, and more.

Working with Data
Sources

TBA

Viewing Your
DbProtect System

Information

You can click the System > About DbProtect System > About DbProtect System > About DbProtect System > About DbProtect link (in the navigation pane of the 
AdministrationAdministrationAdministrationAdministration page) to    display your current DbProtect    system information (including 
component name, version, and last update).

Note:Note:Note:Note: Not all of the following components may be installed. For more 
information on DbProtect and DbProtect Analytics components, including 
minimum system requirements, see the DbProtect Installation Guide and 
the DbProtect Analytics Installation and User’s Guide.



DbProtect 6.1 User’s Guide

Application Security, Inc. 27

Specifically, you can view the current version of:

•  DbProtect (e.g., DbProtect 6.0DbProtect 6.0DbProtect 6.0DbProtect 6.0)

•  the Data Component (e.g., Data Component 2.4.6164.0Data Component 2.4.6164.0Data Component 2.4.6164.0Data Component 2.4.6164.0)

•  the Database Component (e.g., Data Component 2.4.6161.0Data Component 2.4.6161.0Data Component 2.4.6161.0Data Component 2.4.6161.0)

•  DbProtect Analytics (e.g., DbProtect Analytics 1.4.6176DbProtect Analytics 1.4.6176DbProtect Analytics 1.4.6176DbProtect Analytics 1.4.6176)

•  DbProtect Console (e.g., DbProtect Console 4.3.5815DbProtect Console 4.3.5815DbProtect Console 4.3.5815DbProtect Console 4.3.5815)

•  Java (e.g., Java 1.6.0_11Java 1.6.0_11Java 1.6.0_11Java 1.6.0_11)

•  your Windows operating system (e.g., Windows 200x 5.2Windows 200x 5.2Windows 200x 5.2Windows 200x 5.2)

•  the SHATTER Knowledgebase (e.g., 2.5.10815.12.5.10815.12.5.10815.12.5.10815.1)

•  SHATTER schema (e.g., 2.4.0.02.4.0.02.4.0.02.4.0.0)

•  Scan Engine (e.g., 6.2.81766.2.81766.2.81766.2.8176)

•  Sensor (e.g., AppRadar Sensor_3.11.10_Win32.exeAppRadar Sensor_3.11.10_Win32.exeAppRadar Sensor_3.11.10_Win32.exeAppRadar Sensor_3.11.10_Win32.exe).
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DbProtect Organizations, 
Users, and User Roles
This chapter consists of the following topics:

•  What are DbProtect Organizations, Users, and User Roles?

•  DbProtect User Roles and Associated Privileges

•  Adding an Organization

•  Editing an Organization

•  Removing an Organization

•  Setting Your “Effective” Organization

•  Configuring SMTP Mail Server Information for Your Organization

•  Adding a Group

•  Editing a Group

•  Removing a User

•  Adding a User

•  Editing a User

•  Removing a User

•  Creating a DbProtect Audit and Threat Management Policy.

What are
DbProtect

Organizations,
Users, and User

Roles?

This topic consists of the following sub-topics:

•  What are Organizations?

•  What are Users?

•  What are User Roles?

WHAT ARE ORGANIZATIONS?

An OrganizationOrganizationOrganizationOrganization is a logical grouping of applications that allows you to manage User 
rights and capabilities within DbProtect and define a set of IP ranges and Policies for 
each Organization (which you can override at the User or Group level).

As explained in User ID and Associated “Effective” Organization, the upper right 
portion of every Console page displays your User/Organization information, i.e., your 
logged-in user IDuser IDuser IDuser ID and your associated “effective” Organization.Organization.Organization.Organization.

FIGURE: User/”effective” Organization info

“Effective”    
Organization Selector

icon

Logged-in as 
user ID “Effective” Organization
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Every User ID is associated with at least one Organization, and all Users can change 
their “effective” Organization.

WHAT ARE USERS?

DbProtect UsersUsersUsersUsers are individuals that have certain rights within the DbProtect system. 
You can also add Groups to DbProtect. Users and Groups are Windows entities taken 
from either the Active Directory1 or your local system. You mustmustmustmust explicitly add Users 
and Groups to DbProtect in order for these individuals to use the product.

The following conceptual diagram illustrates three differently-configured 
OrganizationsOrganizationsOrganizationsOrganizations, and the subordinate Groups/Users that belong to each Organization.

FIGURE: Users and Organizations example

If you are a DbProtect Super Admin, DbProtect Admin, Vulnerability Management 
Admin, or an Audit and Threat Management Admin you can create Organizations and 
add Users and Groups to them.

Note:Note:Note:Note: If the DbProtect Scan Engine service does notnotnotnot run as a domain User, then 
all Users mustmustmustmust be non-domain Users.

WHAT ARE USER ROLES?

Each User (or Group) added to an Organization has an assigned User Role which has 
inherent privileges. The next topic, DbProtect User Roles and Associated Privileges, 
explains User Roles and associated privileges in detail.

1.Active Directory is an implementation of LDAP directory services for Windows environments. Active Directory 
allows administrators to assign enterprise-wide Policies, deploy programs to many computers, and apply 
critical updates to an entire Organization. Active Directory stores information and settings relating to an 
Organization in a central, organized, accessible database. Active Directory networks can vary from a small 
installation with a few hundred objects, to a large installation with millions of objects.
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DbProtect User
Roles and

Associated
Privileges

DbProtect is comprised of Organizations, and within those Organizations, assigned 
UsersUsersUsersUsers; for more information, see Working with Scan Engines.

Each User has an assigned User RoleUser RoleUser RoleUser Role. The available User Roles are:

•  DbProtect (DBP) Super Admin

•  DBP Admin

•  DBP View

•  Vulnerability Management (VM) Admin

•  VM Basic

•  VM View

•  Audit and Threat Management (ATM) Admin

•  ATM View.

The following table lists privileges associated with each User role.

Caution! If the Console is running as a local administrator, there are User 

management/authentication limitations. When adding a Group/

User, you can only populate the list of Groups from your “local 

system”, not from other domains. In addition, you cannot log on 

to the Console as a domain User. For more information, see 

Working with Scan Engines. 

DBPDBPDBPDBP = DbProtect, VMVMVMVM = Vulnerability Management, ATMATMATMATM = Audit and Threat Management 

Privileges
DBP 
Super 
Admin

DBP 
Admin

VM 
Admin

ATM 
Admin

VM 
Basic

DBP 
View

VM 
View

ATM 
View

Register a Scan Engine. �

Unregister a Scan Engine. �

Edit a Scan Engine. �

Export Vulnerability Management 
credentials to file via a Job 
template or Credential Profile.

� � � �

Import Vulnerability Management 
credentials from file via a Job 
template or Credential Profile.

� � � �

Create or modify a Vulnerability 
Management Credential Profile.

� � � �

Set an effective Organization. � � � � � � � �
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Privileges
DBP 
Super 
Admin

DBP 
Admin

VM 
Admin

ATM 
Admin

VM 
Basic

DBP 
View

VM 
View

ATM 
View

Add, edit, and remove an 
Organization.

� � � �

Add, edit, and remove a User or 
Group.

Note:Note:Note:Note: Login user must have a higher/
equal privilege to edit or remove 
the selected user.

� � �

Edit or remove an application from 
the Vulnerability Management 
Dashboard.

� � �

Add an application to the 
Vulnerability Management 
Dashboard.

� � � �

Create, edit, delete, schedule, 
manage, or cancel a Vulnerability 
Management Job.

� � � �

Delete a Report. � � � � �

Create, view, edit, or schedule a 
Report.

� � � � � � � �

View Vulnerability Management 
Job results and Job history.

� � � � � �

View Sensors. � � �

Register a Sensor. � � �

Configure a Sensor and deploy the 
configuration information.

� � �

Delete configured Sensors. � � �

Perform an ASAP Update of Rules 
in Sensors.

� � �

View and monitor the “health” of 
Sensors (via the Sensor Manager).

� � � � �

Unregister a Sensor. � � �
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DbProtect User
Role Inheritance

In DbProtect, Users may belong to multiple Organizations. Their membership may be 
defined as the role appropriate for a given Organization (i.e., DbProtect Super Admin, 
DbProtect Admin, DbProtect View, Vulnerability Management Admin, Vulnerability 
Management Basic, Vulnerability Management View, and Audit and Threat 
Management Admin). A User’s membership to an Organization may be defined 
directly by explicit enumeration, or inherited by group membership; for more 
information, see What are DbProtect Organizations, Users, and User Roles?

There are cases where more than one role or membership may be valid for a user -- 
depending on the User’s Organizational membership and roles. When Users have 
more than one possible Organizational membership, they are initially placed in a 
default “effective” Organization. All Users, regardless of User Role, can change their 
“effective” Organization, as explained in User ID and Associated “Effective” 

Privileges
DBP 
Super 
Admin

DBP 
Admin

VM 
Admin

ATM 
Admin

VM 
Basic

DBP 
View

VM 
View

ATM 
View

Manually remove a Sensor. � � �

Monitor Alerts. � � � � �

Acknowledge and archive Alerts. � � �

View Policies. � � � � �

Create a Policy. � � �

Edit a Policy. � � �

Import a Policy. � � �

Export a Policy. � � �

Deploy a Policy. � � �

Delete a Policy. � � �

View Filters. � � � � �

Edit a Filter. � � �

Delete a Filter. � � �

Import a Filter. � � �

Export a Filter. � � �

Install and use Compliance Packs. � � � �
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Organization. You can also set a newly-selected Organization as your default 
“effective” Organization.

Once Users sets their “effective” Organization, DbProtect determines whether the 
Users’ membership to the “effective” Organization can be obtained via multiple 
paths. If so, DbProtect grants the highest possible User Role defined for the User -- 
within the selected “effective” Organization -- to the User.

The following tables illustrate the effective User Role and Organizational membership 
under a variety of conditions. 

Organization
Parent 

Organization
User/group User Role

US Operations Global Operations Auditors (Joe, Jane, 
Mary)

Vulnerability 
Management Basic 
User

US Operations Global Operations Administrators (Joe, 
Jim, Mike)

DbProtect Admin

Operations Corporate Administrators (Joe, 
John, Sue)

DbProtect Super 
Admin

User logging in “Effective” Organization User Role granted

Jane US Operations Vulnerability Management 
Basic User

Jim US Operations DbProtect Super Admin

Joe Global Operations Super Admin

US Operations DbProtect Admin
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Understanding the
Manage

Organizations and
Users page

The Organizations and UsersOrganizations and UsersOrganizations and UsersOrganizations and Users page allows you to create logical and hierarchical 
Organizations. You can define a set of IP ranges and Policies for each Organization 
(which you can override at the User or Group level). Your Organizations can be 
exclusive and isolated from other Organizations.

After you create Organizations, you can create subordinate UsersUsersUsersUsers and GroupsGroupsGroupsGroups. Users 
and Groups are Windows entities taken from either the Active Directory or your local 
system.

FFFFIIIIGGGGUUUURRRREEEE: : : : Organizations and Users Organizations and Users Organizations and Users Organizations and Users page

The pane of the Organizations and Users page is divided into two portions:

•  Parent Organization.Parent Organization.Parent Organization.Parent Organization. This portion of the pane displays your parent 
Organization. You can right click the parent Organization to add child 
Organizations, add Users and Groups, edit Organizations, and remove 
Organizations.

•  Organization Users and Groups.Organization Users and Groups.Organization Users and Groups.Organization Users and Groups. The columns in this portion of the pane display 
the following information about Users and Groups in the Organization you have 
highlighted (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the pane):

----Username. Username. Username. Username. The usernames of all Users in your Organization.

-Role. Role. Role. Role. The role of the associated Group (i.e., DbProtect Super AdminDbProtect Super AdminDbProtect Super AdminDbProtect Super Admin, 
DbProtect AdminDbProtect AdminDbProtect AdminDbProtect Admin, DbProtect ViewDbProtect ViewDbProtect ViewDbProtect View, Vulnerability Management AdminVulnerability Management AdminVulnerability Management AdminVulnerability Management Admin, 
Vulnerability Management BasicVulnerability Management BasicVulnerability Management BasicVulnerability Management Basic, Vulnerability Management ViewVulnerability Management ViewVulnerability Management ViewVulnerability Management View, and Audit Audit Audit Audit 
and Threat Management Adminand Threat Management Adminand Threat Management Adminand Threat Management Admin)

----Domain. Domain. Domain. Domain. The associated User’s network domain.

-Type. Type. Type. Type. The role of the associated User (i.e., DbProtect Super AdminDbProtect Super AdminDbProtect Super AdminDbProtect Super Admin, 
DbProtect AdminDbProtect AdminDbProtect AdminDbProtect Admin, DbProtect ViewDbProtect ViewDbProtect ViewDbProtect View, Vulnerability Management AdminVulnerability Management AdminVulnerability Management AdminVulnerability Management Admin, 
Vulnerability Management BasicVulnerability Management BasicVulnerability Management BasicVulnerability Management Basic, Vulnerability Management ViewVulnerability Management ViewVulnerability Management ViewVulnerability Management View, and Audit Audit Audit Audit 
and Threat Management Adminand Threat Management Adminand Threat Management Adminand Threat Management Admin).

You can right click a User or Group to edit or remove the User or Group.

Note:Note:Note:Note: For more information on the pane and other DbProtect Vulnerability 
Management UI components, see Understanding the DbProtect 
Vulnerability Management Portal User Interface (UI).



DbProtect 6.1 User’s Guide

Application Security, Inc. 35

Specifically, the Organizations and Users Organizations and Users Organizations and Users Organizations and Users page allows you to:

•  add an Organization; for more information, see Adding an Organization

•  edit an Organization; for more information, see Editing an Organization

•  remove an Organization; for more information, see Removing an Organization

•  toggle between Organizations, also known as setting your “effective” 
Organization; for more information, see Setting Your “Effective” Organization

•  add a Group; for more information, see Adding a Group

•  edit a Group; for more information, see Editing a Group

•  remove a Group; for more information, see Removing a Group

•  add a User; for more information, see Adding a User

•  edit a User; for more information, see Editing a User

•  remove a User; for more information, see Removing a User.

Adding an
Organization

To add an Organization: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing: 

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page
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2. Do one of the following to display the Organization Setup Organization Setup Organization Setup Organization Setup dialog box:

•  Click the Add OrganizationAdd OrganizationAdd OrganizationAdd Organization button in the Controls Controls Controls Controls Toolbar on the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page

•  Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose Add OrganizationAdd OrganizationAdd OrganizationAdd Organization.

FIGURE: Organization Setup Organization Setup Organization Setup Organization Setup dialog box (GeneralGeneralGeneralGeneral tab selected)

Select the GeneralGeneralGeneralGeneral tab (selected by default).

Note:Note:Note:Note: You can click the E-MailE-MailE-MailE-Mail tab to configure your Organization’s SMTP email 
server information; for more information, see Configuring SMTP Mail 
Server Information for Your Organization.

3. In the Organization Name Organization Name Organization Name Organization Name portion of the Organization Setup Organization Setup Organization Setup Organization Setup dialog box, 
enter the name of your new Organization in the Name: Name: Name: Name: field.

4. In the IP Range  IP Range  IP Range  IP Range portion of the Organization SetupOrganization SetupOrganization SetupOrganization Setup dialog box:

•  Enter an IP address range in the From: From: From: From: and To: To: To: To: fields. This is the IP range that 
members of your Organization are permitted to work within when they 
schedule a Discovery, Audit, Penetration Test, or Report Job. 

Example:Example:Example:Example: If you specify the range 127.0.0.1 through 127.0.0.255, then 
members of your Organization are only permitted to schedule Jobs within this 
range of IP addresses.
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•  Click the AddAddAddAdd button to add the IP addresses to the list of IP addresses that 
members of your Organization are permitted to work within.

•  Click the Load IPs From File Load IPs From File Load IPs From File Load IPs From File button to display an OpenOpenOpenOpen dialog box and upload a 
standard, line-delimited text file. Unlike the format described in Creating a 
Discovery Job, IP addresses for Organizations do not require ports. You can use 
any of the following formats:

-ip (for example, 192.168.1.1)

-ip-ip (for example, 192.168.1.1-192.168.1.255)

-Classless Inter Domain Routing (CIDR) notation, i.e., ip/network prefix (for 
example, 192.9.205.22/18); for more information on CIDR notation, see http://
infocenter.guardiandigital.com/manuals/IDDS/node9.html

Note:Note:Note:Note: To remove an IP address range from the list, highlight the range, then click 
the Remove button.

5. In the Policies  Policies  Policies  Policies portion of the Create OrganizationCreate OrganizationCreate OrganizationCreate Organization dialog box, highlight 
which Penetration Test and Audit Policies the Users in your Organization 
can use (or un-highlight restricted Policies).

You can click the:

•  Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the Organization 
Users can use (or un-highlight restricted Penetration Test Policies)

•  AuditAuditAuditAudit tab, and highlight which Audit Policies the Organization Users can use (or 
un-highlight restricted Audit Policies).

Hint: You can further restrict/enable Penetration Test and Audit Policy access at 

the individual User level. For more information, see Adding a User and 

Editing a User.

Hint: Click <CTRL> to highlight non-sequential Policies.

6. Click the CreateCreateCreateCreate button to create your new Organization.

The new Organization displays in the Parent Organization Parent Organization Parent Organization Parent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.

Editing an
Organization

To edit an Organization: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The the Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).
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Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the 
Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page) and choose Edit OrganizationEdit OrganizationEdit OrganizationEdit Organization to 
display the Organization Setup Organization Setup Organization Setup Organization Setup dialog box.

FIGURE: Organization Setup Organization Setup Organization Setup Organization Setup dialog box (GeneralGeneralGeneralGeneral tab selected)

Select the GeneralGeneralGeneralGeneral tab (selected by default).

Note:Note:Note:Note: You can click the E-MailE-MailE-MailE-Mail tab to configure your Organization’s SMTP email 
server information; for more information, see Configuring SMTP Mail 
Server Information for Your Organization.

3. In the Organization Name Organization Name Organization Name Organization Name portion of the Organization Setup Organization Setup Organization Setup Organization Setup dialog box, 
you can edit the name of your Organization in the Name: Name: Name: Name: field.
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4. In the IP Range  IP Range  IP Range  IP Range portion of the Organization Setup Organization Setup Organization Setup Organization Setup dialog box:

•  You can edit the IP address range in the From: From: From: From: and To: To: To: To: fields. This is the IP range 
that members of your Organization are permitted to work with when they 
schedule a Discovery, Audit, Penetration Test, or Report Job. 

Example:Example:Example:Example: If you specify the range 127.0.0.1 through 127.0.0.255, then 
members of this Organization are only permitted to schedule Jobs within this 
range of IP addresses.

•  Click the AddAddAddAdd button to add the IP addresses to the list of IP addresses that 
members of the Organization are permitted to work within.

•  Click the Load IPs From File Load IPs From File Load IPs From File Load IPs From File button to display an OpenOpenOpenOpen dialog box and upload a 
standard, line-delimited text file. Unlike the format described in Creating a 
Discovery Job, IP addresses for Organizations do not require ports. You can use 
any of the following formats:

-ip (for example, 192.168.1.1)

-ip-ip (for example, 192.168.1.1-192.168.1.255)

-Classless Inter Domain Routing (CIDR) notation, i.e., ip/network prefix 
(for example, 192.9.205.22/18); for more information on CIDR notation, 
see http://infocenter.guardiandigital.com/manuals/IDDS/node9.html

Note:Note:Note:Note: To remove an IP address range from the list, highlight the range, then click 
the Remove button.

5. In the Policies  Policies  Policies  Policies portion of the Organization Setup Organization Setup Organization Setup Organization Setup dialog box, highlight 
which Penetration Test and Audit Policies the Users in your Organization 
can use (or un-highlight restricted Policies). 

You can click the:

•  Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the Organization 
Users can use (or un-highlight restricted Penetration Test Policies)

•  AuditAuditAuditAudit tab, and highlight which Audit Policies the Organization Users can use (or 
un-highlight restricted Audit Policies).

Note:Note:Note:Note: You can further restrict/enable Penetration Test and Audit Policy access at 
the individual User level. For more information, see Adding a User and 
Editing a User.

6. Click the SaveSaveSaveSave button to save your edited Organization.

The edited Organization displays in the Parent Organization Parent Organization Parent Organization Parent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.
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Removing an
Organization

To remove an Organization: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the 
Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page) and choose EditEditEditEdit to display the 
Remove Organization? Remove Organization? Remove Organization? Remove Organization? pop up.

FIGURE: Remove Organization?Remove Organization?Remove Organization?Remove Organization? pop up

Click the YesYesYesYes button to remove the Organization (and all its members).

The Organization is removed from the Parent Organization Parent Organization Parent Organization Parent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.
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Setting Your
“Effective”

Organization

As explained in User ID and Associated “Effective” Organization, the upper right 
portion of every Console page displays your User User User User and ”effective”Organization ”effective”Organization ”effective”Organization ”effective”Organization 
informationinformationinformationinformation, i.e., your logged-in user IDuser IDuser IDuser ID and your associated “effective” Organization.Organization.Organization.Organization.

FIGURE: User/”effective” Organization info

Every User ID is associated with at least one Organization. If you are a Super User or an 
Admin User, and your User ID is associated with multiple Organizations, you can 
toggle between Organizations.

To set your “effective” Organization:

1. Do one of the following to display the Effective Organization Selector dialog box:

•  Click the Effective Organization SelectorEffective Organization SelectorEffective Organization SelectorEffective Organization Selector icon located in the upper right corner 
of every Console page; for more information, see User ID and Associated 
“Effective” Organization

•  Choose File > Organization Selector File > Organization Selector File > Organization Selector File > Organization Selector from the menu.

The Effective Organization SelectorEffective Organization SelectorEffective Organization SelectorEffective Organization Selector dialog box is shown below.

FIGURE: Effective Organization Selector Effective Organization Selector Effective Organization Selector Effective Organization Selector dialog box
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2. Your current “effective” Organization is highlighted. To change your 
“effective” Organization, do the following:

•  Highlight a different “effective” Organization.

•  Click the Set Effective OrganizationSet Effective OrganizationSet Effective OrganizationSet Effective Organization button.

As a result, your User ID and your new, associated “effective” Organization display at 
the top of every DbProtect portal page.

Configuring SMTP
Mail Server

Information for
Your Organization

DbProtect Vulnerability Management allows you to notify others via email when 
DbProtect Vulnerability Management completes a Job. This feature works for all types 
of Jobs, i.e., Discovery, Penetration Test, Audit, and Report Jobs. For more 
information, see Scheduling email notification upon Job completion.

However, in order to notify others via email when DbProtect Vulnerability Management 
completes a Job, an Admin or Super Admin mustmustmustmust first properly configure your 
Organization’s SMTP mail server information. Otherwise, the email notification of Job 
completion feature will notnotnotnot work.

To configure your Organization’s SMTP mail server information: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page
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2. Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the 
Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page) and choose Edit OrganizationEdit OrganizationEdit OrganizationEdit Organization to 
display the Organization Setup Organization Setup Organization Setup Organization Setup dialog box.

FIGURE: Organization Setup Organization Setup Organization Setup Organization Setup dialog box (GeneralGeneralGeneralGeneral tab selected)
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3. Click the E-MailE-MailE-MailE-Mail tab to display the The E-MailE-MailE-MailE-Mail portion of the Organization Organization Organization Organization 
Setup Setup Setup Setup dialog box.

Note:Note:Note:Note: You can click the GeneralGeneralGeneralGeneral tab to specify your Organization’s general 
information. General information includes the IP range that members of 
your Organization are permitted to work within when they schedule a Job 
(Discovery, Audit, Penetration Test, or Report). You can also specify which 
Penetration Test and Audit Policies the Users in your Organization can use. 
For more information, see Adding an Organization or Editing an 
Organization.

FIGURE: OrganizationOrganizationOrganizationOrganization SetupSetupSetupSetup dialog box (E-MailE-MailE-MailE-Mail tab selected)

If you want to:

•  configure your outgoing SMTP server information, see Step 4

•  configure your “from” and “reply to” addresses, see Step 5

•  specify a maximum attachment size in megabytes (1-30), see Step 6.

4. Configure your outgoing SMTP server information.

In the Outgoing ServerOutgoing ServerOutgoing ServerOutgoing Server portion of the dialog box:

•  Enter the name of your outgoing SMTP server in the Outgoing Mail Server  Outgoing Mail Server  Outgoing Mail Server  Outgoing Mail Server 
(SMTP)(SMTP)(SMTP)(SMTP) field
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•  Enter the port number you want to use on your outgoing SMTP server in the    
Outgoing Server Port (1-65535)Outgoing Server Port (1-65535)Outgoing Server Port (1-65535)Outgoing Server Port (1-65535) field.

•  Check the Use AuthenticationUse AuthenticationUse AuthenticationUse Authentication checkbox if your SMTP server requires 
authentication in order to send email.

Note:Note:Note:Note: Some SMTP servers require authentication in order to send email. 
Depending on what kind of SMTP server you are using, and how it is 
configured, this may or may not be the case. If your SMTP server requires 
authentication in order to send email, then you must enter a valid login/
password pair, and check the Use Authentication checkbox. However, if 
you are not sure whether your SMTP server requires authentication, check 
with your mail administrator.

If you check the Use Authentication checkbox, you must also enter a valid:

----Username:Username:Username:Username:

----Password:Password:Password:Password:

•  Check the Use SSL Use SSL Use SSL Use SSL checkbox if want to use Secure Sockets Layer (SSL) to 
encrypt your User name and credentials prior to transmission.

5. Specify your “from”“from”“from”“from” and “reply to” “reply to” “reply to” “reply to” email    addresses.

In the Other User Information Other User Information Other User Information Other User Information portion of the dialog box, enter your:

•  “from” email address in the From Addess:From Addess:From Addess:From Addess: field (i.e., when DbProtect 
Vulnerability Management completes a Job and notifies your email recipienets 
via email, this is the “from” email address)

•  “reply to” email address in the Reply To Address: Reply To Address: Reply To Address: Reply To Address: field (i.e., when DbProtect 
Vulnerability Management completes a Job and notifies your email recipienets 
via email, this is the “reply to” email address).

6. Specify a maximum attachment size in megabytes (1-30).

In the Other Options Other Options Other Options Other Options portion of the dialog box, enter the maximum allowable size of 
email attachments (0-30 megabytes) in the Max Attachment Size in Megabytes (1-30):Max Attachment Size in Megabytes (1-30):Max Attachment Size in Megabytes (1-30):Max Attachment Size in Megabytes (1-30): 
field. The default value is 3 megabytes.

Note:Note:Note:Note: When DbProtect Vulnerability Management completes a Report, the 
generated email always includes link to the Report -- even if there is no 
attachment. In other words, even if the generated Report exceeds the 
maximum attachment size, your email recipients can still view the Report 
online.

7. Review your SMTP server settings.

Hint: You can click the Delete E-Mail Settings button any time to delete all 

configured email settings.

8. Click the SaveSaveSaveSave button to save your SMTP server settings.

The Organization SetupOrganization SetupOrganization SetupOrganization Setup dialog box closes and your SMTP server settings are saved.
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Adding a Group Note:Note:Note:Note: If DbProtect Vulnerability Management does notnotnotnot run as a domain User, you 
must also add local (i.e., non-domain) Users.

To add a Group: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page
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2. Do one of the following to display the Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group 
dialog box:

•  Click the Add User or GroupAdd User or GroupAdd User or GroupAdd User or Group button in the Toolbars    portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page (ControlsControlsControlsControls portion)

•  Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose Add UserAdd UserAdd UserAdd User.

FIGURE: Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group dialog box

3. In the User or Group Identity  User or Group Identity  User or Group Identity  User or Group Identity portion of the Add AppDetective User or Add AppDetective User or Add AppDetective User or Add AppDetective User or 
Group Group Group Group dialog box, do the following:

•  Use the Type:Type:Type:Type: drop-down to select GroupGroupGroupGroup.

•  Use the Group Domain:Group Domain:Group Domain:Group Domain: drop-down to select the Group’s network domain.

Hint: Click the Populate button to display a list of available Groups.

•  Enter or select a Group name. You can:

-manually enter a Group name in the Group Name: Group Name: Group Name: Group Name: field (for example, AUDIT - U.S.)

-click the PopulatePopulatePopulatePopulate button to display a list of available Groups, then select an available 
Group using the Group Name: Group Name: Group Name: Group Name: drop-down.

•  Use the Group Role:Group Role:Group Role:Group Role: drop-down to associate the Group with a role (i.e., Super Super Super Super 
AdminAdminAdminAdmin, AdminAdminAdminAdmin, Basic UserBasic UserBasic UserBasic User, View UserView UserView UserView User); for more information, see the DbProtect 
Administrator’s Guide.

4. In the User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies portion of the Add AppDetective Add AppDetective Add AppDetective Add AppDetective 
User or Group User or Group User or Group User or Group dialog box, highlight which Penetration Test and Audit 
Policies the Group can use (or un-highlight restricted Policies). 
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You can click the:

•  Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the Group can use 
(or un-highlight restricted Penetration Test Policies)

•  AuditAuditAuditAudit tab, and highlight which Audit Policies the Group can use (or un-highlight 
restricted Audit Policies).

5. Click the Add User or Group Add User or Group Add User or Group Add User or Group button to save your new Group.

The new Group displays in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.

Editing a Group Note:Note:Note:Note: If DbProtect Vulnerability Management does notnotnotnot run as a domain User, you 
must also add local (i.e., non-domain) Users.

To edit a Group: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page



DbProtect 6.1 User’s Guide

Application Security, Inc. 49

2. Do one of the following to display the Edit DbProtect AppDetective portal Edit DbProtect AppDetective portal Edit DbProtect AppDetective portal Edit DbProtect AppDetective portal 
Group Group Group Group dialog box:

•  Highlight a Group in the Organization Users and Groups Organization Users and Groups Organization Users and Groups Organization Users and Groups portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page, and choose Organizations and Users > Edit Organizations and Users > Edit Organizations and Users > Edit Organizations and Users > Edit 
User or Group User or Group User or Group User or Group from the menu

•  Right click a Group (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose EditEditEditEdit.

•  Double click a Group (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

FIGURE: Edit DbProtect AppDetective Console GroupEdit DbProtect AppDetective Console GroupEdit DbProtect AppDetective Console GroupEdit DbProtect AppDetective Console Group dialog box

3. Do the following:

•  Use the User Role:User Role:User Role:User Role: drop-down to associate the Group with a different role (i.e., 
Super AdminSuper AdminSuper AdminSuper Admin, AdminAdminAdminAdmin, Basic UserBasic UserBasic UserBasic User, View UserView UserView UserView User); for more information, see the 
DbProtect Administrator’s Guide.

•  In the lower portion of the Edit AppDetective Console Group Edit AppDetective Console Group Edit AppDetective Console Group Edit AppDetective Console Group dialog box, 
highlight which Penetration Test and Audit Policies the Group can use (or un-
highlight restricted Policies). 

You can click the:

-Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the Group can use (or un-
highlight restricted Penetration Test Policies)

-AuditAuditAuditAudit tab, and highlight which Audit Policies the Group can use (or un-highlight 
restricted Audit Policies).

4. Click the SaveSaveSaveSave button to save your edited Group.

The edited Group displays in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.
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Removing a Group To remove a Group: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

Organizations (in the Parent Organization portion of the Manage Organizations 

and Users page)

Users and Groups (in the Organization Users portion of the Manage 

Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Do one of the following:

•  Highlight a Group in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page, and choose Organizations and Users > Remove Organizations and Users > Remove Organizations and Users > Remove Organizations and Users > Remove 
User or GroupUser or GroupUser or GroupUser or Group from the menu

•  Right click the Group (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose RemoveRemoveRemoveRemove.

The Remove User? Remove User? Remove User? Remove User? or Remove Group?  Remove Group?  Remove Group?  Remove Group? pop up displays, accordingly, prompting you to 
confirm the removal.

FIGURE: Remove Group? Remove Group? Remove Group? Remove Group? pop up

Click the YesYesYesYes button to remove the Group.

The Group is removed from the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.
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Adding a User To add a User: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page
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2. Do one of the following to display the Add AppDetective User or Group 
dialog box:

•  Choose Organizations and Users > Add User or Group Organizations and Users > Add User or Group Organizations and Users > Add User or Group Organizations and Users > Add User or Group from the menu

•  Click the Add User or GroupAdd User or GroupAdd User or GroupAdd User or Group button in the Controls    portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page

•  Right click an Organization (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose Add UserAdd UserAdd UserAdd User.

FIGURE: Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group Add AppDetective User or Group dialog box

3. Do the following:

•  Use the Type:Type:Type:Type: drop-down to select UserUserUserUser.

•  Enter a User name in the User Name: User Name: User Name: User Name: field (for example, jsmith).

•  Use the User Domain:User Domain:User Domain:User Domain: drop-down to select the User’s network domain.

•  Use the User Role:User Role:User Role:User Role: drop-down to associate the User with a role (i.e., Super Super Super Super 
AdminAdminAdminAdmin, AdminAdminAdminAdmin, Basic UserBasic UserBasic UserBasic User, View UserView UserView UserView User); for more information, see the DbProtect 
Administrator’s Guide.
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•  In the User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies portion of the Add AppDetective User Add AppDetective User Add AppDetective User Add AppDetective User 
or Group or Group or Group or Group dialog box, highlight which Penetration Test and Audit Policies the 
User or Group can use (or un-highlight restricted Policies). 

You can click the:

-Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the User can use (or un-
highlight restricted Penetration Test Policies)

-AuditAuditAuditAudit tab, and highlight which Audit Policies the User can use (or un-highlight 
restricted Audit Policies).

4. Click the Add User or Group Add User or Group Add User or Group Add User or Group button to save your new User.

The new User displays in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page.

Editing a User Note:Note:Note:Note: If DbProtect Vulnerability Management does notnotnotnot run as a domain User, you 
must also add local (i.e., non-domain) Users.

To edit a User: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Do one of the following:

•  Highlight a User in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page, and choose Organizations and Users > Edit Organizations and Users > Edit Organizations and Users > Edit Organizations and Users > Edit 
User or Group User or Group User or Group User or Group from the menu
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•  Right click a User (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page) and choose EditEditEditEdit.

•  Double click a User (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

The Edit DbProtect Console User Edit DbProtect Console User Edit DbProtect Console User Edit DbProtect Console User dialog box displays.

FIGURE: Edit AppDetective Console User Edit AppDetective Console User Edit AppDetective Console User Edit AppDetective Console User dialog box

3. Use the User Role:User Role:User Role:User Role: drop-down to associate the User with a different User or 
Group type (i.e., Super AdminSuper AdminSuper AdminSuper Admin, AdminAdminAdminAdmin, Basic UserBasic UserBasic UserBasic User, View UserView UserView UserView User); for more 
information, see the DbProtect Administrator’s Guide.

4. In the User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies  User or Group Accessible Policies portion of the Edit AppDetective Edit AppDetective Edit AppDetective Edit AppDetective 
Console User Console User Console User Console User dialog box, highlight which Penetration Test and Audit 
Policies the User can use (or un-highlight restricted Policies). 

You can click the:

•  Pen TestPen TestPen TestPen Test tab, and highlight which Penetration Test Policies the User can use (or 
un-highlight restricted Penetration Test Policies)

•  AuditAuditAuditAudit tab, and highlight which Audit Policies the User can use (or un-highlight 
restricted Audit Policies).

5. Click the SaveSaveSaveSave button to save your edited User.

The edited User displays in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.

Removing a User To remove a User: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.
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The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Do one of the following:

•  Highlight a User in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page, and choose Organizations and Users > Remove Organizations and Users > Remove Organizations and Users > Remove Organizations and Users > Remove 
UserUserUserUser from the menu

•  Right click User (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page) and choose RemoveRemoveRemoveRemove.

The Remove User? Remove User? Remove User? Remove User? or Remove Group? Remove Group? Remove Group? Remove Group? pop up displays, prompting you to confirm the 
removal.

FIGURE: Remove User? Remove User? Remove User? Remove User? pop up

3. Click the YesYesYesYes button to remove the User.

The User is removed from the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page.



DbProtect 6.1 User’s Guide

Application Security, Inc. 56

Creating a
DbProtect Audit

and Threat
Management

Policy

You can create a DbProtect Audit and Threat Management Policy based on 
vulnerabilities detected in applications using DbProtect Vulnerability Management.

To create a DbProtect Audit and Threat Management Policy: 

1. Do one of the following to display the Manage Organizations and Users page:

•  Choose Admin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and UsersAdmin > Organizations and Users from the menu

•  Click the Organizations and Users Organizations and Users Organizations and Users Organizations and Users tab.

The Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page displays your existing:

•  Organizations (in the Parent OrganizationParent OrganizationParent OrganizationParent Organization portion of the Manage Organizations Manage Organizations Manage Organizations Manage Organizations 
and Users and Users and Users and Users page)

•  Users and Groups (in the Organization Users Organization Users Organization Users Organization Users portion of the Manage Manage Manage Manage 
Organizations and Users Organizations and Users Organizations and Users Organizations and Users page).

Hint: Highlight an Organization in the Parent Organization portion of the 

Manage Organizations and Users page to display its subordinate Users 

and Groups, and to activate the Control buttons and menu items.

FIGURE: Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page

2. Locate the AppRadar Policy AppRadar Policy AppRadar Policy AppRadar Policy Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more 
information, see Understanding the Manage Jobs page.

3. Click the AppRadar Policy AppRadar Policy AppRadar Policy AppRadar Policy button to display the AppRadar Policy AppRadar Policy AppRadar Policy AppRadar Policy 
GeneratorGeneratorGeneratorGenerator dialog box.

FIGURE: AppRadar Policy Generator AppRadar Policy Generator AppRadar Policy Generator AppRadar Policy Generator dialog box

4. Enter a DbProtect Audit and Threat Management Policy name in the Policy Policy Policy Policy 
Name: Name: Name: Name: field.
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5. Click the Generate Policy Generate Policy Generate Policy Generate Policy button.

DbProtect Vulnerability Management creates a DbProtect Audit and Threat 
Management Policy based on vulnerabilities detected in applications in your selected 
Organization. This new Policy is dynamically created on the PoliciesPoliciesPoliciesPolicies page in DbProtect 
Audit and Threat Management. You do notnotnotnot have to import the Policy.
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Customer Support
Customer SupportCustomer SupportCustomer SupportCustomer Support is available from 9 A.M. to 9 P.M. (GMT -5) Monday through

Friday, except for company holidays. You may contact technical support for the list of 
company holidays.

Extended support of 24x7 is available as an added cost. You may contact 
sales@appsecinc.com if you require this service.

Telephone (in the U.S.): 1-866-927-7732

Telephone (outside the U.S.): 1-212-912-4100

Email: support@appsecinc.com
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Vulnerability 
Management
DbProtect’s Vulnerability Management  Vulnerability Management  Vulnerability Management  Vulnerability Management Scan Engines discover database applications 
within your infrastructure and assesses their security strength. Backed by a proven 
security methodology and extensive knowledge of application-level vulnerabilities, 
DbProtect locates, examines, reports, and fixes security holes and misconfigurations.

DbProtect assesses your database vulnerabilities and customizes Policies based on 
each deployment’s unique parameters and requirements.

This chapter of the DbProtect User’s Guide discusses how to use the DbProtect DbProtect DbProtect DbProtect 
Vulnerability ManagementVulnerability ManagementVulnerability ManagementVulnerability Management UI to perform Vulnerability Management tasks on your 
enterprise database applications.

This section consists of the following chapters:

•  Understanding the DbProtect Vulnerability Management Portal User Interface 
(UI)

•  Vulnerability Management User Roles

•  Working with Jobs

•  Working with the Dashboard

•  Working with Scan Engines

•  Working with Policies

•  Working with Credential Profiles and User Credential Files

•  Working with Fix Scripts.
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Understanding the DbProtect 
Vulnerability Management 
Portal User Interface (UI)
This chapter consists of the following topics:

•  What is the DbProtect Vulnerability Management UI?

•  DbProtect Vulnerability Management UI components

•  Understanding the DbProtect Vulnerability Management UI menus.

What is the
DbProtect

Vulnerability
Management UI?

The DbProtect Vulnerability Management UIDbProtect Vulnerability Management UIDbProtect Vulnerability Management UIDbProtect Vulnerability Management UI is the web browser-based, graphical 
component of DbProtect that allows you to navigate to the various features of 
DbProtect Vulnerability Management.

The DbProtect Vulnerability Management UIDbProtect Vulnerability Management UIDbProtect Vulnerability Management UIDbProtect Vulnerability Management UI is comprised of the:

•  Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more information, see Understanding the Manage Jobs 
page

•  DashboardDashboardDashboardDashboard; for more information, see Understanding the Dashboard

•  Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users Manage Organizations and Users page (for Admins and Super Admins only); for 
more information, see Understanding the Manage Organizations and Users 
page

•  Scan EnginesScan EnginesScan EnginesScan Engines page (for Super Admins only); for more information, see 
Understanding the Scan Engines page.
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UNDERSTANDING THE MANAGE JOBS PAGE

The Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (shown below) allows you to create, schedule, run, filter, 
refresh, and delete Jobs. DbProtect Vulnerability Management allows you to run the 
following Job types: Audit, Penetration Test, Discovery, and Report.

For more information, see Working with Jobs.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

UNDERSTANDING THE DASHBOARD

The DashboardDashboardDashboardDashboard (shown below) displays detailed data about applications Discovered 
on your network, recent Penetration Tests and Audits performed, and the number of 
vulnerabilities detected.

For more information, see Working with the Dashboard.

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard
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UNDERSTANDING THE MANAGE ORGANIZATIONS AND 

USERS PAGE

The Manage Organizations and UsersManage Organizations and UsersManage Organizations and UsersManage Organizations and Users page (shown below) allows you to create logical 
and hierarchical Organizations (for example, AUDIT, RISK, PRIVATE BANKING, etc.). You 
can define a set of IP ranges and Policies for each Organization (which you can modify 
at the User or Group level). Your Organizations can be exclusive and isolated from 
other Organizations.

After you create Organizations, you can create subordinate UsersUsersUsersUsers and GroupsGroupsGroupsGroups. Users 
and Groups are Windows entities taken from either the Active Directory or your local 
system. You must explicitly add Users and Groups as DbProtect Vulnerability 
Management Users in order to authorize them to use DbProtect Vulnerability 
Management.

For more information, see Working with Scan Engines.

FIGURE: Organizations and Users Organizations and Users Organizations and Users Organizations and Users page

UNDERSTANDING THE SCAN ENGINES PAGE

The Scan EnginesScan EnginesScan EnginesScan Engines page (shown below) allows you to manage your installed and 
configured Scan Engines. Specifically, the Scan EnginesScan EnginesScan EnginesScan Engines page allows you to register 
(and unregister) your installed/configured Scan Engines, refresh the Scan Engine, 
monitor the “health” of your installed/configured/registered Scan Engines, or run an 
ASAP Update to obtain the latest Scan Engine software.

For more information, see Working with Scan Engines.

FIGURE: Scan Engines Scan Engines Scan Engines Scan Engines page
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DbProtect
Vulnerability

Management UI
components

A portion of the DbProtect Vulnerability Management UI (i.e., the DashboardDashboardDashboardDashboard) is shown 
below, with its parts labeled.

FIGURE: DbProtect Vulnerability Management UI components (example from the DashboardDashboardDashboardDashboard)

Every DbProtect Vulnerability Management UI page consists of the following 
components:

•  Tabs

•  Menus

•  Toolbars

•  Pane.

TABS

The tabstabstabstabs allow you to toggle between the DbProtect Vulnerability Management UI 
pages. The tabs are global, meaning they display no matter what DbProtect 
Vulnerability Management UI page you are on.

FIGURE: Tabs

Note:Note:Note:Note: The Organizations and UsersOrganizations and UsersOrganizations and UsersOrganizations and Users and Scan Engines Scan Engines Scan Engines Scan Engines tabs only displays for 
Super Users. For more information, see the DbProtect Administrator’s 
Guide.

 PaneToolbar

Menus Tabs
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MENUS

The menusmenusmenusmenus allow you to perform tasks such as creating Job templates (for Discovery, 
Penetration Test, Audit, and Report Jobs), managing Credential Profiles, configuring 
your Scan Engines, managing your Organizations and Users, etc. The menus are 
global, meaning they display no matter what DbProtect Vulnerability Management UI 
page you are on.

FIGURE: Menus

Note:Note:Note:Note: The AdminAdminAdminAdmin menu only displays for Super Users and Admin Users. For more 
information, see the DbProtect Administrator’s Guide.

For more information on the DbProtect Vulnerability Management UI menus, see 
Understanding the DbProtect Vulnerability Management Portal User Interface (UI).
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TOOLBARS

Depending which tab you click and page you select, the DbProtect Vulnerability 
Management UI displays a corresponding set of page-specific ToolbarsToolbarsToolbarsToolbars. The Toolbars 
allow you to perform such tasks as creating/running Jobs, refreshing and updating 
data on a page, registering Scan Engines, adding applications to Discover, manually 
refreshing a Scan Engine, setting the Scan Engine refresh rate, etc.

FIGURE: Toolbar (example from the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page)
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PANE

Depending which tab you click and page you select, the DbProtect Vulnerability 
Management UI displays a page-specific panepanepanepane. The pane displays your DbProtect 
Vulnerability Management data. 

For example, the DashboardDashboardDashboardDashboard pane (shown below) displays data about your networks, 
Discovered applications, last Penetration Test, etc.

FIGURE: Pane (example from the DashboardDashboardDashboardDashboard)

However, on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page, the pane is different (shown below). The pane on 
the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page consists of three portions (Job SetupJob SetupJob SetupJob Setup, Active JobsActive JobsActive JobsActive Jobs, and Job Job Job Job 
HistoryHistoryHistoryHistory), each of which contain different information about created/scheduled Jobs, 
active (i.e., currently-running) Jobs, and completed Jobs, respectively.

FIGURE: Pane (example from the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page)
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Understanding the
DbProtect

Vulnerability
Management UI

menus

The DbProtect Vulnerability Management UI consists of the following menusmenusmenusmenus:

•  File menu

•  Jobs menu

•  Admin menu

Note:Note:Note:Note: The AdminAdminAdminAdmin menu only displays for DbProtect Super Admins, DbProtect 
Admins, and Vulnerability Management Admins.

FILE MENU

From the FileFileFileFile menu, you can choose:

•  File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager to view and modify your Organization’s Audit 
credentials; for more information, see Setting and testing your database and 
operating system credentials.

JOBS MENU

From the JobsJobsJobsJobs menu, you can choose:

•  Jobs > Templates > New DiscoveryJobs > Templates > New DiscoveryJobs > Templates > New DiscoveryJobs > Templates > New Discovery to create a new Discovery Job; for more 
information, see Discovery Jobs.

•  Jobs > Templates > New AuditJobs > Templates > New AuditJobs > Templates > New AuditJobs > Templates > New Audit to create a new Audit Job; for more 
information, see Audit Jobs.

•  Jobs > Templates > New PentestJobs > Templates > New PentestJobs > Templates > New PentestJobs > Templates > New Pentest to create a new Penetration Test Job; for 
more information, see Penetration Test Jobs.

•  Jobs > Templates > New Report Jobs > Templates > New Report Jobs > Templates > New Report Jobs > Templates > New Report to create a new Report Job; for more 
information, see Report Jobs.

•  Jobs > ManageJobs > ManageJobs > ManageJobs > Manage to view, schedule, and apply filters to your Discovery, 
Penetration Test, Audit, and Report Jobs; for more information, see Working 
with Jobs.

ADMIN MENU

Note:Note:Note:Note: The AdminAdminAdminAdmin menu item only displays for Super Users and Admin Users; for 
more information, see the DbProtect Administrator’s Guide.

From the AdminAdminAdminAdmin menu, you can choose:

•  Admin > Dashboard Admin > Dashboard Admin > Dashboard Admin > Dashboard to display the DashboardDashboardDashboardDashboard; for more information, see 
Working with the Dashboard

•  Admin > Organizations and Users Admin > Organizations and Users Admin > Organizations and Users Admin > Organizations and Users to display the Organizations and UsersOrganizations and UsersOrganizations and UsersOrganizations and Users page; 
for more information, see Working with Scan Engines

•  Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines to display the Select Scan Engine Select Scan Engine Select Scan Engine Select Scan Engine page and view 
information about your registered Scan Engines; for more information, see 
Working with Scan Engines.
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Vulnerability Management 
User Roles
For information on Vulnerability Management user rolesVulnerability Management user rolesVulnerability Management user rolesVulnerability Management user roles, and all other roles (and 
associated privileges) in DbProtect, see DbProtect Organizations, Users, and User 
Roles in the DbProtect Organizations, Users, and User Roles section of this guide.
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Working with Jobs
This chapter consists of the following topics:

•  What are Jobs?

•  Understanding the Manage Jobs page

•  Discovery Jobs

•  Penetration Test Jobs

•  Audit Jobs

•  Report Jobs

•  “Run Job Now”

•  Editing a Job

•  Scheduling a Job

•  Unscheduling a Job

•  Viewing a completed Report

•  Saving a completed Report

•  Filtering Jobs

•  Filtering Job history

•  Deleting a set up Job

•  Purging a completed Job

•  Cancelling an active Job

•  Deleting an application to Discover

•  Viewing Job details

•  Viewing the properties of a completed Job

•  Viewing individual vulnerabilities detected during an Audit

•  Setting the refresh rate of data on the Manage Jobs page

•  Manually refreshing data on the Manage Jobs Page

•  Scheduling email notification upon Job completion.
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What are Jobs? DbProtect Vulnerability Management allows you to create and schedule any of the 
following types of JobsJobsJobsJobs. They are:

•  Discovery Jobs. Discovery Jobs. Discovery Jobs. Discovery Jobs. A Discovery locates applications on your network, and 
identifies the applications' IP addresses (as well as ports used to provide 
network services). For more information, see Discovery Jobs.

•  Penetration Test Jobs and Audit Jobs. Penetration Test Jobs and Audit Jobs. Penetration Test Jobs and Audit Jobs. Penetration Test Jobs and Audit Jobs. Penetration Tests assess the security of 
your applications by running security checks (based on a Policy you choose). 
Penetration Tests perform a non-authenticated but non-intrusive test against 
your applications. They also commonly uncover misconfiguration errors, in 
addition to well-known application vulnerabilities.

Audits test the security of your applications (which requires system credentials 
on databases such as Oracle). The Audit checks your Discovered applications 
for password configurations, table access, User roles, and other vulnerabilities.

For more information, see Penetration Test Jobs and Audit Jobs.

•  You can install the Scan Engine on the same server as the DbProtect Console, 
where the Scan Engine (by default) can run a maximum of three Penetration 
Tests and Audits concurrently. Or, you can install the Scan Engine on a remote 
server, where the Scan Engine (by default) can run a maximum of 10 Penetration 
Tests and Audits concurrently. You can modify these default values, post-
installation; for more information, see Editing a Scan Engine.

•  Report Jobs.Report Jobs.Report Jobs.Report Jobs. These are designed to communicate vulnerabilities Discovered by 
DbProtect Vulnerability Management to all levels of your Organization. For 
more information, see Report Jobs.
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Understanding the
Manage Jobs page

The Manage Jobs Manage Jobs Manage Jobs Manage Jobs page is shown below.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

The pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page is divided into three portions:

•  Job Setup.Job Setup.Job Setup.Job Setup. The columns in this portion of the pane display the following 
information about set up Jobs:

----Job Name. Job Name. Job Name. Job Name. The name of the set up Discovery, Penetration Test, Audit, or Report Job.

----Job Type. Job Type. Job Type. Job Type. The type of the set up Job (i.e., DiscoveryDiscoveryDiscoveryDiscovery, Penetration Test,Penetration Test,Penetration Test,Penetration Test, AuditAuditAuditAudit, or 
ReportReportReportReport).

-Policy. Policy. Policy. Policy. The Policy associated with the Job; for more information, see Working with 

Policies.

----Last Modifier. Last Modifier. Last Modifier. Last Modifier. The ID of the last person to modify the set up Discovery, Penetration 
Test, Audit, or Report Job.

----Frequency. Frequency. Frequency. Frequency. The frequency of the set up Discovery, Penetration Test, Audit, or Report 
Job (i.e., DailyDailyDailyDaily, WeeklyWeeklyWeeklyWeekly, MonthlyMonthlyMonthlyMonthly, etc.).

----Next Run Time. Next Run Time. Next Run Time. Next Run Time. The next scheduled run time of the set up Discovery, Penetration Test, 
Audit, or Report Job.

•  Active Jobs.Active Jobs.Active Jobs.Active Jobs. The columns in this portion of the pane display the following 
information about active Jobs:

----Job Name. Job Name. Job Name. Job Name. The name of the active Discovery, Penetration Test, Audit, or Report Job.

----Job Type. Job Type. Job Type. Job Type. The type of the active Job (i.e., DiscoveryDiscoveryDiscoveryDiscovery, Penetration Test,Penetration Test,Penetration Test,Penetration Test, AuditAuditAuditAudit, or 
ReportReportReportReport).

----Last Modifier. Last Modifier. Last Modifier. Last Modifier. The ID of the last person to modify the active Discovery, Penetration 
Test, Audit, or Report Job.

----Start Date. Start Date. Start Date. Start Date. The date the active Job started.

----% Completed. % Completed. % Completed. % Completed. The completion percentage of the active Job as it processes.
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----Comments. Comments. Comments. Comments. If you cancel a Job, this column displays a cancellation message. 
Otherwise, this column remains blank.

•  Job History.Job History.Job History.Job History. The columns in this portion of the pane display the following 
information about completed Jobs:

----Job Name. Job Name. Job Name. Job Name. The name of the completed Discovery, Penetration Test, Audit, or Report 
Job.

----Job Type. Job Type. Job Type. Job Type. The type of completed Job (i.e., DiscoveryDiscoveryDiscoveryDiscovery, Penetration Test,Penetration Test,Penetration Test,Penetration Test, AuditAuditAuditAudit, or 
ReportReportReportReport).

----Last Modifier. Last Modifier. Last Modifier. Last Modifier. The ID of the last person to modify the completed Discovery, 
Penetration Test, Audit, or Report Job.

----Start Date. Start Date. Start Date. Start Date. The date the completed Job started.

----End Date. End Date. End Date. End Date. The date the completed Job finished.

----Job Status. Job Status. Job Status. Job Status. The status of the completed Job (i.e., CompletedCompletedCompletedCompleted, CanceledCanceledCanceledCanceled, FailedFailedFailedFailed, and 
Click for detailsClick for detailsClick for detailsClick for details).

Note:Note:Note:Note: For more information on the pane and other DbProtect Vulnerability 
Management UI components, see Understanding the DbProtect 
Vulnerability Management Portal User Interface (UI).

Specifically, the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page allows you to:

•  createcreatecreatecreate Discovery, Audit, Penetration Test, and Report Jobs; for more 
information, see Creating a Discovery Job, Creating an Audit Job, Creating a 
Penetration Test Job, and Creating a Report Job, respectively

•  editediteditedit Jobs; for more information, see Editing a Job

•  runrunrunrun a Job now; for more information, see “Run Job Now”

•  scheduleschedulescheduleschedule Jobs; for more information, see Scheduling a Job

•  view view view view and savesavesavesave completed Reports for any type of Job; for more information, see 
Viewing a completed Report and Saving a completed Report, respectively

•  filterfilterfilterfilter Jobs and Job history; for more information, see Filtering Jobs and 
Filtering Job history, respectively

•  deletedeletedeletedelete a set up Job; for more information, see Deleting a set up Job

•  cancelcancelcancelcancel an active Job; for more information, see Cancelling an active Job

•  purgepurgepurgepurge a completed Job; for more information, see Purging a completed Job

•  view the details details details details of an active or completed Job; for more information, see 
Viewing Job details

•  view the properties properties properties properties of a completed Job; for more information, see Viewing the 
properties of a completed Job

•  set the Manage JobsManage JobsManage JobsManage Jobs page data refresh raterefresh raterefresh raterefresh rate; for more information, see Setting 
the refresh rate of data on the Manage Jobs page

•  manually refresh refresh refresh refresh the data on the Manage JobsManage JobsManage JobsManage Jobs page; for more information, see 
Manually refreshing data on the Manage Jobs Page

•  schedule email notificationemail notificationemail notificationemail notification upon Job completion; for more information, see 
Scheduling email notification upon Job completion.
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Discovery Jobs This topic consists of the following sub-topics:

•  What is a Discovery Job?

•  Manually Adding Oracle SIDs and DB2 Databases to Discover

•  Creating a Discovery Job.

WHAT IS A DISCOVERY JOB?

When DbProtect Vulnerability Management performs a Discovery JobDiscovery JobDiscovery JobDiscovery Job, it:

•  locates applications on your network

•  identifies the applications’ IP addresses (as well as ports used to provide 
network services).

Note:Note:Note:Note: Discovery does notnotnotnot identify vulnerabilities. This is the function of 
Penetration Tests and Audits. For more information, see What is a 
Penetration Test? and What is an Audit?, respectively.

MANUALLY ADDING ORACLE SIDS AND DB2 DATABASES TO 

DISCOVER

When you run an Oracle Discovery, DbProtect only detects the Oracle Listener (unless 
you specified a listener password during Scan Engine installation; for more 
information, see the DbProtect Installation Guide). In order to run an Audit on a 
Discovered Oracle database, the Oracle SID mustmustmustmust display in the DashboardDashboardDashboardDashboard. 
Therefore, in most cases, you must manually add the Oracle SID to the DashboardDashboardDashboardDashboard 
before you run an Audit.

The same is true for running an Audit Jobs on DB2. When you run a DB2 Discovery, 
DbProtect only detects the DB2 instance. In order to run an Audit on a Discovered 
DB2 database, the DB2 database mustmustmustmust display in the DashboardDashboardDashboardDashboard. Therefore, in most 
cases, you must manually add the DB2 database to the Dashboard by following the 
steps in this topic.

For more information on:

•  running an Audit Job, see Audit Jobs

•  running a Penetration Test Job, see Penetration Test Jobs

•  manually adding an application to Discover, see Adding an application to 
Discover.
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CREATING A DISCOVERY JOB

To create a Discovery Job:

1. Do one of the following to display the Discovery Job Template dialog box:

•  Choose Jobs > Templates > New Discovery Jobs > Templates > New Discovery Jobs > Templates > New Discovery Jobs > Templates > New Discovery from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab, and choose New Job > New DiscoveryNew Job > New DiscoveryNew Job > New DiscoveryNew Job > New Discovery in the Job Job Job Job 
Setup OptionsSetup OptionsSetup OptionsSetup Options Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more information, see 
Toolbars.

FIGURE: Discovery Job TemplateDiscovery Job TemplateDiscovery Job TemplateDiscovery Job Template dialog box

2. In the Job Name: Job Name: Job Name: Job Name: portion of the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box:

•  Enter the name of your new Discovery Job in the Name: Name: Name: Name: field (required).

•  Click the Load IPs and Ports from file... Load IPs and Ports from file... Load IPs and Ports from file... Load IPs and Ports from file... button to display an OpenOpenOpenOpen dialog box 
and upload a standard, comma-delimited text file. You can use any of the 
following formats:

-ip (for example, 192.168.1.1)

-ip, port (for example, 192.168.1.1, 8080)
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-ip-ip (for example, 192.168.1.1-192.168.1.255)

-ip-ip,port (for example, 192.168.1.1-192.168.1.255, 8080)

-Classless Inter Domain Routing (CIDR) notation, i.e., ip/network prefix (for 
example, 192.9.205.22/18); for more information on CIDR notation, see http://
infocenter.guardiandigital.com/manuals/IDDS/node9.html

Caution! When running a Discovery for IBM DB2 (using either file 

identification method described above), you must include the 

DB2 Administration Server (DAS) port (523 by default) to ensure 

DbProtect Vulnerability Management will Discover all databases. 

Otherwise, DbProtect Vulnerability Management will only 

Discover the default databases (i.e. SAMPLE).

Note:Note:Note:Note: The DbProtect Vulnerability Management does notnotnotnot support NMAP. 
However, AppDetectivePro doesdoesdoesdoes support NMAP; for more information, 
see the AppDetectivePro User’s Guide.

3. In the IP Range  IP Range  IP Range  IP Range portion of the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box:

•  Specify the IP addresses you want to includeincludeincludeinclude (and excludeexcludeexcludeexclude) in your Discovery. 

If you want to specify IP addresses to includeincludeincludeinclude in your Discovery, then: 

-Manually enter the host name of the machine where you want to perform a Discovery 
in the Hostname:Hostname:Hostname:Hostname: field.

-Click the AddAddAddAdd button.

-Select Include RangeInclude RangeInclude RangeInclude Range.

If you want to specify IP addresses to excludeexcludeexcludeexclude from your Discovery, then:

-Manually enter the host name of the machine where you want to perform a Discovery 
in the Hostname:Hostname:Hostname:Hostname: field.

-Click the AddAddAddAdd button.

-Select Exclude RangeExclude RangeExclude RangeExclude Range.

•  Optionally, you can highlight one or more individual IP address ranges from the 
include/exclude list, and click the RemoveRemoveRemoveRemove button to remove them.

Hint: Click <CTRL> to highlight non-sequential IP address ranges.

4. In the Port Range  Port Range  Port Range  Port Range portion of the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box:

•  Check Use Default PortsUse Default PortsUse Default PortsUse Default Ports if you want DbProtect Vulnerability Management to 
probe standard default installation ports for applications (that you mustmustmustmust select 
below). For example, SQL Server is installed, by default, on port 1433. Oracle is 
installed, by default, on port 1521.

•  Check one or more of the following application types to Discover:

----IBM DB2 for MainframeIBM DB2 for MainframeIBM DB2 for MainframeIBM DB2 for Mainframe

----IBM DB2 Universal DatabaseIBM DB2 Universal DatabaseIBM DB2 Universal DatabaseIBM DB2 Universal Database

----Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server

----Lotus DominoLotus DominoLotus DominoLotus Domino
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----MySQLMySQLMySQLMySQL

----Sybase Advance Server EnterpriseSybase Advance Server EnterpriseSybase Advance Server EnterpriseSybase Advance Server Enterprise

-OracleOracleOracleOracle.

5. Auto-generate a Report upon completion of your Discovery Job.

The Report GenerationReport GenerationReport GenerationReport Generation portion of the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box allows you 
to automatically generate an Application Inventory Application Inventory Application Inventory Application Inventory Report upon completion of your 
Discovery Job. For more information on Report types, see Report types.

FIGURE: Report GenerationReport GenerationReport GenerationReport Generation section of the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box

If you want to use the Report auto-generation feature, do the following:

•  Check the Enable Auto ReportEnable Auto ReportEnable Auto ReportEnable Auto Report checkbox in the Report GenerationReport GenerationReport GenerationReport Generation portion of 
the Discovery Job Template Discovery Job Template Discovery Job Template Discovery Job Template dialog box. The Job History Job History Job History Job History portion of the pane 
displays the status of your auto Report Job after your Discovery Job completes. 
The format that displays is: "for JOB_TYPE JOB_NAME [ran at 11/29/2007 
12:23:20]"

•  Use the Report type drop-down to select an Application Inventory Application Inventory Application Inventory Application Inventory Report for 
auto-generation upon completion of your Discovery Job; for more information 
on Report types, see Report types.

•  Use the Report FormatReport FormatReport FormatReport Format drop-down to select whether you want to auto-generate 
your Report in any of the following formats:

----HTML - Single FileHTML - Single FileHTML - Single FileHTML - Single File

----TextTextTextText

----XMLXMLXMLXML

-PDFPDFPDFPDF.

For more information on Report formats, see Report formats.

If you use the Report auto-generation feature to generate a Report for a Discovery 
Job, you can:

•  view the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Viewing a completed Report

•  save the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Saving a completed Report.

6. Click the SaveSaveSaveSave button to save your Discovery Job.

7. You can:

•  run the Discovery Job now; for more information, see “Run Job Now”

•  schedule the Discovery Job to run later; for more information, see Scheduling a 
Job.
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8. After your Discovery Job completes, you can:

•  view the completed Job details; for more information, see Viewing Job details

•  view the completed Job properties; for more information, see Viewing the 
properties of a completed Job.

Penetration Test
Jobs

This topic consists of the following sub-topics:

•  What is a Penetration Test?

•  Manually Adding Oracle SIDs and DB2 Databases to Discover (Pre-Penetration 
Test)

•  What Does a Penetration Test Do to My System?

•  Creating a Penetration Test Job.

WHAT IS A PENETRATION TEST?

A Penetration Penetration Penetration Penetration (Pen) TestTestTestTest assesses the security of your applications by running security 
checks (based on a Policy you choose). Penetration Tests:

•  are run from an “outside-in” perspective

•  gives a good analysis of what a hacker or intruder might discover when 
attempting to bypass your application’s defenses

•  commonly uncover misconfiguration errors in addition to well-known 
application vulnerabilities.

This section explains how to create Penetration Test and Audit Jobs using DbProtect 
Vulnerability Management. Penetration Tests may only be performed after you have 
performed a Discovery Job.

MANUALLY ADDING ORACLE SIDS AND DB2 DATABASES TO 

DISCOVER (PRE-PENETRATION TEST)

When you run an Oracle Discovery, DbProtect only detects the Oracle Listener (unless 
you specified a listener password during Scan Engine installation; for more 
information, see the DbProtect Installation Guide). In order to run a Penetration Test 
(or an Audit) on a Discovered Oracle database, the Oracle SID mustmustmustmust display in the 
DashboardDashboardDashboardDashboard. Therefore, in most cases, you must manually add the Oracle SID to the 
DashboardDashboardDashboardDashboard before you run a Penetration Test (or an Audit).

The same is true for running Penetration Test (or an Audit) Jobs on DB2. When you run 
a DB2 Discovery, DbProtect only detects the DB2 instance. In order to run a 
Penetration Test (or an Audit) Job against a Discovered DB2 database, the DB2 
database mustmustmustmust display in the DashboardDashboardDashboardDashboard. Again, in most cases, you must manually add 
the DB2 database to the DashboardDashboardDashboardDashboard before you run a Penetration Test (or an Audit).



DbProtect 6.1 User’s Guide

Application Security, Inc. 78

For more information on:

•  running a Discovery Job, see Discovery Jobs

•  running an Audit Job, see Audit Jobs

•  manually adding an application to Discover, see Adding an application to 
Discover.

WHAT DOES A PENETRATION TEST DO TO MY SYSTEM?

A Penetration Test externally probes your database. Inherent to this activity is 
anonymous querying of network services for a variety of information. The User running 
DbProtect Vulnerability Management does notnotnotnot provide a username or password, so 
nothing is used to actually connect to -- or authenticate to -- your system.

During the course of a Penetration Test, DbProtect Vulnerability Management can run 
tests which may result in acquiring a valid username and password that attackers can 
potentially use to authenticate to the application. In such cases, DbProtect 
Vulnerability Management performs the authentication in order to gather additional 
information from the application. It may connect to the database and gather username 
and password hashes, or configuration values. A Penetration Test does notnotnotnot make any 
updates or changes to your database. It may, however, read data such as the password 
hashes from the system.
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CREATING A PENETRATION TEST JOB

To create a Penetration Test Job:

1. Do one of the following to display the Pen Test Template Editor dialog box:

•  Choose Jobs > Templates > New Pentest Jobs > Templates > New Pentest Jobs > Templates > New Pentest Jobs > Templates > New Pentest from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab, and choose New Job > New Pentest New Job > New Pentest New Job > New Pentest New Job > New Pentest in the Job Job Job Job 
Setup OptionsSetup OptionsSetup OptionsSetup Options Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more information, see 
Toolbars.

FIGURE: Pen Test Template Editor Pen Test Template Editor Pen Test Template Editor Pen Test Template Editor dialog box

2. In the Template Name Template Name Template Name Template Name portion of the Pen Test Template EditorPen Test Template EditorPen Test Template EditorPen Test Template Editor dialog box, 
enter the name of your new Penetration Test Job in the Name: Name: Name: Name: field.

3. In the Policy Policy Policy Policy portion of the Pen Test Template EditorPen Test Template EditorPen Test Template EditorPen Test Template Editor dialog box, use the 
Select Policy:Select Policy:Select Policy:Select Policy: drop-down to select your Penetration Test Policy.
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4. Pick Applications to Penetration Test.

Click the Add Application(s)...Add Application(s)...Add Application(s)...Add Application(s)... button to display the Application PickerApplication PickerApplication PickerApplication Picker, which allows 
you to select which applications you want to Penetration Test.

FFFFIIIIGGGGUUUURRRREEEE: : : : Application PickerApplication PickerApplication PickerApplication Picker

You can check:

•  the NetworkNetworkNetworkNetwork checkbox to select all IPs (and subordinate subnets and 
applications) on a network

•  a subnetsubnetsubnetsubnet checkbox to select all subordinate host and applications within a 
subnet (e.g., 192.168.1.0/24192.168.1.0/24192.168.1.0/24192.168.1.0/24)

•  a hosthosthosthost checkbox to select all subordinate applications within a host (e.g., 
192.168.1.23 testing192.168.1.23 testing192.168.1.23 testing192.168.1.23 testing)

•  an individual applicationapplicationapplicationapplication beneath a parent host (e.g., Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server 
2000200020002000).

Hint: Click the + icons to display subordinate subnets and applications.

5. Click the AddAddAddAdd button to close the Application PickerApplication PickerApplication PickerApplication Picker. Your selected 
networks, subnets, hosts, and applications display in the Pen Test Template Pen Test Template Pen Test Template Pen Test Template 
EditorEditorEditorEditor dialog box.

FIGURE: Selected networks, subnets, hosts, and applications in the Pen Test Template EditorPen Test Template EditorPen Test Template EditorPen Test Template Editor 
dialog box
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For each application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, the following fields 
display:

•  The IncludeIncludeIncludeInclude drop-down, which allows you to select whether to IncludeIncludeIncludeInclude or 
ExcludeExcludeExcludeExclude the application in your Penetration Test Job. (IncludeIncludeIncludeInclude selected by 
default.)

•  The IP Address IP Address IP Address IP Address of your selected application (if applicable).

•  The Hostname Hostname Hostname Hostname of your selected application (if applicable).

•  The TypeTypeTypeType of application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, i.e., AppAppAppApp, 
SubnetSubnetSubnetSubnet, HostHostHostHost, NetworkNetworkNetworkNetwork.

•  The Add Filter Add Filter Add Filter Add Filter button under the App Type App Type App Type App Type column, which you can click to 
display the Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker pop up (shown below).

FFFFIIIIGGGGUUUURRRREEEE: : : : Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker

The Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker pop up allows you to filter which application types you 
want to filter from Penetration Testing at the network, subnet, or host level. (Does notnotnotnot 
apply at the application level.)

For example, if you used the Application PickerApplication PickerApplication PickerApplication Picker in Step 4 to select the subnet 
192.168.1.1/50192.168.1.1/50192.168.1.1/50192.168.1.1/50, and you want to exclude all Auditing of Oracle Database applications, 
then you can uncheck the Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database checkbox in the Application PickerApplication PickerApplication PickerApplication Picker to filter 
Penetration Testing of Oracle in this particular Penetration Test Job.

•  The Port Port Port Port number of your selected application (if applicable)

•  The Instance Instance Instance Instance name of your selected application (if applicable).

6. Auto-generate a Report upon completion of your Penetration Test Job.

The Report GenerationReport GenerationReport GenerationReport Generation portion of the Pen Test Template EditorPen Test Template EditorPen Test Template EditorPen Test Template Editor dialog box allows you 
to automatically generate a Vulnerability DetailsVulnerability DetailsVulnerability DetailsVulnerability Details or Vulnerability SummaryVulnerability SummaryVulnerability SummaryVulnerability Summary Report 
upon completion of your Penetration Test Job. For more information on Report types, 
see Report types.

FIGURE: Report GenerationReport GenerationReport GenerationReport Generation section of the Pen Test Template EditorPen Test Template EditorPen Test Template EditorPen Test Template Editor dialog box
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If you want to use the Report auto-generation feature, do the following:

•  Check the Enable Auto ReportEnable Auto ReportEnable Auto ReportEnable Auto Report checkbox in the Report GenerationReport GenerationReport GenerationReport Generation portion of 
the Pen Test Template Editor Pen Test Template Editor Pen Test Template Editor Pen Test Template Editor dialog box. The Job History Job History Job History Job History portion of the pane 
displays the status of your auto Report Job after your Penetration Test Job 
completes. The format that displays is: "for JOB_TYPE JOB_NAME [ran at 11/
29/2007 12:23:20]".

•  Use the Report type drop-down to select whether you want to auto-generate a 
Vulnerability DetailsVulnerability DetailsVulnerability DetailsVulnerability Details or Vulnerability SummaryVulnerability SummaryVulnerability SummaryVulnerability Summary Report upon completion of your 
Penetration Test Job; for more information on Report types, see Report types.

•  Use the Report FormatReport FormatReport FormatReport Format drop-down to select whether you want to auto-generate 
your Report in any of the following formats:

----HTML - Single FileHTML - Single FileHTML - Single FileHTML - Single File

----TextTextTextText

----XMLXMLXMLXML

-PDFPDFPDFPDF.

For more information on Report formats, see Report formats.

If you use the Report auto-generation feature to generate a Report for a Penetration 
Test Job, you can:

•  view the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Viewing a completed Report

•  save the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Saving a completed Report.

7. Click the SaveSaveSaveSave button to save your Penetration Test Job.

8. You can:

•  run the Penetration Test Job now; for more information, see “Run Job Now”

•  schedule the Penetration Test Job to run later; for more information, see 
Scheduling a Job.

9. After your Penetration Test Job completes, you can:

•  view the completed Job details; for more information, see Viewing Job details

•  view the completed Job properties; for more information, see Viewing the 
properties of a completed Job.
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Audit Jobs This topic consists of the following sub-topics:

•  What is an Audit?

•  Manually Adding Oracle SIDs and DB2 Databases to Discover (Pre-Audit)

•  Windows OS Audit Check Requirements

•  UNIX OS Audit Check Requirements

•  IBM DB2 z/OS Considerations

•  Running an Audit Using Currently Logged-On Windows User Credentials 
(Instead of Oracle Database User Credentials)

•  DISA Check Requirements

•  Required Open Ports on Machines Running Microsoft SQL Server

•  Auditing Multiple Database Instances on a Single Host

•  Important Pre-Audit Security Consideration

•  Auditing Microsoft SQL Server (Using Windows Authentication) Against a 
Machine on a Different or Untrusted Domain

•  Creating an Audit Job.

WHAT IS AN AUDIT?

An AuditAuditAuditAudit tests the security of your application using an “inside out” approach. Audits 
require that you already have access to a system, such as Oracle. In accordance with 
your associated Policies, an Audit checks your Discovered applications for password 
configurations, table access, User roles, and other vulnerabilities.

Note:Note:Note:Note: In order to Audit DB2, Sybase, or Lotus Notes/Domino applications, you 
mustmustmustmust have a working client installed. For more information, see the 
DbProtect Installation Guide.

MANUALLY ADDING ORACLE SIDS AND DB2 DATABASES TO 

DISCOVER (PRE-AUDIT)

When you run an Oracle Discovery, DbProtect only detects the Oracle Listener (unless 
you specified a listener password during Scan Engine installation; for more 
information, see the DbProtect Installation Guide). In order to run an Audit (or a 
Penetration Test) on a Discovered Oracle database, the Oracle SID mustmustmustmust display in the 
DashboardDashboardDashboardDashboard. Therefore, in most cases, you must manually add the Oracle SID to the 
DashboardDashboardDashboardDashboard before you run an Audit (or a Penetration Test).

The same is true for running an Audit (or a Penetration Test) Jobs on DB2. When you 
run a DB2 Discovery, DbProtect only detects the DB2 instance. In order to run an Audit 
(or a Penetration Test) Job against a Discovered DB2 database, the DB2 database 
mustmustmustmust display in the DashboardDashboardDashboardDashboard. Again, in most cases, you must manually add the DB2 
database to the DashboardDashboardDashboardDashboard before you run an Audit (or a Penetration Test).
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For more information on:

•  running a Discovery Job, see Discovery Jobs

•  running a Penetration Test Job, see Penetration Test Jobs

•  manually adding an application to Discover, see Adding an application to 
Discover.

WINDOWS OS AUDIT CHECK REQUIREMENTS

DbProtect Vulnerability Management performs Windows OS checks via Windows 
authentication. Make sure the DbProtect Scan Engine service where you are running 
DbProtect Vulnerability Management has the appropriate permissions for the 
following checks:

•  Not Using NTFS Partition. Not Using NTFS Partition. Not Using NTFS Partition. Not Using NTFS Partition. Permission to read the installation disk type.

•  Registry Permissions.Registry Permissions.Registry Permissions.Registry Permissions. Remote registry access.

•  Service Runs as Local System.Service Runs as Local System.Service Runs as Local System.Service Runs as Local System. Permission to list the system services.

•  Permissions on Files. Permissions on Files. Permissions on Files. Permissions on Files. Permission to read files in the installation directory of the 
database.

The Scan Engine uses the credentials it is running as to run these checks. For more 
information on:

•  services, see the DbProtect Administrator’s Guide

•  Scan Engines, see Working with Scan Engines.

UNIX OS AUDIT CHECK REQUIREMENTS

DbProtect Vulnerability Assessment performs Unix OS checks via a Telnet or SSH 
account. Your account mustmustmustmust have the appropriate read and directory listing 
permissions activated on the database installation and running directories.

If you run the following 
checks:

Then you must have permission to:

Permissions on FilesPermissions on FilesPermissions on FilesPermissions on Files List files in the installation directories of the database.

Setgid Bit EnabledSetgid Bit EnabledSetgid Bit EnabledSetgid Bit Enabled

Setuid Bit EnabledSetuid Bit EnabledSetuid Bit EnabledSetuid Bit Enabled
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Properly-Configured Environment VariablesProperly-Configured Environment VariablesProperly-Configured Environment VariablesProperly-Configured Environment Variables

DbProtect Vulnerability Assessment can Audit platforms that use system variables to 
specify the location of the database instances. In UNIX, you must set the environment 
variables correctly in order to use SSH or Telnet to access the accounts. Specific 
requirements follow.

IBM DB2 Z/OS CONSIDERATIONS

When you run an Audit with password checks against an IBM DB2 z/OS database, 
accounts can be locked outaccounts can be locked outaccounts can be locked outaccounts can be locked out. The Scan Engine PropertiesPropertiesPropertiesProperties dialog box allows you to 
select which security option DbProtect Vulnerability Assessment should use to 
authenticate an IBM DB2 z/OS application. You can select:

•  Use authentication value in server’s DBM configurationUse authentication value in server’s DBM configurationUse authentication value in server’s DBM configurationUse authentication value in server’s DBM configuration

•  Client authenticationClient authenticationClient authenticationClient authentication

•  Server authenticationServer authenticationServer authenticationServer authentication

•  Server authentication with encryptionServer authentication with encryptionServer authentication with encryptionServer authentication with encryption

•  DDCS authenticationDDCS authenticationDDCS authenticationDDCS authentication

•  DDCS authentication with encryptionDDCS authentication with encryptionDDCS authentication with encryptionDDCS authentication with encryption.

For more information, see Configuring the properties of a Scan Engine.

In addition, you mustmustmustmust enable sysproc.dsnwzp on your target server or the following 
IBM DB2 z/OS Audit checks fail:

•  Dual logging not enabledDual logging not enabledDual logging not enabledDual logging not enabled

•  Audit Trace is not set to start automaticallyAudit Trace is not set to start automaticallyAudit Trace is not set to start automaticallyAudit Trace is not set to start automatically

•  SMF accounting is not set to start automaticallySMF accounting is not set to start automaticallySMF accounting is not set to start automaticallySMF accounting is not set to start automatically

•  Dual archiving not enabledDual archiving not enabledDual archiving not enabledDual archiving not enabled

The sysproc.dsnwzp stored procedure is notnotnotnot enabled by default when you install IBM 
DB2 z/OS, but it should be enabled if you properly performed maintenance hold data 
actions.

If you want to Audit the 
following platform:

Then you must:

Oracle Make sure the $ORACLE_HOME variable is correct.

Sybase Make sure the $SYBASE variable is correct.

MySQL Define a datadir or basedir variable to point to the 
database root.
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RUNNING AN AUDIT USING CURRENTLY LOGGED-ON 

WINDOWS USER CREDENTIALS (INSTEAD OF ORACLE 

DATABASE USER CREDENTIALS)

To perform an Audit using currently logged-on Windows user credentials (instead of 
Oracle database user credentials) make sure:

•  your target Oracle server is configured for NTS authentication (check the server 
file sqlnet.ora to verify)

•  the local user on the DbProtect machine has the same user name and password 
as the one on the target machine

•  the user on remote machine is member of local ORA_DBA Windows group 
(required to connect as SYSDBA)

•  create file \network\admin\sqlnet.ora under DbProtect’s installation 
directory contains the following line: 
sqlnet.authentication_services=(NTS).

If you have an Oracle client or database installed on your DbProtect machine, make 
sure the ORACLE_HOME environment variable used to start DbProtect points to 
DbProtect’s installation directory so the correct sqlnet.ora file is used. To do so, 
manually unset the ORACLE_HOME environment before you launch 
DbProtect_Setup.exe.

To use currently logged-on Windows account to run your Audit, leave the User NameUser NameUser NameUser Name    
field empty in 

DISA CHECK REQUIREMENTS

Starting with version 6.0, AppDetectivePro uses Windows Management 
Instrumentation (WMI) technology on the following DISA checks when you Audit a 
Microsoft SQL Server application.

•  SQL Server service account user rightsSQL Server service account user rightsSQL Server service account user rightsSQL Server service account user rights

•  SQL Server component service account user rightsSQL Server component service account user rightsSQL Server component service account user rightsSQL Server component service account user rights

•  Integration Services OS account least privilegesIntegration Services OS account least privilegesIntegration Services OS account least privilegesIntegration Services OS account least privileges

•  SQL Server Agent account user rightsSQL Server Agent account user rightsSQL Server Agent account user rightsSQL Server Agent account user rights

Note:Note:Note:Note: For more information on WMI, see http://msdn.microsoft.com/en-us/
library/aa389290(VS.85).aspx.

DbProtect Vulnerability Assessment uses WMI to connect to remote WMI servers in 
order to obtain the service account or group of Microsoft SQL Server services (i.e., the 
Microsoft SQL Server service, Microsoft SQL Server Agent, Integration Service, 
Analysis Server, Report Server, Full Text Search and Microsoft SQL Server Browser).
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Subsequently, if you are Auditing a Microsoft SQL Server database on a remote WMI 
server, and you have any of the DISA checks listed above enabled in your Policy, you 
can do either of the following:

•  Enter a valid Windows account user name/password pair in the User NameUser NameUser NameUser Name and 
PasswordPasswordPasswordPassword fields in the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box (Operating System Operating System Operating System Operating System 
CredentialsCredentialsCredentialsCredentials tab selected). You can enter a user name (i.e., jsmith) or a 
domain\username (wmiserver-10\jsmith). The user name should only be valid 
with connections to remoteremoteremoteremote WMI servers. If you enter a user name for a locallocallocallocal 
WMI connection, the connection attempt will fail.

•  Leave the User NameUser NameUser NameUser Name and PasswordPasswordPasswordPassword fields blank if you want to log in as the 
currently logged-on user.

In the following scenarios you can leave the User NameUser NameUser NameUser Name and PasswordPasswordPasswordPassword fields blank to 
log in as the current logged-on Windows user:

•  You are notnotnotnot Auditing a Microsoft SQL Server database.

•  You are Auditing a Microsoft SQL Server database on a remote WMI server on a 
Windows host, but nonenonenonenone of the DISA checks listed above are enabled in your 
Policy.

•  You are Auditing a Microsoft SQL Server database on a remote WMI server on a 
Windows host, and you want to log in as the current logged-on Windows user.

•  You are Auditing a Microsoft SQL Server database on a locallocallocallocal WMI server.

For more information, see Step 7 of Creating an Audit Job.

REQUIRED OPEN PORTS ON MACHINES RUNNING 

MICROSOFT SQL SERVER

In order to run an Audit against a Microsoft SQL Server database, certain ports on the 
machine running Microsoft SQL Server mustmustmustmust be open. For more information, see 
Appendix L: Open Ports (on Computers Running Microsoft SQL Server) Required to 
Run Discoveries, Pen Tests, and Audits.

AUDITING MULTIPLE DATABASE INSTANCES ON A SINGLE 

HOST

If you have multiple database instances installed on a single host, and you want to 
Audit them all, you can enter separate credentials for each instance. However, you can 
only enter a single (per Scan Engine) global listener password in order to Discover 
Oracle database instances.

DB2 Admin Client Considerations:DB2 Admin Client Considerations:DB2 Admin Client Considerations:DB2 Admin Client Considerations:

If you install the DB2 Admin Client after you already have the Scan Engine installed 
and running, you mustmustmustmust re-start the Scan Engine service to perform an Audit against a 
DB2 application.
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IMPORTANT PRE-AUDIT SECURITY CONSIDERATION

DbProtect requires database and operating system (OS) credentials to be stored in 
DbProtect to successfully perform Audits. When using SSH for OS connections, a 
private key and passphrase is stored within DbProtect and passed on to the Scan 
Engine for performing the actual Audit. The private key and the passphrase are 
encrypted and stored in the Data Repository.

You can remove the private key and passphraseYou can remove the private key and passphraseYou can remove the private key and passphraseYou can remove the private key and passphrase; for more information, see Step 2 of 
Setting your operating system credentials (for Unix-based operating systems).

AUDITING MICROSOFT SQL SERVER (USING WINDOWS 

AUTHENTICATION) AGAINST A MACHINE ON A DIFFERENT 

OR UNTRUSTED DOMAIN

If you attempt to Audit a Microsoft SQL Server database (using Windows 
Authentication) against a machine on a different or untrusted domain, the following 
error message may display:

SQLSTATE: 28000, Native error: 18452, Message: [Microsoft][ODBC 

SQL Server Driver][SQL Server]Login failed for user ''. The user 

is not associated with a trusted SQL Server connection..

To Audit a Microsoft SQL Server database (using Windows Authentication) against a 
machine on a different or untrusted domain: 

1. Establish a connection to the target server.

Enter the appropriate Net Use syntax. For a remote host that is a: 

•  member of domain, enter: net use \\ip /user:domain\username

•  workgroup member (standalone computer), enter: net use \\ip /
user:username or net use \\ip /user:computername\username

2. Use named pipes to connect to an untrusted domain.

Select the PropertiesPropertiesPropertiesProperties branch option Connect to Microsoft SQL Servers via Named Connect to Microsoft SQL Servers via Named Connect to Microsoft SQL Servers via Named Connect to Microsoft SQL Servers via Named 
PipesPipesPipesPipes. You must check this option when Auditing a Microsoft SQL Server database in 
an untrusted domain. For more information on:

•  displaying the PropertiesPropertiesPropertiesProperties branch, see Displaying the Properties branches

•  the PropertiesPropertiesPropertiesProperties branch options, see Understanding the Properties branches.

Important: You mustmustmustmust enable the named pipes protocol on both the DbProtect host 
and the Microsoft SQL Server target server when using this option.

Note:Note:Note:Note: DbProtect does notnotnotnot support Pen Testing any Microsoft SQL Server 
instances which use named pipes for connection.
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3. Make sure of the following:

•  That the Server and Remote Registry services on your remote host are 
running

•  That the Net Use set of credentials file being used is a member of either the 
domain hosting the target server, or a domain that is trusted by that domain

•  the login provides remote registry access and read-only file access to the 
remote machine. To check this, do the following: 

•  enter net use \\server with your credentials, and expand 
HKEY_LOCAL_MACHINE on the target server

•  enter net use \\server\c$ to verify you can access files on the target server.

•  That access to the remote host can be restricted by firewall, which is common 
on Windows 2003/XP/Vista. You can verify this on the remote host by looking 
into the firewall settings/logs for rejects packets. This means there should be 
connectivity on port 445 or 139 on the target host.

4. Do the following to create and test a DSN connection to the target host:

•  Choose Control Panel > Administrative Tools > Data Sources (ODBC)Control Panel > Administrative Tools > Data Sources (ODBC)Control Panel > Administrative Tools > Data Sources (ODBC)Control Panel > Administrative Tools > Data Sources (ODBC).

•  Open the    System DSNSystem DSNSystem DSNSystem DSN tab and click the AddAddAddAdd button.

•  Choose Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server from the list.

•  Click the FinishFinishFinishFinish button.

•  Enter a NameNameNameName and DescriptionDescriptionDescriptionDescription for this data source entry.

•  In the ServerServerServerServer field, enter the IP address and listening port of the target server, 
e.g., 172.27.190.58,1756.

•  Click the NextNextNextNext button.

•  Select SQL Server AuthenticationSQL Server AuthenticationSQL Server AuthenticationSQL Server Authentication and enter your database credentials in the 
Login ID Login ID Login ID Login ID and PasswordPasswordPasswordPassword fields. 

•  Click the NextNextNextNext button.

•  Follow the steps in the wizard.

You should be able to test the connection to the data source. If this test is successful, 
you should also be able to perform the Audit with DbProtect. If you are unable to 
connect, try using the other IP address, or use Windows Authentication rather than the 
SQL credentials (after connecting with Net Use).
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CREATING AN AUDIT JOB

Note:Note:Note:Note: DbProtect requires database and operating system (OS) credentials to be 
stored in DbProtect to successfully perform Audits. When using SSH for 
OS connections, a private key and passphraseprivate key and passphraseprivate key and passphraseprivate key and passphrase is stored within DbProtect 
and passed on to the Scan Engine for performing the actual Audit. The 
private key and the passphrase are encrypted and stored in the Data 
Repository. You can remove the private key and passphraseYou can remove the private key and passphraseYou can remove the private key and passphraseYou can remove the private key and passphrase; for more 
information, see Step 2 of Setting your operating system credentials (for 
Unix-based operating systems).

You can set your database and operation system authentication 
credentials manually (see Step 7), apply a Credential Profile (see Step 8), or 
import credentials from a properly-formatted User Credentials File (see 
Step 9). For more information on Credential Profiles and User Credentials 
Files, see Working with Credential Profiles and User Credential Files.

To create an Audit Job:

1. Do one of the following to display the Audit Template Editor dialog box:

•  Choose Jobs > Templates > New Audit Jobs > Templates > New Audit Jobs > Templates > New Audit Jobs > Templates > New Audit from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab, and choose New Job > New Audit New Job > New Audit New Job > New Audit New Job > New Audit in the Job Setup Job Setup Job Setup Job Setup 
OptionsOptionsOptionsOptions Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more information, see Toolbars.

FIGURE: Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box
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2. In the Template Name Template Name Template Name Template Name portion of the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box, 
enter the name of your new Audit Job in the Name: Name: Name: Name: field.

3. In the Policy Policy Policy Policy portion of the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box, use the 
Select Policy:Select Policy:Select Policy:Select Policy: drop-down to select your Audit Policy.

4. Pick applications to Audit.

Click the Add Application(s)...Add Application(s)...Add Application(s)...Add Application(s)... button in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box to 
display the Application PickerApplication PickerApplication PickerApplication Picker, which allows you to select which applications you want 
to Audit.

FFFFIIIIGGGGUUUURRRREEEE: : : : Application PickerApplication PickerApplication PickerApplication Picker

You can check:

•  the NetworkNetworkNetworkNetwork checkbox to select all IPs (and subordinate subnets and 
applications) on a network

•  a subnetsubnetsubnetsubnet checkbox to select all subordinate host and applications within a 
subnet (e.g., 192.168.1.0/24192.168.1.0/24192.168.1.0/24192.168.1.0/24)

•  a hosthosthosthost checkbox to select all subordinate applications within a host (e.g., 
192.168.1.23 testing192.168.1.23 testing192.168.1.23 testing192.168.1.23 testing)

•  an individual applicationapplicationapplicationapplication beneath a parent host (e.g., Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server 
2000200020002000).
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Hint: Click the + icons to display subordinate subnets and applications.

5. Click the AddAddAddAdd button to close the Application PickerApplication PickerApplication PickerApplication Picker. Your selected 
applications display in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box.

FIGURE: Selected networks, subnets, hosts, and applications in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor 
dialog box

For each application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, the following fields 
display:

•  The IncludeIncludeIncludeInclude drop-down, which allows you to select whether to IncludeIncludeIncludeInclude or 
ExcludeExcludeExcludeExclude the application in your Audit Job. (IncludeIncludeIncludeInclude selected by default.)

•  The IP Address IP Address IP Address IP Address of your selected application (if applicable).

•  The Hostname Hostname Hostname Hostname of your selected application (if applicable).

•  The TypeTypeTypeType of application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, i.e., AppAppAppApp, 
SubnetSubnetSubnetSubnet, HostHostHostHost, NetworkNetworkNetworkNetwork.

•  The Add Filter Add Filter Add Filter Add Filter button under the App Type App Type App Type App Type column, which you can click to 
display the Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker pop up (shown below).

FFFFIIIIGGGGUUUURRRREEEE: : : : Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker

The Application Type PickerApplication Type PickerApplication Type PickerApplication Type Picker pop up allows you to filter which application types you 
want to filter from an Audit at the network, subnet, or host level. (Does notnotnotnot apply at the 
application level.)

For example, if you used the Application PickerApplication PickerApplication PickerApplication Picker in Step 4 to select the subnet 
192.168.1.1/50192.168.1.1/50192.168.1.1/50192.168.1.1/50, and you want to exclude all Auditing of Oracle Database applications, 
then you can uncheck the Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database checkbox in the Application PickerApplication PickerApplication PickerApplication Picker to filter 
Auditing of Oracle in this particular Audit Job.

•  The Port Port Port Port number of your selected application (if applicable)

•  The Instance Instance Instance Instance name of your selected application (if applicable)

•  The EditEditEditEdit button under the CredentialCredentialCredentialCredential column, which you can click to display the 
Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box, and set credentials only for this Audit Job (see Step 
6). Or, you can apply a Credential Profile to this Audit Job (see Step 7).
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•  The icon under the StatusStatusStatusStatus column indicates whether your credentials are 
incompleteincompleteincompleteincomplete , partial partial partial partial , or completecompletecompletecomplete . If your credentials are incomplete 
or partial, click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column, and set credentials 
only for this Audit Job (see Step 6).

6. You must provide database and operation system authentication 
credentials in order to run an Audit Job. If you want to:

•  set credentials manually, see Step 7

•  apply a Credential Profile, see Step 8

•  import credentials from a properly-formatted User Credentials File, see Step 9.

For more information on Credential Profiles and User Credentials Files, see Working 
with Credential Profiles and User Credential Files.

7. Set credentials manually for this Audit Job.Set credentials manually for this Audit Job.Set credentials manually for this Audit Job.Set credentials manually for this Audit Job.

You can set credentials only for this Audit Job, without applying a Credential Profile. 
Do the following:

•  Click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column in the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor 
dialog box to display the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box
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•  Select an Application/PlatformApplication/PlatformApplication/PlatformApplication/Platform combination in the Please Select One or More Please Select One or More Please Select One or More Please Select One or More 
Application(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box, e.g., 
Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database running on WindowsWindowsWindowsWindows.

The corresponding Database Credentials Database Credentials Database Credentials Database Credentials and Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials 
tabbed fields display in the CredentialsCredentialsCredentialsCredentials portion the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

•  Set your credentials, according to your selected Application/PlatformApplication/PlatformApplication/PlatformApplication/Platform 
combination. For more information, see Setting and testing your database and 
operating system credentials.

8. Apply an existing Credential Profile to this Audit Job.

You can apply an existing Credential Profile to this Audit Job. Do the following:

•  Click the Apply Credential Profile...Apply Credential Profile...Apply Credential Profile...Apply Credential Profile... button in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog 
box to display the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker

•  Use the Credential Profile:Credential Profile:Credential Profile:Credential Profile: drop-down to select an existing Credential Profile, 
then click the ApplyApplyApplyApply button.

DbProtect Vulnerability Management applies the selected, existing Credential 
Profile to this Audit Job.

•  Alternately, from the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker you can click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles 
button to display the Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

The Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager allows you to click the:

•  NewNewNewNew button to create a new Credential Profile; for more information, see 
Creating a Credential Profile

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile
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•  Set DefaultSet DefaultSet DefaultSet Default button to set the Credential Profile selected with the Credential Credential Credential Credential 
Profile:Profile:Profile:Profile: drop-down as your Organizational default; for more information see 
Setting a Credential Profile as an Organizational default.

9. Import credentials.

All Users (except View Users) can import User Credentials from an .xml file. This file 
must be properly-formatted or the import will fail, and the credentials will remain 
unchanged. For more information on:

•  the proper format of a User Credentials File, see Appendix A: Creating a User 
Credentials File

•  importing a User Credentials File, see Importing a User Credentials File.

10.Export credentials (Super Users only).

Super Users can export User Credentials to an .xml file. For more information, see 
Exporting a User Credentials File.

11.Auto-generate a Report upon completion of your Audit Job.

The Report GenerationReport GenerationReport GenerationReport Generation portion of the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box allows you to 
automatically generate a Vulnerability DetailsVulnerability DetailsVulnerability DetailsVulnerability Details or Vulnerability SummaryVulnerability SummaryVulnerability SummaryVulnerability Summary Report upon 
completion of your Audit Job. For more information on Report types, see Report 
types.

FIGURE: Report GenerationReport GenerationReport GenerationReport Generation section of the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box

If you want to use the Report auto-generation feature, do the following:

•  Check the Enable Auto ReportEnable Auto ReportEnable Auto ReportEnable Auto Report checkbox in the Report GenerationReport GenerationReport GenerationReport Generation portion of 
the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box. Check the Enable Auto ReportEnable Auto ReportEnable Auto ReportEnable Auto Report checkbox 
in the Report GenerationReport GenerationReport GenerationReport Generation portion of the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box. The 
Job History Job History Job History Job History portion of the pane displays the status of your auto Report Job 
after your Audit Job completes. The format that displays is: "for JOB_TYPE 
JOB_NAME [ran at 11/29/2007 12:23:20]"

•  Use the Report type drop-down to select whether you want to auto-generate a 
Vulnerability DetailsVulnerability DetailsVulnerability DetailsVulnerability Details or Vulnerability SummaryVulnerability SummaryVulnerability SummaryVulnerability Summary Report upon completion of your 
Audit Job; for more information on Report types, see Report types.

•  Use the Report FormatReport FormatReport FormatReport Format drop-down to select whether you want to auto-generate 
your Report in any of the following formats:

----HTML - Single FileHTML - Single FileHTML - Single FileHTML - Single File

----TextTextTextText

----XMLXMLXMLXML

-PDFPDFPDFPDF.

For more information on Report formats, see Report formats.
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If you use the Report auto-generation feature to generate a Report for an Audit Job, 
you can:

•  view the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Viewing a completed Report

•  save the completed Report (when the Job is complete) in whatever format you 
specified in this step; for more information, see Saving a completed Report.

12.Auto-generate Fix Scripts upon completion of your Audit Job.

The Fix Script GenerationFix Script GenerationFix Script GenerationFix Script Generation section of the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box allows you 
to check the Enable Fix Script GenerationEnable Fix Script GenerationEnable Fix Script GenerationEnable Fix Script Generation checkbox (unchecked by default) to 
automatically generate a Fix Script for all vulnerabilities detected upon completion of 
your Audit Job. For more information on Fix Scripts, see Automatically running a Fix 
Script.

FIGURE: Fix Script GenerationFix Script GenerationFix Script GenerationFix Script Generation section of the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box

13.Click the SaveSaveSaveSave button to save your Audit Job.

14.You can:

•  run the Audit Job now; for more information, see “Run Job Now”

•  schedule the Audit Job to run later; for more information, see Scheduling a 
Job.

15.After your Audit Job completes, you can:

•  view the completed Job details; for more information, see Viewing Job details

•  view the completed Job properties; for more information, see Viewing the 
properties of a completed Job

•  view individual vulnerabilities detected during an Audit of a Discovered 
database; for more information, see Viewing individual vulnerabilities detected 
during an Audit.
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Report Jobs This topic consists of the following sub-topics:

•  What is a Report?

•  Understanding legacy Reports

•  Report types

•  Report formats

•  Creating a Report Job.

WHAT IS A REPORT?

DbProtect Vulnerability Management allows you to generate ReportsReportsReportsReports designed to 
communicate vulnerabilities detected by DbProtect Vulnerability Management to all 
levels of your Organization.

Note:Note:Note:Note: You can schedule a Report Job to run in the future (explained in this topic), 
or you can create a Report Job and run a Report now; for more 
information, see “Run Job Now”.

UNDERSTANDING LEGACY REPORTS

DbProtect allows you to run Vulnerability Management Reports as legacy Reports legacy Reports legacy Reports legacy Reports (if 
you selected the Legacy Vulnerability Assessment Reporting option during the 
installation of the DbProtect suite). A legacy Report is a Vulnerability Management 
Report that displays in a pre-DbProtect 2009.1R4 (i.e., legacy) format.

As explained in the DbProtect Installation Guide, when you first install the DbProtect 
suite, you have the option of adding support for Legacy VA (Vulnerability Assessment) 
Reporting.

If you did notnotnotnot select legacy Vulnerability Assessment reporting when you installed the 
DbProtect suite, then legacy Vulnerability Assessment reports are notnotnotnot available. 
Specifically, the Enable Legacy ReportsEnable Legacy ReportsEnable Legacy ReportsEnable Legacy Reports checkbox will notnotnotnot display on the New Report New Report New Report New Report 
Template Template Template Template dialog box when you create a Report Job; for more information, see 
Creating a Report Job.

On the other hand, if you selected legacy Vulnerability Assessment reporting when 
you installed the DbProtect suite, then legacy Vulnerability Assessment reports are 
available. Specifically, the Enable Legacy ReportsEnable Legacy ReportsEnable Legacy ReportsEnable Legacy Reports checkbox displays on the New New New New 
Report Template Report Template Report Template Report Template dialog box when you create a Report Job; for more information, see 
Creating a Report Job.

REPORT TYPES

DbProtect Vulnerability Management supports the following Report typesReport typesReport typesReport types:

•  Application Banners. Application Banners. Application Banners. Application Banners. This type of Report displays information found within the 
DetailsDetailsDetailsDetails tab of the main window.

•  Application Inventory. Application Inventory. Application Inventory. Application Inventory. Use this Report to generate a snapshot of your 
applications. This Report is useful in summarizing the state of your network 
applications.
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•  Check Status. Check Status. Check Status. Check Status. Creates a Report of all security checks run on an application and 
their results. The following table explains possible StatusStatusStatusStatus field messages.

•  Policy Detail. Policy Detail. Policy Detail. Policy Detail. Generates a Report based on the Policy you choose.

•  Summary Report. Summary Report. Summary Report. Summary Report. Displays a high-level summary of all the applications and 
vulnerabilities Discovered on the network or in a particular folder.

•  User Information. User Information. User Information. User Information. Creates a Report containing a list of User logins and related 
information.

•  Vulnerability Differences.Vulnerability Differences.Vulnerability Differences.Vulnerability Differences. Generates a Report showing the differences in 
vulnerabilities between two Penetration Tests or Audits of a specific 
application.

•  Vulnerability Details. Vulnerability Details. Vulnerability Details. Vulnerability Details. Creates a Report containing the specific vulnerability 
details found for each Audit and Penetration Test performed.

•  Vulnerability Summary. Vulnerability Summary. Vulnerability Summary. Vulnerability Summary. Creates a Report which contains high-level summary 
information for vulnerabilities found for each Audit and Penetration Test.

•  STIG Findings by Database Overview.STIG Findings by Database Overview.STIG Findings by Database Overview.STIG Findings by Database Overview. This report shows a summary of STIG 
compliance broken down by results that pass, fail, and are not applicable (N/A) 
for automated verification.

•  STIG Findings by Database Mapping.STIG Findings by Database Mapping.STIG Findings by Database Mapping.STIG Findings by Database Mapping. This report shows the findings summary 
mapped to STIG compliance.

•  STIG Findings by Database Detail. STIG Findings by Database Detail. STIG Findings by Database Detail. STIG Findings by Database Detail. This report shows the detailed findings 
mapped to STIG compliance.

If the Status Field reads:If the Status Field reads:If the Status Field reads:If the Status Field reads: It means a check:

Violation FoundViolation FoundViolation FoundViolation Found Found at least one vulnerability.

No Violation FoundNo Violation FoundNo Violation FoundNo Violation Found Found no vulnerabilities.

FailedFailedFailedFailed Failed for some reason (an explanation message displays).

WorkingWorkingWorkingWorking Is currently running.

SkippedSkippedSkippedSkipped Could not be executed for some reason and was skipped (an 
explanation message displays).
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Note:Note:Note:Note: To run DISA-STIG compliance pack reports, you must import a compliance 
content pack; for more information see Importing a Compliance Content 
Pack.

You can also display generated DISA-STIG compliance pack reports (i.e., 
STIG Findings by Database OverviewSTIG Findings by Database OverviewSTIG Findings by Database OverviewSTIG Findings by Database Overview, STIG Findings by Database STIG Findings by Database STIG Findings by Database STIG Findings by Database 
MappingMappingMappingMapping, and STIG Findings by Database Detail STIG Findings by Database Detail STIG Findings by Database Detail STIG Findings by Database Detail) -- as well as generated 
DISA-STIG compliance Dashboards -- on the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page; for 
more information, see Interpreting Your Generated Compliance Pack 
Dashboards, and Displaying/Interpreting Your Generated Compliance 
Pack Reports.

REPORT FORMATS

DbProtect Vulnerability Management generates Reports in the following Report Report Report Report 
formatsformatsformatsformats:

•  HTML - Single File.HTML - Single File.HTML - Single File.HTML - Single File. You can view an HTML Report in a web browser. DbProtect 
Vulnerability Management stores the Report in a directory.

•  Text. Text. Text. Text. You can view a text Report with any text or word processing program, such 
as Notepad or Word.

•  XML.XML.XML.XML. The “bare” XML skeleton used to generate custom Reports.

•  PDF. PDF. PDF. PDF. You can view a PDF Report, using Acrobat Reader.

Note:Note:Note:Note: You can download Acrobat Reader for free from www.adobe.com.

Important: In the current version of DbProtect Vulnerability Management, you can 
view a Report in HTML, but if you want to savesavesavesave a Report to your computer 
or network, then you mustmustmustmust save your Report as an .mht file instead of 
.html or .xml.

Note:Note:Note:Note: You can only generate legacy Reports in XML or PDF formats; for more 
information, see Report types.
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CREATING A REPORT JOB

To create a Report Job:

1. Do one of the following to display the New Report Template dialog box:

•  Choose Jobs > Templates > New Report Jobs > Templates > New Report Jobs > Templates > New Report Jobs > Templates > New Report from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab, and choose New Job > New Report New Job > New Report New Job > New Report New Job > New Report in the Job Job Job Job 
Setup OptionsSetup OptionsSetup OptionsSetup Options Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more information, see 
Toolbars.

FIGURE: New Report Template New Report Template New Report Template New Report Template dialog box
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2. In the Template: Template: Template: Template: portion of the New Report TemplateNew Report TemplateNew Report TemplateNew Report Template dialog box, enter the 
name of your new Report Job in the TemplateTemplateTemplateTemplate Name: Name: Name: Name: field.

3. In the Select Report Type Select Report Type Select Report Type Select Report Type portion of the New Report TemplateNew Report TemplateNew Report TemplateNew Report Template dialog box, 
highlight the Report you want to associate with this Job.

4. A Report descriptionReport descriptionReport descriptionReport description displays to the right, and corresponding setting 
options display in the Report SettingsReport SettingsReport SettingsReport Settings portion of the dialog box (see Step 
5). For more information, see Report types.

Note:Note:Note:Note: As explained in Understanding legacy Reports, DbProtect allows you to 
run Vulnerability Management Reports as legacy Reports (if you selected 
the Legacy Vulnerability Assessment Reporting option during the 
installation of the DbProtect suite). A legacy Report is a Vulnerability 
Management Report that displays in a pre-DbProtect 2009.1R4 (i.e., 
legacy) format.

When you first install the DbProtect suite, you have the option of adding 
support for Legacy VA (Vulnerability Assessment) Reporting. If you did notnotnotnot 
select legacy Vulnerability Assessment reporting when you installed the 
DbProtect suite, then legacy Vulnerability Assessment reports are notnotnotnot 
available. Specifically, the Enable Legacy ReportsEnable Legacy ReportsEnable Legacy ReportsEnable Legacy Reports checkbox will notnotnotnot display 
on the New Report TemplateNew Report TemplateNew Report TemplateNew Report Template dialog box. On the other hand, if you 
selected legacy Vulnerability Assessment reporting when you installed the 
DbProtect suite, then legacy Vulnerability Assessment reports are 
available. Specifically, the Enable Legacy ReportsEnable Legacy ReportsEnable Legacy ReportsEnable Legacy Reports checkbox displays on 
the New Report TemplateNew Report TemplateNew Report TemplateNew Report Template dialog box.

5. The Report SettingsReport SettingsReport SettingsReport Settings portion of the dialog box allows you specify your Report-
specific criteria, i.e., a Policy name for a Policy ReportPolicy ReportPolicy ReportPolicy Report, a Penetration Test 
for a Vulnerability ReportVulnerability ReportVulnerability ReportVulnerability Report, etc. This portion of the dialog box is different for each 

Report.

6. In the Report Output Format Report Output Format Report Output Format Report Output Format portion of the New Report TemplateNew Report TemplateNew Report TemplateNew Report Template dialog 
box, use the Report Format Report Format Report Format Report Format drop-down to choose whether you want to 
generate your Report as:

•  HTML - Single FileHTML - Single FileHTML - Single FileHTML - Single File

•  TextTextTextText

•  XMLXMLXMLXML

•  PDFPDFPDFPDF.

Important: In the current version of DbProtect, you can view a Report in HTML, but if 
you want to savesavesavesave a Report to your computer or network, then you must must must must 
save your Report as an .mht file instead of .html or .xml.

For more information, see Report formats.
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7. Click the SaveSaveSaveSave button to save your Report Job.

8. You can:

•  run the Report Job now; for more information, see “Run Job Now”

•  schedule the Report Job to run later; for more information, see Scheduling a 
Job.

9. After your Report Job completes, you can:

•  view the completed Report Job (in whatever format you specified in Step 5); for 
more information, see Viewing a completed Report

•  save the completed Report Job (in whatever format you specified in Step 5); for 
more information, see Saving a completed Report

•  view the completed Job details; for more information, see Viewing Job details

•  view the completed Job properties; for more information, see Viewing the 
properties of a completed Job.

Editing a Job To edit a Job: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page
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2. Do one of the following:

•  Right click the Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup portion) 
and choose EditEditEditEdit.

•  Double click the Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup portion).

Depending what type of Job you select (i.e., Discovery, Penetration Test, Audit, or 
Report), the appropriate template dialog box displays. For example, if you select a 
Discovery Job to edit, then the Discovery Job TemplateDiscovery Job TemplateDiscovery Job TemplateDiscovery Job Template dialog box displays. If you 
choose an Audit Job, the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box displays. And so on.

For more information, see:

•  Discovery Jobs

•  Penetration Test Jobs

•  Audit Jobs

•  Report Jobs.

“Run Job Now” To run a Job now: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Highlight one more Jobs in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup 
portion).

Hint:Hint:Hint:Hint: Click <CTRL> to highlight non-sequential Jobs.
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3. Do one of the following:

•  Click Run Job Now Run Job Now Run Job Now Run Job Now in the Job Setup Options Job Setup Options Job Setup Options Job Setup Options Toolbar

•  Right click the Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup portion) 
and choose Run Job NowRun Job NowRun Job NowRun Job Now.

The Job runs, and displays in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Active Jobs Active Jobs Active Jobs Active Jobs portion).

Even as the Job is running, you can:

•  view the active Job details; for more information, see Viewing Job details

•  cancel the active Job; for more information, see Cancelling an active Job.

Scheduling a Job When you schedule a Job, you specify the following:

•  Job FrequencyJob FrequencyJob FrequencyJob Frequency, i.e., how often the Job should run (i.e., DailyDailyDailyDaily, WeeklyWeeklyWeeklyWeekly, MonthlyMonthlyMonthlyMonthly, 
YearlyYearlyYearlyYearly, or OnceOnceOnceOnce)

•  Date SettingsDate SettingsDate SettingsDate Settings, i.e., when the Job should run (i.e., on specific date, day of the 
week, time, etc.).

To schedule a Job:

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Highlight one more Jobs in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup 
portion).

Hint: Click <CTRL> to highlight non-sequential Jobs.
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3. Do one of the following to display the Schedule Job Schedule Job Schedule Job Schedule Job dialog box:

•  Click Set Schedule Set Schedule Set Schedule Set Schedule in the Job Setup Options Job Setup Options Job Setup Options Job Setup Options Toolbar

•  Right click the Job and choose Set ScheduleSet ScheduleSet ScheduleSet Schedule.

FIGURE: Schedule JobSchedule JobSchedule JobSchedule Job dialog box

Note:Note:Note:Note: If you are re-scheduling a previously-scheduled Job, the Schedule Job 
dialog box displays the existing schedule information (which you can 
modify).

4. Select Job frequency.

In the Job Frequency Job Frequency Job Frequency Job Frequency portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box, use the Task Task Task Task 
Frequency: Frequency: Frequency: Frequency: drop-down to select how often you want the Job to run.

Note:Note:Note:Note: The fields that display in the Date SettingsDate SettingsDate SettingsDate Settings portion of the Schedule JobsSchedule JobsSchedule JobsSchedule Jobs 
dialog box vary depending on your selection.

If you select:

•  DailyDailyDailyDaily, then go to Step 5

•  WeeklyWeeklyWeeklyWeekly, then go to Step 6

•  MonthlyMonthlyMonthlyMonthly, then go to Step 7

•  YearlyYearlyYearlyYearly, then go to Step 8

•  OnceOnceOnceOnce, then go to Step 9.
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5. Scheduling a daily Job.

If you selected a Job frequency of DailyDailyDailyDaily in Step 4, then the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box 
looks like this:

FIGURE: Schedule JobsSchedule JobsSchedule JobsSchedule Jobs dialog box (DailyDailyDailyDaily Job frequency selected)

In the Date Settings Date Settings Date Settings Date Settings portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Use the Start Date: Start Date: Start Date: Start Date: and End Date:  End Date:  End Date:  End Date: drop-downs to specify when the scheduled 
Job should begin and end.

Hint: Check the No end date checkbox (checked by default) if you do not want 

to specify an end date for this scheduled Job. Uncheck the No end date 

checkbox if you want to specify an End Date: for this scheduled Job.

•  Use the Start Time: Start Time: Start Time: Start Time: scroll bar to specify (in HH:MM:SSHH:MM:SSHH:MM:SSHH:MM:SS format) when the 
scheduled Job should run. Use the up and down arrow keys to advance and 
back up the time.

•  Select Every _ Day(s)Every _ Day(s)Every _ Day(s)Every _ Day(s), and use the up and down arrow keys to specify how many 
days a week the daily Job should run. If you select the default 1111, then DbProtect 
Vulnerability Management runs your daily Job every day (within the specified 
start and end dates). If you select 2222, then DbProtect Vulnerability Management 
runs your daily Job every other day (within the specified start and end dates). 
And so on.

•  Select Every weekday Every weekday Every weekday Every weekday if you want DbProtect Vulnerability Management to run 
your daily Job every weekday (within the specified start and end dates).

When you’re done, go to Step 10.
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6. Scheduling a weekly Job.

If you selected a Job frequency of WeeklyWeeklyWeeklyWeekly in Step 4, then the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog 
box looks like this:

FIGURE: Schedule JobsSchedule JobsSchedule JobsSchedule Jobs dialog box (WeeklyWeeklyWeeklyWeekly Job frequency selected)

In the Date Range Date Range Date Range Date Range portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Use the Start Date: Start Date: Start Date: Start Date: and End Date:  End Date:  End Date:  End Date: drop-downs to specify when the scheduled 
Job should begin and end.

Hint: Check the No end date checkbox if you do not want to specify an end date 

for this scheduled Job.

•  Use the Start Time: Start Time: Start Time: Start Time: scroll bar to specify (in HH:MM:SSHH:MM:SSHH:MM:SSHH:MM:SS format) when the 
scheduled Job should run. Use the up and down arrow keys to advance and 
back up the time.

In the Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box, use the 
checkboxes to specify on which day(s) you want to run a weekly Job on a specific day 
(within the specified date range). For example, check the MondayMondayMondayMonday checkbox to run 
your weekly Job every Monday (within the specified date range). 

When you’re done, go to Step 10.
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7. Scheduling a monthly Job.

If you selected a Job frequency of MonthlyMonthlyMonthlyMonthly in Step 4, then the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog 
box looks like this:

FIGURE: Schedule JobsSchedule JobsSchedule JobsSchedule Jobs dialog box (MonthlyMonthlyMonthlyMonthly Job frequency selected)

In the Date Settings Date Settings Date Settings Date Settings portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Use the Start Date: Start Date: Start Date: Start Date: and End Date:  End Date:  End Date:  End Date: drop-downs to specify when the scheduled 
Job should begin and end.

Hint: Check the No end date checkbox if you do not want to specify an end date 

for this scheduled Job.

•  Use the Start Time: Start Time: Start Time: Start Time: scroll bar to specify (in HH:MM:SSHH:MM:SSHH:MM:SSHH:MM:SS format) when the 
scheduled Job should run. Use the up and down arrow keys to advance and 
back up the time.

In the Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Select Day _ of every _ Month(s) Day _ of every _ Month(s) Day _ of every _ Month(s) Day _ of every _ Month(s) if you want to run your monthly Job on a 
specific date each month (within the specified date range).    For example, 
assume    You want to run a monthly Job on the 15th of every month for three 
months within the specified date range. Enter 15 in the date field, then use the 
up and down arrow keys to select 3333.

•  Select The _ _ of every _ Month(s) The _ _ of every _ Month(s) The _ _ of every _ Month(s) The _ _ of every _ Month(s) if you want to run your monthly Job on a 
specific day of the week each month.    For example, assume you want to run a 
monthly Job on the first Monday of every month for three months within the 
specified date range. Select firstfirstfirstfirst, select MondayMondayMondayMonday, and use the up and down 
arrow keys to select 3333.

When you’re done, go to Step 10.
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8. Scheduling a yearly Job.

If you selected a Job frequency of YearlyYearlyYearlyYearly in Step 4, then the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box 
looks like this:

FIGURE: Schedule JobsSchedule JobsSchedule JobsSchedule Jobs dialog box (YearlyYearlyYearlyYearly Job frequency selected)

In the Date Settings Date Settings Date Settings Date Settings portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Use the Start Date: Start Date: Start Date: Start Date: and End Date:  End Date:  End Date:  End Date: drop-downs to specify when the scheduled 
Job should begin and end.

Hint: Check the No end date checkbox if you do not want to specify an end date 

for this scheduled Job.

•  Use the Start Time: Start Time: Start Time: Start Time: scroll bar to specify (in HH:MM:SSHH:MM:SSHH:MM:SSHH:MM:SS format) when the 
scheduled Job should run. Use the up and down arrow keys to advance and 
back up the time.

In the Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence Frequency of Occurrence portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Select Every _ Every _ Every _ Every _ if you want to run your yearly Job on a specific date each year 
(within the specified date range). For example, assume you want to run a yearly 
Job on June 16 every year within the specified date range. Select JuneJuneJuneJune, and 
enter 16.

•  Select The _ _ of _ The _ _ of _ The _ _ of _ The _ _ of _ if you want to run your yearly Job on a specific day of the 
week, during a specific month, each year.    For example, assume you want to run 
a yearly Job on the first Monday of every June every year within the specified 
date range. Select firstfirstfirstfirst, select MondayMondayMondayMonday, and select JuneJuneJuneJune.

When you’re done, go to Step 10.
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9. Scheduling a one-time Job.

If you selected a Job frequency of OnceOnceOnceOnce in Step 4, then the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box 
looks like this:

FIGURE: Schedule JobsSchedule JobsSchedule JobsSchedule Jobs dialog box (OnceOnceOnceOnce Job frequency selected)

In the Date Settings Date Settings Date Settings Date Settings portion of the Schedule Jobs Schedule Jobs Schedule Jobs Schedule Jobs dialog box:

•  Select Run job nowRun job nowRun job nowRun job now to run your Job immediately.

•  Select Run this job once on _ at _ Run this job once on _ at _ Run this job once on _ at _ Run this job once on _ at _ if you want to run your Job once, on a specific 
date and at a specific time. For example, assume you want to run your Job once 
on June 16, 2008 at 4:29 P.M. Select June 16, 2008June 16, 2008June 16, 2008June 16, 2008, then use the up and down 
arrow keys to select 4:29 P.M.4:29 P.M.4:29 P.M.4:29 P.M.

When you’re done, go to Step 10.

10.Click the ScheduleScheduleScheduleSchedule button.

DbProtect Vulnerability Management schedules your Job according to the criteria 
specified.

Even as the Job is running, you can:

•  view the active Job details; for more information, see Viewing Job details

•  cancel the active Job; for more information, see Cancelling an active Job.
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Unscheduling a
Job

Note:Note:Note:Note: Deleting an application also deletes the application from any unscheduled 
Job (as explained in Deleting an application to Discover).

To unschedule a Job:

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Highlight one more Jobs in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup 
portion).

Hint: Click <CTRL> to highlight non-sequential Jobs.

3. Do one of the following to display the Unschedule Jobs Unschedule Jobs Unschedule Jobs Unschedule Jobs pop up.

•  Click Un-Schedule Un-Schedule Un-Schedule Un-Schedule in the Job Setup Options Job Setup Options Job Setup Options Job Setup Options Toolbar

•  Right click the Job and choose Un-ScheduleUn-ScheduleUn-ScheduleUn-Schedule.

FIGURE: Unschedule JobsUnschedule JobsUnschedule JobsUnschedule Jobs pop up

The Unschedule Jobs Unschedule Jobs Unschedule Jobs Unschedule Jobs pop up prompts you to confirm you want to unschedule the 
selected Jobs. Click the YesYesYesYes button to unschedule (but not delete) the selected Jobs.
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Viewing a
completed Report

You can viewviewviewview a completed Report for any type of Job. For more information on using 
the Report auto-generation feature to generate a Report for a:

•  Discovery Job, see Discovery Jobs

•  Penetration Test Job, see Penetration Test Jobs

•  Audit Job, see Audit Jobs.

To view a completed Report: 

1. Locate your completed Jobs. They display in the pane of the Manage Jobs page 

(Job History portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

2. Right click a completed Job and choose Show ReportShow ReportShow ReportShow Report.

The completed Report displays, in whatever Report format you specified (i.e., HTML - HTML - HTML - HTML - 
Single FileSingle FileSingle FileSingle File, TextTextTextText, XMLXMLXMLXML, or PDFPDFPDFPDF). A completed Check StatusCheck StatusCheck StatusCheck Status Report in XML Report 
format is shown below.

FIGURE: Completed Check StatusCheck StatusCheck StatusCheck Status Report in XML format
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Saving a
completed Report

You can savesavesavesave a completed Report for any type of Job. For more information on using 
the Report auto-generation feature to generate a Report for a:

•  Discovery Job, see Discovery Jobs

•  Penetration Test Job, see Penetration Test Jobs

•  Audit Job, see Audit Jobs.

To save a completed Report Job:

1. Locate your completed Jobs. They display in the pane of the Manage Jobs page 

(Job History portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

2. Right click a completed Job and choose Save ReportSave ReportSave ReportSave Report.

The SaveSaveSaveSave dialog box displays, prompting you to save a copy of your Report in 
whatever Report format you specified (i.e., HTML - Single FileHTML - Single FileHTML - Single FileHTML - Single File, TextTextTextText, XMLXMLXMLXML, or PDFPDFPDFPDF).

FIGURE: SaveSaveSaveSave dialog box
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Filtering Jobs DbProtect Vulnerability Management allows you to filter the Jobs you want to view. 
For example, you can filter just Penetration Test and Audit Jobs, and hide Discovery 
and Report Jobs.

Note:Note:Note:Note: A filter reduces what information is displayed, so you won’t have to scroll 
through a lengthy list of applications.

To filter Jobs:

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Locate the Job Filters Job Filters Job Filters Job Filters Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more 
information, see Toolbars.

3. Check/uncheck:

•  DiscoveriesDiscoveriesDiscoveriesDiscoveries to filter your Discovery Jobs

•  Pen TestsPen TestsPen TestsPen Tests to filter your Penetration Test Jobs

•  AuditsAuditsAuditsAudits to filter your Audit Jobs

•  ReportsReportsReportsReports to filter your Report Jobs

•  Only UserOnly UserOnly UserOnly User, and use the drop-down, to filter/hide Jobs by a specific User

Your filtered Jobs display in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup portion).
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Filtering Job
history

DbProtect Vulnerability Management allows you to filter Job history. For example, you 
can filter only successful Jobs that ran in the past 24 hours.

Note:Note:Note:Note: A filter reduces what information is displayed, so you won’t have to scroll 
through a lengthy list of applications.

To filter Job history:

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Locate the Job History FiltersJob History FiltersJob History FiltersJob History Filters Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page; for more 
information, see Toolbars.

3. In the:

•  Show... Show... Show... Show... part of the Job History Filters Job History Filters Job History Filters Job History Filters section, check/uncheck:

-SuccessfulSuccessfulSuccessfulSuccessful to filter Jobs that ran successfully

-Failed Failed Failed Failed to filter your Jobs that failed

-CanceledCanceledCanceledCanceled to filter your Jobs that you intentionally canceled

-TerminatedTerminatedTerminatedTerminated to filter your Jobs that were terminated (not through cancellation)

-Mixed to display a mix of all completed Jobs by Job History Filter status (i.e., 
SuccessfulSuccessfulSuccessfulSuccessful, FailedFailedFailedFailed, CanceledCanceledCanceledCanceled, and TerminatedTerminatedTerminatedTerminated).
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Important: Include Jobs Within... Include Jobs Within... Include Jobs Within... Include Jobs Within... part of the Job History Filters Job History Filters Job History Filters Job History Filters section, select:

-Last 24 Hours Last 24 Hours Last 24 Hours Last 24 Hours to filter Jobs that ran within the last 24 hours

-Last 7 Days Last 7 Days Last 7 Days Last 7 Days to filter Jobs that ran within the last 7 days

-Last 30 Days Last 30 Days Last 30 Days Last 30 Days to filter Jobs that ran within the last 30 days

-Any Time Any Time Any Time Any Time (default) if you don’t want to filter Jobs by time range.

Your filtered Jobs display in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup portion).

Deleting a set up
Job

You can deletedeletedeletedelete any Job template that you have set up in the pane of the Manage JobsManage JobsManage JobsManage Jobs 
page (Job SetupJob SetupJob SetupJob Setup portion). However, activeactiveactiveactive Jobs must be cancelledcancelledcancelledcancelled (for more 
information, see Cancelling an active Job) and completedcompletedcompletedcompleted Jobs must be purgedpurgedpurgedpurged (for 
more information, see Purging a completed Job).

To delete a set up Job:

1. Locate your set up Jobs. They display in the pane of the Manage Jobs page (Job 

Setup portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job Setup Job Setup Job Setup Job Setup portion)

2. Do the following:

•  Highlight one more set up Jobs.

Hint: Click <CTRL> to highlight non-sequential Jobs.

•  Right click the set up Job(s) and select Delete.

•  A Confirm DeleteConfirm DeleteConfirm DeleteConfirm Delete pop up prompts you to confirm the deletion.

FIGURE: Confirm Delete Confirm Delete Confirm Delete Confirm Delete pop up

•  Click the YesYesYesYes button to delete the set up Jobs.

•  The set up Jobs disappear from the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup 
portion).
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Purging a
completed Job

You can purgepurgepurgepurge any completed Job, of any Job type, that you no longer need. 
Completed Jobs display in the Manage JobsManage JobsManage JobsManage Jobs page (Completed Jobs Completed Jobs Completed Jobs Completed Jobs portion).

To purge a completed Job: 

1. Locate your completed Jobs. They display in the pane of the Manage Jobs page 

(Job History portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

2. Highlight one more completed Jobs.

Hint: Click <CTRL> to highlight non-sequential Jobs.

3. Right click the completed Jobs and choose PurgePurgePurgePurge.

A Confirm PurgeConfirm PurgeConfirm PurgeConfirm Purge pop up prompts you to confirm the purge.

FIGURE: Confirm Purge Confirm Purge Confirm Purge Confirm Purge pop up

Click the YesYesYesYes button to purge the completed Jobs.

The completed Jobs disappear from the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job History Job History Job History Job History 
portion).

Cancelling an
active Job

If your Jobs are active it means they are currently running. You can cancel any active 
Job in the Manage JobsManage JobsManage JobsManage Jobs page (Active Jobs Active Jobs Active Jobs Active Jobs portion).

To cancel an active Job:

1. Locate your active Jobs. They display in the pane of the Manage Jobs page 

(Active Jobs portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Active JobsActive JobsActive JobsActive Jobs portion)
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2. Right click an active Job and choose CancelCancelCancelCancel.

A Confirm CancelConfirm CancelConfirm CancelConfirm Cancel pop up prompts you to confirm the cancellation.

FIGURE: Confirm Cancel Confirm Cancel Confirm Cancel Confirm Cancel pop up

Click the YesYesYesYes button to cancel the active Job.

The color of the active Job turns red on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Active Jobs Active Jobs Active Jobs Active Jobs portion) 
until DbProtect Vulnerability Management cancels the Job -- at which point it 
disappears.

Deleting an
application to

Discover

If you manually added an application for DbProtect to Discover (explained in Adding 
an application to Discover), but now you want to deletedeletedeletedelete the application, you must 
unscheduleunscheduleunscheduleunschedule any scheduled Jobs associated with the application (for more information, 
see Unscheduling a Job). Deleting an application deletes the application from any 
unscheduled Job.

Viewing Job
details

You can view the Job detailsJob detailsJob detailsJob details for any Job type when the Job is in:

•  an active state; for more information, see Viewing the Job details of an active 
Job

•  a completed state; for more information, see Viewing the Job details of a 
completed Job.

VIEWING THE JOB DETAILS OF AN ACTIVE JOB

To view the Job details of an active Job:

1. Locate your active Jobs. They display in the pane of the Manage Jobs page 

(Active Jobs portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Active Jobs Active Jobs Active Jobs Active Jobs portion)
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2. Right click an active Job and choose Show Job DetailsShow Job DetailsShow Job DetailsShow Job Details to display the Active Active Active Active 
Job DetailsJob DetailsJob DetailsJob Details dialog box.

FIGURE: Active Job DetailsActive Job DetailsActive Job DetailsActive Job Details dialog box

The Active Job Details Active Job Details Active Job Details Active Job Details dialog box displays the active Job details, including:

•  DescriptionDescriptionDescriptionDescription

•  StartStartStartStart time

•  EndEndEndEnd time

•  StatusStatusStatusStatus (e.g., Dispatched to Scan Engine Dispatched to Scan Engine Dispatched to Scan Engine Dispatched to Scan Engine)

•  The Scan EngineScan EngineScan EngineScan Engine where the Job is running.

Note:Note:Note:Note: You cannotcannotcannotcannot display a Report for an active Job.

Click the CloseCloseCloseClose button to close the Active Job Details Active Job Details Active Job Details Active Job Details dialog box.

VIEWING THE JOB DETAILS OF A COMPLETED JOB

To view the Job details of a completed Job:

1. Locate your completed Jobs. They display in the pane of the Manage Jobs page 

(Completed Jobs portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)
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2. Do one of the following to display the Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box:

•  Double click a completed Job.

•  Right click a completed Job and choose Show DetailsShow DetailsShow DetailsShow Details.

The Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box is shown below.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The Job Details Job Details Job Details Job Details portion    of the Job History Details Job History Details Job History Details Job History Details dialog box displays the Job’s 
historical details, including:

•  DescriptionDescriptionDescriptionDescription

•  StartStartStartStart time

•  EndEndEndEnd time

•  StatusStatusStatusStatus (e.g., CompleteCompleteCompleteComplete)

•  The Scan EngineScan EngineScan EngineScan Engine where the Job ran.

Hint: You can click the report icon on the right side of the Job History Details 

dialog box to display the Run Report pop up and run a Report for a 

completed Job. For more information, see Report Jobs.

For Audit Jobs only, the Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box 
displays information about any Fix Scripts that have been run, including:

•  NameNameNameName

•  Generation DateGeneration DateGeneration DateGeneration Date

•  StatusStatusStatusStatus.

For more information on Fix Scripts, see Working with Fix Scripts.

You can click the CloseCloseCloseClose button to close the Job History Details Job History Details Job History Details Job History Details dialog box.

Viewing individual
vulnerabilities

detected during an
Audit

After you complete an Audit Job, you can view individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities detected 
during an Audit of a Discovered database. You can then run an “on demand” Fix 
Script to repair individual vulnerabilities detected on an individual Audited database 
instance.

To view individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities detected during an Audit of a Discovered database:

1. Audit a Discovered database application; for more information, see Creating an 

Audit Job.

2. Locate your completed Jobs. They display in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs 
page (Completed Jobs Completed Jobs Completed Jobs Completed Jobs portion).
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FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

3. Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details to display the 
Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

4. Do one of the following to display the Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box:

•  Right click any completed Audit Job in the upper Job DetailsJob DetailsJob DetailsJob Details portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box, and select Additional InformationAdditional InformationAdditional InformationAdditional Information.

•  Double click any completed Audit Job in the upper Job DetailsJob DetailsJob DetailsJob Details portion of the 
Job History Details Job History Details Job History Details Job History Details dialog box.
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The Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box (shown below) lists individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities 
detected during an Audit of a Discovered database.

FIGURE: Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box

Hint: You can check the Show checks with no violation found to display 

checks that did not detect any vulnerabilities during your Audit.

Hint: In the Check Violation Messages portion of the Job Error Messages 

dialog box, you can generate an “on demand” Fix Script to repair 

individual vulnerabilities for a selected Audited database instance; for 

more information, see Running an “on demand” Fix Script to repair 

individual vulnerabilities detected on an individual Audited database 

instance.

Viewing the
properties of a
completed Job

To view the properties of a completed Job: 

1. Locate your completed Jobs. They display in the pane of the Manage Jobs page 

(Job History portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

2. Right click a completed Job and choose Show PropertiesShow PropertiesShow PropertiesShow Properties.
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The Job Properties Job Properties Job Properties Job Properties dialog box displays the Job’s properties, including: Template Template Template Template 
NameNameNameName, TypeTypeTypeType of Job (e.g., Pen TestPen TestPen TestPen Test), PolicyPolicyPolicyPolicy applied, whether an auto-generated Report 
is included, and all Applications that you Discovered, Penetration Tested, Audited, or 
Reported on.

FIGURE: Job Properties Job Properties Job Properties Job Properties dialog box

Click the CloseCloseCloseClose button to close the Job Properties Job Properties Job Properties Job Properties dialog box. 

Setting the refresh
rate of data on the
Manage Jobs page

Job data refreshes automatically according to whatever time interval (in seconds) you 
set on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

To set the refresh rate of Job data on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Locate the Refresh Refresh Refresh Refresh Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.
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3. Edit the Job data refresh rate of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page in the secondssecondssecondsseconds 
field, then click the SetSetSetSet button.

DbProtect Vulnerability Management changes the Job data refresh rate of the 
Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

Manually
refreshing data on
the Manage Jobs

Page

To manually refresh Job data on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Locate the Refresh Refresh Refresh Refresh Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

3. Click the RefreshRefreshRefreshRefresh button in the Refresh Refresh Refresh Refresh Toolbar.

DbProtect Vulnerability Management refreshes the Job data on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs 
page.

Scheduling email
notification upon
Job completion

DbProtect Vulnerability Management allows you to notify others via email when 
DbProtect Vulnerability Management completes a Job. This feature works for all types 
of Jobs, i.e., Discovery, Penetration Test, Audit, and Report Jobs.

Note:Note:Note:Note: In order to notify others via email when DbProtect Vulnerability 
Management completes a Job, DbProtect Super Admin, DbProtect 
Admin, or Vulnerability Management Admin mustmustmustmust first properly configure 
your Organization’s SMTP mail server information. Otherwise, the email 
notification of Job completion feature will notnotnotnot work. For more information, 
see Configuring SMTP Mail Server Information for Your Organization.
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To schedule email notification upon Job completion: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

Highlight one Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup portion).

Note:Note:Note:Note: You can only send email for one Job at a time. Do not select multiple Jobs.

2. Do one of the following to display the Specify E-Mail Recipients for <JOB Specify E-Mail Recipients for <JOB Specify E-Mail Recipients for <JOB Specify E-Mail Recipients for <JOB 
NAME> NAME> NAME> NAME> dialog box:

•  Click Set E-Mail Set E-Mail Set E-Mail Set E-Mail in the Job Setup Options Job Setup Options Job Setup Options Job Setup Options Toolbar

•  Right click the Job and choose Set E-Mail RecipientsSet E-Mail RecipientsSet E-Mail RecipientsSet E-Mail Recipients.

Note:Note:Note:Note: The same dialog box displays for all Job Types.

FIGURE: Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> dialog box
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Do the following:

•  Enter one email recipient’s email address (e.g., jsmith@company.com) in the 
Recipients:Recipients:Recipients:Recipients: field.

Caution! You can only enter one email recipient’s email address at a time.

•  Click the AddAddAddAdd button to add the email address to the field below the 
Recipients:Recipients:Recipients:Recipients: field.

•  Repeat to add as many email recipients’ email addresses as you want.

Hint: If you want to remove an email address, highlight the email address in the 

field below the Recipients: field, and click the Remove button.

Optionally, you can enter a message to your email recipients in the Optional Message: Optional Message: Optional Message: Optional Message: 
field.

Click the SaveSaveSaveSave button.

3. The Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> Specify E-Mail Recipients for <JOB NAME> dialog box closes. The 
Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job SetupJob SetupJob SetupJob Setup portion) displays email icons. A blue icon 
indicates the corresponding Job is configured to email at least one email 
recipient when the Job completes. A white icon indicates you have notnotnotnot 
configured the corresponding Job to email any email recipients when the 
Job completes.

FIGURE: Email notification icons

Remember: in order to notify others via email when DbProtect Vulnerability 
Management completes a Job, an Admin or Super Admin mustmustmustmust first properly 
configure your Organization’s SMTP mail server information. Otherwise, the email 
notification of Job completion feature will not work. For more information, see 
Configuring SMTP Mail Server Information for Your Organization.



DbProtect 6.1 User’s Guide

Application Security, Inc. 127

Working with the Dashboard
This chapter consists of the following topics:

•  Understanding the Dashboard

•  Refreshing the Dashboard

•  Adding an application to Discover

•  Filtering “unknown” Discovered servers

•  Detecting Oracle SIDs with a listener password.

Understanding the
Dashboard

The DashboardDashboardDashboardDashboard displays detailed data about applications Discovered on your network, 
recent Penetration Tests and Audits performed, and the number of vulnerabilities 
detected.

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

The columns in the pane of the Dashboard Dashboard Dashboard Dashboard display the following information:

•  IP address.IP address.IP address.IP address. The IP addresses of your Discovered applications.

•  Hostname. Hostname. Hostname. Hostname. The server hostnames of your Discovered applications.

Note:Note:Note:Note: For more information on the pane and other DbProtect Vulnerability 
Management UI components, see Understanding the DbProtect 
Vulnerability Management Portal User Interface (UI).

You can click the + + + + icons under the IP AddressIP AddressIP AddressIP Address column to display the Discovered 
applications. The DashboardDashboardDashboardDashboard displays the following detailed information:

•  IP addressesIP addressesIP addressesIP addresses and hostnameshostnameshostnameshostnames of the applications Discovered on your network; 
for more information, see Discovery Jobs

•  portsportsportsports where your Discovered applications are installed

•  statusstatusstatusstatus of your Discovered application (e.g., ActiveActiveActiveActive, InactiveInactiveInactiveInactive, etc.)

•  date/time of the last Pen TestPen TestPen TestPen Test or AuditAuditAuditAudit performed on each application, and the 
number of vulnerabilitiesnumber of vulnerabilitiesnumber of vulnerabilitiesnumber of vulnerabilities that were detected; for more information, see 
Penetration Test Jobs and Audit Jobs.
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Refreshing the
Dashboard

To refresh the data on the DashboardDashboardDashboardDashboard:

1. Do one of the following to display the Dashboard:

•  Choose Admin > Dashboard Admin > Dashboard Admin > Dashboard Admin > Dashboard from the menu.

•  Click the DashboardDashboardDashboardDashboard button on the toolbar. 

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

Do the following:

•  Locate the Controls Controls Controls Controls Toolbar on the DashboardDashboardDashboardDashboard.

•  Click the RefreshRefreshRefreshRefresh button in the Controls Controls Controls Controls Toolbar on the DashboardDashboardDashboardDashboard.

The DashboardDashboardDashboardDashboard refreshes the detailed data about applications Discovered on your 
network, recent Penetration Tests and Audits performed, and the number of 
vulnerabilities detected.

Adding an
application to

Discover

The DashboardDashboardDashboardDashboard allows you to add new applications (typically an Oracle SID or a DB2 
database) for DbProtect to Discover.

The reason this feature exists is because when you run an OracleOracleOracleOracle Discovery, DbProtect 
only detects the Oracle Listener (unless you specified a listener password during Scan 
Engine installation; for more information, see the DbProtect Installation Guide). In 
order to run an Audit or Pen Test on a Discovered Oracle database, the Oracle SID 
mustmustmustmust display in the DashboardDashboardDashboardDashboard. Therefore, in most cases, you must manually add the 
Oracle SID to the DashboardDashboardDashboardDashboard by following the steps in this topic.

The same is true for running Audit and Pen Test Jobs on DB2DB2DB2DB2. When you run a DB2DB2DB2DB2 
Discovery, DbProtect only detects the DB2 instance. In order to run an Audit or Pen 
Test on a Discovered DB2 database, the DB2 database mustmustmustmust display in the DashboardDashboardDashboardDashboard. 
Therefore, in most cases, you must manually add the DB2 database to the DashboardDashboardDashboardDashboard 
by following the steps in this topic.

Note:Note:Note:Note: If you want to delete an application to Discover delete an application to Discover delete an application to Discover delete an application to Discover from DbProtect, you must 
unschedule any scheduled Jobs associated with the application. For more 
information, see Unscheduling a Job.
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To add an application to Discover:

1. Do one of the following to display the Dashboard:

•  Choose Admin > Dashboard Admin > Dashboard Admin > Dashboard Admin > Dashboard from the menu.

•  Click the DashboardDashboardDashboardDashboard button on the toolbar. 

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

2. Do the following:

•  Click an Organization in the pane of the DashboardDashboardDashboardDashboard.

•  Locate the Controls Controls Controls Controls Toolbar on the DashboardDashboardDashboardDashboard. 

•  Click the Add ApplicationAdd ApplicationAdd ApplicationAdd Application button in the ControlsControlsControlsControls Toolbar on the DashboardDashboardDashboardDashboard to 
display the Application Setup Application Setup Application Setup Application Setup dialog box.

FIGURE: Add Application to OrganizationAdd Application to OrganizationAdd Application to OrganizationAdd Application to Organization dialog box

3. Do the following:

•  Enter the Hostname/IP: Hostname/IP: Hostname/IP: Hostname/IP: address of the new application.

•  Enter the Port: Port: Port: Port: number of the new application.

•  Use the Application Type:Application Type:Application Type:Application Type: drop-down to select an application type (e.g., DB2 DB2 DB2 DB2 
6.16.16.16.1, Lotus Notes/DominoLotus Notes/DominoLotus Notes/DominoLotus Notes/Domino, Oracle 10g DatabaseOracle 10g DatabaseOracle 10g DatabaseOracle 10g Database, Sybase 12.5 DatabaseSybase 12.5 DatabaseSybase 12.5 DatabaseSybase 12.5 Database, etc.).

•  Enter the database Instance Name:Instance Name:Instance Name:Instance Name: where the application database is installed.

•  Use the Platform: Platform: Platform: Platform: drop-down to select the application’s platform.
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4. Click the OKOKOKOK button.

The added application displays on the DashboardDashboardDashboardDashboard, under the selected Organization, 
and it will now be available when you create Penetration Test and Audit Jobs.

Filtering
“unknown”

Discovered servers

Sometimes a Discovery can’t figure out a server type. You can filter Discovered servers 
listed as an “Unknown” server type.

To refresh the data on the DashboardDashboardDashboardDashboard:

1. Do one of the following to display the Dashboard:

•  Choose Admin > Dashboard Admin > Dashboard Admin > Dashboard Admin > Dashboard from the menu.

•  Click the DashboardDashboardDashboardDashboard button on the toolbar. 

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

Locate the Dashboard Filters Dashboard Filters Dashboard Filters Dashboard Filters Toolbar on the DashboardDashboardDashboardDashboard.

You can:

•  check the Show... Unknown ServerShow... Unknown ServerShow... Unknown ServerShow... Unknown Server checkbox in the Dashboard FiltersDashboard FiltersDashboard FiltersDashboard Filters Toolbar to 
display “unknown” Discovered server types on the DashboardDashboardDashboardDashboard, in addition to 
Discovered servers of identifiable server types

•  uncheck the Show... Unknown ServerShow... Unknown ServerShow... Unknown ServerShow... Unknown Server checkbox in the Dashboard FiltersDashboard FiltersDashboard FiltersDashboard Filters Toolbar 
to display onlyonlyonlyonly Discovered servers of identifiable server types on the DashboardDashboardDashboardDashboard 
(and hide “unknown” Discovered server types).

The DashboardDashboardDashboardDashboard refreshes the results about Discovered servers on your network (i.e., 
filtered by “unknown” server types only, or all server types) according to whether you 
check or uncheck the Show... Unknown ServerShow... Unknown ServerShow... Unknown ServerShow... Unknown Server checkbox.



DbProtect 6.1 User’s Guide

Application Security, Inc. 131

Detecting Oracle
SIDs with a listener

password

When DbProtect Vulnerability Management Discovers an Oracle listener, it might not 
be able to find all the Oracle SIDs because the listener may require a password. 
DbProtect Vulnerability Management allows you to specify the listener password so 
the Scan Engine can find the missing Oracle SIDs.

Caution! You cannot manually detect Oracle SIDs if the target Oracle 

listener is not using the default listener name, and the version of 

Oracle is 10g or 11g.

To detect Oracle SIDs with a listener password:

1. Do one of the following to display the Dashboard:

•  Choose Admin > Dashboard Admin > Dashboard Admin > Dashboard Admin > Dashboard from the menu.

•  Click the DashboardDashboardDashboardDashboard button on the toolbar.

In the network tree view, right click a listener.

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

2. Click the + + + + icons under the IP AddressIP AddressIP AddressIP Address column to display the Discovered 
applications. For more information, see Understanding the Dashboard.
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3. Right click a Discovered Oracle listener, and choose Detect SIDS with Detect SIDS with Detect SIDS with Detect SIDS with 
Listener PasswordListener PasswordListener PasswordListener Password.

The Oracle SIDs Detection UtilityOracle SIDs Detection UtilityOracle SIDs Detection UtilityOracle SIDs Detection Utility pop up displays.

FIGURE: Oracle SIDs Detection UtilityOracle SIDs Detection UtilityOracle SIDs Detection UtilityOracle SIDs Detection Utility pop up

4. Enter the password for the specified listener.

5. Click the Detect SIDsDetect SIDsDetect SIDsDetect SIDs button.

6. Refresh the DashboardDashboardDashboardDashboard to see the updated applications list.
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Working with Scan Engines
This chapter consists of the following topics:

•  Understanding the Scan Engines page

•  Registering and unregistering a Scan Engine

•  Monitoring the health of your Scan Engines

•  Editing a Scan Engine

•  Configuring the properties of a Scan Engine

•  Setting the Scan Engine refresh rate

•  Manually refreshing the Scan Engine.

Understanding the
Scan Engines page

The Scan EnginesScan EnginesScan EnginesScan Engines page (shown below) allows you to manage your installed and 
configured Scan Engines. Specifically, the Scan EnginesScan EnginesScan EnginesScan Engines page allows you to register 
your installed/configured Scan Engines, set the Scan Engine refresh rate, manually 
refresh the Scan Engine, monitor the “health” of your installed/configured/registered 
Scan Engines, or run an ASAP Update to obtain the latest Scan Engine software.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

The columns in the pane of the Scan Engines Scan Engines Scan Engines Scan Engines page    display the following information:

•  Scan Engine.Scan Engine.Scan Engine.Scan Engine. The names of your installed and registered Scan Engines.

•  Address.Address.Address.Address. The hostnames or IP addresses where your Scan Engines are installed 
and registered.

•  Port.Port.Port.Port. The ports where your installed and registered Scan Engines “listen” to 
incoming network traffic.

•  Status.Status.Status.Status. The status of your installed and registered Scan Engines (i.e., OnlineOnlineOnlineOnline, 
OfflineOfflineOfflineOffline, UnknownUnknownUnknownUnknown, and UpdatingUpdatingUpdatingUpdating).

•  Version.Version.Version.Version. The versions of your installed and registered Scan Engines.

•  # Jobs Running.# Jobs Running.# Jobs Running.# Jobs Running. How many Scan Engines are actively running.

Note:Note:Note:Note: For more information on the pane and other DbProtect Vulnerability 
Management UI components, see Understanding the DbProtect 
Vulnerability Management Portal User Interface (UI).
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Specifically, the Scan Engines Scan Engines Scan Engines Scan Engines page allows you to:

•  register an installed/configured Scan Engine; for more information, see 
Registering a Scan Engine

•  monitor the “health” of your Scan Engine; for more information, see Monitoring 
the health of your Scan Engines

•  edit your Scan Engines; for more information, see Editing a Scan Engine

•  configure the properties of your Scan Engines; for more information, see 
Configuring the properties of a Scan Engine

•  set the Scan Engine refresh rate (from the Scan EnginesScan EnginesScan EnginesScan Engines page); for more 
information, see Setting the Scan Engine refresh rate

•  manually refresh the Scan Engine (from the Scan EnginesScan EnginesScan EnginesScan Engines page); for more 
information, see Manually refreshing the Scan Engine.

Registering and
unregistering a

Scan Engine

The Scan EnginesScan EnginesScan EnginesScan Engines page allows you to registerregisterregisterregister each installed/configured Scan Engine 
on your network. The Scan EnginesScan EnginesScan EnginesScan Engines page also allows you to unregisterunregisterunregisterunregister a registered 
Scan Engine.

Registration involves the specification of:

•  a hostname or IP address where the Scan Engine is installed

•  the port where the Scan Engine “listens” to incoming network traffic

•  an IP address range (or the name of a host machine) which define the extent to 
which the Scan Engine can scan/test applications on your network.

This topic consists of the following sub-topics:

•  Registering a Scan Engine

•  Unregistering a Scan Engine.

REGISTERING A SCAN ENGINE

To register a Scan Engine: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page
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2. Do one of the following to display the Register Scan Engine Register Scan Engine Register Scan Engine Register Scan Engine dialog box:

•  Choose Scan Engines > Register Scan Engines > Register Scan Engines > Register Scan Engines > Register from the menu.

•  Click the RegisterRegisterRegisterRegister button in the Controls portion.

FIGURE: First Register Scan EngineRegister Scan EngineRegister Scan EngineRegister Scan Engine dialog box

3. The upper    portion of the dialog box allows you to enter the information 
you specified during Scan Engine installation and configuration. 
Specifically, you mustmustmustmust enter the:

•  Scan Engine Description/Alias

•  Hostname or IP AddressHostname or IP AddressHostname or IP AddressHostname or IP Address where the Scan Engine is installed; for more 
information, see the DbProtect Installation Guide

Caution! Do not register your Scan Engine with hostname='localhost'. You 

must specify either the correct hostname or a valid IP address.

•  PortPortPortPort where the Scan Engine “listens” to incoming network traffic; for more 
information, see the DbProtect Installation Guide.

4. The Scan Engine Accessible IP Address RangeScan Engine Accessible IP Address RangeScan Engine Accessible IP Address RangeScan Engine Accessible IP Address Range portion of the Register Scan Register Scan Register Scan Register Scan 
EngineEngineEngineEngine dialog box allows you to specify ranges of IP addresses (or enter 
the name of a host machine), which define the extent to which the Scan 
Engine can scan/test applications on your network.

Example: Example: Example: Example: You can exclude the IP address range 192.168.1.1 through 192.168.1.100 
when performing a Discovery using this registered Scan Engine.

•  In the Scan Engine Accessible IP Address RangeScan Engine Accessible IP Address RangeScan Engine Accessible IP Address RangeScan Engine Accessible IP Address Range portion of the first Register Register Register Register 
Scan EngineScan EngineScan EngineScan Engine dialog box, you can do the following:

•  Select whether you want to includeincludeincludeinclude or exclude exclude exclude exclude ranges of IP addresses (or IP 
addresses on host machines) by selecting Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range.

•  Enter a machine host name in the HostnameHostnameHostnameHostname field.

•  Click the AddAddAddAdd button to add the IP addresses of a host machine to the include 
or exclude list (depending whether you chose Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range, 
above).
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•  Enter an IP address range (for example, 192.168.1.1 through 192.168.1.100) 
in the From: From: From: From: and To: To: To: To: fields.

•  Click the AddAddAddAdd button to add the IP addresses to the include or exclude list 
(depending whether you chose Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range, above).

Hint: To remove an IP address range from either the include or exclude list, 

highlight the range, then click the Remove button.

•  Click the Load IP Ranges From FileLoad IP Ranges From FileLoad IP Ranges From FileLoad IP Ranges From File button to display an OpenOpenOpenOpen dialog box and 
upload a standard text file (using the format ip or ip-ip).

5. Click the NextNextNextNext button to display the Network Interface Card SelectionNetwork Interface Card SelectionNetwork Interface Card SelectionNetwork Interface Card Selection 
dialog box.

FIGURE: Network Interface Card SelectionNetwork Interface Card SelectionNetwork Interface Card SelectionNetwork Interface Card Selection dialog box

A network interface cardnetwork interface cardnetwork interface cardnetwork interface card (NIC) (NIC) (NIC) (NIC) is used to connect your computer to an Ethernet 
network. The card provides an interface to DbProtect Vulnerability Management. 
During Scan Engine registration, DbProtect Vulnerability Management identifies all 
available NICs.

Use the Select a Network InterfaceSelect a Network InterfaceSelect a Network InterfaceSelect a Network Interface drop-down to select which NIC you want the Scan 
Engine to use. The Interface DetailsInterface DetailsInterface DetailsInterface Details display on the right half of the dialog box.

6. Click the RegisterRegisterRegisterRegister button to register your Scan Engine.

Your Scan Engine is registered.
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UNREGISTERING A SCAN ENGINE

To unregister a Scan Engine: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

2. Do the following:

•  Highlight one more registered Scan Engines.

Hint: Click <CTRL> to highlight non-sequential registered Scan Engines.

•  Right click the registered Scan Engine(s) and select UnregisterUnregisterUnregisterUnregister.

•  A Confirm Unregister Confirm Unregister Confirm Unregister Confirm Unregister pop up prompts you to confirm the unregistration.

FIGURE: Confirm Delete Confirm Delete Confirm Delete Confirm Delete pop up

•  Click the YesYesYesYes button to unregister the registered Scan Engines.

•  The registered Scan Engines disappear from the pane of the Scan Engines Scan Engines Scan Engines Scan Engines 
page.
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Monitoring the
health of your Scan

Engines

You can monitor the “health” of your installed/configured/registered Scan Engines via 
the Scan Engines Scan Engines Scan Engines Scan Engines page. If DbProtect Vulnerability Management is notnotnotnot detecting 
vulnerabilities, it couldcouldcouldcould be because your Scan Engine is “unhealthy”.

A “healthy” Scan Engine is:

•  “up and running”“up and running”“up and running”“up and running” on the machine where it is installed

•  actively Discovering applicationsactively Discovering applicationsactively Discovering applicationsactively Discovering applications on this machine’s database SIDs/instances (on 
which it can Penetration Tests and Audits)

•  activelyactivelyactivelyactively collecting/interpreting data and detecting vulnerabilitiescollecting/interpreting data and detecting vulnerabilitiescollecting/interpreting data and detecting vulnerabilitiescollecting/interpreting data and detecting vulnerabilities.

To monitor the “health” of your Scan Engines: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

2. For each installed/configured Scan Engine, you can view its:

•  name in the Scan EngineScan EngineScan EngineScan Engine column

•  IP address in the AddressAddressAddressAddress column

•  installation port in the PortPortPortPort column

•  status in the StatusStatusStatusStatus column

Important: If the StatusStatusStatusStatus of your Scan Engine is DownDownDownDown, this indicates your Scan Engine 
is “unhealthy”.

•  software version in the VersionVersionVersionVersion column.
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Editing a Scan
Engine

DbProtect Vulnerability Management allows you to editediteditedit the parameters of a registered    
Scan Engine on your network; for more information on Scan Engine registration, see 
the DbProtect Installation Guide).

To edit a Scan Engine: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page
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2. Do one of the following to display the Edit Scan Engine Edit Scan Engine Edit Scan Engine Edit Scan Engine dialog box:

•  Choose Scan Engines > Edit Scan Engines > Edit Scan Engines > Edit Scan Engines > Edit from the menu.

•  Right click a Scan Engine (in the Scan EnginesScan EnginesScan EnginesScan Engines portion of the Scan EnginesScan EnginesScan EnginesScan Engines 
page) and choose EditEditEditEdit.

3. The IdentityIdentityIdentityIdentity portion of the Edit Scan Engine Edit Scan Engine Edit Scan Engine Edit Scan Engine dialog box allows you to edit 
the Scan Engine Description/AliasScan Engine Description/AliasScan Engine Description/AliasScan Engine Description/Alias you specified during Scan Engine 
registration; for more information, see Registering a Scan Engine.

4. The Accessible IP Address RangeAccessible IP Address RangeAccessible IP Address RangeAccessible IP Address Range portion of the Edit Scan EngineEdit Scan EngineEdit Scan EngineEdit Scan Engine dialog 
box allows you to edit ranges of IP addresses (or edit the name of a host 
machine), which define the extent to which the Scan Engine can scan/test 
applications on your network.

Example: Example: Example: Example: You can exclude the IP address range 192.168.1.1 through 
192.168.1.100 when performing a Discovery using this registered Scan Engine.

In the Accessible IP Address RangeAccessible IP Address RangeAccessible IP Address RangeAccessible IP Address Range portion of the Edit Scan EngineEdit Scan EngineEdit Scan EngineEdit Scan Engine dialog box, you 
can do the following:

•  Select whether you want to includeincludeincludeinclude or exclude exclude exclude exclude ranges of IP addresses (or IP 
addresses on host machines) by selecting Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range.
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•  Edit a machine host name in the HostnameHostnameHostnameHostname field.

•  Click the AddAddAddAdd button to add the IP addresses of a host machine to the include 
or exclude list (depending whether you chose Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range, 
above).

•  Edit an IP address range (for example, 192.168.1.1 through 192.168.1.100) 
in the From: From: From: From: and To: To: To: To: fields.

•  Click the AddAddAddAdd button to add the IP addresses to the include or exclude list 
(depending whether you chose Include RangeInclude RangeInclude RangeInclude Range or Exclude RangeExclude RangeExclude RangeExclude Range, above).

Hint: To remove an IP address range from either the include or exclude list, 

highlight the range, then click the Remove button.

5. The Concurrency Limits and Availability Concurrency Limits and Availability Concurrency Limits and Availability Concurrency Limits and Availability portion of the Edit Scan EngineEdit Scan EngineEdit Scan EngineEdit Scan Engine 
dialog box allows you to modify the maximum concurrent tests that may 
be performed on the Scan Engine, and to specify whether the Scan Engine 
is available for Penetration Test, Audit, and Discovery Jobs.

In the Maximum concurrent tests:Maximum concurrent tests:Maximum concurrent tests:Maximum concurrent tests: field, you can enter the maximum number of 
concurrent Jobs (for Discovery, Penetration Tests, and Audits only) the Scan Engine is 
allowed to run at the same time. The maximum value is 20 Jobs, although this great a 
value is notnotnotnot recommended.

Note:Note:Note:Note: You can run an unlimited number of Report Jobs. Therefore, the value you 
enter in the Maximum concurrent tests: field only applies to Discovery, 
Penetration Tests, and Audits.

If you install a Scan Engine on:

•  the same server as the DbProtect Console, the default Maximum concurrent Maximum concurrent Maximum concurrent Maximum concurrent 
tests:tests:tests:tests: value is 3 (i.e., the Scan Engine can run a maximum of three Discoveries, 
Penetration Tests, and Audits concurrently)

•  a remote server, the default Maximum concurrent tests:Maximum concurrent tests:Maximum concurrent tests:Maximum concurrent tests: value is 10 (i.e., the 
Scan Engine can run a maximum of 10 Discoveries, Penetration Tests, and 
Audits concurrently).

Hint: Depending on the capacity of your local or remote Scan Engine server, you 

can increase or decrease the Maximum concurrent tests: value, 

accordingly. 

For example, if your Scan Engine is installed on a powerful server with 

multiple CPUs and several gigabytes of RAM, you can probably increase 

the default Maximum concurrent tests: value. However, if your Scan 

Engine server is not especially powerful, or is installed on a virtual machine 

(VM), and you notice a decrease in performance, you may instead want to 

decrease the default Maximum concurrent tests: value.

Also, you can check Set Scan Engine available for testsSet Scan Engine available for testsSet Scan Engine available for testsSet Scan Engine available for tests to specify whether the Scan 
Engine is available for test. If unchecked, you can’t use this Scan Engine for tests.
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6. Click the Save Save Save Save button to save your edited, registered Scan Engine values.

Your edited, registered Scan Engine values are saved.

Configuring the
properties of a

Scan Engine

If you are an administrator, DbProtect Vulnerability Management allows you to 
configure the advanced propertiespropertiespropertiesproperties of a registered Scan Engine, e.g., hide/display 
cracked User passwords, network and Discovery parameters, password parameters, 
etc.

This topic consists of the following sub-topics:

•  Displaying the Properties branches

•  Understanding the Properties branches.

DISPLAYING THE PROPERTIES BRANCHES

To display the PropertiesPropertiesPropertiesProperties branches: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

2. Right click a Scan Engine (in the Scan EnginesScan EnginesScan EnginesScan Engines portion of the Scan EnginesScan EnginesScan EnginesScan Engines 
page) and choose PropertiesPropertiesPropertiesProperties.
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The Options Options Options Options dialog box displays the PropertiesPropertiesPropertiesProperties branches.

FIGURE: OptionsOptionsOptionsOptions dialog box

UNDERSTANDING THE PROPERTIES BRANCHES

The following table explains the PropertiesPropertiesPropertiesProperties branches:

Branch Description

Backend TimeoutBackend TimeoutBackend TimeoutBackend Timeout This branch allows you to enter a Command TimeoutCommand TimeoutCommand TimeoutCommand Timeout (in 
seconds), which specifies the maximum number of seconds the 
Scan Engine wait for a SQL command to complete. This is only 
for SQL commands that have been executed against its 
backend database.

In order for this value to take effect, restart the Scan Engine. 
Changing this value may result in unpredictable Scan Engine 
behavior. Specify zero seconds for infinite timeout.

ReportsReportsReportsReports Some Audits and Penetration Tests crack passwords. This 
branch allows you to:

• hide cracked User passwords in DbProtect Vulnerability 
Management Reports using *****, then check the Hide Hide Hide Hide 
Cracked Passwords Cracked Passwords Cracked Passwords Cracked Passwords checkbox

• display cracked User passwords in DbProtect Vulnerability 
Management Reports, then uncheck the Hide Cracked Hide Cracked Hide Cracked Hide Cracked 
Passwords Passwords Passwords Passwords checkbox.
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DiscoveryDiscoveryDiscoveryDiscovery This branch allows you to change the Scan Engine Discovery 
parameters. This tab consists of three sub-branches:

• Timeout. Timeout. Timeout. Timeout. This sub-branch allows you to specify the amount 
of time the Scan Engine should wait before generating a 
timeout error during a Discovery.

• Network Parameters. Network Parameters. Network Parameters. Network Parameters. This sub-branch allows you to specify 
the delay and concurrent number of IP addresses for the 
Scan Engine. Delay is the amount of time the Scan Engine 
waits between sending packets out to the network. The 
concurrent number IP addresses deals with how many IP 
addresses to Discover against at the same time. When the 
limit is reached, the Scan Engine pauses until responses 
come back from the previously-Discovered IPs.

• Discovery Parameters. Discovery Parameters. Discovery Parameters. Discovery Parameters. This sub-branch allows you to select 
an option to Check responsive ports even if IP address is Check responsive ports even if IP address is Check responsive ports even if IP address is Check responsive ports even if IP address is 
not responsivenot responsivenot responsivenot responsive.

If unchecked (default), DbProtect Vulnerability Management 
probes one port (for each IP address) to determine if the 
machine is responsive. If the machine is responsiveresponsiveresponsiveresponsive, 
Discovery probes all ports for the IP address to scan 
applications. If the machine is unresponsiveunresponsiveunresponsiveunresponsive, Discovery ends 
for this IP address. DbProtect Vulnerability Management 
does notnotnotnot probe the rest of the ports for this IP address. If 
checked, DbProtect Vulnerability Management probes all 
ports of each IP address to scan applications.

Branch Description
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Pen Testing/AuditingPen Testing/AuditingPen Testing/AuditingPen Testing/Auditing This branch allows you to set the parameters for use during a 
Penetration Test or Audit. This branch consists of six sub-
branches.

• Timeout. Timeout. Timeout. Timeout. Allows the User to configure the timeout period 
between checks before generating a timeout error.

• Oracle.Oracle.Oracle.Oracle. This branch also allows you to select the OPatch OPatch OPatch OPatch 
data collection methoddata collection methoddata collection methoddata collection method. You can select:

- Use Java Method. This method uses existing Java 

configured on the target database server to collect the 

OPatch data. 

- Use OS (Operating System) Method (default). This method 

detects if the Oracle CPU has been applied to your Oracle 

database. This method requires you to supply OS 

credentials, in addition to a valid database account.

For more information, see Appendix D: Oracle Critical Patch 
Update Detection.

• Lotus Notes/Domino. Lotus Notes/Domino. Lotus Notes/Domino. Lotus Notes/Domino. Reset the Lotus Notes/Domino 
Groupware session after a specified number of connections 
has been made. This will free up cached memory used by 
the Lotus Notes/Domino APIs.

Note:Note:Note:Note: DbProtect Vulnerability Management does notnotnotnot perform 
Audits on Lotus Notes/Domino applications.

•••• Microsoft SQL Server.Microsoft SQL Server.Microsoft SQL Server.Microsoft SQL Server.

-Attempt to use Windows Authentication when Attempt to use Windows Authentication when Attempt to use Windows Authentication when Attempt to use Windows Authentication when 
performing a Pen Test on Microsoft SQL Serverperforming a Pen Test on Microsoft SQL Serverperforming a Pen Test on Microsoft SQL Serverperforming a Pen Test on Microsoft SQL Server.... 
Uncheck to force the Scan Engine to skip this step, 
which enhances information gathering.

-Connect to Microsoft SQL Servers via Named PipesConnect to Microsoft SQL Servers via Named PipesConnect to Microsoft SQL Servers via Named PipesConnect to Microsoft SQL Servers via Named Pipes.... 
Check to force the Scan Engine to use named pipes.

• DB2 Mainframe. DB2 Mainframe. DB2 Mainframe. DB2 Mainframe. Allows you to select which security option 
DbProtect Vulnerability Management should use to 
authenticate a DB2 mainframe application. You can select:

----Use authentication value in server’s DBM Use authentication value in server’s DBM Use authentication value in server’s DBM Use authentication value in server’s DBM 
configurationconfigurationconfigurationconfiguration
----Client authenticationClient authenticationClient authenticationClient authentication
----Server authenticationServer authenticationServer authenticationServer authentication
----Server authentication with encryptionServer authentication with encryptionServer authentication with encryptionServer authentication with encryption
----DDCS authenticationDDCS authenticationDDCS authenticationDDCS authentication

-DDCS authentication with encryptionDDCS authentication with encryptionDDCS authentication with encryptionDDCS authentication with encryption.

Branch Description
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TracingTracingTracingTracing This branch allows you to enable tracing, which collects details 
about the Scan Engine tasks for the purposes of 
troubleshooting with Application Security, Inc. Technical 
Support. You can set the tracing level to:

•••• DebugDebugDebugDebug

•••• NormalNormalNormalNormal

•••• WarningWarningWarningWarning

•••• ErrorErrorErrorError

•••• CriticalCriticalCriticalCritical

• OffOffOffOff.

Note:Note:Note:Note: Application Security, Inc. recommends you turn the 
tracing level to OffOffOffOff, unless otherwise instructed by 
Application Security, Inc. Technical Support.

PasswordsPasswordsPasswordsPasswords This branch allows you to set the following Scan Engine 
password parameter:

• Oracle Listener. Oracle Listener. Oracle Listener. Oracle Listener. This tab records a default value to try as the 
Oracle Listener password, when DbProtect Vulnerability 
Management encounters an Oracle Listener with a 
password set on it.

Branch Description
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Check Point InfoCheck Point InfoCheck Point InfoCheck Point Info The Scan Engine allows you to forward Penetration Test and 
Audit results from an Scan Engine to a Check Point Event 
Logging Server (Check Point SmartView Tracker). This branch 
allows you to send a log entry for every vulnerability a Check 
Point Event Logging Server.

This branch consists of the following fields:

• Enable Check Point SmartCenter Server logging. Enable Check Point SmartCenter Server logging. Enable Check Point SmartCenter Server logging. Enable Check Point SmartCenter Server logging. Check to 
enable logging capability.

• Authentication Type. Authentication Type. Authentication Type. Authentication Type. Allows you to specify an 
authentication method. Check Point provides several 
methods. Application Security, Inc. recommends SSLCA for 
log sending.

• Target Server IP Address. Target Server IP Address. Target Server IP Address. Target Server IP Address. Allows you to specify the server 
machine where Check Point SmartCenter Server is installed.

• Target Server Port.Target Server Port.Target Server Port.Target Server Port. Allows you to specify the port on the 
server machine where the Check Point ELA Server is 
enabled.

• Target SIC Name. Target SIC Name. Target SIC Name. Target SIC Name. This field allows you enter the Secure 
Internal Communication (SIC) name of your Check Point 
SmartCenter Server. SIC is Check Point’s proprietary internal 
communication method for the components within a Next 
Generation (NG) Check Point System. In order for the Scan 
Engine to communicate with a Check Point SmartCenter 
server in SSLCA mode, the SIC name of the Check Point 
SmartCenter Server is required.

• Client SIC Name. Client SIC Name. Client SIC Name. Client SIC Name. For SSLCA authentication, Check Point 
requires each client to be registered on Check Point 
SmartCenter Console. This field allows you to add the 
computer where the Scan Engine is installed.

• P12 Key File.P12 Key File.P12 Key File.P12 Key File. Allows you to enter the location of the .p12 
file generated after you execute the opsec_pull_ 
certificate.exe command. You can click the BrowseBrowseBrowseBrowse 
button to search for the .p12 file on your computer.

Branch Description
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Setting the Scan
Engine refresh rate

Scan Engines refresh automatically according to whatever time interval (in seconds) 
you set on the Scan Engines Scan Engines Scan Engines Scan Engines page (explained in this topic). Or you can manually 
refresh the Scan Engines from the Scan EnginesScan EnginesScan EnginesScan Engines page; for more information, see 
Manually refreshing data on the Manage Jobs Page.

To set the Scan Engine refresh rate: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

2. Edit the Scan Engine refresh rate in the secondssecondssecondsseconds field and click the SetSetSetSet 
button.

DbProtect Vulnerability Management changes your Scan Engine refresh rate.
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Manually
refreshing the Scan

Engine

You can manually refresh the Scan Engines from the Scan EnginesScan EnginesScan EnginesScan Engines page (explained in 
this topic). Normally, Scan Engines refresh automatically according to the time interval 
(in seconds) specified on the Scan EnginesScan EnginesScan EnginesScan Engines page; for more information, see Setting the 
Scan Engine refresh rate.

To manually refresh the Scan Engine: 

1. Do one of the following to display the Scan Engines page:

•  Choose Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines Admin > Scan Engines from the menu

•  Click the Scan Engines Scan Engines Scan Engines Scan Engines tab.

FIGURE: Scan EnginesScan EnginesScan EnginesScan Engines page

2. Click the RefreshRefreshRefreshRefresh button in the ControlsControlsControlsControls portion.

DbProtect Vulnerability Management refreshes the status of your Scan Engines.
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Working with Policies
This chapter consists of the following topics:

•  What are Policies?

•  Built-In Audit Policies

•  Built-In Penetration Test Policies

•  Viewing a Policy

•  Creating a Policy

•  Editing a Policy

•  Renaming a Policy

•  Searching Policies

•  Adding and deleting Exceptions

•  Importing a Policy

•  Exporting a Policy.

What are Policies? PoliciesPoliciesPoliciesPolicies are sets of security checks used by DbProtect Vulnerability Management to 
perform Penetration Tests and Audits. DbProtect Vulnerability Management includes 
built-in Policies which you can use "out of the box". For more information, see Built-In 
Audit Policies and Built-In Penetration Test Policies.

Built-In Audit
Policies

DbProtect Vulnerability Management includes the following built-in Audit Policies.

Note:Note:Note:Note: Built-in Policies cannotcannotcannotcannot be modified. However, you can edit a built-in Policy 
and perform a "save as" to save the edited Policy under a different name. 
For more information, see Editing a Policy.

•  Base Line. Base Line. Base Line. Base Line. Provides an adequate level of security for most applications in the 
government, financial services, and healthcare industries. Provides maximum 
security without sacrificing performance and functionality.

•  FISMA. FISMA. FISMA. FISMA. This Policy is structured following NIST standards and is recommended 
for use in a FISMA compliance assessment.

•  Basel II. Basel II. Basel II. Basel II. This Policy is structured for use in a Basel II compliance assessment.

•  Integrity. Integrity. Integrity. Integrity. This Policy is used to Audit the integrity of an application and the 
underlying operating system.

•  Best Practices for Federal Government.Best Practices for Federal Government.Best Practices for Federal Government.Best Practices for Federal Government. Based on CIS, NSA SNAC, DISA 
Database STIG, NIST 800-53, and Best Practices defined by Application 
Security's Team SHATTER.

•  Operating System. Operating System. Operating System. Operating System. A Policy that checks the service, registry, and file portions of 
a database. It requires an authenticated account to the physical machine 
running the database.
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•  Download. Download. Download. Download. A default Policy that allows an evaluator the chance to test specific 
checks.

•  MITS. MITS. MITS. MITS. This Policy is structured following CoBIT, ISO, and NIST standards and is 
recommended for use in a MITS compliance assessment.

•  Passwords.Passwords.Passwords.Passwords. This Policy is used to Audit password strength and settings.

•  DISA-STIG Database Security Configuration. DISA-STIG Database Security Configuration. DISA-STIG Database Security Configuration. DISA-STIG Database Security Configuration. This policy has been created with 
guidance of the configuration parameters outlined by the DISA-STIG for SQL 
Server and Oracle only.

•  Authorization. Authorization. Authorization. Authorization. This Policy is used to Audit permissions and access controls.

•  PCI Data Security Standard.PCI Data Security Standard.PCI Data Security Standard.PCI Data Security Standard. This Policy is structured following the PCI Data 
Security Standard and is recommended for use in a compliance assessment.

•  Sarbanes-Oxley. Sarbanes-Oxley. Sarbanes-Oxley. Sarbanes-Oxley. This policy is structured following CoBIT and ISO 17799 
standards and is recommended for use in a Sarbanes-Oxley compliance 
assessment.

•  Strict. Strict. Strict. Strict. Provides a maximum level of security with a significant impact on 
functionality. This Policy is much more restrictive than required by most 
applications. Usually used by only the most top secret applications.

•  Massachusetts 201 CMR.Massachusetts 201 CMR.Massachusetts 201 CMR.Massachusetts 201 CMR. TBA

•  MiFID.MiFID.MiFID.MiFID. This Policy is structured for use in a Markets in Financial Instruments 
Directive (MiFID) compliance assessment.

•  EU Data Protection Directive.EU Data Protection Directive.EU Data Protection Directive.EU Data Protection Directive. This Policy is structured following EU 95/46/EC 
standards and is recommened for use in a EU Data Protection Directive 
compliance assessment.

•  Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. This Policy is structured following Gramm-Leach-Bliley 
Act (GLBA) standards and is recommened for use in a GLBA compliance 
assessment.

•  HIPAA.HIPAA.HIPAA.HIPAA. This Policy is structured following NIST standards and best practices for 
database security and is recommended for use in a HIPAA compliance 
assessment.

Built-In
Penetration Test

Policies

DbProtect Vulnerability Management includes the following built-in Penetration Test 
Policies.

Note:Note:Note:Note: Built-in Policies cannotcannotcannotcannot be modified. However, you can edit a built-in Policy 
and perform a "save as" to save the edited Policy under a different name. 
For more information, see Editing a Policy.

•  HIPAA.HIPAA.HIPAA.HIPAA. This Policy is structured following NIST standards and best practices for 
database security and is recommended for use in a HIPAA compliance 
assessment.

•  PCI Data Security Standard. PCI Data Security Standard. PCI Data Security Standard. PCI Data Security Standard. This Policy is structured following the PCI Data 
Security Standard and is recommended for use in a compliance assessment.
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•  Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. Gramm-Leach-Bliley Act. This Policy is structured following Gramm-Leach-Bliley 
Act (GLBA) standards and is recommened for use in a GLBA compliance 
assessment.

•  Demo.Demo.Demo.Demo. Runs a demonstration of DbProtect Vulnerability Management features. 
This demo runs quickly, returning a maximum number of vulnerabilities in a 
short period of time.

•  Sarbanes-Oxley.Sarbanes-Oxley.Sarbanes-Oxley.Sarbanes-Oxley. This Policy is structured following CoBIT and ISO 17799 
standards and is recommended for use in a Sarbanes-Oxley compliance 
assessment.

•  Evaluation. Evaluation. Evaluation. Evaluation. Performs a Penetration Test using basic checks, allowing you to 
evaluate DbProtect Vulnerability Management.

•  FISMA.FISMA.FISMA.FISMA. This Policy is structured following NIST standards and is recommended 
for use in a FISMA compliance assessment.

•  Safe. Safe. Safe. Safe. Runs safe checks only. This Policy does not perform Brute Force or Denial 
of Service checks that cannot be run safely.

•  Basel II. Basel II. Basel II. Basel II. This Policy is structured for use in a Basel II compliance assessment.

•  Full. Full. Full. Full. Performs a complete Penetration Test of your application using all 
available checks.

•  EU Data Protection Directive.EU Data Protection Directive.EU Data Protection Directive.EU Data Protection Directive. This Policy is structured following EU 95/46/EC 
standards and is recommened for use in a EU Data Protection Directive 
compliance assessment.

•  Brute Force.Brute Force.Brute Force.Brute Force. Performs a Penetration Test designed to test the strength of your 
applications’ passwords as well as other mechanisms that may be breached by 
brute force methods.

•  Heavy.Heavy.Heavy.Heavy. Performs a detail-level Penetration Test on your applications. Adds a 
heavy amount of usage. May take more than one hour to run.

•  Download.Download.Download.Download. A default Policy that allows you to test specific checks.

•  MiFID.MiFID.MiFID.MiFID. This Policy is structured for use in a Markets in Financial Instruments 
Directive (MiFID) compliance assessment.

•  Light. Light. Light. Light. Performs a first-level Penetration Test on your application. Adds a 
minimal amount of usage. Should take less than one minute to run.

•  Medium. Medium. Medium. Medium. Performs a second level Penetration Test on an application. Adds a 
moderate amount of usage on the application. Should take less than 15 
minutes to run.

•  Denial of Service.Denial of Service.Denial of Service.Denial of Service. This Policy checks if your applications are vulnerable to any 
Denial of Service (DoS) attacks by looking at the version and platform of the 
database or listener.
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Viewing a Policy DbProtect Vulnerability Management allows you to view a Policy (for either a 
Penetration Test or an Audit), including what security checks it contains.

To view a Policy:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: PoliciesPoliciesPoliciesPolicies dialog box

2. Click the Pen Test PoliciesPen Test PoliciesPen Test PoliciesPen Test Policies or Audit PoliciesAudit PoliciesAudit PoliciesAudit Policies tab.

3. Select a Policy.

4. Click the View Selected  View Selected  View Selected  View Selected button to display the Policy EditorPolicy EditorPolicy EditorPolicy Editor.

5. View which security checks are active within the chosen Policy. (Security 
checks with check marks next to them are activeactiveactiveactive.)

6. Click an individual security check to display its detailed description.
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Creating a Policy DbProtect Vulnerability Management allows you to create a Policy (for either a 
Penetration Test or an Audit), including what security checks it contains. This is known 
as a User-defined PolicyUser-defined PolicyUser-defined PolicyUser-defined Policy.

Note:Note:Note:Note: Some security checks allow you to customize your Policies by excluding 
individual checks (known as Exceptions). You can only add Exceptions to/
delete Exceptions from User-defined Policies. A check must be enabled in 
order to add/delete an Exception. For more information, see Adding and 
deleting Exceptions.

To create a Policy:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: PoliciesPoliciesPoliciesPolicies dialog box

2. Click the Pen Test Policies Pen Test Policies Pen Test Policies Pen Test Policies or Audit Policies Audit Policies Audit Policies Audit Policies tab.

3. Click the New PolicyNew PolicyNew PolicyNew Policy button to display the Policy EditorPolicy EditorPolicy EditorPolicy Editor.

4. Activate security checks by checking the corresponding checkboxes.
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Note:Note:Note:Note: Optionally, some checks allow you to customize your Policies by excluding 
individual checks (known as ExceptionsExceptionsExceptionsExceptions). You can only add Exceptions to/
delete Exceptions from User-defined Policies, notnotnotnot built-in Policies. A check 
mustmustmustmust be enabled in order to add/delete an Exception. For more 
information, see Adding and deleting Exceptions.

5. Click the SaveSaveSaveSave button on the toolbar to display the Save New PolicySave New PolicySave New PolicySave New Policy pop 
up.

6. Enter the new Policy name in the Policy NamePolicy NamePolicy NamePolicy Name field (required).

7. Enter the new Policy description in the Policy Description Policy Description Policy Description Policy Description field (optional).

8. Click the OKOKOKOK button.

DbProtect Vulnerability Management saves your new Policy.

9. You mustmustmustmust edit the permissions for each individual Organization and each 
individual User who is allowed to use this new Policy; for more information, 
see Editing an Organization and Editing a User, respectively.
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Editing a Policy DbProtect Vulnerability Management allows you to edit a Policy.

Note:Note:Note:Note: You cannotcannotcannotcannot modify built-in Policies. However, you cancancancan edit a built-in Policy 
and perform a "save as" to save the edited Policy under a different name.

To edit a Policy: 

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: PoliciesPoliciesPoliciesPolicies dialog box

2. Click the Pen Test Policies Pen Test Policies Pen Test Policies Pen Test Policies or Audit Policies  Audit Policies  Audit Policies  Audit Policies tab.

3. Select a Policy.

4. Click the View Selected View Selected View Selected View Selected button to display the Policy EditorPolicy EditorPolicy EditorPolicy Editor.

5. Activate/deactivate security checks within the chosen Policy by checking/
unchecking the checkboxes, respectively.
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6. Optionally, some checks allow you to customize your Policies by excluding 
individual checks (known as ExceptionsExceptionsExceptionsExceptions). You can only add Exceptions to/
delete Exceptions from User-defined Policies, notnotnotnot built-in Policies. A check 
mustmustmustmust be enabled in order to add/delete an Exception. For more 
information, see Adding and deleting Exceptions.

7. Save the edited Policy. If the Policy is a:

•  built-in Policybuilt-in Policybuilt-in Policybuilt-in Policy, then click the SaveSaveSaveSave button to save the edited Policy

•  User-defined PolicyUser-defined PolicyUser-defined PolicyUser-defined Policy, then click the Save As Save As Save As Save As button to save the edited Policy 
under a different name.

8. You mustmustmustmust edit the permissions for each Organization and each individual 
User who is allowed to use the edited Policy; for more information, see 
Editing an Organization and Editing a User, respectively.



DbProtect 6.1 User’s Guide

Application Security, Inc. 158

Renaming a Policy DbProtect Vulnerability Management allows you to rename a Policy.

Note:Note:Note:Note: You cannotcannotcannotcannot modify Built-in Policies.

To rename a Policy:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: PoliciesPoliciesPoliciesPolicies dialog box

2. Click the Pen Test Policies Pen Test Policies Pen Test Policies Pen Test Policies or Audit PoliciesAudit PoliciesAudit PoliciesAudit Policies tab.

3. Select the Policy you want to rename.

4. Click the RenameRenameRenameRename button to display the Rename PolicyRename PolicyRename PolicyRename Policy pop up.

5. Enter the new Policy name.

6. Click the OKOKOKOK button. 

A pop up displays and informs you if the rename was successful.

7. Click the OKOKOKOK button.
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Searching Policies DbProtect Vulnerability Management allows you to search Policies for checks that 
match a specified criteria. It also allows you to search for specific checks' CVE 
numbers.

To search Policies:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: PoliciesPoliciesPoliciesPolicies dialog box

2. Click the Pen Test Policies Pen Test Policies Pen Test Policies Pen Test Policies or Audit PoliciesAudit PoliciesAudit PoliciesAudit Policies tab.

3. Select a Policy.

4. Click the View Selected View Selected View Selected View Selected button.

5. Enter text to search for. If you have a specific CVE number, enter it as the 
target string.

6. DbProtect Vulnerability Management displays your search results in the Policy Policy Policy Policy 
SearchSearchSearchSearch portion of the Policy EditorPolicy EditorPolicy EditorPolicy Editor.



DbProtect 6.1 User’s Guide

Application Security, Inc. 160

7. Click a search result to display a description of the security check, as well as 
its location within the Policy Editor Policy Editor Policy Editor Policy Editor.

8. Check the checkbox to activate it.

Adding and
deleting

Exceptions

DbProtect Vulnerability Management allows you to customize your Policies by 
excluding individual checks (known as ExceptionsExceptionsExceptionsExceptions). You can only add Exceptions to/
delete Exceptions from User-defined Policies, notnotnotnot built-in Policies. A check mustmustmustmust be 
enabled in order to add/delete an Exception. There are two ways to add an Exception 
to a user-defined Policy. You can:

•  manually create an Exception

•  load a file of Exceptions (from a .txt or .csv file)

This topic consists of the following sub-topics:

•  Exception examples

•  Adding an Exception

•  Deleting an Exception.

EXCEPTION EXAMPLES

Below is an example for creating an Exception file for the Oracle check "Easily-"Easily-"Easily-"Easily-
guessed database password"guessed database password"guessed database password"guessed database password":

•  Username=John,Password=johnspass

•  Username=Bob,"Password=bobs,pass"

•  Username=Jim,"Password=jims""pass"

•  Password=12345

As a result, DbProtect Vulnerability Management will notnotnotnot report "Easily-guessed 
database password" vulnerabilities if:

•  John has an easily-guessed password and it is johnspass

•  Bob has an easily-guessed password and it is bobs,pass

•  Jim has an easily-guessed password and it is jims""pass

•  Any of the database accounts has an easily-guessed password and it is 12345

To follow the CSV standard and allow a correct parsing:

•  The 'Password=bobs,pass' value is enclosed in double quotes because it 
contains a comma.

•  The 'Password=jims"pass' value is enclosed in double quotes because it 
contains a double quote. The inner double quote has been duplicated.
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Below is an example of creating an Exception .txt or .csv file for the MSSQL check 
"Blank password""Blank password""Blank password""Blank password":

•  Login=John

•  Login=Bob

•  Login=Jim

If John, Bob or Jim have blank passwords, DbProtect Vulnerability Management will 
notnotnotnot report "Blank password" check vulnerabilities.

ADDING AN EXCEPTION

To add an Exception:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policies dialog box.

FIGURE: Policies Policies Policies Policies dialog box

2. Click the Pen Test Policies Pen Test Policies Pen Test Policies Pen Test Policies or Audit Policies Audit Policies Audit Policies Audit Policies tab.
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3. Click the New PolicyNew PolicyNew PolicyNew Policy button or the View Selected View Selected View Selected View Selected button to display the 
Policy EditorPolicy EditorPolicy EditorPolicy Editor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy EditorPolicy EditorPolicy EditorPolicy Editor

4. Select a Policy.

5. View which security checks are active within the chosen Policy. (Security 
checks with check marks next to them are activeactiveactiveactive.)

Some checks allow you to click an ExceptionsExceptionsExceptionsExceptions button and customize your Policies by 
excluding individual checks (known as Exceptions). You can only add Exceptions to/
delete Exceptions from User-defined Policies, notnotnotnot built-in Policies. A check mustmustmustmust be 
enabled in order to add/delete an Exception.

Note:Note:Note:Note: You cannotcannotcannotcannot modify built-in Policies. However, you cancancancan edit a built-in Policy 
and choose "save as" to save the edited Policy under a different name. For 
more information, see Editing a Policy.

To add an Exception, check the Check EnabledCheck EnabledCheck EnabledCheck Enabled checkbox and click the ExceptionsExceptionsExceptionsExceptions 
button.

FIGURE: Check EnabledCheck EnabledCheck EnabledCheck Enabled checkbox and ExceptionsExceptionsExceptionsExceptions button
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6. The ExceptionsExceptionsExceptionsExceptions pop up displays.

FIGURE: ExceptionsExceptionsExceptionsExceptions pop up

If you want to:

•  manually create an Exception, go to Step 7

•  load a file of Exceptions (from a .txt or .csv file), go to Step 8.

7. Manually create an Exception.

Click the Add Add Add Add button on the ExceptionsExceptionsExceptionsExceptions dialog box to display the Create ExceptionCreate ExceptionCreate ExceptionCreate Exception 
pop up, which allows you to add:

•  single Exceptions, e.g., Login=Admin

•  Exceptions with an AND clause when more than one Parameter NameParameter NameParameter NameParameter Name is 
available in the Parameter Name Parameter Name Parameter Name Parameter Name drop-down list, e.g., Login=Admin, 
Password=admin123, etc.

•  Exceptions with an AND/OR clause, e.g., Login=Admin, Password=admin123, 
Password=Admin, etc.

To add an Exception with an AND clause:

•  Use the Parameter NameParameter NameParameter NameParameter Name drop-down to select a parameter and a enter a value 
in the Parameter ValueParameter ValueParameter ValueParameter Value field, e.g., Login=Admin.

•  Use the Parameter NameParameter NameParameter NameParameter Name drop-down to select a different parameter and enter 
a value in the Parameter ValueParameter ValueParameter ValueParameter Value field, e.g., Password=admin123.

•  Click the OKOKOKOK button.
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To add an Exception with an AND/OR clause:

•  Add an Exception with an AND clause. Use the Parameter NameParameter NameParameter NameParameter Name drop-down to 
select a parameter and a enter a value in the Parameter ValueParameter ValueParameter ValueParameter Value field, e.g., 
Login=Admin.

•  Use the Parameter NameParameter NameParameter NameParameter Name drop-down to select a different parameter and enter 
a value in the Parameter ValueParameter ValueParameter ValueParameter Value field, e.g., Password=admin123.

•  Click the OKOKOKOK button.

•  Immediately after adding that Exception, use the Parameter NameParameter NameParameter NameParameter Name drop-down 
to select the parameter you want to use for the OR clause, e.g., 
Password=Admin.

•  Click the OKOKOKOK button and go to Step 6.

8. Load a file of Exceptions (from a .txt or .csv file).

Click the Load From File Load From File Load From File Load From File button on the ExceptionsExceptionsExceptionsExceptions dialog box to display the Load Load Load Load 
Exceptions from fileExceptions from fileExceptions from fileExceptions from file pop up, which allows you to select a valid.txt or .csv file of 
Exceptions.

The content of the file, line by line, mustmustmustmust adhere to the following syntax and rules:

PairNameValue[[,<PairNameValue>][,...]]

[PairNameValue[[,<PairNameValue>][,...]]]

[...]

<PairNameValue> ::= <ParamName>=<ParamValue>

<ParamName>: must be an existing parameter in the ParamaterNames table for the 
check.

<ParamValue>: cannot be empty.

If <ParamName> or <ParamValue> contains commas (,) or double quotes ("), you must 
enclose <PairNameValue> between double quotes (") and you replace the contained 
double quotes (if they exist) with (""), as follows:

•  If <ParamName> or <ParamValue> contains commas: 
Login=Admin,"Password=Pass,word"

•  If <ParamName> or <ParamValue> contain double quotes: 
"Login=""Admin""",Password=mypwd

Click the OKOKOKOK button and go to Step 9.

9. Click the SaveSaveSaveSave button on the toolbar to display the e Save New PolicySave New PolicySave New PolicySave New Policy pop 
up.

10.Enter the new Policy name in the Policy NamePolicy NamePolicy NamePolicy Name field (required).

11.Enter the new Policy description in the Policy Description Policy Description Policy Description Policy Description field (optional).
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DELETING AN EXCEPTION

To delete an Exception:

1. Click the enabled check where you want to delete an Exception.

2. Click the ExceptionsExceptionsExceptionsExceptions button.

3. Select the Exception you want to delete.

4. Click the DeleteDeleteDeleteDelete button.

5. Click the YesYesYesYes button to verify the delete.

Importing a Policy DbProtect allows you to importimportimportimport a Policy using AppDetectivePro (which is installed 
automatically during your installation of DbProtect).

Alternately, you can use the standalone DbProtect Migration ToolDbProtect Migration ToolDbProtect Migration ToolDbProtect Migration Tool to migrate Session 
data from a sourcesourcesourcesource (an AppDetectivePro database) to a destinationdestinationdestinationdestination (the DbProtect 
Vulnerability Management database). When you do so, DbProtect Vulnerability 
Management automatically inherits all Policies associated with the migrated 
Session(s); for more information, see Appendix E: Importing Session Data with the 
DbProtect Import Utility.

Note:Note:Note:Note: Imported Policies include any User-defined checks that are part of the 
Policy.
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To import a Policy using AppDetectivePro:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policy Editor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy EditorPolicy EditorPolicy EditorPolicy Editor

2. Click the Import Policy Import Policy Import Policy Import Policy tab.

3. Click the Set Import File Set Import File Set Import File Set Import File button to display the Set Import File Set Import File Set Import File Set Import File dialog box.

4. Specify the path and file name of the AppDetectivePro database file (.adb).

5. Click the ImportImportImportImport button.

A pop up displays, notifying you AppDetectivePro has imported your Policy data as an 
AppDetectivePro database file (.adb). The imported Policy is now available.
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Exporting a Policy AppDetectivePro allows you to exportexportexportexport Policy data from a database. This is useful if you 
want to transfer Policies between machines.

Note:Note:Note:Note: Exported Policies include any User-defined checks that are part of the 
Policy.

To export a Policy:

1. Choose Start > Programs > AppSecInc > DbProtect > Policy Editor to display 

the Policy Editor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy EditorPolicy EditorPolicy EditorPolicy Editor

2. Click the Export/Purge Policy Export/Purge Policy Export/Purge Policy Export/Purge Policy tab.

3. Check the Policies you want to export.

4. Click the ExportExportExportExport button.

A pop up displays, notifying you AppDetectivePro has exported your Policy data as an 
AppDetectivePro database file (.adb). The exported Policy is now available.
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Working with Credential 
Profiles and User Credential 
Files
This chapter consists of the following topics:

•  What is a Credential Profile?

•  What is a User Credentials File?

•  Understanding the Credential Profile hierarchy

•  Credential Profiles and User role privileges

•  Creating a Credential Profile

•  Setting and testing your database and operating system credentials

•  Editing a Credential Profile

•  Removing a Credential Profile

•  Setting a Credential Profile as an Organizational default

•  Removing applications from a Credential Profile

•  Deleting credentials from a Credential Profile

•  Importing a User Credentials File

•  Exporting a User Credentials File.

What is a
Credential Profile?

DbProtect Vulnerability Management allows you to create, view, and modify a 
Credential ProfileCredential ProfileCredential ProfileCredential Profile which contains the specific authentication details DbProtect 
Vulnerability Management uses to authenticate to a target application or operating 
system for the purpose of performing an Audit; for more information, see What is an 
Audit?

You can modify Credential Profiles at any of the following hierarchical levels: networknetworknetworknetwork, 
subnetsubnetsubnetsubnet, hosthosthosthost, or applicationapplicationapplicationapplication.

Important: DbProtect Vulnerability Management displays different Audit credential 
parameters at each level, i.e., network, subnet, host, and application. For 
more information, see Setting and testing your database and operating 
system credentials.
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What is a User
Credentials File?

The User Credentials FileUser Credentials FileUser Credentials FileUser Credentials File includes the administration User’s operating system User 
name, operating system password, system privileges, database username, and 
database password.

You mustmustmustmust provide database and operation system authentication credentials in order 
to run an Audit Job. If you don’t use a Credential Profile, you can import a properly-
formatted User Credentials File. For more information, see Appendix A: Creating a 
User Credentials File.

All Users (except View Users) can import a User Credentials File. Super Admin Users 
can also export a User Credentials File.

For more information on:

•  importing a User Credentials File, see Importing a User Credentials File

•  exporting a User Credentials File, see Exporting a User Credentials File.

Understanding the
Credential Profile

hierarchy

As shown below, Credential Profiles are hierarchical. 

FIGURE: Credential profile hierarchy (conceptual diagram)

Specifically, when you set a Credential Profile for:

•  a networka networka networka network, then all underlying subnetssubnetssubnetssubnets, hostshostshostshosts, and applicationsapplicationsapplicationsapplications inherit the 
network’s credentials

•  a subneta subneta subneta subnet, then all underlying hostshostshostshosts and applicationsapplicationsapplicationsapplications inherit the subnet’s 
credentials

•  a hosta hosta hosta host, then all underlying applicationsapplicationsapplicationsapplications inherit the host’s credentials

•  an applicationan applicationan applicationan application, then the credential settings apply only to the application.
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The applications specified in your Credential Profile must exactly match the 
applications specified in your Audit Job, at the application type level. For example, if 
you specify subnet 192.168.1.x in your Credential Profile, and attempt to apply this 
Credential Profile to an Audit Job that does notnotnotnot include subnet 192.168.1.x in its list 
of applications to Audit, then the Audit Job will fail. However, if the Audit Job includes 
the entire networknetworknetworknetwork in its list of applications to Audit, then this Credential Profile will 
work, because in the credential file, as well as the Audit Job, the subnet 192.168.1.x 
is hierarchically below the network level.

Credential Profiles
and User role

privileges

As explained in the DbProtect Administrator’s Guide, Credential Profile privileges are 
restricted to certain User types. The following table explains which User roles can (and 
cannot):

•  exportexportexportexport credentials to file via a Job template or Credential Profile; for more 
information, see Exporting a User Credentials File

•  importimportimportimport credentials from file via a Job template or Credential Profile; for more 
information, see Importing a User Credentials File

•  create/modifycreate/modifycreate/modifycreate/modify a Credential Profile; for more information, see Creating a 
Credential Profile and Editing a Credential Profile, respectively. , 

Privileges

User role

Super 
Admin

Admin
Basic 
User

View 
User

Create or modify a Credential Profile � � � XXXX

Export credentials to file via a Job 
template or Credential Profile

� XXXX XXXX XXXX

Import credentials from file via a Job 
template or Credential Profile

� � � XXXX

AccessAccessAccessAccess � No AccessNo AccessNo AccessNo Access XXXX
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Creating a
Credential Profile

Super Admins, Admins, and Basic Users can create a Credential Profile; for more 
information, see What is a Credential Profile?

To create a Credential Profile: 

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  New button to create a Credential Profile (see Step 2)

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default, for 
more information, see Setting a Credential Profile as an Organizational default.

2. Click the NewNewNewNew button on the Credential Profile Manager Credential Profile Manager Credential Profile Manager Credential Profile Manager to display the 
Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box
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3. In the Credential Profile Name Credential Profile Name Credential Profile Name Credential Profile Name portion of the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor 
dialog box, enter the name of your new Credential Profile in the Name: Name: Name: Name: 
field.

FIGURE: Credential Profile Name Credential Profile Name Credential Profile Name Credential Profile Name portion of the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box

4. Click the Add Application(s)...Add Application(s)...Add Application(s)...Add Application(s)... button to display the Application PickerApplication PickerApplication PickerApplication Picker.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box

The Application PickerApplication PickerApplication PickerApplication Picker allows you to establish which applications are allowed to use 
the credentials specified in this Credential Profile when you apply the Credential 
Profile to an Audit Job. You can add a(n):

•  networknetworknetworknetwork, and all subordinate subnetssubnetssubnetssubnets, hostshostshostshosts, and applicationapplicationapplicationapplications on the network

•  subnetsubnetsubnetsubnet, and all subordinate hostshostshostshosts and applicationsapplicationsapplicationsapplications on the subnet

•  hosthosthosthost, and all subordinate applications applications applications applications on the host

•  individual applicationapplicationapplicationapplication.
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Important: The applications specified in your Credential Profile must exactly match 
the applications specified in your Audit Job, at the application type level. 
For example, if you specify subnet 192.168.1.x in your Credential Profile, 
and attempt to apply this Credential Profile to an Audit Job that does not 
include subnet 192.168.1.x in its list of applications to Audit, then the 
Audit Job will fail. However, if the Audit Job includes the entire network in 
its list of applications to Audit, then this Credential Profile will work, 
because in the credential file, as well as the Audit Job, the subnet 
192.168.1.x is hierarchically below the network level.For more 
information, see Understanding the Credential Profile hierarchy.

5. When you are done picking which applications are allowed to use the 
credentials specified in this Credential Profile, click the AddAddAddAdd button to close 
the Application PickerApplication PickerApplication PickerApplication Picker. Your selected applications display in the Credential Credential Credential Credential 
Profile Editor Profile Editor Profile Editor Profile Editor dialog box.

FIGURE: Selected networks, subnets, hosts, and applications in the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor 
dialog box

For each application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, the following fields 
display:

•  The IP Address IP Address IP Address IP Address of your selected application (if applicable).

•  The Hostname Hostname Hostname Hostname of your selected application (if applicable).

•  The TypeTypeTypeType of application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, i.e., AppAppAppApp, 
SubnetSubnetSubnetSubnet, HostHostHostHost, NetworkNetworkNetworkNetwork.

•  The App TypeApp TypeApp TypeApp Type of the database application selected (e.g., Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database), if 
you selected an application with the Application Picker Application Picker Application Picker Application Picker in Step 4.

•  The Port Port Port Port number of your selected application (if applicable).

•  The Instance Instance Instance Instance name of your selected application (if applicable).

•  An EditEditEditEdit button under the CredentialCredentialCredentialCredential column, which you can click to set 
credentials for this Credential Profile (see Step 6).

•  The icon under the StatusStatusStatusStatus column indicates whether your credentials are 
incompleteincompleteincompleteincomplete , partial partial partial partial , or completecompletecompletecomplete . If your credentials are incomplete 
or partial, click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column, and set credentials 
for this Credential Profile (see Step 6).
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6. You can set credentials for this Credential Profile. Do the following:

•  Click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column in the Credential Profile Credential Profile Credential Profile Credential Profile 
EditorEditorEditorEditor dialog box.

The Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box displays. The Please Select One or More Application(s) Please Select One or More Application(s) Please Select One or More Application(s) Please Select One or More Application(s) 
to Set Credentialsto Set Credentialsto Set Credentialsto Set Credentials portion displays each available ApplicationApplicationApplicationApplication and PlatformPlatformPlatformPlatform 
combination (for which you can set credentials); for example, Oracle Database Oracle Database Oracle Database Oracle Database on 
UnixUnixUnixUnix. 

Note:Note:Note:Note: The Database StatusDatabase StatusDatabase StatusDatabase Status and OS StatusOS StatusOS StatusOS Status columns display the status of your 
database and operating system credentials, respectively (i.e., SetSetSetSet or Not Not Not Not 
SetSetSetSet).

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

•  Select an Application/PlatformApplication/PlatformApplication/PlatformApplication/Platform combination in the Please Select One or More Please Select One or More Please Select One or More Please Select One or More 
Application(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

The corresponding Database Credentials Database Credentials Database Credentials Database Credentials and Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials 
tabbed fields display in the CredentialsCredentialsCredentialsCredentials portion of the dialog box.

•  Set your database and OS credentials, according to your selected Application/
Platform combination; for more information, see Setting and testing your 
database and operating system credentials.
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7. Click the SaveSaveSaveSave button to save your Credential Profile.

The Credential Profile Manager Credential Profile Manager Credential Profile Manager Credential Profile Manager displays with your new Credential Profile added.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  New button to create another Credential Profile (go back to Step 2)

•  EditEditEditEdit button to edit a Credential Profile, see Editing a Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile, see Removing a Credential 
Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default, see 
Setting a Credential Profile as an Organizational default.

Setting and testing
your database and
operating system

credentials

As the diagram in Understanding the Credential Profile hierarchy illustrates, when you 
set credentials for a networka networka networka network, then all underlying subnetssubnetssubnetssubnets, hostshostshostshosts, and applicationsapplicationsapplicationsapplications 
inherit the network’s credentials. When you run an Audit Job, you must authenticate to 
the host database at both the application and OS levels. This topic explains how to set 
your application and platform credentials in various, supported application/platform 
combinations.

When you set the credentials (for a Credential Profile or an individual Audit Job), 
certain fields will display in the Database CredentialsDatabase CredentialsDatabase CredentialsDatabase Credentials and Operating System Operating System Operating System Operating System 
CredentialsCredentialsCredentialsCredentials tabs of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box. The fields that display depend on 
which network Application Application Application Application and PlatformPlatformPlatformPlatform you select in the Please Select One or More Please Select One or More Please Select One or More Please Select One or More 
Application(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box (shown 
below).
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Note:Note:Note:Note: To display the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box, click EditEditEditEdit button under the 
CredentialCredentialCredentialCredential column in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box; for more 
information, see Step 7 of Creating an Audit Job.

FIGURE: Set Credentials Set Credentials Set Credentials Set Credentials dialog box

In the Please Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set Credentials portion of the Set Set Set Set 
CredentialsCredentialsCredentialsCredentials dialog box, you can set the credentials that allow you to authenticate to a 
database and an operating system.

What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:

•  Setting your database credentials

•  Testing your database credentials

•  Setting your operating system credentials (for Unix-based operating systems)

•  Setting your operating system credentials (for Windows)

•  Setting your operating system credentials (for an “Unknown” operating system)

•  Testing your operating system credentials (for Unix-based operating systems).
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SETTING YOUR DATABASE CREDENTIALS

To set your database credentials (for database authentication on any operating 
system): 

1. To display the Set Credentials dialog box, you must click the Edit button under 

the Credential column in the Audit Template Editor dialog box; for more 

information, see Step 7 of Creating an Audit Job.

In the Please Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set Credentials portion of the Set Set Set Set 
CredentialsCredentialsCredentialsCredentials dialog box, select an application/platform combination.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box
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2. Do the following:

•  Click the Database CredentialsDatabase CredentialsDatabase CredentialsDatabase Credentials tab.

The Database CredentialsDatabase CredentialsDatabase CredentialsDatabase Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box displays. The 
available fields are the same for OracleOracleOracleOracle and SQL ServerSQL ServerSQL ServerSQL Server.

FIGURE: Database Credentials Database Credentials Database Credentials Database Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

•  Under Native Database CredentialsNative Database CredentialsNative Database CredentialsNative Database Credentials, enter your native database Username: Username: Username: Username: and 
Password:Password:Password:Password:

•  Under OptionsOptionsOptionsOptions, do the following:

-For a SQL Server native database. For a SQL Server native database. For a SQL Server native database. For a SQL Server native database. Check the Use Windows Authentication via the Use Windows Authentication via the Use Windows Authentication via the Use Windows Authentication via the 
Scan Engine’s CredentialsScan Engine’s CredentialsScan Engine’s CredentialsScan Engine’s Credentials checkbox to authenticate to Windows using the privileges 
associated with your registered Scan Engine; for more information, see Working with 
Scan Engines

-For an Oracle native database. For an Oracle native database. For an Oracle native database. For an Oracle native database. Use the Privilege Level: Privilege Level: Privilege Level: Privilege Level: drop-down to select the 
associated Oracle privileges (SYSOPER, SYSDBA, or NORMAL).

•  Optionally, you can click the Test DB CredentialsTest DB CredentialsTest DB CredentialsTest DB Credentials button to test your database 
credentials (before you set them). For more information, see Testing your 
database credentials.

3. Click the Set CredentialsSet CredentialsSet CredentialsSet Credentials button to set these database credentials (or click 
the Reset to DefaultReset to DefaultReset to DefaultReset to Default button to restore your last saved database credential 
settings).

4. When you are done, click the Save ChangesSave ChangesSave ChangesSave Changes button to save the database 
and operating system credential changes you made to your Credential 
Profile (for this application/platform combination).
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TESTING YOUR DATABASE CREDENTIALS

To test the database credentials you supplied in Step 2 of Setting your database 
credentials: 

1. If you clicked the Test DB Credentials button in Step 2 of Setting your database 

credentials, then the Database Credential Tester dialog box displays (like the 

one shown below).

FIGURE: Database Credential Tester Database Credential Tester Database Credential Tester Database Credential Tester dialog box

2. The following columns display in the Database Credential TesterDatabase Credential TesterDatabase Credential TesterDatabase Credential Tester dialog 
box (for each application you selected with the Application Picker Application Picker Application Picker Application Picker in 
Creating a Credential Profile):

•  The IP Address IP Address IP Address IP Address of your selected application.

•  The Port Port Port Port number of your selected application.

•  The Instance Name Instance Name Instance Name Instance Name of your selected application.

•  The Hostname Hostname Hostname Hostname of your selected application.

•  The Application Application Application Application selected (e.g., Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database).

•  The PlatformPlatformPlatformPlatform on which the database application runs (e.g., UnixUnixUnixUnix).

3. Check one or more applications (against which you want to test your 
database credentials). You can click the:

•  Select AllSelect AllSelect AllSelect All button to select all applications

•  Deselect AllDeselect AllDeselect AllDeselect All button to de-select all applications.

4. Test your database credentials against one or more selected applications. 
You can click:

•  an individual TestTestTestTest button  next to an individual checked application in 
order to test your database credentials

•  the Test Selected Test Selected Test Selected Test Selected button  at the top of the Database Credential Database Credential Database Credential Database Credential 
TesterTesterTesterTester dialog box, which allows you to test the database credentials for all of 
your checked applications simultaneously.
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DbProtect Vulnerability Management tests the database credentials for all checked 
applications. The test results display under the Scan EngineScan EngineScan EngineScan Engine and ResultResultResultResult columns of the 
Database Credential TesterDatabase Credential TesterDatabase Credential TesterDatabase Credential Tester dialog box.

FIGURE: Scan EngineScan EngineScan EngineScan Engine and ResultResultResultResult columns

The Scan Engine Scan Engine Scan Engine Scan Engine column displays the name of the Scan Engine that is scanning 
applications (selected in Step 3) for vulnerabilities.

The icon under the ResultResultResultResult column indicates whether your database credentials are Set Set Set Set 
 or Not Set Not Set Not Set Not Set ,. 

The Scan Engine Not AvailableScan Engine Not AvailableScan Engine Not AvailableScan Engine Not Available icon , may also display; for more information, see 
Monitoring the health of your Scan Engines.
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SETTING YOUR OPERATING SYSTEM CREDENTIALS (FOR 

UNIX-BASED OPERATING SYSTEMS)

To set your operating system credentials (for Unix-based operating systems): 

1. To display the Set Credentials dialog box, you must click the Edit button under 

the Credential column in the Audit Template Editor dialog box; for more 

information, see Step 7 of Creating an Audit Job.

In the Please Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set Credentials portion of the Set Set Set Set 
CredentialsCredentialsCredentialsCredentials dialog box, select an ApplicationApplicationApplicationApplication on a Unix-based PlatformPlatformPlatformPlatform.

Note:Note:Note:Note: The Database Status  Database Status  Database Status  Database Status and OS StatusOS StatusOS StatusOS Status columns display the status of your 
database and operating system credentials, respectively, i.e., SetSetSetSet or Not Not Not Not 
SetSetSetSet.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box
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2. Click the Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials tab to display the Operating Operating Operating Operating 
System CredentialsSystem CredentialsSystem CredentialsSystem Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

Note:Note:Note:Note: The available fields depend on whether you want to set credentials for 
WindowsWindowsWindowsWindows, UnixUnixUnixUnix, or another (UnknownUnknownUnknownUnknown) platform.

FIGURE: Operating System Credentials Operating System Credentials Operating System Credentials Operating System Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

You can do the following:

•  Use the Protocol:Protocol:Protocol:Protocol: drop-down to select the authentication protocol (TelnetTelnetTelnetTelnet or 
SSHSSHSSHSSH), and enter the Port:Port:Port:Port: number.

Note:Note:Note:Note: DbProtect Vulnerability Management automatically populates the Port:  Port:  Port:  Port: 
field with the default port numbers, in association with the Protocol: Protocol: Protocol: Protocol: you 
select. The default port number for TelnetTelnetTelnetTelnet is 23232323, and the default port 
number for SSHSSHSSHSSH is 22222222. You can overwrite these default values.

•  Enter the operating system Username: Username: Username: Username: associated with the username to 
authenticate to the operating system.

•  Select either of the following:

-Password:Password:Password:Password: Enter the password associated with the username above, or

-SSH Private Key: SSH Private Key: SSH Private Key: SSH Private Key: The SSH private key is the half of the key pair that you keep on your 
computer. The public key is the part that you upload to the remote server. Click the 
Browse button to select a your .ppk file. You must also enter the Key Passphrase: Key Passphrase: Key Passphrase: Key Passphrase: for 
your password-protected private key, and use the Key Cipher Type Key Cipher Type Key Cipher Type Key Cipher Type drop-down to select 
the RSARSARSARSA or DSADSADSADSA cipher type.

Hint: To remove a private key and passphrase, you must do the following: 1.) 

Delete the SSH Private Key: and Key Passphrase: 2.) Click the Clear 

button. 3.) Click the Save Changes button. 4.) When the Audit Template 

Editor dialog box re-displays, click the Save button.

Optionally, you can:

•  check Use OS Credential for DB Credential Use OS Credential for DB Credential Use OS Credential for DB Credential Use OS Credential for DB Credential to use your operating system 
credentials to authenticate to the host database

•  click the Test OS CredentialsTest OS CredentialsTest OS CredentialsTest OS Credentials button to test your database credentials (before 
you set them); for more information, see Testing your operating system 
credentials (for Unix-based operating systems).
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3. When you are done, click the Save ChangesSave ChangesSave ChangesSave Changes button to save the database 
and operating system credential changes you made to your Credential 
Profile (for this application/platform combination).

SETTING YOUR OPERATING SYSTEM CREDENTIALS (FOR 

WINDOWS)

To set your operating system credentials (for Windows): 

1. To display the Set Credentials dialog box, you must click the Edit button under 

the Credential column in the Audit Template Editor dialog box; for more 

information, see Step 7 of Creating an Audit Job.

In the Please Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set Credentials portion of the Set Set Set Set 
CredentialsCredentialsCredentialsCredentials dialog box, select an ApplicationApplicationApplicationApplication on the Windows PlatformPlatformPlatformPlatform.

Note:Note:Note:Note: The Database Status Database Status Database Status Database Status and OS Status OS Status OS Status OS Status columns display the status of your 
database and operating system credentials, respectively, i.e., SetSetSetSet or Not Not Not Not 
SetSetSetSet.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box
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2. Click the Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials tab to display the Operating Operating Operating Operating 
System CredentialsSystem CredentialsSystem CredentialsSystem Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

FIGURE: Operating System Credentials Operating System Credentials Operating System Credentials Operating System Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

You can select:

•  Windows credentialsWindows credentialsWindows credentialsWindows credentials and enter your Windows Username:Username:Username:Username: and Password:Password:Password:Password:

•  Use same credential as Scan Engine serviceUse same credential as Scan Engine serviceUse same credential as Scan Engine serviceUse same credential as Scan Engine service to use the same Windows 
credentials as used by your registered Scan Engine.

3. When you are done, click the Save ChangesSave ChangesSave ChangesSave Changes button to save the database 
and operating system credential changes you made to your Credential 
Profile (for this application/platform combination).
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SETTING YOUR OPERATING SYSTEM CREDENTIALS (FOR AN 

“UNKNOWN” OPERATING SYSTEM)

To set your operating system credentials (for applications on an “unknown” operating 
system): 

1. To display the Set Credentials dialog box, you must click the Edit button under 

the Credential column in the Audit Template Editor dialog box; for more 

information, see Step 7 of Creating an Audit Job.

In the Please Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set CredentialsPlease Select One or More Application(s) to Set Credentials portion of the Set Set Set Set 
CredentialsCredentialsCredentialsCredentials dialog box, select an ApplicationApplicationApplicationApplication on an unknown PlatformPlatformPlatformPlatform.

Note:Note:Note:Note: The Database Status  Database Status  Database Status  Database Status and OS StatusOS StatusOS StatusOS Status columns display the status of your 
database and operating system credentials, respectively, i.e., SetSetSetSet or Not Not Not Not 
SetSetSetSet.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box
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2. Click the Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials tab to display the Operating Operating Operating Operating 
System CredentialsSystem CredentialsSystem CredentialsSystem Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

FIGURE: Operating System Credentials Operating System Credentials Operating System Credentials Operating System Credentials portion of the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

A message displays informing you that your operating system is unknown. For more 
information on applications and platforms that you can Audit, see Scan Engines.

3. When you are done, click the Save ChangesSave ChangesSave ChangesSave Changes button to save the database 
and operating system credential changes you made to your Credential 
Profile (for this application/platform combination).

TESTING YOUR OPERATING SYSTEM CREDENTIALS (FOR 

UNIX-BASED OPERATING SYSTEMS)

To test the database credentials you supplied in Step 2 of Setting your operating 
system credentials (for Unix-based operating systems): 

1. If you clicked the Test OS Credentials button in Step 2 of Setting your operating 

system credentials (for Unix-based operating systems), then the Operating 

System Credential Tester dialog box displays (like the one shown below).

FIGURE: Database Credential Tester Database Credential Tester Database Credential Tester Database Credential Tester dialog box
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2. The following columns display in the Operating System Credential TesterOperating System Credential TesterOperating System Credential TesterOperating System Credential Tester 
dialog box (for each application you selected with the Application Picker Application Picker Application Picker Application Picker in 
Creating a Credential Profile):

•  The IP Address IP Address IP Address IP Address of your selected application.

•  The Port Port Port Port number of your selected application.

•  The Instance Name Instance Name Instance Name Instance Name of your selected application.

•  The Hostname Hostname Hostname Hostname of your selected application.

•  The Application Application Application Application selected (e.g., Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database).

•  The PlatformPlatformPlatformPlatform on which the database application runs (e.g., UnixUnixUnixUnix).

3. Check one or more applications (against which you want to test your 
database credentials). You can click the:

•  Select AllSelect AllSelect AllSelect All button to select all applications

•  Deselect AllDeselect AllDeselect AllDeselect All button to de-select all applications.

4. Test your operating system credentials against one or more selected 
applications. You can click:

•  an individual TestTestTestTest button  next to an individual checked application in 
order to test your operating system credentials

•  the Test Selected Test Selected Test Selected Test Selected button  at the top of the Operating System Operating System Operating System Operating System 
Credential TesterCredential TesterCredential TesterCredential Tester dialog box, which allows you to test the operating system 
credentials for all of your checked applications simultaneously.

DbProtect Vulnerability Management tests the operating system credentials for all 
checked applications. The test results display under the Scan EngineScan EngineScan EngineScan Engine and ResultResultResultResult 
columns of the Operating System Credential TesterOperating System Credential TesterOperating System Credential TesterOperating System Credential Tester dialog box.

FIGURE: Scan EngineScan EngineScan EngineScan Engine and ResultResultResultResult columns

The Scan Engine Scan Engine Scan Engine Scan Engine column displays the name of the Scan Engine that is scanning 
applications (selected in Step 3) for vulnerabilities.

The icon under the ResultResultResultResult column indicates whether your operating system credentials 
are Set Set Set Set  or Not Set Not Set Not Set Not Set ,. 

The Scan Engine Not AvailableScan Engine Not AvailableScan Engine Not AvailableScan Engine Not Available icon , may also display; for more information, see 
Monitoring the health of your Scan Engines.
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Editing a
Credential Profile

To editediteditedit a Credential Profile: 

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  EditEditEditEdit button to edit a Credential Profile (see Step 2)

Hint: You can also right click an application in the Credential Profile Editor 

dialog box (as shown in Step 2), and choose Edit Credentials.

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default; for 
more information, see Setting a Credential Profile as an Organizational default.

2. Select a Credential Profile in the Existing ProfilesExisting ProfilesExisting ProfilesExisting Profiles portion of the Credential Credential Credential Credential 
Profile ManagerProfile ManagerProfile ManagerProfile Manager and click the EditEditEditEdit button.

The Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box displays, with the current settings shown.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box

For each application that comprises the Credential Profile, the following fields display:

•  The IP Address IP Address IP Address IP Address of your selected application (if applicable).

•  The Hostname Hostname Hostname Hostname of your selected application (if applicable).

•  The TypeTypeTypeType of application you selected with the Application PickerApplication PickerApplication PickerApplication Picker, i.e., AppAppAppApp, 
SubnetSubnetSubnetSubnet, HostHostHostHost, NetworkNetworkNetworkNetwork.
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•  The App TypeApp TypeApp TypeApp Type of the database application selected (e.g., Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database), if 
you selected an application with the Application Picker Application Picker Application Picker Application Picker in Step 4.

•  The Port Port Port Port number of your selected application (if applicable).

•  The Instance Instance Instance Instance name of your selected application (if applicable).

•  An EditEditEditEdit button under the CredentialCredentialCredentialCredential column, which you can click to set 
credentials for this Credential Profile.

•  The icon under the StatusStatusStatusStatus column indicates whether your credentials are 
incompleteincompleteincompleteincomplete , partial partial partial partial , or completecompletecompletecomplete . If your credentials are incomplete 
or partial, click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column, and set credentials 
for this Credential Profile.

3. In the Credential Profile Name Credential Profile Name Credential Profile Name Credential Profile Name portion of the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor 
dialog box, you can edit the name of the Credential Profile in the Name: Name: Name: Name: 
field.

4. Credential Profile Name Credential Profile Name Credential Profile Name Credential Profile Name portion of the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box

You can click the Add Application(s)...Add Application(s)...Add Application(s)...Add Application(s)... button to display the Application PickerApplication PickerApplication PickerApplication Picker.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box



DbProtect 6.1 User’s Guide

Application Security, Inc. 190

The Application PickerApplication PickerApplication PickerApplication Picker allows you to edit which applications are allowed to use the 
credentials specified in this Credential Profile when you apply the Credential Profile to 
an Audit Job. You can add a(n):

•  networknetworknetworknetwork, and all subordinate subnetssubnetssubnetssubnets, hostshostshostshosts, and applicationapplicationapplicationapplications on the network

•  subnetsubnetsubnetsubnet, and all subordinate hostshostshostshosts and applicationsapplicationsapplicationsapplications on the subnet

•  hosthosthosthost, and all subordinate applications applications applications applications on the host

•  individual applicationapplicationapplicationapplication.

Important: The applications specified in your Credential Profile must exactly match 
the applications specified in your Audit Job, at the application type level. 
For example, if you specify subnet 192.168.1.x in your Credential Profile, 
and attempt to apply this Credential Profile to an Audit Job that does not 
include subnet 192.168.1.x in its list of applications to Audit, then the 
Audit Job will fail. However, if the Audit Job includes the entire network in 
its list of applications to Audit, then this Credential Profile will work, 
because in the credential file, as well as the Audit Job, the subnet 
192.168.1.x is hierarchically below the network level.For more 
information, see Understanding the Credential Profile hierarchy.
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5. You can edit credentials for this Credential Profile. Do the following:

•  Click the EditEditEditEdit button under the CredentialCredentialCredentialCredential column in the Credential Profile Credential Profile Credential Profile Credential Profile 
Editor Editor Editor Editor dialog box to display the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

FIGURE: Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box

•  Select an Application/PlatformApplication/PlatformApplication/PlatformApplication/Platform combination in the Please Select One or More Please Select One or More Please Select One or More Please Select One or More 
Application(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set CredentialsApplication(s) to Set Credentials portion of the Set Credentials Set Credentials Set Credentials Set Credentials dialog box, e.g., 
Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database running on Microsoft WindowsMicrosoft WindowsMicrosoft WindowsMicrosoft Windows.

The corresponding Database Credentials Database Credentials Database Credentials Database Credentials and Operating System CredentialsOperating System CredentialsOperating System CredentialsOperating System Credentials 
tabbed fields display in the CredentialsCredentialsCredentialsCredentials portion the Set CredentialsSet CredentialsSet CredentialsSet Credentials dialog box.

•  Set your credentials, according to your selected Application/PlatformApplication/PlatformApplication/PlatformApplication/Platform 
combination; for more information, see Setting and testing your database and 
operating system credentials.
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6. Click the SaveSaveSaveSave button to save your edited Credential Profile.

The Credential Profile Manager Credential Profile Manager Credential Profile Manager Credential Profile Manager displays with your edited Credential Profile included.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  EditEditEditEdit button to edit another Credential Profile (go back to Step 2)

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default; for 
more information, see Setting a Credential Profile as an Organizational default.

Removing a
Credential Profile

To removeremoveremoveremove a Credential Profile:

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  RemoveRemoveRemoveRemove button to remove a Credential Profile (see Step 2)

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default; for 
more information, see Setting a Credential Profile as an Organizational default.
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2. Select a Credential Profile in the Existing ProfilesExisting ProfilesExisting ProfilesExisting Profiles portion of the Credential Credential Credential Credential 
Profile ManagerProfile ManagerProfile ManagerProfile Manager and click the RemoveRemoveRemoveRemove button.

DbProtect Vulnerability Management removes the selected Credential Profile. The 
Credential Profile Manager Credential Profile Manager Credential Profile Manager Credential Profile Manager displays with the Credential Profile removed.

You can click the:

•  RemoveRemoveRemoveRemove button to remove another Credential Profile (repeat this step)

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational defaultOrganizational defaultOrganizational defaultOrganizational default; for 
more information, see Setting a Credential Profile as an Organizational default.

Setting a
Credential Profile

as an
Organizational

default

DbProtect allows you to set a Credential Profile as your defaultdefaultdefaultdefault Credential Profile. The 
default Credential Profile displays at the top of the Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager.

To set a Credential Profile as an Organizational default: 

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  Set Default Set Default Set Default Set Default button to set a Credential Profile as an Organizational default (see 
Step 2)

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile.
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2. Select a Credential Profile in the Existing ProfilesExisting ProfilesExisting ProfilesExisting Profiles portion of the Credential Credential Credential Credential 
Profile ManagerProfile ManagerProfile ManagerProfile Manager and click the Set Default Set Default Set Default Set Default button.

The Credential Profile Manager Credential Profile Manager Credential Profile Manager Credential Profile Manager displays the selected Credential Profile as the    
Organization DefaultOrganization DefaultOrganization DefaultOrganization Default.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

You can click the:

•  Set DefaultSet DefaultSet DefaultSet Default button to set a Credential Profile as an Organizational default 
(repeat this step)

•  NewNewNewNew button to create a Credential Profile; for more information, see Creating a 
Credential Profile

•  EditEditEditEdit button to edit a Credential Profile; for more information, see Editing a 
Credential Profile

•  RemoveRemoveRemoveRemove button to remove a Credential Profile; for more information, see 
Removing a Credential Profile.

Removing
applications from a
Credential Profile

To remove applications from a Credential Profile: 

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager

2. Select a Credential Profile in the Existing ProfilesExisting ProfilesExisting ProfilesExisting Profiles portion of the Credential Credential Credential Credential 
Profile ManagerProfile ManagerProfile ManagerProfile Manager and click the EditEditEditEdit button.
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The Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box displays, with the current settings shown.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box

3. Right click an application in the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box and 
choose Remove ApplicationRemove ApplicationRemove ApplicationRemove Application.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box pop up (Remove ApplicationRemove ApplicationRemove ApplicationRemove Application selected)

The selected application is removed from the list of Credential Profile applications in 
the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box.

Deleting
credentials from a
Credential Profile

To delete credentials from a Credential Profile:

1. Do one of the following to display the Credential Profile Manager:

•  Choose File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager File > Credential Profile Manager from the menu.

•  Display the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box (for more information, see 
Creating an Audit Job), then click the Apply Credential ProfileApply Credential ProfileApply Credential ProfileApply Credential Profile button to display 
the Credential Profile PickerCredential Profile PickerCredential Profile PickerCredential Profile Picker pop up, then click the Manage ProfilesManage ProfilesManage ProfilesManage Profiles button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Credential Profile ManagerCredential Profile ManagerCredential Profile ManagerCredential Profile Manager
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2. Select a Credential Profile in the Existing ProfilesExisting ProfilesExisting ProfilesExisting Profiles portion of the Credential Credential Credential Credential 
Profile ManagerProfile ManagerProfile ManagerProfile Manager and click the EditEditEditEdit button.

The Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box displays, with the current settings shown.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box

3. Right click an application in the Credential Profile EditorCredential Profile EditorCredential Profile EditorCredential Profile Editor dialog box and 
choose Delete CredentialDelete CredentialDelete CredentialDelete Credential.

FIGURE: Credential Profile Editor Credential Profile Editor Credential Profile Editor Credential Profile Editor dialog box pop up (Delete Credential Delete Credential Delete Credential Delete Credential selected)

DbProtect Vulnerability Management deletes all credentials from the selected 
application in this Credential Profile.

Importing a User
Credentials File

To import a User Credentials File: 

1. All Users (except View Users) can import User Credentials from an .xml file. This 

file must be properly-formatted or the import will fail, and the User Credentials 

will remain unchanged. For more information on the proper format of a User 

Credentials File, see Appendix A: Creating a User Credentials File.

Do the following:

•  Click the Import Credentials Import Credentials Import Credentials Import Credentials button in the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box to 
display the Open Open Open Open dialog box, which allows you to select a User Credentials file.

FIGURE: OpenOpenOpenOpen dialog box
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•  Select a properly-formatted User Credentials .xml file and click the OpenOpenOpenOpen 
button.

DbProtect Vulnerability Management imports the User Credentials.

Exporting a User
Credentials File

Super Users can export User Credentials to an .xml file.

Note:Note:Note:Note: Private keys are notnotnotnot part of the User Credentials export file.

To export a User Credentials File:

1. Do the following:

•  Click the Export CredentialsExport CredentialsExport CredentialsExport Credentials button in the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box to 
display the SaveSaveSaveSave dialog box.

FIGURE: SaveSaveSaveSave dialog box

•  Specify the location and name of the .xml file you want to export.

•  Click the SaveSaveSaveSave button.

The EncryptionEncryptionEncryptionEncryption pop up displays, allowing you to choose whether you want to encrypt 
all passwords in your Credential Profile .xml file.

FIGURE: EncryptionEncryptionEncryptionEncryption pop up
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2. If you:

•  want to encrypt the passwords in your Credential Profile .xml file, then click the 
YesYesYesYes button and see Step 3

•  do notnotnotnot want to encrypt the passwords in your Credential Profile .xml file, then 
click the NoNoNoNo button and see Step 4.

3. If you click the YesYesYesYes button in Step 2 to encrypt the passwords in your 
Credential Profile .xml file, then the PassphrasePassphrasePassphrasePassphrase pop up displays, 
prompting you to enter a unique passphrase. Whenever you import this 
Credential Profile .xml file, you must enter this passphrase in order to load 
the Credential Profile.

FIGURE: PassphrasePassphrasePassphrasePassphrase pop up

Enter a passphrase and click the EncryptEncryptEncryptEncrypt button.

4. After you export your (encrypted or unencrypted) Credential Profile .xml 
file, a “success” message displays.
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Working with Fix Scripts
This chapter consists of the following topics:

•  What are Fix Scripts?

•  Fix Script parameters

•  Running an “on-demand” Fix Script

•  Automatically running a Fix Script

•  Downloading and viewing the details of a Fix Script

•  Customizing a Fix Script

•  Deleting a Fix Script.

What are Fix
Scripts?

Fix ScriptsFix ScriptsFix ScriptsFix Scripts are DbProtect-generated SQL scripts designed to correct misconfigurations 
and address vulnerabilities identified by DbProtect during an Audit. You can 
voluntarily deploy DbProtect-generated Fix Scripts to remediate your vulnerable 
databases.

DbProtect Vulnerability Management allows you to generate Fix Scripts in two ways:

•  “On demand”“On demand”“On demand”“On demand” for allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected on an individualindividualindividualindividual Audited Audited Audited Audited 
database instancedatabase instancedatabase instancedatabase instance, or for individualindividualindividualindividual vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected on an individual individual individual individual 
Audited database instanceAudited database instanceAudited database instanceAudited database instance; for more information, see Running an “on-
demand” Fix Script and Automatically running a Fix Script

•  AutomaticallyAutomaticallyAutomaticallyAutomatically for allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected for allallallall Audited database instancesAudited database instancesAudited database instancesAudited database instances; 
for more information, for more information, see Running an “on-demand” Fix 
Script and Automatically running a Fix Script

DbProtect Vulnerability Management also allows you to:

•  download and view the details of a Fix Script; for more information, see 
Downloading and viewing the details of a Fix Script

•  customize a Fix Script; for more information, see Customizing a Fix Script

•  delete a Fix Script; for more information, see Deleting a Fix Script.

Important: For Fix Script details, see Appendix J: Fix Scripts (Detail).
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Fix Script
parameters

The following table lists Fix Script parametersFix Script parametersFix Script parametersFix Script parameters: 

•  <NEW PASSWORD>. New password to replace existing password. See database 
documentation for details.

•  <CURRENT PASSWORD>. Currently active password for user.

•  <PASSWORD>. Password to be set. See database documentation for details.

•  <NEW VERIFY FUNCTION>. Name of a function used to verify passwords for 
compliance.

•  <NEW DEFAULT TABLESPACE>. Name of a tablespace to be used as the default 
tablespace.

•  <NEW PROFILE NAME>. Name of a profile to be created or assigned to a user.

•  <NEW ROLE>. Name of a role to be created.

•  <NEW VALUE>. Generic placeholder for parameter values. See database 
documentation for details.

•  <NEW METHOD>. DB2 configuration value.

•  <LIMIT TYPE>. Parameter value used for sp_add_resource_limit stored 
procedure. See Sybase documentation for details.

•  <ENFORCED>. Parameter value used for sp_add_resource_limit stored 
procedure. See Sybase documentation for details.

•  <ACTION>. Parameter value used for sp_add_resource_limit stored 
procedure. See Sybase documentation for details.

•  <SCOPE>. Parameter value used for sp_add_resource_limit stored procedure. 
See Sybase documentation for details.

•  <CHOOSE 'on'|'off'>. Parameter value. Possible values are 'on' and 'off'.

•  <CHOOSE 'on'|'fail'|'pass'>. Parameter value. Possible values are 'on', 
'fail', and 'pass'.

•  <CURRENT AUDIT TABLE>. Table name.

•  <YOUR SERVER NAME>. Server host name.

•  <CORRESPONDING LOGIN>. Login name for user.

•  <LOGIN PASSWORD>. Password for login name.

•  <NEW SA LOGIN>. SA login name to replace 'sa'.

Running an “on-
demand” Fix Script

You can run an “on demand” Fix Script“on demand” Fix Script“on demand” Fix Script“on demand” Fix Script to generate a Fix Script that will repair 
vulnerabilities detected during an Audit. As the name implies, you can run “on 
demand” Fix Scripts anytime you want. Specifically, you can run an “on demand”“on demand”“on demand”“on demand” Fix 
Script to repair:

•  allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected on an individualindividualindividualindividual Audited database instanceAudited database instanceAudited database instanceAudited database instance; for 
more information, see Running an “on demand” Fix Script to repair all 
vulnerabilities detected on an individual Audited database instance
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•  individualindividualindividualindividual vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected on an individual Audited database instanceindividual Audited database instanceindividual Audited database instanceindividual Audited database instance; 
for more information, see Running an “on demand” Fix Script to repair 
individual vulnerabilities detected on an individual Audited database instance.

(Alternately, you can generate a Fix Script automaticallyautomaticallyautomaticallyautomatically (i.e., as soon as your Audit Job 
completes). This option generates Fix Scripts to repair allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected for 
allallallall Audited database instancesAudited database instancesAudited database instancesAudited database instances; for more information, see Automatically running a Fix 
Script.)

RUNNING AN “ON DEMAND” FIX SCRIPT TO REPAIR ALL 

VULNERABILITIES DETECTED ON AN INDIVIDUAL AUDITED 

DATABASE INSTANCE

To run an “on demand” Fix Script to repair allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected on an individualindividualindividualindividual 
Audited database instanceAudited database instanceAudited database instanceAudited database instance: 

1. Audit a Discovered database application; for more information, see Creating an 

Audit Job.

2. Locate your completed Jobs. They display in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs 
page (Completed Jobs Completed Jobs Completed Jobs Completed Jobs portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)
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3. Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details to display the 
Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The upper Job DetailsJob DetailsJob DetailsJob Details portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays the Audit 
Job’s historical details; for more information, see Viewing the Job details of a 
completed Job.

The lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays information 
about any Fix Scripts that have already been run, including:

•  Name

•  Generation Date

•  StatusStatusStatusStatus.

Note:Note:Note:Note: You can right click an existing Fix Script in the Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box to download and view the details of a Fix Script; 
for more information, see Downloading and viewing the details of a Fix 
Script.
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4. Right click any completed Audit Job in the upper Job DetailsJob DetailsJob DetailsJob Details portion of 
the Job History Details Job History Details Job History Details Job History Details dialog box, and select Generate Fix ScriptGenerate Fix ScriptGenerate Fix ScriptGenerate Fix Script.

DbProtect generates an “on demand” Fix Script to repair all vulnerabilitiesall vulnerabilitiesall vulnerabilitiesall vulnerabilities detected 
on the selected individual Audited database instance.

The Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays your “on 
demand” Fix Script.

Next, you can:

•  download the Fix Script and view its details; for more information, see 
Downloading and viewing the details of a Fix Script

•  customize the Fix Script; for more information, see Customizing a Fix Script.

RUNNING AN “ON DEMAND” FIX SCRIPT TO REPAIR 

INDIVIDUAL VULNERABILITIES DETECTED ON AN 

INDIVIDUAL AUDITED DATABASE INSTANCE

To run an “on demand” Fix Script to repair individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities detected on an 
individual Audited database instanceindividual Audited database instanceindividual Audited database instanceindividual Audited database instance: 

1. Audit a Discovered database application; for more information, see Creating an 

Audit Job.

2. Locate your completed Jobs. They display in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs 
page (Completed Jobs Completed Jobs Completed Jobs Completed Jobs portion).

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)
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3. Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details to display the 
Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The upper Job DetailsJob DetailsJob DetailsJob Details portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays the Audit 
Job’s historical details; for more information, see Viewing the Job details of a 
completed Job.

The lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays information 
about any Fix Scripts that have already been run, including:

•  NameNameNameName

•  Generation DateGeneration DateGeneration DateGeneration Date

•  StatusStatusStatusStatus.

Note:Note:Note:Note: You can right click an existing Fix Script in the Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box to download and view the details of a Fix Script; 
for more information, see Downloading and viewing the details of a Fix 
Script.
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4. Do one of the following to display the Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box:

•  Right click any completed Audit Job in the upper Job DetailsJob DetailsJob DetailsJob Details portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box, and select Additional InformationAdditional InformationAdditional InformationAdditional Information.

•  Double click any completed Audit Job in the upper Job DetailsJob DetailsJob DetailsJob Details portion of the 
Job History Details Job History Details Job History Details Job History Details dialog box.

The Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box (shown below) lists individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities 
detected during an Audit of a Discovered database.

FIGURE: Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box

Hint: You can check the Show checks with no violation found to display 

checks that did not detect any vulnerabilities during your Audit.

5. In the Check Violation MessagesCheck Violation MessagesCheck Violation MessagesCheck Violation Messages portion of the Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog 
box, check the FixFixFixFix checkbox next to one or more individual vulnerabilities.

6. Click the Generate Fix ScriptGenerate Fix ScriptGenerate Fix ScriptGenerate Fix Script button at the bottom of the Job Error Job Error Job Error Job Error 
MessagesMessagesMessagesMessages dialog box).

DbProtect generates an “on demand” Fix Script to repair individual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilitiesindividual vulnerabilities 
(selected in Step 4) for the selected individual Audited database instance.
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7. Click the CloseCloseCloseClose button to close the Job Error MessagesJob Error MessagesJob Error MessagesJob Error Messages dialog box.

8. Do one of the following to display the Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box:

•  Double click a completed Audit Job.

•  Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details.

The Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box is shown below.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays your “on 
demand” Fix Script.

You can:

•  download the Fix Script and view its details; for more information, see 
Downloading and viewing the details of a Fix Script

•  customize the Fix Script; for more information, see Customizing a Fix Script.
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Automatically
running a Fix

Script

You can automatically automatically automatically automatically generate a Fix Script (i.e., as soon as your Audit Job completes). 
to repair allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected for allallallall Audited database instancesAudited database instancesAudited database instancesAudited database instances.

(Alternately, you can generate Fix Scripts “on demand”, either for all vulnerabilities 
detected by an Audit, or for individual vulnerabilities; for more information, see 
Running an “on-demand” Fix Script.)

To automatically generate a Fix Script to repair allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities detected for allallallall 
Audited database instancesAudited database instancesAudited database instancesAudited database instances: 

Important: Creating an Audit Job and Editing a Job explain how to create and edit an 
Audit Job, respectively. The option to automatically generate a Fix Script is 
just one partjust one partjust one partjust one part of overall process of creating/editing an Audit Job.

1. If you are creating an Audit Job, do one of the following to display the Audit 

Template Editor dialog box:

•  Choose Jobs > Templates > New Audit Jobs > Templates > New Audit Jobs > Templates > New Audit Jobs > Templates > New Audit from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab, and choose New Job > New Audit New Job > New Audit New Job > New Audit New Job > New Audit in the Job Setup Job Setup Job Setup Job Setup 
OptionsOptionsOptionsOptions Toolbar on the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

If you are editing an Audit Job, do one of the following to display the Audit Template Audit Template Audit Template Audit Template 
Editor Editor Editor Editor dialog box:

•  Right click the Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup portion) 
and choose EditEditEditEdit.

•  Double click the Job in the pane of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page (Job Setup Job Setup Job Setup Job Setup portion).
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The Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box is shown below.

FIGURE: Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box

2. The Fix Script GenerationFix Script GenerationFix Script GenerationFix Script Generation section of the Audit Template Editor Audit Template Editor Audit Template Editor Audit Template Editor dialog box 
allows you to check the Enable Fix Script GenerationEnable Fix Script GenerationEnable Fix Script GenerationEnable Fix Script Generation checkbox (unchecked 
by default) to automatically generate a Fix Script to repair allallallall vulnerabilitiesvulnerabilitiesvulnerabilitiesvulnerabilities 
detected for allallallall database instancesdatabase instancesdatabase instancesdatabase instances that 

FIGURE: Fix Script GenerationFix Script GenerationFix Script GenerationFix Script Generation section of the Audit Template EditorAudit Template EditorAudit Template EditorAudit Template Editor dialog box

3. When your Audit Job completes, do one of the following to display the 
Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box:

•  Double click a completed Audit Job.

•  Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details.
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The Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box is shown below.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays your 
automatically-generated Fix Script.

You can:

•  download the Fix Script and view its details; for more information, see 
Downloading and viewing the details of a Fix Script

•  customize the Fix Script; for more information, see Customizing a Fix Script.
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Downloading and
viewing the details

of a Fix Script

After you generate an “on demand” or automatic Fix Script (for more information, see 
Running an “on-demand” Fix Script and Automatically running a Fix Script, 
respectively), you can download and view the details of the Fix Script.

To download and view the details of a Fix Script: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

2. Locate your completed Audit Jobs. They display in the Job History Job History Job History Job History portion 
of the Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

FIGURE: Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)

3. Do one of the following to display the Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box:

•  Double click a completed Audit Job.

•  Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details.
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The Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box is shown below.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

The lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job History Details Job History Details Job History Details Job History Details dialog box displays information 
about any Fix Scripts that have already been run, including:

•  NameNameNameName

•  Generation DateGeneration DateGeneration DateGeneration Date

•  StatusStatusStatusStatus.

4. Do one of the following to download the Fix    Script as a .zip file.

•  Right click any completed Fix Script in the lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box, and select DownloadDownloadDownloadDownload.

•  Double click any completed Fix Script in the lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box.
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5. A SaveSaveSaveSave dialog box displays, prompting you to save your Fix Script as a .zip 
file.

FIGURE: SaveSaveSaveSave dialog box

6. Save your Fix Script .zip file to a convenient location.
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7. Unzip the Fix Script .zip file, and open individual Fix Scripts to view the SQL 
details. By default, Fix Scripts display in Notepad, as shown below (but you 
can select other applications).

FIGURE: Fix Script displayed in Notepad

You can customize the Fix Script before you deploy it to your database; for more 
information, see Customizing a Fix Script.
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Customizing a Fix
Script

Some Fix Scripts contain parameter placeholders that you need to replace before the 
you actually run the Fix Script. For example, if an Audit detects an easily-guessed 
password vulnerability, your DbProtect-generated Fix Script may look something like 
this:

--Easily-guessed password

USE master

GO

sp_password 'john', '<NEW PASSWORD>', 'john'

GO

Placeholders are enclosed in angle brackets. So, in this example, the placeholder is 
<NEW PASSWORD>. You should replace this placeholder value with the user’s new 
password.

To customize a Fix Script: 

1. Download and view a generated Fix Script, as explained in Downloading and 

viewing the details of a Fix Script.

2. Customize the Fix Script using a standard text editing program like 
Notepad. Remember: placeholders are enclosed in angle brackets, e.g., 
<NEW PASSWORD>. When applicable, replace all placeholder values in Fix 
Script with actual values.

3. Save the Fix Script.
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Deleting a Fix
Script

To delete a Fix Script: 

1. Do one of the following to display the Manage Jobs page:

•  Choose Jobs > Manage Jobs > Manage Jobs > Manage Jobs > Manage from the menu.

•  Click the Manage JobsManage JobsManage JobsManage Jobs tab.

FIGURE: Manage Jobs Manage Jobs Manage Jobs Manage Jobs page

Locate your completed Audit Jobs. They display in the Job History Job History Job History Job History portion of the 
Manage Jobs Manage Jobs Manage Jobs Manage Jobs page.

Manage JobsManage JobsManage JobsManage Jobs page (Job History Job History Job History Job History portion)
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2. Do one of the following to display the Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box:

•  Double click a completed Audit Job.

•  Right click a completed Audit Job and choose Show DetailsShow DetailsShow DetailsShow Details.

•  The Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box is shown below.

FIGURE: Job History DetailsJob History DetailsJob History DetailsJob History Details dialog box

3. Do the following:

•  Right click any completed Fix Scripts in the lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box, and select DeleteDeleteDeleteDelete.

Hint: Click <CTRL> to highlight non-sequential Fix Scripts.

Caution! You cannot un-delete a deleted Fix Script.
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•  Right click any completed Fix Script in the lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box.

•  A Delete Fix Script? Delete Fix Script? Delete Fix Script? Delete Fix Script? pop up prompts you to confirm the deletion.

FIGURE: Delete Fix Script? Delete Fix Script? Delete Fix Script? Delete Fix Script? pop up

•  Click the YesYesYesYes button to delete the Fix Script(s).

•  The deleted Fix Script(s) disappear from the lower Fix Scripts Fix Scripts Fix Scripts Fix Scripts portion of the Job Job Job Job 
History Details History Details History Details History Details dialog box.
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Audit and Threat 
Management
A real-time database Audit and Threat Management Audit and Threat Management Audit and Threat Management Audit and Threat Management solution, DbProtect delivers 
database-specific protection and alerting for best-in-class protection of enterprise 
organizations.

DbProtect allows you to create Policies and Filters and to tune your detection 
parameters to customize which audit and security events you want to monitor. This 
helps you focus security efforts on information that is relevant, while bypassing false 
positives and irrelevant events.

This chapter of the DbProtect User’s Guide discusses how to use DbProtect Audit and DbProtect Audit and DbProtect Audit and DbProtect Audit and 
Threat ManagementThreat ManagementThreat ManagementThreat Management features on your enterprise database applications.

This section consists of the following chapters:

•  Understanding the DbProtect Audit and Threat Management User Interface (UI)

•  Audit and Threat Management User Roles

•  Sensors

•  Alerts

•  Policies

•  Dashboard

•  Filters

•  Reports

•  System Settings: Email Forwarding Rules, Forwarding Settings, Email Server 
Settings.
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Understanding the DbProtect 
Audit and Threat 
Management User Interface 
(UI)
This chapter consists of the following topics:

•  What is the DbProtect Audit and Threat Management UI?

•  DbProtect Audit and Threat Management UI components

•  Navigating the DbProtect Audit and Threat Management UI using the tabs

•  Navigating the DbProtect Audit and Threat Management UI using the workflow 
diagram

•  Understanding result sets.

What is the
DbProtect Audit

and Threat
Management UI?

The DbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UI is the web browser-based, graphical 
component of DbProtect that allows you to navigate to the various features of 
DbProtect Audit and Threat Management.

The DbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UIDbProtect Audit and Threat Management UI is comprised of the:

•  Home Home Home Home page; for more information, see Understanding the Home page

•  Alert Manager Alert Manager Alert Manager Alert Manager page; for more information, see Understanding the Alert 
Manager page

•  DashboardDashboardDashboardDashboard; for more information, see Understanding the Dashboard

•  Report Manager Report Manager Report Manager Report Manager page; for more information, see Understanding the Report 
Manager Page

•  Policy Manager Policy Manager Policy Manager Policy Manager page; for more information, see Understanding the Policy 
Manager page

•  Filter Manager Filter Manager Filter Manager Filter Manager page; for more information, see Understanding the Filter 
Manager page

•  Sensor Manager Sensor Manager Sensor Manager Sensor Manager page; for more information, see Understanding the Sensor 
Manager page

•  System SettingsSystem SettingsSystem SettingsSystem Settings page; for more information, see Understanding the System 
Settings page.
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UNDERSTANDING THE HOME PAGE

The Home Home Home Home page    (shown below) contains tabs, which allow you to navigate the UI. 
Every UI page has tabs. For more information, see Navigating the DbProtect Audit and 
Threat Management UI using the tabs.

The Home Home Home Home page also includes a workflow diagram, which consists of:

•  a graphical depiction of the DbProtect database monitoring and data tuning 
processes; for more information, see Introduction/Next Steps portion of the 
DbProtect Audit and Threat Management workflow diagram

•  interactive tools tools tools tools with links to appropriate DbProtect Audit and Threat 
Management UI pages; for more information, see:

-Configuration Tools portion of the DbProtect Audit and Threat Management 
workflow diagram

-Analysis Tools portion of the DbProtect Audit and Threat Management 
workflow diagram

-Alerting Action tools portion of the DbProtect Audit and Threat 
Management workflow diagram.

FIGURE: Home Home Home Home page
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UNDERSTANDING THE ALERT MANAGER PAGE

The Alert Manager Alert Manager Alert Manager Alert Manager page (shown below) allows you to monitor, filter, archive, and 
delete Alerts. This page displays real-time Alerts, color-coded for easy identification of 
risk level. Sorting, grouping, and criteria matching features allow you to Filter views of 
incoming Alerts. The notification refresh rate is customizable; for more information, 
see Monitoring, filtering, acknowledging, and archiving Alerts (via the Alert Manager).

DbProtect Audit and Threat Management only receives Alerts from properly-
registered, -configured, and -deployed Sensors. In order to receive Alerts, you must:

•  install and initialize install and initialize install and initialize install and initialize a host-based or network-based Sensor on the database 
instance you want to monitor (explained in the DbProtect Installation Guide)

•  registerregisterregisterregister your Sensor (explained in Registering a Sensor)

•  configureconfigureconfigureconfigure your Sensor and deploydeploydeploydeploy it on your database instance (explained in 
Understanding the Sensor Manager).

For more information on using the monitoring Alerts via the Alert ManagerAlert ManagerAlert ManagerAlert Manager, see 
Monitoring, filtering, acknowledging, and archiving Alerts (via the Alert Manager).

FIGURE: Alert Manager Alert Manager Alert Manager Alert Manager page



DbProtect 6.1 User’s Guide

Application Security, Inc. 222

UNDERSTANDING THE DASHBOARD

The Dashboard Dashboard Dashboard Dashboard (shown below) provides a graphical, high-level summary of Alerts, 
audits, and total Alert volume. The DashboardDashboardDashboardDashboard automatically refreshes itself every 30 
seconds to update the display of new, real-time Alerts. In addition, the DashboardDashboardDashboardDashboard 
allows you to drill down to the Alert ManagerAlert ManagerAlert ManagerAlert Manager, and view Alert data in detail. For more 
information, see Monitoring Alerts (via the Dashboard).

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

UNDERSTANDING THE REPORT MANAGER PAGE

The Report Manager Report Manager Report Manager Report Manager page (shown below) allows you to create and manage the 
templates used to create Reports for Alerts generated by the Sensors. For more 
information, see Understanding the Report Manager.

FIGURE: Report Manager Report Manager Report Manager Report Manager page
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UNDERSTANDING THE POLICY MANAGER PAGE

The Policy Manager Policy Manager Policy Manager Policy Manager page (shown below) allows you to create, edit, and deploy 
Policies which associate Alert-triggering Rules with the Sensors. This page also allows 
you to either exportexportexportexport a Policy to use on another DbProtect Audit and Threat 
Management installation, or importimportimportimport a Policy created on another DbProtect Audit and 
Threat Management installation.

You deploy Policies at the database instance level. Each configured instance of a 
registered Sensor mustmustmustmust have a Policy deployed to it (for more information, see 
Configuring a Sensor and deploying the configuration information). If you are 
monitoring multiple instances with a single Sensor, the Policy may or may not be the 
same for all instances.

For more information, see Understanding the Policy Manager.

FIGURE: Policy Manager Policy Manager Policy Manager Policy Manager page
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UNDERSTANDING THE FILTER MANAGER PAGE

The Filter Manager Filter Manager Filter Manager Filter Manager page (shown below) allows you to create and edit Filters, which 
customize the functionality of built-in Rules and Policies. This page also allows you to 
import and export Filters. For more information, see Understanding the Filter 
Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager
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UNDERSTANDING THE SENSOR MANAGER PAGE

The Sensor Manager Sensor Manager Sensor Manager Sensor Manager page (shown below) allows you to configure and deploy 
registered Sensors. This page also allows you to perform an ASAP Update of a 
registered Sensor (i.e., downloading the latest version of DbProtect Audit and Threat 
Management). For more information, see Configuring a Sensor and deploying the 
configuration information.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

UNDERSTANDING THE SYSTEM SETTINGS PAGE

The System Settings System Settings System Settings System Settings page (shown below) consists of the following sub-pages:

•  Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules, which allows you to email Alerts, instead of/in addition 
to the SNMP trap or file methods specified during the configuration/
deployment of an instance for a registered Sensor.

•  Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings, which allows you to specify the “polling frequency”, i.e., 
the interval between each successive check for Alerts to be forwarded via email.

•  Email Server SettingsEmail Server SettingsEmail Server SettingsEmail Server Settings, which allows you to configure your email server to 
accommodate the forwarding of Alerts and Reports via email.

For more information, see System Settings: Email Forwarding Rules, Forwarding 
Settings, Email Server Settings.

FIGURE: System Settings System Settings System Settings System Settings page (Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings tab selected)
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DbProtect Audit
and Threat

Management UI
components

A portion of the DbProtect Audit and Threat Management UI (the Home Home Home Home page) is 
shown below, with its parts labeled.

FIGURE: DbProtect Audit and Threat Management UI components (example from the Home Home Home Home 
page)

In addition, the upper right portion of every DbProtect Audit and Threat Management 
UI page displays your User IDUser IDUser IDUser ID and your associated “effective” OrganizationOrganizationOrganizationOrganization. If you are 
a Super User or an Admin User, and your User ID is associated with multiple 
Organizations, you can toggle between Organizations. For more information, see 
Setting Your “Effective” Organization.

For more information, on:

•  how Organizations work in DbProtect, see DbProtect Organizations, Users, and 
User Roles

•  user roles in DbProtect, see DbProtect Organizations, Users, and User Roles.

FIGURE: User ID/”effective” Organization information

Finally, the upper right portion of every DbProtect Audit and Threat Management UI 
page displays HelpHelpHelpHelp and LogoutLogoutLogoutLogout links, which allow you to display the online help and 
log out of DbProtect, respectively.

Tabs Workflow diagram
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The HomeHomeHomeHome page also has an interactive workflow diagramworkflow diagramworkflow diagramworkflow diagram, which consists of:

•  a graphical depiction of the DbProtect database monitoring and data tuning 
processes; for more information, see Introduction/Next Steps portion of the 
DbProtect Audit and Threat Management workflow diagram

•  interactive workflow links  workflow links  workflow links  workflow links to appropriate DbProtect Audit and Threat 
Management UI pages; for more information, see:

-Configuration Tools portion of the DbProtect Audit and Threat Management 
workflow diagram,

-Analysis Tools portion of the DbProtect Audit and Threat Management 
workflow diagram

-Alerting Action tools portion of the DbProtect Audit and Threat 
Management workflow diagram.

Navigating the
DbProtect Audit

and Threat
Management UI
using the tabs

The upper portion of everyeveryeveryevery DbProtect Audit and Threat Management UI page displays 
a row of tabstabstabstabs.

FIGURE: Tabs

From everyeveryeveryevery DbProtect Audit and Threat Management UI page you can click the:

•  HomeHomeHomeHome tab to display the HomeHomeHomeHome page.

•  AlertsAlertsAlertsAlerts tab to display the Alert Manager Alert Manager Alert Manager Alert Manager page, which allows you to monitor, filter, 
archive, and delete Alerts. DbProtect Audit and Threat Management receives 
Alerts from your registered Sensors. For more information, see Monitoring, 
filtering, acknowledging, and archiving Alerts (via the Alert Manager).

•  DashboardDashboardDashboardDashboard tab to display the DashboardDashboardDashboardDashboard, which provides a graphical, high-level 
summary of Alerts, audits, and total Alert volume. It allows you to drill down to 
the AlertsAlertsAlertsAlerts page, and view Alert data in detail. For more information, see 
Monitoring, filtering, acknowledging, and archiving Alerts (via the Alert 
Manager).

•  ReportsReportsReportsReports tab to display Report ManagerReport ManagerReport ManagerReport Manager, which allows you to create and manage 
Reports for Alerts generated by the Sensors. For more information, see 
Understanding the Report Manager.

•  PoliciesPoliciesPoliciesPolicies tab to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager, which allows you to create, edit, and 
deploy Policies which associate Alert-triggering Rules with the Sensors. For 
more information, see Understanding the Policy Manager.

•  FiltersFiltersFiltersFilters tab to display the Filter ManagerFilter ManagerFilter ManagerFilter Manager, which allows you to create and edit 
Filters, which customize the functionality of built-in Rules and Policies. For more 
information, see Understanding the Filter Manager.

•  SensorsSensorsSensorsSensors tab to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager, which allows you to configure and 
deploy registered Sensors. For more information, see Configuring a Sensor and 
deploying the configuration information.
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•  System Settings System Settings System Settings System Settings tab to display the System SettingsSystem SettingsSystem SettingsSystem Settings page, which consists of the 
following sub-pages:

-Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules, which allows you to email Alerts, instead of/in 
addition to the SNMP trap or file methods specified during the 
configuration/deployment of an instance for a registered Sensor.

-Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings, which allows you to specify the “polling frequency”, 
i.e., the interval between each successive check for Alerts to be forwarded via 
email.

-Email Server SettingsEmail Server SettingsEmail Server SettingsEmail Server Settings, which allows you to configure your email server to 
accommodate the forwarding of Alerts and Reports via email.

For more information, see System Settings: Email Forwarding Rules, Forwarding 

Settings, Email Server Settings.

•  HelpHelpHelpHelp tab to display the DbProtect Audit and Threat Management online help.

Navigating the
DbProtect Audit

and Threat
Management UI

using the workflow
diagram

The HomeHomeHomeHome page includes a DbProtect Audit and Threat Management workflow workflow workflow workflow 
diagramdiagramdiagramdiagram.

FIGURE: DbProtect Audit and Threat Management workflow diagram (from the HomeHomeHomeHome page)

Introduction and 
Next Steps portions Workflow links
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The HomeHomeHomeHome page workflow diagram consists of: 

•  a graphical depiction of the DbProtect database monitoring (i.e., the 
Introduction - Monitoring a Database Introduction - Monitoring a Database Introduction - Monitoring a Database Introduction - Monitoring a Database portion of the HomeHomeHomeHome page workflow 
diagram) and data tuning processes (i.e., the Next Steps - Tuning Data Next Steps - Tuning Data Next Steps - Tuning Data Next Steps - Tuning Data 
Collection Collection Collection Collection portion of the HomeHomeHomeHome page workflow diagram); for more information, 
see Introduction/Next Steps portion of the DbProtect Audit and Threat 
Management workflow diagram

•  interactive workflow links  workflow links  workflow links  workflow links to the appropriate DbProtect Audit and Threat 
Management pages; for more information, see:

-Configuration Tools portion of the DbProtect Audit and Threat Management 
workflow diagram

-Analysis Tools portion of the DbProtect Audit and Threat Management 
workflow diagram

-Alerting Action tools portion of the DbProtect Audit and Threat 
Management workflow diagram.
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INTRODUCTION/NEXT STEPS PORTION OF THE DBPROTECT 

AUDIT AND THREAT MANAGEMENT WORKFLOW DIAGRAM

The Introduction/Next Steps Introduction/Next Steps Introduction/Next Steps Introduction/Next Steps portion of the HomeHomeHomeHome page workflow diagram is shown 
below.

FIGURE: HomeHomeHomeHome page workflow diagram (Introduction/Next Steps Introduction/Next Steps Introduction/Next Steps Introduction/Next Steps portion)
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This portion of the HomeHomeHomeHome page workflow diagram graphically depicts how DbProtect 
Audit and Threat Management works in a typical new customer scenario (following the 
successful installation of DbProtect and the successful installation/initialization of one 
or more Sensors). It consists of two parts, explained in the table below. 

CONFIGURATION TOOLS PORTION OF THE DBPROTECT 

AUDIT AND THREAT MANAGEMENT WORKFLOW DIAGRAM

The Configuration Tools Configuration Tools Configuration Tools Configuration Tools portion of the HomeHomeHomeHome page workflow diagram is shown below.

FIGURE: HomeHomeHomeHome page workflow diagram (Configuration Tools Configuration Tools Configuration Tools Configuration Tools portion)

This portion of the HomeHomeHomeHome page workflow diagram (divided into Policy ManagementPolicy ManagementPolicy ManagementPolicy Management 
and System Settings System Settings System Settings System Settings sub-portions) allows you to click the:

•  PoliciesPoliciesPoliciesPolicies workflow link (in the Policy ManagementPolicy ManagementPolicy ManagementPolicy Management sub-portion) to display the 
Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager, which allows you to create, edit, and deploy Policies which 
associate Alert-triggering Rules with the Sensors. For more information, see 
Understanding the Policy Manager.

Part Steps
For more information, 

see:

Introduction - Introduction - Introduction - Introduction - 
Monitoring a Monitoring a Monitoring a Monitoring a 
DatabaseDatabaseDatabaseDatabase

1. Choose or create a Policy1. Choose or create a Policy1. Choose or create a Policy1. Choose or create a Policy Policies

2. Activate a Sensor (Register)2. Activate a Sensor (Register)2. Activate a Sensor (Register)2. Activate a Sensor (Register) Sensors

3. Configure the Sensor to monitor the 3. Configure the Sensor to monitor the 3. Configure the Sensor to monitor the 3. Configure the Sensor to monitor the 
database using selected Policydatabase using selected Policydatabase using selected Policydatabase using selected Policy

Next Steps - Next Steps - Next Steps - Next Steps - 
Tuning Data Tuning Data Tuning Data Tuning Data 
CollectionCollectionCollectionCollection

4. Review generated Alerts4. Review generated Alerts4. Review generated Alerts4. Review generated Alerts Alerts

5. Revise the Policy with new Filters5. Revise the Policy with new Filters5. Revise the Policy with new Filters5. Revise the Policy with new Filters Filters

6. Deploy modified Policy6. Deploy modified Policy6. Deploy modified Policy6. Deploy modified Policy Policies

7. Review generated Alerts or finished7. Review generated Alerts or finished7. Review generated Alerts or finished7. Review generated Alerts or finished Alerts
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Note:Note:Note:Note: You can also display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager by clicking the PoliciesPoliciesPoliciesPolicies tab on any 
DbProtect Audit and Threat Management UI page. For more information 
on the tabs, see Navigating the DbProtect Audit and Threat Management 
UI using the tabs.

•  FiltersFiltersFiltersFilters workflow link (in the Policy ManagementPolicy ManagementPolicy ManagementPolicy Management sub-portion) to display the Filter Filter Filter Filter 
ManagerManagerManagerManager, which allows you to create and edit Filters. Filters are used to 
customize the functionality of built-in Rules and Policies. For more information, 
see Understanding the Filter Manager.

Note:Note:Note:Note: You can also display the Filter ManagerFilter ManagerFilter ManagerFilter Manager by clicking the FiltersFiltersFiltersFilters tab on any 
DbProtect Audit and Threat Management UI page. For more information 
on the tabs, see Navigating the DbProtect Audit and Threat Management 
UI using the tabs.

•  Sensors - New Sensor Sensors - New Sensor Sensors - New Sensor Sensors - New Sensor workflow link (in the System Settings System Settings System Settings System Settings sub-portion) to 
display the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager, which allows you to register and configure 
installed Sensors. Registration establishes a secure connection between the 
Sensor and DbProtect Audit and Threat Management, and enables the Sensor 
to receive Alerts. For more information, see Registering a Sensor.

•  Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link (in the System SettingsSystem SettingsSystem SettingsSystem Settings sub-portion) to 
display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager, which allows you to configure and deploy your 
registered Sensors. For more information, see Understanding the Sensor 
Manager.

Note:Note:Note:Note: You can also display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager by clicking the SensorsSensorsSensorsSensors tab on 
any DbProtect Audit and Threat Management portal page. For more 
information on the tabs, see Navigating the DbProtect Audit and Threat 
Management UI using the tabs.

•  Sensors - ASAP Update Sensors - ASAP Update Sensors - ASAP Update Sensors - ASAP Update workflow link (in the System Settings System Settings System Settings System Settings sub-portion) to 
display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager, which allows you to perform an ASAP Update of 
your ASAP Updateable Sensors with the latest available security Rules. For 
more information, see Performing an ASAP Update of Rules in your Sensors.

Note:Note:Note:Note: You can also display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager by clicking the SensorsSensorsSensorsSensors tab on 
any DbProtect Audit and Threat Management portal page. For more 
information on the tabs, see Navigating the DbProtect Audit and Threat 
Management UI using the tabs.

•  Email - Configure Server Email - Configure Server Email - Configure Server Email - Configure Server workflow link (in the System Settings System Settings System Settings System Settings sub-portion) to 
display the System SettingsSystem SettingsSystem SettingsSystem Settings page, which allows you to configure the properties 
of your outbound SMTP Server. DbProtect Audit and Threat Management uses 
these values to forward Alerts and send Reports via email. For more 
information, see Understanding the System Settings page.
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Note:Note:Note:Note: You can also display the System Settings System Settings System Settings System Settings page by clicking the System System System System 
Settings Settings Settings Settings tab on any DbProtect Audit and Threat Management UI page. For 
more information on the tabs, see Navigating the DbProtect Audit and 
Threat Management UI using the tabs.

ANALYSIS TOOLS PORTION OF THE DBPROTECT AUDIT AND 

THREAT MANAGEMENT WORKFLOW DIAGRAM

The Analysis Tools Analysis Tools Analysis Tools Analysis Tools portion of the HomeHomeHomeHome page workflow diagram is shown below.

FIGURE: DbProtect Audit and Threat Management workflow diagram (Analysis Tools Analysis Tools Analysis Tools Analysis Tools portion)

This portion of the HomeHomeHomeHome page workflow diagram allows you to click the:

•  Alerts - Security Monitoring Alerts - Security Monitoring Alerts - Security Monitoring Alerts - Security Monitoring workflow link to display the Alert Manager Alert Manager Alert Manager Alert Manager page, 
which allows you to view or delete your archived Alerts, view/sort Alerts, filter 
Alerts, edit the Alert notification rate, edit the number of Alerts that display on 
the Alert ManagerAlert ManagerAlert ManagerAlert Manager, acknowledge and archive your Alert, and to view your Alert 
detail. For more information, see Understanding the Alert Manager.

Note:Note:Note:Note: You can also display the Alert ManagerAlert ManagerAlert ManagerAlert Manager page by clicking the AlertsAlertsAlertsAlerts tab on 
any DbProtect Audit and Threat Management UI page. For more 
information on the tabs, see Navigating the DbProtect Audit and Threat 
Management UI using the tabs.

•  Dashboard - Graphical Summary Dashboard - Graphical Summary Dashboard - Graphical Summary Dashboard - Graphical Summary workflow link to display the DashboardDashboardDashboardDashboard, which 
provides a graphical summary of Alerts, audits, and total Alert volume. For 
more information, see Dashboard.

Note:Note:Note:Note: You can also display the DashboardDashboardDashboardDashboard by clicking the DashboardDashboardDashboardDashboard tab on any 
DbProtect Audit and Threat Management UI page. For more information 
on the tabs, see Navigating the DbProtect Audit and Threat Management 
UI using the tabs.

•  Reports Reports Reports Reports workflow link to display the Report ManagerReport ManagerReport ManagerReport Manager, which allows you to run 
ReportsReportsReportsReports on Alerts received from registered Sensors. A Report is a tabular and 
graphical display of the results of a query constrained by user-supplied criteria 
entered during the Report generation process. The Report Manager Report Manager Report Manager Report Manager allows you 
to view a generated Report, create/copy/edit/delete Report templates, 
generate a Report now, or schedule a Report to get generated in the future.For 
more information, see Understanding the Report Manager.

Note:Note:Note:Note: You can also display the Report Manager Report Manager Report Manager Report Manager by clicking the ReportsReportsReportsReports tab on 
any DbProtect Audit and Threat Management UI page. For more 
information on the tabs, see Navigating the DbProtect Audit and Threat 
Management UI using the tabs.
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ALERTING ACTION TOOLS PORTION OF THE DBPROTECT 

AUDIT AND THREAT MANAGEMENT WORKFLOW DIAGRAM

The Alerting Action Tools Alerting Action Tools Alerting Action Tools Alerting Action Tools portion of the HomeHomeHomeHome page workflow diagram is shown 
below.

FIGURE: DbProtect Audit and Threat Management workflow diagram (Alerting Action Tools Alerting Action Tools Alerting Action Tools Alerting Action Tools 
portion)

This portion of the DbProtect Audit and Threat Management workflow diagram allows 
you to click the Email - Delivery Rules Email - Delivery Rules Email - Delivery Rules Email - Delivery Rules link to display the System SettingsSystem SettingsSystem SettingsSystem Settings page, which 
allows you to specify Email Forwarding Rules (i.e., user-defined criteria for forwarding 
your Alerts via email). When the criteria are met, DbProtect Audit and Threat 
Management emails the Alerts to your list of recipients, which is also specified in your 
Email Forwarding Rule. For more information, see Email Forwarding Rules.

Note:Note:Note:Note: You can also display the System Settings System Settings System Settings System Settings page by clicking the System System System System 
Settings Settings Settings Settings tab on any DbProtect Audit and Threat Management UI page. For 
more information on the tabs, see Navigating the DbProtect Audit and 
Threat Management UI using the tabs.

Understanding
result sets

Result setsResult setsResult setsResult sets refer to the number of records returnedrecords returnedrecords returnedrecords returned or records affectedrecords affectedrecords affectedrecords affected as the result of 
executing a SQL statement. 

Caution! In some cases, DbProtect Audit and Threat Management does 

not return result sets. For example, DML statements indicate 

records affected, but DDL statements do not. Each database 

vendor's architecture is different. In the case of network-based 

Sensors for DB2, it also relies on the client requesting the 

number of records affected.

DbProtect Audit and Threat Management displays result set information in the 
following parts of the application:

•  Alert detail. Alert detail. Alert detail. Alert detail. The Alert detail portion of the Alert page Alert page Alert page Alert page displays a count of 
records affected; Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager).

•  Advanced Filter WizardAdvanced Filter WizardAdvanced Filter WizardAdvanced Filter Wizard. RecordsAffected is a valid SQL Server name attribute 
when writing expressions in the Advanced Filter WizardAdvanced Filter WizardAdvanced Filter WizardAdvanced Filter Wizard; for more information, 
see SQL Server name attributes.
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•  Reports. Reports. Reports. Reports. The one built-in Detail ReportDetail ReportDetail ReportDetail Report (i.e., the AppRadar Monthly Self-AppRadar Monthly Self-AppRadar Monthly Self-AppRadar Monthly Self-
Auditing ReportAuditing ReportAuditing ReportAuditing Report) includes detailed values of “records affected”; for more 
information, see Understanding the Built-In Auditing Event Summary Report. 

The two built-in Summary ReportsSummary ReportsSummary ReportsSummary Reports (i.e., the Auditing Event SummaryAuditing Event SummaryAuditing Event SummaryAuditing Event Summary Report Report Report Report 
and the Security Event SummarySecurity Event SummarySecurity Event SummarySecurity Event Summary ReportReportReportReport) only include a count of “records 
affected”, but no details; for more information, see Understanding the Built-In 
Auditing Event Summary Report and Understanding the Built-In Security Event 
Summary Report, respectively.
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Audit and Threat 
Management User Roles
For information on Audit and Threat Management user rolesAudit and Threat Management user rolesAudit and Threat Management user rolesAudit and Threat Management user roles, and all other roles (and 
associated privileges) in DbProtect, see DbProtect Organizations, Users, and User 
Roles.
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Sensors
This chapter consists of the following topics:

•  What is a Sensor?

•  DbProtect audit and threat management limitations (based on Sensor type, 
activity, target database, and operating system)

•  Monitoring Oracle databases on an Oracle RAC

•  Monitoring Oracle databases in an Oracle Fail Safe cluster environment

•  Troubleshooting connection problems between the Console and a Sensor 
installed on Microsoft Windows 2008

•  Understanding the Sensor Manager

•  Registering a Sensor

•  Configuring a Sensor and deploying the configuration information

•  Deleting configured Sensors

•  Performing an ASAP Update of Rules in your Sensors

•  Monitoring the “health” of your Sensors (via the Sensor Manager)

•  Unregistering a Sensor

•  Manually removing a Sensor.

What is a Sensor? Sensors monitor your database for a variety of events, such as intrusion attempts or 
auditing of normal usage.

Two types of SensorsSensorsSensorsSensors are available: 

•  host-basedhost-basedhost-basedhost-based to monitor your SQL Server, Oracle, Sybase, or DB2 databases

•  network-basednetwork-basednetwork-basednetwork-based to monitor your Oracle, DB2, or Sybase databases.

The Sensor fires Alerts when a real-time monitored event occurs. For more 
information, see What is an Alert?

Important: For information on installing and uninstalling Sensors, including Sensors in 
a SQL Server cluster, see the DbProtect Installation Guide.
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DbProtect audit
and threat

management
limitations (based
on Sensor type,
activity, target
database, and

operating system)

DbProtect audit and threat management may have limitations based on the type of 
Sensor, the nature of the activity.

Network-based SensorsNetwork-based SensorsNetwork-based SensorsNetwork-based Sensors fire Alerts for allallallall remote connections, e.g., from a web server 
communicating to its remote back-end database. However, they do notnotnotnot detect activity 
originating from the database host.

Host-based SensorsHost-based SensorsHost-based SensorsHost-based Sensors detect both local and remote attacks. However, they detect only 
successfully executed commands. For example, a vulnerable database system may 
permit a certain type of attack, and that attack causes the host-based Sensor to 
generate an Alert. Importantly, a patched system generally rejects the same 
command, thus preventing a host-based Sensor from detecting an attempted breach.

In the special case of host-based monitoring of Oracle on Microsoft Windowshost-based monitoring of Oracle on Microsoft Windowshost-based monitoring of Oracle on Microsoft Windowshost-based monitoring of Oracle on Microsoft Windows, Sensors 
use a hybrid of network-based and host-based architectures. These “hybrid Sensors”“hybrid Sensors”“hybrid Sensors”“hybrid Sensors” 
detect allallallall attacks originating remotely, but only those local commands that are 
successfully executed. This does notnotnotnot apply to monitoring Oracle using a network-
based Sensor, or using a host-based Sensor on any *nix platform (i.e., Solaris, AIX, HP-
UX, or Red Hat Enterprise Linux) as these platforms follow the guidelines described 
above.

Any audit and threat management rules that do not follow the above guidelines have a 
note in their description indicating such discrepancies.

Monitoring Oracle
databases on an

Oracle RAC

If you installed a host-based Sensor for Oracle to monitor Oracle databases on an 
Oracle RACOracle RACOracle RACOracle RAC (regardless of host platform) you must appropriately configure the host-
based Sensor. For more information, see Appendix C: Installing and Configuring a 
Host-Based Sensor for Oracle to Monitor Oracle Databases on an Oracle RAC.

Monitoring Oracle
databases in an
Oracle Fail Safe

cluster
environment

If you installed a host-based Sensor for Oracle (on Windows) to monitor Oracle Oracle Oracle Oracle 
databases in an Oracle Fail Safe cluster environmentdatabases in an Oracle Fail Safe cluster environmentdatabases in an Oracle Fail Safe cluster environmentdatabases in an Oracle Fail Safe cluster environment, you must appropriately 
configure your:

•  host-based Sensor for Oracle (on Windows); for more information, see 
Configuring a host-based Sensor to monitor Oracle SIDs and services and 
deploying the configuration information (when Sensor is installed on Windows)

•  Oracle Fail Safe cluster; for more information, see Appendix B: Monitoring 
Oracle Databases in an Oracle Fail Safe Environment: Sensor and Cluster 
Configuration Steps.
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Troubleshooting
connection

problems between
the Console and a
Sensor installed on

Microsoft
Windows 2008

If you’re having trouble establishing a connection between the Console and a Sensor 
installed on Microsoft Windows 2008 (i.e., a host-based Sensor for Oracle on 
Windows, a host-based Sensor for DB2 on Windows, a host-based Sensor for 
Microsoft SQL Server on Windows, or any network-based Sensor), make sure IPV6 
support is notnotnotnot enabled on the network adapter, and that your Microsoft Windows 
Firewall is disabled.

Understanding the
Sensor Manager

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager is shown below.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

The Sensor Manager allows you to:

•  access the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager and register new Sensors; for more 
information, see Registering a Sensor

•  configure and deploy your Sensors; for more information, see Configuring a 
Sensor and deploying the configuration information

•  ASAP Update your ASAP Pocketable Sensors with the latest available security 
Rules; for more information, see Performing an ASAP Update of Rules in your 
Sensors

•  monitor the “health” of your Sensors; for more information, see Monitoring the 
“health” of your Sensors (via the Sensor Manager)

•  unregister Sensors; for more information, see Unregistering a Sensor.
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Registering a
Sensor

Once you have installed the DbProtect and installed/initialized your Sensors (for more 
information, see the DbProtect Installation Guide), you must use the Registration Registration Registration Registration 
ManagerManagerManagerManager to register each Sensor you want the DbProtect Audit and Threat 
Management to monitor.

Registration establishes a secure connection between DbProtect Audit and Threat 
Management and a Sensor. You can only register your Sensors through DbProtect 
Audit and Threat Management.

Note:Note:Note:Note: If you plan to monitor a Microsoft SQL Server cluster, you only need to 
register and configure the Sensor that monitors a clustered Microsoft SQL 
Server instance onceonceonceonce -- regardless of how many nodes are in your cluster.

To register a Sensor (for Microsoft SQL Server, Oracle, Sybase, or DB2): 

1. Do one of the following to display the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager page:

•  Click the Sensors - Manage SensorSensors - Manage SensorSensors - Manage SensorSensors - Manage Sensor workflow link on the HomeHomeHomeHome page to display 
the Sensor ManagerSensor ManagerSensor ManagerSensor Manager, then click the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager link. 

Note:Note:Note:Note: If you have not registered any Sensors, the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager page 
displays when you click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page to display the Sensor Sensor Sensor Sensor 
ManagerManagerManagerManager, then click the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager link.

FFFFIIIIGGGGUUUURRRREEEE: : : : Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager

2. In the IP Address/Host NameIP Address/Host NameIP Address/Host NameIP Address/Host Name field, enter either the host IP address or the 
host name where the Sensor is installed.

Note:Note:Note:Note: If you are using Microsoft Clustering Services (MSCS), enter one of the 
following: a.) the Microsoft SQL Server Virtual Server name or, b.) the IP 
address associated with the Microsoft SQL Server Virtual Server name. 
Currently, DbProtect Audit and Threat Management only supports 
Microsoft SQL 2000 clusters.
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3. In the PortPortPortPort field, enter the port where the Sensor is running (specified 
during Sensor initialization; for more information, see the DbProtect 
Installation Guide). This is the port where the Sensor “listens” for 
commands from DbProtect Audit and Threat Management. The default 
port is 20000. 

Note:Note:Note:Note: At any time you can change the port number in the sensor.xml and 
sensor_original.xml files; for more information, see the DbProtect 
Administrator’s Guide.

Specify which port number the Sensor should use to receive commands from the 
DbProtect Console. The default port (20000) is recommended for most configurations. 
If necessary, enter a different port number (1-65535). Consult your network 
administrator to determine which network port is acceptable. For more information, 
see the DbProtect Installation Guide.

4. Click the NextNextNextNext button to display the next Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager

5. At this point, the Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager has enough information to register 
your Sensor. If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to register the Sensor, click the FinishFinishFinishFinish 
button.
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The Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager confirmation page displays your registered Sensor 
information.

FIGURE: Registration ManagerRegistration ManagerRegistration ManagerRegistration Manager confirmation page

6. Click the Sensor ManagerSensor ManagerSensor ManagerSensor Manager link (or the SensorsSensorsSensorsSensors tab) to display the Sensor Sensor Sensor Sensor 
ManagerManagerManagerManager and configure your registered Sensor; for more information, see 
Configuring a Sensor and deploying the configuration information.

Configuring a
Sensor and

deploying the
configuration
information

After you install and register the Sensor, you must configureconfigureconfigureconfigure it to “listen” to your:

•  SQL Server instances (host-based only)

•  Oracle SIDs or services (host-based or network-based)

•  DB2 database servers (host-based or network-based)

•  Sybase database servers (host-based or network-based).

Configured Sensors fire Alerts when conditions in the deployed Policy are met. (Alerts 
are notifications to DbProtect of the occurrence of a monitored event on the database 
host. A Policy is a set of Rules which identifies the conditions under which Alerts are 
fired and sent to DbProtect.)

Note:Note:Note:Note: DbProtect may have limitations based on the type of Sensor, the nature of 
the activity, the target database, and the operating system. For more 
information, see DbProtect audit and threat management limitations 
(based on Sensor type, activity, target database, and operating system).

Hint: If you have trouble establishing a connection between the Console and a 

Sensor installed on Microsoft Windows 2008 (i.e., a host-based Sensor for 

Oracle on Windows, a host-based Sensor for DB2 on Windows, a host-

based Sensor for Microsoft SQL Server on Windows, or any network-

based Sensor), make sure IPV6 support is not enabled on the network 

adapter, and that your Microsoft Windows Firewall is disabled.

After configuring the Sensor, you must deploydeploydeploydeploy the configuration information to the 
Sensor.
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This topic explains how to configure your:

•  host-based Sensorhost-based Sensorhost-based Sensorhost-based Sensor to monitor a SQL Server SQL Server SQL Server SQL Server instance and deploy the 
configuration information (when Sensor is installed on WindowsWindowsWindowsWindows); for more 
information, see Configuring a host-based Sensor to monitor a SQL Server 
instance and deploying the configuration information (when Sensor is installed 
on Windows)

•  host-based Sensorhost-based Sensorhost-based Sensorhost-based Sensor to monitor a DB2 DB2 DB2 DB2 database server and deploy the 
configuration information (when Sensor is installed on anyanyanyany operating systemoperating systemoperating systemoperating system); 
for more information, see Configuring a host-based Sensor to monitor a DB2 
database server and deploying the configuration information (when Sensor is 
installed on any operating system)

•  host-based Sensorhost-based Sensorhost-based Sensorhost-based Sensor to monitor a Sybase Sybase Sybase Sybase database server and deploy the 
configuration information (when Sensor is installed on a supported *nix-based 
operating system, i.e., Solaris Solaris Solaris Solaris or AIXAIXAIXAIX); for more information, see Configuring a 
host-based Sensor to monitor Sybase databases and deploying the 
configuration information (when Sensor is installed on a supported *nix-based 
operating system)

•  host-based Sensorhost-based Sensorhost-based Sensorhost-based Sensor to monitor OracleOracleOracleOracle SIDs or services and deploy the 
configuration information (when Sensor is installed on WindowsWindowsWindowsWindows or on a *nix-
based operating system, i.e., Solaris, AIX, HP-UX, or Red Hat Enterprise LinuxSolaris, AIX, HP-UX, or Red Hat Enterprise LinuxSolaris, AIX, HP-UX, or Red Hat Enterprise LinuxSolaris, AIX, HP-UX, or Red Hat Enterprise Linux); 
for more information, see:

-Configuring a host-based Sensor to monitor Oracle SIDs and services and deploying 
the configuration information (when Sensor is installed on Windows)

-Configuring a host-based Sensor to monitor Oracle SIDs and services and deploying 
the configuration information (when Sensor is installed on a *nix-based operating 

system)

Important: If you installed a host-based Sensor for Oracle to monitor Oracle 
databases on an Oracle RAC (regardless of host platform) you must 
appropriately configure the host-based Sensor. For more information, see 
Appendix C: Installing and Configuring a Host-Based Sensor for Oracle to 
Monitor Oracle Databases on an Oracle RAC.

•  network-based Sensornetwork-based Sensornetwork-based Sensornetwork-based Sensor to monitor a SybaseSybaseSybaseSybase database server and deploy the 
configuration information (on WindowsWindowsWindowsWindows); for more information, see Configuring 
a network-based Sensor to monitor a Sybase database server and deploying 
the configuration information (when Sensor is installed on Windows)

•  network-based Sensornetwork-based Sensornetwork-based Sensornetwork-based Sensor to monitor a DB2DB2DB2DB2 database server and deploy the 
configuration information (on WindowsWindowsWindowsWindows); for more information, see Configuring 
a network-based Sensor to monitor a DB2 database server and deploying the 
configuration information (when Sensor is installed on Windows)

•  network-based Sensornetwork-based Sensornetwork-based Sensornetwork-based Sensor to monitor OracleOracleOracleOracle SIDs or services and deploy the 
configuration information (on WindowsWindowsWindowsWindows); for more information, see Configuring 
a network-based Sensor to monitor Oracle SIDs and services and deploying the 
configuration information (when Sensor is installed on Windows).
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CONFIGURING A HOST-BASED SENSOR TO MONITOR A SQL 

SERVER INSTANCE AND DEPLOYING THE CONFIGURATION 

INFORMATION (WHEN SENSOR IS INSTALLED ON 

WINDOWS)

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Host-based Sensors detect both local and remote attacks. However, they 
detect only successfully executed commands. For example, a vulnerable 
database system may permit a certain type of attack, and that attack 
causes the host-based Sensor to generate an Alert. Importantly, a patched 
system generally rejects the same command, thus preventing a host-based 
Sensor from detecting an attempted breach.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).

To configure a host-based Sensor to monitor a SQL Server instance and deploy the 
configuration information (when Sensor is installed on Windows):

1. Do one of the following to display the Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor 
page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.
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2. The Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor page displays your registered 
Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor Sensor Manager: Configure Sensor page

This Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

You can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page, which allows you to select the Sensor's 
logging level (i.e., the volume of log information the Sensor outputs to its log 
file) (see Step 3)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new SQL Server instance SQL Server instance SQL Server instance SQL Server instance for the 
Sensor (see Steps 5-14)
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•  ReconfigureReconfigureReconfigureReconfigure button to modify a current configuration of a SQL Server instance SQL Server instance SQL Server instance SQL Server instance 
for the Sensor. See Steps 6-14)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's logging levellogging levellogging levellogging level.

FIGURE: Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.

When you’re done, you can click the NextNextNextNext button to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
from Step 2. You can click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new SQL Server instance SQL Server instance SQL Server instance SQL Server instance for the 
Sensor (and go to Step 3)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a SQL Server SQL Server SQL Server SQL Server 
instance instance instance instance for the Sensor (and go to Step 4)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.
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3. Configuring a new instance.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to select a database platform for the host-
based Sensor to monitor.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

•  Select Microsoft SQL Server 2000/2005/2008Microsoft SQL Server 2000/2005/2008Microsoft SQL Server 2000/2005/2008Microsoft SQL Server 2000/2005/2008.

•  Click the NextNextNextNext button.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to configure/re-configure a Sensor 
for host-based SQL ServerSQL ServerSQL ServerSQL Server.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

•  Enter a meaningful alias (e.g., MEMBERSHIP MSSQL DB1) in the Instance Alias Instance Alias Instance Alias Instance Alias field 
for the database instance you want this configuration of the Sensor to monitor. 
DbProtect Audit and Threat Management uses this alias to identify the SQL 
Server instance from which Alerts are received.

Important: The value you enter mustmustmustmust start with a letter and is restricted to a maximum 
of 128 characters.Your instance alias can only contain alphanumeric, 
underscore (_), period (.), and hyphen (-) characters, or spaces.    
AcceptableAcceptableAcceptableAcceptable examples: MEMBERSHIP MSSQL DB1, MEMBERSHIP.MSSQLDB1, 
MEMBERSHIP_MSSQL_DB1, MEMBERSHIP-MSSQLDB1, etc. UnacceptableUnacceptableUnacceptableUnacceptable 
examples: MEMBERSHIP:MSSQLDB1, MEMBERSHIP/MSSQLDB1, etc.

•  Use the Database instanceDatabase instanceDatabase instanceDatabase instance drop-down to select the SQL Server instance you 
want to monitor.
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Note:Note:Note:Note: If you are configuring the Sensor in a cluster, this value must be the 
instance of the virtual SQL Server server name that this Sensor should 
monitor. The virtual server name should automatically display in the drop-
down list.

•  Optionally, in the OptionalOptionalOptionalOptional portion of the page, you can modify the value in the 
Inactivity duration Inactivity duration Inactivity duration Inactivity duration field. The “inactivity duration” is the amount of time (in 
seconds) that must elapse with no activity on the SQL Server instance before 
the Sensor generates an inactivity Alert. The default value is 5 minutes (300 
seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

4. Click the NextNextNextNext button to display the next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

This page allows you to select a Policy the Sensor uses to monitor the configured SQL 
Server instance. Policies are sets of rules which identify the conditions under which 
Alerts are fired and sent to DbProtect Audit and Threat Management.

Use the Policy:Policy:Policy:Policy: drop-down to select a built-in or custom Policy that the Sensor will use 
to monitor the configured SQL Server instance.

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiple SQL Server instances simultaneously, which may (or may not) be 
monitored by the same Sensor. Additionally, you can change the Policies 
deployed (or deploy multiple additional Policies) any time by clicking the 
PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.
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5. The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard) respectively. In addition, 
the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail Reports Detail Reports Detail Reports Detail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports for Alerts.

Optionally, on this page you can check:

•  TrapTrapTrapTrap to receive Alerts also as SNMP traps

•  FileFileFileFile to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog to receive Alerts also as Syslog messages.

6. Click the NextNextNextNext button. If you checked:

•  TrapTrapTrapTrap, then go to Step 7

•  FileFileFileFile, then go to Step 8

•  SyslogSyslogSyslogSyslog, then go to Step 9.

7. Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you checked TrapTrapTrapTrap).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

•  Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving 
host, and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Optionally, click the AddAddAddAdd button and specify an additional SNMP server IP 
Address (notnotnotnot the host name), and an additional port number of the target 
SNMP server where you want Alerts sent.

•  When you’re done, click the NextNextNextNext button.
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If you also checked:

•  FileFileFileFile, then go to Step 8

•  SyslogSyslogSyslogSyslog, then go to Step 9.

Otherwise, go to Step 10.

8. Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you checked FileFileFileFile).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File NameFile NameFile NameFile Name field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the 
Sensor_installation_directory\logs directory, where 
Sensor_installation_directory is where the Sensor is installed.

•  Click the NextNextNextNext button.

If you also checked SyslogSyslogSyslogSyslog, then go to Step 9. Otherwise, go to Step 10.
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9. Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you checked SyslogSyslogSyslogSyslog). For a sample 
Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

•  Specify the Syslog server IP Address (or the host name), and the port number of 
the target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).

Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Optionally, click the AddAddAddAdd button and specify an additional Syslog server IP 
Address (or the host name), and an additional port number of the target Syslog 
server where you want Alerts sent.

•  When you’re done, click the NextNextNextNext button.
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After you finish specifying the SNMP trap, and/or log file, and/or Syslog parameters, 
then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor Manager.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page re-displays.
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10.In the bottom, right corner of the page you can click the:

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configured instance to the specified 
Sensor

•  CancelCancelCancelCancel button to cancel the Sensor configuration.

Caution! All your configuration changes will be lost if you click the Cancel 

button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Cancel Cancel Cancel Cancel and Deploy to Sensor  Deploy to Sensor  Deploy to Sensor  Deploy to Sensor buttons

Or you can click the:

•  Reconfigure SensorReconfigure SensorReconfigure SensorReconfigure Sensor button to reconfigure the Sensor before deploying the 
instance configuration in the specified Sensor

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button, if available (for a host-based Sensor, this 
button may be disabled if DbProtect Audit and Threat Management does notnotnotnot 
detect additional database instances for this server).

CONFIGURING A HOST-BASED SENSOR TO MONITOR A DB2 

DATABASE SERVER AND DEPLOYING THE CONFIGURATION 

INFORMATION (WHEN SENSOR IS INSTALLED ON ANY 

OPERATING SYSTEM)

Note:Note:Note:Note: DbProtect Audit and Threat Management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Host-based Sensors detect both local and remote attacks. However, they 
detect only successfully executed commands. For example, a vulnerable 
database system may permit a certain type of attack, and that attack 
causes the host-based Sensor to generate an Alert. Importantly, a patched 
system generally rejects the same command, thus preventing a host-based 
Sensor from detecting an attempted breach.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).
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To configure a host-based Sensor to monitor a DB2 database server and deploy the 
configuration information (when Sensor is installed on any operating system, i.e., 
Windows, Red Hat Enterprise Linux, Solaris, and AIX): 

1. Do one of the following to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

2. Click the ConfigureConfigureConfigureConfigure button (if you are configuring a Sensor for the first 
time), or the Reconfigure Reconfigure Reconfigure Reconfigure button (if you are reconfiguring a Sensor).

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

This Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.
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Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

When you’re done, you can click the:

•  ModifyModifyModifyModify button in the Advanced Settings Advanced Settings Advanced Settings Advanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging levellogging levellogging levellogging level (and go to Step 3)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new DB2 database server DB2 database server DB2 database server DB2 database server for the 
Sensor (and go to Step 4)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a DB2 database DB2 database DB2 database DB2 database 
serverserverserverserver for the Sensor (and go to Step 5)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

3. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor’s logging level:

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.
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When you’re done, you can click the NextNextNextNext button to re-display the second Sensor Sensor Sensor Sensor 
ManagerManagerManagerManager page (see Step 2), then click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new DB2 database serverDB2 database serverDB2 database serverDB2 database server for the 
Sensor (and go to Step 4)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a DB2 database DB2 database DB2 database DB2 database 
server server server server for the Sensor (and go to Step 5)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

4. Configuring a newnewnewnew instance.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to select a database platform for the host-
based Sensor to monitor.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

Note:Note:Note:Note: Microsoft SQL Server 2000 does not display as an option if your host-
based Sensor for DB2 is installed on a *nix operating system.

•  Select IBM DB2 UDB / IBM DB2IBM DB2 UDB / IBM DB2IBM DB2 UDB / IBM DB2IBM DB2 UDB / IBM DB2.

•  Click the NextNextNextNext button.

5. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to configure/re-configure/re-configure/re-configure/re-
configureconfigureconfigureconfigure a Sensor for host-based DB2DB2DB2DB2.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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Do the following:

•  Enter a meaningful DB2 database server alias (e.g., DB2_JAPAN) in the Instance Instance Instance Instance 
Alias: Alias: Alias: Alias: field for the database instance you want this configuration of the Sensor 
to monitor. DbProtect uses this alias to identify the DB2 database server from 
which Alerts are received.

Important: The value you enter mustmustmustmust start with a letter and is restricted to a maximum 
of 128 characters.Your instance alias can only contain alphanumeric, 
underscore (_), period (.), and hyphen (-) characters, or spaces.    
AcceptableAcceptableAcceptableAcceptable examples: MEMBERSHIP DB2 DB1, MEMBERSHIP.DB2DB1, 
MEMBERSHIP_DB2_DB1, MEMBERSHIP-DB2DB1, etc. UnacceptableUnacceptableUnacceptableUnacceptable examples: 
MEMBERSHIP:DB2DB1, MEMBERSHIP/DB2DB1, etc.

•  Enter the name of the DB2 database server you want to monitor in the DB2 DB2 DB2 DB2 
instance instance instance instance field.

•  Optionally, in the Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties portion of the page, you can 
modify the value in the Inactivity duration Inactivity duration Inactivity duration Inactivity duration field. The “inactivity duration” is the 
amount of time (in seconds) that must elapse with no activity on a DB2 server 
instance before the Sensor generates an inactivity Alert. The default value is 5 
minutes (300 seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

•  Click the NextNextNextNext button.
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6. The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays. It allows you to select a Policy 
that the Sensor uses to monitor the configured DB2 database server. 
Policies are sets of rules which identify the conditions under which Alerts 
are fired and sent to DbProtect Audit and Threat Management.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Use the Policy:Policy:Policy:Policy: drop-down to select a built-in or custom Policy the Sensor will use to 
monitor the configured DB2 database server.

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiple DB2 database instances simultaneously, which may (or may not) 
be monitored by the same Sensor. Additionally, you can change the 
Policies deployed (or deploy multiple additional Policies) any time by 
clicking the PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.

7. The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard) respectively. In addition, 
the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail Reports Detail Reports Detail Reports Detail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports for Alerts.
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Optionally, on this page you can check:

•  TrapTrapTrapTrap to receive Alerts also as SNMP traps

•  FileFileFileFile to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog to receive Alerts also as Syslog messages.

8. Click the NextNextNextNext button. If you checked:

•  TrapTrapTrapTrap, then go to Step 9

•  FileFileFileFile, then go to Step 10

•  SyslogSyslogSyslogSyslog, then go to Step 11.

Otherwise, go to Step 12.

9. Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you checked TrapTrapTrapTrap).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Optionally, click the AddAddAddAdd button and specify an additional SNMP server IP 
Address (notnotnotnot the host name), and an additional port number of the target 
SNMP server where you want Alerts sent.

•  When you’re done, click the NextNextNextNext button.

If you also checked:

•  FileFileFileFile, then go to Step 10

•  SyslogSyslogSyslogSyslog, then go to Step 11.

Otherwise, go to Step 12.
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10.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you checked FileFileFileFile).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File NameFile NameFile NameFile Name field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the 
Sensor_installation_directory\logs directory, where 
Sensor_installation_directory is where the Sensor is installed.

•  Click the NextNextNextNext button.

If you also checked SyslogSyslogSyslogSyslog, then go to Step 11. Otherwise, go to Step 12.

11.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you checked SyslogSyslogSyslogSyslog). For a sample 
Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager



DbProtect 6.1 User’s Guide

Application Security, Inc. 261

Specify the Syslog server IP Address, and the port number of the target Syslog server 
where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).

Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Optionally, click the AddAddAddAdd button and specify an additional Syslog server IP 
Address, and an additional port number of the target Syslog server where you 
want Alerts sent.

•  When you’re done, click the NextNextNextNext button.

12.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters, then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager.

The second Sensor ManagerSensor ManagerSensor ManagerSensor Manager page re-displays.
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13.In the bottom, right corner of the page you can click the:

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configured instance to the specified 
Sensor

•  CancelCancelCancelCancel button to cancel the Sensor configuration.

Caution! All your configuration changes will be lost if you click the Cancel 

button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Cancel Cancel Cancel Cancel and Deploy to Sensor  Deploy to Sensor  Deploy to Sensor  Deploy to Sensor buttons

Or you can click the:

•  Reconfigure SensorReconfigure SensorReconfigure SensorReconfigure Sensor button to reconfigure the Sensor before deploying the 
instance configuration in the specified Sensor

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button, if available (for a host-based Sensor, this 
button may be disabled if DbProtect Audit and Threat Management does notnotnotnot 
detect additional database instances for this server).

For more information, go back to Step 2.

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Host-based Sensors detect both local and remote attacks. However, they 
detect only successfully executed commands. For example, a vulnerable 
database system may permit a certain type of attack, and that attack 
causes the host-based Sensor to generate an Alert. Importantly, a patched 
system generally rejects the same command, thus preventing a host-based 
Sensor from detecting an attempted breach.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).

Important: If you installed a host-based Sensor for Oracle to monitor Oracle 
databases on an Oracle RAC (regardless of host platform) you must 
appropriately configure the host-based Sensor. For more information, see 
Appendix C: Installing and Configuring a Host-Based Sensor for Oracle to 
Monitor Oracle Databases on an Oracle RAC.
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CONFIGURING A HOST-BASED SENSOR TO MONITOR SYBASE 

DATABASES AND DEPLOYING THE CONFIGURATION 

INFORMATION (WHEN SENSOR IS INSTALLED ON A 

SUPPORTED *NIX-BASED OPERATING SYSTEM)

To configure a host-based Sensor to monitor Sybase databases and deploy the 
configuration information (when Sensor is installed on a supported *nix-based 
operating system, i.e., Solaris or AIX): 

1. Do one of the following to display the first Sensor Manager  Sensor Manager  Sensor Manager  Sensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

2. Click the ConfigureConfigureConfigureConfigure button (if you are configuring a Sensor for the first 
time), or the ReconfigureReconfigureReconfigureReconfigure button (if you are reconfiguring a Sensor).

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

This Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.
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Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

When you’re done, you can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (see Step 4)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Sybase database Sybase database Sybase database Sybase database for the 
Sensor (see Steps 5-16)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Sybase database Sybase database Sybase database Sybase database 
for the Sensor (see Steps 6-16)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

3. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level and/or modify the inactivity durationinactivity durationinactivity durationinactivity duration.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level.

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.
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When you’re done, you can click the NextNextNextNext button to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
from Step 2. You can click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Sybase database Sybase database Sybase database Sybase database for the 
Sensor (see Steps 5-16)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a Sybase database Sybase database Sybase database Sybase database 
for the Sensor (see Steps 6-16)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

4. Configuring a new instance.Configuring a new instance.Configuring a new instance.Configuring a new instance.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to select a database platform for the host-
based Sensor to monitor.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

•  Select Sybase DatabaseSybase DatabaseSybase DatabaseSybase Database.

•  Click the NextNextNextNext button.
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The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to configure/re-configure a Sensor 
for host-based SybaseSybaseSybaseSybase (when the Sensor is installed on a *nix-based operating system).

FIGURE: Sensor ManagerSensor ManagerSensor ManagerSensor Manager page

This page consists of three portions. If you want to work with the:

•  Database Identification Database Identification Database Identification Database Identification portion of the page, see Step 5

•  Database Login CredentialsDatabase Login CredentialsDatabase Login CredentialsDatabase Login Credentials portion of the page, see Step 6

•  Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties portion of the page, see Step 7.

When you’re done, go to Step 8.

5. In the Database IdentificationDatabase IdentificationDatabase IdentificationDatabase Identification portion of the page:

•  Enter a meaningful alias in the Instance Alias:Instance Alias:Instance Alias:Instance Alias: field for the Sybase database you 
want the Sensor to monitor. DbProtect Audit and Threat Management uses this 
alias to identify the Sybase database Sybase database Sybase database Sybase database from which Alerts are received.
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Important: Your instance    alias can only contain alphanumeric, underscore (_), period 
(.), and hyphen (-) characters, or spaces. Letters may be any mix of UPPER 
and/or lower case. AcceptableAcceptableAcceptableAcceptable examples: syb DB1, SYB.db1, Syb_DB1, 
SYB-DB1, etc. UnacceptableUnacceptableUnacceptableUnacceptable examples: SYB:DB1, SYB/DB1, etc.

•  The Database InstanceDatabase InstanceDatabase InstanceDatabase Instance buttons, fields, and drop-downs allow you to do the 
following:

-Select Select a Sybase instance from the list:Select a Sybase instance from the list:Select a Sybase instance from the list:Select a Sybase instance from the list:, and use the Database Instance Database Instance Database Instance Database Instance drop-
down to select a Sybase database host where a Sensor is installed

-Select Specify a Sybase instance and home below:Specify a Sybase instance and home below:Specify a Sybase instance and home below:Specify a Sybase instance and home below: and manually enter the Database Database Database Database 
Instance Instance Instance Instance name and the Sybase HomeSybase HomeSybase HomeSybase Home.

Note:Note:Note:Note: Sybase HomeSybase HomeSybase HomeSybase Home refers to the home directory for Sybase, i.e., the place on 
the operating system where the Sybase database is installed.

6. The Database Login Credentials Database Login Credentials Database Login Credentials Database Login Credentials portion of the page allows you to enter a 
Sybase loginSybase loginSybase loginSybase login and Login passwordLogin passwordLogin passwordLogin password, which DbProtect uses to monitor activity 
that requires local access.

7. In the Advanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring Properties portion of the page:

•  Inactivity Duration.Inactivity Duration.Inactivity Duration.Inactivity Duration. The Inactivity DurationInactivity DurationInactivity DurationInactivity Duration is the amount of time (in seconds) 
that must elapse with no activity on a Sybase database or service before the 
Sensor generates an inactivity Alert. The default value is 5 minutes (300 
seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

•  Audit Interval. Audit Interval. Audit Interval. Audit Interval. The Audit Poll IntervalAudit Poll IntervalAudit Poll IntervalAudit Poll Interval is a numerical value in seconds (1-600) 
that represents the interval at which the Sensor polls the Sybase Audit file to 
detect successful or failed login attempts. Default = 2 seconds.

•  Enable Self Audit. Enable Self Audit. Enable Self Audit. Enable Self Audit. Unchecked by default, the Enable Self AuditEnable Self AuditEnable Self AuditEnable Self Audit checkbox (if 
checked) instructs the Sensor to report on traffic that it (i.e., the Sensor itself) 
generates. Checking the Enable Self AuditEnable Self AuditEnable Self AuditEnable Self Audit checkbox will send queries of the 
Sybsecurity audit tables to the DbProtect rule engine.
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8. Click the NextNextNextNext button.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to select which Organizations can 
have direct access to Alerts generated on this Sybase instance. For more information 
on how Organizations work in DbProtect, see DbProtect Organizations, Users, and 
User Roles.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

9. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to select a Policy that 
the Sensor uses to monitor the configured Sybase database. Policies are 
sets of rules which identify the conditions under which Alerts are fired and 
sent to DbProtect Audit and Threat Management.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Use the Policy:Policy:Policy:Policy: drop-down to select a built-in or custom Policy the Sensor will use to 
monitor the configured Sybase database.

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiple Sybase databases simultaneously, which may (or may not) be 
monitored by the same Sensor. Additionally, you can change the Policies 
deployed (or deploy multiple additional Policies) any time by clicking the 
PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.
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10.The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard) respectively. In addition, 
the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail Reports Detail Reports Detail Reports Detail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports for Alerts.

Optionally, on this page you can check:

•  TrapTrapTrapTrap to receive Alerts also as SNMP traps

•  FileFileFileFile to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog to receive Alerts also as Syslog messages.

11.Click the NextNextNextNext button. If you checked:

•  TrapTrapTrapTrap, then go to Step 12

•  FileFileFileFile, then go to Step 13

•  SyslogSyslogSyslogSyslog, then go to Step 14.

Otherwise, go to Step 15.

12.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you checked TrapTrapTrapTrap).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked:

•  FileFileFileFile, then go to Step 13

•  SyslogSyslogSyslogSyslog, then go to Step 14.

Otherwise, go to Step 15.
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13.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you checked FileFileFileFile).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File Name:File Name:File Name:File Name: field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the Sensor_installation_directory\logs 
directory, where Sensor_installation_directory is where the Sensor is 
installed.

•  Click the NextNextNextNext button.

If you also checked SyslogSyslogSyslogSyslog, then go to Step 14. Otherwise, go to Step 15.

14.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you checked SyslogSyslogSyslogSyslog). For a sample 
Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).

Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).
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•  Optionally, click the AddAddAddAdd button and specify an additional Syslog server IP 
Address, and an additional port number of the target Syslog server where you 
want Alerts sent.

•  When you’re done, click the NextNextNextNext button.

15.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters, then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager.
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The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page from Step 2 re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

16.In the bottom, right corner of the page you can click the:

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configured instance to the specified 
Sensor

•  CancelCancelCancelCancel button to cancel the Sensor configuration.

Caution! All your configuration changes will be lost if you click the Cancel 

button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Cancel Cancel Cancel Cancel and Deploy to Sensor  Deploy to Sensor  Deploy to Sensor  Deploy to Sensor buttons

Or you can click the:

•  Reconfigure SensorReconfigure SensorReconfigure SensorReconfigure Sensor button to reconfigure the Sensor before deploying the 
instance configuration in the specified Sensor

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button, if available (for a host-based Sensor, this 
button may be disabled if DbProtect Audit and Threat Management does notnotnotnot 
detect additional database instances for this server).

For more information, go back to Step 2.
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CONFIGURING A HOST-BASED SENSOR TO MONITOR 

ORACLE SIDS AND SERVICES AND DEPLOYING THE 

CONFIGURATION INFORMATION (WHEN SENSOR IS 

INSTALLED ON WINDOWS)

In the case of host-based monitoring of Oracle on Microsoft Windows, the following 
conditions and warnings apply:

•  Host-based Sensors monitoring Oracle on Windows use a hybrid of network-
based and host-based architectures. These “hybrid Sensors” detect all attacks 
originating remotely, but only those local commands that are successfully 
executed. 

This does notnotnotnot apply to monitoring Oracle using a network-based Sensor, or 
using a host-based Sensor on any *nix platform (i.e., Solaris, AIX, HP-UX, or Red 
Hat Enterprise Linux) as these platforms follow standard network- and host-
based audit and threat management guidelines. 

For more information, see DbProtect audit and threat management limitations 
(based on Sensor type, activity, target database, and operating system).

•  Database login names are always reported in Alerts as /, while logins are 
reported as as sysdba.

•  The Rule “Login attempt – successful” “Login attempt – successful” “Login attempt – successful” “Login attempt – successful” only works (i.e., only fires an Alert) with 
local connections.

•  When monitoring any Oracle instance on Windows, granting privileges via a 
local Oracle session may cause associated Alerts to contain only the first 25 
characters of the SQL command. This is apparently due to a bug in Oracle. 
Application Security, Inc.’s security research team (Team SHATTER) is 
investigating.

Important: If you installed a host-based Sensor for Oracle to monitor Oracle 
databases on an Oracle RAC (regardless of host platform) you mustmustmustmust 
appropriately configure the host-based Sensor. For more information, see 
Appendix C: Installing and Configuring a Host-Based Sensor for Oracle to 
Monitor Oracle Databases on an Oracle RAC.

Important: If you installed a host-based Sensor for Oracle to monitor Oracle 
databases in an Oracle Fail Safe environment (Windows only) you mustmustmustmust 
appropriately configure the host-based Sensor. For more information, see 
Appendix B: Monitoring Oracle Databases in an Oracle Fail Safe 
Environment: Sensor and Cluster Configuration Steps.
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To configure a host-based Sensor to monitor Oracle SIDs and services and deploy the 
configuration information (when Sensor is installed on Windows):

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

2. Click the Configure Configure Configure Configure button (if you are configuring a Sensor for the first 
time), or the Reconfigure Reconfigure Reconfigure Reconfigure button (if you are reconfiguring a Sensor).

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

This Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).
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When you’re done, you can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (and go to Step 3)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (and go to Step 4)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (and go to Step 5)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

3. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level and/or modify the inactivity durationinactivity durationinactivity durationinactivity duration.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level.To modify the Sensor's logging level.To modify the Sensor's logging level.To modify the Sensor's logging level.

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.
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When you’re done, you can click the NextNextNextNext button to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
from Step 2. You can click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (and go to Step 4)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (and go to Step 5)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

4. Configuring a new instance.Configuring a new instance.Configuring a new instance.Configuring a new instance.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to select a database platform for the host-
based Sensor to monitor.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

•  Select Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database.

•  Click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to specify a network device the Sensor 
will use to monitor traffic.

Note:Note:Note:Note: If you are configuring a host-based Sensor for Oracle on Windows to 
monitor Oracle databases in an Oracle Fail Safe environment, you mustmustmustmust 
select a network adapter that is associated with a real IP address (where 
the network traffic can sniff packets). Make sure this is notnotnotnot the cluster 
heartbeat card, because cluster heartbeat cards do not detect network 
traffic. For more information, see Appendix B: Monitoring Oracle 
Databases in an Oracle Fail Safe Environment: Sensor and Cluster 
Configuration Steps.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page

•  Click the NextNextNextNext button.



DbProtect 6.1 User’s Guide

Application Security, Inc. 277

5. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to configure/re-
configure a Sensor for host-based OracleOracleOracleOracle (when the Sensor is installed on 
Windows).

FIGURE: Sensor ManagerSensor ManagerSensor ManagerSensor Manager page

This page consists of three portions. If you want to work with the:

•  Database Identification Database Identification Database Identification Database Identification portion of the page, see Step 6

•  Database Login CredentialsDatabase Login CredentialsDatabase Login CredentialsDatabase Login Credentials portion of the page, see Step 7

•  Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties portion of the page, see Step 8

•  Public Addresses Public Addresses Public Addresses Public Addresses portion of the page, see Step 9.

When you’re done, go to Step 10.
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6. In the Database IdentificationDatabase IdentificationDatabase IdentificationDatabase Identification portion of the page:

•  Enter a meaningful Oracle SID alias in the Instance Alias:Instance Alias:Instance Alias:Instance Alias: field, for the Oracle 
SID you want the Sensor to monitor. DbProtect Audit and Threat Management 
uses this alias to identify the Oracle SID from which Alerts are received.

Important: Your Oracle SID alias can only contain alphanumeric, underscore (_), 
period (.), and hyphen (-) characters, or spaces. AcceptableAcceptableAcceptableAcceptable examples: 
ORCL DB1, ORCL.DB1, ORCL_DB1, ORCL-DB1, etc. UnacceptableUnacceptableUnacceptableUnacceptable examples: 
ORCL:DB1, ORCL/DB1, etc.

Caution! If you installed a host-based Sensor for Oracle to monitor Oracle 

databases on an Oracle RAC, make sure your Instance Alias: 

a.) is unique for each registered host-based Sensor for Oracle; 

b.) is easily identifiable for the database you are monitoring; c.) 

is easily identifies the node where the Sensor is installed (e.g., 

Oracle RAC Node 1, Oracle RAC Node 2, etc.). For more 

information, see Appendix C: Installing and Configuring a 

Host-Based Sensor for Oracle to Monitor Oracle Databases 

on an Oracle RAC.

•  The Oracle SID:Oracle SID:Oracle SID:Oracle SID: fields allow you to do the following:

-Select Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:, and use the OracleOracleOracleOracle 
SIDSIDSIDSID drop-down to select an Oracle SID Oracle SID Oracle SID Oracle SID where a Sensor is installed (derived from the 
oratab file on the host)

-Select Specify Oracle SID and home below:Specify Oracle SID and home below:Specify Oracle SID and home below:Specify Oracle SID and home below: and manually enter the OracleOracleOracleOracle SIDSIDSIDSID name 
and the Oracle HomeOracle HomeOracle HomeOracle Home.

Note:Note:Note:Note: Oracle HomeOracle HomeOracle HomeOracle Home refers to the home directory for Oracle, i.e., the place on the 
operating system where the Oracle SID is installed. For example, 
c:\oracle\product\10.1.0\Db_2.

7. In the Database Login Credentials Database Login Credentials Database Login Credentials Database Login Credentials portion of the page:

•  Enter the name of the Net Service NameNet Service NameNet Service NameNet Service Name (128 alphanumeric characters 
maximum, including spaces) for the Oracle SID or service you want to monitor. 
See your database administrator if you are unsure of this value.

Note:Note:Note:Note: The Oracle TNS ListenerOracle TNS ListenerOracle TNS ListenerOracle TNS Listener is the server-based process that provides basic 
network connectivity for clients, application servers, and other databases 
to an Oracle database. A Listener can provide network connectivity to one 
or many SIDs and services.

•  Enter the Oracle login Oracle login Oracle login Oracle login and LoginLoginLoginLogin passwordpasswordpasswordpassword for your Oracle SID or service -- if 
you plan to use Filters.

Note:Note:Note:Note: For Windows authentication, leave these fields blank. The user ID defaults 
to the "SYS" user.

•  When you are finished configuring DbProtect Audit and Threat Management 
and defining all Rules, you can re-configure your Sensors withoutwithoutwithoutwithout an Oracle SID 
or service user name and password, and then re-deploy the Sensors.
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Note:Note:Note:Note: To enhance security, the user name/password pair that you enter is stored 
in encrypted form on the Sensor.

8. In the Advanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring Properties portion of the page:

•  Modify the Sensor's Polling Rate.Modify the Sensor's Polling Rate.Modify the Sensor's Polling Rate.Modify the Sensor's Polling Rate. The Polling RatePolling RatePolling RatePolling Rate (in milliseconds) is how often 
the Sensor polls for incoming database events and adjusts the rate interval. 
Lower values yield the best accuracy but increase CPU utilization. Higher values 
lessen the load on CPU utilization, but also diminish accuracy (in other words, 
some events may not be detected). Modifying this value yields variable results, 
depending on your database and system load and system hardware. Default = 
10 milliseconds.

•  Modify the Sensor's inactivity duration.Modify the Sensor's inactivity duration.Modify the Sensor's inactivity duration.Modify the Sensor's inactivity duration. The Inactivity DurationInactivity DurationInactivity DurationInactivity Duration is the amount of 
time (in seconds) that must elapse with no activity on an Oracle SID or service 
before the Sensor generates an inactivity Alert. The default value is 5 minutes 
(300 seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

9. In the Public Addresses Public Addresses Public Addresses Public Addresses portion of the page:

•  Enter the IP Address:IP Address:IP Address:IP Address: and Port: Port: Port: Port: of the network interface to the remotely-
monitored Oracle SID or service.

Note:Note:Note:Note: If you are configuring a host-based Sensor for Oracle on Windows to 
monitor Oracle databases in an Oracle Fail Safe environment, you mustmustmustmust 
configure the network adapter for the cluster's virtual IP address. If this 
address is not already populated in the IP Address:  IP Address:  IP Address:  IP Address: field, then you mustmustmustmust 
enter it manually. For more information, see Appendix B: Monitoring 
Oracle Databases in an Oracle Fail Safe Environment: Sensor and Cluster 
Configuration Steps.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.
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10.The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to select a Policy that 
the Sensor uses to monitor the configured Oracle SID or service. Policies 
are sets of rules which identify the conditions under which Alerts are fired 
and sent to DbProtect Audit and Threat Management.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Use the Policy:Policy:Policy:Policy: drop-down to select a built-in or custom Policy the Sensor will use to 
monitor the configured Oracle SID or service.

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiple Oracle SIDs or services simultaneously, which may (or may not) be 
monitored by the same Sensor. Additionally, you can change the Policies 
deployed (or deploy multiple additional Policies) any time by clicking the 
PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.

Caution! If you installed a host-based Sensor for Oracle to monitor Oracle 

databases on an Oracle RAC, you must deploy the exact same 

Policy for each host-based Sensor for Oracle (otherwise, you may 

get inconsistent results for the Alerts you are expecting to see). 

For more information, see Appendix C: Installing and 

Configuring a Host-Based Sensor for Oracle to Monitor 

Oracle Databases on an Oracle RAC and Deploying a Policy.

11.The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard) respectively. In addition, 
the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail Reports Detail Reports Detail Reports Detail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports for Alerts.

Optionally, on this page you can check:

•  TrapTrapTrapTrap to receive Alerts also as SNMP traps

•  FileFileFileFile to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog to receive Alerts also as Syslog messages.
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12.Click the NextNextNextNext button. If you checked:

•  TrapTrapTrapTrap, then go to Step 13

•  FileFileFileFile, then go to Step 14

•  SyslogSyslogSyslogSyslog, then go to Step 15.

Otherwise, go to Step 16.

13.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you checked TrapTrapTrapTrap).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked:

•  FileFileFileFile, then go to Step 14

•  SyslogSyslogSyslogSyslog, then go to Step 15.

Otherwise, go to Step 16.

14.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you checked FileFileFileFile).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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Do the following:

•  Enter an Alert log file name in File Name:File Name:File Name:File Name: field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the Sensor_installation_directory\logs 
directory, where Sensor_installation_directory is where the Sensor is 
installed.

•  Click the NextNextNextNext button.

If you also checked SyslogSyslogSyslogSyslog, then go to Step 15. Otherwise, go to Step 16.

15.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you checked SyslogSyslogSyslogSyslog). For a sample 
Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).

Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Optionally, click the AddAddAddAdd button and specify an additional Syslog server IP 
Address, and an additional port number of the target Syslog server where you 
want Alerts sent.

•  When you’re done, click the NextNextNextNext button.
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16.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters, then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager.
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The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page from Step 2 re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

17.In the bottom, right corner of the page you can click the:

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configured instance to the specified 
Sensor

•  CancelCancelCancelCancel button to cancel the Sensor configuration.

Caution! All your configuration changes will be lost if you click the Cancel 

button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Cancel Cancel Cancel Cancel and Deploy to Sensor  Deploy to Sensor  Deploy to Sensor  Deploy to Sensor buttons

Or you can click the:

•  Reconfigure SensorReconfigure SensorReconfigure SensorReconfigure Sensor button to reconfigure the Sensor before deploying the 
instance configuration in the specified Sensor

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button, if available (for a host-based Sensor, this 
button may be disabled if DbProtect Audit and Threat Management does notnotnotnot 
detect additional database instances for this server).

For more information, go back to Step 2.
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CONFIGURING A HOST-BASED SENSOR TO MONITOR 

ORACLE SIDS AND SERVICES AND DEPLOYING THE 

CONFIGURATION INFORMATION (WHEN SENSOR IS 

INSTALLED ON A *NIX-BASED OPERATING SYSTEM)

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Host-based Sensors detect both local and remote attacks. However, they 
detect only successfully executed commands. For example, a vulnerable 
database system may permit a certain type of attack, and that attack 
causes the host-based Sensor to generate an Alert. Importantly, a patched 
system generally rejects the same command, thus preventing a host-based 
Sensor from detecting an attempted breach.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).

Important: If you installed a host-based Sensor for Oracle to monitor Oracle 
databases on an Oracle RAC (regardless of host platform) you must 
appropriately configure the host-based Sensor. For more information, see 
Appendix C: Installing and Configuring a Host-Based Sensor for Oracle to 
Monitor Oracle Databases on an Oracle RAC.

To configure a host-based Sensor to monitor Oracle SIDs and services and deploy the 
configuration information (when Sensor is installed on a *nix-based operating system, 
i.e., Solaris, AIX, HP-UX, or Red Hat Enterprise Linux): 

1. Do one of the following to display the first Sensor Manager  Sensor Manager  Sensor Manager  Sensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

2. Click the ConfigureConfigureConfigureConfigure button (if you are configuring a Sensor for the first 
time), or the ReconfigureReconfigureReconfigureReconfigure button (if you are reconfiguring a Sensor).
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The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

This Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

When you’re done, you can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (see Step 4)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (see Steps 5-16)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (see Steps 6-16)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.
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3. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level and/or modify the inactivity durationinactivity durationinactivity durationinactivity duration.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level.

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.

When you’re done, you can click the NextNextNextNext button to display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
from Step 2. You can click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (see Steps 5-16)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (see Steps 6-16)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

4. Configuring a new instance.Configuring a new instance.Configuring a new instance.Configuring a new instance.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page prompts you to select a database platform for the host-
based Sensor to monitor.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager page
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•  Select Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database.

•  Click the NextNextNextNext button.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to configure/re-configure a Sensor 
for host-based OracleOracleOracleOracle (when the Sensor is installed on a *nix-based operating system).

FIGURE: Sensor ManagerSensor ManagerSensor ManagerSensor Manager page

This page consists of three portions. If you want to work with the:

•  Database Identification Database Identification Database Identification Database Identification portion of the page, see Step 5

•  Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties Advanced Monitoring Properties portion of the page, see Step 6

When you’re done, go to Step 7.

5. In the Database IdentificationDatabase IdentificationDatabase IdentificationDatabase Identification portion of the page:

•  Enter a meaningful Oracle SID alias in the Instance Alias:Instance Alias:Instance Alias:Instance Alias: field, for the Oracle 
SID you want the Sensor to monitor. DbProtect Audit and Threat Management 
uses this alias to identify the Oracle SID from which Alerts are received.
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Important: Your Oracle SID alias can only contain alphanumeric, underscore (_), 
period (.), and hyphen (-) characters, or spaces. AcceptableAcceptableAcceptableAcceptable examples: 
ORCL DB1, ORCL.DB1, ORCL_DB1, ORCL-DB1, etc. UnacceptableUnacceptableUnacceptableUnacceptable examples: 
ORCL:DB1, ORCL/DB1, etc.

Caution! If you installed a host-based Sensor for Oracle to monitor Oracle 

databases on an Oracle RAC, make sure your Instance Alias: 

a.) is unique for each registered host-based Sensor for Oracle; 

b.) is easily identifiable for the database you are monitoring; c.) 

is easily identifies the node where the Sensor is installed (e.g., 

Oracle RAC Node 1, Oracle RAC Node 2, etc.). For more 

information, see Appendix C: Installing and Configuring a 

Host-Based Sensor for Oracle to Monitor Oracle Databases 

on an Oracle RAC.

•  The Oracle SID:Oracle SID:Oracle SID:Oracle SID: fields allow you to do the following:

-Select Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:Select an Oracle instance from the list of discovered SIDs:, and use the OracleOracleOracleOracle 
SIDSIDSIDSID drop-down to select an Oracle SID Oracle SID Oracle SID Oracle SID where a Sensor is installed (derived from the 
oratab file on the host)

-Select Specify Oracle SID and home below:Specify Oracle SID and home below:Specify Oracle SID and home below:Specify Oracle SID and home below: and manually enter the OracleOracleOracleOracle SIDSIDSIDSID name 
and the Oracle HomeOracle HomeOracle HomeOracle Home.

Note:Note:Note:Note: Oracle HomeOracle HomeOracle HomeOracle Home refers to the home directory for Oracle, i.e., the place on the 
operating system where the Oracle SID is installed. For example, /
export/home/oracle/OraHome32. Also, in some installations of Oracle, 
there may be missing or extraneous configuration entries in the oratab file 
(typically found in the /var/opt/oracle or /etc/oratab). If this is the case 
on your server, AppSecInc recommends you manually specify the Oracle 
Home and Oracle SID.

6. In the Advanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring PropertiesAdvanced Monitoring Properties portion of the page:

•  IPC Port.IPC Port.IPC Port.IPC Port. The IPC PortIPC PortIPC PortIPC Port is where the Sensor “listens” for Alerts that pertain to 
Data Definition Language (DDL) changes. Typically, you should not have to 
change this port number from its default setting of port 7777.

•  Audit Poll Interval. Audit Poll Interval. Audit Poll Interval. Audit Poll Interval. The Audit Poll IntervalAudit Poll IntervalAudit Poll IntervalAudit Poll Interval is a numerical value in seconds (1-600) 
that represents the interval at which the Sensor polls the Oracle Audit file to 
detect successful or failed login attempts. Default = 60 milliseconds.

•  Polling Rate.Polling Rate.Polling Rate.Polling Rate. The Polling RatePolling RatePolling RatePolling Rate (in milliseconds) is how often the Sensor polls for 
incoming database events and adjusts the rate interval. Lower values yield the 
best accuracy but increase CPU utilization. Higher values lessen the load on 
CPU utilization, but also diminish accuracy (in other words, some events may 
not be detected). Modifying this value yields variable results, depending on 
your database and system load and system hardware. Default = 5 milliseconds.

•  DDL Trigger Schema Name. DDL Trigger Schema Name. DDL Trigger Schema Name. DDL Trigger Schema Name. The DDL Trigger Schema Name DDL Trigger Schema Name DDL Trigger Schema Name DDL Trigger Schema Name is the name of the 
schema where the DDL trigger resides. You can modify this value. The default 
value is SYS. For more information on working with DDL triggers, see Appendix 
E: Working with Oracle DDL Triggers in the DbProtect Installation Guide.
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•  Inactivity Duration.Inactivity Duration.Inactivity Duration.Inactivity Duration. The Inactivity DurationInactivity DurationInactivity DurationInactivity Duration is the amount of time (in seconds) 
that must elapse with no activity on an Oracle SID or service before the Sensor 
generates an inactivity Alert. The default value is 5 minutes (300 seconds). Valid 
values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

7. Click the NextNextNextNext button.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shown below allows you to select a Policy that the Sensor 
uses to monitor the configured Oracle SID or service. Policies are sets of rules which 
identify the conditions under which Alerts are fired and sent to DbProtect Audit and 
Threat Management.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Use the Policy:Policy:Policy:Policy: drop-down to select a built-in or custom Policy the Sensor will use to 
monitor the configured Oracle SID or service.

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiple Oracle SIDs or services simultaneously, which may (or may not) be 
monitored by the same Sensor. Additionally, you can change the Policies 
deployed (or deploy multiple additional Policies) any time by clicking the 
PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.

Caution! If you installed a host-based Sensor for Oracle to monitor Oracle 

databases on an Oracle RAC, you must deploy the exact same 

Policy for each host-based Sensor for Oracle (otherwise, you may 

get inconsistent results for the Alerts you are expecting to see). 

For more information, see Appendix C: Installing and 

Configuring a Host-Based Sensor for Oracle to Monitor 

Oracle Databases on an Oracle RAC and Deploying a Policy.
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8. The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard) respectively. In addition, 
the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail Reports Detail Reports Detail Reports Detail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports for Alerts.

Optionally, on this page you can check:

•  TrapTrapTrapTrap to receive Alerts also as SNMP traps

•  FileFileFileFile to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog to receive Alerts also as Syslog messages.

9. Click the NextNextNextNext button. If you checked:

•  TrapTrapTrapTrap, then go to Step 10

•  FileFileFileFile, then go to Step 11

•  SyslogSyslogSyslogSyslog, then go to Step 12.

Otherwise, go to Step 13.

10.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you checked TrapTrapTrapTrap).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked:

•  FileFileFileFile, then go to Step 11

•  SyslogSyslogSyslogSyslog, then go to Step 12.

Otherwise, go to Step 13.
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11.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you checked FileFileFileFile).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File Name:File Name:File Name:File Name: field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the Sensor_installation_directory\logs 
directory, where Sensor_installation_directory is where the Sensor is 
installed.

•  Click the NextNextNextNext button.

If you also checked SyslogSyslogSyslogSyslog, then go to Step 12. Otherwise, go to Step 13.

12.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you checked SyslogSyslogSyslogSyslog). For a sample 
Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).

Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).
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•  Optionally, click the AddAddAddAdd button and specify an additional Syslog server IP 
Address, and an additional port number of the target Syslog server where you 
want Alerts sent.

•  When you’re done, click the NextNextNextNext button.

13.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters, then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager.

The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page from Step 2 re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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14.In the bottom, right corner of the page you can click the:

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configured instance to the specified 
Sensor

•  CancelCancelCancelCancel button to cancel the Sensor configuration.

Caution! All your configuration changes will be lost if you click the Cancel 

button.

FFFFIIIIGGGGUUUURRRREEEE: : : : Cancel Cancel Cancel Cancel and Deploy to Sensor  Deploy to Sensor  Deploy to Sensor  Deploy to Sensor buttons

Or you can click the:

•  Reconfigure SensorReconfigure SensorReconfigure SensorReconfigure Sensor button to reconfigure the Sensor before deploying the 
instance configuration in the specified Sensor

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button, if available (for a host-based Sensor, this 
button may be disabled if DbProtect Audit and Threat Management does notnotnotnot 
detect additional database instances for this server).

For more information, go back to Step 2.

CONFIGURING A NETWORK-BASED SENSOR TO MONITOR A 

SYBASE DATABASE SERVER AND DEPLOYING THE 

CONFIGURATION INFORMATION (WHEN SENSOR IS 

INSTALLED ON WINDOWS)

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Network-based Sensors fire Alerts for all remote connections, e.g., from a 
web server communicating to its remote back-end database. However, 
they do not detect activity originating from the database host.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).
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To configure a network-based Sensor to monitor a Sybase database server and 
deploying the configuration information (when Sensor is installed on Windows):

1. Do one of the following:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your already-registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you have not registered any Sensors, then the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays a 
message.

2. Click the Configure Configure Configure Configure button (if you are configuring a Sensor for the first 
time), or the Reconfigure Reconfigure Reconfigure Reconfigure button (if you are reconfiguring a Sensor).

If you are configuring a new network-based Sensor, the next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
prompts you to specify a network device the Sensor will use to monitor traffic. If you 
have already configured the Sensor, go to Step 4.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Registered Sensor
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3. Select which network device the Sensor should use to monitor traffic. In 
addition to the namenamenamename of the device, you should also know the host IP host IP host IP host IP 
addressaddressaddressaddress each device is configured to use, and the subnet masksubnet masksubnet masksubnet mask of the 
network device. For example:

•  Device ID:Device ID:Device ID:Device ID: The number of the NIC (Network Interface Card) in the Sensor server. 
If the server only has one NIC, then the Device ID is 1. If there are multiple NICs 
on the server machine, they are listed as Device ID: 1, Device ID: 2, etc.

•  Description: Description: Description: Description: The make and model of the NIC, e.g., 3com 905B

•  Host IP Address: Host IP Address: Host IP Address: Host IP Address: The host IP address of the NIC, e.g., 192.168.1.5

•  Subnet Mask: Subnet Mask: Subnet Mask: Subnet Mask: The address of your organization’s subnet, e.g., 255.255.255.0.

4. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

5. You can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (see Steps 6-7)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Sybase database server Sybase database server Sybase database server Sybase database server for 
the Sensor (see Steps 8-19)
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•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Sybase database Sybase database Sybase database Sybase database 
server server server server for the Sensor (see Steps 8-19)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.

6. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level:

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.

7. When you’re done, you can click the NextNextNextNext button to re-display the second 
Sensor ManagerSensor ManagerSensor ManagerSensor Manager page (see Step 4), then click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Sybase database server Sybase database server Sybase database server Sybase database server for 
the Sensor (see Steps 8-19)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a Sybase database Sybase database Sybase database Sybase database 
server server server server for the Sensor (see Steps 8-19).
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8. Click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays, prompting you to select a database platform 
for the network-based Sensor to monitor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

9. Select Sybase (Network-Based Sensor)Sybase (Network-Based Sensor)Sybase (Network-Based Sensor)Sybase (Network-Based Sensor) and click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

10.Do the following:

•  Enter a meaningful instance alias (e.g., SYBASE_DB1) in the Instance AliasInstance AliasInstance AliasInstance Alias field, 
for the Sybase database server you want the Sensor to monitor (DbProtect 
Audit and Threat Management uses this alias to identify the databases from 
which Alerts are received).

•  Enter your Sybase database server Login NameLogin NameLogin NameLogin Name and LoginLoginLoginLogin PasswordPasswordPasswordPassword if you plan 
to use Filters.

When you are finished configuring DbProtect Audit and Threat Management 
and defining all Rules, you can re-configure your Sensors withoutwithoutwithoutwithout a Sybase 
database server user name and password, and then re-deploy the Sensors.
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Note:Note:Note:Note: To enhance security, the user name/password pair that you enter is stored 
in encrypted form on the Sensor. 

•  Optionally, in the OptionalOptionalOptionalOptional portion of the page, you can modify the value in the 
Inactivity duration Inactivity duration Inactivity duration Inactivity duration field. The “inactivity duration” is the amount of time (in 
seconds) that must elapse with no activity on a Sybase database server before 
the Sensor generates an inactivity Alert. The default value is 5 minutes (300 
seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

•  Enter the IP Address:IP Address:IP Address:IP Address: and Port: Port: Port: Port: of the network interface to the remotely-
monitored Sybase database server.

•  Click the AddAddAddAdd button.

A given host machine can accommodate (and, subsequently, a Sensor can monitor) 
multiple SIDs, servers, and services, including:

•  DB2 database serversDB2 database serversDB2 database serversDB2 database servers; for more information, see Configuring a network-based 
Sensor to monitor a DB2 database server and deploying the configuration 
information (when Sensor is installed on Windows))

•  Oracle SIDS and servicesOracle SIDS and servicesOracle SIDS and servicesOracle SIDS and services; for more information, see Configuring a network-
based Sensor to monitor Oracle SIDs and services and deploying the 
configuration information (when Sensor is installed on Windows).
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11.When you're done specifying the databases on the host machine that you 
want the Sensor to monitor, click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

12.Use the PolicyPolicyPolicyPolicy drop-down to select a built-in or custom Policy that the 
Sensor will use to monitor the configured database. Policies are sets of 
security Rules which identify the conditions under which Alerts are fired 
and sent to DbProtect Audit and Threat Management. Different Sensors 
and databases may require different Policies, since intrusion risk and data 
sensitivity will vary between database installations.

Note:Note:Note:Note: You can change the Policy associated with a configured database instance 
(or deploy multiple additional Policies to a configured database instance) 
any time by clicking the PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a 
Policy.

13.The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard), respectively. In 
addition, the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail ReportsDetail ReportsDetail ReportsDetail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports 
for Alerts. For more information, see Reports.
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Optionally, on this page you can check the:

•  TrapTrapTrapTrap checkbox to receive Alerts also as SNMP traps

•  FileFileFileFile checkbox to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog checkbox to receive Alerts as Syslog messages.

14.Click the NextNextNextNext button. If you checked the:

•  TrapTrapTrapTrap checkbox, then go to Step 15

•  FileFileFileFile checkbox, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox, then go to Step 17.

Otherwise, go to Step 18.

15.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you clicked the TrapTrapTrapTrap checkbox in Step 
13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked the:

•  FileFileFileFile checkbox in Step 13, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17.

Otherwise, go to Step 18.
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16.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you clicked the FileFileFileFile checkbox in Step 13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File NameFile NameFile NameFile Name field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the 
Sensor_installation_directory\logs directory, where 
Sensor_installation_directory is where the Sensor is installed.

•  Click the NextNextNextNext button.

If you also checked the SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17. Otherwise, go 
to Step 18.
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17.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you clicked the SyslogSyslogSyslogSyslog checkbox in 
Step 13). For a sample Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).
Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.
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18.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters (depending on which checkboxes, if any, you selected), then 
the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor Manager.
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19.The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

You can click the:

•  Reconfigure Reconfigure Reconfigure Reconfigure button to reconfigure the Sensor before deploying the 
configuration to the specified Sensor

•  CancelCancelCancelCancel button to cancel the configuration

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configuration to the specified Sensor

Important: You mustmustmustmust click the Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to make your modifications 
permanent.

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new database.
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CONFIGURING A NETWORK-BASED SENSOR TO MONITOR A 

DB2 DATABASE SERVER AND DEPLOYING THE 

CONFIGURATION INFORMATION (WHEN SENSOR IS 

INSTALLED ON WINDOWS)

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system.

Network-based Sensors fire Alerts for all remote connections, e.g., from a 
web server communicating to its remote back-end database. However, 
they do not detect activity originating from the database host.

For more information, see DbProtect audit and threat management 
limitations (based on Sensor type, activity, target database, and operating 
system).

To configure a network-based Sensor to monitor a DB2 database server and deploy 
the configuration information (when Sensor is installed on Windows): 

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your already-registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you have not registered any Sensors, then the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays a 
message.

Registered Sensor
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2. Click the Configure Configure Configure Configure button (if you are configuring a Sensor for the first 
time), or the Reconfigure Reconfigure Reconfigure Reconfigure button (if you are reconfiguring a Sensor).

If you are configuring a new network-based Sensor, the next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
prompts you to specify a network device the Sensor will use to monitor traffic. If you 
have already configured the Sensor, go to Step 4.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

3. Select which network device the Sensor should use to monitor traffic. In 
addition to the namenamenamename of the device, you should also know the host IP host IP host IP host IP 
addressaddressaddressaddress each device is configured to use, and the subnet masksubnet masksubnet masksubnet mask of the 
network device. For example:

•  Device ID: The number of the NIC (Network Interface Card) in the Sensor server. 
If the server only has one NIC, then the Device ID is 1. If there are multiple NICs 
on the server machine, they are listed as Device ID: 1, Device ID: 2, etc.

•  Description: Description: Description: Description: The make and model of the NIC, e.g., 3com 905B

•  Host IP Address: Host IP Address: Host IP Address: Host IP Address: The host IP address of the NIC, e.g., 192.168.1.5

•  Subnet Mask: Subnet Mask: Subnet Mask: Subnet Mask: The address of your organization’s subnet, e.g., 255.255.255.0
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4. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

5. You can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (see Steps 6-7)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new DB2 database server DB2 database server DB2 database server DB2 database server for the 
Sensor (see Steps 8-19)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a DB2 server DB2 server DB2 server DB2 server for the 
Sensor (see Steps 8-19)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.
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6. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level:

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.

7. When you’re done, you can click the NextNextNextNext button to re-display the second 
Sensor ManagerSensor ManagerSensor ManagerSensor Manager page (see Step 4), then click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new DB2 database server DB2 database server DB2 database server DB2 database server for the 
Sensor (see Steps 8-19)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of a DB2 database DB2 database DB2 database DB2 database 
server server server server for the Sensor (see Steps 8-19).

8. Click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays, prompting you to select a database platform 
for the network-based Sensor to monitor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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9. Select DB2 (Network-Based Sensor) DB2 (Network-Based Sensor) DB2 (Network-Based Sensor) DB2 (Network-Based Sensor) and click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

10.Do the following:

•  Enter a meaningful instance alias (e.g., DB2_EAGLE) in the Instance AliasInstance AliasInstance AliasInstance Alias field, for 
the DB2 database server you want the Sensor to monitor (DbProtect Audit and 
Threat Management uses this alias to identify the databases from which Alerts 
are received).

•  Enter the DB2 database server you want to monitor in the Database instanceDatabase instanceDatabase instanceDatabase instance 
field.

•  Enter your DB2 database server Login NameLogin NameLogin NameLogin Name and LoginLoginLoginLogin PasswordPasswordPasswordPassword if you plan to 
use Filters.

When you are finished configuring DbProtect Audit and Threat Management 
and defining all Rules, you can re-configure your Sensors withoutwithoutwithoutwithout a DB2 
database server user name and password, and then re-deploy the Sensors.

Note:Note:Note:Note: To enhance security, the user name/password pair that you enter is stored 
in encrypted form on the Sensor.
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Optionally, in the OptionalOptionalOptionalOptional portion of the page, you can modify the value in the 
Inactivity duration Inactivity duration Inactivity duration Inactivity duration field. The “inactivity duration” is the amount of time (in seconds) 
that must elapse with no activity on a DB2 database server before the Sensor 
generates an inactivity Alert. The default value is 5 minutes (300 seconds). Valid values 
are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

•  Enter the IP Address:IP Address:IP Address:IP Address: and Port: Port: Port: Port: of the network interface to the remotely-
monitored DB2 database server.

•  Click the AddAddAddAdd button.

A given host machine can accommodate (and, subsequently, a Sensor can monitor) 
multiple SIDs, servers, and services, including:

•  Sybase database serversSybase database serversSybase database serversSybase database servers; for more information, see Configuring a network-
based Sensor to monitor a Sybase database server and deploying the 
configuration information (when Sensor is installed on Windows))

•  Oracle SIDS and servicesOracle SIDS and servicesOracle SIDS and servicesOracle SIDS and services; for more information, see Configuring a network-
based Sensor to monitor Oracle SIDs and services and deploying the 
configuration information (when Sensor is installed on Windows).

11.When you're done specifying the databases on the host machine that you 
want the Sensor to monitor, click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager



DbProtect 6.1 User’s Guide

Application Security, Inc. 312

12.Use the PolicyPolicyPolicyPolicy drop-down to select a built-in or custom Policy the Sensor 
will use to monitor the configured database. Policies are sets of security 
Rules which identify the conditions under which Alerts are fired and sent to 
DbProtect Audit and Threat Management. Different Sensors and databases 
may require different Policies, since intrusion risk and data sensitivity will 
vary between database installations.

Note:Note:Note:Note: You can change the Policy associated with a configured database instance (or deploy 
multiple additional Policies to a configured database instance) any time by clicking the 
PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a Policy.

13.The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard), respectively. In 
addition, the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail ReportsDetail ReportsDetail ReportsDetail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports 
for Alerts. For more information, see Reports.

Optionally, on this page you can check the:

•  TrapTrapTrapTrap checkbox to receive Alerts also as SNMP traps

•  FileFileFileFile checkbox to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog checkbox to receive Alerts as Syslog messages.

14.Click the NextNextNextNext button. If you checked the:

•  TrapTrapTrapTrap checkbox, then go to Step 15

•  FileFileFileFile checkbox, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox, then go to Step 17.

Otherwise, go to Step 18.
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15.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you clicked the TrapTrapTrapTrap checkbox in Step 
13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked the:

•  FileFileFileFile checkbox in Step 13, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17.

Otherwise, go to Step 18.
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16.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you clicked the FileFileFileFile checkbox in Step 13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File NameFile NameFile NameFile Name field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the Sensor_installation_directory\logs 
directory, where Sensor_installation_directory is where the Sensor is 
installed.

•  Click the NextNextNextNext button.

If you also checked the SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17. Otherwise, go 
to Step 18.
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17.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you clicked the SyslogSyslogSyslogSyslog checkbox in 
Step 13). For a sample Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).
Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.
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After you finish specifying the SNMP trap, and/or log file, and/or Syslog parameters 
(depending on which checkboxes, if any, you selected), then the Sensor ManagerSensor ManagerSensor ManagerSensor Manager 
summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor Manager.
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18.The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

You can click the:

•  Reconfigure Reconfigure Reconfigure Reconfigure button to reconfigure the Sensor before deploying the 
configuration to the specified Sensor

•  CancelCancelCancelCancel button to cancel the configuration

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configuration to the specified Sensor

Important: You mustmustmustmust click the Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to make your modifications 
permanent.

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new database.
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CONFIGURING A NETWORK-BASED SENSOR TO MONITOR 

ORACLE SIDS AND SERVICES AND DEPLOYING THE 

CONFIGURATION INFORMATION (WHEN SENSOR IS 

INSTALLED ON WINDOWS)

Note:Note:Note:Note: DbProtect Audit and Threat Management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system. Network-based Sensors fire Alerts for all remote 
connections, e.g., from a web server communicating to its remote back-
end database. However, they do notnotnotnot detect activity originating from the 
database host. For more information, see DbProtect audit and threat 
management limitations (based on Sensor type, activity, target database, 
and operating system).

To configure a network-based Sensor to monitor Oracle SIDs and services and deploy 
the configuration information (when Sensor is installed on Windows): 

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your already-registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you have not registered any Sensors, then the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays a 
message.

Registered Sensor
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2. Click the Configure Configure Configure Configure button (if you are configuring a Sensor for the first 
time), or the Reconfigure Reconfigure Reconfigure Reconfigure button (if you are reconfiguring a Sensor).

If you are configuring a new network-based Sensor, the next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page 
prompts you to specify a network device the Sensor will use to monitor traffic. If you 
have already configured the Sensor, go to Step 4.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

3. Select which network device the Sensor should use to monitor traffic. In 
addition to the namenamenamename of the device, you should also know the host IP host IP host IP host IP 
addressaddressaddressaddress each device is configured to use, and the subnet masksubnet masksubnet masksubnet mask of the 
network device. For example:

•  Device ID: Device ID: Device ID: Device ID: The number of the NIC (Network Interface Card) in the Sensor server. 
If the server only has one NIC, then the Device ID is 1. If there are multiple NICs 
on the server machine, they are listed as Device ID: 1, Device ID: 2, etc.

•  Description: Description: Description: Description: The make and model of the NIC, e.g., 3com 905B

•  Host IP Address: Host IP Address: Host IP Address: Host IP Address: The host IP address of the NIC, e.g., 192.168.1.5

•  Subnet Mask: Subnet Mask: Subnet Mask: Subnet Mask: The address of your organization’s subnet, e.g., 255.255.255.0.
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4. The Sensor ManagerSensor ManagerSensor ManagerSensor Manager page shows the:

•  Alias Alias Alias Alias of any host server you have configured for your Sensor

•  database TypeTypeTypeType of the instance where your Sensor is registered

•  database instance (DB Instance) (DB Instance) (DB Instance) (DB Instance) where your Sensor is registered

•  PolicyPolicyPolicyPolicy associated with the registered Sensor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Note:Note:Note:Note: The Console also displays whether the rules in your PolicyPolicyPolicyPolicy are up-to-date 
or out-of-date. If a Policy is out-of-date, you can ASAP Update your Sensor 
with the latest security Rules (for more information, see Performing an 
ASAP Update of Rules in your Sensors), then use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to 
update Policies (deployed to your Sensors) with the new security Rules (for 
more information, see Creating a Policy and Editing a Policy).

5. You can click the:

•  ModifyModifyModifyModify button in the Advanced SettingsAdvanced SettingsAdvanced SettingsAdvanced Settings portion of the page to display the 
Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page, which allows you to select the Sensor's 
logging level (see Steps 6-7)

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (see Steps 8-19)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (see Steps 8-19)

•  XXXX button to delete a configured Sensor monitoring an instance; for more 
information, see Deleting configured Sensors.
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6. The Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings Advanced Sensor Settings page allows you to modify the Sensor's 
logging levellogging levellogging levellogging level.

FIGURE: Advanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor SettingsAdvanced Sensor Settings page

To modify the Sensor's logging level:

Use the Log level: Log level: Log level: Log level: drop-down to select the Sensor's logging level, which controls the 
volume of log information the Sensor outputs to its log file. You can select:

•  None. None. None. None. Sensor performs no logging.

•  Critical. Critical. Critical. Critical. Sensor logs only critical errors. The leastleastleastleast verbose level.

•  Error. Error. Error. Error. Sensor logs allallallall errors.

•  Warning.Warning.Warning.Warning. Sensor logs warnings and errors. Recommended level.

•  Info. Info. Info. Info. Sensor logs informational progress messages, which can be useful for 
verification.

•  Debug. Debug. Debug. Debug. Logs information used to troubleshoot Sensor problems at runtime.

Note:Note:Note:Note: ErrorErrorErrorError, CriticalCriticalCriticalCritical, and NoneNoneNoneNone are all decreased logging levels which you can 
use to optimize Sensor performance.

7. When you’re done, you can click the NextNextNextNext button to re-display the second 
Sensor ManagerSensor ManagerSensor ManagerSensor Manager page (see Step 4), then click the:

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new Oracle SID or service Oracle SID or service Oracle SID or service Oracle SID or service for the 
Sensor (see Steps 8-19)

•  ReconfigureReconfigureReconfigureReconfigure button to modify the current configuration of an Oracle SID or Oracle SID or Oracle SID or Oracle SID or 
service service service service for the Sensor (see Steps 8-19).

8. Click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays, prompting you to select a database platform 
for the network-based Sensor to monitor.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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9. Select Oracle (Network-Based Sensor) Oracle (Network-Based Sensor) Oracle (Network-Based Sensor) Oracle (Network-Based Sensor) and click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

10.Do the following:

•  Enter a meaningful instance alias (e.g., ORCL_EAGLE) in the Instance AliasInstance AliasInstance AliasInstance Alias field, 
for the Oracle SID or service you want the Sensor to monitor (DbProtect Audit 
and Threat Management uses this alias to identify the databases from which 
Alerts are received).

•  Enter the name of the OracleOracleOracleOracle SIDSIDSIDSID and Service NameService NameService NameService Name (128 alphanumeric 
characters maximum, including spaces) for the Oracle SID or service you want 
to monitor. See your database administrator if you are unsure of these values.

Note:Note:Note:Note: The Oracle TNS Listener is the server-based process that provides basic 
network connectivity for clients, application servers, and other databases 
to an Oracle database. A Listener can provide network connectivity to one 
or many SIDs and services.

•  Enter the Oracle login Oracle login Oracle login Oracle login and LoginLoginLoginLogin passwordpasswordpasswordpassword for your Oracle SID or service -- if 
you plan to use Filters.

When you are finished configuring DbProtect Audit and Threat Management 
and defining all Rules, you can re-configure your Sensors withoutwithoutwithoutwithout an Oracle SID 
or service user name and password, and then re-deploy the Sensors.
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Note:Note:Note:Note: To enhance security, the user name/password pair that you enter is stored 
in encrypted form on the Sensor.

Important: If you are using network-based Sensors for Oracle on Windows for Audit 
and Threat Management, and you want to use Filters, then you mustmustmustmust enter 
an Oracle user name and password in this step. The user name/password 
pair is notnotnotnot used to monitor your database. The pair is only used by the 
Audit Filter Wizard to collect object information from the database. For 
more information, see Working with the Audit Filter Wizard.

•  Optionally, in the OptionalOptionalOptionalOptional portion of the page, you can modify the value in the 
Inactivity duration Inactivity duration Inactivity duration Inactivity duration field. The “inactivity duration” is the amount of time (in 
seconds) that must elapse with no activity on the Oracle SID or service before 
the Sensor generates an inactivity Alert. The default value is 5 minutes (300 
seconds). Valid values are 0 to 86400 seconds (i.e., 24 hours).

Note:Note:Note:Note: Entering the value 0 (seconds) disables inactivity monitoring.

•  Enter the IP Address:IP Address:IP Address:IP Address: and Port: Port: Port: Port: of the network interface to the remotely-
monitored Oracle SID or service.

•  Click the AddAddAddAdd button.

A given host machine can accommodate (and, subsequently, a Sensor can monitor) 
multiple SIDs, servers, and services, including:

•  Sybase database serversSybase database serversSybase database serversSybase database servers; for more information, see Configuring a network-
based Sensor to monitor a Sybase database server and deploying the 
configuration information (when Sensor is installed on Windows))

•  DB2 database serversDB2 database serversDB2 database serversDB2 database servers; for more information, see Configuring a network-based 
Sensor to monitor a DB2 database server and deploying the configuration 
information (when Sensor is installed on Windows).
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11.When you're done specifying the databases on the host machine that you 
want the Sensor to monitor, click the NextNextNextNext button.

The next Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

12.Use the PolicyPolicyPolicyPolicy drop-down to select a built-in or custom Policy that the 
Sensor will use to monitor the configured database. Policies are sets of 
security Rules which identify the conditions under which Alerts are fired 
and sent to DbProtect Audit and Threat Management. Different Sensors 
and databases may require different Policies, since intrusion risk and data 
sensitivity will vary between database installations.

Note:Note:Note:Note: You can change the Policy associated with a configured database instance 
(or deploy multiple additional Policies to a configured database instance) 
any time by clicking the PoliciesPoliciesPoliciesPolicies tab; for more information, see Deploying a 
Policy.

13.The grayed-out DbProtect Console DbProtect Console DbProtect Console DbProtect Console checkbox indicates Alerts are alwaysalwaysalwaysalways 
sent to the DbProtect Console.

You can monitor these Alerts in real-time via the Alert ManagerAlert ManagerAlert ManagerAlert Manager and the DashboardDashboardDashboardDashboard; for 
more information, see Monitoring, filtering, acknowledging, and archiving Alerts (via 
the Alert Manager) and Monitoring Alerts (via the Dashboard), respectively. In 
addition, the Report ManagerReport ManagerReport ManagerReport Manager allows you to run Detail ReportsDetail ReportsDetail ReportsDetail Reports and Summary ReportsSummary ReportsSummary ReportsSummary Reports 
for Alerts. For more information, see Reports.
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Optionally, on this page you can check the:

•  TrapTrapTrapTrap checkbox to receive Alerts also as SNMP traps

•  FileFileFileFile checkbox to receive Alerts also in a log file

•  SyslogSyslogSyslogSyslog checkbox to receive Alerts as Syslog messages.

14.Click the NextNextNextNext button. If you checked the:

•  TrapTrapTrapTrap checkbox, then go to Step 15

•  FileFileFileFile checkbox, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox, then go to Step 17.

Otherwise, go to Step 18.

15.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.Receiving Alerts as SNMP traps.

The SNMP trap ConfigurationSNMP trap ConfigurationSNMP trap ConfigurationSNMP trap Configuration page displays (if you clicked the TrapTrapTrapTrap checkbox in Step 
13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the SNMP server IP AddressIP AddressIP AddressIP Address (notnotnotnot the host name) of the SNMP receiving host, 
and the portportportport number where the SNMP trap receiver “listens”.

Note:Note:Note:Note: The default port is 162, not 80.

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.

If you also checked the:

•  FileFileFileFile checkbox in Step 13, then go to Step 16

•  SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17.

Otherwise, go to Step 18.
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16.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.Receiving Alerts as Log Files.

The Log File Configuration  Log File Configuration  Log File Configuration  Log File Configuration page displays (if you clicked the FileFileFileFile checkbox in Step 13).

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Do the following:

•  Enter an Alert log file name in File NameFile NameFile NameFile Name field.

Be sure to enter the full name of the log file (including the directory), and the 
log file’s extension (e.g., .txt, .rtf, .log, etc.).

The Alert log file is stored in the Sensor_installation_directory\logs 
directory, where Sensor_installation_directory is where the Sensor is 
installed.

•  Click the NextNextNextNext button.

If you also checked the SyslogSyslogSyslogSyslog checkbox in Step 13, then go to Step 17. Otherwise, go 
to Step 18.
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17.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.Receiving Alerts as Syslog messages.

The Syslog File Configuration Syslog File Configuration Syslog File Configuration Syslog File Configuration page displays (if you clicked the SyslogSyslogSyslogSyslog checkbox in 
Step 13). For a sample Syslog message, see the DbProtect Administrator’s Guide.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

Specify the Syslog server IP Address (notnotnotnot the host name), and the port number of the 
target Syslog server where you want Alerts sent.

Note:Note:Note:Note: The default port is 514 (not 80).
Caution! The Syslog port is a User Datagram Protocol (UDP) port, as 

opposed to Transmission Control Protocol (TCP).

•  Click the AddAddAddAdd button.

•  Click the NextNextNextNext button.
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18.After you finish specifying the SNMP trap, and/or log file, and/or Syslog 
parameters (depending on which checkboxes, if any, you selected), then 
the Sensor ManagerSensor ManagerSensor ManagerSensor Manager summary page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to deploy the configuration to the 
Sensor, click the NextNextNextNext button.

Note:Note:Note:Note: You can reconfigure the Sensor any time via the Sensor Manager.
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19.The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page re-displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

You can click the:

•  Reconfigure Reconfigure Reconfigure Reconfigure button to reconfigure the Sensor before deploying the 
configuration to the specified Sensor

•  CancelCancelCancelCancel button to cancel the configuration

•  Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to deploy this configuration to the specified Sensor

Important: You mustmustmustmust click the Deploy to SensorDeploy to SensorDeploy to SensorDeploy to Sensor button to make your modifications 
permanent.

•  Configure New InstanceConfigure New InstanceConfigure New InstanceConfigure New Instance button to configure a new database.

Deleting
configured Sensors

You can deletedeletedeletedelete Sensors configured for:

•  SQL Server instances (host-based only)

•  Oracle SIDs or services (host-based or network-based)

•  DB2 database servers (host-based or network-based)

•  Sybase database servers (network-based only).

To delete a configured host- or network-based Sensor: 

1. Display the Sensor ManagerSensor ManagerSensor ManagerSensor Manager to view your configured Sensors, and 
determine which one you want to delete.
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2. From the Sensor ManagerSensor ManagerSensor ManagerSensor Manager page, click the XXXX button next to the configured 
Sensor you want to delete.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

A confirmation page prompts you to confirm that you are sure you want to delete the configured 
Sensor.

FIGURE: Confirm delete page

3. If you are sure you want to delete the configured Sensor, click the YesYesYesYes 
button.

Your configured Sensor is deleted.

Performing an
ASAP Update of

Rules in your
Sensors

Prior to the release of Console Management Server version 4.1 and Sensor version 3.9 
(both released as part of DbProtect 2009.1R4), if you wanted to update a Sensor with 
the latest security Rules, you had to manually upgrade both your Console and your 
Sensor.

However, starting with Console Management Server version 4.1, the Sensor ManagerSensor ManagerSensor ManagerSensor Manager 
page allows you to perform an ASAP Update of security Rules in your host- or network-
based Sensors, as long as:

•  the Console Management Server Console Management Server Console Management Server Console Management Server is at least version 4.1version 4.1version 4.1version 4.1

•  the SensorSensorSensorSensor is at least version 3.9version 3.9version 3.9version 3.9

Note:Note:Note:Note: For more information on DbProtect component versioning, see the 
DbProtect Version Compatibility Matrix, and Determining the Current 
Version of Installed DbProtect Applications in the DbProtect Installation 
Guide or the DbProtect Administrator’s Guide.

•  the SensorSensorSensorSensor is registeredregisteredregisteredregistered (for more information, see Registering a Sensor)

•  the Sensor does notnotnotnot already contain the latest available security Rules from the 
Application Security, Inc.    security Rules knowledgebaseknowledgebaseknowledgebaseknowledgebase.

After you ASAP Update your Sensor with the latest available security Rules, you can 
use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to update Policies (deployed to your Sensors) with the new 
security Rules; for more information, see Policies.

Delete (X) button
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To perform an ASAP Update of your ASAP Updateable Sensors with the latest 
available security Rules:

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager
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2. Click the ASAP UpdateASAP UpdateASAP UpdateASAP Update button to display the security Rule ASAP Update 
page of the Sensor ManagerSensor ManagerSensor ManagerSensor Manager.

FIGURE: Sensor Manager Sensor Manager Sensor Manager Sensor Manager (security Rule ASAP Update page)

The summary portionsummary portionsummary portionsummary portion of the page displays information about your registered Sensors. 
Specifically, this portion of the page lists the number of:

•  Total Registered:Total Registered:Total Registered:Total Registered: Sensors -- both ASAP Updateable and non-ASAP Updateable; 
for more information, see Registering a Sensor

•  Online:Online:Online:Online: registered Sensors, including how many Sensors:

-are Up to Date:Up to Date:Up to Date:Up to Date: with the latest available security Rules

-are Updateable:Updateable:Updateable:Updateable: (i.e., you should ASAP Update these Sensors with the latest security 
Rules, following the steps described in this topic)

-Need software update: Need software update: Need software update: Need software update: (i.e., you need to upgrade your Sensor to at least version 3.9 in 
order to ASAP Update them; for more information on upgrading your Sensors, see the 
DbProtect Administrator’s Guide)

•  registered Sensors that are    currently Offline: Offline: Offline: Offline:

Summary portion

“Select all” checkbox Available rules version

Current rules version

Refresh link
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The lower portionlower portionlower portionlower portion of the Sensor Manager’s Sensor Manager’s Sensor Manager’s Sensor Manager’s security Rule ASAP Update page displays 
security Rule ASAP Update security Rule ASAP Update security Rule ASAP Update security Rule ASAP Update information about your registered Sensors. Specifically, 
this portion of the page consists of the following columns:

•  Sensor. Sensor. Sensor. Sensor. The name of each registered SensorSensorSensorSensor that is ASAP Updateable with the 
latest available security Rules. You should ASAP Update these Sensors with the 
latest security Rules, following the steps described in this topic.

Hint: You can check the Also display Sensors not eligible for content updatesAlso display Sensors not eligible for content updatesAlso display Sensors not eligible for content updatesAlso display Sensors not eligible for content updates 
checkbox if you want to display Sensors that are non-ASAP Updateable, 
because: a.) they already contain up-to-date security Rules, or b.) they are 
too old (pre-version 3.9). Non-ASAP Updateable Sensors display in italics, 
are grayed-out, and do notnotnotnot contain checkboxes (i.e., you cannot select 
these Sensors for an ASAP Update).

•  Platform Type. Platform Type. Platform Type. Platform Type. The operating system platform platform platform platform the Sensor (that is ASAP 
Updateable with the latest available security Rules) is installed on (e.g., Win32Win32Win32Win32).

•  Version. Version. Version. Version. The version version version version of the registered Sensor that is ASAP Updateable with the 
latest available security Rules; for more information on DbProtect component 
versions, see DbProtect Version Compatibility Matrix, and Determining the 
Current Version of Installed DbProtect Applications in the DbProtect 
Administrator’s Guide or the DbProtect Installation Guide.

Note:Note:Note:Note: Again, Sensors older than version 3.9 do notnotnotnot allow you to perform an ASAP 
Update of the latest available security Rules. Application Security Inc. 
recommends you upgrade your Sensors to at least version 3.9 in order to 
take advantage of this important functionality. For more information on 
upgrading your Sensors, see the DbProtect Administrator’s Guide.

•  Knowledgebase VersionKnowledgebase VersionKnowledgebase VersionKnowledgebase Version. The version of Application Security, Inc.’s    security 
Rules knowledgebaseknowledgebaseknowledgebaseknowledgebase used by the registered Sensor. You should compare this 
version number to the Available rules versionAvailable rules versionAvailable rules versionAvailable rules version number (in the lower-right portion 
of the page) to determine whether your Sensor (assuming it’s version 3.9 or 
greater) can and should be ASAP Updated with the latest available security 
Rules.

Note:Note:Note:Note: If the Knowledgebase Version Knowledgebase Version Knowledgebase Version Knowledgebase Version column displays a dash (----), this means the 
corresponding registered Sensor contains security Rules that are so 
outdated they aren’t even versioned. In this case, Application Security, Inc. 
stronglystronglystronglystrongly recommends you ASAP Update the Sensor (assuming it’s ASAP 
Updateable, i.e., your registered Sensor is at least version 3.9).

•  Status. Status. Status. Status. The real-time ASAP Update statusstatusstatusstatus of your registered Sensor (that is 
ASAP Updateable with the latest available security Rules).

•  Refresh. Refresh. Refresh. Refresh. The current state of the Sensor, e.g., OnlineOnlineOnlineOnline, OfflineOfflineOfflineOffline, etc. You can click 
the RefreshRefreshRefreshRefresh link to refresh the current state of the Sensor.

Note:Note:Note:Note: If a Sensor is up-to-date with the latest security Rules (i.e., if you check the 
Also display Sensors not eligible for content updatesAlso display Sensors not eligible for content updatesAlso display Sensors not eligible for content updatesAlso display Sensors not eligible for content updates checkbox), then the 
RefreshRefreshRefreshRefresh column reads: latest known rules version.

•  Knowledgebase VersionKnowledgebase VersionKnowledgebase VersionKnowledgebase Version. The version of Application Security, Inc.’s    security 
Rules knowledgebaseknowledgebaseknowledgebaseknowledgebase containing security Rules.
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3. Check one or more Sensors that contain ASAP Updateable security Rules.

Hint: You can check the “select all” checkbox in the upper-left corner of the 
lower portion of the page to select all Sensors that are ASAP Updateable 
with the latest available security Rules.

4. Click the Update RulesUpdate RulesUpdate RulesUpdate Rules button. DbProtect Audit and Threat Management 
updates all ASAP Updateable Sensors (selected in Step 3) with the latest 
available security Rules. The StatusStatusStatusStatus column provides a real-time ASAP 
Update status.

Note:Note:Note:Note: You can click the CancelCancelCancelCancel button to cancel the ASAP Update of a Sensor. If 
the StatusStatusStatusStatus column indicates an ASAP Update is PendingPendingPendingPending, the ASAP Update 
is cancelled completely. However, if the StatusStatusStatusStatus column indicates an ASAP 
Update is In ProgressIn ProgressIn ProgressIn Progress, DbProtect completes its update of the Sensor that is 
being ASAP Updated, and then cancels the ASAP Update of all queued 
Sensors.

Hint: If you ASAP Update some -- but not all -- of your ASAP Updateable 

Sensors with the latest available security Rules, you must click the Reset 

button before you select and ASAP Update additional Sensors.

Important: Once you have ASAP Updated a Sensor with the latest available security 
Rules, you may have to re-configure your Sensor, and re-deploy the 
configuration information to the Sensor, in order for the new security Rules 
to take effect on the database instances you are monitoring; for more 
information, see Configuring a Sensor and deploying the configuration 
information.

5. Click the Manage SensorsManage SensorsManage SensorsManage Sensors button to return to the main Sensor ManagerSensor ManagerSensor ManagerSensor Manager 
page any time (in other words, you do not have to wait until the ASAP 
Update of your security Rules is completed). However, your ASAP 
Updateable Sensor(s) maymaymaymay appear offline until the ASAP Update is 
completed.
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Monitoring the
“health” of your
Sensors (via the

Sensor Manager)

You can monitor the “health” of your registered Sensors via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager and 
the DashboardDashboardDashboardDashboard. If you’re not receiving Alerts, it couldcouldcouldcould be because your registered 
Sensor is “unhealthy”. A “healthy” Sensor is:

•  “up and running” “up and running” “up and running” “up and running” on the database SID or instance where it is registered

•  activelyactivelyactivelyactively collecting/interpreting data and firing Alertscollecting/interpreting data and firing Alertscollecting/interpreting data and firing Alertscollecting/interpreting data and firing Alerts to DbProtect Audit and 
Threat Management in accordance with its deployed Policies.

Hint: If you have trouble establishing a connection between the Console and a 
Sensor installed on Microsoft Windows 2008 (i.e., a host-based Sensor for 
Oracle on Windows, a host-based Sensor for DB2 on Windows, a host-
based Sensor for Microsoft SQL Server on Windows, or any network-based 
Sensor), make sure IPV6 support is notnotnotnot enabled on the network adapter, 
and that your Microsoft Windows Firewall is disabled.

For more information, see the DbProtect Administrator’s Guide.

To monitor the “health” of your Sensors via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager: 

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor Sensors - Manage Sensor workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

If the color-coded icon next to your registered Sensor is:

•  greengreengreengreen, then the Sensor is “healthy”

•  redredredred, then the Sensor is “unhealthy”; for more information, see the Monitoring 
the Health of Your Sensors of the DbProtect Administrator’s Guide.

Hint: Click the Refresh Status button to view the most current state of your 

Sensors’ “health”.
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Unregistering a
Sensor

When you unregister a Sensorunregister a Sensorunregister a Sensorunregister a Sensor, the Sensor stops sending messages and Alerts. 
Unregistration returns the Sensor to its original, unconfigured installation state -- but it 
is not removed. (For more information on removing Sensors, see Manually removing a 
Sensor.)

Important: For information on installing and uninstalling Sensors, including Sensors in 
a SQL Server cluster, see the DbProtect Installation Guide.

Note:Note:Note:Note: An unregistered Sensor continues to log events to a notification file 
(appradar_app.txt located in the Sensor’s log directory), but onlyonlyonlyonly 
whether the Sensor is “up” or “down”.

To unregister a Sensor: 

1. Do one of the following to display the first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page:

•  Click the Manage SensorsManage SensorsManage SensorsManage Sensors workflow link on the HomeHomeHomeHome page.

•  Click the SensorsSensorsSensorsSensors tab from anywhere on the page.

The first Sensor ManagerSensor ManagerSensor ManagerSensor Manager page displays your registered Sensors.

FFFFIIIIGGGGUUUURRRREEEE: : : : Sensor ManagerSensor ManagerSensor ManagerSensor Manager

2. Highlight a registered Sensor, and click the UnregisterUnregisterUnregisterUnregister button.

A page displays, prompting you to confirm the unregistration.

FIGURE: Unregistration confirmation

3. Click the YesYesYesYes button.

DbProtect    Audit and Threat Management unregisters your Sensor.
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If unregistration is unsuccessful, DbProtect Audit and Threat Management prompts 
you to let it attempt a forced unregistration. If the forced unregistration of the Sensor 
fails, you may have to remove the Sensor manually; for more information, see Manually 
removing a Sensor.

Manually removing
a Sensor

You can manually remove a Sensor in the rare event a Sensor does not respond to an 
unregistration request; for more information, see Unregistering a Sensor.

Important: For information on installing and uninstalling Sensors, including Sensors in 
a SQL Server cluster, see the DbProtect Installation Guide.

To manually remove a Sensor:

1. Run the force_unregister.bat for Windows-based Sensors, or 
force_unregister on Sensors on Unix and Linux platforms, on the Sensor's 
host computer. 

Default locations:

•  for Windows-based Sensors, force_unregister.bat is located by default in 
<Sensor Install Directory>\AppSecInc\Sensor\utils

•  for Unix- and Linux-based Sensors, force_unregister is located by default in 
<Sensor Install Directory>/ASIappradar/sensor/util

Your Sensor is unregistered.

Note:Note:Note:Note: You can register the Sensor again, if necessary; for more information, see 
Registering a Sensor.
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Alerts
This chapter consists of the following topics:

•  What is an Alert?

•  Monitoring Alerts via the DbProtect Audit and Threat Management UI

•  Monitoring Alerts as SNMP traps, the log file, or Syslog

•  Acknowledging and archiving Alerts

•  "Password Guessing" and "Password Scripted Attack" Alerts

•  Alert aggregation

•  If you get two Alerts with the same title

•  Warning about missing “Application Name” in Alerts from host-based Sensor 
for Oracle 9i on *nix platforms

•  Limitations in Alerts generated by host-based Sensors for Oracle on Windows

•  Limitations in Alerts generated by host-based Sensors for Oracle on any *nix 
platform

•  Limitations in Alerts generated by host-based Sensors for DB2 on any 
supported platform

•  Understanding the Alert Manager

•  Monitoring, filtering, acknowledging, and archiving Alerts (via the Alert 
Manager).

What is an Alert? A securitysecuritysecuritysecurity AlertAlertAlertAlert is a notification of a monitored security event on the database host or 
network. DbProtect Audit and Threat Management fires an Alert when the criterion for 
security Rule in the associated Policy is met (unless an Exception or Filter prevents the 
Alert from firing). The level of a security Alert is either HighHighHighHigh, MediumMediumMediumMedium, or LowLowLowLow. For more 
information, see Policies.

An Informational AlertInformational AlertInformational AlertInformational Alert (also known as an audit) is a record of standard database 
activity. The level of an Informational Alert can be Info-1Info-1Info-1Info-1, Info-2 Info-2 Info-2 Info-2, Info-3 Info-3 Info-3 Info-3, or Info-4 Info-4 Info-4 Info-4.

Caution! The Alert Manager only displays security Alerts. It does not 

display Informational Alerts.

Note:Note:Note:Note: DbProtect audit and threat management may have limitations based on 
the type of Sensor, the nature of the activity, the target database, and the 
operating system. For more information, see DbProtect audit and threat 
management limitations (based on Sensor type, activity, target database, 
and operating system).
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Important: Prior to the release of Console Management Server version 4.1 and Sensor 
version 3.9 (both released as part of DbProtect 2009.1R4), if you wanted to 
update the security Rules in a Sensor, you had to manually upgrade both 
your Console and your Sensor.

However, starting with Console Management Server version 4.1, the 
Sensor ManagerSensor ManagerSensor ManagerSensor Manager page allows you to perform an ASAP Update of security 
Rules in your host- or network-based Sensors, as long as the Console 
Management Server is at least version 4.1, the Sensor is at least version 
3.9, and the Sensor is registered (for more information, see Registering a 
Sensor).

After you ASAP Update your Sensor with the latest security Rules, you can 
use the Policy EditorPolicy EditorPolicy EditorPolicy Editor to update Policies (deployed to your Sensors) with 
these new security Rules; for more information, see Policies.

Monitoring Alerts
via the DbProtect
Audit and Threat
Management UI

The DbProtect Audit and Threat Management UI provides the following two ways to 
monitor your real-time Alerts:

•  Dashboard.Dashboard.Dashboard.Dashboard. Provides a graphical quantitative summary of Alerts. Designed for 
operations personnel, you can quickly and easily identify issues using visual 
cues. The DashboardDashboardDashboardDashboard automatically refreshes itself every 30 seconds to update 
the display of new, real-time Alerts. This value is customizable. For more 
information, see Monitoring Alerts (via the Dashboard).

•  Alert Manager.Alert Manager.Alert Manager.Alert Manager. Displays real-time Alerts, color-coded for easy identification of 
risk level. Sorting, grouping, and criteria matching features allow you to Filter 
views of incoming Alerts. For more information, see Monitoring, filtering, 
acknowledging, and archiving Alerts (via the Alert Manager).

In addition, the Report ManagerReport ManagerReport ManagerReport Manager allows you to create DetailDetailDetailDetail and SummarySummarySummarySummary Reports for 
Alerts received by DbProtect Audit and Threat Management, and can be generated 
and filtered by search criteria. Reports provide information about the Alerts produced 
in your enterprise, as well as the details that make up those Alerts. For more 
information, see Reports.

Monitoring Alerts
as SNMP traps, the
log file, or Syslog

Optionally, you can also send Alerts to:

•  SNMP Trap Receiver.SNMP Trap Receiver.SNMP Trap Receiver.SNMP Trap Receiver. Sensors can fire Alerts as SNMP traps.

•  Log File. Log File. Log File. Log File. Sensors can write Alerts to a log file.

•  Syslog. Syslog. Syslog. Syslog. Sensors can write Alerts as Syslog messages. Syslog messages sent out 
by the Sensors are in ArcSight CEFArcSight CEFArcSight CEFArcSight CEF, a standard format for logging security alert 
messages. These messages can be sent remotelyremotelyremotelyremotely over the UDP network 
protocol or locallylocallylocallylocally to a Syslog daemon on the same machine as the Sensor. For 
more information, see the DbProtect Administrator’s Guide.
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All three methods are specified during Sensor configuration; for more information, see 
Configuring a Sensor and deploying the configuration information.

Acknowledging
and archiving

Alerts

You can acknowledge and archive Alerts via the Alert ManagerAlert ManagerAlert ManagerAlert Manager to ensure proper 
operational handling of security and audit events. For more information, see 
Monitoring, filtering, acknowledging, and archiving Alerts (via the Alert Manager).

Note:Note:Note:Note: If you want to back up your Alerts and physically remove them from the 
DbProtect Audit and Threat Management system, see the DbProtect 
Administrator’s Guide.

"Password
Guessing" and

"Password
Scripted Attack"

Alerts

The generation of “Password Guessing” and “Password Scripted Attack” Alerts occur 
on a “per minute” basis. Within any given one minute time interval, there must be at 
least:

•  10 failed logins to trigger a “Password Guessing” Alert

•  100 failed logins to trigger a “Password Scripted Attack” Alert.

The Alert ManagerAlert ManagerAlert ManagerAlert Manager will not display more than one yellow (medium)yellow (medium)yellow (medium)yellow (medium) and one red (high)red (high)red (high)red (high) 
Alert per minute for “Password Guessing” and “Password Scripted Attack” Alerts.

Alert aggregation DbProtect Audit and Threat Management aggregates every:

•  10 blue (low)  blue (low)  blue (low)  blue (low) Alerts as one yellow (medium) yellow (medium) yellow (medium) yellow (medium) Alert

•  100 blue (low) blue (low) blue (low) blue (low) Alerts as one red (high)red (high)red (high)red (high) Alert.

Note:Note:Note:Note: Application Security, Inc. implemented this feature because the 
generation of hundreds of blue (low) Alerts per minute triggered a massive 
generation of yellow and red Alerts.

If you get two
Alerts with the

same title

If you are monitoring an Oracle database and you get two Alerts with same Rule Title -
- one with all correct information, the one missing information (e.g., login/username, 
network user, client application name), you should disable the sql_trace parameter. 
You can do so by doing one of the following:

•  log on to Oracle as sys and run "alter system set sql_trace=false 
scope=both

•  update the init file.
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Warning about
missing

“Application
Name” in Alerts
from host-based

Sensor for Oracle
9i on *nix
platforms

If you have a host-based Sensor installed to monitor an Oracle 9i database on any *nix 
platform (i.e., Solaris, AIX, HP-UX, and Red Hat Enterprise Linux), the "Application 
Name" will notnotnotnot display in your Alerts. This is because Oracle 9 does not provide a 
mechanism for the DDL trigger to retrieve the "Application Name" (or "module").

However, this functionality is available in Oracle 10g and greater. Subsequently, DDL 
Alerts in these Oracle releases now display the "Application Name".

Limitations in
Alerts generated

by host-based
Sensors for Oracle

on Windows

If you have a host-based Sensor installed to monitor an Oracle database on Windows:

•  Database login names are always reported in Alerts as /, while logins are 
reported as: as sysdba.

•  The Rule “Login attempt – successful” only works (i.e., only fires an Alert) with 
local connections.

For more information, see Configuring a host-based Sensor to monitor Oracle SIDs 
and services and deploying the configuration information (when Sensor is installed on 
Windows).

Limitations in
Alerts generated

by host-based
Sensors for Oracle

on any *nix
platform

If you have a host-based Sensor installed to monitor an Oracle 9i or 10g database on 
any *nix platform (i.e., Solaris, AIX, HP-UX, and Red Hat Enterprise Linux), all DDL 
statements reported via the DDL trigger have significant restrictionssignificant restrictionssignificant restrictionssignificant restrictions with respect to 
the amount of SQL text the trigger can retrieve. In nearly all cases these restrictions are 
limited to:

•  the DDL command (i.e., DROP, CREATE, etc.)

•  the DDL object type (TABLE, VIEW, INDEX, etc.)

•  the object name itself.

This restriction applies to all DDL statements in Oracle 9i on the Red Hat Enterprise 
Linux platform and for the CREATE, DROP, ASSOCIATE and DISASSOCIATE STATISTICS 
commands for the other *nix platforms, as well as all platforms running Oracle 10g.

Limitations in
Alerts generated

by host-based
Sensors for DB2 on

any supported
platform

If you have a host-based Sensor installed to monitor a DB2 on any supported platform 
(i.e., Red Hat Enterprise Linux, Solaris, AIX, and Microsoft Windows), DB2 will truncate 
SQL text in Alerts if the SQL text is longer than the size of the pipe used by DB2's 
event monitor. This limitation is typically 4KB, but may be larger depending on the 
specific DB2 implementation.
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Understanding the
Alert Manager

The Alert ManagerAlert ManagerAlert ManagerAlert Manager is shown below (partial).

FFFFIIIIGGGGUUUURRRREEEE: : : : Alert ManagerAlert ManagerAlert ManagerAlert Manager

The Alert ManagerAlert ManagerAlert ManagerAlert Manager allows you to monitor your security Alerts, i.e., notifications of 
monitored security events on the database host or network.

Note:Note:Note:Note: The Alert ManagerAlert ManagerAlert ManagerAlert Manager only displays security Alerts. It does notnotnotnot display 
Informational Alerts.

Specifically, the Alert ManagerAlert ManagerAlert ManagerAlert Manager allows you to use the:

•  Alerts/Archive tabs Alerts/Archive tabs Alerts/Archive tabs Alerts/Archive tabs portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager to display the Archived AlertsArchived AlertsArchived AlertsArchived Alerts 
page and view or delete your archived Alerts

•  Alert display toolsAlert display toolsAlert display toolsAlert display tools portion of the Alert Manager Alert Manager Alert Manager Alert Manager to view/sort Alerts, filter Alerts, 
edit the Alert notification rate, and edit the number of Alerts that display on the 
Alert ManagerAlert ManagerAlert ManagerAlert Manager

•  Acknowledge/Archive buttons Acknowledge/Archive buttons Acknowledge/Archive buttons Acknowledge/Archive buttons portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager to acknowledge 
and archive your Alerts

•  AlertsAlertsAlertsAlerts portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager to view your Alert detail.

For more information, see Monitoring, filtering, acknowledging, and archiving Alerts 
(via the Alert Manager).

Monitoring,
filtering,

acknowledging,
and archiving
Alerts (via the

Alert Manager)

DbProtect Audit and Threat Management receives Alerts from your registered 
Sensors. The Alert ManagerAlert ManagerAlert ManagerAlert Manager allows you to monitor your real-time Alerts. You can view, 
sort, Filter, acknowledge, archive, and delete them on this page.

The Alert ManagerAlert ManagerAlert ManagerAlert Manager also allows you to change the Alert notification rate (default rate = 
10 seconds), and the number of Alerts that display on the page (default number = 10 
Alerts). The auto refresh feature is notnotnotnot turned on by default. To turn on the auto refresh 
feature, you must click the StartStartStartStart button. For more information, see Step 6, below.
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Caution! When you have not used DbProtect Audit and Threat 

Management for a while, your Session normally times out. 

However, on certain pages, it does not. Specifically, Audit and 

Threat Management does not time out on the Alert Manager, 

the Dashboard, and the ASAP Update portion of the Sensor 

Manager.

To monitor Alerts (via the Alert ManagerAlert ManagerAlert ManagerAlert Manager): 

1. Do one of the following to display the Alert ManagerAlert ManagerAlert ManagerAlert Manager:

•  Click the Alerts - Security Monitoring Alerts - Security Monitoring Alerts - Security Monitoring Alerts - Security Monitoring workflow link on the HomeHomeHomeHome page.

•  Click the AlertsAlertsAlertsAlerts tab from anywhere on the page.

The AlertsAlertsAlertsAlerts section displays by default. You can click the ArchiveArchiveArchiveArchive tab at the top of the 
page to display the Archive portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Alert ManagerAlert ManagerAlert ManagerAlert Manager

2. Your Alert ManagerAlert ManagerAlert ManagerAlert Manager options follow. If you want to:

•  view or delete your archived Alerts, go to Step 3

•  view or sort your Alerts, go to Step 4

•  filter your Alerts, go to Step 5

•  edit the Alert notification rate, go to Step 6

•  acknowledge and archive your Alerts, go to Step 7

•  view Alert detail, go to Step 8.
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3. View or delete your archived Alerts.

You can click the ArchiveArchiveArchiveArchive tab (in the Alerts/Archive tabs Alerts/Archive tabs Alerts/Archive tabs Alerts/Archive tabs portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager) 
to display the Archived AlertsArchived AlertsArchived AlertsArchived Alerts page and view your archived Alerts.

FIGURE: Alert ManagerAlert ManagerAlert ManagerAlert Manager (Archived AlertsArchived AlertsArchived AlertsArchived Alerts page)

You can delete:

•  selectedselectedselectedselected archived Alerts by checking one or more archived Alerts, then clicking 
the Delete Selected Archived Alerts Delete Selected Archived Alerts Delete Selected Archived Alerts Delete Selected Archived Alerts button

•  allallallall archived Alerts by clicking the Delete All Archived AlertsDelete All Archived AlertsDelete All Archived AlertsDelete All Archived Alerts button.

4. View your Alerts.View your Alerts.View your Alerts.View your Alerts.

The AlertsAlertsAlertsAlerts portion of the Alert Manager Alert Manager Alert Manager Alert Manager page displays your real-time Alerts, color-
coded by risk level, i.e., HighHighHighHigh (red), MediumMediumMediumMedium (yellow), LowLowLowLow (blue), and AcknowledgedAcknowledgedAcknowledgedAcknowledged 
(gray).

Important: To view the Alert detail, click any Alert IDAlert IDAlert IDAlert ID to display an Alert detail pop up, 
then go to Step 9.

FIGURE: Alert ManagerAlert ManagerAlert ManagerAlert Manager (AlertsAlertsAlertsAlerts portion)

Note:Note:Note:Note: Risk levels are derived from built-in Rules. These Rules define the Policy 
deployed to an instance monitored by a Sensor, and determine when 
Alerts are fired. For more information, see What is a Policy? and What do 
the risk levels mean?
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Caution! If you get two Alerts with the same rule title -- one containing 

correct information, and another one containing missing 

information (e.g., missing login/username, network user, and 

client application name), you may need to disable sql_trace. For 

more information, see If you get two Alerts with the same 

title.

Sort your Alerts.Sort your Alerts.Sort your Alerts.Sort your Alerts.

You can sort your Alerts by clicking any of the following column links (on the header 
row of the AlertAlertAlertAlert portion of the page):

•  Alert IDAlert IDAlert IDAlert ID (default)

•  Instance NameInstance NameInstance NameInstance Name

•  Rule TitleRule TitleRule TitleRule Title

•  TimeTimeTimeTime

•  Login/User NameLogin/User NameLogin/User NameLogin/User Name

•  Network UserNetwork UserNetwork UserNetwork User

•  Source of AttackSource of AttackSource of AttackSource of Attack

•  Client Application NameClient Application NameClient Application NameClient Application Name.

For example, if you want to sort your Alerts from latest-to-oldest, click the TimeTimeTimeTime 
column link. Also note, you can sort your Alerts in ascending or descending order.

5. Filter your Alerts.Filter your Alerts.Filter your Alerts.Filter your Alerts.

When you have a lot of Alerts, sometimes it's difficult and time-consuming to see the 
most important ones. The Alert display tools Alert display tools Alert display tools Alert display tools allow you to filter your Alerts.

FIGURE: Alert ManagerAlert ManagerAlert ManagerAlert Manager (Alert display tools)

You can filter your Alerts by:

•  Filter drop-downs. Filter drop-downs. Filter drop-downs. Filter drop-downs. The Alert filter drop-downs are: 

----InstanceInstanceInstanceInstance

----Rule TitleRule TitleRule TitleRule Title

----Login/User NameLogin/User NameLogin/User NameLogin/User Name

----Network UserNetwork UserNetwork UserNetwork User

----Source of AttackSource of AttackSource of AttackSource of Attack

----ApplicationApplicationApplicationApplication

-Risk LevelRisk LevelRisk LevelRisk Level.

Use these drop-downs to filter your Alert data, then click the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button to 
display Alerts that match your filter criteria.
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•  Filtering SQL text.Filtering SQL text.Filtering SQL text.Filtering SQL text. Enter valid SQL text in the Search in SQL textSearch in SQL textSearch in SQL textSearch in SQL text field, then click 
the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button (only for filtering host-based SQL Server Alerts). 

For example, if you want to Filter Alerts with the SQL text Select, enter Select 
in the Search in SQL TextSearch in SQL TextSearch in SQL TextSearch in SQL Text field, then click the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button to display all 
Alerts with the SQL text Select.

•  Acknowledged Alerts only. Acknowledged Alerts only. Acknowledged Alerts only. Acknowledged Alerts only. Uncheck the Hide AcknowledgedHide AcknowledgedHide AcknowledgedHide Acknowledged checkbox 
(checked by default), then click the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button to display 
acknowledged Alerts in addition to unacknowledged Alerts.

•  Specify an Alert count. Specify an Alert count. Specify an Alert count. Specify an Alert count. You can enter the exact number of Alerts that you want 
to display in the CountCountCountCount field, then click the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button to display the 
specified number (prioritized by most-recent Alerts). For example, if you enter 
50 in the CountCountCountCount field, then click the Apply CriteriaApply CriteriaApply CriteriaApply Criteria button, the Alert ManagerAlert ManagerAlert ManagerAlert Manager 
displays your most-recent 50 Alerts received (depending on your filtering 
configuration).

6. Edit your Alert notification rate.Edit your Alert notification rate.Edit your Alert notification rate.Edit your Alert notification rate.

The Alert display tools allow you to monitor your real-time Alerts more (or less) 
frequently than every 10 seconds (i.e., the default Alert notification rate).

FIGURE: Alert ManagerAlert ManagerAlert ManagerAlert Manager (Alert display tools)

To edit the Alert notification rate, and activate the auto-refresh feature, enter the 
number of seconds in the sec(s) sec(s) sec(s) sec(s) field, then click the StartStartStartStart button.

Note:Note:Note:Note: The auto refresh feature is not turned on by default. You must click the 
RefreshRefreshRefreshRefresh button. To turn on the auto refresh feature, click the StartStartStartStart button. 
You can customize the auto refresh rate in the text field next to the StartStartStartStart 
button.

7. Acknowledge/archive your Alerts.Acknowledge/archive your Alerts.Acknowledge/archive your Alerts.Acknowledge/archive your Alerts.

Note:Note:Note:Note: If you want to back up your Alerts and physically remove them from the 
DbProtect Audit and Threat Management system, see the DbProtect 
Administrator’s Guide.

The Alert ManagerAlert ManagerAlert ManagerAlert Manager acknowledge/archive buttons allow you to archive and 
acknowledge your Alerts.

When you:

•  acknowledgeacknowledgeacknowledgeacknowledge an Alert, you affirm that you have reviewed it

•  archivearchivearchivearchive an Alert, you hide it from displaying on the Alert Manager, but you do 
not delete it.
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Note:Note:Note:Note: If you archive an unacknowledged Alert, DbProtect Audit and Threat 
Management marks the archived Alert as "acknowledged" and "archived" 
in the DbProtect Audit and Threat Management database.

FIGURE: Alert ManagerAlert ManagerAlert ManagerAlert Manager (acknowledge/archive buttons)

You can:

•  acknowledge an individual Alert by checking the individual Alert    and clicking 
the Acknowledge Selected AlertsAcknowledge Selected AlertsAcknowledge Selected AlertsAcknowledge Selected Alerts button, or you can click the Alert ID to display 
the Alert detail pop up and click the AcknowledgeAcknowledgeAcknowledgeAcknowledge button

•  acknowledge allallallall Alerts by clicking the Acknowledge All Alerts Acknowledge All Alerts Acknowledge All Alerts Acknowledge All Alerts button

•  archive individual Alerts by checking the individual Alert and clicking the 
Archive Selected AlertsArchive Selected AlertsArchive Selected AlertsArchive Selected Alerts button, or you can click the Alert ID to display the Alert 
detail pop up and click the ArchiveArchiveArchiveArchive button

•  archive allallallall Alerts by clicking the Archive All AlertsArchive All AlertsArchive All AlertsArchive All Alerts button.

Note:Note:Note:Note: You can click the ArchiveArchiveArchiveArchive tab at the top of the page to display the ArchiveArchiveArchiveArchive 
section of the Alert Manager and display your archived Alerts; see Step 8.

The Alert detail pop up also allows you to acknowledge or archive the Alert; for more 
information, see Step 8.

8. View Alert detail.View Alert detail.View Alert detail.View Alert detail.

Click an Alert IDAlert IDAlert IDAlert ID in the AlertsAlertsAlertsAlerts portion of the Alert ManagerAlert ManagerAlert ManagerAlert Manager (see Step 4) to display an 
Alert detail pop up.

FIGURE: Alert detail pop up

The Alert detail pop up displays the following information about a given Alert:

•  Alert ID:Alert ID:Alert ID:Alert ID:

•  Database Type:Database Type:Database Type:Database Type:

•  Instance Alias:Instance Alias:Instance Alias:Instance Alias:

•  Context:Context:Context:Context:

•  Rule Title:Rule Title:Rule Title:Rule Title:
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•  Time:Time:Time:Time:

•  Login/User Name:Login/User Name:Login/User Name:Login/User Name:

•  Network User:Network User:Network User:Network User:

•  Source of Event:Source of Event:Source of Event:Source of Event:

Note:Note:Note:Note: When host-based Sensors for DB2 (all supported platforms) fire a failed 
login Alert, the Source of Event:Source of Event:Source of Event:Source of Event: field is blank. When host- and network-
based Sensors for Oracle (all supported platforms) fire a failed or 
successful login Alert, the Source of Event:  Source of Event:  Source of Event:  Source of Event: field is blank.

•  SQL Text:SQL Text:SQL Text:SQL Text:

•  Records Affected:Records Affected:Records Affected:Records Affected:

Note:Note:Note:Note: The Records Affected:Records Affected:Records Affected:Records Affected: row is a result setresult setresult setresult set, which refers to the number of 
records returned as the result of executing a SQL statement; for more 
information, see Understanding result sets. When DbProtect Audit and 
Threat Management stores identical SQL statements, and their Risk Level:Risk Level:Risk Level:Risk Level: 
is Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, or Info-3Info-3Info-3Info-3, then DbProtect Audit and Threat Management 
aggregates the Records AffectedRecords AffectedRecords AffectedRecords Affected.

Important: Alerts from host-based Sensor for Oracle on *nix platforms do notnotnotnot contain 
a value for the Records Affected:Records Affected:Records Affected:Records Affected: field.

•  Client Application Name:Client Application Name:Client Application Name:Client Application Name:

Note:Note:Note:Note: When host- and network-based Sensors for Oracle (all supported 
platforms) fire a failed or successful login Alert, the Client Application  Client Application  Client Application  Client Application 
Name: Name: Name: Name: field is blank.

•  Risk Level:Risk Level:Risk Level:Risk Level:

•  CVE Reference #:CVE Reference #:CVE Reference #:CVE Reference #:

•  DescriptionDescriptionDescriptionDescription.

The Alert detail pop up allows you to click the AcknowledgeAcknowledgeAcknowledgeAcknowledge and ArchiveArchiveArchiveArchive buttons to 
acknowledge or archive the Alert, respectively; for more information, see Step 7.
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Policies
This chapter consists of the following topics:

•  What is a Policy?

•  ASAP Updating Rules in your Sensors

•  Understanding the Policy Manager

•  What do the risk levels mean?

•  What are the default Policies?

•  Creating a Policy

•  Editing a Policy

•  Importing a Policy

•  Exporting a Policy

•  Deploying a Policy

•  Deleting a Policy

•  Policy Editor rule categories.

What is a Policy? A PolicyPolicyPolicyPolicy is a set of security Rules which identifies the conditions under which Alerts are 
fired and sent to DbProtect Audit and Threat Management. Such activity may include 
intrusion attempts, or other malicious behavior. Policies can also monitor database 
activity of authorized users. Different Sensors, SIDs, or database instances may require 
different Policies, since intrusion risk and data sensitivity often vary between database 
installations.

Once you register a Sensor, you must then deploy the configuration of a database 
instance or SID to a host- or network-based Sensor. Subsequently, the Sensor fires 
Alerts when the conditions/criterion of a Policy’s Rules are met (except when Rules or 
conditions are filtered or excepted); for more information, see What is a Filter?

Note:Note:Note:Note: You can, optionally, deploy a Policy during database SID or instance 
configuration; Configuring a Sensor and deploying the configuration 
information. However, deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you 
to deploy Policies to multiplemultiplemultiplemultiple instances simultaneously, which may (or may 
not) be monitored by the same Sensor.
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You can:

•  create a new Policy using the Policy EditorPolicy EditorPolicy EditorPolicy Editor, applying security Rules available in 
the Policy EditorPolicy EditorPolicy EditorPolicy Editor; for more information, see Creating a Policy

•  edit built-in Policies using the Policy EditorPolicy EditorPolicy EditorPolicy Editor, then “save as” a new Policy (built-in 
Policies cannot be overwritten); for more information, see Editing a Policy

•  import or export a Policy file (in XML format); for more information, see 
Importing a Policy and Exporting a Policy, respectively

•  deploy a Policy to a Sensor with the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager; for more information, see 
Deploying a Policy

•  delete a Policy with the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager; for more information, see Deleting a 
Policy.

ASAP Updating
Rules in your

Sensors

Prior to the release of Console Management Server version 4.1 and Sensor version 3.9 
(both released as part of DbProtect 2009.1R4), if you wanted to update the security 
Rules in a Sensor, you had to manually upgrade both your Console and your Sensor.

However, starting with Console Management Server version 4.1, the Sensor Manager Sensor Manager Sensor Manager Sensor Manager 
page allows you to perform an ASAP Update of security Rules in your host- or network-
based Sensors, as long as:

•  the Console Management Server is at least version 4.1

•  the Sensor is at least version 3.9

•  the Sensor is registered (for more information, see Registering a Sensor)

•  the Sensor does notnotnotnot already contain the latest available security Rules from the 
Application Security, Inc.    security Rules knowledgebaseknowledgebaseknowledgebaseknowledgebase.

For detaileddetaileddetaileddetailed instructionsinstructionsinstructionsinstructions on ASAP Updating security Rules in your Sensors, see 
Performing an ASAP Update of Rules in your Sensors.

After you ASAP Update your Sensor with the latest security Rules, you can use the 
Policy EditorPolicy EditorPolicy EditorPolicy Editor to update Policies (deployed to your Sensors) with these new security 
Rules; for more information, see Creating a Policy and Editing a Policy.

What do the risk
levels mean?

Every Rule in an Policy is associated, by default, with a risk level. You can modify these 
risk levels in a custom Policy. The risk levels are:

•  High: Security AlertHigh: Security AlertHigh: Security AlertHigh: Security Alert

•  Medium: Security AlertMedium: Security AlertMedium: Security AlertMedium: Security Alert

•  Low: Security AlertLow: Security AlertLow: Security AlertLow: Security Alert

•  Info-1: Interval-based/Parameterless SQLInfo-1: Interval-based/Parameterless SQLInfo-1: Interval-based/Parameterless SQLInfo-1: Interval-based/Parameterless SQL

•  Info-2: Exact-time/Parameterless SQLInfo-2: Exact-time/Parameterless SQLInfo-2: Exact-time/Parameterless SQLInfo-2: Exact-time/Parameterless SQL

•  Info-3: Interval-based/Exact SQLInfo-3: Interval-based/Exact SQLInfo-3: Interval-based/Exact SQLInfo-3: Interval-based/Exact SQL

•  Info-4: Exact-time/Exact SQLInfo-4: Exact-time/Exact SQLInfo-4: Exact-time/Exact SQLInfo-4: Exact-time/Exact SQL.
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Understanding the
Policy Manager

The Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager is shown below (partial).

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager

The Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager allows you to:

•  create a Policy; for more information, see Creating a Policy

•  edit a Policy; for more information, see Editing a Policy

•  import a Policy; for more information, see Importing a Policy

•  export a Policy; for more information, see Exporting a Policy

•  deploy a Policy; for more information, see Deploying a Policy

•  delete a Policy; for more information, see Deleting a Policy.
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What are the
default Policies?

DbProtect Audit and Threat Management is configured with default Policesdefault Policesdefault Policesdefault Polices. The rules 
contained in these Polices are database-platform-specific. The default Policies are:

•  Accessing OS Resources (Built-in). Accessing OS Resources (Built-in). Accessing OS Resources (Built-in). Accessing OS Resources (Built-in). This default Policy selects Rules that monitor 
for attempts to access OS-level resources.

•  Attacks Level 1 (Built-in), Attacks Level 2 (Built-in)Attacks Level 1 (Built-in), Attacks Level 2 (Built-in)Attacks Level 1 (Built-in), Attacks Level 2 (Built-in)Attacks Level 1 (Built-in), Attacks Level 2 (Built-in),    and Attacks Level 3 (Built-in). Attacks Level 3 (Built-in). Attacks Level 3 (Built-in). Attacks Level 3 (Built-in). 
These default Policies were developed by Application Security, Inc. security 
researchers to detect attempts to attack your database. Level 1 attacks are the 
least stringent; Level 3 attacks are the most stringent.

•  Auditing Level 1 (Built-in)Auditing Level 1 (Built-in)Auditing Level 1 (Built-in)Auditing Level 1 (Built-in), Auditing Level 2 (Built-in)Auditing Level 2 (Built-in)Auditing Level 2 (Built-in)Auditing Level 2 (Built-in), Auditing Level 3 (Built-in), Auditing Level 3 (Built-in), Auditing Level 3 (Built-in), Auditing Level 3 (Built-in), 
and Auditing Level 4 (Built-in). Auditing Level 4 (Built-in). Auditing Level 4 (Built-in). Auditing Level 4 (Built-in). These default Policies were developed by 
Application Security, Inc. researchers to audit activity on your database. Level 1 
audits are the least comprehensive; Level 4 audits are the most comprehensive.

•  Buffer Overflows (Built-in). Buffer Overflows (Built-in). Buffer Overflows (Built-in). Buffer Overflows (Built-in). This default Policy selects all Rules related to buffer 
overflow attempts.

•  FISMA Policy (Built-In)FISMA Policy (Built-In)FISMA Policy (Built-In)FISMA Policy (Built-In), HIPAA Policy (Built-In) HIPAA Policy (Built-In) HIPAA Policy (Built-In) HIPAA Policy (Built-In), Payment Card Industry Data  Payment Card Industry Data  Payment Card Industry Data  Payment Card Industry Data 
Security Standard (Built-In), Security Standard (Built-In), Security Standard (Built-In), Security Standard (Built-In), and Sarbanes-Oxley Policy (Built-In). Sarbanes-Oxley Policy (Built-In). Sarbanes-Oxley Policy (Built-In). Sarbanes-Oxley Policy (Built-In). All of our built-
in Policies were a result of a joint effort between Application Security, Inc.'s R&D 
Team SHATTER and DbProtect Audit and Threat Management users all over 
the world across all industries. All of the following built-in Policies were created 
in response to facilitate the database auditing and threat monitoring 
requirements of users within each respective vertical:

-FISMA Policy (Built-in). FISMA Policy (Built-in). FISMA Policy (Built-in). FISMA Policy (Built-in). The Federal Information Security Management Act (FISMA) 
provides a comprehensive framework for ensuring effective information security 
controls for all federal information and assets. This built-in Policy is enabled with all of 
the baseline rules and events to monitor all access to Federal databases.

-HIPAA Policy (Built-in). HIPAA Policy (Built-in). HIPAA Policy (Built-in). HIPAA Policy (Built-in). The Health Insurance Portability and Accountability Act 
(HIPAA) is designed to protect all forms of personal health information (PHI), by 
defending the patients' rights to have their health information kept private and 
preserving control of how their PHI data is used and when it is disclosed. This built-in 
Policy is enabled with all of the baseline rules and events to facilitate monitoring all 
access to PHI by unique ID.

-Payment Card Industry Data Security Standard (Built-in).Payment Card Industry Data Security Standard (Built-in).Payment Card Industry Data Security Standard (Built-in).Payment Card Industry Data Security Standard (Built-in). To unify disparate efforts, 
credit card companies created the Payment Card Industry (PCI) Data Security Standard. 
Spearheaded by Visa and MasterCard, PCI offers a common framework for protecting 
sensitive cardholder data for all card brands. This built-in Policy is enabled with all of 
the baseline rules and events to facilitate monitoring all access to cardholder data by 
unique ID.
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-Sarbanes-Oxley Policy (Built-in).Sarbanes-Oxley Policy (Built-in).Sarbanes-Oxley Policy (Built-in).Sarbanes-Oxley Policy (Built-in). The Sarbanes-Oxley Act (SOX) radically redesigned 
federal regulation of public company corporate governance and Reporting obligations 
by demanding executives, auditors, securities analysts, and legal counsel be 
accountable for the integrity of financial Reporting. This built-in Policy is enabled with 
all of the baseline rules and events to facilitate monitoring all access to SOX-relevant 
databases.

•  Password Attacks (Built-in). Password Attacks (Built-in). Password Attacks (Built-in). Password Attacks (Built-in). This default Policy selects all Rules that detect 
attempts to guess passwords by trying likely combinations of characters or 
exploiting certain vulnerabilities.

•  Privilege Escalation (Built-in). Privilege Escalation (Built-in). Privilege Escalation (Built-in). Privilege Escalation (Built-in). This default Policy selects all Rules that detect 
attempts to exploit known vulnerabilities to achieve privilege escalation, and in 
doing so perform tasks they are not authorized to perform.

•  Security Tools (Built-in). Security Tools (Built-in). Security Tools (Built-in). Security Tools (Built-in). This default Policy selects all Rules that check for tools 
that scan your database, in order to determine who is running these tools, 
when, and against which database.

•  Web Application Attacks (Built-in). Web Application Attacks (Built-in). Web Application Attacks (Built-in). Web Application Attacks (Built-in). This default Policy selects all Rules that 
monitor against possible access-related attacks.

•  Miscellaneous (Built-in).Miscellaneous (Built-in).Miscellaneous (Built-in).Miscellaneous (Built-in). This default Policy selects all Rules that detect attacks 
and events that do not necessarily fall within any of the other provided Activity 
DbProtect Monitoring and Auditing Rule categories.
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Creating a Policy To create a Policy: 

1. Do one of the following to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager
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2. Click the Create New PolicyCreate New PolicyCreate New PolicyCreate New Policy button to display the Policy EditorPolicy EditorPolicy EditorPolicy Editor page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy EditorPolicy EditorPolicy EditorPolicy Editor

3. Create your Policy.Create your Policy.Create your Policy.Create your Policy.

Click one or more database platforms that you want your custom Policy to monitor. 
Your choices are:

•  Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000

•  Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005

•  Microsoft SQL Server 2008Microsoft SQL Server 2008Microsoft SQL Server 2008Microsoft SQL Server 2008

•  Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database

•  Sybase ASE (Network)Sybase ASE (Network)Sybase ASE (Network)Sybase ASE (Network)

•  DB2 (Network)DB2 (Network)DB2 (Network)DB2 (Network).

FIGURE: Policy Editor Policy Editor Policy Editor Policy Editor (icons, checkboxes, drop-downs, and Rule links)
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You can:

•  click a ++++ icon next to a platform name to display the underlying default Rules (or 
click the ---- icon to collapse)

•  check a checkbox next to a platform name to select all built-in Rules that apply 
for this platform (or uncheck to de-select all)

•  click a ++++ icon next to a default Policy category to display the underlying Rules 
(or click the - - - - icon to collapse)

•  check a checkbox next to a default Policy category to select all underlying Rules 
for the Policy (or uncheck to de-select all)

•  check a checkbox next to:

-an individual Rule to activate the Rule in the Policy (or uncheck to deactivate)

-a Filter to add the Filter to the Policy (or uncheck to remove); for more information, 
see Filters

•  click an individual Rule/Filter link to display Rule/Filter details in the right frame 
of the Policy EditorPolicy EditorPolicy EditorPolicy Editor

•  use the individual Rule drop-downs to change the risk level of an individual Rule 
from its default setting. Your choices are: HighHighHighHigh, MediumMediumMediumMedium, LowLowLowLow, or InformationalInformationalInformationalInformational 
(i.e., Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, Info-3Info-3Info-3Info-3, and Info-4Info-4Info-4Info-4), which are typically for audit events. Audit 
events are written to a table in the DbProtect Audit and Threat Management 
database, but notnotnotnot displayed on the Alert Manager Alert Manager Alert Manager Alert Manager page of the DbProtect Audit 
and Threat Management UI. For more information, see What do the risk levels 
mean?

4. Enter your custom Policy name (e.g., High Security Policy) in the field next 
to the Save Save Save Save button.

Note:Note:Note:Note: Policy names mustmustmustmust be unique.

5. Click the Save Save Save Save button.

Important: If you have created any Filters/Exception for a specific platform, you must 
enable them separately. Turning on off the base Rules for a particular 
platform does notnotnotnot automatically also turn on all of the Filters/Exceptions 
that may currently exist for a database platform. For more information, see 
Filters.
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The Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page re-displays. Your custom Policy is listed.

FIGURE: Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager (with a custom Policy added)

Note:Note:Note:Note: A DeleteDeleteDeleteDelete button displays next to custom Policies. Unlike built-in Policies, 
you can delete a custom Policy; for more information, see Deleting a 
Policy.

6. You can now deploy your custom Policy to a Sensor; for more information, 
see Deploying a Policy.
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Editing a Policy The Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager allows you to edit a built-in or custom Policy. You cannotcannotcannotcannot save an 
edited built-in Policy under its original name, but you cancancancan use the “save as” option to 
save an edited built-in Policy under a different name.

To edit a Policy: 

1. Do one of the following to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager
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2. Click the EditEditEditEdit button next to the Policy you want to edit to display the 
Policy EditorPolicy EditorPolicy EditorPolicy Editor dialog box. 

Note:Note:Note:Note: If you are editing a built-in Policy and saving it under a different name, 
then only the Save AsSave AsSave AsSave As button and field display (the original name of the 
Policy displays above). However, if you are editing a custom Policy, then 
both the SaveSaveSaveSave and Save AsSave AsSave AsSave As buttons and fields display, allowing you to save 
the custom Policy under its original name or “save as” a new name, 
respectively.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy EditorPolicy EditorPolicy EditorPolicy Editor

3. Edit your Policy.Edit your Policy.Edit your Policy.Edit your Policy.

Click one or more database platforms that you want your custom Policy to monitor. 
Your choices are:

•  Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000

•  Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005

•  Microsoft SQL Server 2008Microsoft SQL Server 2008Microsoft SQL Server 2008Microsoft SQL Server 2008

•  Oracle DatabaseOracle DatabaseOracle DatabaseOracle Database

•  Sybase ASE (Network)Sybase ASE (Network)Sybase ASE (Network)Sybase ASE (Network)

•  DB2 (Network)DB2 (Network)DB2 (Network)DB2 (Network).

FIGURE: Policy Editor Policy Editor Policy Editor Policy Editor (icons, checkboxes, drop-downs, and Rule links)

You can:

•  click a ++++ icon next to a platform name to display the underlying Rules (or click 
the ---- icon to collapse)

•  check a checkbox next to a platform name to select all default Policies for the 
platform (or uncheck to de-select all)
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•  click a ++++ icon next to a default Policy category to display the underlying Rules 
(or click the - - - - icon to collapse)

•  check a checkbox next to a default Policy category to select all underlying Rules 
for the Policy (or uncheck to de-select all)

•  check a checkbox next to:

-an individual Rule to activate the Rule in the Policy (or uncheck to deactivate)

-a Filter to add the Filter to the Policy (or uncheck to remove); for more information, 
see Filters

•  click an individual Rule/Filter link to display Rule/Filter details in the right frame 
of the Policy EditorPolicy EditorPolicy EditorPolicy Editor

•  use the individual Rule drop-downs to change the risk level of an individual Rule 
from its default setting. Your choices are: HighHighHighHigh, MediumMediumMediumMedium, LowLowLowLow, or InformationalInformationalInformationalInformational 
(i.e., Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, Info-3Info-3Info-3Info-3, and Info-4Info-4Info-4Info-4), which are typically for audit events. Audit 
events are written to a table in the DbProtect Audit and Threat Management 
database, but notnotnotnot displayed on the Alert Manager Alert Manager Alert Manager Alert Manager page of the UI. For more 
information, see What do the risk levels mean?

4. If you are editing:

•  a built-in Policy and saving it as a custom Policy, then enter the custom Policy 
name in the field next to the SaveSaveSaveSave button, and click the SaveSaveSaveSave button

•  an existing custom Policy (as shown below), then you can:

-click the SaveSaveSaveSave button to save the edited custom Policy under its original name

-enter a new custom Policy name in the field next to the Save AsSave AsSave AsSave As button, and click the 
Save AsSave AsSave AsSave As button.

Note:Note:Note:Note: Policy names mustmustmustmust be unique.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy Editor Policy Editor Policy Editor Policy Editor (when editing an existing custom Policy)
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The Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page re-displays. Your custom Policy is listed.

FIGURE: Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager (with a custom Policy added)

Note:Note:Note:Note: A DeleteDeleteDeleteDelete button displays next to custom Policies. Unlike built-in Policies, 
you can delete a custom Policy; for more information, see Deleting a 
Policy.

5. You can now deploy your edited custom Policy to a Sensor; for more 
information, see Deploying a Policy.

Importing a Policy You can importimportimportimport an Policy file (in XML format).

Caution! Do not manually modify/create XML Policy files for import 

purposes; they may not work properly.

Important: When you import a Policy, it mustmustmustmust include all Filters. If you import a Policy 
that includes custom Filters, the order of the Filters is significant.
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To import a Policy: 

1. Do one of the following to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager

2. Click the Import a PolicyImport a PolicyImport a PolicyImport a Policy button to display the Import FileImport FileImport FileImport File page.

FIGURE: Import File Import File Import File Import File page
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3. Specify the location of the Policy file (must be in XML format). You can:

•  click the Browse... Browse... Browse... Browse... button to display the File UploadFile UploadFile UploadFile Upload pop up and locate the 
Policy file you want to import (on your local computer or network)

•  enter the full path and file name of the XML Policy file you want to import (on 
your local computer or network).

Note:Note:Note:Note: Check Import with overwriteImport with overwriteImport with overwriteImport with overwrite to overwrite an existing Policy file 
automatically.

4. Click the ImportImportImportImport button.

DbProtect Audit and Threat Management imports your Policy.

Exporting a Policy You can exportexportexportexport an Policy file (in XML format).

To export a Policy: 

1. Do one of the following to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.
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2. Click the ExportExportExportExport button next to the Policy you want to export.

The Open <Policy Name>.xml Open <Policy Name>.xml Open <Policy Name>.xml Open <Policy Name>.xml dialog box displays.

FIGURE: Open <Policy Name>.xml Open <Policy Name>.xml Open <Policy Name>.xml Open <Policy Name>.xml dialog box

3. Select Save to DiskSave to DiskSave to DiskSave to Disk (default).

Caution! Do not select Open With.

4. Click the OKOKOKOK button.

DbProtect Audit and Threat Management exports your Policy to the desktop (or other 
location specified, depending on your browser) as an XML file.

Deploying a Policy After creating or editing a Policy, you can deploydeploydeploydeploy it to a Sensor in order for it to take 
effect. You can deploy Policies to Sensors:

•  during Sensor configuration and deployment; for more information, see 
Configuring a Sensor and deploying the configuration information

•  from the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager (explained below).

Note:Note:Note:Note: Deploying a Policy via the Policy MangerPolicy MangerPolicy MangerPolicy Manger allows you to deploy Policies to 
multiplemultiplemultiplemultiple instances simultaneously, which may (or may not) be monitored by 
the same Sensor.

Caution! If you installed a host-based Sensor for Oracle to monitor Oracle 

databases on an Oracle RAC, you must deploy the exact same 

Policy for each host-based Sensor for Oracle (otherwise, you may 

get inconsistent results for the Alerts you are expecting to see). 

For more information, see Appendix C: Installing and 

Configuring a Host-Based Sensor for Oracle to Monitor 

Oracle Databases on an Oracle RAC.
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To deploy a Policy: 

1. Do one of the following to display the Policy Manager Policy Manager Policy Manager Policy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager
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2. Click the Deploy...Deploy...Deploy...Deploy... button next to the Policy you want to deploy to a 
Sensor.

A list of your registered Sensors displays. If no Sensors display, you need to configure 
and deploy a Sensor first; for more information, see Configuring a Sensor and 
deploying the configuration information.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager

Two scroll-down boxes display: 

•  Database Applications AvailableDatabase Applications AvailableDatabase Applications AvailableDatabase Applications Available

•  Deploy Policy ToDeploy Policy ToDeploy Policy ToDeploy Policy To.

These scroll-down boxes allow you to select database SIDs or instances where Sensors 
are registered, and deploy Policies for the Sensors to monitor.

You can also:

•  check which database platforms your Policy should apply to (i.e., SQL ServerSQL ServerSQL ServerSQL Server, 
OracleOracleOracleOracle, SybaseSybaseSybaseSybase, DB2DB2DB2DB2) in the Show:Show:Show:Show: portion of the page

•  move database SIDs or instances from the Database Applications Available Database Applications Available Database Applications Available Database Applications Available 
scroll-down box to the Deploy Policy ToDeploy Policy ToDeploy Policy ToDeploy Policy To scroll-down box, and vice versa, by 
highlighting the database SID or instance and clicking either the <<<<<<<<<<<< or >>>>>>>>>>>> 
button.

Clicking the >>> >>> >>> >>> button adds the highlighted database SID or instance to the 
list of database SIDs or instances to be updated. Clicking the <<<<<<<<<<<< button 
removes the highlighted database SID or instance from the list of database 
SIDs or instances to be updated.
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Hint: Press <SHIFT> to highlight multiple consecutive database SIDs or 

instances. Press <CTRL> to highlight multiple non-consecutive database 

SIDs or instances.

•  enter a Sensor name the find field, then click the FindFindFindFind button to display any 
Sensors with matching values.

3. Click the DeployDeployDeployDeploy button.

DbProtect Audit and Threat Management deploys the Policy to the selected Sensor. 
The Sensor will fire Alerts whenever conditions in the Policy are met (exceptexceptexceptexcept when a 
Rule or condition is filtered; for more information, see What is a Filter?).

Deleting a Policy You can only deletedeletedeletedelete a custom Policy. You cannotcannotcannotcannot delete built-in Policies or any 
deployed Policies (whether built-in or custom).

To delete a custom Policy:

1. Do one of the following to display the Policy Manager Policy Manager Policy Manager Policy Manager page:

•  Click the PoliciesPoliciesPoliciesPolicies workflow link on the HomeHomeHomeHome page.

•  Click the PoliciesPoliciesPoliciesPolicies tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager
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2. Click the DeleteDeleteDeleteDelete button next to the custom Policy you want to delete.

The next page prompts you to confirm the delete.

FFFFIIIIGGGGUUUURRRREEEE: : : : Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager

3. Click the Yes Yes Yes Yes button.

Your custom Policy is deleted from the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager list of built-in and custom 
Policies.

Policy Editor rule
categories

Note:Note:Note:Note: You can deploy a Sensor on a database host (for Oracle and SQL Server), 
or on another host that monitors network traffic to/from the database (for 
Oracle, Sybase, and DB2). You can activate most Rules for host- and 
network-based Sensors. However, certain Rules only work for network-
based Sensors. Network-based only Rules are denoted in the Policy Editor.

Rules in the Policy EditorPolicy EditorPolicy EditorPolicy Editor (which apply to SQL Server, Oracle, Sybase, and DB2 Rules) 
are divided into the following Rule categoriesRule categoriesRule categoriesRule categories:

•  Accessing OS Resources. Accessing OS Resources. Accessing OS Resources. Accessing OS Resources. An important aspect of application security is 
ensuring the integrity of the operating system (OS) on which the application 
resides. These Rules monitor for OS access via database controls.

•  Audit Events.Audit Events.Audit Events.Audit Events. These Rules allow Sensors to log the execution of database 
queries regardless of threat level. This provides administrators full awareness of 
what has been executed in the database, when, by whom, and where. 
Essentially, this is a category of events that can provide an audit trail of all 
database activity with “real-time” alerting on changes or key events. This 
functionality is provided without any impact on performance and with no 
modifications to the application or underlying database.

•  Buffer Overflow.Buffer Overflow.Buffer Overflow.Buffer Overflow. Buffer overflows can cause a database server to crash, or cause 
the memory in the stack to be overwritten (including the return address of the 
calling function). This can result in an Exception being thrown. These Rules 
focus on this type of attack and Alerts are fired if the Sensor sees the attack 
pattern being executed. For example: SQL Server provides a built-in function 
called BULK INSERT which allows data to be uploaded from a file directly to a 
table. The function BULK INSERT does not properly allocate enough memory 
when called with a long string as the name of the file from which to load. This 
can cause the stack to be overwritten and allows an attacker to inject 
executable code onto the stack.
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•  Miscellaneous.Miscellaneous.Miscellaneous.Miscellaneous. These Rules include attacks and events that do not necessarily 
fall within any of the other provided Rule categories.

•  Password Attacks. Password Attacks. Password Attacks. Password Attacks. Attempts to guess passwords by trying likely combinations of 
characters or exploiting certain vulnerabilities are simplistic attacks that can be 
used against a database. For example, one method of breaking into a database 
is to script a password attack on that database. This attack involves using a 
dictionary of usernames and passwords to attempt to log into the database. 
When performed using a script, a large number of passwords can be attempted 
rapidly. This can be an effective strategy for an attacker to break into a 
database. DbProtect Audit and Threat Management is designed to handle 
scripted password attacks and can be configured to send out a notification 
whenever it detects 100 failed login attempts within one minute.

•  Privilege Escalation. Privilege Escalation. Privilege Escalation. Privilege Escalation. Access controls deal with determining which users are 
allowed to perform what actions. Access controls are designed to restrict users 
from performing tasks they are not authorized to perform. These Rules check 
for attempts to exploit known vulnerabilities to achieve privilege escalation.

•  Security Tools.Security Tools.Security Tools.Security Tools. DbProtect Audit and Threat Management can detect various 
tools that scan the database. Although these tools may not be inherently 
malicious, it can be helpful to know who is running these tools, when, and 
against which database.

•  Web Application Attacks.Web Application Attacks.Web Application Attacks.Web Application Attacks. These Rules can be enabled to monitor against 
possible access-related attacks. Attacks may include attempts to elevate 
privileges and gain access to powerful resources within a database. SQL 
injection attack Rules can also be set within the Web Application Attacks 
category. SQL Injection occurs when an attacker is “injecting” or manipulating 
SQL code. By adding unexpected SQL to a query, an attacker is able to 
manipulate a database in many unanticipated ways. For example, one common 
technique used to detect a SQL injection vulnerability is to insert a single quote 
and observe the results for an error message. If unmatched single quotes are 
found in SQL statements being executed by the web application, it may be an 
attacker searching for SQL injection vulnerabilities.

•  User-Defined Filters.User-Defined Filters.User-Defined Filters.User-Defined Filters. User-Defined Filters are divided into the following three 
categories:

-User-Defined Security FiltersUser-Defined Security FiltersUser-Defined Security FiltersUser-Defined Security Filters, i.e., Filters created either via the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard or 
Advanced Filter and Exceptions EditorAdvanced Filter and Exceptions EditorAdvanced Filter and Exceptions EditorAdvanced Filter and Exceptions Editor that have a Risk LevelRisk LevelRisk LevelRisk Level higher than 
InformationalInformationalInformationalInformational); for more information, see Working with the Audit Filter Wizard and 
Working with the Advanced Filter and Exception Editor, respectively

-User Defined AuditsUser Defined AuditsUser Defined AuditsUser Defined Audits, i.e., Filters created either via the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard or Advanced Advanced Advanced Advanced 
Filter and Exceptions EditorFilter and Exceptions EditorFilter and Exceptions EditorFilter and Exceptions Editor that have a Risk LevelRisk LevelRisk LevelRisk Level of InformationalInformationalInformationalInformational); for more 
information, see Working with the Audit Filter Wizard and Working with the Advanced 

Filter and Exception Editor, respectively

-User-Defined ExceptionsUser-Defined ExceptionsUser-Defined ExceptionsUser-Defined Exceptions, i.e., Filters created either via the Exception WizardException WizardException WizardException Wizard or the 
Advanced Filter and Exceptions EditorAdvanced Filter and Exceptions EditorAdvanced Filter and Exceptions EditorAdvanced Filter and Exceptions Editor that prohibit an Alert from firing under certain 
circumstances; for more information, see Working with the Exception Wizard and 
Working with the Advanced Filter and Exception Editor, respectively.
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Dashboard
This chapter consists of the following topics:

•  Understanding the Dashboard

•  Monitoring Alerts (via the Dashboard)

•  Monitoring the “health” of your Sensors (via the Dashboard).

Understanding the
Dashboard

The DashboardDashboardDashboardDashboard is shown below.

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard

The DashboardDashboardDashboardDashboard provides a graphical, high-level summary of Alerts, audits, and total 
Alert volume. You can also monitor the “health” of your registered Sensors from the 
Dashboard. For more information, see Monitoring, filtering, acknowledging, and 
archiving Alerts (via the Alert Manager) and Monitoring the “health” of your Sensors 
(via the Dashboard), respectively.
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Monitoring Alerts
(via the

Dashboard)

DbProtect Audit and Threat Management receives Alerts from the registered Sensors. 
The DashboardDashboardDashboardDashboard provides a graphical, high-level summary of unacknowledged Alerts, 
audit events (i.e., Informational Alerts), most recently received Alerts, and total Alert 
volume. The DashboardDashboardDashboardDashboard automatically refreshes itself every 30 seconds to update the 
display of new, real-time Alerts.

Caution! When you have not used DbProtect Audit and Threat 

Management for a while, your Session normally times out. 

However, on certain pages, it does not. Specifically, DbProtect 

Audit and Threat Management does not time out on the Alert 

Manager, the Dashboard, and the ASAP Update portion of the 

Sensor Manager. 

To monitor Alerts (via the DashboardDashboardDashboardDashboard): 

1. Do one of the following to display the DashboardDashboardDashboardDashboard:

•  Click the Dashboard - Graphical Summary Dashboard - Graphical Summary Dashboard - Graphical Summary Dashboard - Graphical Summary workflow link on HomeHomeHomeHome page.

•  Click the DashboardDashboardDashboardDashboard tab from anywhere on the page.

The unacknowledged Alerts portion of the DashboardDashboardDashboardDashboard displays your unacknowledged 
Alerts (all Alerts and today’s Alerts), most recently received Alerts, and audit events 
(i.e., Informational Alerts).

FFFFIIIIGGGGUUUURRRREEEE: : : : DashboardDashboardDashboardDashboard (Alert portion)

2. Your Dashboard Dashboard Dashboard Dashboard options follow. If you want to view your:

•  unacknowledged Alertsunacknowledged Alertsunacknowledged Alertsunacknowledged Alerts, then go to Step 3

•  most recently received Alertsmost recently received Alertsmost recently received Alertsmost recently received Alerts, then go to Step 4

•  Informational AlertsInformational AlertsInformational AlertsInformational Alerts, then go to Step 5.
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3. To view your unacknowledged Alerts.To view your unacknowledged Alerts.To view your unacknowledged Alerts.To view your unacknowledged Alerts.

The color-coded graphs in the unacknowledged Alerts portion of the DashboardDashboardDashboardDashboard 
display your unacknowledged HighHighHighHigh, MediumMediumMediumMedium, and LowLowLowLow risk Alerts (i.e., all Alerts and 
today’s Alerts).

Note:Note:Note:Note: For more information, see What do the risk levels mean?

4. To view your most recently-received Alerts.To view your most recently-received Alerts.To view your most recently-received Alerts.To view your most recently-received Alerts.

The most recently-received Alerts portion of the DashboardDashboardDashboardDashboard displays your 
unacknowledged HighHighHighHigh, MediumMediumMediumMedium, and LowLowLowLow risk Alerts (i.e., all Alerts and for today only).

Note:Note:Note:Note: For more information, see What do the risk levels mean?

5. To view your Informational Alerts.To view your Informational Alerts.To view your Informational Alerts.To view your Informational Alerts.

The bottom portion of the DashboardDashboardDashboardDashboard displays the number of Informational (audit) 
Alerts received today.

Note:Note:Note:Note: For more information, see What do the risk levels mean?

Monitoring the
“health” of your
Sensors (via the

Dashboard)

You can monitor the “health” of your registered Sensors via the Sensor ManagerSensor ManagerSensor ManagerSensor Manager and 
the DashboardDashboardDashboardDashboard. If you’re not receiving Alerts, it couldcouldcouldcould be because your registered 
Sensor is “unhealthy”. A “healthy” Sensor is:

•  “up and running” “up and running” “up and running” “up and running” on the database SID or instance where it is registered

•  activelyactivelyactivelyactively collecting/interpreting data and firing Alertscollecting/interpreting data and firing Alertscollecting/interpreting data and firing Alertscollecting/interpreting data and firing Alerts to DbProtect Audit and 
Threat Management in accordance with its deployed Policies.

For more information, see the DbProtect Administrator’s Guide.

To monitor the “health” of your Sensors via the DashboardDashboardDashboardDashboard: 

1. Do one of the following to display the DashboardDashboardDashboardDashboard:

•  Click the Dashboard - Graphical SummaryDashboard - Graphical SummaryDashboard - Graphical SummaryDashboard - Graphical Summary workflow link on HomeHomeHomeHome page.

•  Click the DashboardDashboardDashboardDashboard tab from anywhere on the page.

The Sensor “health” portion of the DashboardDashboardDashboardDashboard displays your registered Sensors.

FIGURE: DashboardDashboardDashboardDashboard (Sensor “health” portion)
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2. The Sensor “health”Sensor “health”Sensor “health”Sensor “health” portion of the DashboardDashboardDashboardDashboard allows you to view the:

•  Number of registered SensorsNumber of registered SensorsNumber of registered SensorsNumber of registered Sensors

•  Unresponsive SensorsUnresponsive SensorsUnresponsive SensorsUnresponsive Sensors.

An unresponsive Sensor is “unhealthy”; for more information, see the DbProtect 
Administrator’s Guide.
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Filters
This chapter consists of the following topics:

•  What is a Filter?

•  What are Global Filters and Global Exceptions?

•  Understanding the Filter Manager

•  Working with the Audit Filter Wizard

•  Working with the Exception Wizard

•  Working with the Advanced Filter and Exception Editor

•  Writing expressions

•  Joining expressions

•  Editing a Filter

•  Deleting a Filter

•  Importing a Filter

•  Exporting a Filter.

What is a Filter? This topic explains:

•  What do Filters do?

•  Working with Filters

•  Important column-level considerations for Filters and Exceptions.

WHAT DO FILTERS DO?

FiltersFiltersFiltersFilters are custom Rules created for:

•  auditing database activity

•  inhibiting output of another Rule

•  monitoring database activity in ways not provided for in the DbProtect Audit 
and Threat Management built-in Rules.

Like a built-in Rule, you can add a Filter to a Policy and, subsequently, deploy it to a 
Sensor.

Caution! Filters are only active when you include them in a Policy, then 

deploy the Policy.

Note:Note:Note:Note: When you import a Policy, it mustmustmustmust include all Filters. If you import a Policy 
that includes custom Filters, the order of the Filters is significant. For more 
information, see Importing a Policy.

The Filter ManagerFilter ManagerFilter ManagerFilter Manager allows you to create and edit Filters that customize the effect of 
built-in Rules and Policies to better suit individual security needs. For more 
information, see Understanding the Filter Manager.
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WORKING WITH FILTERS

There are three ways to work with Filters:

•  Audit Filter Wizard. Audit Filter Wizard. Audit Filter Wizard. Audit Filter Wizard. Allows you to create audit Rules for system objects. You can 
monitor SELECT, INSERT, UPDATE and DELETE activity against system and user 
tables in any database, and monitor the execution of stored procedures and 
functions; for more information, see Working with the Audit Filter Wizard.

Example: Example: Example: Example: The built-in Rule User-table SELECTUser-table SELECTUser-table SELECTUser-table SELECT generates an audit event any 
time a SQL query is executed against a user table. This audit Rule may result in 
a significant amount of data -- perhaps more than is required or really useful. 
Perhaps you only need to monitor a few database tables with this Rule. In other 
words, you don't want to deactivate the Rule -- but you want to limit its scope. 

Solution:Solution:Solution:Solution: Use the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard to restrict auditing to only the user tables 
you specify. (You can even design the Filter to monitor specific columns in the 
tables.) 

•  Exception Wizard. Exception Wizard. Exception Wizard. Exception Wizard. Allows you to create criteria to suppress built-in Rules from 
triggering. Exceptions are useful because they can reduce the volume of 
unremarkable Alerts and audits sent to DbProtect Audit and Threat 
Management and log file, respectively. For more information, see Working with 
the Exception Wizard.

Examples: Examples: Examples: Examples: Consider the auditing event drop tabledrop tabledrop tabledrop table. Your company requires you 
to audit the integrity of the database, but periodically maintenance is 
performed using the well-known sasasasa account. By creating an Exception Filter 
when the account is sa, those drop tabledrop tabledrop tabledrop table events will notnotnotnot be reported to 
DbProtect Audit and Threat Management.

Or, assume you want to allow machine ABC to run xp_cmdshell, and notnotnotnot fire an 
Alert for the check Generic use of xp_cmdshellGeneric use of xp_cmdshellGeneric use of xp_cmdshellGeneric use of xp_cmdshell. You can enable the Rule and 
create an Exception for the Source of AttackSource of AttackSource of AttackSource of Attack, i.e., machine ABC.

The Exception Wizard also allows you to create Global FiltersGlobal FiltersGlobal FiltersGlobal Filters. Global 
Exceptions allow you to monitor all database activity (for a selected database 
type), and configure DbProtect Audit and Threat Management not not not not to fire Alerts 
when certain criteria are met. For more information, see What are Global Filters 
and Global Exceptions?
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•  Advanced Filter and Exception Editor.Advanced Filter and Exception Editor.Advanced Filter and Exception Editor.Advanced Filter and Exception Editor. Allows you to customize any built-in Rule 
or create new ones. It contains a flexible expression editor for creating 
arbitrarily complex Rules; for more information, see Working with the Advanced 
Filter and Exception Editor.

Example:Example:Example:Example: The Rule Accessing list of loginsAccessing list of loginsAccessing list of loginsAccessing list of logins monitors the system table 
(sysxloginssysxloginssysxloginssysxlogins) which contains the list of valid logins and password hashes for the 
database server. Attempts to access this data may indicate an attacker is trying 
to access the table information. In some cases, however, it is legitimate for an 
account to access the sysxloginssysxloginssysxloginssysxlogins table. For instance, the application BILL BILL BILL BILL 
SYSTEMSYSTEMSYSTEMSYSTEM is configured to access the sysxloginssysxloginssysxloginssysxlogins table as part of its normal 
operations. However, this is the only system authorized to perform such a 
function.

To monitor the sysxloginssysxloginssysxloginssysxlogins table for unauthorized access -- with the exception of 
the BILL SYSTEMBILL SYSTEMBILL SYSTEMBILL SYSTEM application -- you can create a Filter to notify you when any 
application except BILL SYSTEMBILL SYSTEMBILL SYSTEMBILL SYSTEM is not accessing the sysxloginssysxloginssysxloginssysxlogins table. You can 
add criteria to the Rule with the following expression: Application is not 
equal to “BILL SYSTEM”

The Advanced Filter and Exception Editor also allows you to create Global Global Global Global 
FiltersFiltersFiltersFilters and Global ExceptionsGlobal ExceptionsGlobal ExceptionsGlobal Exceptions. Global Filters allow you to monitor all database 
activity (for a selected database type), and configure DbProtect Audit and 
Threat Management to fire Alerts only when certain criteria are met. Global Global Global Global 
ExceptionsExceptionsExceptionsExceptions, on the other hand, allow you to monitor all database activity (for a 
selected database type), and configure DbProtect Audit and Threat 
Management notnotnotnot to fire Alerts when certain criteria are met. For more 
information, see What are Global Filters and Global Exceptions?

For advice (and an example) on writing XML Rules in Advanced Filter EditorAdvanced Filter EditorAdvanced Filter EditorAdvanced Filter Editor, see 
Writing expressions.

IMPORTANT COLUMN-LEVEL CONSIDERATIONS FOR FILTERS 

AND EXCEPTIONS

DbProtect Audit and Threat Management allows you to select multiple columns when 
you define a Filter or an Exception. If you are defining:

•  a Filter, and any of the selected columns are found in the query, then the Rule 
will fire. This includes the * wild card, which includes all columns.

•  an Exception, and if any of the selected columns are found in the query, then 
the Rule will notnotnotnot fire. This includes the * wild card, which includes all columns.

Note:Note:Note:Note: DbProtect Audit and Threat Management also supports filtering at the row 
level with the application of custom Filters. For assistance with customizing 
this feature, email Application Security, Inc. Support at 
support@appsecinc.com.
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What are Global
Filters and Global

Exceptions?

There may be cases when you do not want to monitor database activity related to a 
specific Rule, but rather you want to monitor all database activity, in special cases. This 
can be done in DbProtect Audit and Threat Management using either Global Filters or 
Global Exceptions.

Global FiltersGlobal FiltersGlobal FiltersGlobal Filters allow you to monitor all database activity (for a selected database type), 
and configure DbProtect Audit and Threat Management to fire Alerts only when 
certain criteria are met. Global ExceptionsGlobal ExceptionsGlobal ExceptionsGlobal Exceptions, on the other hand, allow you to monitor all 
database activity (for a selected database type), and configure DbProtect Audit and 
Threat Management notnotnotnot to fire Alerts when certain criteria are met.

You can only create Global Filters using the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor. 
However, both the Exception Wizard Exception Wizard Exception Wizard Exception Wizard and the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor 
allow you to create Global Exceptions. For more information on:

•  creating Global Filters with the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor, see 
Working with the Advanced Filter and Exception Editor

•  creating Global Exceptions with the Exception Wizard Exception Wizard Exception Wizard Exception Wizard and the Advanced Filter Advanced Filter Advanced Filter Advanced Filter 
and Exception Editorand Exception Editorand Exception Editorand Exception Editor, see and Working with the Exception Wizard and Working 
with the Advanced Filter and Exception Editor, respectively.

Understanding the
Filter Manager

The Filter ManagerFilter ManagerFilter ManagerFilter Manager is shown below.

FIGURE: Filter Manager Filter Manager Filter Manager Filter Manager page
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The upper portionupper portionupper portionupper portion of the Filter ManagerFilter ManagerFilter ManagerFilter Manager allows you to:

•  create Filters and Exceptions using the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard, the Exception Exception Exception Exception 
WizardWizardWizardWizard, and the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor; for more information, 
see What is a Filter?

•  import a Filter; for more information, see Importing a Filter.

The lower (My FiltersMy FiltersMy FiltersMy Filters) portion of the Filter ManagerFilter ManagerFilter ManagerFilter Manager page:

•  displays your existing Filters, including the name and the risk level assigned 
during Filter creation

•  allows you to edit or delete any displayed Filter; for more information, see 
Editing a Filter and Deleting a Filter, respectively.

Working with the
Audit Filter Wizard

The Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard allows you to create audit Rules for system objects. You can 
monitor SELECT, INSERT, UPDATE and DELETE activity against system and user tables in 
any database, and monitor the execution of stored procedures and functions.

This topic consists of the following sub-topics:

•  Oracle DBA considerations

•  DB2 DBA considerations (for network-based Sensors for DB2)

•  DB2 DBA considerations (for host-based Sensors for DB2)

•  Sybase DBA considerations

•  Creating a Filter with the Audit Filter Wizard.

ORACLE DBA CONSIDERATIONS

If you are using a host- or network-based Sensor for Oracle on Windowshost- or network-based Sensor for Oracle on Windowshost- or network-based Sensor for Oracle on Windowshost- or network-based Sensor for Oracle on Windows for Activity 
Monitoring and Auditing, and you want to use Filters, then you mustmustmustmust enter an Oracle 
user name and password during Sensor registration and configuration; for more 
information on configuring a:

•  hosthosthosthost-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows, see Configuring a host-based 
Sensor to monitor Oracle SIDs and services and deploying the configuration 
information (when Sensor is installed on a *nix-based operating system).

•  networknetworknetworknetwork-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows-based Sensor for Oracle on Windows, see Configuring a network-
based Sensor to monitor Oracle SIDs and services and deploying the 
configuration information (when Sensor is installed on Windows).

The user name/password pair is notnotnotnot used to monitor your database. The pair is only 
used by the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard to collect object information from the database.

Note:Note:Note:Note: This requirement does notnotnotnot apply to host-based Sensors for Oracle on *nix 
platforms for Activity Monitoring and Auditing. For these types of Sensors, 
the account running the Sensor process should have the same primary 
group as the oracle account, and no further credentials should be 
necessary.
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The host- or network-based Sensor for Oracle on Windows service account mustmustmustmust be 
part of bothbothbothboth the administrator and ora_dba windows groups.

The Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard for Oracle does notnotnotnot require full DBA permissions. You only 
need to specify the following set of permissions:

•  SELECT on SYS.DBA_OBJECTS

•  SELECT on SYS.DBA_TAB_COLUMNS

•  SELECT on SYS.DBA_USERS

•  SELECT on SYS.DBA_TABLES

•  SELECT on SYS.DBA_VIEWS

•  SELECT on SYS.DBA_SEQUENCES

When you finish configuring DbProtect Activity Monitoring and Auditing and defining 
all Rules, you can re-configure your Sensors withoutwithoutwithoutwithout an Oracle user name and 
password, then re-deploy the Sensors. For more information, see the DbProtect 
Installation Guide.

DB2 DBA CONSIDERATIONS (FOR NETWORK-BASED 

SENSORS FOR DB2)

If you’re a DB2 DBA, and you plan to create a custom Filter for DB2, you must:

•  install the appropriate DB2 administrative client drivers on the server where the 
network-based Sensor for DB2 resides

•  catalog the DB2 client drivers to recognize the monitored DB2 database (either 
through Discovery or reference).

The reason you must catalog your monitored DB2 databases is so they will display in 
the Audit Filter Wizard; for more information, see Creating a Filter with the Audit Filter 
Wizard. In other words, you must make the client “aware” of these DB2 databases. 
With any client, you must always catalog the resources you’re going to use, starting 
with a node (i.e., the server itself), then a database on the node to which you’re 
connected.

The Audit Filter Wizard does not require full DBA permissions. However, a custom 
Filter for DB2 does require read access to the following tables:

•  sysibm.systables

•  sysibm.syscolumns

•  sysibm.sysroutines

For more information on DB2 client driver installation, see “Appendix G: DB2 
Administrative Client Driver Installation” in the DbProtect Installation Guide.



DbProtect 6.1 User’s Guide

Application Security, Inc. 380

DB2 DBA CONSIDERATIONS (FOR HOST-BASED SENSORS 

FOR DB2)

The DBADM permissions required to run the host-based Sensor for DB2 (SYSADM if the 
appradar user wants to monitor failed logins) are sufficient to create a Filter with the 
Audit Filter Wizard. For more information, see the DbProtect Installation Guide.

SYBASE DBA CONSIDERATIONS

The Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard for Sybase does notnotnotnot require full DBA permissions. You only 
require access to read the following tables: master..sysdatabases and the 
sysobjects, sysusers, and syscolumns tables in the target databases being Audited.

For more information, see the DbProtect Installation Guide.

CREATING A FILTER WITH THE AUDIT FILTER WIZARD

To create a Filter using the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard:

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager
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2. Click the CreateCreateCreateCreate button in the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard portion of the page.

The first Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard

3. Select whether you want to create a Rule for:

•  Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server 2000200020002000 (host-based Sensor)

•  Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 (host-based Sensor)

•  Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 (host-based Sensor)

•  OracleOracleOracleOracle (host-based or network-based Sensor)

•  SybaseSybaseSybaseSybase (network-based Sensor)

•  DB2DB2DB2DB2 (host-based or network-based Sensor).

Note:Note:Note:Note: If you’re a DB2 DBA, and you have a network-based Sensor for DB2 
installed, and you plan to create a custom Filter for DB2, then you must: a.) 
install the appropriate DB2 administrative client drivers on the server 
where the network-based Sensor for DB2 resides; b.) catalog the DB2 
client drivers to recognize the monitored DB2 database (either through 
Discovery or reference).

You must catalog your monitored DB2 databases so they will display in the 
Audit Filter Wizard. In other words, you must make the client “aware” of 
these DB2 databases. With any client, you must always catalog the 
resources you’re going to use, starting with a node (i.e., the server itself), 
then a database on the node to which you’re connected. For more 
information on DB2 client driver installation, see “Appendix G: DB2 
Administrative Client Driver Installation” in the DbProtect Installation 
Guide.
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4. Click the NextNextNextNext button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard

5. Check the action(s) you want to audit. DbProtect Audit and Threat 
Management can audit:

•  activity on database objectsdatabase objectsdatabase objectsdatabase objects (such as tables and views) by monitoring SELECT, 
INSERT, UPDATE, and DELETE actions

•  the EXECUTION of stored proceduresstored proceduresstored proceduresstored procedures and functionsfunctionsfunctionsfunctions.

6. Click the NextNextNextNext button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard

7. Use the drop-down to select the alias name for the configured database 
instance or SID that contains the objects you want to audit.
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8. Click the NextNextNextNext button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard

9. Use the drop-down to select the database you want to Audit.

To create a custom Filter create a custom Filter create a custom Filter create a custom Filter for:

•  OracleOracleOracleOracle, you must have the following privileges: all_users, all_tables, 
all_tab_columns, and all_objects

•  SybaseSybaseSybaseSybase, you require access to read the following tables: 
master..sysdatabases and the sysobjects, sysusers, and syscolumns 
tables in the target databases being Audited.

•  DB2DB2DB2DB2, you mustmustmustmust install the appropriate DB2 administrative client drivers (for more 
information on DB2 client driver installation, see the DbProtect Installation 
Guide), and configure it to recognize the monitored database (either through 
Discovery or reference). Creating a custom Filter for DB2 also requires access to 
read the following tables:

-sysibm.systables

-ysibm.syscolumns

-sysibm.sysroutines

For more information, see the “Rights” row in the Creating a Filter with the Audit Filter 
Wizard table.

10.Click the NextNextNextNext button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays. Up to three portions of the page display, 
depending on whether you selected to audit database objectsdatabase objectsdatabase objectsdatabase objects, and/or the EXECUTION 
of stored proceduresstored proceduresstored proceduresstored procedures and/or functionsfunctionsfunctionsfunctions in Step 5.

If you selected to audit: 

•  database objectsdatabase objectsdatabase objectsdatabase objects in Step 5, then go to Step 11

•  stored procedures stored procedures stored procedures stored procedures in Step 5, then go to Step 12

•  functionsfunctionsfunctionsfunctions in Step 5, then go to Step 13.
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11.If you selected to audit database objectsdatabase objectsdatabase objectsdatabase objects in Step 5, then the Audit Filter Audit Filter Audit Filter Audit Filter 
Wizard Wizard Wizard Wizard page allows you to:

•  use the scroll-down box to highlight one or more database objects you want to 
audit

Hint: Press <SHIFT> to highlight multiple consecutive objects. Press <CTRL> to 

highlight multiple non-consecutive objects.

•  select whether you want to audit the selected database objects at the column 
level (YesYesYesYes or NoNoNoNo).

Note:Note:Note:Note: DbProtect Audit and Threat Management allows you to select multiple 
columns when you define a Filter or an Exception. If you are defining a 
Filter, and the selected columns are found in a query, then the Rule will fire. 
For more information, see Important column-level considerations for 
Filters and Exceptions.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard
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12.If you selected to audit stored procedures in Step 5, then the Audit Filter 
Wizard page allows you to use the scroll-down box to highlight one or 
more stored procedures you want to audit.

Hint: Press <SHIFT> to highlight multiple consecutive objects. Press <CTRL> to 

highlight multiple non-consecutive objects.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard
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13.If you selected to audit functions functions functions functions in Step 5, then the Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard 
page allows you to use the scroll-down box to highlight one or more 
functions you want to audit.

Hint: Press <SHIFT> to highlight multiple consecutive objects. Press <CTRL> to 

highlight multiple non-consecutive objects.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard
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14.Click the Next Next Next Next button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard

15.This page allows you to enter descriptive information about your Filter.

•  * Title * Title * Title * Title (required field). Enter the Filter title. There are no strict naming 
restrictions for Filters, other than size limit and alphanumeric characters. 
Application Security, Inc. recommends you adopt a naming convention for the 
Filters that are created; the title of the Filter is the first thing seen by an 
operator when an event occurs, and you choose an informative title, marking it 
with a special code if it's an Exception.

•  * Risk Level * Risk Level * Risk Level * Risk Level (required field). Select a risk level for the audit event, i.e., 
InformationalInformationalInformationalInformational (i.e., Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, Info-3Info-3Info-3Info-3, and Info-4Info-4Info-4Info-4). 

Note:Note:Note:Note: The InformationalInformationalInformationalInformational risk levels are typically for audit events. Audit events are 
written to a table in the DbProtect database, but notnotnotnot displayed on the 
Alert Manager page on the UI. For more information, see What do the risk 
levels mean?
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•  Policy Description.Policy Description.Policy Description.Policy Description. Enter a description of any corporate Policy that governs this 
Filter Rule.

•  Alert Description. Alert Description. Alert Description. Alert Description. Enter an description of the Alert (and Filter).

•  Summary.Summary.Summary.Summary. Enter a summary of the Alert (and Filter).

•  Fix Information. Fix Information. Fix Information. Fix Information. Enter any fix information that is relevant to this Filter.

16.Click the Next Next Next Next button.

The next Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard Audit Filter Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard
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17.At this point, the Audit Filter WizardAudit Filter WizardAudit Filter WizardAudit Filter Wizard has enough information to save your 
Filter. If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to save your Filter, click the SaveSaveSaveSave 
button.

DbProtect Audit and Threat Management saves your Filter. The Filter Manager: Filter Manager: Filter Manager: Filter Manager: 
Results Results Results Results page displays.

FIGURE: Filter Manager: ResultsFilter Manager: ResultsFilter Manager: ResultsFilter Manager: Results page

18.In order for your Filter to take effect, you mustmustmustmust add the Filter to a Policy 
(whether you create a new Policy, or edit an existing Policy), then deploy 
the Policy.

You can click the:

•  Add filter to policy Add filter to policy Add filter to policy Add filter to policy link to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager, add the Filter to the 
Policy, then deploy the Policy; for more information, see Creating a Policy if you 
want to add the Filter to a new Policy, or Editing a Policy if you want to add the 
Filter to an existing Policy

•  Return to Filters Main Page Return to Filters Main Page Return to Filters Main Page Return to Filters Main Page link to re-display the Filter ManagerFilter ManagerFilter ManagerFilter Manager.

Working with the
Exception Wizard

The Exception Wizard Exception Wizard Exception Wizard Exception Wizard allows you to create Exceptions, i.e., conditions applied to 
Rules that prevent Alerts from firing for a given login name, source of attack, and/or 
application name.

There may be cases when you do not want to monitor database activity related to a 
specific Rule, but rather you want to monitor all database activity, in special cases. This 
can be done in DbProtect Audit and Threat Management using Global ExceptionsGlobal ExceptionsGlobal ExceptionsGlobal Exceptions. 
Global Exceptions allow you to monitor all database activity (for a selected database 
type), and configure DbProtect Audit and Threat Management notnotnotnot to fire Alerts when 
certain criteria are met. The Exception Wizard Exception Wizard Exception Wizard Exception Wizard allows you to create Global Exceptions. 
For more information, see What are Global Filters and Global Exceptions?
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To create regular and global Exception using the Exception WizardException WizardException WizardException Wizard: 

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager

2. Click the CreateCreateCreateCreate button in the Exception WizardException WizardException WizardException Wizard portion of the page.

The first Exception Wizard Exception Wizard Exception Wizard Exception Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard

3. Select whether you want to create an Exception for:

•  MicrosoftMicrosoftMicrosoftMicrosoft SQL ServerSQL ServerSQL ServerSQL Server 2000200020002000 (host-based Sensor)

•  Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 (host-based Sensor)

•  Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 (host-based Sensor)



DbProtect 6.1 User’s Guide

Application Security, Inc. 391

•  OracleOracleOracleOracle (host-based or network-based Sensor)

•  SybaseSybaseSybaseSybase (network-based Sensor)

•  DB2DB2DB2DB2 (host-based or network-based Sensor).

Note:Note:Note:Note: If you are going to use a network-based Sensor to monitor a DB2 server, 
you must install the appropriate DB2 administrative client drivers. This 
requirement does notnotnotnot apply to host-based Sensors for DB2. For more 
information, see the DbProtect Installation Guide.

4. Click the NextNextNextNext button.

The next Exception WizardException WizardException WizardException Wizard page displays. You can select an individual Rule for which 
to create an Exception (e.g., Accessing list of loginsAccessing list of loginsAccessing list of loginsAccessing list of logins).

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard

Or you can select the All <Database Type> Server Activity All <Database Type> Server Activity All <Database Type> Server Activity All <Database Type> Server Activity Rule to create a Global 
Exception (e.g., All Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server Activity). For more information, see What are 
Global Filters and Global Exceptions?

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard
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5. Click the NextNextNextNext button.

The next Exception WizardException WizardException WizardException Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard

6. This page has two parts: a "do not fire when"  "do not fire when"  "do not fire when"  "do not fire when" drop-down and a text box/
addaddaddadd button.

•  The "do not fire when"  "do not fire when"  "do not fire when"  "do not fire when" drop-down allows you to select one of the following 
Exception conditions (i.e., when Alerts should notnotnotnot fire).

-LLLLiogin Name. ogin Name. ogin Name. ogin Name. The user name a potential source of Alerts may attempt to authenticate 
as.

-Source of Attack.Source of Attack.Source of Attack.Source of Attack. The network hostname or IP of a potential Alert source.

-Application Name.Application Name.Application Name.Application Name. The name of an application, as it registers itself with SQL Server, 
Oracle, Sybase, or DB2.

•  Use the text box to specify the conditions under which to avoid firing an Alert. 
For example, if you select Login NameLogin NameLogin NameLogin Name in the "do not fire when" "do not fire when" "do not fire when" "do not fire when" drop-down, 
and enter jsmith in the text box, then the Rule selected in Step 4 will notnotnotnot fire 
when the individual with the login name jsmith performs the monitored action.
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7. Click the addaddaddadd button to add additional criteria to your Exception. The 
added criteria display dynamically at the bottom of the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard

Hint: You can click the delete button to delete any added Exception criteria 

before continuing.
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8. Once you have added all your Exception criteria, click the NextNextNextNext button.

The next Exception WizardException WizardException WizardException Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard

9. This page allows you to enter descriptive information about the Exception. 

•  * Title Title Title Title (required field). Enter the Exception title. There are no strict naming 
restrictions for Exceptions, other than size limit and alphanumeric characters. 
Application Security, Inc. recommends you adopt a naming convention for the 
Exceptions that are created; the title of the Exception is the first thing seen by 
an operator when an event occurs, and you choose an informative title, marking 
it with a special code if it's an Exception.

•  Policy Description.Policy Description.Policy Description.Policy Description. Enter a description of any corporate Policy that governs this 
Exception Rule.

•  Alert Description. Enter an description of the Alert (and Exception).

•  Summary. Enter a summary of the Alert (and Exception).

•  Fix Information. Enter any fix information that is relevant to this Exception.
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10.Click the Next Next Next Next button.

The next Exception WizardException WizardException WizardException Wizard page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Exception WizardException WizardException WizardException Wizard
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11.At this point, the Exception WizardException WizardException WizardException Wizard has enough information to save your 
Exception. If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your settings and ready to save your Exception, click the SaveSaveSaveSave 
button.

DbProtect Audit and Threat Management saves your Exception. The Filter Manager: Filter Manager: Filter Manager: Filter Manager: 
Results Results Results Results page displays.

FIGURE: Filter Manager: ResultsFilter Manager: ResultsFilter Manager: ResultsFilter Manager: Results page

12.In order for the Exception to take effect, you must add the Exception to a 
Rule. You can click the:

•  Add Exception to rule Add Exception to rule Add Exception to rule Add Exception to rule link to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager, add the Exception to 
a Rule in a Policy, then deploy the Policy; for more information, see Creating a 
Policy if you want to add the Exception to a rule in a new Policy, or Editing a 
Policy if you want to add the Exception to a rule in an existing Policy

•  Return to Filters Main Page Return to Filters Main Page Return to Filters Main Page Return to Filters Main Page link to re-display the Filter ManagerFilter ManagerFilter ManagerFilter Manager.

Working with the
Advanced Filter
and Exception

Editor

The Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor allows you to customize any built-in Rule, or 
create new ones. It contains a flexible expression editor for creating arbitrarily 
complex Rules.

Example:Example:Example:Example: The Rule Accessing list of loginsAccessing list of loginsAccessing list of loginsAccessing list of logins monitors the system table (sysxloginssysxloginssysxloginssysxlogins) 
which contains the list of valid logins and password hashes for the database server. 
Attempts to access this data may indicate an attacker is trying to access the table 
information. In some cases, however, it is legitimate for an account to access the 
sysxloginssysxloginssysxloginssysxlogins table. For instance, the application BILL SYSTEMBILL SYSTEMBILL SYSTEMBILL SYSTEM is configured to access the 
sysxloginssysxloginssysxloginssysxlogins table as part of its normal operations. However, this is the only system 
authorized to perform such a function.

To monitor the sysxloginssysxloginssysxloginssysxlogins table for unauthorized access -- with the exception of the 
BILL SYSTEMBILL SYSTEMBILL SYSTEMBILL SYSTEM application -- you can create a Filter to notify you when any application 
except BILL SYSTEMBILL SYSTEMBILL SYSTEMBILL SYSTEM is not accessing the sysxloginssysxloginssysxloginssysxlogins table. You can add criteria to the 
Rule with the following expression: Application is not equal to “BILL SYSTEM”

The topic Writing expressions also contains advice (and an example) on writing XML 
Rules in the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor.
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There may be cases when you do not want to monitor database activity related to a 
specific Rule, but rather you want to monitor all database activity, in special cases. This 
can be done in DbProtect Audit and Threat Management using Global Filters Global Filters Global Filters Global Filters and 
Global ExceptionsGlobal ExceptionsGlobal ExceptionsGlobal Exceptions. Global FiltersGlobal FiltersGlobal FiltersGlobal Filters allow you to monitor all database activity (for a 
selected database type), and configure DbProtect Audit and Threat Management to 
fire Alerts only when certain criteria are met. Global Exceptions allow you to monitor 
all database activity (for a selected database type), and configure DbProtect Audit and 
Threat Management notnotnotnot to fire Alerts when certain criteria are met. The Advanced Advanced Advanced Advanced 
Filter and Exception Editor Filter and Exception Editor Filter and Exception Editor Filter and Exception Editor allows you to create Global Filters and Global Exceptions. 
For more information, see What are Global Filters and Global Exceptions?

To create Filters (regular and Global) and Exceptions (regular and Global) using the 
Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor: 

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

s

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager
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2. Click the CreateCreateCreateCreate button in the Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor of the 
page.

The first Advanced Filter and Exception Editor  Advanced Filter and Exception Editor  Advanced Filter and Exception Editor  Advanced Filter and Exception Editor page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor

3. Select whether you want to create a Rule for:

•  Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server 2000200020002000 (host-based Sensor); for more information on 
Microsoft SQL Server name attributes, see SQL Server name attributes

•  Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 (host-based Sensor); for more information on 
Microsoft    SQL Server name attributes, see SQL Server name attributes

•  Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 Microsoft SQL Server 2008 (host-based Sensor); for more information on 
Microsoft    SQL Server name attributes, see SQL Server name attributes

•  OracleOracleOracleOracle (host-based or network-based Sensor); for more information on Oracle 
name attributes, see Oracle name attributes

•  SybaseSybaseSybaseSybase (network-based Sensor); for more information on Sybase name 
attributes, see Sybase name attributes

•  DB2DB2DB2DB2 (host-based or network-based Sensor); for more information on SQL Server 
name attributes, see DB2 name attributes.

Note:Note:Note:Note: If you are going to use a network-based Sensor to monitor a DB2 server, 
you must install the appropriate DB2 administrative client drivers. This 
requirement does not apply to host-based Sensors for DB2. For more 
information, see the DbProtect Installation Guide.
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4. Click the NextNextNextNext button.

The next Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor page displays. You can select an 
individual Rule for which to create an Exception (e.g., Accessing list of loginsAccessing list of loginsAccessing list of loginsAccessing list of logins).

FFFFIIIIGGGGUUUURRRREEEE: : : : Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor

Or you can select the All <Database Type> Server Activity All <Database Type> Server Activity All <Database Type> Server Activity All <Database Type> Server Activity Rule to create a Global 
Filter or a Global Exception (e.g., All Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server Activity). For more 
information, see What are Global Filters and Global Exceptions?

FFFFIIIIGGGGUUUURRRREEEE: : : : Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor
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5. Click the NextNextNextNext button.

The next Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor

This page consists of the following portions:

•  SQL Server Name Legend/AppRadar Names Legend/Operator Legend.SQL Server Name Legend/AppRadar Names Legend/Operator Legend.SQL Server Name Legend/AppRadar Names Legend/Operator Legend.SQL Server Name Legend/AppRadar Names Legend/Operator Legend. These 
legends allow you to copy/paste valid SQL Server names, DbProtect Audit and 
Threat Management names, and operators into the XML editor when you 
create your Rule.

•  Trigger conditions. Trigger conditions. Trigger conditions. Trigger conditions. The trigger condition radio buttons allows you to select 
whether the base Rule will trigger an Alert only when or except when the 
conditions (expressed in the XML editor) are met.
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Note:Note:Note:Note: If you selected the All <Database Type> Server Activity Rule All <Database Type> Server Activity Rule All <Database Type> Server Activity Rule All <Database Type> Server Activity Rule (e.g., All All All All 
Microsoft SQL Server ActivityMicrosoft SQL Server ActivityMicrosoft SQL Server ActivityMicrosoft SQL Server Activity) in Step 4, and you select you select will 
trigger and alert only when the conditions below are met, then you are 
creating a Global Filter. However, if you selected the All <Database Type> All <Database Type> All <Database Type> All <Database Type> 
Server Activity RuleServer Activity RuleServer Activity RuleServer Activity Rule (e.g., All Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server ActivityAll Microsoft SQL Server Activity) in Step 4, and 
you select will trigger and alert except when the conditions below are metwill trigger and alert except when the conditions below are metwill trigger and alert except when the conditions below are metwill trigger and alert except when the conditions below are met, 
then you are creating a Global Exception. For more information, see What 
are Global Filters and Global Exceptions?

•  XML editor. XML editor. XML editor. XML editor. The XML editor allows you to write a Rule as an XML expression. 
You can copy/paste valid values from the legends. The XML editor is already 
activated once you display this page, and populated with a template of XML 
code containing "dummy" placeholder values.

Important: You mustmustmustmust understand XML syntax, Boolean logic, and prefix-notation to 
create valid expressions. The topic Joining expressions also contains 
advice (and an example) on writing XML Rules in Advanced Filter and Advanced Filter and Advanced Filter and Advanced Filter and 
Exception EditorException EditorException EditorException Editor.

6. Do the following:

•  Use the XML editorXML editorXML editorXML editor to create Rule criteria by joining together any number of 
expressions with AND and OR logical operators; for more information on 
expression writing, see Writing expressions and Joining expressions. 

For example: 

<and>

<expr name="ObjectName" operator="equals" value="foo" />

</and>

The XML mustmustmustmust be both well-formed and valid. The XML is valid if it contains a 
name attribute with a value shown in the SQL Server Name Legend SQL Server Name Legend SQL Server Name Legend SQL Server Name Legend and the 
AppRadar NamesAppRadar NamesAppRadar NamesAppRadar Names LegendLegendLegendLegend, and an operator attribute with a value shown in the 
OperatorOperatorOperatorOperator LegendLegendLegendLegend.

•  In the trigger conditionstrigger conditionstrigger conditionstrigger conditions portion, select whether your base Rule will trigger an 
Alert only when or except when the conditions (expressed in the XML editor) 
are met.

•  Click the Add ExpressionAdd ExpressionAdd ExpressionAdd Expression button to append another template of XML code 
(with more "dummy" placeholder values).
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7. When you’re done, click the NextNextNextNext button.

The next Advanced Filter and Exception Editor Advanced Filter and Exception Editor Advanced Filter and Exception Editor Advanced Filter and Exception Editor page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor

8. This page allows you to enter descriptive information about the Rule.

•  * Title * Title * Title * Title (required field). Enter the Rule title. There are no strict naming 
restrictions for Rules, other than size limit and alphanumeric characters. 
Application Security, Inc. recommends you adopt a naming convention for the 
Rules that are created; the title of the Rule is the first thing seen by an operator 
when an event occurs, and you choose an informative title.

•  * Risk Level * Risk Level * Risk Level * Risk Level (required field). Select a risk level. Your choices are: HighHighHighHigh, MediumMediumMediumMedium, 
LowLowLowLow, or InformationalInformationalInformationalInformational (i.e., Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, Info-3Info-3Info-3Info-3, and Info-4Info-4Info-4Info-4), which are typically 
for audit events. Audit events are written to a table in the DbProtect database, 
but notnotnotnot displayed on the Alert Manager Alert Manager Alert Manager Alert Manager page on the UI. For more information, 
see What do the risk levels mean?

•  Policy Description. Policy Description. Policy Description. Policy Description. Enter a description of any corporate Policy that governs this 
Rule.

•  Alert Description.Alert Description.Alert Description.Alert Description. Enter an description of the Alert (and Rule).

•  Summary. Summary. Summary. Summary. Enter a summary of the Alert (and Rule).

•  Fix Information.Fix Information.Fix Information.Fix Information. Enter any fix information that is relevant to this Rule.
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9. Click the NextNextNextNext button.

The Advanced Filter and Exception Editor: Summary Advanced Filter and Exception Editor: Summary Advanced Filter and Exception Editor: Summary Advanced Filter and Exception Editor: Summary page displays.

FIGURE: Advanced Filter and Exception Editor: SummaryAdvanced Filter and Exception Editor: SummaryAdvanced Filter and Exception Editor: SummaryAdvanced Filter and Exception Editor: Summary page

If you:

•  want to review or change any settings you can click the BackBackBackBack button or any link 
that displays on the page

•  are satisfied with your Rule settings, click the SaveSaveSaveSave button.

Your Rule is saved. A confirmation page displays.

FIGURE: Advanced Filter and Exception Editor: ConfirmationAdvanced Filter and Exception Editor: ConfirmationAdvanced Filter and Exception Editor: ConfirmationAdvanced Filter and Exception Editor: Confirmation page
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10.In order for the Rule to take effect, you must add the Rule to a Policy 
(whether you create a new Policy, or edit an existing Policy), then deploy 
the Policy.

From the confirmation page, you can click the:

•  Add filter to policyAdd filter to policyAdd filter to policyAdd filter to policy link, to display the Policy ManagerPolicy ManagerPolicy ManagerPolicy Manager; for more information, 
see Creating a Policy or Editing a Policy, accordingly.

•  Return to Filters Main PageReturn to Filters Main PageReturn to Filters Main PageReturn to Filters Main Page link to display the main Filter ManagerFilter ManagerFilter ManagerFilter Manager page.

Writing
expressions

ExpressionsExpressionsExpressionsExpressions are written in eXtsensible Markup Language (XML), and are built on 
Boolean logic. This topic explains expressions, and provides practical examples to 
help you write Filters with the expression semantics.

Every DbProtect Audit and Threat Management expression consists of two operandstwo operandstwo operandstwo operands 
and one operatorone operatorone operatorone operator. The two operands are the name operand and the value operandvalue operandvalue operandvalue operand. 
The name operands are predefined values that map directly to the SQL Server or 
Oracle Profiler’s data columns, and to special DbProtect Audit and Threat 
Management-defined values. The value operand may be any string, and is notnotnotnot 
restricted by DbProtect Audit and Threat Management; you must supply it.

This topic consists of the following sub-topics:

•  Expression syntax

•  DbProtect AppRadar name attributes

•  SQL Server name attributes

•  DB2 name attributes

•  Sybase name attributes

•  Oracle name attributes

•  Operator attributes

•  Examples.

EXPRESSION SYNTAX

The expr tag contains three attributes: namenamenamename, operatoroperatoroperatoroperator and valuevaluevaluevalue. The syntax is: 
<expr name="X" operator="Y" value="Z"/>
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DBPROTECT APPRADAR NAME ATTRIBUTES

The following table includes valid DbProtect AppRadar name attributesDbProtect AppRadar name attributesDbProtect AppRadar name attributesDbProtect AppRadar name attributes, which are 
common for all Audit and Threat Management expressions across all supported 
database platforms. 

DbProtect 
AppRadar Name 

Attribute
Details

Application Name of the client application that created the connection to an 

instance of a given database type (i.e., Microsoft SQL Server 2000/

2005/2008, DB2, Sybase, or Oracle). This column is populated with 
the values passed by the application rather than the displayed name 
of the program.

ColumnName The name of the column of a table in which the user statement is 
running.

DbUser Database user name.

HostName The name of the machine (host) from which the client application is 
run.

ObjectName Name of the referenced object.

SqlText The SQL text command presented for execution by the client. 

AbsDate (yyyy/
mm/dd)

Absolute date.

DayOfWeek The day of the week.

Date (mm/dd) Date (month and date).

TimeOfDay 

(hh:mm)

Time of day in military time (e.g., 20:00 = 8 P.M.).

RecordsAffected Indicates how many rows have been queried/updated as the result 
of executing a SQL statement; for more information, see 
Understanding result sets.
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SQL SERVER NAME ATTRIBUTES

The following table includes valid MicrosoftMicrosoftMicrosoftMicrosoft SQL Server name attributes SQL Server name attributes SQL Server name attributes SQL Server name attributes (for Microsoft 
SQL Server 2000/2005/2008). An expression can contain SQL Profiler Data Columns, 
and DbProtect Audit and Threat Management-defined values. 

SQL Server Name 
Attribute

Details

ClientProcessID ID assigned by the host computer to the process where the client 
application is running. This data column is populated if the client 
process ID is provided by the client.

DatabaseName Name of the database in which the user statement is running.

Error Indicates if the SQL command yielded an error.

EventSubClass Type of event subclass, providing further information about each 
event class. For example, event subclass values for the Execution Execution Execution Execution 
WarningWarningWarningWarning event class represent the type of execution warning:

• 1 = Query wait. Query wait. Query wait. Query wait. The query must wait for resources (for example, 
memory) before it can execute.

• 2 = Query time out. Query time out. Query time out. Query time out. The query timed out while waiting for 
required resources to execute. This data column is not populated 
for all event classes.

NestLevel The nesting level of the stored procedure call. For example, 
my_proc_a stored procedure calls my_proc_b. In this case, 
my_proc_a has a NestLevel of 1, my_proc_b has a NestLevel 
of 2.

NTUserName Windows NT 4.0 user name.

ObjectOwner User who owns the referenced object.
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ObjectType Value representing the type of the object involved in the event. 
Values are:

For Microsoft SQL Server 2000:For Microsoft SQL Server 2000:For Microsoft SQL Server 2000:For Microsoft SQL Server 2000:

• 1 = Index

• 2 = Database

• 5 = Default

• 8 = Stored Procedure

• 9 = Function

• 10 = Rule

• 12 = System Table

• 13 = Trigger

• 17 = User Table

• 18 = View

• 19 = Extended Stored Procedure

For Microsoft SQL Server 2005 and 2008:For Microsoft SQL Server 2005 and 2008:For Microsoft SQL Server 2005 and 2008:For Microsoft SQL Server 2005 and 2008:

• 8259 = Check Constraint

• 8260 = Default (constraint or standalone)

• 8262 = Foreign-key Constraint

• 8272 = Stored Procedure

• 8274 = Rule

• 8275 = System Table

• 8276 = Trigger on Server

• 8277 = (User-defined) Table

• 8278 = View

• 8280 = Extended Stored Procedure

• 16724 = CLR Trigger

• 16964 = Database

• 16975 = Object

• 17222 = FullText Catalog

• 17232 = CLR Stored Procedure

• 17235 = Schema

• 17475 = Credential

• 17491 = DDL Event

• 17741 = Management Event

• 17747 = Security Event

• 17749 = User Event

SQL Server Name 
Attribute

Details
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ObjectType 

(cont’d)
• 17985 = CLR Aggregate Function

• 17993 = Inline Table-valued SQL Function

• 18000 = Partition Function

• 18002 = Replication Filter Procedure

• 18004 = Table-valued SQL Function

• 18259 = Server Role

• 18263 = Microsoft Windows Group

• 19265 = Asymmetric Key

• 19277 = Master Key

• 19280 = Primary Key

• 19283 = ObfusKey

• 19521 = Asymmetric Key Login

• 19523 = Certificate Login

• 19538 = Role

• 19539 = SQL Login

• 19543 = Windows Login

• 20034 = Remote Service Binding

• 20036 = Event Notification on Database

• 20037 = Event Notification

• 20038 = Scalar SQL Function

• 20047 = Event Notification on Object

• 20051 = Synonym

• 20549 = End Point

• 20801= Adhoc Queries which may be cached

• 20816 = Prepared Queries which may be cached

• 20819 = Service Broker Service Queue

• 20821 = Unique Constraint

• 21057 = Application Role

• 21059 = Certificate

• 21075 = Server

• 21076 = Transact-SQL Trigger

• 21313 = Assembly

• 21318 = CLR Scalar Function

• 21321 = Inline scalar SQL Function

• 21328 = Partition Scheme

• 21333 = User

SQL Server Name 
Attribute

Details
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For more information about SQL Server Profiler Data Columns, see your SQL Server 
documentation.

ObjectType 

(cont’d)
• 21571 = Service Broker Service Contract

• 21572 = Trigger on Database

• 21574 = CLR Table-valued Function

• 21577 = Internal Table (For example, XML Node 

Table, Queue Table.)

• 21581 = Service Broker Message Type

• 21586 = Service Broker Route

• 21587 = Statistics

• 21825, 21827, 21831, 21843, 21847 = User

• 22099 = Service Broker Service

• 22601 = Index

• 22604 = Certificate Login

• 22611 = XMLSchema

• 22868 = Type

Permissions Integer value representing the type of permissions checked. Values 
are:

• 1 = SELECT ALL

• 2 = UPDATE ALL

• 4 = REFERENCES ALL

• 8 = INSERT

• 16 = DELETE

• 32 = EXECUTE (procedures only)

• 4096 = SELECT ANY (at least one column)

• 8192 = UPDATE ANY

• 16384 = REFERENCES ANY

SPID Server Process ID assigned by SQL Server to the process associated 
with the client.

SQLSecurity

LoginName

Name of the login of the user (either SQL Server security login or the 
Windows login credentials in the form of DOMAIN\Username).

StartTime Time when the event started, when available.

Success Indicates if the SQL command yielded ran successfully.

TargetLoginName For actions which target a login (for example, adding a new login), 
the name of the targeted login.

SQL Server Name 
Attribute

Details
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DB2 NAME ATTRIBUTES

The following table includes valid DB2 name attributesDB2 name attributesDB2 name attributesDB2 name attributes. An expression can contain 
these DbProtect Audit and Threat Management-defined values. 

SYBASE NAME ATTRIBUTES

The following table includes valid Sybase name attributesSybase name attributesSybase name attributesSybase name attributes. An expression can contain 
these DbProtect Audit and Threat Management-defined values. 

ORACLE NAME ATTRIBUTES

The following table includes valid Oracle name attributesOracle name attributesOracle name attributesOracle name attributes. 

DB2 Attribute Details

DatabaseName Name of the database in which the user statement is running.

OsUser Name of the login of the operating system user running the 
database client. 

SqlTextSize The size of the SQL text command presented for execution by the 
client.

Sybase Attribute Details

DatabaseName Name of the database in which the user statement is running.

OsUser Name of the login of the operating system user running the 
database client. 

SqlTextSize The size of the SQL text command presented for execution by the 
client.

Oracle Attribute Details

OsUser Name of the login of the operating system user running the 
database client. 

SqlTextSize The size of the SQL text command presented for execution by the 
client.
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OPERATOR ATTRIBUTES

As a general rule, if you know specifically what value to compare, use the equals 
operator. If you need to search by a substring, then the contains operator makes 
more sense. The following table includes valid operator attributes. 

•  equals. . . . This compares the name to the value field. The value must match 
exactly for this expression to be true. This operator is also case-sensitive. For 
example if we have an expression that compares the "DatabaseName" to 
"Human_Resources" as defined in:

<expr name="DatabaseName" value="Human_Resources" 

operator="equals"></expr>

So, when the DatabaseName is: 

-"Human_Resources", the expression is TRUE

-"human_resources", the expression is FALSE

-"Human_Resources_Database", the expression is FALSE

-"Human_Resources " (note extra space at the end), the expression is FALSE

-"Human_Resource", the expression is FALSE.

•  contains. . . . This operator searches for a substring contained in the value. It is 
case insensitive. For example, if you have an expression that compares the 
"DatabaseName" to "Human_Resources" as defined in: 

<expr name="DatabaseName" value="Human_Resources" 

operator="contains"></expr>

Operator Attribute Details

equals Equals.

contains The left operand contains the substring value of 
the right operand.

notEquals Does not equal.

regex Regular expression.

lessThan Less than.

greaterThan Greater than.

lessThanEqual Less than or equal.

greaterThanEqual Greater than equal.
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So, when the DatabaseName is: 

-"Human_Resources", the expression is TRUE

-"human_resources", the expression is TRUE

-"Human_Resources_Database", the expression is TRUE

-"Human_Resources ", the expression is TRUE

-"DBHuman_Resources", the expression is TRUE

-"Human_Resource", the expression is FALSE

-"HR_Database", the expression is FALSE.

•  regex.... This operator is more complicated. It uses the regular expression 
pattern matching language to search for a value. This is a more advanced 
technique for searches, and should be reserved for more complex searches. For 
more information, visit some websites that discuss the regular expression 
language that is heavily used in programming languages such as Perl and Unix 
commands such as sed and grep. For more information, see http://
en.wikipedia.org/wiki/Regular_expression.

•  notEquals.... This operator checks whether two values are different. It has the 
same semantics as the equals operator.

•  lessThan. . . . This operator checks whether one integer value is less than another 
integer value. It does notnotnotnot support real numbers. You cannotcannotcannotcannot apply this operator 
to alphabetic values.

•  greaterThan.This operator checks whether one integer value is greater than 
another integer value. It does notnotnotnot support real numbers. You cannotcannotcannotcannot apply this 
operator to alphabetic values.

•  lessThanEqual.This operator checks whether one integer value is less than, or 
equal to. another integer value. It does notnotnotnot support real numbers. You cannotcannotcannotcannot 
apply this operator to alphabetic values.

•  greaterThanEqual. This operator checks whether one integer value is greater 
than, or equal to, another integer value. It does notnotnotnot support real numbers. You 
cannotcannotcannotcannot apply this operator to alphabetic values.

http://en.wikipedia.org/wiki/Regular_expression
http://en.wikipedia.org/wiki/Regular_expression
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Example:Example:Example:Example:

Below is an example of an XML expression written in the Advanced Filter Editor to 
Filter Rules for three specific databases; for more information, see Working with the 
Advanced Filter and Exception Editor.

<and>

  <or>

    <expr name="DatabaseName" value="Finance" 

operator="equals"></expr>

    <expr name="DatabaseName" value="Human_Resources" 

operator="equals"></expr>

    <expr name="DatabaseName" value="JCRS" operator="equals"></

expr>

  </or>

</and>

The enclosing <and></and> tags are not really necessary in this case. In plain English, 
this statement means: “Show this Alert when the database names are either ‘Finance’, 
‘Human_Resources’, or ‘JCRS’, and ...”

AndAndAndAnd what? Well...nothing. So, you can simplify this expression to:

<or>

  <expr name="DatabaseName" value="Finance" operator="equals"></

expr>

  <expr name="DatabaseName" value="Human_Resources" 

operator="equals"></expr>

  <expr name="DatabaseName" value="JCRS" operator="equals"></

expr>

</or>
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Joining
expressions

You can join expressions  join expressions  join expressions  join expressions to form more complex Rules. Usually just monitoring the 
master database is not granular enough. You may only be interested in monitoring the 
master database in conjunction with the sa account. DbProtect Audit and Threat 
Management provides the boolean and and/or and/or and/or and/or operators as XML tags to represent 
this.

EXAMPLES

Capture only events that are taking place in the master database that are performed 
by the sa account. Notice the use of the <and> tag to combine these two expressions:

<and>

<expr name="DatabaseName" operator="equals" value="master" />

<expr name="SQLSecurityLoginName" operator="equals" 

value="sa" />

</and>

Capture only events that are taking place in the master database and are performed 
by either the sa account, or the itsecurityitsecurityitsecurityitsecurity login (a SQL Server login that exists in this 
example). Note the combination of the <and> and <or> tags to express this Rule:

<and> 

<expr name="DatabaseName" operator="equals" value="master" /> 

<or> 

<expr name="SQLSecurityLoginName" operator="equals" 

value="sa" /> 

<expr name="SQLSecurityLoginName" operator="equals" 

value="itsecurity" /> 

</or> 

</and>
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Editing a Filter To edit a Filter:

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager

2. In the My FiltersMy FiltersMy FiltersMy Filters portion of the page, click the EditEditEditEdit button next to the Filter.

FIGURE: Filter ManagerFilter ManagerFilter ManagerFilter Manager (My FiltersMy FiltersMy FiltersMy Filters portion)

The Advanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception EditorAdvanced Filter and Exception Editor displays, allowing you to edit your Filter; for 
more information, see Working with the Advanced Filter and Exception Editor.
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Deleting a Filter To delete a Filter: 

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager

2. In the My FiltersMy FiltersMy FiltersMy Filters portion of the page:

•  check a Filter you want to delete

•  click the DeleteDeleteDeleteDelete button next to the Filter.

FIGURE: Filter ManagerFilter ManagerFilter ManagerFilter Manager (My FiltersMy FiltersMy FiltersMy Filters portion)
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A confirmation page prompts you to confirm the delete.

FIGURE: Delete confirmation page

3. Click the YesYesYesYes button to delete.

Your Filter is deleted.

Note:Note:Note:Note: After you activate a Filter in a Policy, DbProtect Audit and Threat 
Management does notnotnotnot allow you to delete the Filter. You must de-select 
the Filter from any associated Policy. Then, you mustmustmustmust re-deploy the Policy. 
For more information, see Editing a Policy and Deploying a Policy, 
respectively.
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Importing a Filter To import a Filter:

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager

2. Click the Import Import Import Import button in the Import FilterImport FilterImport FilterImport Filter portion of the page.

The Import File Import File Import File Import File page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager

3. Specify the location of the Filter file (which must be in XML format). You 
can:

•  click the Browse... Browse... Browse... Browse... button to display the File UploadFile UploadFile UploadFile Upload pop up and locate the 
Filter file you want to import (on your local computer or network)
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•  enter the full path and file name of the XML Filter file you want to import (on 
your local computer or network).

Note:Note:Note:Note: Check Import with overwriteImport with overwriteImport with overwriteImport with overwrite to overwrite an existing Filter file 
automatically.

4. Click the ImportImportImportImport button.

DbProtect Audit and Threat Management imports your Filter.

Exporting a Filter To export a Filter: 

1. Do one of the following to display the Filter Manager Filter Manager Filter Manager Filter Manager page:

•  Click the FiltersFiltersFiltersFilters workflow link on the HomeHomeHomeHome page.

•  Click the FiltersFiltersFiltersFilters tab from anywhere on the page.

FFFFIIIIGGGGUUUURRRREEEE: : : : Filter ManagerFilter ManagerFilter ManagerFilter Manager
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2. In the My FiltersMy FiltersMy FiltersMy Filters portion of the page:

•  check one or more Filters that you want to delete

Hint: Check the checkbox (below the Export button) to select all Filters at one 

time.

•  click the ExportExportExportExport button.

FIGURE: Filter ManagerFilter ManagerFilter ManagerFilter Manager (My FiltersMy FiltersMy FiltersMy Filters portion)

The Open MySelectedFilters.xml Open MySelectedFilters.xml Open MySelectedFilters.xml Open MySelectedFilters.xml dialog box displays.

FIGURE: Open MySelectedFilters.xmlOpen MySelectedFilters.xmlOpen MySelectedFilters.xmlOpen MySelectedFilters.xml dialog box

3. Select Save to DiskSave to DiskSave to DiskSave to Disk (default).

Caution! Do not select Open With.

4. Click the OKOKOKOK button.

DbProtect Audit and Threat Management exports your selected Filters as an XML file 
(to your local computer or network).
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Reports
This chapter consists of the following topics:

•  What are Reports?

•  Understanding the Report Manager

•  Report navigation, viewing, and output

•  Scheduling your Reports

•  Understanding the Built-In Auditing Event Summary Report

•  Understanding the Built-In Security Event Summary Report

•  Understanding the Built-In DbProtect AppRadar Monthly Self-Auditing Report

•  Creating a Report template

•  Generating a Report from an existing template

•  Viewing a generated Report

•  Editing a Report template

•  Deleting a generated Report

•  Deleting a Report template

•  Copying a Report template

•  Scheduling a Report.

What are Reports? DbProtect Audit and Threat Management allows you to run ReportsReportsReportsReports on Alerts received 
from registered Sensors. A Report is a tabular and graphical display of the results of a 
query constrained by user-supplied criteria entered during the Report generation 
process.

In order to run a Report you must first create a Report template template template template. After you create a 
Report template, you can either:

•  immediately generate a Report from an existing template; for more 
information, see Generating a Report from an existing template

•  schedule the Report to run later; for more information, see Scheduling a 
Report.

Specifically, you can generate the following DbProtect Audit and Threat Management 
Reports:

•  Auditing Event SummaryAuditing Event SummaryAuditing Event SummaryAuditing Event Summary ReportReportReportReport. This Report provides a weekly summary of all 
audit events; for more information, see Understanding the Built-In Auditing 
Event Summary Report.

•  Security Event SummarySecurity Event SummarySecurity Event SummarySecurity Event Summary ReportReportReportReport. This Report provides a weekly summary of your 
Alerts; for more information, see Understanding the Built-In Security Event 
Summary Report.
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•  AppRadar Monthly Self-Auditing ReportAppRadar Monthly Self-Auditing ReportAppRadar Monthly Self-Auditing ReportAppRadar Monthly Self-Auditing Report. This Report provides detailed 
information about recent activities performed with DbProtect Audit and Threat 
Management; for more information, see Understanding the Built-In DbProtect 
AppRadar Monthly Self-Auditing Report.

Understanding the
Report Manager

The Report ManagerReport ManagerReport ManagerReport Manager is shown below.

FIGURE: Report Manager Report Manager Report Manager Report Manager page

The Report ManagerReport ManagerReport ManagerReport Manager consists of the following portions:

•  View/create/copy. View/create/copy. View/create/copy. View/create/copy. This portion of the Report ManagerReport ManagerReport ManagerReport Manager allows you to:

-view a generated Report; for more information, see Viewing a generated Report

-create a Report template; for more information, see Creating a Report template

-copy a Report template; for more information, see Copying a Report template.

•  Delete buttons.Delete buttons.Delete buttons.Delete buttons. The delete buttons (represented as XXXXs) allow you to delete 
Report templates; for more information, see Deleting a Report template.

•  Template detail. Template detail. Template detail. Template detail. This portion of the Report ManagerReport ManagerReport ManagerReport Manager displays each Report 
template NameNameNameName, TypeTypeTypeType (i.e., SummarySummarySummarySummary or DetailDetailDetailDetail), and a brief DescriptionDescriptionDescriptionDescription.
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•  Action buttons. Action buttons. Action buttons. Action buttons. This portion of the Report ManagerReport ManagerReport ManagerReport Manager allows you to:

-edit a Report template; for more information, see Editing a Report template

-generate a Report from an existing template; for more information, see Generating a 
Report from an existing template

-schedule a Report; for more information, see Scheduling a Report

-delete a Report template; for more information, see Deleting a Report template.

Report navigation,
viewing, and

output

Every DbProtect Audit and Threat Management Report includes a toolbar with 
navigation, viewing, and output buttons.

FIGURE: Report navigation, viewing, and output buttons

These buttons allow you to: 

•  navigate through multiple pages of a Report; for more information, see 
Navigating through multiple pages of a Report

•  view the Report as a single page; for more information, see Viewing your 
Report as one page

•  create a PDF of your Report, for more information, see Creating a PDF of your 
Report (output)

•  export your Report to comma-separated value (CSV) format; for more 
information, see Exporting your Report to CSV (output).

NAVIGATING THROUGH MULTIPLE PAGES OF A REPORT

To navigate through multiple pages of a Report: 

1. DbProtect Audit and Threat Management Reports are sometimes dozens 
or hundreds of pages long. You can click the navigation buttonsnavigation buttonsnavigation buttonsnavigation buttons to move 
forward and backwards through the pages Report. Specifically, you can 
click the:

•  |<|<|<|< button to go backbackbackback to the first page of the Report

•  <<<< button to go backbackbackback one page in the Report

•  >>>>button to go forwardforwardforwardforward one page in the Report

•  >|>|>|>| button to go forwardforwardforwardforward to the last page of the Report.

VIEWING YOUR REPORT AS ONE PAGE

To view your Report as one page:

1. If you want to view your Report as just one page, click the One PageOne PageOne PageOne Page button 
in the viewing and output buttonsviewing and output buttonsviewing and output buttonsviewing and output buttons portion of the Report.
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The navigation buttons no longer display. Your Report displays as just one page. You 
can click the <Back <Back <Back <Back button on your web browser to go back to the multiple page 
Report view.

CREATING A PDF OF YOUR REPORT (OUTPUT)

Note:Note:Note:Note: You mustmustmustmust have Adobe Acrobat installed.

To create a PDF of your Report: 

1. Click the PDFPDFPDFPDF button in the viewing and output buttonsviewing and output buttonsviewing and output buttonsviewing and output buttons portion of the 
Report.

DbProtect Audit and Threat Management generates a PDF of your Report.

Scheduling your
Reports

The Report SchedulingReport SchedulingReport SchedulingReport Scheduling page allows you to schedule how often and when DbProtect 
Audit and Threat Management should generate a selected Report template into a 
Report. 

The Task Frequency: Task Frequency: Task Frequency: Task Frequency: drop-down on the Report SchedulingReport SchedulingReport SchedulingReport Scheduling page allows you to select 
how often you want DbProtect Audit and Threat Management to generate the 
scheduled Report. Your choices are: OnceOnceOnceOnce, DailyDailyDailyDaily, WeeklyWeeklyWeeklyWeekly, and MonthlyMonthlyMonthlyMonthly. The Date Date Date Date 
Settings Settings Settings Settings portion of the Report SchedulingReport SchedulingReport SchedulingReport Scheduling page allows you to enter the exact dates 
and times when the scheduled Report should begin and end. The following table 
explains different job frequency scenarios. 

If you specify: Then:

• Task FrequencyTask FrequencyTask FrequencyTask Frequency = DAILY

• Start DateStart DateStart DateStart Date = 10/01/06

• End DateEnd DateEnd DateEnd Date = 12/31/06

• Start TimeStart TimeStart TimeStart Time = 10:00 A.M.

DbProtect Audit and Threat Management first 
generates your Report at 10:00 A.M. on October 
1, 2006, then generates a new Report every day 
(i.e., on October 2, 3, 4, 5, 6, 7, and so on) at 
10:00 A.M., until the end date, i.e., December 
31, 2006.

• Task FrequencyTask FrequencyTask FrequencyTask Frequency = WEEKLY

• Start DateStart DateStart DateStart Date = 10/01/06

• End DateEnd DateEnd DateEnd Date = 12/31/06

• Start TimeStart TimeStart TimeStart Time = 10:00 A.M.

DbProtect Audit and Threat Management first 
generates your Report at 10:00 A.M. on October 
1, 2006, then generates a new Report every 
week (i.e., on October 8, 15, 22, and so on) at 
10:00 A.M., until the end date, i.e., December 
31, 2006.

• Task FrequencyTask FrequencyTask FrequencyTask Frequency = MONTHLY

• Start DateStart DateStart DateStart Date = 10/01/06

• End DateEnd DateEnd DateEnd Date = 12/31/06

• Start TimeStart TimeStart TimeStart Time = 10:00 A.M.

DbProtect Audit and Threat Management first 
generates your Report at 10:00 A.M. on October 
1, 2006, then generates a new Report every 
month (i.e., on November 1 and December 1) at 
10:00 A.M., until the end date, i.e., December 
31, 2006.
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For more information, see Scheduling a Report.

EXPORTING YOUR REPORT TO CSV (OUTPUT)

You can save your Report in CSV format, or open it with the default application 
associated with the .csv extension (typically Excel).

Note:Note:Note:Note: Excel cannot handle more than 65,536 rows of data. If your Report exceeds 
this size, you can select to save the .csv file to your hard drive or network, 
and open it with another application of your choice.

To export your Report to CSV: 

1. Click the CSVCSVCSVCSV button in the viewing and output buttonsviewing and output buttonsviewing and output buttonsviewing and output buttons portion of the 
Report.

If Excel is the default application associated with the .csv extension, then Excel 
launches automatically and displays your Report data.

Understanding the
Built-In Auditing
Event Summary

Report

The Auditing Event SummaryAuditing Event SummaryAuditing Event SummaryAuditing Event Summary ReportReportReportReport is a built-in summary Report. It provides a weekly 
summary of all your audit events.

FFFFIIIIGGGGUUUURRRREEEE: : : : Auditing Event Summary ReportAuditing Event Summary ReportAuditing Event Summary ReportAuditing Event Summary Report
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The navigation, viewing, and output buttons at the top of the Report allow you to 
navigate through multiple pages of a Report, view the Report as a single page, create 
a PDF of your Report, and export your Report to CSV; for more information, see Report 
navigation, viewing, and output.

Understanding the
Built-In Security
Event Summary

Report

The Security Event SummarySecurity Event SummarySecurity Event SummarySecurity Event Summary ReportReportReportReport is a built-in summary Report. It provides a weekly 
summary of your Alerts.

FFFFIIIIGGGGUUUURRRREEEE: : : : Security Event Summary ReportSecurity Event Summary ReportSecurity Event Summary ReportSecurity Event Summary Report

The navigation, viewing, and output buttons at the top of the Report allow you to 
navigate through multiple pages of a Report, view the Report as a single page, create 
a PDF of your Report, and export your Report to CSV; for more information, see Report 
navigation, viewing, and output.
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Understanding the
Built-In DbProtect
AppRadar Monthly

Self-Auditing
Report

The DbProtect AppRadar Monthly Self-Auditing Report DbProtect AppRadar Monthly Self-Auditing Report DbProtect AppRadar Monthly Self-Auditing Report DbProtect AppRadar Monthly Self-Auditing Report is a built-in detail Report.    It 
provides detailed information about recent activities performed with DbProtect Audit 
and Threat Management.

Note:Note:Note:Note: The Records Affected: Records Affected: Records Affected: Records Affected: rows are result sets, which refer to the number of 
records returned as the result of executing a SQL statement; for more 
information, see Understanding result sets. When DbProtect Audit and 
Threat Management stores identical SQL statements, and their Risk Level: Risk Level: Risk Level: Risk Level: 
is Info-1Info-1Info-1Info-1, Info-2Info-2Info-2Info-2, or Info-3 Info-3 Info-3 Info-3, then DbProtect AppRadar aggregates the 
Records Affected:Records Affected:Records Affected:Records Affected:.

FFFFIIIIGGGGUUUURRRREEEE: : : : DbProtect AppRadar Monthly Self-Auditing ReportDbProtect AppRadar Monthly Self-Auditing ReportDbProtect AppRadar Monthly Self-Auditing ReportDbProtect AppRadar Monthly Self-Auditing Report

The navigation, viewing, and output buttons at the top of the Report allow you to 
navigate through multiple pages of a Report, view the Report as a single page, create 
a PDF of your Report, and export your Report to CSV; for more information, see Report 
navigation, viewing, and output.
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Creating a Report
template

To create a Report template: 

Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the Create Create Create Create button in the Report ManagerReport ManagerReport ManagerReport Manager portion of the page.

The next Report ManagerReport ManagerReport ManagerReport Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

3. Select whether you want to create a template for a Summary ReportSummary ReportSummary ReportSummary Report or a 
Details ReportDetails ReportDetails ReportDetails Report; for more information, see What are Reports?
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4. Click the NextNextNextNext button.

The next Report Manager Report Manager Report Manager Report Manager page displays (the same page for either Report type 
selected).

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

5. This page allows you to specify Report criteria used to constrain which 
Alerts are included in your Report. It consists of the following portions:

•  Specify the scope of your Report. Specify the scope of your Report. Specify the scope of your Report. Specify the scope of your Report. This portion of the page allows you to 
highlight which applications you want to run your Report on, answering the 
question: “what Alerts have these applications triggered?” 

You can move applications from the Application Available: Application Available: Application Available: Application Available: scroll-down box to 
the Selected Applications: Selected Applications: Selected Applications: Selected Applications: scroll-down box, or vice versa, by highlighting an 
application and clicking the <<<<<<<<<<<< or >>>>>>>>>>>> button. Clicking the >>> >>> >>> >>> button adds 
the highlighted application to the list of applications to Report on. Clicking the 
<<<<<<<<<<<< button removes the highlighted application from the list of applications to 
Report on.

Hint: Click the Select All>>> button to move all applications from the 

Applications Available: scroll-down box to the Selected Applications: 

scroll-down box. Or, click the <<<Clear All button to move all applications 

from the Selected Applications: scroll-down box back to the 

Applications Available: scroll-down box.
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•  Specify a date range. Specify a date range. Specify a date range. Specify a date range. This portion of the page allows you to specify a Reporting 
date range. You can select:

----TodayTodayTodayToday

----Current WeekCurrent WeekCurrent WeekCurrent Week

----Current MonthCurrent MonthCurrent MonthCurrent Month

----Current YearCurrent YearCurrent YearCurrent Year

----Past 7-daysPast 7-daysPast 7-daysPast 7-days

----Past 30-daysPast 30-daysPast 30-daysPast 30-days

----Past 365-daysPast 365-daysPast 365-daysPast 365-days

-Custom RangeCustom RangeCustom RangeCustom Range.

If you select Custom Range, then you must enter a date range (down to a second) 

in the From: and To: fields, using the format mm/dd/yyyy hh:mm:ss.

Hint: You can click the calendar icons next to the From: and To: fields to display 

a calendar pop up and select your "from" and "to" dates in the date range.

•  Include Alerts.Include Alerts.Include Alerts.Include Alerts. This portion of the page allows you to select to Report on Alerts 
that are:

----Current (Not Archived)Current (Not Archived)Current (Not Archived)Current (Not Archived)

----ArchivedArchivedArchivedArchived

-BothBothBothBoth.

•  Show.Show.Show.Show. This portion of the page allows you to specify which database platforms 
you want to Report on (or notnotnotnot Report on). For example, maybe you only want to 
know about Oracle Alerts. You can also select AppRadar SystemAppRadar SystemAppRadar SystemAppRadar System if you want to 
know about system Alerts.

•  Find tool.Find tool.Find tool.Find tool. This portion of the page allows you to enter a search term in the text 
box, then click the FindFindFindFind button.
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6. Click the NextNextNextNext button.

The next Report Manager Report Manager Report Manager Report Manager page displays (the same page for both Report types). The 
left half of the page looks like this:

FFFFIIIIGGGGUUUURRRREEEE: : : : Report Manager Report Manager Report Manager Report Manager (left half of the page)
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The right half right half right half right half of the page looks like this:

FIGURE: Report Manager Report Manager Report Manager Report Manager (right half of the page)

The Report Manager Report Manager Report Manager Report Manager page allows you to specify Report criteria used to constrain 
which Alerts are included in your Report. Specifically, you must specify criteria in the 
following sections:

•  Database Logins/Users.Database Logins/Users.Database Logins/Users.Database Logins/Users. Allows you to highlight login/users to Report on, i.e., 
who logged in to the database, with or without success?

•  Network Users. Network Users. Network Users. Network Users. Allows you to highlight specific network users to Report on, i.e., 
did a specific network user generate Alerts?

•  Client Application. Client Application. Client Application. Client Application. Allows you to highlight which applications you want to 
Report on, i.e., which client applications generated Alerts?

•  Source of Event. Source of Event. Source of Event. Source of Event. Allows you to highlight which database client computer you 
want to report on, i.e., on which database client computer did Alerts originate?

•  Alert Titles.Alert Titles.Alert Titles.Alert Titles. Allows you to highlight which specific Alerts you want to Report on.

Hint: Click the Clear Selections button to clear your highlighted selections.

•  Risk Level.Risk Level.Risk Level.Risk Level. Select a risk level for the audit event, i.e., InformationalInformationalInformationalInformational (i.e., Info-1Info-1Info-1Info-1, 
Info-2Info-2Info-2Info-2, Info-3Info-3Info-3Info-3, and Info-4Info-4Info-4Info-4).
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Note:Note:Note:Note: The InformationalInformationalInformationalInformational risk levels are typically for audit events. Audit events are 
written to a table in the DbProtect database, but not displayed on the 
Alert ManagerAlert ManagerAlert ManagerAlert Manager page on the UI. For more information, see What do the risk 
levels mean? If you check an InformationalInformationalInformationalInformational risk level checkbox (and 
depending on which Policies you have deployed) it may take a while to run 
your Reports because of the volume of data the DbProtect Audit and 
Threat Management reporting engine needs to process.

Hint: Click the Clear All button to clear your checked selections.

•  Records Affected.Records Affected.Records Affected.Records Affected. Use the drop-down to select how many affected records you 
want to Report on. Or enter a value in the Records AffectedRecords AffectedRecords AffectedRecords Affected field.

Note:Note:Note:Note: This row is a result set, which refers to the number of records returned as 
the result of executing a SQL statement; for more information, see 
Understanding result sets. For queries that join multiple tables, Records Records Records Records 
AffectedAffectedAffectedAffected represents the number of rows the query retrieves. DbProtect 
Audit and Threat Management does notnotnotnot break down results by table. For 
example, if you run a query that joins your CUSTOMER table to your CREDIT 
CARD table, and the Records AffectedRecords AffectedRecords AffectedRecords Affected indicates five rows, you can interpret 
this result to mean five customers with one credit card, or one customer 
with five credit cards.

•  Application Types. Application Types. Application Types. Application Types. Allows you to check one or more risk levels to Report on, i.e., 
MicrosoftMicrosoftMicrosoftMicrosoft SQL Server 2000SQL Server 2000SQL Server 2000SQL Server 2000/2005/20082005/20082005/20082005/2008, OracleOracleOracleOracle, SybaseSybaseSybaseSybase, DB2DB2DB2DB2, or AppRadarAppRadarAppRadarAppRadar. You 
mustmustmustmust check at least one checkbox.

•  Sort Order.Sort Order.Sort Order.Sort Order. Allows you to specify how you want to display your Report data.

-First field:First field:First field:First field:. and Second field:Second field:Second field:Second field: Use these drop-downs to select which data you want to 
display in the first field of your Report. Your choices are: CountCountCountCount, Alert TitleAlert TitleAlert TitleAlert Title, RiskRiskRiskRisk, SourceSourceSourceSource, 
First OccurrenceFirst OccurrenceFirst OccurrenceFirst Occurrence, Last OccurrenceLast OccurrenceLast OccurrenceLast Occurrence, and ContextContextContextContext.

•  Ascending Ascending Ascending Ascending and Descending Descending Descending Descending. Use these drop-downs to select whether you want 
your Report data to display in ascending or descending order, respectively.
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7. Click the NextNextNextNext button.

The next Report ManagerReport ManagerReport ManagerReport Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

8. This page allows you to enter descriptive information about the Exception.

•  *Report Name *Report Name *Report Name *Report Name (required field).    Enter the Report template name. There are no 
strict naming restrictions for Exceptions, other than size limit and alphanumeric 
characters.

•  Description. Description. Description. Description. Enter a Report template description.

9. At this point, the Report ManagerReport ManagerReport ManagerReport Manager has enough information to save your 
Report template. The buttons at the bottom of this page allow you to go 
back and change settings, save your Report template and generate the 
Report later, or save the Report template and generate the Report now.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report Manager Report Manager Report Manager Report Manager buttons

•  If you want to review or change any settings you can click the BackBackBackBack button or 
any link that displays on the page.
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•  If you are satisfied with your settings and you want to save your Report template 
and generate a Report later, then click the SaveSaveSaveSave button. Your Report template is 
saved. The main Report ManagerReport ManagerReport ManagerReport Manager page displays your Report template. You can 
click the Generate ReportGenerate ReportGenerate ReportGenerate Report button to generate the Report at any time; for more 
information, see Generating a Report from an existing template.

•  If you are satisfied with your settings and you want to save your Report template 
and generate a Report now, then click the Save & Generate Save & Generate Save & Generate Save & Generate button.

DbProtect Audit and Threat Management displays your Report results on a separate 
page; for more information, see Report navigation, viewing, and output.

Generating a
Report from an

existing template

To generate a Report from an existing template: 

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the Generate Report Generate Report Generate Report Generate Report action button next to a Report template.

FIGURE: ActionActionActionAction buttons

DbProtect Audit and Threat Management displays your Report results on a separate 
page; for more information, see Report navigation, viewing, and output.
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Viewing a
generated Report

To view a generated Report: 

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the ViewViewViewView button.

The Completed ReportsCompleted ReportsCompleted ReportsCompleted Reports page displays your scheduled Reports, i.e., Reports that you 
scheduled from a template, notnotnotnot ad hoc Reports; for more information, see Scheduling 
a Report.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

3. Click the View ReportView ReportView ReportView Report button next to the generated Report that you want 
to view.

DbProtect Audit and Threat Management displays your Report results on a separate 
page; for more information, see Report navigation, viewing, and output.



DbProtect 6.1 User’s Guide

Application Security, Inc. 437

Editing a Report
template

To edit a Report template: 

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

Assuming you've created Report templates, they display, too. If you have notnotnotnot created a 
Report template, see Creating a Report template.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the EditEditEditEdit action button next to a Report template.

FIGURE: ActionActionActionAction buttons

The next Report ManagerReport ManagerReport ManagerReport Manager displays your existing Report criteria. Now you can edit your 
Report template criteria as if you were creating a new Report template; for more 
information, see Creating a Report template.
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Deleting a
generated Report

To delete a generated Report: 

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the ViewViewViewView button.

The AppRadar Completed ReportsAppRadar Completed ReportsAppRadar Completed ReportsAppRadar Completed Reports page displays all your generated Reports, i.e., 
Reports that you scheduled from a template; for more information, see Scheduling a 
Report.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

3. Check the generated Report(s) that you want to delete.
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4. Click the Delete Selected Reports Delete Selected Reports Delete Selected Reports Delete Selected Reports button.

A pop up prompts you to confirm the delete.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

5. Click the OKOKOKOK button to delete. 

Your selected generated Report(s) is/are deleted.

Deleting a Report
template

To delete a Report template:

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the XXXX button next to the Report template you want to delete.

A confirmation page prompts you to confirm the delete.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager
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3. Click the YesYesYesYes button to delete.

Your Report template is deleted.

Copying a Report
template

To copy a Report template:

1. Do one of the following:

•  Click the Report ManagerReport ManagerReport ManagerReport Manager workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

The Report ManagerReport ManagerReport ManagerReport Manager page displays.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Use the template drop-down to select which existing Report template you 
want to copy.

3. Enter the new Report name in the asasasas field (e.g., Copy of Audit Event 
Summary Template).

4. Click the CopyCopyCopyCopy button to copy the Report template under the name 
specified in Step 3.

Your copied Report displays on the Report ManagerReport ManagerReport ManagerReport Manager list of available Reports. You can 
now edit the copied Report template to differentiate it from the original Report 
template; for more information, see Editing a Report template.
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Scheduling a
Report

To schedule a Report: 

1. Do one of the following to display the Report ManagerReport ManagerReport ManagerReport Manager page:

•  Click the Reports Reports Reports Reports workflow link on the HomeHomeHomeHome page.

•  Click the ReportsReportsReportsReports tab from anywhere on the page.

For more information, see Understanding the Report Manager.

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager

2. Click the Schedule Schedule Schedule Schedule action button next to a Report template.

FIGURE: ActionActionActionAction buttons
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The Report SchedulingReport SchedulingReport SchedulingReport Scheduling page displays.

FIGURE: Report Scheduling Report Scheduling Report Scheduling Report Scheduling page

3. The Report Scheduling Report Scheduling Report Scheduling Report Scheduling page allows you to schedule how often and when 
DbProtect Audit and Threat Management should generate the selected 
Report template into a Report. You can also email others as soon as 
DbProtect Audit and Threat Management successfully generates the 
Report, attach the Report itself to an email, and more. Specifically, you 
must specify scheduling criteria in the following portions:

•  Job Frequency.Job Frequency.Job Frequency.Job Frequency. Use the Task Frequency: Task Frequency: Task Frequency: Task Frequency: drop-down to select how often you 
want DbProtect Audit and Threat Management to generate the scheduled 
Report. Your choices are: OnceOnceOnceOnce, DailyDailyDailyDaily, WeeklyWeeklyWeeklyWeekly, and MonthlyMonthlyMonthlyMonthly. For more 
information, see Scheduling your Reports.

•  Date Settings. Date Settings. Date Settings. Date Settings. Enter the exact dates when the scheduled Report should begin 
and end in the Start Date: Start Date: Start Date: Start Date: and End Date: End Date: End Date: End Date: fields, respectively. You must use the 
mm/dd/yyyy format (e.g., 01/01/2007). Also enter the exact time when the 
scheduled Report should begin. You must use the 24 hour HH:MM format (e.g., 
18:00 = 6 P.M.). For more information, see Scheduling your Reports.
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•  Email. Email. Email. Email. This portion of the Report SchedulingReport SchedulingReport SchedulingReport Scheduling page consists of the following:

-Notify via Email:Notify via Email:Notify via Email:Notify via Email:. Check this box to indicate you want DbProtect Audit and Threat 
Management to email the people in the Recipients: Recipients: Recipients: Recipients: field as soon as DbProtect Audit 
and Threat Management successfully generates your Report. 

-Recipients:Recipients:Recipients:Recipients:. Enter your comma-separated list of email addresses in this field, e.g., 
jsmith@company.com, ajones@company.com, etc.

Caution! Your list of email addresses cannot exceed 256 characters.

•  Subject:Subject:Subject:Subject:. You mustmustmustmust enter an email subject. The default subject text is: 
DbProtect AppRadar generated Report now available: <Report Name 

Here> where <Report Name Here> is the name of your Report template. You 
can overwrite this text.

•  Optional Message:Optional Message:Optional Message:Optional Message:. Optionally, you can enter a message that will display in the 
body of the email to your recipients. The default message text is: 

The Report named, <Report Name Here>, has been generated by 

DbProtect AppRadar. Please find it attached here or you can log 

into DbProtect AppRadar and view it at:

Note:Note:Note:Note: DbProtect Audit and Threat Management automatically appends a Report link to this 
default message.

<Report Name Here> is the name of your Report template. You can overwrite 

this text. 

•  Link to Report (no attachment)Link to Report (no attachment)Link to Report (no attachment)Link to Report (no attachment). Select to append a Report link to your email.

•  Attached PDFAttached PDFAttached PDFAttached PDF. Select to attach the generated Report to your email as a PDF.

•  Attached CSVAttached CSVAttached CSVAttached CSV. Select to attach the generated Report to your email as a comma-
separated values (CSV) file.

4. When you’re done, click the ScheduleScheduleScheduleSchedule button at the bottom of the page.

The Report ManagerReport ManagerReport ManagerReport Manager re-displays. A message in red text displays below the scheduled 
Report template, i.e., next scheduled run: <mm/dd/yy> <hh:mm:ss> <your time zone>

FFFFIIIIGGGGUUUURRRREEEE: : : : Report ManagerReport ManagerReport ManagerReport Manager
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System Settings: Email 
Forwarding Rules, Forwarding 
Settings, Email Server 
Settings
This chapter consists of the following topics:

•  What are system settings?

•  Understanding the System Settings page

•  Email Forwarding Rules

•  Forwarding Settings

•  Email Server Settings.

What are system
settings?

System settingsSystem settingsSystem settingsSystem settings refer to the following:

•  Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules. Allow you to email Alerts instead of (or in addition to) 
using the SNMP trap, file, or Syslog methods specified during the 
configuration/deployment of an instance for a registered Sensor; for more 
information, see Email Forwarding Rules.

•  Forwarding Settings. Forwarding Settings. Forwarding Settings. Forwarding Settings. Allow you to specify the polling frequencypolling frequencypolling frequencypolling frequency (i.e., the 
interval between each successive check for Alerts to be forwarded via email) 
and the maximum number of Alerts to handlemaximum number of Alerts to handlemaximum number of Alerts to handlemaximum number of Alerts to handle (i.e., if the number of Alerts is 
exceeded, Audit and Threat Management does notnotnotnot send an email); for more 
information, see Forwarding Settings.

•  Email Server Settings. Email Server Settings. Email Server Settings. Email Server Settings. Allow you to configure email server properties (e.g., 
outbound SMTP server name and port number, maximum attachment size, etc.) 
to accommodate the forwarding of Alerts and Reports via email; for more 
information, see Email Server Settings.
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Understanding the
System Settings

page

The System Settings System Settings System Settings System Settings page is shown below.

FIGURE: System SettingsSystem SettingsSystem SettingsSystem Settings page

Different System Settings System Settings System Settings System Settings sub----pages display, depending on which tab you click. For 
example, if you click the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules tab, the Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules sub-
page displays.

FIGURE: System SettingsSystem SettingsSystem SettingsSystem Settings page tabs

These System SettingsSystem SettingsSystem SettingsSystem Settings sub-pages allow you to configure Email Forwarding Rules, 
forwarding settings, and email server settings. For more information, see What are 
system settings?.

For specific information on configuring:

•  Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules, see Email Forwarding Rules

•  Forwarding SettingForwarding SettingForwarding SettingForwarding Setting, see Forwarding Settings

•  Email Server SettingsEmail Server SettingsEmail Server SettingsEmail Server Settings, see Email Server Settings.
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Email Forwarding
Rules

Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules allow you to email Alerts, instead of (or in addition to) the 
SNMP trap, file, or Syslog methods specified during the configuration/deployment of 
an instance for a registered Sensor (for more information, see Configuring a Sensor 
and deploying the configuration information).

Each Email Forwarding RuleEmail Forwarding RuleEmail Forwarding RuleEmail Forwarding Rule specifies user-defined criteria for forwarding Alerts via 
email. When the Email Forwarding Rule is activated, and these criteria are met, Audit 
and Threat Management emails the Alerts to your list of recipients (also specified in 
your Email Forwarding Rule).

Note:Note:Note:Note: DbProtect Audit and Threat Management does notnotnotnot allow you to email 
forward Alerts with a risk level of InfoInfoInfoInfo. You must elevate the risk level of a 
rule in a Policy to LowLowLowLow, MediumMediumMediumMedium, or HighHighHighHigh if you want to email forward 

Alerts. For more information, see Editing a Policy and What do the risk 

levels mean?

Important: Email Forwarding Rules work onlyonlyonlyonly works after you properly configure your 

email server; for more information, see Email Server Settings.

This topic assumes you understand Simple Mail Transfer Protocol (SMTP) server 
technology.

This topic consists of the following sub-topics:

•  Understanding the Email Forwarding Rules sub-page

•  Creating a new Email Forwarding Rule

•  Modifying an Email Forwarding Rule

•  Deleting an Email Forwarding Rule

•  Activating/deactivating an Email Forwarding Rule.
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UNDERSTANDING THE EMAIL FORWARDING RULES SUB-

PAGE

The Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules sub-page is shown below.

FIGURE: Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules sub-page

The Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules sub-page displays your existing Email Forwarding Rules. 
Specifically, for each Rule, this sub-page displays the following attributes:

•  the NameNameNameName of the Email Forwarding Rule

•  the StateStateStateState of the Email Forwarding Rule (i.e., ActivatedActivatedActivatedActivated or DeactivatedDeactivatedDeactivatedDeactivated)

Hint: The color-coded icon to the left of each Email Forwarding Rules also 

indicate the state of the rule. Red means the Rule is Inactive. Green 

means the Rule is Active.

•  the Time RangeTime RangeTime RangeTime Range of the Email Forwarding Rule (you can configure an Email 
Forwarding Rule to take effect only during a specified time period, e.g., 10 P.M. 
to 6 A.M.)

•  which Risk LevelsRisk LevelsRisk LevelsRisk Levels the Email Forwarding Rule is configured to send emails about 
(i.e., High and/or Medium and/or Low).

Note:Note:Note:Note: DbProtect Audit and Threat Management does notnotnotnot allow you to email 
forward Alerts with a risk level of InfoInfoInfoInfo. You must elevate the risk level of a 
rule in a Policy to LowLowLowLow, MediumMediumMediumMedium, or HighHighHighHigh if you want to email forward 
Alerts. For more information, see Editing a Policy and What do the risk 
levels mean?

The Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules sub-page allows you to:

•  createcreatecreatecreate a new Email Forwarding Rule; for more information, see Creating a new 
Email Forwarding Rule

•  modifymodifymodifymodify Email Forwarding Rules; for more information, see Modifying an Email 
Forwarding Rule

•  deletedeletedeletedelete Email Forwarding Rules; for more information, see Deleting an Email 
Forwarding Rule
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•  activate/deactivateactivate/deactivateactivate/deactivateactivate/deactivate Email Forwarding Rules; for more information, see 
Activating/deactivating an Email Forwarding Rule.

CREATING A NEW EMAIL FORWARDING RULE

To create an Email Forwarding Rule:

1. Do the following to display the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules tab.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page

2. Click the Create a new Email Forwarding Rule Create a new Email Forwarding Rule Create a new Email Forwarding Rule Create a new Email Forwarding Rule link at the bottom of the 
page to display the first Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page.

FIGURE: First Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page
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Note:Note:Note:Note: If you have not created any Email Forwarding Rules, this page displays by 
default.

The first Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page allows you to specify an Email Forwarding Rule 
template name, and a list of email recipients.

Enter the:

•  name of your Email Forwarding Rule in the Template Name: Template Name: Template Name: Template Name: field, e.g., HIGH 
RISK ALERTS FOR DBA GROUP AND CTO

•  email addresses of your email recipients in the Forward To:Forward To:Forward To:Forward To: field, e.g., 
user@company.com

Caution! You must enter each email address on a separate line. Do not 

separate the email addresses with commas.

3. Click the NextNextNextNext button.

The next Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page displays.

FIGURE: Second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page
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4. In the Select one or more aliases below:Select one or more aliases below:Select one or more aliases below:Select one or more aliases below: portion of the second Email Email Email Email 
Forwarding Rules Forwarding Rules Forwarding Rules Forwarding Rules page, select the alias of the database instance where you 
registered a Sensor.

Only Alerts on this database instance will trigger your Email Forwarding Rule. You can 
select the default (ALLALLALLALL) if you want Alerts on all database instance aliases to trigger 
your Email Forwarding Rule.

FIGURE: Select one or more aliases below:Select one or more aliases below:Select one or more aliases below:Select one or more aliases below: portion

Hint: Press <SHIFT> to highlight multiple aliases. Press <CTRL> to highlight 

multiple non-consecutive aliases. Click the Clear Selections button to 

clear your alias selections.

For more information on configuring and deploying Sensors, see Configuring a Sensor 
and deploying the configuration information.

5. In the Alert TitlesAlert TitlesAlert TitlesAlert Titles portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page, 
select which Alerts will trigger your Email Forwarding Rule. Use the scroll-
down box to highlight one or more Alerts. You can select the default (ALLALLALLALL) 
if you want all Alerts to trigger your Email Forwarding Rule.

FIGURE: Alert Titles Alert Titles Alert Titles Alert Titles portion
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Hint: Press <SHIFT> to highlight multiple consecutive Alerts. Press <CTRL> to 

highlight multiple non-consecutive Alerts. Click the Clear Selections 

button to clear your Alert selections.

6. In the Specify a time range:Specify a time range:Specify a time range:Specify a time range: portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules 
page, you can specify a time rangetime rangetime rangetime range for your Email Forwarding Rule. (For 
example, perhaps you only want Alerts that occur between the hours of 
midnight to 6:59 A.M. to trigger your Email Forwarding Rule.)

FIGURE: Specify a time range: Specify a time range: Specify a time range: Specify a time range: portion

If you select:

•  Any timeAny timeAny timeAny time, then any Alerts specified in Step 6 will trigger your Email Forwarding 
Rule -- 24 hours a day

•  Custom rangeCustom rangeCustom rangeCustom range, then enter a military time range in the From: From: From: From: and To: To: To: To: fields, 
using the format hh:mm. For example, if you only want Alerts that occur 
between the hours of midnight to 6:59 A.M. to trigger your Email Forwarding 
Rule, then enter 00:00 and 06:59 in the From: From: From: From: and To: To: To: To: fields, respectively.

7. In the Effective Risk Levels Effective Risk Levels Effective Risk Levels Effective Risk Levels portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules 
page, you can specify which Risk LevelsRisk LevelsRisk LevelsRisk Levels are associated with your Email 
Forwarding Rule.

FIGURE: Effective Risk Levels Effective Risk Levels Effective Risk Levels Effective Risk Levels portion

You can check one (minimum) or more of the following:

•  HighHighHighHigh

•  MediumMediumMediumMedium

•  LowLowLowLow.
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Note:Note:Note:Note: DbProtect Audit and Threat Management does notnotnotnot allow you to email 
forward Alerts with a risk level of InfoInfoInfoInfo. You must elevate the risk level of a 
rule in a Policy to LowLowLowLow, MediumMediumMediumMedium, or HighHighHighHigh if you want to email forward 

Alerts; for more information, see Editing a Policy and What do the risk 

levels mean?

8. Click the NextNextNextNext button.

The third Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page displays.

FIGURE: Third Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page

Two scroll-down boxes display: Possible FieldsPossible FieldsPossible FieldsPossible Fields and Fields To SendFields To SendFields To SendFields To Send. These scroll-down 
boxes allow you to select which Alert fields and values should display in each 
forwarded email Alert.

Note:Note:Note:Note: Application Security, Inc. recommends that you include, at a minimum, the 
Alert TitleAlert TitleAlert TitleAlert Title and Risk LevelRisk LevelRisk LevelRisk Level fields in your forwarded email Alerts.

You can move fields from the Possible FieldsPossible FieldsPossible FieldsPossible Fields scroll-down box to the Fields To SendFields To SendFields To SendFields To Send 
scroll-down box, or vice versa, by highlighting the field name and clicking either the 
<<<<<<<<<<<< or >>>>>>>>>>>> button. Clicking the >>> >>> >>> >>> button adds the highlighted Alert fields and 
values to the list of Alert fields and values to be displayed in an email Alert. Clicking 
the <<<<<<<<<<<< button removes the highlighted Alert fields and values from the list of Alert 
fields and values to be displayed in an email Alert.

Note:Note:Note:Note: Press <SHIFT> to highlight multiple consecutive fields. Press <CTRL> to 
highlight multiple non-consecutive fields. Click the Select All >>> button 
to move all fields in the Possible Fields scroll-down box to the Fields To 
Send scroll-down box.
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9. Click the NextNextNextNext button.

The Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules summary page displays.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules summary    page

If you:

•  want to review or change any Email Forwarding Rule settings, you can click the 
BackBackBackBack button or any link that displays on the page

•  are satisfied with your Email Forwarding Rule settings, click the SaveSaveSaveSave button.

Your Email Forwarding Rule is saved. A confirmation page displays.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules confirmation    page

10.From the confirmation page, you can click the:

•  first herehereherehere link to display the Global PropertiesGlobal PropertiesGlobal PropertiesGlobal Properties sub-page, which allows you to 
specify your Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings; for more information, see    Forwarding 
Settings

•  second herehereherehere link to display the Email Server Settings Email Server Settings Email Server Settings Email Server Settings sub-page, which allows 
you to configure your email server to accommodate the forwarding of Alerts 
and Reports via email; for more information, see Email Server Settings

•  third herehereherehere link to display the first Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page.
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MODIFYING AN EMAIL FORWARDING RULE

To modify an Email Forwarding Rule:

1. Do the following to display the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules tab.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page

2. Click the Modify Modify Modify Modify button next to an existing Rule to display the first Email Email Email Email 
Forwarding Rules Forwarding Rules Forwarding Rules Forwarding Rules page.

FIGURE: First Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page

The first Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page allows you to modify an Email Forwarding Rule 
template name, and a list of email recipients.
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Modify the:

•  name of your Email Forwarding Rule in the Template Name: Template Name: Template Name: Template Name: field, e.g., HIGH 
RISK ALERTS FOR DBA GROUP AND CTO

•  email addresses of your email recipients in the Forward To:Forward To:Forward To:Forward To: field, e.g., 
user@company.com.

Caution! You must enter each email address on a separate line. Do not 

separate the email addresses with commas.

3. Click the NextNextNextNext button.

The second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page displays.

FIGURE: Second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page
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4. In the Select one or more aliases below:Select one or more aliases below:Select one or more aliases below:Select one or more aliases below: portion of the second Email Email Email Email 
Forwarding Rules Forwarding Rules Forwarding Rules Forwarding Rules page, modify the alias of the database instance where 
you registered a Sensor.

Only Alerts on this database instance will trigger your Email Forwarding Rule. You can 
select the default (ALLALLALLALL) if you want Alerts on all database instance aliases to trigger 
your Email Forwarding Rule.

FIGURE: Select one or more aliases below:Select one or more aliases below:Select one or more aliases below:Select one or more aliases below: portion

Hint: Press <SHIFT> to highlight multiple aliases. Press <CTRL> to highlight 

multiple non-consecutive aliases. Click the Clear Selections button to 

clear your alias selections.

For more information on configuring and deploying Sensors, see Configuring a Sensor 
and deploying the configuration information.
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5. In the Alert TitlesAlert TitlesAlert TitlesAlert Titles portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page, 
modify which Alerts will trigger your Email Forwarding Rule. Use the scroll-
down box to highlight one or more Alerts. You can select the default (ALLALLALLALL) 
if you want all Alerts to trigger your Email Forwarding Rule.

FIGURE: Alert Titles Alert Titles Alert Titles Alert Titles portion

Hint: Press <SHIFT> to highlight multiple consecutive Alerts. Press <CTRL> to 

highlight multiple non-consecutive Alerts. Click the Clear Selections 

button to clear your Alert selections.

6. In the Specify a time range:Specify a time range:Specify a time range:Specify a time range: portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules 
page, you can modify a time rangetime rangetime rangetime range for your Email Forwarding Rule. (For 
example, perhaps you only want Alerts that occur between the hours of 
midnight to 6:59 A.M. to trigger your Email Forwarding Rule.)

FIGURE: Specify a time range: Specify a time range: Specify a time range: Specify a time range: portion

If you select:

•  Any timeAny timeAny timeAny time, then any Alerts specified in Step 6 will trigger your Email Forwarding 
Rule -- 24 hours a day

•  Custom rangeCustom rangeCustom rangeCustom range, then enter a military time range in the From: From: From: From: and To: To: To: To: fields, 
using the format hh:mm. For example, if you only want Alerts that occur 
between the hours of midnight to 6:59 A.M. to trigger your Email Forwarding 
Rule, then enter 00:00 and 06:59 in the From: From: From: From: and To: To: To: To: fields, respectively.
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7. In the Effective Risk Levels Effective Risk Levels Effective Risk Levels Effective Risk Levels portion of the second Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules 
page, you can modify which Risk LevelsRisk LevelsRisk LevelsRisk Levels are associated with your Email 
Forwarding Rule.

FIGURE: Effective Risk Levels Effective Risk Levels Effective Risk Levels Effective Risk Levels portion

You can check one (minimum) or more of the following:

•  HighHighHighHigh

•  MediumMediumMediumMedium

•  LowLowLowLow.

Note:Note:Note:Note: DbProtect Audit and Threat Management does notnotnotnot allow you to email 
forward Alerts with a risk level of InfoInfoInfoInfo. You must elevate the risk level of a 
rule in a Policy to LowLowLowLow, MediumMediumMediumMedium, or HighHighHighHigh if you want to email forward 

Alerts; for more information, see Editing a Policy and What do the risk 

levels mean?

8. Click the NextNextNextNext button.

The third Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page displays.

FIGURE: Third Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page

Two scroll-down boxes display: Possible FieldsPossible FieldsPossible FieldsPossible Fields and Fields To SendFields To SendFields To SendFields To Send. These scroll-down 
boxes allow you to modify which Alert fields and values should display in each 
forwarded email Alert.

Note:Note:Note:Note: Application Security, Inc. recommends that you include, at a minimum, the 
Alert TitleAlert TitleAlert TitleAlert Title and Risk LevelRisk LevelRisk LevelRisk Level fields in your forwarded email Alerts.
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You can move fields from the Possible FieldsPossible FieldsPossible FieldsPossible Fields scroll-down box to the Fields To SendFields To SendFields To SendFields To Send 
scroll-down box, or vice versa, by highlighting the field name and clicking either the 
<<<<<<<<<<<< or >>>>>>>>>>>> button. Clicking the >>> >>> >>> >>> button adds the highlighted Alert fields and 
values to the list of Alert fields and values to be displayed in an email Alert. Clicking 
the <<<<<<<<<<<< button removes the highlighted Alert fields and values from the list of Alert 
fields and values to be displayed in an email Alert.

Note:Note:Note:Note: Press <SHIFT> to highlight multiple consecutive fields. Press <CTRL> to 
highlight multiple non-consecutive fields. Click the Select All >>> button 
to move all fields in the Possible Fields scroll-down box to the Fields To 
Send scroll-down box.

9. Click the NextNextNextNext button.

The Email Forwarding RulesEmail Forwarding RulesEmail Forwarding RulesEmail Forwarding Rules summary page displays.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules summary    page

If you:

•  want to review or change any Email Forwarding Rule settings, you can click the 
BackBackBackBack button or any link that displays on the page

•  are satisfied with your Email Forwarding Rule settings, click the SaveSaveSaveSave button.

Your Email Forwarding Rule is saved. A confirmation page displays.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules confirmation    page
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10.From the confirmation page, you can click the:

•  first herehereherehere link to display the Global PropertiesGlobal PropertiesGlobal PropertiesGlobal Properties sub-page, which allows you to 
specify your Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings; for more information, see    Forwarding 
Settings

•  second herehereherehere link to display the Email Server Settings Email Server Settings Email Server Settings Email Server Settings sub-page, which allows 
you to configure your email server to accommodate the forwarding of Alerts 
and Reports via email; for more information, see Email Server Settings

•  third herehereherehere link to display the first Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules page.

DELETING AN EMAIL FORWARDING RULE

To deletedeletedeletedelete an Email Forwarding Rule: 

1. Do the following to display the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules tab.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page

This sub-page lists your existing Email Forwarding Rules (whether active or inactive).

2. If you want to:

•  delete an individualindividualindividualindividual Email Forwarding Rule, go to Step 3

•  delete all all all all Email Forwarding Rules, go to Step 4.



DbProtect 6.1 User’s Guide

Application Security, Inc. 461

3. Delete an individual Email Forwarding Rule.Delete an individual Email Forwarding Rule.Delete an individual Email Forwarding Rule.Delete an individual Email Forwarding Rule.

From the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page, do the following:

•  Click the XXXX button next to the Email Forwarding Rule you want to delete.

DbProtect Audit and Threat Management prompts you to confirm that you 
want to delete the Email Forwarding Rule.

FIGURE: Confirm delete page (individual Email Forwarding Rule)

•  Click the YesYesYesYes button to delete the Rule.

4. Delete all Email Forwarding Rules.

From the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page, do the following:

•  Click the Delete All Delete All Delete All Delete All button to delete allallallall Email Forwarding Rules.

DbProtect Audit and Threat Management prompts you to confirm that you 
want to delete the Email Forwarding Rule.

FIGURE: Confirm delete (allallallall Email Forwarding Rules)

•  Click the YesYesYesYes button to delete all Rules.
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ACTIVATING/DEACTIVATING AN EMAIL FORWARDING RULE

To activate/deactivate activate/deactivate activate/deactivate activate/deactivate an Email Forwarding Rule: 

1. Do the following to display the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules tab.

FIGURE: Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page

This sub-page lists your existing Email Forwarding Rules (whether active or inactive).

2. If you want to:

•  activate/deactivate an individualindividualindividualindividual Email Forwarding Rule, go to Step 3

•  activate/deactivate all all all all Email Forwarding Rules, go to Step 4.

3. Activate/deactivate an individual Email Forwarding Rule.Activate/deactivate an individual Email Forwarding Rule.Activate/deactivate an individual Email Forwarding Rule.Activate/deactivate an individual Email Forwarding Rule.

From the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page, do the following:

•  Click the ActivateActivateActivateActivate button to activate a corresponding (deactivated) Email 
Forwarding Rule.

•  Click the DeactivateDeactivateDeactivateDeactivate button to deactivate a corresponding (activated) Email 
Forwarding Rule.
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4. Activate/deactivate Activate/deactivate Activate/deactivate Activate/deactivate all Email Forwarding Rules. Email Forwarding Rules. Email Forwarding Rules. Email Forwarding Rules.

From the Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules Email Forwarding Rules sub-page, do the following:

•  Click the Activate All Activate All Activate All Activate All button to activate all (deactivated) Email Forwarding 
Rules.

•  Click the Deactivate All Deactivate All Deactivate All Deactivate All button to deactivate all (activated) Email Forwarding 
Rules.

Forwarding
Settings

Forwarding SettingsForwarding SettingsForwarding SettingsForwarding Settings allow you to specify the:

•  polling frequencypolling frequencypolling frequencypolling frequency, i.e., how often (in minutes) DbProtect Audit and Threat 
Management should check for new Alerts and email them to recipients 
identified in your Email Forwarding Rules).

•  maximum number of Alerts to handlemaximum number of Alerts to handlemaximum number of Alerts to handlemaximum number of Alerts to handle, i.e., the maximum number of Alerts you 
want DbProtect Audit and Threat Management to send in each email to your 
recipients (specified in your Email Forwarding Rules).

To configure your Forwarding Settings: 

1. Do the following to display the Global Properties Global Properties Global Properties Global Properties sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Forwarding Settings Forwarding Settings Forwarding Settings Forwarding Settings tab.

FIGURE: Global Properties Global Properties Global Properties Global Properties sub-page

2. The Global Properties Global Properties Global Properties Global Properties sub-page consists of the following fields:

•  Polling Frequency:Polling Frequency:Polling Frequency:Polling Frequency: Enter the polling frequencypolling frequencypolling frequencypolling frequency, in minutes, for DbProtect Audit 
and Threat Management to check for new Alerts and email them to the 
recipients identified in your Email Forwarding Rules. The default polling 
frequency is 5 minutes.

•  Maximum Alerts to Handle:Maximum Alerts to Handle:Maximum Alerts to Handle:Maximum Alerts to Handle: Enter the maximum number of Alertsmaximum number of Alertsmaximum number of Alertsmaximum number of Alerts you want 
DbProtect Audit and Threat Management to send in each email to the 
recipients identified in your Email Forwarding Rules. The default value is 100 
Alerts.
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Email Server
Settings

Email Server Settings Email Server Settings Email Server Settings Email Server Settings allow you to configure your email server to accommodate the 
forwarding of Alerts and Reports via email.

The Email Server SettingsEmail Server SettingsEmail Server SettingsEmail Server Settings sub-page allows you to:

•  specify your Outbound SMTP Server:Outbound SMTP Server:Outbound SMTP Server:Outbound SMTP Server: name and Port: Port: Port: Port: number

•  indicate whether you want to Use AuthenticationUse AuthenticationUse AuthenticationUse Authentication (for SMTP servers), and if so, 
which login/passwordlogin/passwordlogin/passwordlogin/password pair to use; for more information, see SMTP server 
authentication considerations

•  select whether to use a Secure Connection:Secure Connection:Secure Connection:Secure Connection: (you can select NoneNoneNoneNone or SSLSSLSSLSSL)

•  enter the From Address: From Address: From Address: From Address: and Reply To Address: Reply To Address: Reply To Address: Reply To Address: to display in your emailed 
Alerts

•  specify the Max Attachment Size:Max Attachment Size:Max Attachment Size:Max Attachment Size: (in megabytes) for attachments to your 
emailed Alerts

•  send a test emailtest emailtest emailtest email.

This topic consists of the following sub-topics:

•  SMTP server authentication considerations

•  Configuring your email server settings.

SMTP SERVER AUTHENTICATION CONSIDERATIONS

Some SMTP serversSMTP serversSMTP serversSMTP servers require authentication in order to send email. Depending on what 
kind of SMTP server you are using, and how it is configured, this may or may not be the 
case. If your SMTP server requires authentication in order to send email, then you must 
enter a valid login/password pair, and check the Use AuthenticationUse AuthenticationUse AuthenticationUse Authentication checkbox in Step 
2 of Configuring your email server settings, below. However, if you are not sure 
whether your SMTP server requires authentication, check with your mail administrator.

For more information on email authentication, see http://en.wikipedia.org/wiki/
Email_authentication.

http://en.wikipedia.org/wiki/Email_authentication
http://en.wikipedia.org/wiki/Email_authentication
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CONFIGURING YOUR EMAIL SERVER SETTINGS

To configure your Email Server Settings:

1. Do the following to display the Email Server Properties Email Server Properties Email Server Properties Email Server Properties sub-page:

•  Click the System Settings System Settings System Settings System Settings tab from any DbProtect Audit and Threat 
Management page to display the System Settings System Settings System Settings System Settings page (for more information, 
see Understanding the System Settings page).

•  Click the Email Server Settings Email Server Settings Email Server Settings Email Server Settings tab.

FIGURE: Email Server Settings Email Server Settings Email Server Settings Email Server Settings sub-page

2. In the:

•  Outbound SMTP Server: Outbound SMTP Server: Outbound SMTP Server: Outbound SMTP Server: field, enter the name of your outgoing SMTP server

•  PortPortPortPort field, enter which port number (in the 1-65535 range) you want to use on 
your outgoing SMTP server.

3. Check the Use AuthenticationUse AuthenticationUse AuthenticationUse Authentication checkbox if your SMTP server requires 
authentication in order to send email.
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Note:Note:Note:Note: Some SMTP servers require authentication in order to send email. 
Depending on what kind of SMTP server you are using, and how it is 
configured, this may or may not be the case. If your SMTP server requires 
authentication in order to send email, then you must enter a valid login/
password pair, and check the Use Authentication checkbox. However, if 
you are not sure whether your SMTP server requires authentication, check 
with your mail administrator.

If you check the Use AuthenticationUse AuthenticationUse AuthenticationUse Authentication checkbox, you must alsoalsoalsoalso enter a valid:

•  Username:Username:Username:Username:

•  Password:Password:Password:Password:

4. In the Secure Connection: Secure Connection: Secure Connection: Secure Connection: portion of the page, select:

•  SSLSSLSSLSSL if you want to use Secure Sockets Layer (SSL) to encrypt your user name 
and credentials prior to transmission

•  NoneNoneNoneNone if you do not want to use SSL encryption.

5. Enter a:

•  “from” email address in the From Address:From Address:From Address:From Address: field (i.e., when DbProtect Audit and 
Threat Management sends an Alert email to the recipients identified in your 
Email Forwarding Rules, this is the “from” email address they will see)

•  “reply to” email address in the Reply To Address: Reply To Address: Reply To Address: Reply To Address: field (i.e., when DbProtect 
Audit and Threat Management sends an Alert email to the recipients identified 
in your Email Forwarding Rules, this is the “reply to” email address they will 
see).

6. In the Max Attachment Size:Max Attachment Size:Max Attachment Size:Max Attachment Size: field, specify a maximum attachment size in 
megabytes (1-30). The default value is 3 megabytes.

Note:Note:Note:Note: When DbProtect Audit and Threat Management completes a Report, the 
generated email always includes link to the Report -- even if there is no 
attachment. In other words, even if the generated Report exceeds the 
maximum attachment size, your email recipients can still view the Report 
online.

7. Optionally, you can enter a valid email address in the Send Test Email to: Send Test Email to: Send Test Email to: Send Test Email to: 
field, and click the Send EmailSend EmailSend EmailSend Email button, to send a test Alert email.

8. Review your Email Server Settings.

9. Click the SaveSaveSaveSave button.
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Compliance Packs
This section consists of the following chapters:

•  Understanding Compliance Packs

•  Interpreting Your Generated Compliance Pack Dashboards, and Displaying/
Interpreting Your Generated Compliance Pack Reports..
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Understanding Compliance 
Packs
This chapter consists of the following topics:

•  What are Compliance Packs and Compliance Content Packs?

•  Compliance Pack Prerequisite: DbProtect Analytics 1.3 or Greater

•  Minimum Required Privileges for Compliance Pack Usage

•  Available Compliance Packs

•  Obtaining Your Compliance Content Packs

•  Viewing Your Available Imported Compliance Content Packs

•  Importing a Compliance Content Pack

•  Understanding the Compliance Packs Page

•  Generating Compliance Pack Dashboards and Reports.

What are
Compliance Packs
and Compliance
Content Packs?

Compliance packsCompliance packsCompliance packsCompliance packs are optional DbProtect add-ons that contain regulatory 
compliance-level views of your database environment designed to help you track, 
manage, and meet compliance requirements. Compliance packsCompliance packsCompliance packsCompliance packs work in conjunction 
with DbProtect Analytics (version 1.3 or higher), allowing you to review and analyze 
compliance progress with additional high-level Dashboards and report the results of 
testing of database security controls in the correct compliance language context (e.g., 
information assurance controls and identifiers).

Compliance packs    simplify the mapping between established test controls and the 
automated methods and procedures within DbProtect, which helps to save a 
tremendous amount of analysis time. Moreover, content packs offer additional 
Policies, Dashboards, reports, export formats, and independent resource information 
where applicable.

In order to enable compliance packs within DbProtect, you must first obtain and 
import a compliance content packcompliance content packcompliance content packcompliance content pack, i.e., an Application Security, Inc.-provided .zip 
files that, when successfully imported into DbProtect, adds reports geared toward 
helping you achieve regulation-specific compliance (for example, DISA-STIG). Once 
you import a compliance    content pack, a new Compliance PacksCompliance PacksCompliance PacksCompliance Packs tab displays on the 
Console.

For more information on:

•  obtaining compliance content packs, see Obtaining Your Compliance Content 
Packs

•  importing compliance content packs, see Importing a Compliance Content 
Pack
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•  understanding the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page (created when you successfully 
import a compliance content pack), see Understanding the Compliance Packs 
Page

•  running a compliance pack    report, see Generating Compliance Pack 
Dashboards and Reports

For more information on how DbProtect can help your organization achieve regulatory 
compliance, please visit the Application Security, Inc. website at http://
www.appsecinc.com/solutions/compliance/index.shtml. If you have any questions, 
don’t hesitate to contact an Application Security, Inc. Customer Support 
representative.

Compliance Pack
Prerequisite:

DbProtect
Analytics 1.3 or

Greater

In order to use compliance packs in DbProtect, you mustmustmustmust have DbProtect Analytics 1.3 DbProtect Analytics 1.3 DbProtect Analytics 1.3 DbProtect Analytics 1.3 
or greater installed. For more information on DbProtect Analytics, see the DbProtect 
Analytics Installation and User’s Guide.

Minimum Required
Privileges for

Compliance Pack
Usage

In order to work with compliance packs, your assigned User role mustmustmustmust be one of the 
following:

•  DbProtect AdminDbProtect AdminDbProtect AdminDbProtect Admin

•  DbProtect Super AdminDbProtect Super AdminDbProtect Super AdminDbProtect Super Admin

•  Vulnerability Management AdminVulnerability Management AdminVulnerability Management AdminVulnerability Management Admin

•  Audit and Threat Management AdminAudit and Threat Management AdminAudit and Threat Management AdminAudit and Threat Management Admin.

For more information on User roles, and their inherent rights and privileges, see 
DbProtect Organizations, Users, and User Roles.

Available
Compliance Packs

The current version of DbProtect supports the DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack. Additional 
compliance packs -- for all supported regulations -- are in development and will be 
released soon.

For more information on:

•  generating DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack Dashboards and reports, see 
Generating Compliance Pack Dashboards and Reports

•  interpreting generated DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack Dashboards and reports, 
see Interpreting Your Generated Compliance Pack Dashboards, and 
Displaying/Interpreting Your Generated Compliance Pack Reports.
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Obtaining Your
Compliance

Content Packs

Once you purchase a regulation-specific content pack, an Application Security, Inc. 
representative will provide you with your compliance content pack in .zip file format 
(e.g., DISA-STIG_1.0.20.cp.zip). You must import this compliance content pack via 
the AdministrationAdministrationAdministrationAdministration page in order to start running compliance pack reports. For more 
information on:

•  importing compliance content packs, see Importing a Compliance Content 
Pack

•  running compliance pack reports, see Generating Compliance Pack 
Dashboards and Reports.

Viewing Your
Available Imported

Compliance
Content Packs

To view your available imported compliance content packs:

1. Click the Administration tab to display the Administration page; for more 

information on the Administration page, see DbProtect Administration: 

Content/Compliance Packs, Data Sources, and System Information.

2. Click the Content Packs > View ContentContent Packs > View ContentContent Packs > View ContentContent Packs > View Content link (in the navigation pane of the 
AdministrationAdministrationAdministrationAdministration page) to    display content packs that you have already 
successfully imported (in the viewing pane).

FIGURE: Available imported content packs (in the AdministrationAdministrationAdministrationAdministration page viewing pane)

The navigation pane displays the name of the imported content pack (e.g., DISA 

STIG), as well as the version number (e.g., 1.0.20).

Assuming you have already imported content packs, then you should see a 

Compliance Packs application tab on the DbProtect Console, which allows you to 

toggle to the Compliance Packs page and run compliance pack reports. For more 

information on:

•  the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page, see Understanding the Compliance Packs Page

•  running compliance pack reports, see Generating Compliance Pack 
Dashboards and Reports.
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Importing a
Compliance

Content Pack

To import a compliance content pack:

1. Click the Administration tab to display the Administration page; for more 

information on the Administration page, see DbProtect Administration: 

Content/Compliance Packs, Data Sources, and System Information.

2. Click the Content Packs > Import ContentContent Packs > Import ContentContent Packs > Import ContentContent Packs > Import Content link (in the navigation pane of 
the AdministrationAdministrationAdministrationAdministration page) to    import your Application Security, Inc.-
provided, regulation-specific compliance content pack .zip file (e.g., DISA-
STIG_1.0.20.cp.zip). You must import this compliance content pack via the 
AdministrationAdministrationAdministrationAdministration page in order to start running your compliance pack 
reports (explained in Generating Compliance Pack Dashboards and 
Reports).

3. Enter the full path location of your compliance content pack .zip file (stored 
on your local computer or network) in the File: File: File: File: field, or click the Browse... Browse... Browse... Browse... 
button to locate and upload the file.

4. Click the ImportImportImportImport link.

FIGURE: Compliance content pack import (in the AdministrationAdministrationAdministrationAdministration page viewing pane)

Import link
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5. DbProtect imports your compliance content pack .zip file.

FIGURE: Compliance content pack import progress bar

DbProtect displays a success message upon completion.

Once you successfully import your compliance content pack into DbProtect, a 

new Compliance Packs application tab displays on the Console, allowing you to 

toggle to the newly-created Compliance Packs page and run compliance pack 

reports.

In addition, if you click the Content Packs > View Content link (in the navigation 

pane of the Administration page), you can display the content packs that you have 

already successfully imported (in the viewing pane).

For more information on:

•  viewing the content packs that you have already imported, see Viewing Your 
Available Imported Compliance Content Packs

•  the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page, see Understanding the Compliance Packs Page

•  running compliance pack reports, see Generating Compliance Pack 
Dashboards and Reports.
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Understanding the
Compliance Packs

Page

Once you have successfully imported a compliance content pack into DbProtect (as 
explained in Importing a Compliance Content Pack), the new Compliance PacksCompliance PacksCompliance PacksCompliance Packs 
application tab displays on the Console, allowing you to toggle to the newly-created 
Compliance PacksCompliance PacksCompliance PacksCompliance Packs page (shown below) and run compliance pack reports.

FIGURE: Compliance PacksCompliance PacksCompliance PacksCompliance Packs page

The Compliance PacksCompliance PacksCompliance PacksCompliance Packs page consists of:

•  Compliance pack buttonsCompliance pack buttonsCompliance pack buttonsCompliance pack buttons -- one for each successfully-imported compliance 
content pack -- located in the upper-left portion of the page. Click this button 
to run a compliance pack report; for more information, see Generating 
Compliance Pack Dashboards and Reports.

•  The compliance pack report resultscompliance pack report resultscompliance pack report resultscompliance pack report results portion of the page, which displays your 
compliance pack report data.

Compliance Packs tab
Compliance pack
button

Compliance pack 
report results
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Generating
Compliance Pack
Dashboards and

Reports

There are twotwotwotwo ways to generate compliance pack reportsreportsreportsreports in DbProtect:

•  from the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page (explained below)

•  as a Report Job in DbProtect Vulnerability Management; for more information, 
see Report Jobs.

There is only one way, however, to generate high-level compliance pack Dashboards Dashboards Dashboards Dashboards in 
DbProtect, however -- through from the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page (explained below).

To generate compliance pack Dashboards and reports from the Compliance PacksCompliance PacksCompliance PacksCompliance Packs 
page:

1. Click the Compliance Report application tab to display the Compliance Packs 

page (shown below); for more information, see Understanding the Compliance Packs 

Page.

FIGURE: Compliance PacksCompliance PacksCompliance PacksCompliance Packs page

2. Click a compliance pack button (one displays for each successfully-
imported compliance content pack) located in the upper-left portion of the 
Compliance Report Compliance Report Compliance Report Compliance Report page.

3. DbProtect runs your compliance pack report, and displays the results in the 

compliance pack report data portion of the Compliance Report Compliance Report Compliance Report Compliance Report page.

4. For more information on:

•  the Compliance Report Compliance Report Compliance Report Compliance Report page, see Understanding the Compliance Packs Page

•  each available compliance pack report, see Generating Compliance Pack 
Dashboards and Reports.

Compliance Packs tab
Compliance pack
button

Compliance pack 
report results
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Interpreting Your Generated 
Compliance Pack Dashboards, 
and Displaying/Interpreting 
Your Generated Compliance 
Pack Reports
There are twotwotwotwo ways to generate compliance pack reportsreportsreportsreports in DbProtect:

•  from the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page; for more information, see Generating 
Compliance Pack Dashboards and Reports

•  as a Report Job in DbProtect Vulnerability Management; for more information, 
see Report Jobs.

There is only one way, however, to generate high-level compliance pack Dashboards Dashboards Dashboards Dashboards in 
DbProtect -- i.e., from the Compliance PacksCompliance PacksCompliance PacksCompliance Packs page; for more information, see 
Generating Compliance Pack Dashboards and Reports.

What do you do with your compliance pack Dashboard and report information once Dashboard and report information once Dashboard and report information once Dashboard and report information once 
it’s generated? it’s generated? it’s generated? it’s generated? That’s what this section explains.

Note:Note:Note:Note: The current version of DbProtect supports the DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance 
pack. Additional compliance packs -- for all supported regulations -- are in 
development and will be released soon. For more information on 
interpreting your generated DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack Dashboards and 
reports, see Interpreting Your Generated Compliance Pack Dashboards, 
and Displaying/Interpreting Your Generated Compliance Pack Reports, 
below.
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DISA-STIG
Compliance Pack
Dashboards and

Reports

This topic consists of the following sub-topics:

•  What is DISA-STIG?

•  Interpreting Your Generated DISA-STIG Compliance Pack Dashboards

•  Displaying and Interpreting Your Generated DISA-STIG Compliance Pack 
Reports

WHAT IS DISA-STIG?

Databases have become more frequent hacker targets leaving you vulnerable to 
disruption in operations, confidential information breaches, and national security risks. 
Application Security, Inc. empowers you with the security solutions to address the 
guidelines set forth by the Defense Information Systems Agency's Database Security 
Technical Implementation Guide.

The Defense Information Systems Agency (DISA)Defense Information Systems Agency (DISA)Defense Information Systems Agency (DISA)Defense Information Systems Agency (DISA) has responded to this threat with a 
new set of database security guidelines. The Database Security Technical Database Security Technical Database Security Technical Database Security Technical 
Implementation Guide (STIG)Implementation Guide (STIG)Implementation Guide (STIG)Implementation Guide (STIG) presents the known security configuration items, 
vulnerabilities, and issues required to be addressed by DOD policy.

The STIG is provided under the authority of DOD Directive 8500.1. This directive 
requires that “all information assurance (IA) and IA-enabled IT products incorporated 
into DOD information systems shall be configured in accordance with DOD approved 
security configuration guidelines”. Implementing the recommendations and checklists 
outlined in the DISA-STIG will ensure DOD environments meet these security 
requirements and comply with this mandate.

Application Security, Inc. has created an automated policy for implementing the DISA-
STIG requirements for database security. Using of the DISA-STIG Policy with the 
AppDetectivePro and DbProtect Vulnerability Management tools -- as well as the 
DISA-STIG compliance pack in DbProtect (explained herein) -- allows you to verify 
compliance with STIG checklist requirements and avoid the long, often painful, manual 
checklist process. This reduces implementation time by weeks, even months, and 
provides significant auditing information to satisfy compliance reporting requirements.
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INTERPRETING YOUR GENERATED DISA-STIG COMPLIANCE 

PACK DASHBOARDS

After you import a DISA-STIG compliance pack (explained in Importing a Compliance 
Content Pack) you can generate your DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack Dashboards and compliance pack Dashboards and compliance pack Dashboards and compliance pack Dashboards and 
reports reports reports reports (explained in Generating Compliance Pack Dashboards and Reports).

The DISA-STIGDISA-STIGDISA-STIGDISA-STIG Compliance Pack Dashboards Compliance Pack Dashboards Compliance Pack Dashboards Compliance Pack Dashboards are shown below.

FIGURE: DISA-STIG Compliance Pack Dashboards
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DbProtect includes the following DISA-STIG compliance pack Dashboards:

•  Coverage by STIG Version. Coverage by STIG Version. Coverage by STIG Version. Coverage by STIG Version. This Dashboard displays which STIG versions your 
scanned databases are compliant and not compliant with (i.e., FAILFAILFAILFAIL or PASSPASSPASSPASS).

•  Assets by Compliance Levels. Assets by Compliance Levels. Assets by Compliance Levels. Assets by Compliance Levels. This Dashboard graphically displays what 
percentage of your scanned databases that have achieved (or not achieved) 
DISA-STIG compliance, by database type.

•  Coverage. Coverage. Coverage. Coverage. This Dashboard graphically displays STIG tests over time, and how 
well your organization has done with achieving) DISA-STIG compliance.

•  Database Type. Database Type. Database Type. Database Type. This Dashboard graphically the top five most frequent STIG 
violations that DbProtect has detected over time.

DISPLAYING AND INTERPRETING YOUR GENERATED DISA-

STIG COMPLIANCE PACK REPORTS

After you import a DISA-STIG compliance pack (explained in Importing a Compliance 
Content Pack) you can generate your DISA-STIGDISA-STIGDISA-STIGDISA-STIG compliance pack Dashboards and compliance pack Dashboards and compliance pack Dashboards and compliance pack Dashboards and 
reports reports reports reports (explained in Generating Compliance Pack Dashboards and Reports).

Note:Note:Note:Note: You can also run DISA-STIG Compliance Pack reports as Report Jobs in 
DbProtect Vulnerability Management; for more information, see Report 
Jobs. 

The DISA-STIGDISA-STIGDISA-STIGDISA-STIG Compliance Pack report links Compliance Pack report links Compliance Pack report links Compliance Pack report links are labeled below.

FIGURE: DISA-STIG Compliance Pack report links

To displaydisplaydisplaydisplay a DISA-STIG Compliance Pack report, click the appropriate link. The DISA-
STIG Compliance Pack reports are:

•  STIG Findings by Database Overview.STIG Findings by Database Overview.STIG Findings by Database Overview.STIG Findings by Database Overview. This report shows a summary of STIG 
compliance broken down by results that pass, fail, and are not applicable (N/A) 
for automated verification.

•  STIG Findings by Database Mapping.STIG Findings by Database Mapping.STIG Findings by Database Mapping.STIG Findings by Database Mapping. This report shows the findings summary 
mapped to STIG compliance.

•  STIG Findings by Database Detail. STIG Findings by Database Detail. STIG Findings by Database Detail. STIG Findings by Database Detail. This report shows the detailed findings 
mapped to STIG compliance.

Report links
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Data Sources
This section consists of the following chapters:

•  Understanding Data Sources

•  Working with Oracle Audit Vault as a DbProtect Data Source.
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Understanding Data Sources
This chapter consists of the following topics:

•  What are Data Sources?

•  Available Data Sources.

What are Data
Sources?

Starting with version 6.0, DbProtect allows you to register and aggregate data from 
third-party data sources, such as Oracle Audit Vault, and include this data in certain 
DbProtect Analytics reports.

You must register properly-configured data sources in order to use them. For example, 
Oracle Audit Vault must be properly-configured and you must meet certain DbProtect 
suite and DbProtect Analytics minimum system requirements. Then you must register 
it as a data source. For more information, see Working with Oracle Audit Vault as a 
DbProtect Data Source.

Available Data
Sources

The current version of DbProtect supports the Oracle Audit Vault data source. For 
more information on the Oracle Audit Vault data source, see Working with Oracle 
Audit Vault as a DbProtect Data Source.
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Working with Oracle Audit 
Vault as a DbProtect Data 
Source
Starting with DbProtect 6.0 and DbProtect Analytics 1.4, you can configure Oracle Oracle Oracle Oracle 
Audit VaultAudit VaultAudit VaultAudit Vault as a DbProtect data source. This means you can include Oracle Audit Vault    
data in certain DbProtect Analytics reports. This section explains everything you 
should know about configuring Oracle Audit Vault as a DbProtect data source.

This chapter consists of the following topics:

•  Which DbProtect Analytics Reports Use Oracle Audit Vault Data?

•  Minimum Requirements for Using Oracle Audit Vault as a DbProtect Data 
Source

•  Roles and Privileges Required to Use Oracle Audit Vault as a DbProtect Data 
Source

•  Registering Oracle Audit Vault as a DbProtect Data Source

•  Unregistering Oracle Audit Vault as a DbProtect Data Source

•  Troubleshooting Oracle Audit Vault (as a DbProtect Data Source) Issues.

Which DbProtect
Analytics Reports
Use Oracle Audit

Vault Data?

If you are using Oracle Audit Vault to audit your databases, then certain DbProtect 
Analytics reports can include Oracle Audit Vault data. The specific DbProtect Analytics 
Reports that include Oracle Audit Vault data are:

•  Failed Logins Review Report

•  Privileged Activity Report

•  Threat Detailed Review Report

•  Threat Detailed Review Report (with Knowledgebase Articles)

•  Sarbanes-Oxley (SOX) - Vulnerability Assessment Report

•  Payment Card Industry Data Security Standard (PCI DSS) - Activity Monitoring 
Report.

For information on each DbProtect Analytics Report, see the DbProtect Analytics 
User’s Guide.

In order to include Oracle Audit Vault data in your DbProtect Analytics Reports, you 
must properly install Oracle Audit Vault and register Oracle Audit Vault within 
DbProtect prior to running any DbProtect Analytics Reports that support Oracle Audit 
Vault data (explained in this section).
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Minimum
Requirements for

Using Oracle Audit
Vault as a

DbProtect Data
Source

In order to use Oracle Audit Vault as a DbProtect data source, you require, at a 
minimum, the following:

•  DbProtect 6.0 or greater

•  DbProtect Analytics 1.4 or greater

•  A properly configured Oracle Audit Vault environment with data.

•  Oracle Instant Client for 10g/11g.

Roles and
Privileges

Required to Use
Oracle Audit Vault

as a DbProtect
Data Source

When you register Oracle Audit Vault as a data source within DbProtect, you will need 
to provide a database user. You must also have at least the following roles and 
privileges in order to successfully connect to Oracle Audit Vault:

•  At least SELECT privileges to the AUDIT_EVENT_FACT table, as well as the 
following dimension (*_DIM) tables, under the schema owner AVSYS:

-CLIENT_HOST_DIM

-CLIENT_TOOL_DIM

-USER_DIM

-TARGET_DIM

-EVENT_DIM

-TIME_DIM

-CONTEXT_DIM

-SOURCE_DIM

-PRIVILEGES_DIM

•  The role AV_AGENT, which manages collection agents and collectors by starting, 
stopping, and resetting them. A user is created and granted this role prior to a 
collection agent installation. The Oracle Audit Vault collection agent software 
uses this role at run time to query Oracle Audit Vault for configuration 
information. For more information on the AV_AGENT role, see http://
download.oracle.com/docs/cd/E11062_01/admin.1023/e11059/

avadm_mng_security.htm.

Registering Oracle
Audit Vault as a
DbProtect Data

Source

To register Oracle Audit Vault as a DbProtect data source:

1. Install DbProtect 6.0 or greater and Analytics 1.4 (bundled with the DbProtect 6.0 

installation bootstrapper); for more information, see the DbProtect Installation 

Guide.

2. Install Oracle Instance Client. Do the following:

•  Go to the Oracle website and download the Oracle Instant Client that matches 
your Oracle and operating system versions. Unzip the Oracle Instant Client 
anywhere on the same host as where DbProtect Analytics is installed. For 
example, use Oracle Instant Client Package - Basic Lite, version 11.1.0.7.0 (32-
bit) or greater for Oracle 11g (on Windows 2003 32-bit).

Caution! Use a 32-bit driver even on 64-bit Windows. Some versions of 

Oracle Instance Client do not accept parenthesis in the path.
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•  Copy the ojdbc5.jar file from the unzip Oracle Instance Client folder to the 
DbProtect Analytics installation folder webapps.

For example: If you unzip the client to folder: C:\Program 
Files\Oracle\instantclient_11_1, and DbProtect is installed on 
C:\Program Files\AppSecInc\DbProtect, copy ojdbc5.jar from 
C:\Program Files\Oracle\instance_11_1 to C:\Program 
Files\AppSecInc\DbProtect\Reporting\media\c8\webapps\p2pd\WEB-

INF\lib (substitute your installation directory if it isn't the default)

•  Add Oracle Instance Client to the system path. Do the following:

-Open the Microsoft Windows Control Panel.

-Select SystemSystemSystemSystem to display the System PropertiesSystem PropertiesSystem PropertiesSystem Properties dialog box.

-Click the AdvancedAdvancedAdvancedAdvanced tab. 

-Click the Environment VariablesEnvironment VariablesEnvironment VariablesEnvironment Variables button to display the Environment VariablesEnvironment VariablesEnvironment VariablesEnvironment Variables 
dialog box.

-In the System VariablesSystem VariablesSystem VariablesSystem Variables portion of the Environment VariablesEnvironment VariablesEnvironment VariablesEnvironment Variables dialog box, 
locate the PathPathPathPath variable and click the EditEditEditEdit button to display the Edit System Edit System Edit System Edit System 
VariableVariableVariableVariable dialog box.

-Append (not replace) instantclient_11_1 to the end of the path, e.g., 
C:\Program Files\Oracle\instantclient_11_1.

•  Run the command services.msc.

•  Restart the Cognos8 service.

3. Register your Oracle Audit Vault data source within DbProtect. Do the 
following:

•  Log into the DbProtect Console as a user that has DbProtect administrator 
privileges; for more information, see Logging Into the DbProtect Console (and 
DbProtect Console Login Troubleshooting).

•  Click the AdministrationAdministrationAdministrationAdministration tab to display the DbProtect Console Administration Administration Administration Administration 
page; for more information on the DbProtect Administration: Content/
Compliance Packs, Data Sources, and System Information.

•  Click the Data Sources > Audit VaultData Sources > Audit VaultData Sources > Audit VaultData Sources > Audit Vault    link in the navigation panel.

•  Click the RegisterRegisterRegisterRegister button.

•  Specify the Oracle Audit Vault data source connection information:

-Host or IP.Host or IP.Host or IP.Host or IP. Enter the name of the host or IP address where Oracle Audit Vault 
Server is installed and running. If the host is on a different domain than the 
machine where DbProtect is installed, you mustmustmustmust provide a fully-qualified 
domain name.

-Port.Port.Port.Port. Enter the port where the Oracle Audit Vault is installed. The default 
port is 1521.

-Service name.Service name.Service name.Service name.    Enter the Oracle Audit Vault service name, which is defined in 
TNSNAMES.ORA.
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Note:Note:Note:Note: TNSNAMES.ORA is a SQL*Net configuration file that defines databases 
addresses for establishing connections to them. This file normally resides 
in the ORACLE HOME\NETWORK\ADMIN directory.

-Username.Username.Username.Username. Enter the user created during the Oracle Audit Vault server 
installation. This user requires certain roles and privileges; for more 
information, see Roles and Privileges Required to Use Oracle Audit Vault as a 
DbProtect Data Source.

-Password. Password. Password. Password. Specify the password for the user specified in the UsernameUsernameUsernameUsername field.

Note:Note:Note:Note: If you encounter problems registering Oracle Audit Vault as a DbProtect 
data source, see Troubleshooting Oracle Audit Vault (as a DbProtect Data 
Source) Issues.

-Test ConnectionTest ConnectionTest ConnectionTest Connection. The Test Connection Test Connection Test Connection Test Connection checkbox is checked by default. 
When this checkbox is checked, DbProtect automatically checks whether 
there is a valid connection between the DbProtect Console and your data 
source. However, as explained in SID Defined TNSNAMES.ORA is Different 
From Service Name, if the Oracle SID defined in your TNSNAMES.ORA file is 
different from the Service nameService nameService nameService name    (explained above), the test connection will 
fail. You must uncheckuncheckuncheckuncheck the Test ConnectionTest ConnectionTest ConnectionTest Connection checkbox to proceed.

4. Click the NextNextNextNext button to complete the Oracle Audit Vault data source 
registration.

5. Run a DbProtect Analytics report that includes Oracle Audit Vault data; for 
more information, see Which DbProtect Analytics Reports Use Oracle 
Audit Vault Data? and the DbProtect Analytics User’s Guide.

Unregistering
Oracle Audit Vault

as a DbProtect
Data Source

To unregister a registered version of Oracle Audit Vault:

1. In the DbProtect Console, click the Administration tab to display the DbProtect 

Console Administration page; for more information, see Displaying, 

Understanding, and Navigating the DbProtect Administration Page.

2. Click the Data Sources > Audit VaultData Sources > Audit VaultData Sources > Audit VaultData Sources > Audit Vault    link in the navigation panel.

3. Click the UnregisterUnregisterUnregisterUnregister button.

4. Confirm the unregistration.
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Troubleshooting
Oracle Audit Vault

(as a DbProtect
Data Source)

Issues

This topic explains some issues you may encounter when using Oracle Audit Vault as a 
DbProtect data source, and how to troubleshoot these issues. As a general rule, you 
should consult your Oracle Audit Vault administrator if you are not sure whether Oracle 
Audit Vault is running.

This topic consists of the following sub-topics:

•  DbProtect Suite is Installed on a Machine Where the Domain is Not the Same 
as the Domain Where Oracle Audit Vault is Installed

•  SID Defined TNSNAMES.ORA is Different From Service Name

•  If Oracle Audit Vault Registration Fails, Verify the Connection

•  Starting Oracle Audit Vault Agents and Collectors

•  Checking Whether Oracle Audit Vault is Running

•  Starting Oracle Audit Vault

•  Stopping Oracle Audit Vault.

DBPROTECT SUITE IS INSTALLED ON A MACHINE WHERE 

THE DOMAIN IS NOT THE SAME AS THE DOMAIN WHERE 

ORACLE AUDIT VAULT IS INSTALLED

Upon registering your data source (or test connecting via the Cognos AdministrationAdministrationAdministrationAdministration 
tab), you may encounter an error message such as this: "QE-DEF-0068 Unable to 
connect to at least one database".

This error may mean your Oracle client was not installed or not configured properly. 
However, it could also be related to a cross-domain environment issue. If you installed 
the DbProtect suite on a machine where the domain is notnotnotnot the same as the domain 
where Oracle Audit Vault is installed, you must run the Cognos8 service with a user that 
can access the domain controller (e.g., a domain user, not a local system user). For 
more information, see the DbProtect Installation Guide.

SID DEFINED TNSNAMES.ORA IS DIFFERENT FROM SERVICE 

NAME

If the Oracle SID defined in your TNSNAMES.ORA file is different from the Service nameService nameService nameService name    
(specified when you register Oracle Audit Vault as a DbProtect data source), the 
connection will fail. You must uncheckuncheckuncheckuncheck the Test ConnectionTest ConnectionTest ConnectionTest Connection checkbox in the data 
source registration portion of the DbProtect Console Administration Administration Administration Administration page in order to 
proceed; for more information, see Registering Oracle Audit Vault as a DbProtect Data 
Source.

IF ORACLE AUDIT VAULT REGISTRATION FAILS, VERIFY THE 

CONNECTION

If Oracle Audit Vault registration fails (as explained in Registering Oracle Audit Vault as 
a DbProtect Data Source), you should verify the connection between your DbProtect 
Console server and your Oracle Audit Vault server. To do so, run the following 
command telnet auditvaulthost port, e.g., telnet myauditvault 1521.
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STARTING ORACLE AUDIT VAULT AGENTS AND COLLECTORS

Once Oracle Audit Vault is running, log in as an Oracle Audit Vault administrator 
(typically avadmin) and start the collectors manually via the CollectorsCollectorsCollectorsCollectors tab. If the screen 
still shows a communication problem, select the AgentsAgentsAgentsAgents tab and confirm the problem. 
If it shows up in the AgentsAgentsAgentsAgents tab as well, you must manually fix the problem for each 
agent.

Once the agent is available you may see an icon of a "down arrrow". This means oc4j 
is up but the agent/collector is down. Start the agent via the Oracle Audit Vault user 
interface under the AgentsAgentsAgentsAgents tab. Once the agent is up (indicated by an up arrow), go to 
the CollectorsCollectorsCollectorsCollectors tab and start the collector(s).

CHECKING WHETHER ORACLE AUDIT VAULT IS RUNNING

To check whether Oracle Audit Vault is running:

1. SSH to the host where Oracle Audit Vault is installed.

2. Check if Oracle Audit Vault is running by executing the command avctl 
show_av_status. Alternately, you can run the command ps -ef | grep 
oracleav. If the process oracleav displays, then Oracle Audit Vault is 
running. For example:

oracle   23906     1  0 Aug03 ?        00:03:45 oracleav (LOCAL=NO)

STARTING ORACLE AUDIT VAULT

To start Oracle Audit Vault:

1. SSH to the host where Oracle Audit Vault is installed.

2. Run the command avctl start_av. 

Sample output:

AVCTL started

Starting OC4J...

OC4J started successfully.

TZ set to US/PacificOracle Audit Vault 10g Database Control Release 

10.2.3.1.0  Copyright (c) 1996, 2008 Oracle Corporation.  All rights 

reserved.

http://auditvault1:5700/av

Oracle Audit Vault 10g is running.
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STOPPING ORACLE AUDIT VAULT

To stop Oracle Audit Vault:

1. SSH to the host where Oracle Audit Vault is running.

2. Run the command: avctl stop_av to stop Oracle Audit Vault and the entire 
Oracle Application Server. This may take a while.

Sample output:

AVCTL started

Stopping OC4J...

OC4J stopped successfully.

Hint: If this command fails to stop Oracle Audit Vault, you may need to kill the 

processes one by one running the kill -9 nnnn (where nnnn is the 

process ID).
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Asset Management
This section consists of the following chapters:

•  Understanding Asset Management

•  Asset Search.
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Understanding Asset 
Management
This chapter consists of the following topics:

•  What is Asset Management?

•  Displaying the Asset Management Page.

What is Asset
Management?

Starting with version 6.0, DbProtect includes a new beta feature called Asset Asset Asset Asset 
ManagementManagementManagementManagement which, in its current form, allows you to filter and query your database 
assets. A database assetassetassetasset, by definition, refers to any database in your enterprise that 
utilizes DbProtect’s    Vulnerability Management and DbProtect Audit and Threat 
Management technology. In other words, if your database has a Scan Engine or a 
Sensor installed, it’s a manageable asset.

In future releases, Application Security, Inc. plans to expand the Asset Management 
feature to allow you to manage virtually allallallall aspects of your asset inventory. For the time 
being, you must still conduct most Asset Management tasks using the Vulnerability 
Management tools and features described in the Vulnerability Management section of 
this guide.

The beta release of Asset Management includes Asset SearchAsset SearchAsset SearchAsset Search capabilities, which allow 
you to search your database assets based on specific filter and query criteria. You can 
save Asset Search queries for future use without having to repeat the process of re-
configuring an Asset Search from scratch; for more information, see Asset Search.
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Displaying the
Asset

Management Page

To display the Asset ManagementAsset ManagementAsset ManagementAsset Management page, and access the Asset Management tools, 
click the Asset Management Asset Management Asset Management Asset Management application tab from any DbProtect Console page; for 
more information on using the application tabs, see Application Tabs.

FIGURE: Asset Management Asset Management Asset Management Asset Management page (default SearchSearchSearchSearch tab selected)

Currently, Asset Search is the only available Asset Management tool; for more 
information, see Asset Search.
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Asset Search
This chapter consists of the following topics:

•  What is an Asset Search?

•  Displaying the Asset Management Page

•  Understanding the Components of Asset Search

•  Performing an Asset Search

•  Saving Your Asset Search as a Query

•  Working with Saved Asset Search Queries

•  Deleting a Saved Asset Search Query.

What is an Asset
Search?

Asset SearchAsset SearchAsset SearchAsset Search is an Asset Management tool that allows you to identify which database 
assets match specific Asset Search free-form query and/or filter tool criteria. 
Performing an Asset Search lets you quickly find out answers to questions like:

•  “How many Oracle database assets are in my enterprise?”

•  “Which database assets with a network address starting with 172 are in my 
enterprise?”

•  “How many database assets in my enterprise are running on Windows?”

•  “Which database assets in my enterprise belong to a specific Organization?”

•  “Which database assets in my enterprise have fired Alerts in the past month?”

•  “Which database assets in my enterprise have weak passwords and patchable 
vulnerabilities?”

Most Asset Searches consist of a combinationcombinationcombinationcombination of filter and search terms, e.g., “How 
many Oracle databases on Windows have fired Alerts in the past month?” Importantly, 
the Asset Search filter tools and the free-form query field are notnotnotnot mutually exclusive. In 
other words, for maximum efficiency you can perform your Asset Search using bothbothbothboth 
the Asset Search filter tools and the free-form query field.
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Understanding the
Components of

Asset Search

As explained in Displaying the Asset Management Page, you display the Asset Asset Asset Asset 
ManagementManagementManagementManagement page by clicking the Asset Management Asset Management Asset Management Asset Management application tab from any 
DbProtect Console page; for more information. Currently, Asset Search is the only 
Asset Management tool that displays on the Asset ManagementAsset ManagementAsset ManagementAsset Management page.

The componentscomponentscomponentscomponents of Asset Search are labeled below.

FIGURE: Asset Search

This topic consists of the following sub-topics:

•  Understanding the Asset Search Tabs

•  Understanding the Navigation and Viewing Panes.

UNDERSTANDING THE ASSET SEARCH TABS

Asset Search consists of two tabstabstabstabs: the SearchSearchSearchSearch tab and the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab.

FIGURE: Asset Search tabs

Tabs

Navigation pane Viewing pane
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When the default SearchSearchSearchSearch tab is selected, you can perform your Asset Search by 
entering valid search parameters in the free-form query field and/or by using the filter 
tools. For more information, see Performing an Asset Search. In addition, when the 
SearchSearchSearchSearch tab is selected, you can save your Asset Search as a query; for more 
information, see Saving Your Asset Search as a Query.

When the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab is selected, you can:

•  retrieve your saved Asset Search queries; for more information, see Working 
with Saved Asset Search Queries

•  delete a saved asset management query; for more information, see Deleting a 
Saved Asset Search Query.

UNDERSTANDING THE NAVIGATION AND VIEWING PANES

Regardless of which tab you select, Asset Search consists of two panes: the navigation navigation navigation navigation 
panepanepanepane (on the left) and the viewing pane viewing pane viewing pane viewing pane (on the right). The actual contents of these 
panes depends on which Asset Search tab is selected.

When the SearchSearchSearchSearch tab is selected, the navigation pane displays the free-form query 
field and the Asset Search filter tools, which allow you to perform your Asset Search.

FIGURE: Navigation pane (SearchSearchSearchSearch tab selected)
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After you perform your Asset Search, the viewing paneviewing paneviewing paneviewing pane (shown below) displays your 
Asset Search results.

FIGURE: Viewing pane (Asset Search results)

Note:Note:Note:Note: The columns of your Asset Search results (in the viewing pane) are 
sortable. To sort your Asset Search data, click a column header. For 
example, if you want to sort your Asset Search data by asset type, then 
click the TypeTypeTypeType column header.

For more information, see Performing an Asset Search.

On the other hand, when the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab is selected, the navigation pane 
displays any saved Asset Search queries.

FIGURE: Viewing pane (Saved Queries Saved Queries Saved Queries Saved Queries tab selected)

You can select one or more saved Asset Search queries and:

•  modify or run them; for more information, see Working with Saved Asset Search 
Queries

•  delete them; for more information, see Deleting a Saved Asset Search Query.
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Performing an
Asset Search

When the SearchSearchSearchSearch tab is selected, you can configure your Asset Search using the:

•  free-form query fieldfree-form query fieldfree-form query fieldfree-form query field, which allows you to enter query parameters; for more 
information, see Understanding the Asset Search Free-Form Query Field

•  filter toolsfilter toolsfilter toolsfilter tools, which are broken down into categories; for more information, see 
Understanding the Asset Search Filter Tools.

As noted earlier, the Asset Search free-form query field and filter tools are notnotnotnot mutually 
exclusive. In other words, you can perform your Asset Search using bothbothbothboth the free-form 
query field and the filter tools.

FIGURE: Free-form query field, filter tools, and the run query button

Asset Search free-form 

Run query button

query field

Filter tools
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To run an Asset Search using the Asset Search free-form query field and/or filter tools, 
do the following:

1. Click the Search tab (in the upper-left portion of the Asset Management page).

2. In the navigation pane:

•  enter query terms in the free-form query field; for more information, see 
Understanding the Asset Search Free-Form Query Field

•  use the categorized Asset Search filter toolsfilter toolsfilter toolsfilter tools to fine-tune your Asset Search; for 
more information, see Understanding the Asset Search Filter Tools.

3. Click the run query button run query button run query button run query button (next to the free-form query field) to run your 
query. Your Asset Management query results will display in the viewing 
pane; for more information, see Understanding the Navigation and 
Viewing Panes.

The results of your Asset Search display in the following sortable columns:

•  TypeTypeTypeType

•  OSOSOSOS

•  Asset NameAsset NameAsset NameAsset Name

•  DatabaseDatabaseDatabaseDatabase.

Furthermore, you can click the + + + + icon next to any asset to expand individual assets (as 
shown below).

FIGURE: Viewing pane (expanded Asset Search results)
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UNDERSTANDING THE ASSET SEARCH FREE-FORM QUERY 

FIELD

The Asset Search free-form query fieldfree-form query fieldfree-form query fieldfree-form query field in the navigation pane (shown below) allows 
you to fine-tune your Asset Search by entering specific query parameters.

Important: As noted earlier, the Asset Search free-form query field and filter tools are 
notnotnotnot mutually exclusive. In other words, you can perform your Asset Search 
using bothbothbothboth the free-form query field and the filter tools.

FIGURE: Free-form query field

When you enter query terms in the free-form query field, DbProtect searches your 
assets across the following attributes:

•  Asset nameAsset nameAsset nameAsset name

•  Database instance nameDatabase instance nameDatabase instance nameDatabase instance name

•  Host addressHost addressHost addressHost address

•  PortPortPortPort.

Hint: You can click the >reset link to clear the free-form query field.

You can enter multiple query terms (separated by a space) to further narrow your Asset 
Search results. Asset Search only returns assets which have include each search term as 
part of at least one at least one at least one at least one of its attributes (i.e., asset name, instance name, host address, or 
port number).

For example, if you enter the query terms 172.16 ora 1521 (as displayed above), 
Asset Search returns assets where:

•  the asset nameasset nameasset nameasset name OR instance nameinstance nameinstance nameinstance name OR host addresshost addresshost addresshost address OR port numberport numberport numberport number contain 
172.16

AND

•  the asset nameasset nameasset nameasset name OR instance nameinstance nameinstance nameinstance name OR host addresshost addresshost addresshost address OR port numberport numberport numberport number contain 
ora

AND

•  the asset nameasset nameasset nameasset name OR instance nameinstance nameinstance nameinstance name OR host addresshost addresshost addresshost address OR port numberport numberport numberport number contain 
1521

Hint: You cannot use * wildcards in the free-form query field. Use partial query 

terms instead (which works the same as using a * wildcard).

Free-form query field
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UNDERSTANDING THE ASSET SEARCH FILTER TOOLS

The Asset Search filter tools filter tools filter tools filter tools in the navigation pane    are broken down into categoriescategoriescategoriescategories 
(e.g., DatabasesDatabasesDatabasesDatabases, NetworksNetworksNetworksNetworks, PlatformsPlatformsPlatformsPlatforms, etc.).

Each Asset Search filter tool category is comprised of facetsfacetsfacetsfacets (and sub-facets) of 
searchable data attributes. The filter tools allow you to fine-tune your Asset Search 
according to broad (or narrow) search parameters.

Important: As noted earlier, the Asset Search free-form query field and filter tools are 
notnotnotnot mutually exclusive. In other words, you can perform your Asset Search 
using bothbothbothboth the free-form query field and the filter tools.

FIGURE: Filter tools

Filter tool category

Facets and sub-facets

Filter tool category

Filter tool category
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Initially, the navigation pane displays four open filter tool categories (i.e., DatabasesDatabasesDatabasesDatabases, 
NetworksNetworksNetworksNetworks, PlatformsPlatformsPlatformsPlatforms, and OrganizationsOrganizationsOrganizationsOrganizations) and two closed filter tool categories (i.e., 
FindingsFindingsFindingsFindings and ThreatsThreatsThreatsThreats).

The following table explains each available filter tool link and icon, and how facets and 
sub-facets work within Asset Search. 

Filter tool link/icon Description

moremoremoremore link Click the moremoremoremore link to display more 
filter tool options.

lesslesslessless link Click the lesslesslessless link to display fewer 
filter tool options.

up arrow icon Click the up arrow iconup arrow iconup arrow iconup arrow icon to open a filter 
tool.

down arrow icon Click the down arrow icondown arrow icondown arrow icondown arrow icon to close a 
filter tool.
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When a filter tool category is initially closed, Asset Search does notnotnotnot apply a filter 
condition for that category. For example, if you don’t open the ThreatsThreatsThreatsThreats filter tool 
category, Asset Search does notnotnotnot consider the ThreatsThreatsThreatsThreats filter tool category during the 
Asset Search. In other words, it will return assets whether or not they are being 
monitored and whether or not Alerts have been received for those assets.

Note:Note:Note:Note: If you open a filter tool category, make selections, and then close the filter 
tool category, your selections will be applied to the Asset Search despite 
the filter tool category is closed.

Similarly, if you check the AllAllAllAll facet checkbox, then Asset Search does notnotnotnot apply a filter 
condition for a given filter tool category. For example, if you check the AllAllAllAll facet 
checkbox in the PlatformsPlatformsPlatformsPlatforms filter tool category, then DbProtect will perform an Asset 
Search on allallallall platforms. On the other hand, if you uncheck the AllAllAllAll facet checkbox (in 
the Platforms filter tool category) and, instead, only check the Microsoft Windows  Microsoft Windows  Microsoft Windows  Microsoft Windows sub-
facet checkbox, then DbProtect will only return assets that run on Microsoft Windows.

facet/sub-facet arrow icons

 

All filter tool categories employ facetsfacetsfacetsfacets 
and sub-facetssub-facetssub-facetssub-facets to reduce the volume 
of displayed data. A facet is an 
attribute within a given filter tool 
category. For example, All All All All is a facet 
within the DatabasesDatabasesDatabasesDatabases category, i.e., all 
databases.

A sub-facet is an attribute that is 
logically related to its parent facet (for 
example, OracleOracleOracleOracle, SybaseSybaseSybaseSybase, and IBM IBM IBM IBM 
DB2 DB2 DB2 DB2 are sub-facets of the parent facet 
AllAllAllAll databases).

In some cases, you can “drill down” 
to the sub-sub-facet level. For 
example, the sub-facet OracleOracleOracleOracle 
contains Oracle version sub-sub-
facets, i.e., Oracle 10g DatabaseOracle 10g DatabaseOracle 10g DatabaseOracle 10g Database, 
Oracle 11g DatabaseOracle 11g DatabaseOracle 11g DatabaseOracle 11g Database, etc.

When an arrow iconarrow iconarrow iconarrow icon displays next to a 
facet, you know the facet contains 
sub-facets. Likewise, when an arrow 
icon displays next to a sub-facet, you 
know the sub-facet contains sub-sub-
facets.

Click the arrow icons to expand (and 
contract) the facets and sub-facets 
beneath.

Filter tool link/icon Description

Facet

Sub-
facets

Sub-sub-
facets

Sub-
facets
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The following table lists each filter tool category. 

Asset Search filter tool category Description

NetworksNetworksNetworksNetworks This filter tool category allows you to run a 
query against assets in your enterprise 
according to specific network IP addresses. 
For example, if you want to know which 
assets in your enterprise have a network 
address starting with 172, you would only 
check the 192.*.*.*192.*.*.*192.*.*.*192.*.*.* sub-facet checkbox in 
the Networks Networks Networks Networks filter tool category.

You can check the AllAllAllAll facet checkbox to 
run a query against allallallall network IP 
addresses, or you can uncheck the AllAllAllAll facet 
checkbox and, instead, select individual 
network IP address prefixes (where assets 
have been detected).
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PlatformsPlatformsPlatformsPlatforms This filter tool category allows you to run a 
query against assets in your enterprise 
according to specific operating systems. 
For example, if you want to know which 
assets in your enterprise run on HP UX HP UX HP UX HP UX 
Itanium 32Itanium 32Itanium 32Itanium 32 and HP UX Itanium 64HP UX Itanium 64HP UX Itanium 64HP UX Itanium 64, you 
would only check the HP UX Itanium 32 HP UX Itanium 32 HP UX Itanium 32 HP UX Itanium 32 
and HP UX Itanium 64 HP UX Itanium 64 HP UX Itanium 64 HP UX Itanium 64 sub-facet    
checkboxes in Platforms Platforms Platforms Platforms filter tool 
category.

You can check the AllAllAllAll facet checkbox to 
run a query against all platforms, or you 
can uncheck the AllAllAllAll facet checkbox and, 
instead, select individual platforms (e.g., 
Microsoft WindowsMicrosoft WindowsMicrosoft WindowsMicrosoft Windows, SolarisSolarisSolarisSolaris, LinuxLinuxLinuxLinux, etc.).

Asset Search filter tool category Description
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OrganizationsOrganizationsOrganizationsOrganizations This filter tool category allows you to run a 
query against assets in your enterprise 
according to specific Organizations. For 
example, if you want to know which assets 
are associated with your Default Default Default Default 
Monitoring OrganizationMonitoring OrganizationMonitoring OrganizationMonitoring Organization, you would only 
check the Default Monitoring OrganizationDefault Monitoring OrganizationDefault Monitoring OrganizationDefault Monitoring Organization 
sub-facet checkbox in the Organizations Organizations Organizations Organizations 
filter tool category.

You can check the AllAllAllAll facet checkbox to 
run a query against all Organizations, or 
you can uncheck the AllAllAllAll facet checkbox 
and, instead, select individual 
Organizations.

Unlike other filter tools that include pre-
configured facets, the Organizations that 
display in the Organizations Organizations Organizations Organizations Asset Search 
filter tool category depend on the 
Organizations you have created for your 
enterprise; for more information, see 
DbProtect Organizations, Users, and User 
Roles.

Asset Search filter tool category Description
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FindingsFindingsFindingsFindings This filter tool category consists of the 
following sub-categories:

• Risk. Risk. Risk. Risk. This sub-category allows you to 
perform an Asset Search according to 
the risk levels of detected findings. You 
can check the AllAllAllAll facet checkbox to 
perform an Asset Search against all 
checks where findings (of any Risk level) 
have been reported. Or uncheck the 
AllAllAllAll facet checkbox and, instead, select 
one or more of the following finding 
Risk levels: HighHighHighHigh, MediumMediumMediumMedium, LowLowLowLow, or 
InformationalInformationalInformationalInformational.

• Categories. Categories. Categories. Categories. This sub-category allows 
you to perform an Asset Search 
according to a specific category of 
detected findings. For example, maybe 
you only want to know which assets 
contain Sensors that have detected 
HighHighHighHigh risk level findings. In this case, you 
would only check the HighHighHighHigh facet 
checkbox.

• ResultsResultsResultsResults. This sub-category allows you 
to perform an Asset Search against 
your assets according to checks (in all 
Policies deployed to your Scan 
Engines) that yielded findings within a 
specified date range. You can also set a 
minimum and maximum number of 
checks with findings.

For example, let’s say you want to know 
which assets yielded findings against a 
minimum of 10 different checks in the 
month of January 2010. To do so, you 
would specify the From:  From:  From:  From: and To: To: To: To: date 
facet fields (01/01/10 and 01/31/10, 
respectively). Next, you would specify a 
Min: Min: Min: Min: number of findings (10).

Hint:Hint:Hint:Hint: You can enter the From: From: From: From: and To:To:To:To: 
dates manually using the MM/DD/
YYYY format, or you can click the 
calendar icons to display a calendar 
and select your From:From:From:From: and To: To: To: To: dates.

Asset Search filter tool category Description
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ThreatsThreatsThreatsThreats This filter tool category consists of the 
following sub-categories:

• Monitoring. Monitoring. Monitoring. Monitoring. This sub-category allows 
you to search which assets currently 
have Sensors that are monitoring (or 
Sensors that are notnotnotnot monitoring) 
threats using DbProtect Audit and 
Threat Management technology.

For example, assume you only want to 
know which assets are currently being 
monitored. In this case, you would 
check the Currently monitored Currently monitored Currently monitored Currently monitored sub-
facet    checkbox, and uncheck the 
Currently not monitoredCurrently not monitoredCurrently not monitoredCurrently not monitored checkbox. For 
more information, see Audit and Threat 
Management.

• Alerts. Alerts. Alerts. Alerts. This sub-category allows you to 
search which assets (with Sensors 
installed on them) currently contain 
Alerts, and/or which assets (with 
Sensors installed on them) currently 
contain no Alerts.

For example, assume you only want to 
know which assets (with Sensors 
installed on them) currently contain 
Alerts. In this case, you would check 
the Alerts exist Alerts exist Alerts exist Alerts exist sub-facet    checkbox 
(and uncheck the No alerts No alerts No alerts No alerts sub-facet    
checkbox).

Asset Search filter tool category Description
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Saving Your Asset
Search as a Query

To save an Asset Search as a query:

1. With the Search tab (in the upper-left portion of the Asset Management page) selected, 

click the > save link in the navigation pane to display the Save Search Query pop 

up.

FIGURE: Save Search QuerySave Search QuerySave Search QuerySave Search Query pop up

2. Enter the name of your Asset Search query in the Query Name: Query Name: Query Name: Query Name: field.

3. Click the SaveSaveSaveSave button to save your Asset Search query. Your saved Asset 
Search query will now display in the navigation pane of the Asset Asset Asset Asset 
ManagementManagementManagementManagement page when you click the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab; for more information, 

see Working with Saved Asset Search Queries.

Working with
Saved Asset

Search Queries

When the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab is selected, your saved Asset Search queries will display 
in the navigation pane. The viewing pane will display the results of your saved Asset 
Search queries (when you run them).

To select and run a saved Asset Search query:

1. Click the Saved Queries tab to display your saved queries in the navigation pane.

FIGURE: Navigation pane (Saved QueriesSaved QueriesSaved QueriesSaved Queries tab selected)

2. Select which saved Asset Search query you want to run, and it will run 
automatically. The SearchSearchSearchSearch tab is automatically selected, and your Asset 

Search query results display in the viewing pane.

Hint: You can check the Query Name checkbox to select all saved queries.
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Deleting a Saved
Asset Search

Query

When the Saved QueriesSaved QueriesSaved QueriesSaved Queries tab is selected, your saved Asset Search queries display in 
the navigation pane. You can delete one or more saved Asset Search queries.

To delete one or more saved Asset Search queries:

1. Click the Saved Queries tab to display your saved queries in the navigation pane.

FIGURE: Navigation pane (Saved QueriesSaved QueriesSaved QueriesSaved Queries tab selected)

2. Select which saved Asset Search query (or queries) you want to delete.

Hint: You can check the Query Name checkbox to select all saved queries.

3. Click the DeleteDeleteDeleteDelete button.

4. A pop up prompts you to confirm the delete.

5. Click the YesYesYesYes button to delete your selected saved Asset Search query/
queries.



DbProtect 6.1 User’s Guide

Application Security, Inc. 508

DbProtect Analytics
This section explains how to use DbProtect AnalyticsDbProtect AnalyticsDbProtect AnalyticsDbProtect Analytics, and provides an overview of the 
Dashboard and Report elements. It also includes DbProtect Analytics troubleshooting 
help.

This section consists of the following chapters:

•  Understanding DbProtect Analytics

•  DbProtect Analytics Dashboards

•  DbProtect Analytics Reports

•  DbProtect Analytics Troubleshooting.
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Understanding DbProtect 
Analytics
This chapter consists of the following topics:

•  What is DbProtect Analytics?

•  DbProtect Analytics and Compliance Reporting

•  Starting DbProtect Analytics

•  Using the Toolbar Buttons to Navigate DbProtect Analytics

•  Understanding Compliance Scores in DbProtect Analytics.

What is DbProtect
Analytics?

DbProtect Analytics is an essential component of the DbProtect suite of products. 
DbProtect Analytics includes new executive-level DashboardsDashboardsDashboardsDashboards for security, compliance, 
and operations, and a collection of ReportsReportsReportsReports (including new compliance Reports for 
NIST 800-53, SOX, PCI DSS, HIPAA and DISA-STIG, and more).

DbProtect Analytics provides a global view of your enterprise's database security 
posture. This content is designed for executives, security risk managers, IT 
administration, and any personnel involved in the enforcement of regulatory/
corporate compliance policies and database patch administration.

DbProtect Analytics    provides a convenient set of executive level Dashboards and key 
Reports that draw data from DbProtect's Vulnerability Management and Audit and 
Threat Management components.

DbProtect Analytics Dashboards provide better security and compliance transparency 
to executives and management. Dashboards are designed to support adhoc 
investigation with drill-through technology, combining assessment and monitoring 
data.
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DbProtect
Analytics and
Compliance
Reporting

The DbProtect Analytics ComplianceComplianceComplianceCompliance Dashboard charts the compliance posture across 
your inventory of databases assessed and/or monitored by the DbProtect suite of 
products. In addition, DbProtect Analytics includes a set of Reports which displays 
vulnerability and threat data mapped using DbProtect’s regulatory compliance 
mappings. Some key DbProtect Analytics compliance Reports include:

•  Healthcare Services (HIPAA)

•  Sarbanes-Oxley Act (SOX)

•  Payment Card Industry (PCI) Data Security Standards

•  National Institute of Standards and Technology (NIST).

Starting DbProtect
Analytics

DbProtect Analytics is part of DbProtect suite. When you sign into the DbProtect 
Console, you will be able to access DbProtect Analytics via the Analytics & ReportingAnalytics & ReportingAnalytics & ReportingAnalytics & Reporting 
tab. For more information on logging into the DbProtect Console, see Logging Into 
the DbProtect Console (and DbProtect Console Login Troubleshooting).

DbProtect Analytics consists of Dashboards and Reports that span your entire 
organization’s assets. The data displayed in the DbProtect Analytics Dashboards and 
drill-down reports is filtered by the “effective” Organization of the logged-in user.

Using the Toolbar
Buttons to
Navigate

DbProtect
Analytics

When you click the Analytics & ReportingAnalytics & ReportingAnalytics & ReportingAnalytics & Reporting tab (available on every DbProtect Console 
page) to display DbProtect Analytics, you will notice a group of toolbar buttonstoolbar buttonstoolbar buttonstoolbar buttons.

FIGURE: DbProtect Analytics toolbar buttons

There are two types of DbProtect Analytics toolbar buttons. They are:

•  The DashboardDashboardDashboardDashboard toolbar buttons (i.e., SecuritySecuritySecuritySecurity, ComplianceComplianceComplianceCompliance, and OperationsOperationsOperationsOperations); for 
more information, see DbProtect Analytics Dashboards

•  The Report ManifestReport ManifestReport ManifestReport Manifest toolbar button, which allows you to access DbProtect 
Analytics Reports; for more information, see DbProtect Analytics Reports

Toolbar buttons

 
Analytics & Reporting tab
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Understanding
Compliance Scores

in DbProtect
Analytics

Several DbProtect Analytics reports and Dashboards display compliance score 
information as percentages. There are six levels of compliance, described below.

•  100%. 100%. 100%. 100%. The asset was scanned and no vulnerabilities were found.

•  80%.80%.80%.80%. The asset was scanned at least one InformationalInformationalInformationalInformational vulnerability was found.

•  60%. 60%. 60%. 60%. The asset was scanned at least one LowLowLowLow vulnerability was found.

•  40%.40%.40%.40%. The asset was scanned and at least one MediumMediumMediumMedium vulnerability was found.

•  20%. 20%. 20%. 20%. The asset was scanned and at least one HighHighHighHigh vulnerability was found.

•  0%. 0%. 0%. 0%. The asset was notnotnotnot scanned.



DbProtect 6.1 User’s Guide

Application Security, Inc. 512

DbProtect Analytics 
Dashboards
This chapter consists of the following topics:

•  What are DbProtect Analytics Dashboards?

•  The Security Dashboard

•  The Compliance Dashboard

•  The Operations Dashboard.

What are
DbProtect
Analytics

Dashboards?

DbProtect Analytics provides executive DashboardsDashboardsDashboardsDashboards which contain information 
targeted toward specific areas of interest in most organizations. When you click the 
Analytics & ReportingAnalytics & ReportingAnalytics & ReportingAnalytics & Reporting tab (available on every DbProtect Console page) to display 
DbProtect Analytics, you will notice a group of toolbar buttonstoolbar buttonstoolbar buttonstoolbar buttons.

FIGURE: DbProtect Analytics toolbar buttons

The DashboardDashboardDashboardDashboard toolbar buttons (i.e., SecuritySecuritySecuritySecurity, ComplianceComplianceComplianceCompliance, and OperationsOperationsOperationsOperations) allow you 
to display the DbProtect Analytics Dashboards (i.e., the SecuritySecuritySecuritySecurity, ComplianceComplianceComplianceCompliance, and 
OperationsOperationsOperationsOperations Dashboards, respectively).

Alternately, you can click the Reports ManifestReports ManifestReports ManifestReports Manifest link to display the Reports section, 
which contains up-to-the-minute DbProtect Analytics report data; for more 
information, see DbProtect Analytics Reports.

Starting with version 1.4, DbProtect Analytics Dashboards are Organization aware. 
Meaning, the dates displayed by the DbProtect Analytics Dashboards are filtered 
based on the “effective” Organization of the logged-in user, which is displayed on 
every page of the DbProtect Console; for more information, see User ID and 
Associated “Effective” Organization. If you change your “effective” Organization (as 
explained in Setting Your “Effective” Organization), the DbProtect Analytics 
Dashboards will refresh with the date associated with your new “effective” 
Organization.

Toolbar buttons

 
Analytics & Reporting tab
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For all Organizations (other than root), the DbProtect Analytics Dashboard data that 
displays is only for the current “effective” Organization, and does not drill down to 
children Organizations. For the root Organization, however, the DbProtect Analytics 
Dashboards allow you to drill down the entire Organizational structure, encompassing 
all assets across all Organizations. DbProtect Analytics Dashboards and Reports 
display the Organizational filtering structure in the upper left portion of each 
Dashboard and Report page.

The Security
Dashboard

The Security DashboardSecurity DashboardSecurity DashboardSecurity Dashboard consists of the following elements:

•  Vulnerabilities by Severity

•  Threats by Severity.

VULNERABILITIES BY SEVERITY 

The Vulnerabilities by Severity Vulnerabilities by Severity Vulnerabilities by Severity Vulnerabilities by Severity Dashboard element computes the most recent result 
for any assessment test that was run within the scope of the associated Report. If the 
test revealed a vulnerability, it is aggregated into this Dashboard according to its 
severity and category. For tests that return a list of objects in violation (such as 
accounts with weak passwords, or objects with inappropriate privilege grants), the test 
result only counts as one violation.

FIGURE: Vulnerabilities by Severity Dashboard element
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THREATS BY SEVERITY 

The Threats by Severity Threats by Severity Threats by Severity Threats by Severity Dashboard element computes the distribution of monitored 
security events aggregated by severity and category. The Dashboard shows no 
informational events or internal system audit events since they are not considered 
security events.

FIGURE: Threats by Severity Dashboard element
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The Compliance
Dashboard

The Compliance DashboardCompliance DashboardCompliance DashboardCompliance Dashboard consists of the following elements:

•  Compliance Summary

•  Compliance by Database

•  Aging Scan Activity

•  Compensating Controls.

COMPLIANCE SUMMARY

The Compliance SummaryCompliance SummaryCompliance SummaryCompliance Summary Dashboard element provides a view of the managed 
databases that meet a set of criteria. This Dashboard displays compliance score 
information as percentages. There are six levels of compliance, as described in 
Understanding Compliance Scores in DbProtect Analytics.

Compliance Summary Dashboard element

COMPLIANCE BY DATABASE

The Compliance by Database Compliance by Database Compliance by Database Compliance by Database Dashboard element provides a view of the managed 
databases that meet a set of criteria. This Dashboard displays compliance score 
information as percentages. There are six levels of compliance, as described in 
Understanding Compliance Scores in DbProtect Analytics.
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In this Dashboard element, DbProtect Analytics charts each database type separately, 
displaying the proportion of compliant assets within each database type.

FIGURE: Compliance by Database Dashboard element
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AGING SCAN ACTIVITY

The Aging Scan Activity Aging Scan Activity Aging Scan Activity Aging Scan Activity Dashboard element shows the number of assets distributed 
across the age of the most recent scan data recorded for those assets. The complete 
inventory of databases is categorized into buckets of scan ranges (such as 0-30 days, 
30-60 days, etc.). The assets that fall into each range are then aggregated by type 
(such as Oracle, IBM DB2, etc.) and scan ranges. These are shown as a set of stacked 
points (one for each database type) plotted along a time axis (scan ranges). You should 
be able to discern your average scan age by looking for the median scan age in this 
plot with the highest number of assets.

FIGURE: Aging Scan Activity Dashboard element
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COMPENSATING CONTROLS

The Compensating Controls Compensating Controls Compensating Controls Compensating Controls Dashboard element shows a distribution of database 
assets that have DbProtect Audit and Threat Management turned on. All other assets 
are classified with a monitoring status of None/UnknownNone/UnknownNone/UnknownNone/Unknown.

FIGURE: Compensating Controls Dashboard element
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The Operations
Dashboard

The Operations DashboardOperations DashboardOperations DashboardOperations Dashboard consists of the following elements:

•  Database Distribution

•  Recent Scan Jobs

•  Scan Policy Usage

•  Inactivity Trends.

DATABASE DISTRIBUTION

The Database Distribution Database Distribution Database Distribution Database Distribution Dashboard element shows all discovered database 
instances aggregated by the type of asset (such as Oracle, IBM DB2, etc.). This 
inventory data does notnotnotnot include supplemental services such as Oracle listeners or 
Microsoft SQL Redirectors.

FIGURE: Database Distribution Dashboard element
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RECENT SCAN JOBS

The Recent Scan Jobs Recent Scan Jobs Recent Scan Jobs Recent Scan Jobs Dashboard element shows a list of the 15 most recent scan jobs. 
It serves as a quick snapshot of what jobs are being run, how often, status of the job, 
and the organization from which the job was executed.

FIGURE: Recent Scan Jobs Dashboard element
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SCAN POLICY USAGE

The Scan Usage Policy Scan Usage Policy Scan Usage Policy Scan Usage Policy Dashboard element displays the aggregated usage counts for 
Vulnerability Management Policies. Since these Policies are categorized as Penetration 
Test and Audit Policies, the Dashboard aggregates the usage along the same 
categories. Within each category, the proportion of individual Policy usage is stacked 
to show the relative use. This serves as an easy reference point to determine whether 
Policies are being used for assessment which deviate from corporate mandates.

FIGURE: Scan Policy Usage Dashboard element
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INACTIVITY TRENDS

The Inactivity Trends Inactivity Trends Inactivity Trends Inactivity Trends Dashboard element provides an aggregation of inactivity alerts 
over the last twelve months system wide. It is a very high-level view of overall levels of 
detected inactivity. This allows you to easily identfiy database assets that might be 
offline (or network unreachable), or have unusual usage patterns over time.

FIGURE: Inactivity Trends Dashboard element
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DbProtect Analytics Reports
This chapter consists of the following topics:

•  Navigating to the Reports

•  Running and Viewing Reports

•  Understanding the Reports.

Navigating to the
Reports

You can click the Report ManifestReport ManifestReport ManifestReport Manifest toolbar button to access DbProtect Analytics 
Reports. The Report ManifestReport ManifestReport ManifestReport Manifest page is shown below.

FIGURE: Report ManifestReport ManifestReport ManifestReport Manifest page

Available DbProtect Analytics Reports are organized by category (e.g., Risk Risk Risk Risk 
ManagementManagementManagementManagement) and subcategory (e.g., AssessmentAssessmentAssessmentAssessment), with a clickable link to generate 
each Report.

Running and
Viewing Reports

This sections explains what you need to know about Running a Report and Viewing a 
Report.

RUNNING A REPORT

To run a DbProtect Analytics Report, click the Report description (e.g., Database Database Database Database 
Findings Detailed ReviewFindings Detailed ReviewFindings Detailed ReviewFindings Detailed Review) on the Report ManifestReport ManifestReport ManifestReport Manifest page. The Report runs, and displays 
in a separate window.
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VIEWING A REPORT

Each DbProtect Analytics Report contains a drop-down icon in the upper right portion 
of the Report window. When you click the drop-down icon, the Report viewing options 
menu displays (shown below).

FIGURE: Report viewing options menu

You can click View in HTML Format, View in PDF FormatView in HTML Format, View in PDF FormatView in HTML Format, View in PDF FormatView in HTML Format, View in PDF Format, or View in Excel OptionsView in Excel OptionsView in Excel OptionsView in Excel Options to 
view your Report in HTML, PDF, or Excel formats, respectively.

Understanding the
Reports

This section provides a description of each DbProtect Analytics Report. It consists of 
the following topics:

•  DbProtect Analytics Reports At-a-Glance

•  Which DbProtect Analytics Reports Include Oracle Audit Vault Data?

•  Risk Management

•  Standards and Compliance

•  System Information.

Drop-down

icon
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DBPROTECT ANALYTICS REPORTS AT-A-GLANCE

The following table lists each available DbProtect Analytics Report (organized by 
category and subcategory), and provides a link to the Report detail.  

Category Subcategory Report

Activity 

Monitoring

Activity Monitoring - 

Monitoring

Audit Events Details with Knowledgebase Articles 

Report

Audit Events Summary Report

Latest Alerts Report

Self Audit Details with Knowledgebase Articles 
Report

Self Audit Summary Report
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Risk 

Management

Risk Management - 

Assessment

Database Findings Detailed Review Report

Database Findings Detailed Review Report (with 

Knowledgebase Articles)

Database Findings Summary Review Report

Database Findings Summary Review Report (with 

Knowledgebase Articles)

Database Inventory Report

Job Findings Detailed Review Report (with 
Knowledgebase Articles)

Job Findings Summary Review Report

Weak Passwords Report

RIsk Management - 

Monitoring

Failed Logins Review Report

Privileged Activity Report

Threat Detailed Review Report

Threat Detailed Review Report (with 

Knowledgebase Articles)

Threat Summary Review Report

Threat Summary Review Report (with 

Knowledgebase Articles)

User Activity Report

Risk Management - 
Policy Management

Available Policies Report

Knowledgebase Detail Report

Monitoring Configuration Report

Category Subcategory Report
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WHICH DBPROTECT ANALYTICS REPORTS INCLUDE ORACLE 

AUDIT VAULT DATA?

If you are using Oracle Audit Vault to audit your databases, then certain DbProtect 
Analytics Reports may include Oracle Audit Vault data. The specific DbProtect 
Analytics Reports that may include Oracle Audit Vault data are:

•  Failed Logins Review Report

•  Privileged Activity Report

•  Threat Detailed Review Report

•  Threat Detailed Review Report (with Knowledgebase Articles)

•  Sarbanes-Oxley (SOX) - Audit and Threat Management Report

•  Payment Card Industry Data Security Standard (PCI DSS) - Audit and Threat 
Management Report.

Standards 

and 

Compliance

Standards and 

Compliance - 

Assessment

Compliance Report Wizard

Health Insurance Portability and Accountability Act 

(HIPAA) - Vulnerability Assessment Report

NIST 800-53 Report

Payment Card Industry Data Security Standard (PCI 

DSS) - Vulnerability Assessment Report

Sarbanes-Oxley (SOX) - Audit and Threat 
Management Report

Standards and 

Compliance - 

Monitoring

Payment Card Industry Data Security Standard (PCI 

DSS) - Audit and Threat Management Report

Sarbanes-Oxley (SOX) - Audit and Threat 

Management Report

System 
Information

System Information - 
Diagnostics

Inactivity Alerts Report

Category Subcategory Report
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In order to include Oracle Audit Vault data in your DbProtect Analytics Reports, you 
must properly install Oracle Audit Vault and register Oracle Audit Vault within 
DbProtect. For more information, see Minimum Requirements for Using Oracle Audit 
Vault as a DbProtect Data Source in the DbProtect User’s Guide.

Activity
Monitoring

This topic explains the DbProtect Analytics Risk Management Risk Management Risk Management Risk Management Reports, and its one 
current sub-category:

•  Activity Monitoring - Monitoring

ACTIVITY MONITORING - MONITORING

Audit Events Details with Knowledgebase Articles Report

This report is designed to display detailed Audit Events with filters that allow dynamic 
filtering and an appendix of the relevant knowledgebase articles.

Audit Events Summary Report

This report is designed to display a summary of Audit Events with filters that allow 
dynamic filtering. 

Latest Alerts Report

This report is designed to display the Latest Alerts with filters that allow dynamic 
filtering. 

Self Audit Details with Knowledgebase Articles Report

This report is designed to display detailed Self Audit Events with filters that allow 
dynamic filtering and an appendix of the relevant knowledgebase articles. 

Self Audit Summary Report

This report is designed to display a summary of Self Audit Events with filters that allow 
dynamic filtering. 
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Risk Management This topic explains the DbProtect Analytics Risk Management Risk Management Risk Management Risk Management Reports, organized in 
the following sub-categories:

•  Risk Management - Assessment

•  RIsk Management - Monitoring

•  Risk Management - Policy Management.

RISK MANAGEMENT - ASSESSMENT

Database Findings Detailed Review ReportDatabase Findings Detailed Review ReportDatabase Findings Detailed Review ReportDatabase Findings Detailed Review Report

This Report provides a complete and detailed listing of the latest outside-in 
(Penetration) and inside-out (Audit) tests across all organizations. This Report groups 
the information by database instance providing deep visibility of issues within each 
database. The data and graph can be used to determine general trends, strengths and 
weaknesses of your database security.

Database Findings Detailed Review Report (with Knowledgebase Articles)Database Findings Detailed Review Report (with Knowledgebase Articles)Database Findings Detailed Review Report (with Knowledgebase Articles)Database Findings Detailed Review Report (with Knowledgebase Articles)

This Report provides a complete summary of the latest outside-in (Penetration) and 
inside-out (Audit) tests across all organizations. This Report groups the information by 
database instance providing deep visibility of issues within each database. The data 
and graph can be used to determine general trends, strengths and weaknesses of your 
database security. The last section of this Report includes an appendix of 
knowledgebase articles that correspond to the findings.

Database Findings Summary Review ReportDatabase Findings Summary Review ReportDatabase Findings Summary Review ReportDatabase Findings Summary Review Report

This Report summarizes the collection of findings, the latest results from penetration 
tests and audits, across all the databases in the organization. This Report groups the 
information by database instance (or server) which represents the depth issues within 
each database instance (or server).

Database Findings Summary Review Report (with Knowledgebase Articles)Database Findings Summary Review Report (with Knowledgebase Articles)Database Findings Summary Review Report (with Knowledgebase Articles)Database Findings Summary Review Report (with Knowledgebase Articles)

This Report provides a complete and detailed listing of the latest outside-in 
(Penetration) and inside-out (Audit) tests across all organizations. This Report groups 
the information by database instance providing deep visibility of issues within each 
database. The data and graph can be used to determine general trends, strengths and 
weaknesses of your database security. The last section of this Report includes an 
appendix of knowledgebase articles that correspond to the findings.
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Database Inventory ReportDatabase Inventory ReportDatabase Inventory ReportDatabase Inventory Report

This Report lists of all the discovered database instances (or servers). The network was 
inventoried by either an inventory import or by conducting a network sweep of IP 
addresses and investigating the responsive ports for the existence of applications 
using DbProtect AppDetective. This inventory information should be reviewed 
periodically to reconcile the systems against their business context. It is also important 
to evaluate the system versions and patch levels to ensure they are up to corporate 
standard.

Job Findings Detailed Review Report (with Knowledgebase Articles)Job Findings Detailed Review Report (with Knowledgebase Articles)Job Findings Detailed Review Report (with Knowledgebase Articles)Job Findings Detailed Review Report (with Knowledgebase Articles)

This Report provides a complete and detailed listing of the latest outside-in 
(penetration) and inside-out (audit) tests for a selected job in a given organization. You 
can use the data and graphic to determine general trends, strengths and weaknesses 
of your database security. The last section of this report includes an appendix of 
knowledgebase articles that correspond to the findings.

Job Findings Summary Review ReportJob Findings Summary Review ReportJob Findings Summary Review ReportJob Findings Summary Review Report

This Report summarizes the collection of findings, the latest results from penetration 
tests and audits, across all the databases in the organization. It also summarizes the 
most recent information which represents the job execution initiated by 
administrator(s) of the organization.

Weak Passwords ReportWeak Passwords ReportWeak Passwords ReportWeak Passwords Report

This Report shows all the occurrences of weak passwords. Weak passwords are 
vulnerabilities that have the potential for exploitation. They are much sought-after by 
hackers and can put your entire organization at risk. Weak passwords are easily 
guessable by a human or a computer within a finite timeframe. The longer the lifespan 
of a password, the weaker it becomes. Best practices suggest that regular password 
modifications combined with strong passwords helps to thwart the weak password 
threat.

RISK MANAGEMENT - MONITORING

Failed Logins Review ReportFailed Logins Review ReportFailed Logins Review ReportFailed Logins Review Report

This activity Report provides a comprehensive history of failed database connection 
attempts. This Report should be reviewed periodically to examine whether an 
unauthorized threat existed or to investigate past incidents. Excessive login failures, 
patterned login failures, failures with non-existing accounts and default accounts, are 
some indicators of possible break-in attempts and should be cause for concern.
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Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.

Privileged Activity ReportPrivileged Activity ReportPrivileged Activity ReportPrivileged Activity Report

This activity Report provides an audit trail of activity that is classified as privileged-- 
schema modifications, authorization changes, and administrative actions. This 
represents the privileged activity performed according to the active policy during the 
time of the recorded events. Regular reviews of privileged activity help to reduce the 
propagation of bad behavior and support the ability to thwart ongoing malicious 
activity. This can also be used in incident investigation. The authorized privileged 
activity can generally be matched to some change control reference, if your 
organization actively uses one.

Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.

Threat Detailed Review ReportThreat Detailed Review ReportThreat Detailed Review ReportThreat Detailed Review Report

This threat Report provides a detailed view of all the security alerts that were 
generated across the organization. This is designed to provide the complete event 
details for the selected risk-events. Security Alerts are events that are classified with 
risk levels of HighHighHighHigh, MediumMediumMediumMedium, and LowLowLowLow. These events should occur irregularly and be 
addressed in a timely manner. Any regularity of events should be questioned; it should 
become a candidate for policy change or process change.

Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.

Threat Detailed Review Report (with Knowledgebase Articles)Threat Detailed Review Report (with Knowledgebase Articles)Threat Detailed Review Report (with Knowledgebase Articles)Threat Detailed Review Report (with Knowledgebase Articles)

This threat Report provides a complete detailed view of all the security alerts that were 
generated across the organization. This depth of information can be used to 
investigate issues raised by the Threat Summary Review Threat Summary Review Threat Summary Review Threat Summary Review Report. Security Alerts are 
events that are classified with risk levels of HighHighHighHigh, MediumMediumMediumMedium, and LowLowLowLow. These events 
should occur irregularly and be addressed in a timely manner. Any regularity of events 
should be questioned; it should become a candidate for policy change or process 
change. The last section of this Report includes an appendix of knowledgebase 
articles that correspond to the findings.

Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.
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Threat Summary Review ReportThreat Summary Review ReportThreat Summary Review ReportThreat Summary Review Report

This threat Report provides a summarized view of all the security alerts that were 
generated across the organization. This is designed to support high-level analysis of 
the risk-events that occurred within the environment. This summarized information can 
be used as a starting point for deeper investigation. Security Alerts are events that are 
classified with risk levels of HighHighHighHigh, MediumMediumMediumMedium, and LowLowLowLow. These events should occur 
irregularly and be addressed in a timely manner. Any regularity of events should be 
questioned; it should become a candidate for policy change or process change.

Threat Summary Review Report (with Knowledgebase Articles)Threat Summary Review Report (with Knowledgebase Articles)Threat Summary Review Report (with Knowledgebase Articles)Threat Summary Review Report (with Knowledgebase Articles)

This is a version of the Threat Summary Review ReportThreat Summary Review ReportThreat Summary Review ReportThreat Summary Review Report that includes an appendix of 
the relevant knowledgebase articles.

User Activity ReportUser Activity ReportUser Activity ReportUser Activity Report

This activity Report provides an audit trail of user activity. This report provides activity 
details limited to a selection of users, or can provide full details on all user activity.

RISK MANAGEMENT - POLICY MANAGEMENT

Available Policies ReportAvailable Policies ReportAvailable Policies ReportAvailable Policies Report

This displays a listing of all policies that are available for use in the system. Policies are 
divided into three distinctive categories: 1) Penetration Tests; 2) Audits; and 3) Audit 
and Threat Management. The three Policy types are used to perform separate 
functions.

Knowledgebase Detail ReportKnowledgebase Detail ReportKnowledgebase Detail ReportKnowledgebase Detail Report

This Report shows knowledgebase articles for a selection of database types.

Monitoring Configuration ReportMonitoring Configuration ReportMonitoring Configuration ReportMonitoring Configuration Report

This Report lists all of the database instances that have Audit and Threat Management 
turned on with their corresponding monitoring policy. The chart represents the 
distribution of active policies across all the monitored databases.
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Standards and
Compliance

This topic explains the DbProtect Analytics Risk Management Risk Management Risk Management Risk Management Reports, organized in 
the following sub-categories:

•  Standards and Compliance - Assessment

•  Standards and Compliance - Monitoring.

STANDARDS AND COMPLIANCE - ASSESSMENT

Compliance Report WizardCompliance Report WizardCompliance Report WizardCompliance Report Wizard

This is a Report that presents the results as it maps to your selected compliance policy. 
Use this wizard to generate details that meet the compliance standards described by 
your policies.

Health Insurance Portability and Accountability Act (HIPAA) - Vulnerability Assessment Health Insurance Portability and Accountability Act (HIPAA) - Vulnerability Assessment Health Insurance Portability and Accountability Act (HIPAA) - Vulnerability Assessment Health Insurance Portability and Accountability Act (HIPAA) - Vulnerability Assessment 
ReportReportReportReport

This Report is an indicator of compliance with Health Insurance Portability and 
Accountability Act (HIPAA). This Report is based on the out-of-the-box policy that 
maps regulatory standards to the appropriate vulnerability checks. Use this Report as a 
gauge of compliance with regulatory compliance.

NIST 800-53 ReportNIST 800-53 ReportNIST 800-53 ReportNIST 800-53 Report

This Report is an indicator of compliance with NIST 800-53. NIST 800-53 is the 
recommended guideline for security controls for a federal information system. This is 
applicable to all federal agencies and any government entity that follows the NIST 
standard. The NIST 800-53 guideline breaks down security controls into six categories: 
Access Control (AC), Audit and Accountability (AU), Identification and Authentication 
(IA), Configuration Management (CM), System and Communications Protection (SC), 
and System and Information Integrity (SI). This Report provides the results of 
vulnerability findings mapped to the six security control categories.

Payment Card Industry Data Security Standard (PCI DSS) - Vulnerability Assessment Payment Card Industry Data Security Standard (PCI DSS) - Vulnerability Assessment Payment Card Industry Data Security Standard (PCI DSS) - Vulnerability Assessment Payment Card Industry Data Security Standard (PCI DSS) - Vulnerability Assessment 
ReportReportReportReport

This Report is an indicator of compliance with Payment Card Industry Data Security 
Standard (PCI DSS). This Report is based on the out-of-the-box policy that maps 
regulatory standards to the appropriate vulnerability checks. Use this Report as a 
gauge of compliance with regulatory compliance.

Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.
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STANDARDS AND COMPLIANCE - MONITORING

Payment Card Industry Data Security Standard (PCI DSS) - Audit and Threat Payment Card Industry Data Security Standard (PCI DSS) - Audit and Threat Payment Card Industry Data Security Standard (PCI DSS) - Audit and Threat Payment Card Industry Data Security Standard (PCI DSS) - Audit and Threat 
Management ReportManagement ReportManagement ReportManagement Report

This Report highlights database activity that pertains to Payment Card Industry Data 
Security Standard (PCI DSS) compliance. This Report is based on an out-of-the-box 
policy that maps regulatory standards to the appropriate Audit and Threat 
Management rules. Use this Report to summarize activity that may compromise 
compliance with this regulatory standard.

Sarbanes-Oxley (SOX) - Audit and Threat Management ReportSarbanes-Oxley (SOX) - Audit and Threat Management ReportSarbanes-Oxley (SOX) - Audit and Threat Management ReportSarbanes-Oxley (SOX) - Audit and Threat Management Report

This Report is an indicator of compliance with Sarbanes-Oxley (SOX). This Report is 
based on the out-of-the-box policy that maps regulatory standards to the appropriate 
vulnerability checks. Use this Report as a gauge of compliance with regulatory 
compliance.

Note:Note:Note:Note: If you are using Oracle Audit Vault to audit your databases, and you 
registered Oracle Audit Vault within DbProtect, this report will include 
Oracle Audit Vault data. For more information, see Working with Oracle 
Audit Vault as a DbProtect Data Source.

System
Information

This topic explains the DbProtect Analytics System Information System Information System Information System Information Report (i.e., the 
Inactivity Alerts Report), which belongs to the sub-category System Information - 
Diagnostics.

SYSTEM INFORMATION - DIAGNOSTICS

Inactivity Alerts ReportInactivity Alerts ReportInactivity Alerts ReportInactivity Alerts Report

Inactivity alerts are special diagnostic events that a Sensor sends when it does not 
detect any database activity for a pre-determined period of time. That period is 
configurable and should be evaluated for each environment to determine its 
appropriate value. Inactivity alerts can also be shut off. Inactivity at the database may 
or may not be considered normal behavior depending on its usage. Peak and Off-
peak hours, weekend and holidays, business hours are all factors that contribute to 
normal occurrences of inactivity alerts. However, if the profile of the inactivity alerts 
change, then there is reasonable cause to investigate its shift. Under normal 
circumstances, you should be able associate shifts to an environmental change. 
Otherwise, this is an indicator that the monitoring system has been modified or is 
experiencing difficulty.
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DbProtect Analytics 
Troubleshooting
This chapter consists of the following topics:

•  Resolving Problems Quickly

•  Key Issues

•  Troubleshooting Installation Errors

•  Troubleshooting Runtime Errors.

Resolving
Problems Quickly

This section provides a list of items you should gather before you contact Application 
Security, Inc. Support (support@appsecinc.com). This information allows us to rapidly 
identify the source of a problem, and provide a quick resolution. Key information 
elements include:

•  Operating System Characteristics

•  Log File to Troubleshoot Installation Problems

•  Key Configuration and Log Files.

OPERATING SYSTEM CHARACTERISTICS

It is beneficial to find out your hardware and software system characteristics in order to 
help determine if they are causing the issues you are experiencing. One easy way to 
obtain this information is to run the built-in system information utility from Microsoft.
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Do the following: 

Step Action

1 Choose Start > Run > msinfo32.exeStart > Run > msinfo32.exeStart > Run > msinfo32.exeStart > Run > msinfo32.exe. A window similar to the one below displays.

FIGURE: System InformationSystem InformationSystem InformationSystem Information window

Key information elements here for Application Security, Inc. Support are:

•••• Total / Available Physical MemoryTotal / Available Physical MemoryTotal / Available Physical MemoryTotal / Available Physical Memory

•••• Total / Available Virtual MemoryTotal / Available Virtual MemoryTotal / Available Virtual MemoryTotal / Available Virtual Memory

•••• Page File SpacePage File SpacePage File SpacePage File Space

•••• OS NameOS NameOS NameOS Name

•••• VersionVersionVersionVersion

• LocaleLocaleLocaleLocale.
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LOG FILE TO TROUBLESHOOT INSTALLATION PROBLEMS

During normal installation of the DbProtect suite components, log files are generated 
and placed in a temporary directory. You can access this directory by entering %temp% 
in Windows Explorer. Application Security, Inc. Customer Support will ask you to send 
these files if you contact them.

Caution! Since this is a technical “dump” of your install process, 

sometimes there may be credential information recorded in this 

manually generated log file. Review the contents of this log to 

remove any sensitive credential information before sending it to 

any Application Security, Inc. Customer Support professionals.

KEY CONFIGURATION AND LOG FILES

Sometimes it may be necessary for Support personnel to investigate a problem in 
more detail. In order to help us in this process, it is beneficial to collect the following 
files/directories with key information.

<DbProtect Installation Root>/Reporting/media/c8/logs

<DbProtect Installation Root>/Reporting/media/c8/configuration/

cogstartup.xml

<DbProtect Installation Root>/GUI/logs

<DbProtect Installation Root>/GUI/tomcat/conf/wrapper.conf

<DbProtect Installation Root>/GUI/tomcat/conf/Catalina/localhost

<DbProtect Installation Root>/GUI/tomcat/logs

In addition to these, it is also useful to record how the DbProtect Console and 
Analytics services are run. To verify this, do the following:

•  Choose Start > Control Panel > Administrative Tools > ServicesStart > Control Panel > Administrative Tools > ServicesStart > Control Panel > Administrative Tools > ServicesStart > Control Panel > Administrative Tools > Services.

•  Locate the services DbProtect Console, DbProtect Analytics, and Cognos 
8.

•  Right-click the service name and select PropertiesPropertiesPropertiesProperties to display the PropertiesPropertiesPropertiesProperties 
dialog box.

•  Click the Log OnLog OnLog OnLog On tab.

Record the current selection for Local System AccountLocal System AccountLocal System AccountLocal System Account, or the account specified under 
This accountThis accountThis accountThis account.
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Key Issues This section consists of the following topics:

•  Installation, Uninstallation, and Repair

•  Credential Management

•  Service Creation

•  Reports.

INSTALLATION, UNINSTALLATION, AND REPAIR

•  To uninstall DbProtect Analytics via the Start Menu (recommended), choose: 
Start > Program Files > AppSecInc > DbProtect > Uninstall AnalyticsStart > Program Files > AppSecInc > DbProtect > Uninstall AnalyticsStart > Program Files > AppSecInc > DbProtect > Uninstall AnalyticsStart > Program Files > AppSecInc > DbProtect > Uninstall Analytics.

•  When you uninstall DbProtect Analytics -- either from the Start Menu or the 
Control Panel -- you mustmustmustmust manually address some intentional cleanup items. 
The following steps need to be completed in order to cleanly remove all 
artifacts from a DbProtect Analytics installation:

-Remove the DbPAnalytics database (created at time of installation on the 
same database instance as the DbProtect Console Data Repository). You may 
do this from any of the Microsoft SQL Server tools (such as Microsoft SQL 
Management Studio or Query Analyzer). Do the following: 1.) Log in to the 
Microsoft SQL Server instance with appropriate privileges allowing you to 
drop databases. 2.) Locate the database DbPAnalytics in the Object 
Explorer. 3.) Right click the database DbPAnalytics and select DeleteDeleteDeleteDelete.

-Remove any files and folders that remain in the <DbProtect Console 
Root>/Reporting folder. You may also remove the Reporting folder. 

•  Uninstall fails if any DbProtect Console browser windows are open. Ensure all 
DbProtect Console browser windows are closed prior to uninstalling.

CREDENTIAL MANAGEMENT

DbProtect Analytics allows for both SQL and Windows authentication modes. If you 
are using SQL authentication, there is currently no UI for credential management. 
Contact the Application Security, Inc. Support team to obtain a specific utility and 
instructions to affect this type of credential change.

SERVICE CREATION

The DbProtect Analytics installer prompts the user for service log on credentials. If a 
user is specified but not domain-qualified (such as domain\user). For local users, use 
the host name instead of the domain), the service credential setting is reverted to Log Log Log Log 
On as Local SystemOn as Local SystemOn as Local SystemOn as Local System. Open the ServicesServicesServicesServices dialog box (choose Start > Control Panel > Start > Control Panel > Start > Control Panel > Start > Control Panel > 
Administrative Tools > ServicesAdministrative Tools > ServicesAdministrative Tools > ServicesAdministrative Tools > Services) and set the appropriate account credentials from the 
Log On tab, after you complete the installation.
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REPORTS

DbProtect Analytics includes a set of export options that allows you to save report 
data in a number of XLS/CSV formats. If you see a flash, but do not successfully export 
any content when you select one of these options, ensure the following:

•  You do not have an active pop up blocker that is closing the window.

OR 

•  Your browser’s security settings allow the DbProtect Console site to open 
windows and download file content. You may need to add the DbProtect 
Console site to your list of trusted sites.

OR

•  In the case of generating an Excel spreadsheet (XLS) report, make sure you 
have enabled Automatic prompting for file downloadsAutomatic prompting for file downloadsAutomatic prompting for file downloadsAutomatic prompting for file downloads within Internet Explorer. 
To do so, choose: Internet Options > Security Tab > Custom Level > Internet Options > Security Tab > Custom Level > Internet Options > Security Tab > Custom Level > Internet Options > Security Tab > Custom Level > 
Downloads > Automatic prompting for file downloads > EnableDownloads > Automatic prompting for file downloads > EnableDownloads > Automatic prompting for file downloads > EnableDownloads > Automatic prompting for file downloads > Enable.

Troubleshooting
Installation Errors

This section explains how to troubleshoot common DbProtect Analytics installationinstallationinstallationinstallation 
errors. It consists of the following topics:

•  "The Setup Wizard determined that this is not enough space to install 
DbProtect Analytics”

•  "Your machine has XXX MB of physical memory; at least YYY GB is required to 
install DbProtect Analytics”

•  "Your machine has XXX MB of physical memory; at least YYY GB is 
recommended to install DbProtect Analytics”

•  "This account does not have logon as service right or account privileges could 
not be obtained”

•  "DbProtect Analytics Setup Wizard was interrupted”

•  “DbProtect Analytics Setup Wizard ended prematurely”.
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"THE SETUP WIZARD DETERMINED THAT THIS IS NOT 

ENOUGH SPACE TO INSTALL DBPROTECT ANALYTICS”

FIGURE: "The Setup Wizard determined that this is not enough space to install DbProtect 
Analytics” error message

DbProtect Analytics is installed as an add-on component to DbProtect Console, in the 
same drive location as the DbProtect Console. For more information, see the 
DbProtect Installation Guide.
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"YOUR MACHINE HAS XXX MB OF PHYSICAL MEMORY; AT 

LEAST YYY GB IS REQUIRED TO INSTALL DBPROTECT 

ANALYTICS”

FIGURE: "Your machine has XXX MB of physical memory; at least YYY GB is required to install 
DbProtect Analytics” error message

DbProtect Analytics enforces that at least 1 GB of RAM is present to complete the 
installation. This allows you to complete the installation process, but may yield poor 
performance except with very small data sets. Make sure you meet all the physical 
hardware requirements before you install. For more information, see the DbProtect 
Installation Guide.
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"YOUR MACHINE HAS XXX MB OF PHYSICAL MEMORY; AT 

LEAST YYY GB IS RECOMMENDED TO INSTALL DBPROTECT 

ANALYTICS”

FIGURE: "Your machine has XXX MB of physical memory; at least YYY GB is recommended to 
install DbProtect Analytics” error message

There is enough memory to proceed with the installation; however, it is below the 
recommended hardware configuration. Please make sure you meet all the physical 
hardware requirements before you install. For more information, see the DbProtect 
Installation Guide.

Memory warning
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"THIS ACCOUNT DOES NOT HAVE LOGON AS SERVICE RIGHT 

OR ACCOUNT PRIVILEGES COULD NOT BE OBTAINED”

FIGURE: "This account does not have logon as service right or account privileges could not be 
obtained” error message

DbProtect Analytics runs as two services: DbProtect Analytics and Cognos 8. The 
credentials you enter into the installer for a runtime user are used to run this service. 
The account you are using to run the installer needs to have the necessary privileges 
to check for the Log on as a service Log on as a service Log on as a service Log on as a service rights. The specified runtime user needs to have 
these rights granted to them. Make sure you have the necessary privileges and 
accounts listed in What You Will Need.
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"DBPROTECT ANALYTICS SETUP WIZARD WAS 

INTERRUPTED”

FIGURE: "DbProtect Analytics Setup Wizard was interrupted” error message

This screen confirms that you have aborted an in-progress DbProtect Analytics 
installation. If you received this unexpectedly, click the Finish Finish Finish Finish button, then confirm the 
installation has exited by checking the Task ManagerTask ManagerTask ManagerTask Manager. Once the installer process has 
exited, you may restart the installation.
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“DBPROTECT ANALYTICS SETUP WIZARD ENDED 

PREMATURELY”

FIGURE: “DbProtect Analytics Setup Wizard ended prematurely” error message

This screen confirms that the DbProtect Analytics installation has failed. There are 
many environmental factors that might lead to a failure. Typically, these failures are 
related to login rights (either for the database instance, or on the host), or to lack of 
hardware resources on the host. Please make sure you have the necessary privileges 
and accounts enumerated in the section What You Will Need.
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Troubleshooting
Runtime Errors

This section explains how to troubleshoot common DbProtect Analytics runtimeruntimeruntimeruntime 
errors. It consists of the following topics:

•  The Analytics & Reporting Tab is Disabled/Grayed Out

•  The Message “CAM-AAA-1079 The 3rd party provider returned an 
unrecoverable exception” Displays When You Navigate to the Analytics tab, 
from DbProtect Console

•  Upon Navigating to the Analytics Tab Within DbProtect Console, the Message 
“The Cognos gateway is unable to connect to the Cognos BI server” Displays

•  The “Your report is running, please wait …” Page Displays for a Long Time

•  The Message “RSV-XXX-XXXX The request 'asynchWait_Request' failed 
because the Conversation was already canceled” Appears in Place of a Report 
or Dashboard

•  The Message “RSV-XXX-XXXX The absolute affinity request 
'asynchWait_Request' failed, the requested session does not exist” Displays in 
Place of a Report or Dashboard

•  Excel Spreadsheet Report Generation Fails With a DPR-ERR-2079 Firewall 
Security Rejection Error Message

THE ANALYTICS & REPORTING TAB IS DISABLED/GRAYED 

OUT

The DbProtect Console connects to and identifes the DbProtect Analytics service 
during startup. If the DbProtect Console is unable to detect whether DbProtect 
Analytics was installed, the Analytics & ReportingAnalytics & ReportingAnalytics & ReportingAnalytics & Reporting tab in the DbProtect Console is 
disabled.

In some cases (especially when a server has less than the minimum hardware 
specifications, as explained in the DbProtect Installation Guide), the DbProtect 
Console might start up, without DbProtect Analytics starting.

Make sure DbProtect Analytics was installed successfully, and verify that both the 
DbProtect Analytics and Cognos 8 services are up and running on your server. Then 
restart the DbProtect Console service.
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THE MESSAGE “CAM-AAA-1079 THE 3RD PARTY PROVIDER 

RETURNED AN UNRECOVERABLE EXCEPTION” DISPLAYS 

WHEN YOU NAVIGATE TO THE ANALYTICS TAB, FROM 

DBPROTECT CONSOLE

FIGURE: “CAM-AAA-1079 The 3rd party provider returned an unrecoverable exception” error 
message

This error typically confirms that you have tried to navigate to DbProtect Analytics 
without first authenticating to DbProtect Console. Since DbProtect Analytics is an add-
on portal within DbProtect Console, only authenticated users are allowed to access 
the Analytics portal. Please identify a suitable user and authenticate to DbProtect 
Console as that user. Then select the AnalyticsAnalyticsAnalyticsAnalytics tab to navigate to DbProtect Analytics. 
For more information, see Navigating the DbProtect Analytics Portal.

UPON NAVIGATING TO THE ANALYTICS TAB WITHIN 

DBPROTECT CONSOLE, THE MESSAGE “THE COGNOS 

GATEWAY IS UNABLE TO CONNECT TO THE COGNOS BI 

SERVER” DISPLAYS

FIGURE: “The Cognos gateway is unable to connect to the Cognos BI server” error message
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If the error message “The Cognos gateway is unable to connect to the Cognos BI “The Cognos gateway is unable to connect to the Cognos BI “The Cognos gateway is unable to connect to the Cognos BI “The Cognos gateway is unable to connect to the Cognos BI 
server” server” server” server” displays, the server may be unavailable or the gateway may not be correctly 
configured. Try again or contact your administrator.

This error typically confirms that the DbProtect Analytics service (Cognos 8) is not 
running. This may be because it was not set to start up automatically, or the service 
user did not have the necessary rights. Start the service, exit, log back in to DbProtect 
Console, and navigate to DbProtect Analytics. If you need to validate the runtime 
user's privileges, see What You Will Need.

THE “YOUR REPORT IS RUNNING, PLEASE WAIT …” PAGE 

DISPLAYS FOR A LONG TIME

FIGURE: “Your report is running, please wait” page

This page displays when DbProtect Analytics is preparing a Report or computing a 
Dashboard.

If this message displays for a long time on your Reports and Dashboards, you should 
verify your hardware configuration; for more information, see the DbProtect 
Installation Guide.
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THE MESSAGE “RSV-XXX-XXXX THE REQUEST 

'ASYNCHWAIT_REQUEST' FAILED BECAUSE THE 

CONVERSATION WAS ALREADY CANCELED” APPEARS IN 

PLACE OF A REPORT OR DASHBOARD

FIGURE: “RSV-XXX-XXXX The request 'asynchWait_Request' failed because the Conversation 
was already canceled” error message

This message often displays when the host running DbProtect Console and DbProtect 
Analytics is starved of resources, or the SQL Server database repository is slow or non-
responsive.

If this is a sporadic problem, click on the RetryRetryRetryRetry link. This re-issues the request and the 
element or page should repaint normally. If this is a regular problem, consider whether 
your hardware environment continues to be within the recommended parameters. If 
you are operating on large data sets, it is important you have enough processor and 
memory resources, both on the host running DbProtect Analytics as well as the host 
running SQL Server. You should verify your hardware configuration; for more 
information, see the DbProtect Installation Guide.

THE MESSAGE “RSV-XXX-XXXX THE ABSOLUTE AFFINITY 

REQUEST 'ASYNCHWAIT_REQUEST' FAILED, THE REQUESTED 

SESSION DOES NOT EXIST” DISPLAYS IN PLACE OF A 

REPORT OR DASHBOARD

This message displays when the browser's session with DbProtect Analytics has timed 
out. Your browser may have been idle for a long time, or you may have participated in 
navigation that caused the DbProtect Analytics session to be abandoned. Close the 
browser, or locate a valid DbProtect Console browser session, and navigate to 
DbProtect Analytics; for more information, see Navigating the DbProtect Analytics 
Portal.
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EXCEL SPREADSHEET REPORT GENERATION FAILS WITH A 

DPR-ERR-2079 FIREWALL SECURITY REJECTION ERROR 

MESSAGE

This message displays if you are trying to generate an Excel spreadsheet (XLS) report, 
and you have not not not not enabled Automatic prompting for file downloadsAutomatic prompting for file downloadsAutomatic prompting for file downloadsAutomatic prompting for file downloads within Internet 
Explorer.

To do so, choose: Internet Options > Security Tab > Custom Level > Downloads > Internet Options > Security Tab > Custom Level > Downloads > Internet Options > Security Tab > Custom Level > Downloads > Internet Options > Security Tab > Custom Level > Downloads > 
Automatic prompting for file downloads > EnableAutomatic prompting for file downloads > EnableAutomatic prompting for file downloads > EnableAutomatic prompting for file downloads > Enable.
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Appendices
What you will find in this chapter:What you will find in this chapter:What you will find in this chapter:What you will find in this chapter:

•  Appendix A: Creating a User Credentials File

•  Appendix B: Monitoring Oracle Databases in an Oracle Fail Safe Environment: 
Sensor and Cluster Configuration Steps

•  Appendix C: Installing and Configuring a Host-Based Sensor for Oracle to 
Monitor Oracle Databases on an Oracle RAC

•  Appendix D: Oracle Critical Patch Update Detection

•  Appendix E: Importing Session Data with the DbProtect Import Utility

•  Appendix F: Using the Configuration Manager Tool

•  Appendix G: Moving or Changing Your DbProtect Back-End Database

•  Appendix H: Manually Changing the Logging Level for the Console by 
Modifying the log4j.properties File

•  Appendix I: Required Audit Privileges

•  Appendix J: Fix Scripts (Detail)

•  Appendix K: Backing Up, Restoring, Archiving, and Purging Alerts

•  Appendix L: Open Ports (on Computers Running Microsoft SQL Server) 
Required to Run Discoveries, Pen Tests, and Audits.
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Appendix A: Creating a User 
Credentials File
This appendix consists of the following topics:

•  What is a User Credentials File?

•  Converting to the .xml file format from the legacy flat file format

•  Current User Credentials File format (.xml file)

•  Legacy User Credentials File format (flat file).

What is a User
Credentials File?

The User Credentials FileUser Credentials FileUser Credentials FileUser Credentials File includes the administration user’s operating system user 
name, operating system password, system privileges, database username, and 
database password.

You mustmustmustmust provide database and operation system authentication credentials in order 
to run an Audit Job. If you don’t use a Credential Profile (see Working with Credential 
Profiles and User Credential Files), you can import a properly-formatted User 
Credentials File (explained below).

All users (except View Users) can importimportimportimport a User Credentials File from an .xml file. This 
file mustmustmustmust be properly-formatted or the import will fail, and the credentials will remain 
unchanged.

Note:Note:Note:Note: Super Admin users can also exportexportexportexport a User Credentials File.

For more information on:

•  importing a User Credentials File, see Importing a User Credentials File

•  exporting a User Credentials File, see Exporting a User Credentials File.

Note:Note:Note:Note: If you have multiple database instances installed on a single host, and you 
want to Audit them all, you can enter separate credentials for each 
instance. However, you can only enter a single (per AppDetective Scan 
Engine) global listener password in order to Discover Oracle database 

instances. For more information, see Creating an Audit Job.
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Converting to the
.xml file format
from the legacy
flat file format

Past versions of DbProtect AppDetective allowed you to import credentials from a flat 
file. The flat file format is The flat file format is The flat file format is The flat file format is notnotnotnot recommended. recommended. recommended. recommended.

The .xml format developed by Application Security, Inc. allows for better readability of 
the credentials file, as well as encryption of application passwords. The .xml format is 
now considered the standard.

However, Application Security, Inc. has notnotnotnot disabled the importing of the flat files for 
backwards compatibility. If you are currently using a flat file to import credentials, 
Application Security, Inc. strongly encouragesstrongly encouragesstrongly encouragesstrongly encourages you to switch to the new, standard, and 
vastly superior .xml format. To do so, you must first import the flat file, then export it. 
DbProtect AppDetective automatically converts the flat file to the proper format.

For more information on:

•  importing a User Credentials File, see Importing a User Credentials File

•  exporting a User Credentials File, see Exporting a User Credentials File.

Current User
Credentials File
format (.xml file)

The .xml file is simple to create manually, assuming you have basic .xml skills. Please 
refer to the schema provided below for this. If you have exported a file with 
encryption, and you want to add a new credential set, this can be done by editing the 
file. It is allowed for some of the credentials in the file to be encrypted, while others are 
not.

Caution! If you select the option to encrypt the application passwords, a 

number of elements and attributes will be added to support 

encryption (encryption, encryptionUsed, verificationString, 

salt, encrypted). It is highly discouraged that the user add, 

remove, or change values of these elements and attributes, as 

this will likely lead to an unreadable .xml file.

Importing does notnotnotnot change the file it imports, and exporting overwrites an existing file, 
so be careful that all the credentials you want to export were correctly imported into 
the current set of subnets and applications.

For example, it is possible to import a credential file with a dozen nodes, although you 
have only selected one node with the Application PickerApplication PickerApplication PickerApplication Picker tool. In this case, exporting 
the credentials with only one node selected will only export the credentials for the one 
application. If you overwrite the existing credential file, you will lose the other 11 
credentials.

Below is the current User Credentials File format schema, written in RelaxNG format:

<?xml version="1.0"?>

<grammar xmlns="http://relaxng.org/ns/structure/1.0" 

datatypeLibrary="http://www.w3.org/2001/XMLSchema-datatypes">

<start>
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<element name="credentials">

<optional>

<ref name="encryptElement"/>

<!-- This element must only be used if any of the passwords in the file 

are encrypted. -->

</optional>

<interleave>

<optional>

<ref name="networkElement"/>

</optional>

<zeroOrMore>

<ref name="subnetElement"/>

</zeroOrMore>

<zeroOrMore>

<ref name="hostElement"/>

</zeroOrMore>

<zeroOrMore>

<ref name="appElement"/>

</zeroOrMore>

</interleave>

</element>

</start>

<define name="encryptElement">

<element name="encryption">

<attribute name="encryptionUsed"><text/></attribute>

<attribute name="verificationString"><text/></attribute>

<ref name="saltAttribute"/>

</element>

</define>

<define name="networkElement">

<element name="network">

<zeroOrMore>

<ref name="pairElement"/>

</zeroOrMore>

</element>

</define>

<define name="subnetElement">

<element name="subnet">

<ref name="ipAttribute"/>

<zeroOrMore>

<ref name="pairElement"/>

</zeroOrMore>

</element>
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</define>

<define name="hostElement">

<element name="host">

<choice>

<ref name="ipAttribute"/>

<ref name="hostnameAttribute"/>

</choice>

<zeroOrMore>

<ref name="pairElement"/>

</zeroOrMore>

</element>

</define>

<define name="appElement">

<element name="app">

<choice>

<ref name="ipAttribute"/>

<ref name="hostnameAttribute"/>

</choice>

<ref name="portAttribute"/>

<attribute name="instance"><text/></attribute>

<ref name="pairElement"/>

</element>

</define>

<define name="pairElement">

<element name="pair">

<interleave>

<optional>

<ref name="osElement"/>

</optional>

<ref name="dbElement"/>

</interleave>

</element>

</define>

<define name="osElement">

<choice>

<element name="windows">

<interleave>

<ref name="credentialSet"/>

<optional>

<element name="usescanenginecred"><data type="boolean"/></element>

</optional>
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</interleave>

</element>

<element name="unix">

<interleave>

<ref name="credentialSet"/>

<ref name="protocolElement"/>

<ref name="portElement"/>

<optional>

<element name="useoscredfordb"><data type="boolean"/></element>

</optional>

</interleave>

</element>

</choice>

</define>

<define name="dbElement">

<choice>

<element name="mssql">

<interleave>

<ref name="credentialSet"/>

<element name="windowsauth"><data type="boolean"/></element>

</interleave>

</element>

<element name="oracle">

<interleave>

<ref name="credentialSet"/>

<element name="privilege">

    <choice>

    <value>sysdba</value>

    <value>normal</value>

    <value>sysoper</value>

    </choice>

</element>

</interleave>

</element>

<element name="otherdb">

<attribute name="application">

<choice>

<value>Microsoft SQL Server</value>

    <value>Oracle Database</value>

    <value>Sybase Adaptive Server Enterprise</value>

    <value>IBM DB2 Universal Database</value>

    <value>MySQL</value>

    <value>HTTP Web Server</value>

    <value>Lotus Domino</value>

    <value>Lotus Application Server</value>
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    <value>Oracle All Components</value>

    <value>Microsoft Exchange Server</value>

    <value>IBM WebSphere Application Server</value>

    <value>IBM DB2 For Mainframe</value>

    <value>Bea WebLogic</value>

    <value>Bea Webservices</value>

    </choice>

</attribute>

<ref name="credentialSet"/>

</element>

</choice>

</define>

<define name="credentialSet">

<interleave>

<element name="username">

<text/>

</element>

<element name="password">

<optional>

<!-- if the encrypted attribute has a value of true, the password is 

assumed to be encrypted -->

<attribute name="encrypted"><data type="boolean"/></attribute>

<ref name="saltAttribute"/>

</optional>

<text/>

</element>

</interleave>

</define>

<define name="protocolElement">

<element name="protocol">

<choice>

<value>ssh</value>

<value>telnet</value>

</choice>

</element>

</define>

<define name="portElement">

<element name="port">

<data type="integer">

<param name="minInclusive">0</param>

<param name="maxInclusive">65535</param>

</data>
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</element>

</define>

<define name="portAttribute">

<attribute name="port">

<data type="integer">

<param name="minInclusive">0</param>

<param name="maxInclusive">65535</param>

</data>

</attribute>

</define>

<define name="ipAttribute">

<attribute name="ip">

<data type="string">

<param name="maxLength">15</param>

</data>

</attribute>

</define>

<define name="hostnameAttribute">

<attribute name="hostname">

<text/>

</attribute>

</define>

<define name="saltAttribute">

<attribute name="salt"><text/></attribute>

</define>

</grammar>

Legacy User
Credentials File
format (flat file)

The legacy, flat file User Credentials File format is:

ipaddress,port,"database instance name","dbuser","dbpwd” [, 

sysprivileges, “osusrname” , “ospwd] “

where: [] indicates optionaloptionaloptionaloptional parameters.

EXAMPLES:

Oracle:Oracle:Oracle:Oracle:

192.168.1.73,1521,"ORCL","sys","admin123",normal,"oracle","admin123"

10.9.0.34,1521,"ORCL","sys","admin123",sysdba
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DB2:DB2:DB2:DB2:

192.168.1.106,50000,"db2inst1:SAMPLE","admin","admin123", normal, 

"alamo", "alamo123"

192.168.1.106,50000,"db2inst1:SAMPLE","admin","admin123", normal

SQL Server:SQL Server:SQL Server:SQL Server:

192.168.1.18,1433,"MSSQLSERVER","sa","admin123",normal, “alamo”, 

“alamo123”

192.168.1.18,1433,"MSSQLSERVER","sa","admin123",normal

Sybase:Sybase:Sybase:Sybase:

192.168.1.233,5000,"sbse_sql","sys","admin123
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Appendix B: Monitoring 
Oracle Databases in an Oracle 
Fail Safe Environment: Sensor 
and Cluster Configuration 
Steps
This appendix explains how to configure a host-based Sensor for Oracle (on Windows) 
in an Oracle Fail Safe environment. It also explains how to configure your Oracle Fail 
Safe cluster, once you have properly configured your Sensor.

In this appendix:

•  About Oracle Fail Safe

•  Oracle Fail Safe vs. Oracle RAC

•  Sensor configuration steps (Oracle Fail Safe)

•  Cluster configuration steps (Oracle Fail Safe).

About Oracle Fail
Safe

Oracle Fail SafeOracle Fail SafeOracle Fail SafeOracle Fail Safe, a type of Oracle cluster, is a core feature included with every Oracle 
11g, Oracle 10g and Oracle9i license for Microsoft Windows 2000 and Microsoft 
Windows 2003. Oracle Fail Safe is integrated with Microsoft Cluster Server to allow you 
to configure and verify Microsoft Windows clusters and to automatically fail over 
Oracle databases and applications.

Oracle Fail Safe is essentially a Microsoft Clustering Services (MSCS) plug-in. In an 
MSCS architecture, two systems share the same disk, which only one system controls 
at a time. In the event of a failure (determined by the heartbeat mechanism), the 
standby system replaces the instance currently running the Oracle instance (and 
controlling the storage).

Oracle Fail Safe vs.
Oracle RAC

Oracle Fail Safe differs in several ways from Oracle Real Application Cluster (RAC); for 
more information on installing and configuring a host-based Sensor for Oracle (on 
Windows) to monitor Oracle databases on a RAC, see Appendix C: Installing and 
Configuring a Host-Based Sensor for Oracle to Monitor Oracle Databases on an 
Oracle RAC.
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Oracle Fail Safe is generally considered easier to implement and administer than RAC. 
Most organizations that run applications on Microsoft Windows have already 
implemented MSCS and are familiar with it. In addition, Oracle Fail Safe is a core 
feature of Oracle9i and Oracle10g for Windows, so you won’t need additional licenses.

Another key difference: unlike Oracle RAC (which can run in a Microsoft Windows or 
on a *nix-based platform), Oracle Fail Safe runs on Microsoft Windows only. Thus, this 
appendix is only relevant if you are configuring a host-based Sensor for Oracle (on 
Windows); for more information, see Configuring a host-based Sensor to monitor 
Oracle SIDs and services and deploying the configuration information (when Sensor is 
installed on Windows).

Sensor
configuration steps

(Oracle Fail Safe)

To monitor Oracle databases in an Oracle Fail Safe environment, first complete the 
following host-based SensorSensorSensorSensor for Oracle (on Windows) configuration configuration configuration configuration steps:

1. Install your host-based Sensor for Oracle (on Windows); for more information, see 

Host-based Sensor for Oracle (on Windows) - installation steps in the DbProtect 

Installation Guide.

2. RegisterRegisterRegisterRegister your host-based SensorSensorSensorSensor for Oracle (on Windows); for more information, 

see Registering a Sensor.

3. Configure and deployConfigure and deployConfigure and deployConfigure and deploy your host-based SensorSensorSensorSensor for Oracle (on Windows). Pay 
special attention to:

•  Step 5Step 5Step 5Step 5 of Configuring a host-based Sensor to monitor Oracle SIDs and services 
and deploying the configuration information (when Sensor is installed on 
Windows), where you mustmustmustmust select a network adapter that is associated with a 
real IP address (where the network traffic can sniff packets). Make sure this is notnotnotnot 
the cluster heartbeat card, because cluster heartbeat cards do not detect 
network traffic.

•  Step 10Step 10Step 10Step 10 of    Configuring a host-based Sensor to monitor Oracle SIDs and 
services and deploying the configuration information (when Sensor is installed 
on Windows), where you must configure your network adapter for the cluster's 
virtual IP address. If this is not already populated in the IP Address:IP Address:IP Address:IP Address: field, then 
you must enter it manually.

4. Complete the remaining configurationconfigurationconfigurationconfiguration steps described in Configuring a 
host-based Sensor to monitor Oracle SIDs and services and deploying the 
configuration information (when Sensor is installed on Windows), and 
deploydeploydeploydeploy the configured instance to your host-based SensorSensorSensorSensor for Oracle (on 

Windows).

5. Next, configure your Oracle Fail Safe cluster; for more information, see 
Cluster configuration steps (Oracle Fail Safe).
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Cluster
configuration steps

(Oracle Fail Safe)

Once you have configured your host-based Sensor for Oracle (on Windows) to 
monitor Oracle databases in an Oracle Fail Safe environment (as explained in Sensor 
configuration steps (Oracle Fail Safe)), you must next complete the following clusterclusterclustercluster 
configuration configuration configuration configuration steps:

1. In your cluster, make the other node the active node either by initiating a failover 

or by moving the cluster resources over to that node.

2. From the new active node, access your shared drive via Windows Explorer.

3. On the shared drive, go to the directory where your host-based Sensor for 

Oracle (on Windows) is installed and navigate to the <installation 
directory>\sensor\conf\overrides directory.

4. Open the file networkAdapter_sensor_override.xsl in any text editor such 
as Notepad.

5. In a separate text editor window, open the file sensor.xml, which is located 
in the <installation directory>\sensor\conf\ directory.

6. In the sensor.xml file, locate the line that begins: <networkAdapter name=. 
Copy everything on that lineCopy everything on that lineCopy everything on that lineCopy everything on that line between the double quotes (but notnotnotnot the 
double quotes themselves).

7. Go to the text editor window where the 
networkAdapter_sensor_override.xsl file is open and locate the following 
section:

<!-- This is node 1 -->

        <xsl:element name="networkAdapter">

            <!-- Insert network adapter in between xsl attribute tags --> 

<xsl:attribute name="name">INSERT_NETWORK_ADAPTER_HERE</xsl:attribute>

8. Paste the information you copied in Step 6 fromfromfromfrom the sensor.xml file totototo the 
location in Step 7. Specifically, you must paste the information you copied 
in Step 6 between the tags <xsl:attribute name="name"> and </
xsl:attribute> so it replaces the string reading: 
INSERT_NETWORK_ADAPTER_HERE. The string INSERT_NETWORK_ADAPTER_HERE 
should no longer be visible once you paste the actual network adapter 
information for node 1 from the sensor.xml file into this location.

9. Open a command prompt window in the Sensor's <installation 
directory>\sensor\bin\ directory on the shared drive.

10.From the command prompt window, run the utility: list_net_adapter.exe

11.The list_net_adapter.exe utility outputs the list of network adapters it 
detects on cluster node. Note which network adapter corresponds to the 
real IP address for that node (i.e., notnotnotnot the cluster heartbeat network 
adapter).
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12.Copy the network adapter information.

13.Paste the network adapter information into the area of the 
networkAdapter_sensor_override.xsl file reserved for the other node of 
your Oracle Fail Safe cluster. It should be just below the location from Step 
8. It looks something like this:

<!-- This is node 2 -->

        <xsl:element name="networkAdapter">

            <!-- Insert network adapter in between xsl attribute tags -->

            <xsl:attribute name="name">INSERT_NETWORK_ADAPTER_HERE</

xsl:attribute>

Again, paste the network adapter information between the tags <xsl:attribute 
name="name"> and </xsl:attribute>, replacing the string that reads: 
INSERT_NETWORK_ADAPTER_HERE.  The string INSERT_NETWORK_ADAPTER_HERE should 
no longer be visible once the actual network adapter information for node 2 from the 
list_net_adapter.exe utility is pasted in this location.

14.Save the changes made to networkAdapter_sensor_override.xsl, then 
close the file.

15.Rename the networkAdapter_sensor_override.xsl file so the words 
networkAdapter_ are removed. The new file name should be named: 
sensor_override.xsl

16.Copy the sensor_override.xsl file from the <installation 
directory>\sensor\conf\overrides directory to the <installation 
directory>\sensor\conf\ directory (one level up).

17.Restart the DbProtect Sensor service. You can do this in either of two ways:

•  Stop then start the DbProtect Sensor service from the Windows Service 
Control Manager on the cluster's active node.

•  Bring the DbProtect AppRadar Sensor ClusterDbProtect AppRadar Sensor ClusterDbProtect AppRadar Sensor ClusterDbProtect AppRadar Sensor Cluster resource offline, then bring it 
online again in the Cluster Administrator on either cluster node.

Once the host-based Sensor for Oracle (on Windows) restarts, a new file displays in 
your Sensor installation's <installation directory>\sensor\conf\ directory. The 
new file is named: sensor_transformed.xml. This new file contains two occurrences 
of the <networkAdapter> XML element, which the Sensor uses to monitor your Oracle 
Fail Safe cluster.



DbProtect 6.1 User’s Guide

Application Security, Inc. 564

Appendix C: Installing and 
Configuring a Host-Based 
Sensor for Oracle to Monitor 
Oracle Databases on an 
Oracle RAC
Oracle Real Application Clusters (RAC) Oracle Real Application Clusters (RAC) Oracle Real Application Clusters (RAC) Oracle Real Application Clusters (RAC) allows multiple computers to run Oracle 
relational database management system (RDBMS) software simultaneously while 
accessing a single database, thus providing a clustered database. In a non-RAC Oracle 
database, by contrast, a single instance accesses a single database. 

In order to configure a host-based Sensor to monitor databases on an Oracle RAC, 
you must do the following:

1. Install a host-based Sensor for Oracle on each node in your Oracle RAC. For more 

information, see Appendix B: Configuring a Host-Based Sensor for Oracle to 

Monitor Oracle Databases on an Oracle RAC in the DbProtect Installation Guide.

2. Next, in the DbProtect Console, you must registerregisterregisterregister each host-based Sensor 
for Oracle you installed. If you installed your host-based Sensor for Oracle 
on:

•  Windows, see Configuring a host-based Sensor to monitor Oracle SIDs and 
services and deploying the configuration information (when Sensor is installed 
on Windows)

•  any supported *nix operating system (i.e., Solaris, AIX, HP-UX, or Red Hat 
Enterprise Linux), see Configuring a host-based Sensor to monitor Oracle SIDs 
and services and deploying the configuration information (when Sensor is 
installed on a *nix-based operating system).

3. In the DbProtect Console, configure an instance for each host-based 
Sensor for Oracle you registered in Step 2. Make sure your Instance AliasInstance AliasInstance AliasInstance Alias 
is:

•  unique for each registered host-based Sensor for Oracle

•  is easily identifiable for the database you are monitoring

•  easily identifies the node where the Sensor is installed (e.g., Oracle RAC Node Oracle RAC Node Oracle RAC Node Oracle RAC Node 
1111, Oracle RAC Node 2Oracle RAC Node 2Oracle RAC Node 2Oracle RAC Node 2, etc.).
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If you installed your host-based Sensor for Oracle on:

•  Windows, see Configuring a host-based Sensor to monitor Oracle SIDs and 
services and deploying the configuration information (when Sensor is installed 
on Windows)

•  any supported *nix operating system (i.e., Solaris, AIX, HP-UX, or Red Hat 
Enterprise Linux), see Configuring a host-based Sensor to monitor Oracle SIDs 
and services and deploying the configuration information (when Sensor is 
installed on a *nix-based operating system).

4. When configuring each instance, also ensure you deploy the exact same 
Policy for each host-based Sensor for Oracle (otherwise, you may get 
inconsistent results for the Alerts you are expecting to see).

Again, if you installed your host-based Sensor for Oracle on:

•  Windows, see Configuring a host-based Sensor to monitor Oracle SIDs and 
services and deploying the configuration information (when Sensor is installed 
on Windows)

•  any supported *nix operating system (i.e., Solaris, AIX, HP-UX, or Red Hat 
Enterprise Linux), see Configuring a host-based Sensor to monitor Oracle SIDs 
and services and deploying the configuration information (when Sensor is 
installed on a *nix-based operating system).
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Appendix D: Oracle Critical 
Patch Update Detection
This appendix explains the different methods DbProtect AppDetective uses to detect 
if the Oracle Critical Patch Update (CPU) has been applied to your Oracle database.

This appendix consists of the following topics:

•  Java method

•  OS method

•  Legacy patch detection

•  Patches_History.txt Method for Oracle CPU Collection on OpenVMS

•  REGISTRY&HISTORY Table Method.

Java method The Java methodJava methodJava methodJava method is new functionality added to DbProtect AppDetective 3.0.2 and 
greater. This new method uses existing Java configured on the target database server 
to collect the OPatch data. DbProtect AppDetective requires Java Virtual Machine 
(JVM) on the target database server, as well as the following two privileges, in order to 
use the method correctly:

•  JAVASYSPRIV

•  CREATE PROCEDURE

You can run the commands below to grant these privileges:

•  grant JAVASYSPRIV to <username>

•  grant CREATE PROCEDURE to <username>

Caution! Java XML is required to use the Java method. Some custom 

scripts used to install JVM may not include Java XML (initxml.sql 

and xmlja.sql scripts).

By default, DbProtect AppDetective uses the OS (operating system) method to detect 
if the Oracle CPU has been applied to your Oracle database; for more information, see 
OS method. The Java method uses Oracle Java stored procedures to connect to the 
operating system, and then reviews the OPatch files to detect which CPUs have been 
installed.

Note:Note:Note:Note: Using the Java method creates the following database objects: a Java 
source and function. DbProtect AppDetective deletes these objects as 
soon as DbProtect AppDetective completes the Audit. If an error occurs 
during the Audit, it is probably because the operating system user lacks 
the aforementioned permissions.

In addition, you can only use the Java method on versions of Oracle 9iR2 
and above, where CPUs have been applied to the database using OPatch.
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For more information on enabling use of the Java method, see Configuring the 
properties of a Scan Engine.

OS method By default, DbProtect AppDetective uses the OSOSOSOS (Operating System) methodmethodmethodmethod to 
detect if the Oracle CPU has been applied to your Oracle database. This method 
requires you to supply OS credentials, in addition to a valid database account.

The OS method uses:

•  telnet or SSH to connect to the operating system, then reviews the OPatch files 
to detect which CPUs have been installed

•  Windows Administrative shares, such as C$ and D$, to connect to the operating 
system for the Windows platforms.

Note:Note:Note:Note: The OS Method only applies to version of Oracle 9iR2 and above, where 
CPUs have been applied to the database using OPatch.

If you encounter an error when running an Audit, verify the following:

•  You have supplied the proper user name and password.

•  The operating system user has the proper ORACLE_HOME set.

•  The operating system user has permission to access ORACLE_HOME.

For more information on enabling use of the OS method, see Configuring the 
properties of a Scan Engine.

Legacy patch
detection

For versions of Oracle 8i and 9iR1, DbProtect AppDetective performs its own method 
of examining whether the CPU is applied on the target database. This method, legacy legacy legacy legacy 
patch detectionpatch detectionpatch detectionpatch detection, also requires for you to supply OS credentials, in addition to having a 
valid database account.

Legacy patch detection uses telnet or SSH to connect to the operating system and 
then reviews various attributes such as files dates and sizes to tell what patches have 
been installed.

If you encounter an error when running an Audit, verify the following:

•  You have supplied the proper user name and password.

•  The operating system user has the proper ORACLE_HOME set.

The operating system user has permission to access ORACLE_HOME.
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Patches_History.txt

Method for Oracle
CPU Collection on

OpenVMS

Oracle CPU checks onOracle CPU checks onOracle CPU checks onOracle CPU checks on OpenVMSOpenVMSOpenVMSOpenVMS work the same way as they do on other platforms. 
DbProtect AppDetective includes a feature that looks up a local copy of the CPU 
history file. This is called comps.xml on most platforms, but on OpenVMS OpenVMS OpenVMS OpenVMS the file is 
called patches_history.txt.

The patches_history.txt file is located under the PATCHES subdirectory of 
ORACLE_HOME on the target OpenVMS server. The patches_history.txt contains 
information about installed and de-installed patches.

DbProtect AppDetective uses an existing copy instead of collecting files remotely. 
After the CPU check finishes, DbProtect AppDetective renames the local file (with a 
.bak extension) so it won't be used next time.

CPU DATA COLLECTION

When DbProtect AppDetective executes the CPU check against an OpenVMS server, 
you can select one of two CPU data collection methodsCPU data collection methodsCPU data collection methodsCPU data collection methods:

•  Java method. Java method. Java method. Java method. The Oracle database account requires the same privileges as 
required for the Java method on other platforms. For more information, see 
Java method.

•  OS method. OS method. OS method. OS method. As opposed to other platform, on OpenVMS the OS account mustmustmustmust 
have at least one of the following:

-ORACLE_HOME logical defined

-actual oratab file in home directory

-listener banner containing PRMFILE string.

DbProtect AppDetective uses this information to extract the ORACLE_HOME path.

USING A LOCAL FILE FOR AN ORACLE CPU CHECK ON AN 

OPENVMS SERVER

If you cannot Telnet/SSH to a remote OpenVMS server, you can use a local filelocal filelocal filelocal file for to 
perform your Oracle CPU check.

To do so, you must place a copy of the patches_history.txt file under the 
DbProtect AppDetective installation directory -- specifically, under the 
\mirror\<IP>\<PORT>\<SID>\PATCHES directory. For example, if the address of your 
OpenVMS server is 192.168.1.1, and there is Oracle database on port 1521 with the 
SID sales, then the path is: \mirror\192.168.1.1\1521\sales\PATCHES (under the 
AppDetectivePro installation directory).

If the \mirror\192.168.1.1\1521\sales\PATCHES\patches_history.txt exists, 
then DbProtect AppDetective parses this file, and uses it (instead of performing a 
Telnet/SSH to the remote OpenVMS server). When DbProtect AppDetective 
completes the Audit, it changes the file name by appending .bak, to avoid confusion 
in the future.
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REGISTRY&HISTORY

Table Method

For CPUs dated January 2009 and later, DbProtect AppDetective supports the 
REGISTRY$HISTORY CPU detection method. This method checks information in the 
SYS.REGISTRY$HISTORY table to determine whether a CPU was applied.

This method only requires 'SELECT on SYS.REGISTRY$HISTORY' rights. This method 
does notnotnotnot require OS or JAVA credentials, but is considered less accurate in certain 
cases.
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Appendix E: Importing 
Session Data with the 
DbProtect Import Utility
This appendix consists of the following topics:

•  What is the DbProtect Import Utility?

•  What is Session data?

•  Session data import prerequisites, minimum system requirements, and 
considerations

•  What data does the DbProtect Import Utility import (and not import)?

•  Using the DbProtect Import Utility

•  Troubleshooting a corrupted source database with the 
pre_import_cleanups.sql script.

What is the
DbProtect Import

Utility?

The DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility is a standalone utility that allows you to import critical 
security (Session) data from a database source to a destination DbProtect database.

For the source database, you can select:

•  an exported AppDetectivePro Session (.adb) file; for more information, see 
Importing Session Data from an AppDetectivePro Session file

•  the AppDetectivePro back-end Microsoft SQL Server database or the 
DbProtect back-end Microsoft SQL Server database; for more information, see 
Importing Session data from an AppDetectivePro or DbProtect Microsoft SQL 
Server database.

What is Session
data?

A SessionSessionSessionSession is a logical grouping of target databases and the Penetration Tests/Audits 
run against them. It also contains all the vulnerabilities and other information obtained 
by running Penetration Tests and Audits.

When an AppDetectivePro user creates a Session, AppDetectivePro automatically 
performs a Discovery of target databases on the user’s networks. The 
AppDetectivePro user may then run Penetration Tests and Audits against these 
Discovered target databases. Consequently, when you migrate AppDetectivePro 
Session data to DbProtect, you are migrating all Discovery, Penetration Test, Audit, 
vulnerability, and associated Policy information within the Session.

You can also exportexportexportexport Polices from AppDetectivePro, then importimportimportimport the exported Policies 
into DbProtect AppDetective, using AppDetectivePro (installed automatically when 
you install DbProtect). For more information, see Importing a Policy and Exporting a 
Policy, respectively.
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For more information on AppDetective Pro and Sessions, see the AppDetective User’s 
Guide.

Session data
import

prerequisites,
minimum system

requirements, and
considerations

A few important Session data import prerequisites, minimum system requirements, Session data import prerequisites, minimum system requirements, Session data import prerequisites, minimum system requirements, Session data import prerequisites, minimum system requirements, 
and considerations and considerations and considerations and considerations follow:

•  If you want to import Session data from an exported AppDetectivePro file, your your your your 
version of AppDetectivePro must be version 5.4.3 or greaterversion of AppDetectivePro must be version 5.4.3 or greaterversion of AppDetectivePro must be version 5.4.3 or greaterversion of AppDetectivePro must be version 5.4.3 or greater. If your version of 
AppDetectivePro is older than 5.4.3, you must:

-upgrade your version of AppDetectivePro to the most current version (at least a 
version greater than 5.4.3)

-import your old, pre-version 5.4.3 AppDetectivePro Session file (.adb) into your 
upgraded (i.e., greater than 5.4.3) version of AppDetectivePro

-export your upgraded AppDetectivePro Session file (.adb) file

-go to Importing Session Data from an AppDetectivePro Session file.

•  If your database sourcedatabase sourcedatabase sourcedatabase source is an AppDetectivePro or DbProtect back-end 
database, the versions must be AppDetective Pro 5.4.3 or greaterAppDetective Pro 5.4.3 or greaterAppDetective Pro 5.4.3 or greaterAppDetective Pro 5.4.3 or greater, or DbProtect DbProtect DbProtect DbProtect 
2007.1 or greater2007.1 or greater2007.1 or greater2007.1 or greater, respectively.

•  The version of your destination DbProtect databasedestination DbProtect databasedestination DbProtect databasedestination DbProtect database must be DbProtect 2009.1 
or greater.

•  Before using the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility, make sure you have valid database 
credential information available for both your sourcesourcesourcesource database and targettargettargettarget 
database.

•  Your source database and destination database cannot be the cannot be the cannot be the cannot be the samesamesamesame database database database database.

•  The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility requires Service Pack 2 (SP2) for Microsoft SQL 
Server 2000, or SP1 for Microsoft SQL Server 2005/2008, on both your source 
and destination databases.
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What data does
the DbProtect
Import Utility

import (and not
import)?

What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:

•  What data does the DbProtect Import Utility import?

•  What data does the DbProtect Import Utility not import?

WHAT DATA DOES THE DBPROTECT IMPORT UTILITY 

IMPORT?

The DbProtect Import Utility importsDbProtect Import Utility importsDbProtect Import Utility importsDbProtect Import Utility imports the following content from the selected Session/
Organization on the source file/database into the target Organizations:

•  Customer-created checks and their content.Customer-created checks and their content.Customer-created checks and their content.Customer-created checks and their content. The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility 
imports customer-created checks into the target DbProtect database. Re-
importing does notnotnotnot generate duplicate checks.

•  Customer-created Policies and their content.Customer-created Policies and their content.Customer-created Policies and their content.Customer-created Policies and their content. The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility 
imports all customer-created Policies. Re-importing does notnotnotnot generate 
duplicate Policies.

•  Target databases with IP addresses that match the target Organizations’ IP Target databases with IP addresses that match the target Organizations’ IP Target databases with IP addresses that match the target Organizations’ IP Target databases with IP addresses that match the target Organizations’ IP 
ranges.ranges.ranges.ranges. The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility migrates all target databases in the 
selected Session/Organization of the source file/database to the relevant 
Organization, if the IP address of the source Session/Organization falls within 
the IP ranges of the target Organization.

Example:Example:Example:Example: If the source Session file contains 100 target databases (in which 80 of 
them have a 192.168.1.* IP address), and you select a target Organization 
with an IP range of 192.168.1.1 – 192.168.1.255, then the DbProtect Import DbProtect Import DbProtect Import DbProtect Import 
Utility Utility Utility Utility imports 80 target databases, and filters out the remaining 20.
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•  All tests (Penetration Tests and Audits) associated with the qualified target All tests (Penetration Tests and Audits) associated with the qualified target All tests (Penetration Tests and Audits) associated with the qualified target All tests (Penetration Tests and Audits) associated with the qualified target 
database. database. database. database. Since any given target database can run multiple tests, the DbProtect DbProtect DbProtect DbProtect 
Import Utility Import Utility Import Utility Import Utility also imports tests associated with qualified target databases. In 
order to be “qualified”, the target database’s IP address must fall into the 
target Organization’s IP range as described above. In addition, the DbProtect DbProtect DbProtect DbProtect 
Import Utility Import Utility Import Utility Import Utility implements an internal mechanism that filters out “unqualified” 
tests; for more information, see What data does the DbProtect Import Utility 
not import?

If a target database already exists, the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility merges the tests 
into the same target database, unlessunlessunlessunless the tests themselves already exist. If you 
want to distinguish the tests, check the combination of scanid, ipaddress, 
port, name, and endtime.

Example:Example:Example:Example: The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility detects that the target database 
described by 1, 192.168.1.234 1433 'MSSQLSERVER' already exists. Five tests Five tests Five tests Five tests 
have been run before. The new incoming import request contains 10 new tests10 new tests10 new tests10 new tests 
for the same target database. As a result, the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility merges 
the tests. Subsequently, the target DbProtect database will now contain 15 tests15 tests15 tests15 tests 
for this target database.

•  All test results associated with the qualified tests. All test results associated with the qualified tests. All test results associated with the qualified tests. All test results associated with the qualified tests. The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility 
imports test results, which may include vulnerabilities, users found, and a check 
status associated with each test. In order to be “qualified”, the target 
database’s IP address must fall into the target Organization’s IP range, as 
described above.

•  Job histories will be created for the tests. Job histories will be created for the tests. Job histories will be created for the tests. Job histories will be created for the tests. After an import is complete, the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility creates Job histories for each Organization in the 
target DbProtect database. The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility creates Jobs based on 
how many different Policies are used in the tests. For example, for the target 
Organization root, assume 100 Penetration Tests have been imported. Among 
these 100 tests, five different Policies were used. As a result, the DbProtect DbProtect DbProtect DbProtect 
Import UtilityImport UtilityImport UtilityImport Utility creates five unique Job histories. You can verify these job histories 
by checking the Job HistoryJob HistoryJob HistoryJob History panel on the DbProtect Console; for more 
information, see Filtering Job history.
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WHAT DATA DOES THE DBPROTECT IMPORT UTILITY NOT 

IMPORT?

The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility does notnotnotnot import the following content from the source 
database into the target Organizations:

•  Organizations, users, templates, jobs, job histories, reports from the source Organizations, users, templates, jobs, job histories, reports from the source Organizations, users, templates, jobs, job histories, reports from the source Organizations, users, templates, jobs, job histories, reports from the source 
DbProtect database.DbProtect database.DbProtect database.DbProtect database. If the source database is a DbProtect database, it only 
imports all the customized checks, customized Policies, and qualified target 
databases. Tests, test results, users, templates, Jobs, and reports are not  not  not  not 
imported.

•  “Unqualified” tests (Penetration Tests and Audits).“Unqualified” tests (Penetration Tests and Audits).“Unqualified” tests (Penetration Tests and Audits).“Unqualified” tests (Penetration Tests and Audits). In order to maintain the data 
integrity, the following tests/audits are filtered out:

-Tests which are not finished. You can identify these by checking the Status on the Jobs 
panel of the DbProtect Console; for more information, see Viewing Job details.

-Tests which the IP range is outside the range of the target Organizations.

-Tests which use obsolete Policies. If a test uses Policy which no longer exists in the 
source DbProtect database, the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility    skips this test (and all of its 
results).
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Using the
DbProtect Import

Utility

What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:What you will find in this help topic:

•  Launching the DbProtect Import Utility

•  Importing Session Data from an AppDetectivePro Session file

•  Importing Session data from an AppDetectivePro or DbProtect Microsoft SQL 
Server database. 

LAUNCHING THE DBPROTECT IMPORT UTILITY

To launch the DbProtect Import Utility:

1. Choose Start > Programs > AppSecInc > DbProtect > DbProtect Import 

Utility to display the Welcome page of the DbProtect Import Utility.

FIGURE: WelcomeWelcomeWelcomeWelcome page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility
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2. Click the NextNextNextNext button.

The Data Source Type Data Source Type Data Source Type Data Source Type page of the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility displays.

FIGURE: Data Source Type Data Source Type Data Source Type Data Source Type page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

The Data Source Type Data Source Type Data Source Type Data Source Type page of the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility allows you to select your 
database source. If you select:

•  Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) to import Session data from an 
exported AppDetectivePro Session, then go to Importing Session Data from an 
AppDetectivePro Session file

•  AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) to import 
Session data from an AppDetectivePro or DbProtect Microsoft SQL Server 
database, then go to Importing Session data from an AppDetectivePro or 
DbProtect Microsoft SQL Server database.

IMPORTING SESSION DATA FROM AN APPDETECTIVEPRO 

SESSION FILE

To import Session data from an exported AppDetectivePro Session (.adb) file: 

1. As explained in Launching the DbProtect Import Utility, the Data Source Type 

page of the DbProtect Import Utility allows you to select a database source for 

importing critical Session data.

If you selected Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) Exported AppDetectivePro Session File (*adb) in Step 2 of Launching 
the DbProtect Import Utility to import Session data from an exported 
AppDetectivePro Session (.adb) file, then the Source File DetailSource File DetailSource File DetailSource File Detail page displays.

FIGURE: Source File DetailSource File DetailSource File DetailSource File Detail page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility
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•  You can manually enter the path and name of the AppDetectivePro Session 
(.adb) file, or click the BrowseBrowseBrowseBrowse button to search for the .adb file on your 
computer or network.

Caution! If a pop-up informs you that your destination database is 

corrupted, you must run the pre_import_cleanups.sql script; for 

more information, see Troubleshooting a corrupted source 

database with the pre_import_cleanups.sql script at the 

end of this appendix.

•  Click the NextNextNextNext button to display the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page of the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

2. The Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility is 
shown below.

FIGURE: Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

Do the following:

•  In the Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: portion of the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page::::

-enter the Host Name:Host Name:Host Name:Host Name: of your destination DbProtect database server, or a valid IP 
address

-manually enter (or use the Instance Name:Instance Name:Instance Name:Instance Name: drop-down to select) a specific DbProtect 
database server (<Default Instance><Default Instance><Default Instance><Default Instance> is selected by default), or enter the instance name 
manually.

•  In the Connect Using:Connect Using:Connect Using:Connect Using: portion of the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page, select 
whether you want to connect to your destination database instance using:

-Windows Authentication Windows Authentication Windows Authentication Windows Authentication using the current logged-on Windows user’s privileges.

Note:Note:Note:Note: This user mustmustmustmust be a Microsoft SQL Server user on the destination machine.

-SQL AuthenticationSQL AuthenticationSQL AuthenticationSQL Authentication (make sure SQL Authentication is enabled).



DbProtect 6.1 User’s Guide

Application Security, Inc. 578

Note:Note:Note:Note: If you’re not sure which authentication type to select, see your database 
administrator.

If you choose SQL Authentication, then you must also enter the database user 

Login Name: and Password:

•  Click the Test Connection Test Connection Test Connection Test Connection button to test your connection to your destination 
database. The DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility attempts to connect to your destination 
database. If the connection succeeds, the NextNextNextNext button is illuminated.

3. Click the NextNextNextNext button to display the Session SelectorSession SelectorSession SelectorSession Selector page of the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

FIGURE: Session SelectorSession SelectorSession SelectorSession Selector page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

Select the Sessions you want to import from your selected AppDetectivePro Session 
(.adb) file (in the SourceSourceSourceSource panel) into your DbProtect database (in the DestinationDestinationDestinationDestination 
panel).

Note:Note:Note:Note: The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility imports all data (with source IP addresses that 
match the destination IP ranges) from your selected source Sessions into 
every Organization you selected in the DestinationDestinationDestinationDestination panel.

Example: Example: Example: Example: Assume you are importing a Session with target databases in the 
IP range 192.168.1.1 - 192.168.1.255, and the IP range 172.16.1.1 - 
172.16.1.255. Your root target Organization, however, only includes the 
IP range 192.168.1.1 - 192.168.1.255. As a result, the DbProtect Import DbProtect Import DbProtect Import DbProtect Import 
UtilityUtilityUtilityUtility imports all target databases in the IP range 192.168.1.1 - 
192.168.1.255, but ignores the 172.16.1.* data. If you want to import 
172.16.1.* target database data, you must modify the IP range of your 
destination Organization; for more information, see Editing an 
Organization.

Hint: If you mouse over any Organization or Session name (in either the Source 

or Destination panels of the Session Selector page), then the DbProtect 

Import Utility displays the Session names and IP ranges for all 

Discovered target databases. This feature allows you to logically compare 

your source Sessions and destination Organizations.



DbProtect 6.1 User’s Guide

Application Security, Inc. 579

4. Click the NextNextNextNext button to display the Session SummarySession SummarySession SummarySession Summary page of the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

FIGURE: Session SummarySession SummarySession SummarySession Summary page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

The Session SummarySession SummarySession SummarySession Summary page of the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility displays a summary of 
which Sessions the utility is ready to import into your destination DbProtect database.
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5. Click the NextNextNextNext button to import your Session data.

Note:Note:Note:Note: For more information on what data the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility does (and 
does notnotnotnot) import, see What data does the DbProtect Import Utility import 
(and not import)?

When the import process completes, the Import CompletedImport CompletedImport CompletedImport Completed page of the DbProtect DbProtect DbProtect DbProtect 
Import Utility Import Utility Import Utility Import Utility displays.

Hint: You can copy/paste the import summary data and save it to a file for future 

reference.

FIGURE: Import Completed Import Completed Import Completed Import Completed page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

You may now launch DbProtect AppDetective. Your imported Session data is available; 
for more information, see Vulnerability Management.
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IMPORTING SESSION DATA FROM AN APPDETECTIVEPRO OR 

DBPROTECT MICROSOFT SQL SERVER DATABASE

To import Session data from an AppDetectivePro or DbProtect Microsoft SQL Server 
database:

1. As explained in Launching the DbProtect Import Utility, the Data Source Type 

page of the DbProtect Import Utility allows you to select a database source for 

importing critical Session data.

If you selected AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) AppDetectivePro or DbProtect Database (Microsoft SQL Server) in 
Step 2 of Launching the DbProtect Import Utility to import Session data from the 
AppDetectivePro or DbProtect back-end database, then the Source File DetailSource File DetailSource File DetailSource File Detail page 
displays.

FIGURE: Source Database DetailSource Database DetailSource Database DetailSource Database Detail page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

The Source Database DetailSource Database DetailSource Database DetailSource Database Detail page of the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility allows you to specify 
the location of your source AppDetectivePro or DbProtect back-end database.

2. Do the following:

•  In the Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: portion of the Source Database DetailSource Database DetailSource Database DetailSource Database Detail page:

-Enter the Host Name:Host Name:Host Name:Host Name: of your AppDetectivePro or DbProtect back-end database

-Manually enter (or use the Instance Name:Instance Name:Instance Name:Instance Name: drop-down to select) a specific 
AppDetectivePro or DbProtect back-end database (<Default Instance><Default Instance><Default Instance><Default Instance> is selected by 
default), or enter the instance name manually

-Enter the Database Name:Database Name:Database Name:Database Name:. The default source database name is AppDetective. 
However, if you backed-up your source database under a different name, manually 
enter the database name in this field.
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•  In the Connect Using:Connect Using:Connect Using:Connect Using: portion of the Source Database DetailSource Database DetailSource Database DetailSource Database Detail page, select 
whether you want to connect to your destination database instance using:

-Windows Authentication Windows Authentication Windows Authentication Windows Authentication using the current logged-on Windows user’s privileges.

Note:Note:Note:Note: This user mustmustmustmust be a Microsoft SQL Server user on the destination machine.

-SQL AuthenticationSQL AuthenticationSQL AuthenticationSQL Authentication (make sure SQL Authentication is enabled).

Note:Note:Note:Note: If you’re not sure which authentication type to select, see your database 
administrator.

If you choose SQL Authentication, then you must also enter the database user 

Login Name: and Password:

Note:Note:Note:Note: If you do not know the SQL Authentication user name and password, see 
your database administrator.

•  Click the Test Connection Test Connection Test Connection Test Connection button to test your connection to the source 
database. The DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility attempts to connect to your source 
database. 

Caution! If a pop-up informs you that your destination database is 

corrupted, you must run the pre_import_cleanups.sql script; for 

more information, see Troubleshooting a corrupted source 

database with the pre_import_cleanups.sql script.

If the connection succeeds, the Next button is illuminated.

3. Click the NextNextNextNext button to display the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page of 
the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

FIGURE: Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility
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Do the following:

•  In the Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: Microsoft SQL Server: portion of the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page::::

-enter the Host Name:Host Name:Host Name:Host Name: of your destination DbProtect database server, or a valid IP 
address

-manually enter (or use the Instance Name:Instance Name:Instance Name:Instance Name: drop-down to select) a specific DbProtect 
database server (<Default Instance><Default Instance><Default Instance><Default Instance> is selected by default), or enter the instance name 
manually.

•  In the Connect Using:Connect Using:Connect Using:Connect Using: portion of the Destination Database DetailDestination Database DetailDestination Database DetailDestination Database Detail page, select 
whether you want to connect to your destination database using:

-Windows Authentication Windows Authentication Windows Authentication Windows Authentication using the current logged-on user’s privileges.

Note:Note:Note:Note: This user mustmustmustmust be a Microsoft SQL Server user on the destination machine.

-SQL AuthenticationSQL AuthenticationSQL AuthenticationSQL Authentication (make sure SQL Authentication is enabled).

Note:Note:Note:Note: If you’re not sure which authentication type to select, see your database 
administrator.

•  If you choose SQL AuthenticationSQL AuthenticationSQL AuthenticationSQL Authentication, then you must also enter the database user 
Login Name: Login Name: Login Name: Login Name: and Password:Password:Password:Password:

•  Click the Test ConnectionTest ConnectionTest ConnectionTest Connection button to verify the connection on the destination 
database. If the connection succeeds, the NextNextNextNext button is illuminated.

4. Click the NextNextNextNext button to display the Organization SelectorOrganization SelectorOrganization SelectorOrganization Selector page of the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

FIGURE: Organization SelectorOrganization SelectorOrganization SelectorOrganization Selector page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

Select the Sessions you want to import from your selected AppDetectivePro or 
DbProtect back-end database (in the SourceSourceSourceSource panel) into your DbProtect database (in 
the DestinationDestinationDestinationDestination panel).
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Note:Note:Note:Note: The DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility imports all data (with source IP addresses that 
match the destination IP ranges) from your selected source Sessions into 
every Organization you selected in the DestinationDestinationDestinationDestination panel.

Example: Example: Example: Example: Assume you are importing a Session with target databases in the 
IP range 192.168.1.1 - 192.168.1.255, and the IP range 172.16.1.1 - 
172.16.1.255. Your root target Organization, however, only includes the 
IP range 192.168.1.1 - 192.168.1.255. As a result, the DbProtect Import DbProtect Import DbProtect Import DbProtect Import 
UtilityUtilityUtilityUtility imports all target databases in the IP range 192.168.1.1 - 
192.168.1.255, but ignores the 172.16.1.* data. If you want to import 
the 172.16.1.* data, you must modify the IP range of your destination 
Organization; for more information, see Working with Scan Engines.

Hint: If you mouse over any Organization name (in either the Source or 

Destination panels of the Organization Selector page), then the 

DbProtect Import Utility displays the Session names and IP ranges for all 

Discovered target databases. This feature allows you to logically compare 

your source Organizations and destination Organizations.

5. Click the NextNextNextNext button to display the Session SummarySession SummarySession SummarySession Summary page of the 
DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

FIGURE: Session SummarySession SummarySession SummarySession Summary page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

The Session SummarySession SummarySession SummarySession Summary page of the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility displays a summary of 
which Sessions the utility is ready to import into your destination DbProtect database.

6. Click the NextNextNextNext button to import your Session data.
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Note:Note:Note:Note: For more information on what data the DbProtect Import Utility does and 
does notnotnotnot import, see What data does the DbProtect Import Utility import 
(and not import)?

When the import process completes, the Import CompletedImport CompletedImport CompletedImport Completed page of the DbProtect DbProtect DbProtect DbProtect 
Import Utility Import Utility Import Utility Import Utility displays.

Hint: You can copy/paste the import summary data and save it to a file for future 

reference.

FIGURE: Import Completed Import Completed Import Completed Import Completed page of the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility

You may now launch DbProtect AppDetective. Your imported Session data is available; 
for more information, see Vulnerability Management.
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Troubleshooting a
corrupted source
database with the
pre_import_cleanups.sql

script

In Step 2 of Importing Session Data from an AppDetectivePro Session file and 
Importing Session data from an AppDetectivePro or DbProtect Microsoft SQL Server 
database, the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility attempts to connect to your source database. 
The utility also checks whether there are any duplicated records in the following tables:

•  ScansServicesFound

•  ChecksToRun

•  VulnerabilityDetails

•  HostNames

If the DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility DbProtect Import Utility discovers duplicate records in any of these tables, the 
Check data integrityCheck data integrityCheck data integrityCheck data integrity pop up displays, informing you your source database contains 
corrupted data.

FIGURE: Check data integrityCheck data integrityCheck data integrityCheck data integrity pop up

In order to troubleshoot, do the following:

•  Back up your corrupted source database.

•  Close the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

•  Run the pre_import_cleanups.sql script -- located in the following folder: 
<installation directory>:\Program 

Files\AppSecInc\DbProtect\AppDetectiveConsole\db -- against your 
corrupted source database server.

•  Re-run the DbProtect Import UtilityDbProtect Import UtilityDbProtect Import UtilityDbProtect Import Utility.

Note:Note:Note:Note: If you experience trouble, contact Application Security, Inc. Customer 
Support at support@appsecinc.com.
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Appendix F: Using the 
Configuration Manager Tool
Note:Note:Note:Note: Starting with DbProtect 2008.1 R2, Application Security, Inc. removed the 

CertificatesCertificatesCertificatesCertificates tab from the Configuration Manager ToolConfiguration Manager ToolConfiguration Manager ToolConfiguration Manager Tool. This option used to 
allow you to install your company's own certificate to eliminate browser 
messages that indicated issues with the "website's security certificate". 
Security concerns, however, necessitated the removal of this option. 
Nevertheless, you can install a custom certificate using command line 
tools provided with DbProtect. For more information, see the DbProtect 
Administrator’s Guide.

This appendix consists of the following topics:

•  What is the Configuration Manager Tool?

•  Using the Configuration Manager Tool.

What is the
Configuration

Manager Tool?

The Configuration Manager ToolConfiguration Manager ToolConfiguration Manager ToolConfiguration Manager Tool allows you to modify the following DbProtect 
AppDetective configuration parameters on the host machine:

•  Server.Server.Server.Server. Clicking the ServerServerServerServer tab on the Configuration Manager ToolConfiguration Manager ToolConfiguration Manager ToolConfiguration Manager Tool allows you to 
configure the DbProtect AppDetective listening portlistening portlistening portlistening port and the shutdown portshutdown portshutdown portshutdown port. 
The listening portlistening portlistening portlistening port is the port DbProtect AppDetective binds to and waits for 
incoming requests. The shutdown port shutdown port shutdown port shutdown port is the port DbProtect AppDetective 
binds to and waits for incoming local shutdown requests. A shutdown request 
forces DbProtect AppDetective process to terminate.

•  Database. Database. Database. Database. Clicking the DatabaseDatabaseDatabaseDatabase tab on the Configuration Manager ToolConfiguration Manager ToolConfiguration Manager ToolConfiguration Manager Tool allows 
you to configure your Database ServerDatabase ServerDatabase ServerDatabase Server and Database AuthenticationDatabase AuthenticationDatabase AuthenticationDatabase Authentication settings. 
Specifically, you can specify:

-the database host machine where your AppDetectivePro database resides

-your back-end database credentials, which you can configure using Windows 
Authentication or SQL Authentication.

Note:Note:Note:Note: In previous versions of DbProtect, you could use the Configuration Configuration Configuration Configuration 
Manager ToolManager ToolManager ToolManager Tool to modify the Console’s logging level. Now, you must 
manually change logging level values in the log4j.properties files; for 
more information, see Appendix H: Manually Changing the Logging Level 
for the Console by Modifying the log4j.properties File.



DbProtect 6.1 User’s Guide

Application Security, Inc. 588

Using the
Configuration
Manager Tool

To use the Configuration Manager ToolConfiguration Manager ToolConfiguration Manager ToolConfiguration Manager Tool: 

1. Choose Start > Programs > AppSecInc > DbProtect > Configuration Manager 

to display the Configuration Manager. The General tab is selected by default.

FIGURE: Configuration ManagerConfiguration ManagerConfiguration ManagerConfiguration Manager (ServerServerServerServer tab selected)

2. If you want to:

•  modify the DbProtect AppDetective listening port listening port listening port listening port and/or shutdown portshutdown portshutdown portshutdown port, then 
see Step 3

•  modify your DbProtect AppDetective database serverdatabase serverdatabase serverdatabase server information, see Step 4

•  modify your DbProtect AppDetective database authenticationdatabase authenticationdatabase authenticationdatabase authentication method, see 
Step 5.

3. To modify DbProtect AppDetective listening portlistening portlistening portlistening port and/or shutdown portshutdown portshutdown portshutdown port:

•  Select the ServerServerServerServer tab on the Configuration ManagerConfiguration ManagerConfiguration ManagerConfiguration Manager (selected by default).

•  Modify the Listening Port:Listening Port:Listening Port:Listening Port: value. The listening portlistening portlistening portlistening port is the port DbProtect 
AppDetective binds to and waits for incoming requests.

•  Modify the Shutdown Port:Shutdown Port:Shutdown Port:Shutdown Port: value. The shutdown port shutdown port shutdown port shutdown port is the port DbProtect 
AppDetective binds to and waits for incoming local shutdown requests. A 
shutdown request forces DbProtect AppDetective process to terminate.

•  Click the OKOKOKOK button.

FIGURE: Configuration Manager Configuration Manager Configuration Manager Configuration Manager (Server Server Server Server tab selected)
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4. To modify your DbProtect AppDetective database serverdatabase serverdatabase serverdatabase server information:

•  Select the DatabaseDatabaseDatabaseDatabase tab on the Configuration ManagerConfiguration ManagerConfiguration ManagerConfiguration Manager.

•  Modify the AppDetectivePro DB Host:DB Host:DB Host:DB Host: value.

•  Click the OKOKOKOK button.

FIGURE: Configuration Manager Configuration Manager Configuration Manager Configuration Manager (Database Database Database Database tab selected)

5. To modify your DbProtect AppDetective database authenticationdatabase authenticationdatabase authenticationdatabase authentication method    (using 
Windows Authentication or SQL Authentication):

•  Select the Database Database Database Database tab on the Configuration ManagerConfiguration ManagerConfiguration ManagerConfiguration Manager.

•  In the Database Authentication Database Authentication Database Authentication Database Authentication portion of dialog box, select whether you want 
to configure your back-end database credentials back-end database credentials back-end database credentials back-end database credentials using:

-Windows AuthenticationWindows AuthenticationWindows AuthenticationWindows Authentication using the Windows privileges of the user that runs the 
DbProtect services.

Note:Note:Note:Note: This user mustmustmustmust be a Microsoft SQL Server user on the back-end database 
machine.

-SQL AuthenticationSQL AuthenticationSQL AuthenticationSQL Authentication (make sure SQL Authentication is enabled).

Note:Note:Note:Note: If you’re not sure which authentication type to select, see your database 
administrator.

If you choose SQL Authentication, then you must also enter the database user 

Login Name: and Password:
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Appendix G: Moving or 
Changing Your DbProtect 
Back-End Database
To move or change your DbProtect back-end database, you must:

•  use the built-in AppDSNAppDSNAppDSNAppDSN utility to repair the OBDC    (Open Database 
Connectivity) Database Source Name (DSN) entry on the DbProtect Console 
host, and on each installed Scan Engine host; for more information, see Using 
the AppDSN utility to repair the ODBC DSN entry on your DbProtect Console 
host and on each installed Scan Engine host

•  update the JDBC connection strings on the DbProtect Console host; for more 
information, see Updating the JDBC connection strings on the DbProtect 
Console host.

AppDSN also allows you to change the type of authentication DbProtect 
AppDetective uses to authenticate to the DbProtect back-end database (i.e., from 
Windows authentication to SQL Server authentication -- or vice-versa).
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Using the AppDSN
utility to repair the
ODBC DSN entry

on your DbProtect
Console host and
on each installed
Scan Engine host

Again, you must use the AppDSN to repair the ODBC DSN entry on:

•  the DbProtect Console host

•  each installed Scan Engine host.

To use the AppDSN utility to repair the ODBC DSN entry on the DbProtect Console 
host and on each installed Scan Engine host:

1. Choose Start > Programs > AppSecInc > AppDetective Scan Engine > 

AppDSN to display the AppDSN utility.

FIGURE: AppDSNAppDSNAppDSNAppDSN    utility

2. Use the ServerServerServerServer drop-down to select the Microsoft SQL Server instance 
where the Scan Engine stores its results, or enter the Microsoft SQL Server 
instance name.

This mustmustmustmust be the same database DbProtect AppDetective uses.

Hint: Click the Locate instances... button to search for/display all Microsoft 

SQL Server instances on your network.

3. Select to authenticate to the database server using: Windows Windows Windows Windows 
AuthenticationAuthenticationAuthenticationAuthentication (strongly recommended) or SQL Server AuthenticationSQL Server AuthenticationSQL Server AuthenticationSQL Server Authentication. 

If you select: 

•  Windows AuthenticationWindows AuthenticationWindows AuthenticationWindows Authentication, then the DbProtect Scan Engine service uses the 
login/password credentials supplied in the Sensor installation section of the 
DbProtect Installation Guide. If you want to change or verify these values, you 
must run services.msc
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•  SQL Server AuthenticationSQL Server AuthenticationSQL Server AuthenticationSQL Server Authentication, then you must enter a Microsoft SQL Server 
authentication Login Name: Login Name: Login Name: Login Name: and Password:Password:Password:Password:

4. Click the OK OK OK OK button.

The Repair ODBC Repair ODBC Repair ODBC Repair ODBC utility changes the database server the Scan Engine uses to store its 
results, and/or changes the type of authentication DbProtect AppDetective uses to 
authenticate to the database server.

Updating the
JDBC connection

strings on the
DbProtect Console

host

To update the JDBC connection strings on the DbProtect Console host:

1. If you want to:

•  change the username/password to connect to the DbProtect database, use the 
Configuration Manager tool; for more information, see Appendix F: Using the 
Configuration Manager Tool

•  change the DbProtect database host or port, see Steps 2-4.

2. Stop the DbProtect and Message Collector services.

3. To change the DbProtect database host, first locate the following files:

•  <installation folder>\DbProtect\GUI\tomcat\conf\context.xml

•  <installation folder>\Message Collector\tomcat\conf\context.xml

Note:Note:Note:Note: DbProtect encrypts credentials in these files. Application Security, Inc. 
recommends you use the Configuration ManagerConfiguration ManagerConfiguration ManagerConfiguration Manager tool to modify the 
connection string and/or credentials; for more information see Appendix 
F: Using the Configuration Manager Tool.

At the bottom of each of these files you will notice the XML property values for the 
JDBC connection string. You can alter any of the values according to the following 
syntax: jdbc:jtds:sqlserver://[host][:port][/
database][;property=value[;...]]. Change [host] to he desired hostname, and 
[:port] to the desired port.

4. Re-start the DbProtect and Message Collector services.

At the bottom of each of these files you will notice the XML property values for the 
JDBC connection string. You can alter any of the values according to the following 
syntax: jdbc:jtds:sqlserver://[server][:port][/
database][;property=value[;...]]
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Examples: Examples: Examples: Examples: 

•  Using Windows AuthenticationWindows AuthenticationWindows AuthenticationWindows Authentication, URL = "jdbc:jtds:sqlserver://larch/
appdetective;ssl=request" username="" password=""

•  Using SQL Server AuthenticationSQL Server AuthenticationSQL Server AuthenticationSQL Server Authentication, URL ="jdbc:jtds:sqlserver://larch/
appdetective;ssl=request" username="dbp-appuser" 
password="user$1560p"

You can use either the instance name or the explicit port number for named instances. 
Using the port number explicitly eliminates the need to have SQL Server Browser 
Service running.

•  URL = "jdbc:jtds:sqlserver://[server][:port]/
appdetective;ssl=request"

OR

•  URL = "jdbc:jtds:sqlserver://[server]/
appdetective;ssl=request[;instance=<instance name>]
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Appendix H: Manually 
Changing the Logging Level 
for the Console by Modifying 
the log4j.properties File
This appendix consists of the following topics:

•  What are the Console logging levels?

•  log4j.properties file location

•  Manually modifying logging level values in a log4j.properties file.

Note:Note:Note:Note: This appendix explains how to manually modify logging level values in a 
log4j.properties file for DbProtect 2009.1R3 and greater. Previous 
versions of DbProtect have different instructions. Please refer to the 
appropriate, version-specific copy of the DbProtect User’s Guide for 
log4j.properties file logging level modification instructions if your 
version of DbProtect is earlier than 2009.1R3.

What are the
Console logging

levels?

The Console logging levellogging levellogging levellogging level controls the volume of log information the Console outputs 
to its log files.

In versions of the Console prior to version 3.10, you could use the Configuration Configuration Configuration Configuration 
Manager ToolManager ToolManager ToolManager Tool to modify the Console's logging levelConsole's logging levelConsole's logging levelConsole's logging level. However, 3.10 and greater 
versions of the Console require you to manually change the Console’s logging level 
values in a log4j.properties file.

Note:Note:Note:Note: Application Security, Inc. highly recommends you do notnotnotnot modify the 
Console log4j.properties file, unless instructed to do so by Customer 
Support.

VALID CONSOLE LOGGING LEVEL VALUES

Valid Console logging level values follow the hierarchy below, from most to least 
verbose:

•  DEBUG DEBUG DEBUG DEBUG (an increased logging level used to troubleshoot Console, Scan 
Engine, Sensor, and database problems)

•  INFOINFOINFOINFO

•  WARNWARNWARNWARN

•  ERRORERRORERRORERROR

•  FATALFATALFATALFATAL (a decreased logging level used to optimize Console performance).



DbProtect 6.1 User’s Guide

Application Security, Inc. 595

log4j.properties
file location

DbProtect 2009.1R3 and greater has only one log file and only one log4j.properties 
file (for both DbProtect Audit and Threat Management and DbProtect Vulnerability 
Management). It is located here: <installation 
folder>\DbProtect\GUI\tomcat\common\classes

The log4j.properties file for the Message CollectorMessage CollectorMessage CollectorMessage Collector component is located here: 
<AppSecInc Location>\Message Collector\tomcat\common\classes

Manually
modifying logging

level values in a
log4j.properties

file

To manually modify the logging level values in a log4j.properties file:

1. For SOAP logging between the Console and Sensors/Scan Engines.

If you run an Audit, or deploy a Policy to a Sensor, the log includes SOAP messages 
containing Audit and/or Policy information.

Edit the log4j.properties file and change the level from WARNWARNWARNWARN to INFOINFOINFOINFO in the 
following lines:

•  log4j.logger.org.apache.cxf.interceptor.LoggingInInterceptor=WARN
•  log4j.logger.org.apache.cxf.interceptor.LoggingOutInterceptor=WARN

2. For SOAP logging between Console and Console client.For SOAP logging between Console and Console client.For SOAP logging between Console and Console client.For SOAP logging between Console and Console client.

You can track SOAP messages passing between the client and the server. AfterAfterAfterAfter you 
make the edits described below, the DbProtect log will contain SOAP messages with 
the current logged-in username.

•  Edit the log4j.properties file and change the level from WARNWARNWARNWARN to INFOINFOINFOINFO on 
the following lines 
log4j.logger.org.apache.cxf.interceptor.LoggingInInterceptor=WARN

log4j.logger.org.apache.cxf.interceptor.LoggingOutInterceptor=WARN

•  Unpack the appdetective.war file.

•  Open appdetective/WEB-INF/cxf-servlet.xml and locate the following 
lines:

<jaxws:server id="ADCService"

serviceClass="com.appsec.console.soap.adc.ADC" address="/

ADCService">

<jaxws:serviceBean>

<bean class="com.appsec.console.soap.adc.ADCServiceImpl" />

</jaxws:serviceBean>

</jaxws:server>

Change it to the following:

<jaxws:server id="ADCService" 

serviceClass="com.appsec.console.soap.adc.ADC" address="/

ADCService">

<jaxws:serviceBean>

<bean class="com.appsec.console.soap.adc.ADCServiceImpl" />

</jaxws:serviceBean>
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<jaxws:inInterceptors>

<ref bean="loggingInInterceptor"/>

</jaxws:inInterceptors>

<jaxws:outInterceptors>

<ref bean="loggingOutInterceptor"/>

</jaxws:outInterceptors>

</jaxws:server>

•  Save the file and repack the appdetective.war file.

•  Re-start the Console.

3. Log client-side activity.

The AppDetective applet uses a different log4j.properties file, which is 

packaged into consoleapp.jar

•  Unpack the appdetective.war file.

•  Create a backup of the following files:

-consoleapp.jar

-consoleapp.jar.pack.gz

•  Delete the consoleapp.jar.pack.gz package file from the current folder.

•  Rename the consoleapp.jar package file to: consoleapp.zip

•  Use a zip tool to open the archive and edit consoleapp.zip. 

Caution! Do not extract and replace, because this might corrupt the .jar 

file.

•  Locate and open the log4j.properties file for editing.

The default Console appender is: 
log4j.appender.C=org.apache.log4j.ConsoleAppender

Note:Note:Note:Note: The appender writes to the Java console on the client side's machine.

•  Define the logging level for the desired package (i.e., classes within 
com.appsec.console.gui.xxx).

Example: Example: Example: Example: You can change WARNWARNWARNWARN to INFOINFOINFOINFO in the snippet below to log SOAP 
messages on the client side. 

Note:Note:Note:Note: You must set #CXF SOAP logging to INFOINFOINFOINFO or higher in order to see the 
SOAP messages.

log4j.logger.org.apache.cxf.interceptor.LoggingInInterceptor=

WARN

log4j.logger.org.apache.cxf.interceptor.LoggingOutInterceptor=

WARN
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•  Save the log4j.properties file and close the .zip file.

•  Re-name consoleapp.zip to consoleapp.jar.

To restore the logging level to its original setting, do the following:

•  Unpack the appdetective.war file.

•  Restore the consoleapp.jar and consoleapp.jar.pack.gz files from your 
backup.

•  Repack the .war file.

•  Re-start the DbProtect Console service.
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Appendix I: Required Audit 
Privileges
In this appendix:

•  IBM DB2 Audit Privileges

•  IBM DB2 z/OS Audit Privileges

•  Lotus Domino Groupware Audit Privileges

•  Microsoft SQL Server Audit Privileges and User Creation Scripts

•  MySQL Audit Privileges

•  Oracle Audit Privileges and User Creation Script

•  Sybase Audit Privileges

•  Operating System Considerations (for Audits).

IBM DB2 Audit
Privileges

Note:Note:Note:Note: For more information on IBM DB2 OS check requirements, see Operating 
System Considerations (for Audits).

To conduct a full IBM DB2IBM DB2IBM DB2IBM DB2 Audit, you need the following privilegesprivilegesprivilegesprivileges. Make sure the 
account you are using has rights to use the following tables, views, and functions:

•  CONNECT

•  GET DATABASE MANAGER CONFIGURATION & LIST DATABASE DIRECTORY

•  Service Info (on Windows only)

•  SYSIBM.SYSCOLAUTH

•  SYSIBM.SYSINDEXAUTH

•  SYSIBM.SYSPASSTHRUAUTH

•  SYSIBM.SCHEMAAUTH

•  SYSIBM.SYSDBAUTH

•  SYSIBM.SYSTABAUTH

•  SYSIBM.SYSFUNCTIONS

•  SYSIBM.SYSPROCEDURES

•  SYSIBM.SYSVERSIONS

•  SYSPROC.SNAPSHOT_DATABASE

Note:Note:Note:Note: SYSPROC.SNAPSHOT_DATABASE requires the Audit user to have SYSMON 
authority. Users with SYSADM, SYSCTRL, or SYSMAINT authority automatically 
inherit SYSMON authority.



DbProtect 6.1 User’s Guide

Application Security, Inc. 599

Below is a list of checkscheckscheckschecks within DbProtect Vulnerability Assessment for an IBM DB2 
Audit, and the tables and views they need permission to access in order to function 
properly:

•  CLIENT authentication:  GET DATABASE MANAGER CONFIGURATION & LIST 
DATABASE DIRECTORY

•  SERVER authentication:  GET DATABASE MANAGER CONFIGURATION & LIST 
DATABASE DIRECTORY

•  DCS authentication:  GET DATABASE MANAGER CONFIGURATION & LIST 
DATABASE DIRECTORY

•  Trust All Client:  GET DATABASE MANAGER CONFIGURATION & LIST 
DATABASE DIRECTORY

•  Authentication type:  GET DATABASE MANAGER CONFIGURATION & LIST 
DATABASE DIRECTORY

•  Service runs as LocalSystem:  Service Info (Windows ONLY)

•  Permissions granted to PUBLIC:  SYSIBM.SYSCOLAUTH, 
SYSIBM.SYSINDEXAUTH, SYSIBM.SYSPASSTHRUAUTH, SYSIBM.SCHEMAAUTH, 

SYSIBM.SYSDBAUTH, SYSIBM.SYSTABAUTH

•  Permissions granted to user:  SYSIBM.SYSCOLAUTH, 
SYSIBM.SYSINDEXAUTH, SYSIBM.SYSPASSTHRUAUTH, SYSIBM.SCHEMAAUTH, 

SYSIBM.SYSDBAUTH, SYSIBM.SYSTABAUTH

•  Permissions grantable:  SYSIBM.SYSCOLAUTH, SYSIBM.SYSINDEXAUTH, 
SYSIBM.SYSPASSTHRUAUTH, SYSIBM.SCHEMAAUTH, SYSIBM.SYSDBAUTH, 

SYSIBM.SYSTABAUTH

•  Permissions on system catalog:  SYSIBM.SYSDBAUTH, 
SYSIBM.SYSTABAUTH

•  Permissions to list users:  SYSIBM.SYSDBAUTH, SYSIBM.SYSTABAUTH

•  db2ckpwd buffer overflow (Version verify):  SYSIBM.SYSVERSIONS

•  Query Compiler DoS (Verify version):  SYSIBM.SYSVERSIONS

•  Date/Varchar DoS (Verify version):  SYSIBM.SYSVERSIONS

•  Latest FixPak not installed:  SYSIBM.SYSVERSIONS

•  Control Center buffer overflow (Verify version):  
SYSIBM.SYSVERSIONS

•  Excessive DBADM connections

For the Excessive DBADM connections check, the IBM DB2 OS user mustmustmustmust have:

•  SELECT or CONTROL privilege on the APPLICATIONS and SNAPAPPL_INFO 
administrative views

•  SYSMON, SYSCTRL, SYSMAINT, or SYSADM authority which is required to access 
snapshot monitor data.

Some DB2 Audit checks need to differentiate between fixpaks such as 4/4a, 6/6a, etc. 
These checks require specific permissionspermissionspermissionspermissions. Specifically, the checks affected are:

•  Arbitrary code execution in a federated system (Verify version)

•  Arbitrary code execution when processing connection messages 
(Verify version)

•  Arbitrary file creation in XML Extender functions (Verify version)
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•  Buffer overflow in CALL statement (Verify version)

•  Buffer overflow in db2fmp (Verify version)

•  Buffer overflow in generate_distfile procedure (Verify version)

•  Buffer overflow in REC2XML function (Verify version)

•  Buffer overflow in SATADMIN.SATENCRYPT function (Verify version)

•  Buffer overflow in the JDBC listener (Verify version)

•  Buffer overflows in XML Extender functions (Verify version)

•  DoS in string formatting functions (Verify version)

•  Latest FixPak not installed

•  Multiple Buffer overflows in libdb2.so.1 library (Verify version)

•  Multiple critical vulnerabilities in IBM DB2 (Verify version)

•  Multiple DoS vulnerabilities in SQLJRA protocol

The IBM DB2 OS user mustmustmustmust have access to the db2greg command on all Unix 
platforms for the following IBM DB2 LUW checks:

•  Permission on files

•  Setuid bit enabled

•  Setgid bit enabled

In order for DbProtect Vulnerability Assessment to work properly with any of these 
checks, you must set special permissionspermissionspermissionspermissions, depending on what version of DB2 is 
running on your server. The following table explains which permissions are required for 
which versions of DB2:  

If your server is 
running DB2 version:

Requirements:

9.10 or later SELECT or CONTROL privilege on the ENV_INST_INFO 
administrative view.

OR

SYSADM and/or ATTACH privileges.

AND

EXECUTE privilege on the ENV_GET_INST_INFO table function 
(required for IBM DB2 LUW v 8.2.2 and later). 

8.2.2 or later EXECUTE privilege on the ENV_GET_INST_INFO table function.

8.1.0 or later SYSADM or ATTACH privileges.

7 Registry access or OS access.
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IBM DB2 z/OS
Audit Privileges

This topic consists of the following sub-topics:

•  Full IBM DB2 z/OS Audit Requirements

•  Per Check IBM DB2 z/OS Audit Requirements.

FULL IBM DB2 Z/OS AUDIT REQUIREMENTS

You require the following permissionspermissionspermissionspermissions (which SYSADM has by default) in order to 
conduct a full IBM DB2 z/OS IBM DB2 z/OS IBM DB2 z/OS IBM DB2 z/OS Audit with all checks enabled:

•  SELECT privileges on the following catalog tables:

-SYSIBM.SYSCOLAUTH

-SYSIBM.SYSDBAUTH

-SYSIBM.SYSPACKAUTH

-SYSIBM.SYSPLANAUTH

-SYSIBM.SYSROUTINEAUTH

-SYSIBM.SYSSCHEMAAUTH

-SYSIBM.SYSTABAUTH

-SYSIBM.SYSUSERAUTH

-SYSIBM.GETVARIABLE

•  Permission to call the following function: SYSIBM.GETVARIABLE

•  Permission to call the following stored procedure: SYSPROC.DSNWZP

PER CHECK IBM DB2 Z/OS AUDIT REQUIREMENTS

To conduct an IBM DB2 z/OS Audit with selected checkscheckscheckschecks enabled, the following 
permissions are required in a per-check basis:

•  All checks require permission to call the following function: 
SYSIBM.GETVARIABLE

•  The following IBM DB2 z/OS Audit checks require permission to call the stored 
procedure SYSPROC.DSNWZP:

-Dual logging not enabled

-Dual archiving not enabled

-SMF accounting is not set to start automatically

-Audit Trace is not set to start automatically

-SMF statistics not set to start automatically

-Authorization checking disabled

-Collection interval for statistics

-System install administrators and operators

Note:Note:Note:Note: If the SYSPROC.DSNWZP and SYSPROC.ADMIN_DS_LIST stored procedures 
are not enabled, you mustmustmustmust enable them and set up the proper 
environments so they can function correctly.
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•  The IBM DB2 z/OS Audit check Connection and sign-on exits requires 
permission to call the stored procedure SYSPROC.ADMIN_DS_LIST.

•  The following table lists IBM DB2 z/OS Audit checks which mustmustmustmust have SELECT 
privileges on the corresponding IBM DB2 z/OS tables: 

Check
Corresponding IBM DB2 z/OS tables 

requiring SELECT privileges

Access list of authorization IDs SYSIBM.SYSTABAUTH

Administrative authorities on DB2 

Subsystem

SYSIBM.SYSUSERAUTH

Privileges granted to PUBLIC on 

packages

SYSIBM.SYSPACKAUTH

Administrative authorities for DB2 

catalog database

SYSIBM.SYSDBAUTH

Administrative authorities over 

databases

SYSIBM.SYSDBAUTH

Privileges granted to PUBLIC on 

plans

SYSIBM.SYSPLANAUTH

PUBLIC granted Administrative 

authorities on DB2 Subsystem

SYSIBM.SYSUSERAUTH

Privileges granted to PUBLIC on 

columns

SYSIBM.SYSCOLAUTH

Privileges granted to PUBLIC on 

routines

SYSIBM.SYSROUTINEAUTH

• Easily-guessed usernames and 

passwords

• No permission is required

• Privileges granted to PUBLIC on 

databases

SYSIBM.SYSDBAUTH

Privileges granted to PUBLIC on DB2 

subsystem

SYSIBM.SYSUSERAUTH
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Lotus Domino
Groupware Audit

Privileges

Note:Note:Note:Note: For more information on Lotus Domino OS check requirements, see 
Operating System Considerations (for Audits).

To conduct a full Lotus Domino GroupwareLotus Domino GroupwareLotus Domino GroupwareLotus Domino Groupware Audit, you need the following privilegesprivilegesprivilegesprivileges. 
Make sure the account you are using has rights to use the following tables and views:

•  Read all databases

•  Read decsadm.nsf and all of its documents

•  Read names.nsf and all of its documents

•  Execute commands on the server

•  Read all user documents

At a document level, DbProtect Vulnerability Assessment checks certain fields, 
including: $Author, $Readers, RM_MapFrom, $Readers, and fields of type 
LNRTTYPE_AUTHORS_FIELD.

DbProtect Vulnerability Assessment also verifies certain Lotus Domino Groupware 
properties (for example, if you have attachments and if they are encrypted). If any of 
the required fields listed above are encrypted and the id does not have access to it, 
then some of the checks below will notnotnotnot work properly.

Password same as username for 

account

SYSIBM.SYSDBAUTH

SYSIBM.SYSTABAUTH

SYSIBM.SYSPLANAUTH

SYSIBM.SYSCOLAUTH

SYSIBM.SYSSCHEMAAUTH

SYSIBM.SYSPACKAUTH

SYSIBM.SYSROUTINEAUTH

SYSIBM.SYSUSERAUTH

Privileges on the DB2 catalog PSYSTABAUTH

Privileges granted to PUBLIC on 

schemas

SYSIBM.SYSSCHEMAAUTH

Privileges granted to PUBLIC on DB2 

catalog tables

SYSTABAUTH

Privileges granted to PUBLIC on 

tables

SYSTABAUTH

Administrative authority for 

database granted to PUBLIC

SYSIBM.SYSDBAUTH

Check
Corresponding IBM DB2 z/OS tables 

requiring SELECT privileges
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Caution! Despositor access that only has access to read public 

documents is sufficient to run a Lotus Domino Groupware Audit, 

with the exception of the names.nsf database which requires 

Reader access. 

Besides SHOW commands, the following Lotus Domino Groupware commandscommandscommandscommands are also 
executed:

•  TELL HTTP SHOW FILE ACCESS

•  SET SECURE

Below is a list of checkscheckscheckschecks within the DbProtect Vulnerability Assessment for a Lotus 
Domino Audit, and the tables and views they need permission to access in order to 
function properly:

•  Anonymous can create documents:  Read all databases

•  Anonymous granted Designer or higher access:  Read all databases

•  Anonymous user in Authors field:  Read all databases

•  Default has Editor or higher access:  Read all databases

•  Encrypted field full-text indexed:  Read all databases

•  Unspecified user type in ACL: Read all databases

•  DECS password unencrypted:  Read decsadm.nsf and all of its 
documents

•  Anonymous ACL missing:  Read all databases, Read names.nsf and all 
of its documents

•  Access server unrestricted:  Read names.nsf and all of its 
documents

•  All people can use monitors:  Read names.nsf and all of its 
documents

•  All users can run personal agents:  Read names.nsf and all of its 
documents

•  Anonymous access via HTTPS:  Read names.nsf and all of its 
documents

•  Anonymous access via Notes RPC: Read names.nsf and all of its 
documents

•  Bindsock arbitrary file creation:  Read names.nsf and all of its 
documents

•  CGI directory leak:  Read names.nsf and all of its documents

•  Check passwords on Notes IDs:  Read names.nsf and all of its 
documents

•  Create databases unrestricted:  Read names.nsf and all of its 
documents

•  Enumerate groups:  Read names.nsf and all of its documents

•  Failed access control on file attachments:  Read names.nsf and all 
of its documents

•  iNotes client ActiveX control buffer overflow:  Read names.nsf and 
all of its documents
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•  iNotes s_ViewName buffer overflow:  Read names.nsf and all of its 
documents

•  Latest maintenance release not applied:  Read names.nsf and all of 
its documents

•  Long POST request DoS:  Read names.nsf and all of its documents

•  Maximum number of request headers:  Read names.nsf and all of its 
documents

•  Maximum size of request contents:  Read names.nsf and all of its 
documents

•  Maximum size of request headers:  Read names.nsf and all of its 
documents

•  Maximum URL length:  Read names.nsf and all of its documents

•  Maximum URL path segments:  Read names.nsf and all of its 
documents

•  Non-admins can use monitors:  Read names.nsf and all of its 
documents

•  Notes RPC buffer overflow:  Read names.nsf and all of its 
documents

•  Notes_ExecDirectory buffer overflow:  Read names.nsf and all of 
its documents

•  Password change interval for user:  Read names.nsf and all of its 
documents

•  PATH buffer overflow:  Read names.nsf and all of its documents

•  Public keys compared to directory:  Read names.nsf and all of its 
documents

•  Restricted agents runlist:  Read names.nsf and all of its 
documents

•  Restricted Java/COM runlist:  Read names.nsf and all of its 
documents

•  Saved email not encrypted:  Read names.nsf and all of its 
documents

•  Servlets disabled:  Read names.nsf and all of its documents

•  Unrestricted agents runlist:  Read names.nsf and all of its 
documents

•  Unrestricted Java/COM runlist:  Read names.nsf and all of its 
documents

•  User can create new databases:  Read names.nsf and all of its 
documents

•  Administration over HTTP:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Anonymous access via HTTP:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Anonymous access via IIOP:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Anonymous access via IIOPS:  Read names.nsf and all of its 
documents, Execute a command on the server
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•  Anonymous access via LDAP:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Anonymous access via LDAPS:  Read names.nsf and all of its 
documents, Execute a command on the server

•  ESMTP buffer overflow:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Expired certificates allowed:  Read names.nsf and all of its 
documents, Execute a command on the server

•  HTTP authenticate buffer overflow:  Read names.nsf and all of its 
documents, Execute a command on the server

•  HTTP database browsing:  Read names.nsf and all of its documents, 
Execute a command on the server

•  HTTP logging not enabled:  Read names.nsf and all of its 
documents, Execute a command on the server

•  HTTP methods excluded from logging:  Read names.nsf and all of its 
documents, Execute a command on the server

•  HTTP MIME types excluded from logging:  Read names.nsf and all of 
its documents, Execute a command on the server

•  HTTP return codes excluded from logging:  Read names.nsf and all 
of its documents, Execute a command on the server

•  HTTP user agents excluded from logging:  Read names.nsf and all of 
its documents, Execute a command on the server

•  HTTPS allows anonymous access:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Inadequate amgr process logging:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Incomplete POST DoS:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Interface address leak in banner:  Read names.nsf and all of its 
documents, Execute a command on the server

•  LDAP buffer overflow:  Read names.nsf and all of its documents, 
Execute a command on the server

•  LDAP format string:  Read names.nsf and all of its documents, 
Execute a command on the server

•  MS-DOS device web path leak:  Read names.nsf and all of its 
documents, Execute a command on the server

•  Personal agents runlist:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Redirected host/location buffer overflow:  Read names.nsf and all 
of its documents, Execute a command on the server

•  Routing loop DoS (Verify version):  Read names.nsf and all of its 
documents, Execute a command on the server

•  SMTP buffer overflow:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Unencrypted HTTP:  Read names.nsf and all of its documents, 
Execute a command on the server
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•  Unencrypted IIOP:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Unencrypted IMAP:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Unencrypted LDAP:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Unencrypted NNTP:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Unencrypted POP3:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Web retriever HTTP status buffer overflow:  Read names.nsf and all 
of its documents, Execute a command on the server

•  Web Retriever logging:  Read names.nsf and all of its documents, 
Execute a command on the server

•  Easily-guessed Internet password:  Read all user documents

•  Easily-guessed Notes password:  Read all user documents

•  Agent manager debugging not enabled:  Execute a command on the 
server

•  Ambiguous webnames allowed:  Execute a command on the server

•  Console password not set:  Execute a command on the server

•  Inadequate console logging:  Execute a command on the server

•  NDS password present:  Execute a command on the server

•  NDS userid present:  Execute a command on the server

•  Phone line logging not enabled:  Execute a command on the server

Microsoft SQL
Server Audit

Privileges and User
Creation Scripts

Note:Note:Note:Note: For more information on Microsoft SQL Server OS check requirements, 
see Operating System Considerations (for Audits).

This topic consists of the following sub-topics:

•  Microsoft SQL Server 2000 and MSDE Audit Privileges

•  Running the Microsoft SQL Server 2000 User Creation Script

•  Running the Microsoft SQL Server 2000 with Sysadmin User Creation Script

•  Microsoft SQL Server 2005 and Microsoft SQL Server 2008 Audit Privileges

•  Credentials for Microsoft SQL Server Audits

•  Running the Microsoft SQL Server 2005 and 2008 User Creation Script

•  Registry Access for Microsoft SQL Server 2000, 2005, and 2008.
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MICROSOFT SQL SERVER 2000 AND MSDE AUDIT 

PRIVILEGES

To conduct a full Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000 or MSDEMSDEMSDEMSDE Audit, you need the following 
privilegesprivilegesprivilegesprivileges. Make sure the account you are using has rights to use the following tables 
and views: 

Check
Privileges 
Required

master.dbo.xp_loginconfig EXECUTE

master.dbo.xp_regread

exec <db name>.dbo.sp_helprotect

msdb.dbo.sp_get_sqlagent_properties

master.dbo.xp_cmdshell

@@VERSION SELECT

master.dbo.syslogins 

(MSSQLSysLogins)

master.dbo.sysxlogins

master.dbo.sysdatabases

master.dbo.sysconfigures

master.dbo.syscurconfigs

master.dbo.syscharsets

<db name>.dbo.sysusers

<db name>.dbo.sysobjects

<db name>.dbo.syscomments
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In addition, certain Microsoft SQL Server 2000 DISA-STIG Database Security 
Configuration checks require you to be a member of the sysadmin fixed server role or 
the db_owner fixed database role on the publication database. The following table 
provides specific information about which checks require which roles (and why): 

Below is a list of checkscheckscheckschecks within the DbProtect Vulnerability Assessment for a Microsoft 
SQL Server 2000 Audit, and the tables and views they need permission to access in 
order to function properly:

•  Agent jobs privilege escalation: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Auditing of failed logins: master.dbo.xp_loginconfig

•  Auditing of successful logins: master.dbo.xp_loginconfig

•  Blank password: master.dbo.sysxlogins

•  Blank password for sa: master.dbo.sysxlogins

•  Blank password for well-known login: master.dbo.sysxlogins

•  BULK INSERT buffer overflow: @@VERSION

•  C2 Audit Mode: @@VERSION, master.dbo.sysconfigures, 
master.dbo.syscurconfigs

•  Case-insensitive sort order: master.dbo.syscharsets, 
master.dbo.sysconfigures,master.dbo.syscurconfigs

•  Changing mode may leave sa password blank: @@VERSION

•  Cleartext password written by installation: @@VERSION, 
master.dbo.xp_cmdshell

•  Computed Column UDF DoS:  @@version

•  Database ownership chaining not disabled:  
sysconfigures,syscurconfigs

•  DBCC addextendedproc buffer overflow: @@VERSION

•  DBCC BUFFER buffer overflow: @@VERSION

Microsoft SQL Server 
2000 DISA-STIG checks:

Use:
To run these checks, you 
must be a member of:

DBMS replication 

account privileges

Replication system stored 
procedures.

The sysadmin fixed server 
role or the db_owner fixed 
database role on the 
publication database.Replication snapshot 

folder protection

Database auditing fn_trace_getinfo and 
fn_trace_geteventinfo 
functions.

The sysadmin fixed server 
role.

Auditing of Security 

Events

Startup Stored 

Procedures
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•  DBCC CHECKCONSTRAINTS buffer overflow: @@VERSION

•  DBCC CLEANTABLE buffer overflow: @@VERSION

•  DBCC INDEXDEFRAG buffer overflow: @@VERSION

•  DBCC PROCBUF buffer overflow: @@VERSION

•  DBCC SHOWCONTIG buffer overflow: @@VERSION

•  DBCC SHOWTABLEAFFINITY buffer overflow: @@VERSION

•  DBCC UPDATEUSAGE buffer overflow: @@VERSION

•  DBMS remote system credential use and access: 
master.dbo.sysxlogins, [master].dbo.sysservers

•  Default login enabled: @@VERSION, master.dbo.syslogins, 
master.dbo.xp_loginconfig

•  Direct updates on data dictionary: master.dbo.sysconfigures, 
master.dbo.syscurconfigs

•  DTS package procedures granted to public:  sp_helprotect

•  DTS package password publicly viewable: msdb.dbo.sysuser, exec 
msdb.dbo.sp_helprotect

•  DTS password exposed in properties dialog: @@VERSION

•  DTS passwords publicly viewable: <db name>.dbo.sysuser, exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Easily-guessed password: @@VERSION

•  Easily-guessed password for sa: @@VERSION

•  Easily-guessed password for well-known login: @@VERSION

•  Encoded password written by installation: @@VERSION, 
master.dbo.xp_cmdshell

•  Enterprise Manager improperly revokes proxy account: @@VERSION

•  Error logs can be overwritten: Registry access

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2000, see Registry Access for Microsoft SQL Server 2000, 2005, and 2008.

•  Escalated privileges in heterogeneous joins: @@VERSION

•  Extended stored proc privilege upgrade: exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Fixed server role granted: master.dbo.syslogins

•  Format string in C runtime DoS: @@VERSION

•  Format string vuln in xp_sprintf: @@VERSION

•  FORMATMESSAGE buffer overflow: @@VERSION

•  Global temporary stored proc exists:  sysobjects,sysusers

•  Guest user exists in database: <db name>.dbo.sysuser, 
master.dbo.sysdatabases

•  Hello buffer overflow: @@VERSION

•  Infected with Spida worm: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases, master.dbo.xp_cmdshell

•  Jet running in sandbox Mode: Registry access

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2000, see Registry Access for Microsoft SQL Server 2000, 2005, and 2008.

•  Job output file handling: @@VERSION
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•  Latest service pack applied: @@VERSION

•  Lumigent Log Explorer buffer overflow: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  Malformed RPC request DoS: @@VERSION

•  Malformed TDS packet header DoS: @@VERSION

•  MDX Query buffer overflow: @@VERSION

•  Objects not owned by dbo: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases, <db name>.dbo.sysuser

•  OLEDB ad hoc queries allowed: Registry access

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2000, see Registry Access for Microsoft SQL Server 2000, 2005, and 2008.

•  Orphaned user: @@VERSION, <db name>.dbo.sysuser, 
master.dbo.sysdatabases, master.dbo.syslogins

•  Password same as login name: @@VERSION

•  Permission grantable: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permissions granted to public: <db name>.dbo.sp_helprotect

•  Permission on mswebtasks: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permission on registry extended proc: exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Permission on sp_MSsetalertinfo: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permission on sp_MSSetServerProperties: exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Permission on sp_readwebtask: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permission on sp_runwebtask: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permission on xp_readerrorlog: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  Permission to select from syslogins: exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Permission to select from system table: <db name>.dbo.sysobjects, 
exec <db name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Permissions granted on sp_add_dtspackage: msdb.dbo.sysuser, exec 
msdb.dbo.sp_helprotect

•  Permissions granted on xp_cmdshell: @@VERSION, exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Permissions granted to user: <db name>.dbo.sysuser, exec <db 
name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Public can create Agent jobs: exec <db name>.dbo.sp_helprotect, 
master.dbo.sysdatabases

•  pwdencrypt buffer overflow: @@VERSION

•  RAISERROR buffer overflow: @@VERSION
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•  Registry extended proc not removed: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  Remote access allowed: master.dbo.sysconfigures, 
master.dbo.syscurconfigs

•  Remote data source function unchecked buffer: @@VERSION

•  Replication password publicly viewable:  
xp_regread,sysobjects,@@version,sp_helprotect

•  Resolution service DoS: @@VERSION

•  Resolution service heap overflow: @@VERSION

•  Resolution service stack overflow: @@VERSION

•  Reusable cached administrator connection: @@VERSION

•  sp_attachsubscription command injection: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  sp_MScopyscriptfile command injection: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases, @@VERSION

•  SQL Agent password publicly viewable:  @@version, 
msdb.dbo.sp_get_sqlagent_properties, sp_helprotect

•  SQL Agent procedures granted to public:  sp_helprotect

•  SQLServerAgent password in registry: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  srv_paraminfo buffer overflow in sp_OACreate: @@VERSION

•  srv_paraminfo buffer overflow in sp_OADestroy: @@VERSION

•  srv_paraminfo buffer overflow in sp_OAGetProperty: @@VERSION

•  srv_paraminfo buffer overflow in sp_OAMethod: @@VERSION

•  srv_paraminfo buffer overflow in sp_OASetProperty: @@VERSION

•  srv_paraminfo buffer overflow in xp_displayparamstmt: @@VERSION

•  srv_paraminfo buffer overflow in xp_execresultset: @@VERSION

•  srv_paraminfo buffer overflow in xp_peekqueue: @@VERSION

•  srv_paraminfo buffer overflow in xp_printstatements: @@VERSION

•  srv_paraminfo buffer overflow in xp_proxiedmetadata: @@VERSION

•  srv_paraminfo buffer overflow in xp_SetSQLSecurity: @@VERSION

•  srv_paraminfo buffer overflow in xp_showcolv: @@VERSION

•  srv_paraminfo buffer overflow in xp_sqlagent_monitor: @@VERSION

•  srv_paraminfo buffer overflow in xp_sqlinventory: @@VERSION

•  srv_paraminfo buffer overflow in xp_updatecolvbm: @@VERSION

•  Standard SQL Server authentication allowed: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases, 

master.dbo.xp_loginconfig

•  Statement permission granted: master.dbo.sysdatabases, exec <db 
name>.dbo.sp_helprotect

•  SysAdmin only for CmdExec job steps: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  sysadmin role granted: master.dbo.syslogins

•  Table to store DTS passwords publicly viewable: <db 
name>.dbo.sysuser, master.dbo.sysdatabases, exec <db 

name>.dbo.sp_helprotect
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•  Temporary stored procedures bypass permissions: @@VERSION

•  UDB broadcast buffer overflow: master.dbo.xp_cmdshell

•  Unauthorized object permission grants: <db name>.dbo.sysuser, exec 
<db name>.dbo.sp_helprotect, master.dbo.sysdatabases

•  Windows account name shown as hostname: @@VERSION, 
master.dbo.xp_loginconfig

•  XMLHTTP control allows local file access: <db 
name>.dbo.sysobjects, master.dbo.sysdatabases, @@VERSION

•  xp_cmdshell not removed: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases replace for xp_cmdshell not removed/not 

disabled: select object_id()

•  xp_controlqueueservice buffer overflow: <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  xp_createprivatequeue buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_createqueue buffer overflow: @@VERSION, 
master.dbo.sysdatabases, <db name>.dbo.sysobjects

•  xp_decodequeuecmd buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_deleteprivatequeue buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_deletequeue buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_dirtree buffer overflow: @@VERSION, <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  xp_displayqueuemesgs buffer overflow: @@VERSION, 
master.dbo.sysdatabases, <db name>.dbo.sysobjects

•  xp_dsninfo buffer overflow: <db name>.dbo.sysobjects, @@VERSION, 
master.dbo.sysdatabases

•  xp_mergelineages buffer overflow: @@VERSION, 
master.dbo.sysdatabases, <db name>.dbo.sysobjects

•  xp_oledbinfo buffer overflow: @@VERSION, <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  xp_proxiedmetadata buffer overflow: master.dbo.sysdatabases, <db 
name>.dbo.sysobjects, @@VERSION

•  xp_readpkfromqueue buffer overflow: @@VERSION,  <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_readpkfromvarbin buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_repl_encrypt buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_resetqueue buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases

•  xp_sprintf buffer overflow: @@VERSION

•  xp_sqlagent_param buffer overflow: @@VERSION, <db 
name>.dbo.sysobjects, master.dbo.sysdatabases
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•  xp_sqlinventory buffer overflow: @@VERSION, 
master.dbo.sysdatabases, <db name>.dbo.sysobjects

•  xp_unpackcab buffer overflow: @@VERSION, <db name>.dbo.sysobjects, 
master.dbo.sysdatabases

•  xstatus backdoor: @@VERSION, master.dbo.sysxlogins

RUNNING THE MICROSOFT SQL SERVER 2000 USER 

CREATION SCRIPT

Application Security Inc. has written a convenient Microsoft SQL Server 2000 user 
creation script (CreateUserSQLServer2k.sql) which creates an account with the 
minimum privileges necessary to perform Audits on a Microsoft SQL 2000 instance.

The contents of the CreateUserSQLServer2k.sql script follow:

--create login

use [master]

EXEC sp_addlogin 'aduser', 'Admin123', 'master'

GO

--add user to each database

EXEC sp_MSforeachdb '

USE [?]

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,''Updateability'') FROM 

master.dbo.sysdatabases where databasePropertyEx(name,''Sta-

tus'')=''ONLINE'' and name = ''?''

IF @isUpdateable = ''READ_WRITE''

BEGIN

    EXEC sp_adduser ''aduser''

END'

GO

--assign privileges needed for audit

USE [master]

GO

GRANT EXECUTE ON dbo.xp_loginconfig TO [aduser]

GRANT SELECT ON dbo.syslogins TO [aduser]

GRANT SELECT ON dbo.sysxlogins TO [aduser]
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GRANT SELECT ON dbo.sysaltfiles TO [aduser]

GRANT SELECT ON dbo.sysdatabases TO [aduser]

GRANT SELECT ON dbo.sysconfigures TO [aduser]

GRANT SELECT ON dbo.syscurconfigs TO [aduser]

GRANT SELECT ON dbo.sysservers TO [aduser]

GRANT SELECT ON dbo.sysmembers TO [aduser]

GRANT SELECT ON dbo.sysprotects TO [aduser]

GRANT SELECT ON dbo.spt_values TO [aduser]

GRANT EXECUTE ON sp_helpreplicationdboption TO [aduser]

GRANT EXECUTE ON sp_helpsrvrolemember TO [aduser]

GRANT EXECUTE ON sp_helprolemember TO [aduser]

GRANT SELECT ON dbo.sysoledbusers TO [aduser]

EXEC sp_MSforeachdb '

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,''Updateability'') FROM 

master.dbo.sysdatabases where databasePropertyEx(name,''Sta-

tus'')=''ONLINE'' and name = ''?''

IF @isUpdateable = ''READ_WRITE''

BEGIN

GRANT EXECUTE ON [?].dbo.sp_helprotect TO [aduser]

GRANT EXECUTE ON [?].dbo.sp_helpuser TO [aduser]

END

'

EXEC sp_MSforeachdb '

USE [?]

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,''Updateability'') FROM 

master.dbo.sysdatabases where databasePropertyEx(name,''Sta-

tus'')=''ONLINE'' and name = ''?''

IF @isUpdateable = ''READ_WRITE''
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BEGIN

GRANT SELECT ON dbo.sysusers TO [aduser]

GRANT SELECT ON dbo.sysobjects TO [aduser]

GRANT SELECT ON dbo.syscomments TO [aduser]

END

'

use [msdb]

GRANT SELECT ON dbo.sysjobs TO [aduser]

GRANT SELECT ON dbo.sysjobhistory TO [aduser]

print 'all done.'

RUNNING THE MICROSOFT SQL SERVER 2000 WITH 

SYSADMIN USER CREATION SCRIPT

Application Security Inc. has written a convenient Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000 user user user user 
creation scriptcreation scriptcreation scriptcreation script (CreateUserSQLServer2kwithSA.sql) which creates an account with 
the minimum privileges necessary to perform Audits on a Microsoft SQL 2000 
instance, and adds it to the SYSADMIN server role.

The contents of the CreateUserSQLServer2kwithSA.sql script follow:

USE master

GO

EXEC sp_addlogin 'aduser', 'Admin123'

GO

EXEC sp_MSforeachdb '

USE [?]

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,''Updateability'') FROM 

master.dbo.sysdatabases where 

databasePropertyEx(name,''Status'')=''ONLINE'' and name = ''?''

IF @isUpdateable = ''READ_WRITE''

BEGIN EXEC sp_grantdbaccess ''aduser'', ''aduser''

END'

GO

EXEC sp_addsrvrolemember "aduser", SYSADMIN
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MICROSOFT SQL SERVER 2005 AND MICROSOFT SQL SERVER 

2008 AUDIT PRIVILEGES

Important: Application Security Inc. wrote a convenient Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 Microsoft SQL Server 2005 
and Microsoft SQL Server 2008 user creation script Microsoft SQL Server 2008 user creation script Microsoft SQL Server 2008 user creation script Microsoft SQL Server 2008 user creation script 
(CreateUserSQLServer2k52k8PublicRevoked.sql) that creates an 
account with the minimum privileges necessary to perform an Audit on a 
Microsoft SQL Server instance. If you want to run this script, just make sure 
whatever account you use to conduct your Audit has at least the SELECT 
privileges listed in the script. For more information, see Running the 
Microsoft SQL Server 2005 and 2008 User Creation Script.

Any Audit check for Microsoft SQL Server 2005 and Microsoft SQL Server 2008 queries 
the following views:

•  sys.databases

•  sys.configurations

•  sys.server_principals

•  sys.server_role_members

In Microsoft SQL Server 2005 and Microsoft SQL Server 2008 the public group can 
select from these views but, due to metadata visibility concept, DbProtect Vulnerability 
Assessment may not return all records. For this reason, each of the checks listed below 
requires the following permissions in order to retrieve data: VIEW DEFINITION, VIEW 
ANY DEFINITION, and CONTROL SERVER.

In addition, you mustmustmustmust have permission to select from system table: select all 
rows from master.sys.database_permissions, <dbname>.sys.system_objects 

views which implies VIEW DEFINITION on database scope permission.

For the check Symmetric Keys: encrypting mechanism to work properly, the 
auditing user should have access to all keys. The user must be a privileged user have 
been granted access to all the keys. You can use one of the following statements to 
grant access:

for every database

GRANT VIEW DEFINITION TO [aduser]

or

in master database

GRANT VIEW ANY DEFINITION TO [aduser]

In addition, certain Microsoft SQL Server 2005 and 2008 DISA-STIG Database Security 
Configuration checks require you to be a member of the sysadmin fixed server role or 
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the db_owner fixed database role on the publication database. The following table 
provides specific information about which checks require which roles (and why): 

Below is a list of DbProtect Vulnerability Assessment checkscheckscheckschecks used to run a Microsoft 
SQL Server 2005 or and Microsoft SQL Server 2008 Audit, including the tables and 
views they need permission to access in order to function properly:

•  Agent XPs enabled: select from sys.configurations view.

•  Application user access to external objects: select from 
<dbname>.sys.objects, <dbname>.sys.database_permissions.

•  Asymmetric Keys: private key encryption type: select from 
master.dbo.sysdatabases, select from 

<dbname>.sys.asymmetric_keys, VIEW DEFINITION on database scope 

permission.

•  Auditing of failed logins: master.dbo.xp_loginconfig.

•  Auditing of failed/successful logins: execute xp_loginconfig.

•  Audit trace status: select from fn_trace_getinfo, 
fn_trace_geteventinfo.

•  Blank password checks: select password_hash column of 
sys.sql_logins for all sql logins which implies CONTROL SERVER 

permission.

•  BUILTIN\Administrators not removed: select all rows from 
sys.server_principals view which implies VIEW ANY DEFINITION 

permission.

•  C2 Audit Mode: select from sys.configurations view.

•  CLR objects allowed: select from sys.configurations view.

•  Common criteria compliance disabled: select from 
sys.configurations view.

•  Database job/batch queue monitoring: select from 
master.sys.procedures, select name, job_id columns from 

msdb.dbo.sysjobs and select job_id column from 

msdb.dbo.sysjobhistory.

•  Database Master Key: access control: select from 
master.dbo.sysdatabases, <dbname>.sys.database_principals, 

<dbname>.sys.database_permissions.

Microsoft SQL Server 205 
and 2008 DISA-STIG 

checks:
Use:

To run these checks, you 
must be a member of:

DBMS replication 

account privileges

Replication system stored 
procedures.

The sysadmin fixed server 
role or the db_owner fixed 
database role on the 
publication databaseReplication snapshot 

folder protection
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•  Database Master Key: encryption password: select from 
master.dbo.sysdatabases,<dbname>.sys.key_encryptions,<dbname>.sys

.symmetric_keys, VIEW DEFINITION on database scope permission.

•  Database Master Key: is_master_key_encrypted_by_server: select 
from sys.databases.

•  Database Master Key: password storage: select from 
sys.master_key_passwords.

•  Database ownership chaining not disabled: select from 
sys.configurations view.

•  DBA OS privilege assignment: execute sp_helpsrvrolemember.

•  DBMS account password expiration: select from sys.sql_logins.

•  DBMS administration OS accounts: execute sp_helpsrvrolemember.

•  DBMS audit log backups: select from fn_trace_getinfo.

•  DBMS audit record access: select from sys.server_permissions, 
master.dbo.syslogins and master.dbo.sysusers, execute 

sp_helpsrvrolemember.

•  DBMS Password Policy Enforced: execute xp_loginconfig, select from 
sys.sql_logins.

•  DBMS remote system credential use and access: select from 
dbo.sysservers, sys.linked_logins.

•  DBMS services dedicated custom account: Registry access.

•  DBMS software file backups: Registry access.

•  DBMS dedicated software directory and partition: Registry access.

•  DBMS network port, protocol, and services (PPS) configuration: 
Registry access*.

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2005 and 2008, see Registry Access for Microsoft SQL Server 2000, 2005, 
and 2008.

•  Dedicated data file directories: select from sys.master_files, 
sys.databases, Registry access*.

•  Default password for well-known login: makes connection attempts.

•  Default Trace Disabled: select from sys.configurations view.

•  DTS package password publicly viewable: select all rows from 
msdb.sys.database_permissions, sys.types, sys.all_objects, 

sys.certificates, sys.fulltext_catalogs, sys.routes, 

sys.remote_service_bindings, sys.services, sys.service_contracts, 

sys.service_message_types, sys.xml_schema_collections, 

sys.assemblies views which implies VIEW DEFINITION on database 

scope permission.

•  DTS package procedures granted to public: select from 
msdb.sys.database_permissions view.

•  DTS procedures granted to PUBLIC: select from 
msdb.sys.database_principals, msdb.sys.database_permissions.

•  Easily-guessed password checks: select password_hash column of 
sys.sql_logins for all sql logins which implies CONTROL SERVER 

permission.

•  Encryption of DBMS sensitive data in transit: Registry access.
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•  Error logs can be overwritten: Registry access.

•  Event forwarding not disabled: Registry access.

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2005 and 2008, see Registry Access for Microsoft SQL Server 2000, 2005, 
and 2008.

•  Fixed server role granted: select all rows from 
sys.server_principals, sys.server_role_members views which 

implies VIEW ANY DEFINITION permission.

•  Global temporary stored proc exists: select from 
tempdb.sys.all_objects.

•  Guest user exists in database: select all rows from sys.databases 
and <dbname>.sys.database_principals, and 

<dbname>.sys.database_permissions views.

•  Integration Services OS account least privileges: Windows 
Management Instrumentation (WMI).

•  Latest service pack/hot fix not applied: uses @@version - requires 
no privileges.

•  Linked Servers Definitions: select from sys.servers view. 
Permissions granted on sp_add_dtspackage: select all rows from 

msdb.sys.database_permissions, sys.types, sys.all_objects, 

sys.certificates, sys.fulltext_catalogs, sys.routes, 

sys.remote_service_bindings, sys.services, sys.service_contracts, 

sys.service_message_types, sys.xml_schema_collections, 

sys.assemblies views which implies VIEW DEFINITION on database 

scope permission.

•  Lumigent Log Explorer buffer overflow: select all rows from 
master.sys.objects view which implies VIEW DEFINITION on master 

database permission.

•  Not using NTFS partition: execute xp_instance_regread.

•  OLEDB ad hoc queries allowed: select from sys.configurations view, 
Registry access.

Note:Note:Note:Note: To learn more about enabling registry access for Microsoft SQL Server 
2005 and 2008, see Registry Access for Microsoft SQL Server 2000, 2005, 
and 2008.

•  Password same as login name: select password_hash column of 
sys.sql_logins view for all sql logins which implies CONTROL 

SERVER permission.

•  Permission grantable: select all rows from sys.databases, 
<dbname>.sys.database_permissions views which implies VIEW 

DEFINITION on database scope permission.

•  Permission on OLE automation procs: select all rows from 
master.sys.database_permissions view which implies VIEW DEFINITION 

on database scope permission.

•  Permission on registry extended proc: select all rows from 
master.sys.database_permissions view which implies VIEW DEFINITION 

on database scope permission.
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•  Permission to select from system table: select all rows from 
master.sys.database_permissions view which implies VIEW DEFINITION 

on database scope permission.

•  Permissions granted on xp_cmdshell: select all rows from 
master.sys.database_permissions view which implies VIEW DEFINITION 

on database scope permission.

•  Permissions granted to PUBLIC: select all rows from sys.databases, 
<dbname>.sys.database_permissions views.

•  Permissions granted to user: select all rows from sys.databases, 
<dbname>.sys.database_permissions, sys.types, sys.all_objects, 

sys.certificates, sys.fulltext_catalogs, sys.routes, 

sys.remote_service_bindings, sys.services, sys.service_contracts, 

sys.service_message_types, sys.xml_schema_collections, 

sys.assemblies views which implies VIEW DEFINITION on database 

scope permission.

•  Permissions on files: execute xp_instance_regread.

•  Protection of DBMS asymmetric encryption keys: select from 
master.dbo.sysdatabases, <dbname>.sys.asymmetric_keys, 

<dbname>.sys.database_principals, 

<dbname>.sys.database_permissions, VIEW DEFINITION on database 

scope permission.

•  Proxy account subsystem privileges: select subsystem, subsystem_id 
columns from msdb.dbo.syssubsystems.

•  Registry extended proc not removed: select from 
master.sys.system_objects view.

•  Registry permissions: execute xp_instance_regread.

•  Remote access allowed: select from sys.configurations view.

•  Remote admin connections allowed: select from sys.configurations 
view.

•  Sample database not removed: select all rows from sys.databases 
view.

•  Service Broker Endpoints exist: select from 
sys.service_broker_endpoints.

•  Service runs as LocalSystem: execute xp_instance_regread.

•  SMO and DMO XPs enabled: select from sys.configurations view.

•  SQL Server Agent account user rights: Windows Management 
Instrumentation (WMI).

•  SQL Server Agent proxy accounts are not dedicated: execute 
sp_enum_login_for_proxy.

•  SQL Server component service account user rights: Windows 
Management Instrumentation (WMI).

•  SQL Server file permissions: Registry access*, OS access 
(Permission to read files in the installation directory of the 

database) also Windows Management Instrumentation (WMI).

•  SQL Server service account: Windows Management Instrumentation 
(WMI).

•  SQL Server service account user rights: Windows Management 
Instrumentation (WMI).
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•  Standard SQL Server authentication allowed: execute 
xp_instance_regread.

•  Statement permission granted: select all rows from sys.databases, 
<dbname>.sys.database_permissions views which implies VIEW 

DEFINITION on database scope permission.

•  Symmetric Keys: allowed encryption algorithms: select from 
master.dbo.sysdatabases, <dbname>.sys.symmetric_keys, VIEW 

DEFINITION on database scope permission.

•  Symmetric Keys: encrypting mechanism: select from 
master.dbo.sysdatabases, <dbname>.sys.symmetric_keys, 

<dbname>.sys.key_encryptions, VIEW DEFINITION on database scope 

permission.

•  sysadmin role granted: select all rows from sys.server_principals, 
sys.server_role_members views which implies VIEW ANY DEFINITION 

permission.

•  Unauthorized object permission grants: select all rows from 
sys.databases, <dbname>.sys.database_permissions, sys.types, 

sys.all_objects, sys.certificates, sys.fulltext_catalogs, 

sys.routes, sys.remote_service_bindings, sys.services, 

sys.service_contracts, sys.service_message_types, 

sys.xml_schema_collections, sys.assemblies views which implies 

VIEW DEFINITION on database scope permission.

•  XML web service access: select from sys.http_endpoints.

•  Web assistant procedures enabled: select from sys.configurations 
view.

•  xp_cmdshell not removed/not disabled: select from 
sys.configurations view.

CREDENTIALS FOR MICROSOFT SQL SERVER AUDITS

If you are unable to Audit a Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server Microsoft SQL Server database using Windows 
Authentication, you may be using an account that lacks the proper credentialscredentialscredentialscredentials. There 
are a number of different ways to supply the proper credentials for Microsoft SQL 
Server. The appropriate method depends on your circumstances.

The following table explains how to change your credentials under different scenarios 
when you attempt to perform an Audit on the Microsoft SQL Server TARGET machine 
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from another machine (HOST). Once you have valid credentials on the target HOST, you 
should be able to perform your Audit. 

Part If Then

1 TARGET and HOST are in the same 
or trusted domain.

• If you are logged in to HOST as a user that 
has Administrative access to TARGET, you 
do not need to supply additional 
credentials.

Or...

• If you are logged in as user without 
Administrative access, you will need to 
supply TARGET’s sa credentials.
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2 TARGET is in WORKGROUP_X and 
HOST is in DOMAIN_A

Or...

TARGET is in WORKGROUP_X and 
HOST is in WORKGROUP_Y

Or...

TARGET is in WORKGROUP_X and 
HOST is in WORKGROUP_X

• You can supply sa credentials in DbProtect 
Vulnerability Assessment.

Or...

• You can create a local user on TARGET and 
a local user on HOST with matching user 
names and passwords.

Note:Note:Note:Note: You cannotcannotcannotcannot use Domain names here.

Or...

• Select the PropertiesPropertiesPropertiesProperties branch option 
Connect to Microsoft SQL Servers via Connect to Microsoft SQL Servers via Connect to Microsoft SQL Servers via Connect to Microsoft SQL Servers via 
Named PipesNamed PipesNamed PipesNamed Pipes in the DbProtect Vulnerability 
Assessment PropertiesPropertiesPropertiesProperties branch, then use 
the Net Use technique to establish 
credentials on TARGET. You mustmustmustmust select this 
option to force DbProtect Vulnerability 
Assessment to use named pipes. You must 
check this option if you want to Audit a 
Microsoft SQL Server database (using 
Windows Authentication) against a 
machine on a different or untrusted 
domain. Additional steps are required. Additional steps are required. Additional steps are required. Additional steps are required. For 
more information, see Auditing Microsoft 
SQL Server (Using Windows 

Authentication) Against a Machine on a 

Different or Untrusted Domain.

To use the Net Use technique:

-Open a command prompt.

-Enter the net use command to 
log in to the target server with valid 
credentials.

-The command should adhere to the 
following format: net use 
\\computerIP /

user:[domainname\]username

-DbProtect Vulnerability Assessment 
prompts you for a valid password on 
the TARGET.

-Verify access by re-entering net 
use.

Note:Note:Note:Note:DbProtect Vulnerability Assessment 
does notnotnotnot support Pen Testing any 
Microsoft SQL Server instances which 
use named pipes for connection. 

Part If Then
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RUNNING THE MICROSOFT SQL SERVER 2005 AND 2008 

USER CREATION SCRIPT

Application Security Inc. has written a convenient Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005Microsoft SQL Server 2005 and 
Microsoft SQL Server 2008 user creation scriptMicrosoft SQL Server 2008 user creation scriptMicrosoft SQL Server 2008 user creation scriptMicrosoft SQL Server 2008 user creation script 
(CreateUserSQLServer2k52k8PublicRevoked.sql) which creates an account with the 
minimum privileges necessary to perform Audits on either a Microsoft SQL Server 
2005 or a Microsoft SQL Server 2008 instance.

Caution! If you want to run this script, make sure whatever account you 

use to conduct your Audit has at least the SELECT privileges listed 

in the script (see below).

The contents of the CreateUserSQLServer2k52k8PublicRevoked.sql script follow:

CREATE LOGIN [aduser] WITH PASSWORD=N'Admin123', 

DEFAULT_DATABASE=[master]

GO

EXEC sp_MSforeachdb '

USE [?]

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,"Updateability") FROM 

master.dbo.sysdatabases where 

databasePropertyEx(name,"Status")="ONLINE" and name = "?"

IF @isUpdateable = "READ_WRITE"

BEGIN

    CREATE USER [aduser] FOR LOGIN [aduser] WITH DEFAULT_SCHEMA=[dbo]

END'

GO

USE [master]

3 TARGET is in DOMAIN_A and 
HOST is either in an untrusted 
DOMAIN_B or in WORKGROUP_X

• You can use any of the methods listed in 
Part 2, above.

Or...

• You can add HOST to DOMAIN_A.

Part If Then
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GO

GRANT EXECUTE ON dbo.xp_loginconfig TO [aduser]

GRANT SELECT ON dbo.syslogins TO [aduser]

GRANT SELECT ON dbo.sysdatabases TO [aduser]

GRANT SELECT ON dbo.sysconfigures TO [aduser]

GRANT SELECT ON dbo.syscurconfigs TO [aduser]

GRANT SELECT ON dbo.syscharsets TO [aduser]

GRANT SELECT ON sys.configurations TO [aduser]

GRANT SELECT ON sys.server_principals TO [aduser]

GRANT SELECT ON sys.server_role_members TO [aduser]

GRANT ALTER TRACE TO [aduser]

GRANT SELECT ON sys.fn_trace_getinfo TO [aduser]

EXEC sp_MSforeachdb '

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,"Updateability") FROM 

master.dbo.sysdatabases where 

databasePropertyEx(name,"Status")="ONLINE" and name = "?"

IF @isUpdateable = "READ_WRITE"

BEGIN

    GRANT EXECUTE ON [?].dbo.sp_helprotect TO [aduser]

END'

GRANT SELECT ON sys.servers TO [aduser] 

GRANT EXECUTE ON dbo.sp_helpsrvrolemember TO [aduser] 

GRANT SELECT ON dbo.fn_trace_geteventinfo TO [aduser] 

GRANT SELECT ON dbo.fn_trace_getinfo TO [aduser] 

GRANT SELECT ON sys.databases TO [aduser] 

GRANT SELECT ON sys.master_key_passwords TO [aduser] 

GRANT SELECT ON sys.sql_logins TO [aduser] 

GRANT SELECT ON sys.master_files TO [aduser] 
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GRANT SELECT ON sys.procedures TO [aduser] 

GRANT SELECT ON sys.server_permissions TO [aduser] 

GRANT SELECT ON sys.all_objects TO [aduser] 

GRANT SELECT ON sys.certificates TO [aduser] 

GRANT SELECT ON sys.fulltext_catalogs TO [aduser] 

GRANT SELECT ON sys.routes TO [aduser] 

GRANT SELECT ON sys.remote_service_bindings TO [aduser] 

GRANT SELECT ON sys.services TO [aduser] 

GRANT SELECT ON sys.service_contracts TO [aduser] 

GRANT SELECT ON sys.service_message_types TO [aduser] 

GRANT SELECT ON sys.xml_schema_collections TO [aduser] 

GRANT SELECT ON sys.assemblies TO [aduser] 

GRANT SELECT ON sys.http_endpoints TO [aduser] 

GRANT SELECT ON dbo.sysservers TO [aduser] 

GRANT SELECT ON dbo.sysservers TO [aduser] 

GRANT SELECT ON sys.linked_logins  TO [aduser] 

GRANT SELECT ON sys.service_broker_endpoints TO [aduser] 

GRANT SELECT ON sys.credentials TO [aduser]

GRANT EXECUTE ON dbo.sp_helppublication TO [aduser]

GRANT EXECUTE ON dbo.sp_helpmergepublication TO [aduser]

GRANT EXECUTE ON dbo.sp_helpmergesubscription TO [aduser]

GRANT EXECUTE ON dbo.sp_helpsubscription TO [aduser] 

GRANT EXECUTE ON dbo.sp_help_publication_access TO [aduser]      

GRANT EXECUTE ON dbo.sp_helpuser TO [aduser]  

GRANT SELECT ON sys.dm_os_cluster_nodes TO [aduser]  

GRANT SELECT ON sys.database_files TO [aduser]  

GRANT EXECUTE ON dbo.sp_helpreplicationdboption TO [aduser]       

GRANT EXECUTE ON dbo.sp_helprolemember TO [aduser] 

GRANT SELECT ON dbo.sysprocesses TO [aduser]

grant view any definition to [aduser]

GRANT VIEW SERVER STATE TO [aduser]

GO
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USE [msdb]

GO

GRANT EXECUTE ON dbo.sp_get_sqlagent_properties TO [aduser]

GRANT SELECT ON dbo.sysproxysubsystem TO [aduser]

GRANT SELECT ON dbo.sysproxies TO [aduser]

GRANT EXECUTE ON dbo.sp_enum_login_for_proxy TO [aduser]

GRANT SELECT ON dbo.sysjobs ([name],[job_id]) TO [aduser]

GRANT SELECT ON dbo.sysjobhistory ([job_id]) TO [aduser] 

GRANT SELECT ON dbo.syssubsystems ([subsystem],[subsystem_id]) TO 

[aduser] 

GRANT SELECT ON [dbo].[sysjobsteps] ([proxy_id],[subsystem], [job_id]) 

TO [aduser] 

GRANT SELECT ON dbo.sysjobs TO [aduser] 

GO

EXEC sp_MSforeachdb '

USE [?]

DECLARE @isUpdateable sql_variant

SELECT @isUpdateable = databasePropertyEx(name,"Updateability") FROM 

master.dbo.sysdatabases where 

databasePropertyEx(name,"Status")="ONLINE" and name = "?"

IF @isUpdateable = "READ_WRITE"

BEGIN

GRANT SELECT ON dbo.sysusers TO [aduser]

GRANT SELECT ON dbo.sysobjects TO [aduser]

GRANT SELECT ON dbo.syscomments TO [aduser]

GRANT VIEW DEFINITION TO [aduser]

GRANT SELECT ON sys.database_permissions TO [aduser]

GRANT SELECT ON sys.objects TO [aduser]

GRANT SELECT ON sys.asymmetric_keys TO [aduser]

GRANT SELECT ON sys.database_principals TO [aduser]

GRANT SELECT ON sys.key_encryptions TO [aduser]

GRANT SELECT ON sys.symmetric_keys TO [aduser]

GRANT SELECT ON sys.types TO [aduser]
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GRANT SELECT ON sys.sysmembers TO [aduser]

GRANT SELECT ON sys.database_role_members TO [aduser]

GRANT SELECT ON sys.schemas TO [aduser]

GRANT SELECT ON sys.system_objects TO [aduser] 

END'

GO

REGISTRY ACCESS FOR MICROSOFT SQL SERVER 2000, 

2005, AND 2008

Some Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000, 2005 2005 2005 2005, and 2008 2008 2008 2008 Audit privileges require you to have 
remote registry accessremote registry accessremote registry accessremote registry access in order to perform Audits on Microsoft SQL Server instances. 
These required Audit privileges are listed in:

•  Microsoft SQL Server 2000 and MSDE Audit Privileges (for all applicable 
Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000Microsoft SQL Server 2000 Audit privileges)

•  Microsoft SQL Server 2005 and Microsoft SQL Server 2008 Audit Privileges (for 
all applicable Microsoft SQL Server 2005 and 2008Microsoft SQL Server 2005 and 2008Microsoft SQL Server 2005 and 2008Microsoft SQL Server 2005 and 2008 Audit privileges).

Depending on your version of Microsoft SQL Server 2000, 2005, and 2008 (and 
whether you are using Microsoft SQL Server Authentication or Windows 
Authentication), you can get the remote registry value in either of the following two 
ways:

4. Via the xp_regread extended stored procedure (explained in the following 
table). 

If your version of 
Microsoft SQL 

Server is:

And you are 
using:

Detail

Microsoft SQL 
Server 2000 (service 
pack priorpriorpriorprior to SP4)

Microsoft SQL 
Server 
Authentication

Grant execute on xp_regread to the 
DbProtect Vulnerability Assessment user or 
the Public role.

Windows 
Authentication

Grant execute on xp_regread to the 
Windows user or to the Public role, and 
permissions on the key being accessed.
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5. Get the remote registry value via the Windows Remote Registry API, and 
provide a valid Windows account with remote registry access.

Microsoft SQL 
Server 2000 SP4 and 
Microsoft SQL 
Server 2005 or 2008

Microsoft SQL 
Server 
Authentication

Grant execute on xp_regread to the 
DbProtect Vulnerability Assessment user or 
the Public role.

Windows 
Authentication

Grant execute on xp_regread to Windows 
user or the Public role, and permissions on 
the key being accessed.

Microsoft SQL 
Server 
Authentication or 
Windows 
Authentication

Although authentication mode (i.e., Microsoft 
SQL Server Authentication or Windows 
Authentication) is used, DbProtect 
Vulnerability Assessment requires an entry on 
the target 
(HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft
\Microsoft SQL 

Server\<INSTANCE>\MSSQLServer\

ExtendedProcedures\Xp_regread 

Allowed Paths) of the requested registry 
subkey. (Reference: http://
support.microsoft.com/kb/887165)

Since the Microsoft SQL Server installation 
program pre-populates the Xp_regread 
Allowed Paths registry entry with the 
extended stored procedures that Microsoft 
SQL Server can access, you only need to add 
the following registry entries: 

• HKEY_LOCAL_MACHINE\SOFTWARE\

Microsoft\Microsoft SQL 

Server\Instance Names\SQL

• HKEY_LOCAL_MACHINE\SYSTEM\Current

ControlSet\Services\MSSQLServerOLAP

Service

• HKEY_LOCAL_MACHINE\SYSTEM\Current

ControlSet\Services\ReportServer

If your version of 
Microsoft SQL 

Server is:

And you are 
using:

Detail

http://support.microsoft.com/kb/887165
http://support.microsoft.com/kb/887165
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MySQL Audit
Privileges

Note:Note:Note:Note: For more information on MySQL Server OS check requirements, see 
Operating System Considerations (for Audits).

To conduct a full MySQLMySQLMySQLMySQL Audit, you need the following privilegesprivilegesprivilegesprivileges. Make sure the 
account you are using has rights to use the following tables and views:

•  Anonymous user exists: SELECT on user table

•  Blank account passwords: SELECT on user table

•  Blank root password: SELECT on user table

•  Default passwords for test accounts: SELECT on user table

•  Easily-guessed account passwords: SELECT on user table

•  Easily-guessed root password: SELECT on user table

•  FILE privileges granted: SELECT on user table

•  General log file not enabled: execute SHOW VARIABLES

•  Password for user same as username: SELECT on user table

•  Permissions grantable: SELECT on the user table, SELECT on the db 
table, SELECT on the host table, SELECT on the tables_priv table, 

and SELECT on the procs_priv table

•  Permissions on GRANT tables: SELECT on the user table, SELECT on 
the db table, SELECT on the host table, SELECT on the tables_priv 

table, SELECT on the procs_priv table, and SELECT on the 

columns_priv' table

•  Permissions on user table: SELECT on the user table, SELECT on the 
db table, SELECT on the host table, SELECT on the tables_priv 

table, and SELECT on the columns_priv table.

•  PROCESS privileges granted: SELECT on user table

•  Sample database not removed: execute SHOW DATABASES

•  SSL encryption not enabled: execute SHOW VARIABLES

•  Grant SELECT on procs_priv

Note:Note:Note:Note: The Grant SELECT on procs_priv privilege is only required on the 
Permissions on GRANT tables and Permissions grantable MySQL 
Audit checks on MySQL 5.0 and greater.

MYSQL CHECKS

MySQL AuditMySQL AuditMySQL AuditMySQL Audit

•  Easily-guessed root password

•  Easily-guessed passwords

•  Blank password

•  Blank root password

•  Universal access

•  SSL is enabled

•  Grant tables privileges
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•  Ensure sample databases have been removed

•  Permissions on [User] table

•  Permissions granted directly to user

•  Logging not enabled

•  MySQL mysqld Privilege Escalation Vulnerability

•  MySQL libmysqlclient Library Read_One_Row Buffer Overflow 
Vulnerability

•  MySQL COM_CHANGE_USER Password Memory Corruption Vulnerability

•  MySQL Double Free Heap Corruption Vulnerability

•  MySQL COM_CHANGE_USER Password Length Account Compromise 
Vulnerability

•  MySQL libmysqlclient Library Read_Rows Buffer Overflow 
Vulnerability

•  MySQL COM_TABLE_DUMP Memory Corruption Vulnerability

•  MySQL COM_TABLE_DUMP Memory Corruption Vulnerability

•  MySQL Bind Address Not Enabled Weak Default Configuration 
Vulnerability

•  MySQL Null Root Password Weak Default Configuration Vulnerability

•  WinMySQLadmin Plain Text Password Storage Vulnerability

•  MySQL Root Operation Symbolic Link File Overwriting Vulnerability

•  MySQL SHOW GRANTS Password Hash Disclosure Vulnerability

•  MySQL Local Buffer Overflow Vulnerability

•  MySQL Authentication Algorithm Vulnerability

•  MySQL GRANT Global Password Changing Vulnerability

•  MySQL Unauthenticated Remote Access Vulnerability

•  Permissions on GRANT tables

•  Permissions grantable

Note:Note:Note:Note: The Grant SELECT on procs_priv privilege is only required on the 
Permissions on GRANT tables and Permissions grantable MySQL 
Audit checks on MySQL 5.0 and greater.

MySQL Pen TestMySQL Pen TestMySQL Pen TestMySQL Pen Test

•  Easily-guessed root password

•  Easily-guessed password

•  Blank password

•  Blank root password

•  MySQL mysqld Privilege Escalation Vulnerability

•  MySQL libmysqlclient Library Read_One_Row Buffer Overflow 
Vulnerability

•  MySQL COM_CHANGE_USER Password Memory Corruption Vulnerability
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•  MySQL Double Free Heap Corruption Vulnerability

•  MySQL COM_CHANGE_USER Password Length Account Compromise 
Vulnerability

•  MySQL libmysqlclient Library Read_Rows Buffer Overflow 
Vulnerability

•  MySQL COM_TABLE_DUMP Memory Corruption Vulnerability

•  MySQL COM_TABLE_DUMP Memory Corruption Vulnerability

•  MySQL Bind Address Not Enabled Weak Default Configuration 
Vulnerability

•  MySQL Null Root Password Weak Default Configuration Vulnerability

•  WinMySQLadmin Plain Text Password Storage Vulnerability

•  MySQL Root Operation Symbolic Link File Overwriting Vulnerability

•  MySQL SHOW GRANTS Password Hash Disclosure Vulnerability

•  MySQL Local Buffer Overflow Vulnerability

•  MySQL Authentication Algorithm Vulnerability

•  MySQL GRANT Global Password Changing VulnerabilityMySQL

•  MySQL Unauthenticated Remote Access Vulnerability

Oracle Audit
Privileges and User

Creation Script

Note:Note:Note:Note: For more information on Oracle OS check requirements, see Operating 
System Considerations (for Audits) and Appendix O: Oracle Critical Patch 
Update Detection in the AppDetectivePro User’s Guide.

This topic consists of the following sub-topics:

•  Oracle Audit Privileges

•  Running the Oracle User Creation Script.

ORACLE AUDIT PRIVILEGES

To conduct a full OracleOracleOracleOracle Audit, you need the following privilegesprivilegesprivilegesprivileges. Make sure the 
account you are using has rights to use the following tables, views, and functions:

•  $PWFILE_USERS

•  ALTER USER username TEMPORARY TABLESPACE TEMP

•  DBA_OBJ_AUDIT_OPTS

•  DBA_OBJECTS

•  DBA_PROFILES

•  DBA_ROLES

•  DBA_ROLE_PRIVS

•  DBA_STMT_AUDIT_OPTS

•  DBA_SYS_PRIVS

•  DBA_TABLES
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•  DBA_TAB_PRIVS

•  DBA_USERS

•  DBA_VIEWS

•  DBMS_UTILITY.PORT_STRING

•  PRODUCT_COMPONENT_VERSION

•  SYS.LINK$

•  SYS.USER$

•  SYS.REGISTRY$HISTORY

•  SYS.DBA_DB_LINKS

•  SYS.DBA_LIBRARIES

•  SYS.DBA_OBJECTS

•  SYS.DBA_ROLE_PRIVS

•  SYS.DBA_SOURCE

•  SYS.DBA_USERS

•  SYS.DBA_DB_LINKS

•  SYS.V_$INSTANCE

•  SYS.DBA_TS_QUOTAS

•  V$LOG

•  V$PWFILE_USERS

•  V$VERSION

•  V_$DATABASE

•  V_$DATAFILE

•  V_$LOGFILE

•  V_$SESSION

•  V_$PARAMETER (DbProtect Vulnerability Assessment selects from V$PARAMETER 
but you must grant SELECT on V_$PARAMETER)

Note:Note:Note:Note: The user account must have the CREATE SESSION privilege. In addition, 
the user account used for Audits needs a temporary table space assigned, 
which you can create with the following command: ALTER USER username 
TEMPORARY TABLESPACE TEMP

The following scriptscriptscriptscript creates an accountaccountaccountaccount with the minimum privilegesminimum privilegesminimum privilegesminimum privileges necessary to 
perform a Security Audit on an Oracle SID. Be sure that whatever account is used to 
conduct your Audit has at least the SELECT privileges listed below:

DROP USER aduser cascade;

CREATE USER aduser IDENTIFIED BY AD123; 

GRANT SELECT ON SYS.DBA_DB_LINKS TO aduser;

GRANT SELECT ON SYS.DBA_DATA_FILES TO aduser;

GRANT SELECT ON SYS.DBA_OBJECTS TO aduser;

GRANT SELECT ON SYS.DBA_OBJ_AUDIT_OPTS TO aduser;
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GRANT SELECT ON SYS.DBA_PROCEDURES TO aduser;

GRANT SELECT ON SYS.DBA_PROFILES TO aduser;

GRANT SELECT ON SYS.DBA_ROLES TO aduser;

GRANT SELECT ON SYS.DBA_ROLE_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_STMT_AUDIT_OPTS TO aduser;

GRANT SELECT ON SYS.DBA_SYS_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_TABLES TO aduser; 

GRANT SELECT ON SYS.DBA_INDEXES TO aduser;

GRANT SELECT ON SYS.DBA_TAB_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_TS_QUOTAS TO aduser;

GRANT SELECT ON SYS.DBA_USERS TO aduser;

GRANT SELECT ON SYS.DBA_SOURCE TO aduser;

GRANT SELECT ON SYS.DBA_VIEWS TO aduser;

GRANT SELECT ON SYS.PRODUCT_COMPONENT_VERSION TO aduser;

GRANT SELECT ON SYS.LINK$ TO aduser;

GRANT SELECT ON SYS.USER$ TO aduser;

GRANT SELECT ON SYS.V_$PARAMETER TO aduser;

GRANT SELECT ON SYS.V_$LOG TO aduser;

GRANT SELECT ON SYS.V_$PWFILE_USERS TO aduser;

GRANT SELECT ON SYS.V_$INSTANCE TO aduser;

GRANT SELECT ON SYS.V_$DATABASE TO aduser;

GRANT SELECT ON SYS.DBA_PRIV_AUDIT_OPTS TO aduser;

GRANT SELECT ON SYS.DBA_REPCATLOG TO aduser;

GRANT SELECT ON SYS.DEFPROPAGATOR TO aduser;

GRANT SELECT ON SYS.V_$DATAFILE TO aduser;

GRANT SELECT ON SYS.V_$LOGFILE TO aduser;

GRANT SELECT ON SYS.V_$SESSION TO aduser;

GRANT SELECT ON SYS.REGISTRY$HISTORY TO aduser;

GRANT CREATE SESSION TO aduser;

grant javasyspriv to aduser;

grant create procedure to aduser;
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The following is a list of checkscheckscheckschecks within the DbProtect Vulnerability Assessment for 
Oracle Security Audit, and the tables and views which they need permission to in order 
to function properly:

•  _TRACE_FILES_PUBLIC undocumented configuration parameter is NOT 
set to FALSE

Note:Note:Note:Note: This check requires SYSDBA privileges, and, because of this, it is not part 
of any built-in Policies.

•  Account associated with DEFAULT profile: DBA_USERS 

•  Account granted the predefined role CONNECT: DBA_ROLE_PRIVS

•  Account granted the predefined role DBA:  DBA_ROLE_PRIVS

•  Account granted the predefined role RESOURCE:  DBA_ROLE_PRIVS

•  Accounts with SYSTEM as default tablespace:  DBA_USERS

•  ANSI join syntax bypasses object privileges: 
PRODUCT_COMPONENT_VERSION

•  ANY system privilege applies to data dictionary:  V$PARAMETER

•  Auditing Not Enabled:  V$PARAMETER

•  Auditing of CREATE SESSION not enabled:  DBA_STMT_AUDIT_OPTS

•  BFILENAME buffer overflow (Verify 
version):PRODUCT_COMPONENT_VERSION

•  Brute-force database password:  DBA_USERS

•  Brute-force role password:  SYS.USER$

•  Cleartext password stored with database link:  SYS.LINK$

•  Create library privilege:  DBA_SYS_PRIVS, 
PRODUCT_COMPONENT_VERSION

•  Database link buffer overflow (Verify 
version):PRODUCT_COMPONENT_VERSION

•  Database user allows remote authentication:  DBA_USERS, 
V$PARAMETER

•  DBLINK_ENCRYPT_LOGIN not enabled:  SYS.LINK$, V$PARAMETER

•  DBMS dedicated software directory and partition: V$DATAFILE, 
V$LOGFILE, V$PARAMETER

•  Default database password: DBA_USERS

•  Easily-guessed database password:  DBA_USERS

•  Easily-guessed role password:  SYS.USER$

•  Expired password:  DBA_USERS, PRODUCT_COMPONENT_VERSION

•  Kick Listener DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  Label Security row label improperly assigned:  
PRODUCT_COMPONENT_VERSION

•  Label Security SQL predicates bypassed:  PRODUCT_COMPONENT_VERSION
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•  Label Security unauthorized higher level read:  
PRODUCT_COMPONENT_VERSION

•  Listener debug DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  Listener format string buffer overflow (Verify version):  
PRODUCT_COMPONENT_VERSION

•  Locked account:  DBA_USERS, PRODUCT_COMPONENT_VERSION

•  MTDS DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  NERP DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  Non-standard account with DBA role:  DBA_ROLE_PRIVS

•  NSPTCN buffer overflow (Verify version):  
PRODUCT_COMPONENT_VERSION

•  NSPTCN data offset DoS (Verify version):  
PRODUCT_COMPONENT_VERSION

•  Object privilege grantable: DBA_TAB_PRIVS

•  Object privilege granted to account:  DBA_TAB_PRIVS, DBA_USERS

•  Object privilege granted to PUBLIC:  DBA_TAB_PRIVS

•  Oracle Configuration Manager: DBA_USERS

•  Oracle DIAGNOSTIC_DEST parameter: V$PARAMETER 

•  Oracle file overwrite:  PRODUCT_COMPONENT_VERSION

•  Oracle LOG_ARCHIVE_DEST parameter: V$DATABASE, V$PARAMETER

•  OS authentication prefix:  V$PARAMETER

•  Overdue password change:  sys.user$

•  Password for database user same as username:  DBA_USERS

•  Privilege granted to SELECT from data dictionary:  DBA_TABLES, 
DBA_TAB_PRIVS

•  Privilege on audit trail table:  DBA_TAB_PRIVS

•  Privilege on database link table:  DBA_TAB_PRIVS, DBA_USERS

•  Privilege to execute UTL_FILE granted to PUBLIC:  DBA_TAB_PRIVS

•  Privilege to execute UTL_HTTP granted to PUBLIC:  DBA_TAB_PRIVS

•  Privilege to execute UTL_SMTP granted to PUBLIC:  DBA_TAB_PRIVS

•  Privilege to execute UTL_TCP granted to PUBLIC:  DBA_TAB_PRIVS

•  Profile settings - Failed Login Attempts:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Profile settings - Password Grace Time:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Profile settings - Password Life Time:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Profile settings - Password Lock Time:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION
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•  Profile settings - Password Reuse Maximum:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Profile settings - Password Reuse Time: DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Profile settings - Password Verify Function:  DBA_PROFILES, 
PRODUCT_COMPONENT_VERSION

•  Remote login password file not disabled:  V$PARAMETER

•  Remote OS Authentication enabled:  V$PARAMETER

•  Remote OS Roles enabled:  V$PARAMETER

•  Requestor version DoS (Verify version):  PRODUCT_COMPONENT_VERSION 

•  Role without password:  DBA_ROLES

•  Roles granted WITH ADMIN OPTION:  DBA_ROLE_PRIVS

•  SERVICE_CURLOAD DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  SERVICE_NAME buffer overflow (Verify version):  
PRODUCT_COMPONENT_VERSION

•  SNMP DoS (Verify version):  PRODUCT_COMPONENT_VERSION

•  SQL92_SECURITY parameter not enabled:  V$PARAMETER

•  SYSDBA auditing bug:  PRODUCT_COMPONENT_VERSION

•  SYSDBA privilege assignments

•  System privilege granted to account:  DBA_SYS_PRIVS, DBA_USERS

•  System privilege granted to PUBLIC:  DBA_SYS_PRIVS

•  System privilege granted WITH ADMIN OPTION:  DBA_SYS_PRIVS

•  System privilege with ANY clause:  DBA_SYS_PRIVS

•  TCL debugger installs with setUID root:  DBA_SYS_PRIVS

•  TCL debugger installs with setUID root:  PRODUCT_COMPONENT_VERSION

•  TO_TIMESTAMP_TZ buffer overflow (Verify 
version):PRODUCT_COMPONENT_VERSION

•  TZ_OFFSET buffer overflow (Verify 
version):PRODUCT_COMPONENT_VERSION

•  Trace reporting buffer overflow:  PRODUCT_COMPONENT_VERSION

•  UTL_FILE_DIR unrestricted:  V$PARAMETER

•  XSQL Servlet stylesheet as URL parameter:  
PRODUCT_COMPONENT_VERSION

•  Auditing of Schema Objects: DBA_OBJ_AUDIT_OPTS, DBA_VIEWS
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RUNNING THE ORACLE USER CREATION SCRIPT

Application Security Inc. has written a convenient Oracle user creation script 
(CreateUserSQLServer2k.sql) which creates an account with the minimum privileges 
necessary to perform Audits on a Microsoft SQL 2000 instance.

The contents of the CreateUserSQLServer2k.sql script follow:

DROP USER aduser cascade;

CREATE USER aduser IDENTIFIED BY AD123; 

GRANT SELECT ON SYS.DBA_DB_LINKS TO aduser;

GRANT SELECT ON SYS.DBA_DATA_FILES TO aduser;

GRANT SELECT ON SYS.DBA_OBJECTS TO aduser;

GRANT SELECT ON SYS.DBA_OBJ_AUDIT_OPTS TO aduser;

GRANT SELECT ON SYS.DBA_PROCEDURES TO aduser;

GRANT SELECT ON SYS.DBA_PROFILES TO aduser;

GRANT SELECT ON SYS.DBA_ROLES TO aduser;

GRANT SELECT ON SYS.DBA_ROLE_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_STMT_AUDIT_OPTS TO aduser;

GRANT SELECT ON SYS.DBA_SYS_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_TABLES TO aduser; 

GRANT SELECT ON SYS.DBA_INDEXES TO aduser;

GRANT SELECT ON SYS.DBA_TAB_PRIVS TO aduser;

GRANT SELECT ON SYS.DBA_TS_QUOTAS TO aduser;

GRANT SELECT ON SYS.DBA_USERS TO aduser;

GRANT SELECT ON SYS.DBA_SOURCE TO aduser;

GRANT SELECT ON SYS.DBA_VIEWS TO aduser;

GRANT SELECT ON SYS.PRODUCT_COMPONENT_VERSION TO aduser;

GRANT SELECT ON SYS.LINK$ TO aduser;

GRANT SELECT ON SYS.USER$ TO aduser;

GRANT SELECT ON SYS.V_$PARAMETER TO aduser;

GRANT SELECT ON SYS.V_$LOG TO aduser;

GRANT SELECT ON SYS.V_$PWFILE_USERS TO aduser;

GRANT SELECT ON SYS.V_$INSTANCE TO aduser;

GRANT SELECT ON SYS.V_$DATABASE TO aduser;

GRANT SELECT ON SYS.DBA_PRIV_AUDIT_OPTS TO aduser;

GRANT SELECT ON SYS.DBA_REPCATLOG TO aduser;

GRANT SELECT ON SYS.DEFPROPAGATOR TO aduser;
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GRANT SELECT ON SYS.V_$DATAFILE TO aduser;

GRANT SELECT ON SYS.V_$LOGFILE TO aduser;

GRANT SELECT ON SYS.V_$SESSION TO aduser;

GRANT SELECT ON SYS.REGISTRY$HISTORY TO aduser;

GRANT CREATE SESSION TO aduser;

grant javasyspriv to aduser;

grant create procedure to aduser;

Sybase Audit
Privileges

To conduct a full SybaseSybaseSybaseSybase Audit, you need the following privilegesprivilegesprivilegesprivileges. Make sure the 
account you are using has rights to use the following tables and views:

•  SELECT @@VERSION

•  master.dbo.syslogins

•  master.dbo.syssrvroles

•  master.dbo.sysdatabases

•  master.dbo.sysconfigures

•  master.dbo.syscurconfigs

•  master.dbo.sysroles

•  master.dbo.sysloginroles

•  master.dbo.sysattributes

•  master.dbo.sysservers

•  exec sp_loginconfig

•  exec sp_displayaudit (if it's >= 11.5)

•  sp_auditoption (if it's < 11.5 and >= 11.0)

•  master.dbo.syblicenseslog

•  master.dbo.syscharsets

•  <db name>.dbo.sysusers

•  <db name>.dbo.sysobjects

•  <db name>.dbo.syscomments

•  exec <db name>.dbo.sp_help_resource_limit (if it's >= 11.5)

The following is a list of checkscheckscheckschecks within the DbProtect Vulnerability Assessment for 
Sybase Security Audit, and the tables and views which they need permission to in 
order to function properly:

•  Audit database owned by sa_role member: master.dbo.syslogins, 
master.dbo.sysloginroles, master.dbo.syssrvroles, 

<dbname>.dbo.sysusers 



DbProtect 6.1 User’s Guide

Application Security, Inc. 641

•  Guest user exists in sybsecurity: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers 

•  Login granted sa_role: master.dbo.syslogins, 
master.dbo.sysloginroles, master.dbo.syssrvroles, 

<dbname>.dbo.sysusers 

•  Login granted sso_role: master.dbo.syslogins, 
master.dbo.sysloginroles, master.dbo.syssrvroles, 

<dbname>.dbo.sysusers 

•  Objects not owned by dbo: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers, 

<dbname>.dbo.sysobjects 

•  Permission granted in sybsecurity: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  Permission granted on system table: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  Permission granted on xp_cmdshell: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  Permission to select from syslogins: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Permissions granted to public: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers 

•  Permissions granted to user: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers 

•  Remote access allowed: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Roles revoked from the sa login: master.dbo.syslogins, 
master.dbo.sysloginroles, master.dbo.syssrvroles 

•  Server configured with remote server: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Statement permission granted: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers 

•  Unrestricted access to syscomments: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Updates allowed to system tables: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  With grant option: master.dbo.syslogins, master.dbo.syssrvroles, 
<dbname>.dbo.sysusers 

•  xp_cmdshell context: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  Absolute value of numeric DoS (Verify version): 
master.dbo.syslogins, master.dbo.syssrvroles 

•  Allow resource limit: master.dbo.syslogins, master.dbo.syssrvroles 

•  Audit logout not set: sybsystemprocs.dbo.sp_loginconfig, sso_role 

•  Audit queue size: master.dbo.syslogins, master.dbo.syssrvroles 

•  Audit subsystem not installed: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Auditing disabled: sybsystemprocs.dbo.sp_loginconfig, sso_role 
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•  Auditing of failed logins not enabled: 
sybsystemprocs.dbo.sp_loginconfig, sso_role 

•  Auditing of successful logins not enabled: 
sybsystemprocs.dbo.sp_loginconfig, sso_role 

•  Current audit table: master.dbo.syslogins, master.dbo.syssrvroles 

•  DBCC CHECKVERIFY buffer overflow: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  DROP DATABASE buffer overflow: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Event log computer name: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Event logging: master.dbo.syslogins, master.dbo.syssrvroles 

•  Exceeded licensing limitations: master.dbo.syblicenseslog 

•  Latest patch not applied: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  List resource limits: master.dbo.syslogins, master.dbo.syssrvroles 

•  Log audit logon failure: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Log audit logon success: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  No patches available for version: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Password array buffer overflow: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Require message confidentiality with encryption: 
master.dbo.syslogins, master.dbo.syssrvroles 

•  Require message integrity: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Select all DoS (Verify version): master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Select/Into DoS (Verify version): master.dbo.syslogins, 
master.dbo.syssrvroles 

•  SSL enabled: master.dbo.syslogins, master.dbo.syssrvroles 

•  Start mail session: master.dbo.syslogins, master.dbo.syssrvroles 

•  Suspend audit when full disabled: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Vulns for v12.5.3 ESD#1 (Verify version): master.dbo.syslogins, 
master.dbo.syssrvroles 

•  xp_cmdshell not removed: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  xp_freedll buffer overflow: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysobjects 

•  Blank password for sa: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Check password for digit: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default login exists: sybsystemprocs.dbo.sp_loginconfig, sso_role 
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•  Default login granted role: sybsystemprocs.dbo.sp_loginconfig, 
sso_role 

•  Default password for dba repository user: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for entldbdbo: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for entldbreader: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for jagadmin: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for PIAdmin: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for pkiuser: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for PortalAdmin: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default password for pso: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Default SAP password: master.dbo.syslogins, master.dbo.syssrvroles 

•  Easily-guessed password: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Easily-guessed sa password: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Expired logins: master.dbo.syslogins, master.dbo.syssrvroles 

•  Guest user exists in database: master.dbo.syslogins, 
master.dbo.syssrvroles, <dbname>.dbo.sysusers 

•  Locked logins: master.dbo.syslogins, master.dbo.syssrvroles 

•  Login attributes less restrictive: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Login mode: sybsystemprocs.dbo.sp_loginconfig, sso_role 

•  Maximum failed logins: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Minimum password length: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Orphaned user: master.dbo.syslogins, master.dbo.syssrvroles, 
<dbname>.dbo.sysusers 

•  Password same as login name: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Per login password expiration: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Roles without passwords: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Secure default login exists: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  System-wide password expiration: master.dbo.syslogins, 
master.dbo.syssrvroles 
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•  Unified login required: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Unlocked sa login: master.dbo.syslogins, master.dbo.syssrvroles 

•  Use security services: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Not using NTFS partition: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Permissions on files: master.dbo.syslogins, master.dbo.syssrvroles 

•  Registry permissions: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Service runs as LocalSystem: master.dbo.syslogins, 
master.dbo.syssrvroles 

•  Setgid bit enabled: master.dbo.syslogins, master.dbo.syssrvroles 

•  Setuid bit enabled: master.dbo.syslogins, master.dbo.syssrvroles

Operating System
Considerations (for

Audits)

Some DbProtect Vulnerability Assessment Audit checks require more than just a valid 
database account to perform correctly. They have different requirements depending 
upon whether the operating systemoperating systemoperating systemoperating system (OS) is Windows or UNIX. (The checks are listed in 
the Audit category OS IntegrityOS IntegrityOS IntegrityOS Integrity.) They only run if the target database has the 
appropriate OS.

This topic consists of the following sub-topics:

•  Windows OS Audit Check Requirements

•  UNIX OS Audit Check Requirements.
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WINDOWS OS AUDIT CHECK REQUIREMENTS

DbProtect Vulnerability Assessment performs Windows OS checks via Windows 
authentication. Make sure the account and computer you are running DbProtect 
Vulnerability Assessment from has the appropriate permissions for the corresponding 
checks:

•  Not Using NTFS Partition. Not Using NTFS Partition. Not Using NTFS Partition. Not Using NTFS Partition. Permission to read the installation disk type.

•  Registry Permissions.Registry Permissions.Registry Permissions.Registry Permissions.    Remote registry access.

•  Service Runs as Local SystemService Runs as Local SystemService Runs as Local SystemService Runs as Local System. . . . Permission to list the system services.

•  Permissions on Files.Permissions on Files.Permissions on Files.Permissions on Files. Permission to read files in the installation directory of the 
database.

UNIX OS AUDIT CHECK REQUIREMENTS

DbProtect Vulnerability Assessment performs Unix OS checks via a Telnet or SSH 
account. Your account must have the appropriate read and directory listing 
permissions activated on the database installation and running directories.

Properly-Configured Environment VariablesProperly-Configured Environment VariablesProperly-Configured Environment VariablesProperly-Configured Environment Variables

DbProtect Vulnerability Assessment can Audit platforms that use system variables to 
specify the location of the database instances. In UNIX, you must set the environment 
variables correctly in order to use SSH or Telnet to access the accounts. Specific 
requirements follow.  

If you run the following 
checks:

Then you must have permission to:

Permissions on FilesPermissions on FilesPermissions on FilesPermissions on Files List files in the installation directories of the database.

Setgid Bit EnabledSetgid Bit EnabledSetgid Bit EnabledSetgid Bit Enabled

Setuid Bit EnabledSetuid Bit EnabledSetuid Bit EnabledSetuid Bit Enabled

If you want to Audit the 
following platform:

Then you must have permission to:

Oracle Make sure the $ORACLE_HOME variable is correct.

Sybase Make sure the $SYBASE variable is correct.

MySQL Define a datadir or basedir variable to point to the 
database root.
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Appendix J: Fix Scripts 
(Detail)
The following tables list each AppDetectivePro fix script (for Oracle and SQL Server); 
for more information on fix scripts, see Working with Fix Scripts.

This appendix consists of the following topics:

•  Microsoft SQL Server Fix Scripts

•  Oracle Fix Scripts

•  Sybase Fix Scripts

•  IBM DB2 Fix Scripts

•  MySQL Fix Scripts.
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MICROSOFT SQL SERVER FIX SCRIPTS 

Check Script

xp_controlqueueservice buffer 
overflow

USE master

GO

DROP PROCEDURE xp_controlqueueservice

GO

Password same as login name USE master

GO

sp_password '<!!--LOGIN--!!>', '<NEW PASSWORD>', 
'<!!--LOGIN--!!>'

GO

Blank password Note: The following SQL statements require sysadmin 
privileges in order to be performed

USE master

GO

sp_password NULL, '<NEW PASSWORD>', '<!!--
LOGIN--!!>'

GO

Easily-guessed password for well-
known login

USE master

GO

sp_password '<!!--PASSWORD--!!>', '<NEW 
PASSWORD>', '<!!--LOGIN--!!>'

GO

Easily-guessed password for sa USE master

GO

sp_password '<!!--PASSWORD--!!>', '<NEW 
PASSWORD>', 'sa'

GO

Blank password for well-known 
login

Note: The following SQL statements require sysadmin 
privileges in order to be performed.

USE master

GO

sp_password NULL, '<NEW PASSWORD>', '<!!--
LOGIN--!!>'

GO
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Blank password for sa Note: The following SQL statements require sysadmin 
privileges in order to be performed

USE master

GO

sp_password NULL, '<NEW PASSWORD>', 'sa'

GO

srv_paraminfo buffer overflow in 
xp_showcolv

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_showcolv FROM 
public

GO

Extended stored proc privilege 
upgrade

USE master

GO

REVOKE ALL ON [<!!--EXTENDED STORED 
PROCEDURE--!!>] FROM public

GO

srv_paraminfo buffer overflow in 
xp_proxiedmetadata

USE master

GO

REVOKE EXECUTE ON 
master.dbo.xp_proxiedmetadata FROM public

GO

xp_dsninfo buffer overflow USE master

GO

DROP PROCEDURE xp_dsninfo

GO

xp_oledbinfo buffer overflow Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

xp_repl_encrypt buffer overflow Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

xp_dirtree buffer overflow Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Check Script
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Enterprise Manager improperly 
revokes proxy account

DECLARE @regread_dropped int

DECLARE @regwrite_dropped int

SELECT @regread_dropped=0, @regwrite_dropped=0

IF not exists (select * from master.dbo.sysobjects where 
name = 'xp_instance_regread')

BEGIN

EXECUTE master.dbo.sp_addextendedproc 
'xp_instance_reg

Permission on registry extended 
proc

USE <!!--DATABASE--!!>

GO

REVOKE EXECUTE ON [<!!--EXTENDED STORED 
PROCEDURE--!!>] FROM <!!--GRANTED TO--!!>

GO

srv_paraminfo buffer overflow in 
sp_OAGetProperty

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Remote access allowed USE master

GO

sp_configure 'remote access', 0

GO

RECONFIGURE

GO

srv_paraminfo buffer overflow in 
xp_updatecolvbm

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_updatecolvbm 
FROM public

GO

Format string vuln in xp_sprintf USE master

GO

REVOKE EXECUTE ON master.dbo.xp_sprintf FROM 
public

GO

Check Script
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Changing mode may leave sa 
password blank

Note: The following SQL statements require sysadmin 
privileges in order to be performed

USE master

GO

sp_password NULL, '<NEW PASSWORD>','sa'

GO

srv_paraminfo buffer overflow in 
xp_sqlagent_monitor

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

srv_paraminfo buffer overflow in 
sp_OACreate

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

srv_paraminfo buffer overflow in 
xp_peekqueue

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_peekqueue 
FROM public

GO

Permissions granted to user USE [<!!--DATABASE--!!>]

GO

REVOKE <!!--PRIVILEGE--!!> ON <!!--OBJECT NAME--
!!> FROM [<!!--GRANTED TO--!!>]

GO

Easily-guessed password USE master

GO

sp_password '<!!--PASSWORD--!!>', '<NEW 
PASSWORD>', '<!!--LOGIN--!!>'

GO

Permission on OLE automation 
procs

USE master 

GO

REVOKE EXECUTE ON [<!!--OBJECT NAME--!!>] 
FROM [<!!--USER NAME--!!>] 

GO

srv_paraminfo buffer overflow in 
sp_OASetProperty

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Check Script
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srv_paraminfo buffer overflow in 
xp_execresultset

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_execresultset 
FROM public

GO

Direct updates on data dictionary USE master

GO

sp_configure 'allow updates', 0

GO

RECONFIGURE WITH OVERRIDE

GO

srv_paraminfo buffer overflow in 
xp_SetSQLSecurity

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_SetSQLSecurity 
FROM public

GO

srv_paraminfo buffer overflow in 
xp_printstatements

USE master

GO

REVOKE EXECUTE ON master.dbo.xp_printstatements 
FROM public

GO

srv_paraminfo buffer overflow in 
sp_OAMethod

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Unauthorized object permission 
grants

IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--OWNER--!!>].[<!!--
OBJECT NAME--!!>] FROM [<!!--GRANTEE--!!>]')

Default trace disabled USE master

exec sp_configure 'show advanced options', 1 
reconfigure

exec sp_configure 'default trace enabled', 1

reconfigure

Check Script
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Agent jobs privilege escalation USE <!!--DATABASE--!!>

GO

REVOKE ALL ON [<!!--STORED PROCEDURE--!!>] 
FROM public

GO

Remote admin connections 
allowed

exec sp_configure 'remote admin connections', 0

go

reconfigure

go

Agent XPs enabled USE master

EXEC sp_configure 'show advanced options', 1

RECONFIGURE

EXEC sp_configure 'Agent XPs', '0'

RECONFIGURE

sp_replwritetovarbin limited 
memory overwrite vulnerability

USE master

GO

REVOKE ALL ON master.dbo.sp_replwritetovarbin 
FROM [<!!--GRANTED TO--!!>]

GO

xp_cmdshell not removed/not 
disabled

USE master

GO

sp_dropextendedproc @functname='xp_cmdshell'

GO

Unauthorized object permission 
grants

IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--COLUMN--!!>] FROM [<!!--
GRANTEE--!!>]')

C2 Audit Mode USE master

EXEC sp_configure 'show advanced option', '1'

RECONFIGURE WITH OVERRIDE

EXEC sp_configure 'c2 audit mode', 1

RECONFIGURE WITH OVERRIDE

Check Script
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Unauthorized object permission 
grants

DECLARE @oldValue int

SELECT @oldValue = value FROM master..syscurconfigs 
where config=102

We have to run SP_CONFIGURE to allow updates to the 
system catalogs

EXEC SP_CONFIGURE 'ALLOW UPDATES', 1

RECONFIGURE WITH OVERRIDE

Unauthorized object permission 
grants

EXEC SP_CONFIGURE 'ALLOW UPDATES', @oldValue

RECONFIGURE WITH OVERRIDE

GO

Permissions granted to GUEST IF DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> FROM GUEST')"

Permissions granted to GUEST

IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--OWNER--!!>].[<!!--
OBJECT NAME--!!>] FROM GUEST')

Unauthorized object permission 
grants

IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--SCHEMA NAME--!!>].[<!!--
OBJECT NAME--!!>] FROM [<!!--GRANTEE--!!>]')

Permissions granted to GUEST IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--SCHEMA NAME--!!>].[<!!--
OBJECT NAME--!!>] FROM GUEST'

Unauthorized object permission 
grants

IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> FROM [<!!--GRANTEE--!!>]')

Permission on sp_runwebtask USE master

GO

REVOKE ALL ON master.dbo.sp_runwebtask FROM 
public

GO

Check Script



DbProtect 6.1 User’s Guide

Application Security, Inc. 654

Statement permission granted USE <!!--DATABASE--!!>

GO

REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>

GO

Permission grantable USE [<!!--DATABASE--!!>]

GO

REVOKE <!!--PRIVILEGE--!!> ON [<!!--DATABASE--
!!>].[<!!--SCHEMA NAME--!!>].[<!!--OBJECT NAME--
!!>] FROM <!!--GRANTED TO--!!> CASCADE

GO

Guest user exists in database USE <!!--DATABASE--!!>

GO

sp_dropuser guest

GO

Registry extended proc not 
removed

USE master

GO

sp_dropextendedproc @functname='<!!--EXTENDED 
STORED PROCEDURE--!!>'

GO

xp_createqueue buffer overflow USE master

GO

DROP PROCEDURE xp_createqueue

GO

Permissions granted on 
xp_cmdshell

USE master

GO

IF exists (select * from master.dbo.sysobjects where 
name = 'xp_cmdshell')

REVOKE EXECUTE ON [xp_cmdshell] FROM [<!!--USER 
NAME--!!>]

GO

Permission grantable USE [<!!--DATABASE--!!>]

GO

REVOKE <!!--PRIVILEGE--!!> ON [<!!--DATABASE--
!!>].[<!!--OWNER--!!>].[<!!--OBJECT NAME--!!>] 
FROM <!!--GRANTED TO--!!> CASCADE

GO

Check Script
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Permissions granted to user USE [<!!--DATABASE--!!>]

GO

REVOKE <!!--PRIVILEGE--!!> FROM [<!!--GRANTED 
TO--!!>]

GO

C2 Audit Mode DECLARE @oldValue int 

SELECT @oldValue = value FROM master..syscurconfigs 
where config=518

--We have to run SP_CONFIGURE 'show advanced 
option', '1' to be able to change advanced options

Permissions granted to user USE [<!!--DATABASE--!!>]

GO

REVOKE <!!--PRIVILEGE--!!> ON [<!!--SCHEMA 
NAME--!!>].[<!!--OBJECT NAME--!!>] FROM [<!!--
GRANTED TO--!!>] CASCADE

GO

Permission to select from system 
table

USE [<!!--DATABASE--!!>]

GO

REVOKE SELECT ON [<!!--DATABASE--!!>].[<!!--
SCHEMA NAME--!!>].[<!!--TABLE NAME--!!>] FROM 
[<!!--GRANTED TO--!!>] CASCADE

GO

Permission to select from system 
table

USE [<!!--DATABASE--!!>]

GO

REVOKE SELECT ON [<!!--DATABASE--!!>].[<!!--
OWNER--!!>].[<!!--TABLE NAME--!!>] FROM [<!!--
GRANTED TO--!!>] CASCADE

GO

Error logs can be overwritten Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Permission to select from syslogins

USE master

GO

REVOKE SELECT ON master.dbo.syslogins FROM <!!--
GRANTED TO--!!>

GO
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Objects not owned by dbo USE  <!!--DATABASE--!!>

GO

DROP TABLE [<!!--DATABASE--!!>].[<!!--OWNER--
!!>].[<!!--OBJECT NAME--!!>]

GO

srv_paraminfo buffer overflow in 
sp_OADestroy

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Default password for well-known 
login

USE master

GO

sp_password <!!--PASSWORD--!!>, <NEW 
PASSWORD>, <!!--LOGIN--!!>

GO

Permissions granted to PUBLIC EXEC SP_CONFIGURE 'ALLOW UPDATES', @oldValue

RECONFIGURE WITH OVERRIDE

GO

sysadmin role granted"USE 
master

GO  

EXEC sp_dropsrvrolemember N'<!!--LOGIN--!!>', 
'sysadmin'  

GO

xp_deletequeue buffer overflow USE master

GO

DROP PROCEDURE xp_deletequeue

GO

xp_displayqueuemesgs buffer 
overflow

USE master

GO

DROP PROCEDURE xp_displayqueuemesgs

GO

xp_readpkfromqueue buffer 
overflow

USE master

GO

DROP PROCEDURE xp_readpkfromqueue

GO
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xp_sprintf buffer overflow USE master

GO

REVOKE EXECUTE ON master.dbo.xp_sprintf FROM 
public

GO

xp_unpackcab buffer overflow USE master

GO

DROP PROCEDURE xp_unpackcab

GO

Permission on sp_MSsetalertinfo USE master

GO

REVOKE ALL ON master.dbo.sp_MSsetalertinfo FROM 
public

GO

xp_mergelineages buffer 
overflow

USE master

GO

DROP PROCEDURE xp_mergelineages

GO

xp_decodequeuecmd buffer 
overflow

USE master

GO

DROP PROCEDURE xp_decodequeuecmd

GO

xp_resetqueue buffer overflow USE master

GO

DROP PROCEDURE xp_resetqueue

GO

Permissions granted to GUEST EXEC SP_CONFIGURE 'ALLOW UPDATES', @oldValue

RECONFIGURE WITH OVERRIDE

GO

xp_sqlagent_param buffer 
overflow

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Securit Audits. To fully fix this vulnerability, please apply 
the latest patch.
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xp_readpkfromvarbin buffer 
overflow

USE master

GO

DROP PROCEDURE

xp_readpkfromvarbin

GO

Encoded password written by 
installation

USE master

GO

sp_password <!!--SQLDOMAINPWD--!!>,<NEW 
PASSWORD>,'sa'

GO

Encoded password written by 
installation

USE master

GO

sp_password <!!--CONFIRMPWD--!!>,<NEW 
PASSWORD>,'sa'

GO

Encoded password written by 
installation

USE master

GO

sp_password <!!--ENTERPWD--!!>,<NEW 
PASSWORD>,'sa'

GO

xp_sqlinventory buffer overflow USE master

GO

DROP PROCEDURE xp_sqlinventory

GO

Encoded password written by 
installation

USE master

GO

sp_password <!!--AGTDOMAINPWD--!!>,<NEW 
PASSWORD>,'sa'

GO

Fixed server role granted USE master

GO

EXEC sp_dropsrvrolemember N'<!!--LOGIN--!!>', '<!!--
PRIVILEGE--!!>' 

GO
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Encoded password written by 
installation

USE master

GO

sp_password <!!--SVPWD--!!>,<NEW PASSWORD>,'sa'

GO

Encoded password written by 
installation

USE master

GO

sp_password <!!--SVPASSWORD--!!>,<NEW 
PASSWORD>,'sa'

GO

DTS password table publicly 
viewable

USE msdb

GO

sp_dropuser guest

GO

REVOKE SELECT ON RTblDBMProps FROM public

GO

Table to store DTS passwords 
publicly viewable

USE msdb

GO

sp_dropuser guest

GO

REVOKE SELECT ON RTblDBMProps FROM public

GO

sp_MScopyscriptfile command 
injection

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

Public can create Agent jobs USE <!!--DATABASE--!!>

GO

REVOKE ALL ON [<!!--STORED PROCEDURE--!!>] 
FROM public

GO

Permission on 
sp_MSSetServerProperties

USE master

GO

REVOKE ALL ON 
master.dbo.sp_MSSetServerProperties FROM public

GO
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xp_deleteprivatequeue buffer 
overflow

USE master

GO

DROP PROCEDURE xp_deleteprivatequeue

GO

srv_paraminfo buffer overflow in 
xp_displayparamstmt

USE master

GO

REVOKE EXECUTE ON 
master.dbo.xp_displayparamstmt FROM public

GO

Permissions granted to PUBLIC IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL 

    EXEC('USE [<!!--DATABASE--!!>]'  +  '  REVOKE <!!--
PERMISSION--!!> ON [<!!--OWNER--!!>].[<!!--
OBJECT NAME--!!>] FROM PUBLIC')

xp_proxiedmetadata buffer overflow

Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

xp_createprivatequeue buffer 
overflow

USE master

GO

DROP PROCEDURE xp_createprivatequeue

GO

Permissions granted on 
sp_add_dtspackage

USE msdb

GO

REVOKE EXECUTE ON sp_add_dtspackage FROM 
public

GO

Permissions granted to GUEST"IF  DB_ID(N'<!!--
DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--COLUMN--!!>] FROM 
GUEST')

Permission on mswebtasks USE msdb

GO

REVOKE <!!--PERMISSION--!!> ON 
msdb.dbo.mswebtasks FROM public

GO
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Permission on sp_readwebtask USE master

GO

REVOKE ALL ON master.dbo.sp_readwebtask FROM 
public

GO

Permission on xp_readerrorlog USE master

GO

REVOKE ALL ON master.dbo.xp_readerrorlog FROM 
<!!--GRANTED TO--!!> 

GO

xstatus backdoor EXEC SP_CONFIGURE 'ALLOW UPDATES', @oldValue

RECONFIGURE WITH OVERRIDE

GO

xstatus backdoor DECLARE @oldValue int

SELECT @oldValue = value FROM master..syscurconfigs 
where config=102 

We have to run SP_CONFIGURE to allow updates to the 
system catalogs

EXEC SP_CONFIGURE 'ALLOW UPDATES', 1

RECONFIGURE WITH OVERRIDE

DTS package procedures granted 
to public

USE <!!--DATABASE--!!>

GO

REVOKE ALL ON [<!!--DATABASE--!!>].[<!!--OWNER--
!!>].[<!!--PROCEDURE NAME--!!>] FROM public

GO

Agent jobs privilege escalation USE <!!--DATABASE--!!>

GO

REVOKE ALL ON [<!!--EXTENDED STORED 
PROCEDURE--!!>] FROM public

GO

xstatus backdoor USE master

exec('delete from master.dbo.sysxlogins where [name] = 
''<!!--LOGIN--!!>''') 

EXEC sp_grantlogin N'<!!--LOGIN--!!>'
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DTS package procedures granted 
to public

USE <!!--DATABASE--!!>

GO

REVOKE ALL ON [<!!--DATABASE--!!>].[<!!--OWNER--
!!>].[<!!--TABLE NAME--!!>] FROM public

GO

SQL injection in sp_MSdropretry Note: Despite performing the following SQL 
statements, vulnerabilities may still show up in future 
Security Audits. To fully fix this vulnerability, please apply 
the latest patch.

SQL Agent password publicly 
viewable

USE msdb

GO

sp_dropuser guest

GO

REVOKE ALL ON sp_get_sqlagent_properties FROM 
public

GO

SQL Agent procedures granted to 
public

USE msdb

GO

sp_dropuser guest

GO

REVOKE ALL ON sp_get_sqlagent_properties FROM 
public

GO

Permissions granted to GUEST DECLARE @oldValue int

SELECT @oldValue = value FROM master..syscurconfigs 
where config=102

We have to run SP_CONFIGURE to allow updates to the 
system catalogs

EXEC SP_CONFIGURE 'ALLOW UPDATES', 1

RECONFIGURE WITH OVERRIDE

Permissions granted to PUBLIC IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL 

    EXEC('USE [<!!--DATABASE--!!>]' + '  REVOKE <!!--
PERMISSION--!!> ON [<!!--COLUMN--!!>] FROM 
PUBLIC')

Permissions granted to PUBLIC"IF  DB_ID(N'<!!--
DATABASE--!!>') IS NOT NULL

EXEC('USE [<!!--DATABASE--!!>]' + ' REVOKE <!!--
PERMISSION--!!> ON [<!!--SCHEMA NAME--!!>].[<!!--
OBJECT NAME--!!>] FROM PUBLIC')
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Sample database not removed USE master

GO

DROP DATABASE <!!--DATABASE--!!>

GO

Permissions granted to PUBLIC DECLARE @oldValue int

SELECT @oldValue = value FROM master..syscurconfigs 
where config=102

We have to run SP_CONFIGURE to allow updates to the 
system catalogs

EXEC SP_CONFIGURE 'ALLOW UPDATES',

RECONFIGURE WITH OVERRIDE

Permissions granted to PUBLIC IF  DB_ID(N'<!!--DATABASE--!!>') IS NOT NULL

   EXEC('USE [<!!--DATABASE--!!>]' + '  REVOKE <!!--
PERMISSION--!!> FROM PUBLIC')
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ORACLE FIX SCRIPTS 

Check Script

Brute-force role password ALTER ROLE <!!--USERNAME--!!> IDENTIFIED BY 
<PASSWORD>;

Object privilege granted to 
PUBLIC

BEGIN

IF UPPER('<!!--PRIVILEGE--!!>') IN ('DEQUEUE', 
'ENQUEUE') THEN

DBMS_AQADM.REVOKE_QUEUE_PRIVILEGE('<!!--
PRIVILEGE--!!>', '<!!--OWNER--!!>.<!!--OBJECT 
NAME--!!>', 'PUBLIC');

ELSE

EXECUTE IMMEDIATE 'REVOKE <!!--PRIVILEGE--!!> 
ON "<!!--OWNER--

Account granted the predefined 
role CONNECT

CREATE ROLE <NEW ROLE>;

GRANT CREATE SESSION TO <NEW ROLE>;

Account granted the predefined 
role CONNECT

REVOKE CONNECT FROM <!!--GRANTED TO--!!>;

GRANT <NEW ROLE> TO <!!--GRANTED TO--!!>;

Non-standard account with DBA 
role

REVOKE DBA FROM <!!--GRANTED TO--!!>;

Account granted the predefined 
role RESOURCE

CREATE ROLE <NEW ROLE>;

GRANT CREATE SESSION TO <NEW ROLE>;

Privilege to execute UTL_HTTP 
granted to PUBLIC

REVOKE EXECUTE ON SYS.UTL_HTTP FROM PUBLIC;

Easily-guessed role password ALTER ROLE <!!--USER NAME--!!> IDENTIFIED BY 
<PASSWORD>;

Privilege to execute UTL_SMTP 
granted to PUBLIC

REVOKE EXECUTE ON SYS.UTL_SMTP FROM PUBLIC;

Profile settings - Failed Login 
Attempts

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
FAILED_LOGIN_ATTEMPTS 10;
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Object privilege grantable BEGIN 

IF UPPER('<!!--PRIVILEGE--!!>') IN ('DEQUEUE', 
'ENQUEUE') THEN    
DBMS_AQADM.REVOKE_QUEUE_PRIVILEGE('<!!--
PRIVILEGE--!!>', '<!!--OWNER--!!>.<!!--OBJECT 
NAME--!!>', '<!!--GRANTED TO--!!>'); 
DBMS_AQADM.GRANT_QUEUE_PRIVILEGE('<!!--
PRIVILEGE--!!>'

Privilege on database link table REVOKE <!!--PRIVILEGE--!!> ON SYS.LINK$ FROM <!!-
-USER NAME--!!>;

Object privilege granted to 
account

CREATE ROLE <NEW ROLE>;

Default database password ALTER USER <!!--USER NAME--!!> IDENTIFIED BY 
<NEW PASSWORD>;

Account granted the predefined 
role RESOURCE

REVOKE RESOURCE FROM <!!--GRANTED TO--!!>;

GRANT <NEW ROLE> TO <!!--GRANTED TO--!!>;

System privilege granted WITH 
ADMIN OPTION

REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>;

GRANT <!!--PRIVILEGE--!!> TO <!!--GRANTED TO--
!!>;

Role without password ALTER ROLE <!!--ROLE--!!> IDENTIFIED BY 
<PASSWORD>;

Profile settings - Password Verify 
Function

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_VERIFY_FUNCTION <NEW VERIFY 
FUNCTION>;

Profile settings - Password Reuse 
Time

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_REUSE_TIME 180 
PASSWORD_REUSE_MAX UNLIMITED;

Profile settings - Password Reuse 
Maximum

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_REUSE_MAX 10 
PASSWORD_REUSE_TIME UNLIMITED;

Profile settings - Password Lock 
Time

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_LOCK_TIME 1;

Profile settings - Password Life 
Time

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_LIFE_TIME 90;

Profile settings - Password Grace 
Time

ALTER PROFILE <!!--PROFILE--!!> LIMIT 
PASSWORD_GRACE_TIME 3;
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Object privilege granted to 
account

BEGIN

IF NOT UPPER('<!!--PRIVILEGE--!!>') IN ('INDEX', 
'REFERENCES') THEN

    EXECUTE IMMEDIATE 'REVOKE <!!--PRIVILEGE--!!> 
ON ""<!!--OWNER--!!>"".""<!!--OBJECT NAME--
!!>"" FROM <!!--GRANTED TO--!!>';

    EXECUTE IMMEDIATE 'GRANT <!!--PRIVILEGE--!!> 
ON ""<!!-

Privilege to execute UTL_FILE 
granted to PUBLIC

REVOKE EXECUTE ON SYS.UTL_FILE FROM PUBLIC;

Auditing of CREATE SESSION not 
enabled

AUDIT SESSION;

SQL Injection in 
OWF_MGR.WF_LOV

REVOKE EXECUTE ON OWF_MGR.WF_LOV FROM 
PUBLIC;

Password for database user same 
as username

ALTER USER <!!--USER NAME--!!> IDENTIFED BY 
<NEW PASSWORD>;

Expired password ALTER USER <!!--USERNAME--!!> IDENTIFED BY 
<NEW PASSWORD>;

Account granted ALTER SYSTEM 
privilege

REVOKE ALTER SYSTEM FROM <!!--GRANTED TO--
!!>;

System privilege with ANY clause REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>;

Create library privilege REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>;

Privilege on audit trail table REVOKE <!!--PRIVILEGE--!!> ON SYS.AUD$ FROM <!!-
-GRANTED TO--!!>;

Account associated with 
DEFAULT profile

ALTER USER <!!--USERNAME--!!> PROFILE <NEW 
PROFILE NAME>;

Account associated with 
DEFAULT profile

CREATE PROFILE <NEW PROFILE NAME> LIMIT 
SESSIONS_PER_USER 2 CPU_PER_SESSION unlimited 
CPU_PER_CALL 6000 LOGICAL_READS_PER_SESSION 
unlimited LOGICAL_READS_PER_CALL 100 IDLE_TIME 
30 CONNECT_TIME 480;

Privilege granted to SELECT from 
data dictionary

REVOKE <!!--PRIVILEGE--!!> ON <!!--TABLE NAME--
!!> FROM <!!--GRANTED TO--!!>;
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Account granted the predefined 
role DBA

CREATE ROLE <NEW ROLE>;

System privilege granted to 
account

CREATE ROLE <NEW ROLE>;VARIABLE 
privilege_name VARCHAR2(20);

VARIABLE privilege_user VARCHAR2(100);

Account can access source code 
as SYS

REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>;

System privilege granted to 
account"

BEGIN

:privilege_user := 'Privilege: ' || '<!!--PRIVILEGE--!!>' || ' - 
User: ' || '<!!--GRANTED TO--!!>'; 

END;

/

PRINT :privilege_user;

BEGIN 

--UNLIMITED TABLESPACE, SYSDBA or SYSOPER 
privilege cannot be granted to a role.

IF NOT UPPER('<!!--PRIVILEGE"

Overdue password change ALTER USER <!!--USERNAME--!!> IDENTIFIED BY 
<PASSWORD>;

Account can grant any role REVOKE GRANT ANY ROLE FROM <!!--GRANTED TO-
-!!>;

SQL Injection in 
PORTAL.WPG_SESSION

REVOKE EXECUTE ON PORTAL.WPG_SESSION FROM 
PUBLIC;

Accounts with SYSTEM as default 
tablespace

ALTER USER <!!--USER NAME--!!> DEFAULT 
TABLESPACE <NEW DEFAULT TABLESPACE>;

SQL Injection in 
ORASSO.WPG_SESSION

REVOKE EXECUTE ON ORASSO.WPG_SESSION 
FROM PUBLIC;

Account granted the predefined 
role DBA

REVOKE DBA FROM <!!--GRANTED TO--!!>;

GRANT CREATE SESSION TO <NEW ROLE>;

GRANT <NEW ROLE> TO <!!--GRANTED TO--!!>;

Account can replace public links REVOKE CREATE PUBLIC DATABASE LINK FROM <!!--
GRANTED TO--!!>;

REVOKE DROP PUBLIC DATABASE LINK FROM <!!--
GRANTED TO--!!>;
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Privilege to execute 
DBMS_RANDOM granted to 
PUBLIC

REVOKE EXECUTE ON SYS.DBMS_RANDOM FROM 
PUBLIC;

Roles granted WITH ADMIN 
OPTION

REVOKE <!!--ROLE--!!> FROM <!!--GRANTED TO--
!!>;

GRANT <!!--ROLE--!!> TO <!!--GRANTED TO--!!>;

Account granted the 
JAVA_ADMIN role

REVOKE JAVA_ADMIN FROM <!!--GRANTED TO--!!>;

Default role password ALTER ROLE <!!--ROLE--!!> IDENTIFIED BY 
<PASSWORD>;

System privilege granted to 
PUBLIC

REVOKE "<!!--PRIVILEGE--!!>" FROM PUBLIC;

SQL Injection in 
OWF_MGR.WF_EVENT_HTML

REVOKE EXECUTE ON OWF_MGR.WF_EVENT_HTML 
FROM PUBLIC;

Privilege to execute UTL_TCP 
granted to PUBLIC

REVOKE EXECUTE ON SYS.UTL_TCP FROM PUBLIC;

Account can become another 
user

REVOKE BECOME USER FROM <!!--GRANTED TO--
!!>;

REVOKE ALTER USER FROM <!!--GRANTED TO--!!>;

Account can create public 
synonyms

REVOKE CREATE PUBLIC SYNONYM FROM <!!--
GRANTED TO--!!>;
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SYBASE FIX SCRIPTS 

Check Script

Server configured with remote 
server

USE master

sp_dropserver <!!--SERVER NAME--!!>, droplogins

Allow resource limit USE master

sp_configure 'allow resource limits', 1

RECONFIGURE

Permission granted in sybsecurity USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!>.<!!--COLUMN-
-!!> FROM <!!--GRANTED TO--!!>

Permission granted on 
xp_cmdshell

USE <!!--DATABASE--!!>

REVOKE EXECUTE ON xp_cmdshell FROM <!!--
GRANTED TO--!!>

Permission granted in sybsecurity USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!> FROM <!!--
GRANTED TO--!!>

Auditing disabled sp_auditoption 'enable auditing', 'on'

sp_configure 'auditing', 1

Log audit logon failure USE master

sp_configure 'log audit logon failure', 1

RECONFIGURE

Blank password for sa USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'sa'

Easily-guessed sa password USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'sa'

Default password for 
entldbreader

USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'entldbreader'

Default password for jagadmin USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'jagadmin'
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Suspend audit when full disabled USE master

sp_configure 'suspend audit when device full', 1

RECONFIGURE

Statement permission granted USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>

Default password for entldbdbo USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'entldbdbo'

Default password for dba 
repository user

USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'dba'

Easily-guessed password USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, <!!--LOGIN--!!>

Permissions granted to public USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!>.<!!--COLUMN-
-!!> FROM public

Require message integrity USE master

execute sp_configure 'msg integrity reqd', 1

execute sp_configure 'use security services', 1

Default password for pso USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'pso'

Unrestricted access to 
syscomments

USE master

sp_configure 'select on syscomments.text', 0

RECONFIGURE

Audit database owned by sa_role 
member

USE master

sp_changedbowner <!!--LOGIN--!!> <, true >
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Login attributes less restrictive USE master

sp_modifylogin <!!--LOGIN--!!>, 'max failed_logins', 
<NEW VALUE>

sp_modifylogin <!!--LOGIN--!!>, 'passwd expiration', 
<NEW VALUE>

sp_modifylogin <!!--LOGIN--!!>, 'min passwd length', 
<NEW VALUE>

sp_modifylogin 'all overrides', 'max failed_login

Unlocked sa login USE master

sp_role ""grant"", sa_role, <NEW SA LOGIN>

sp_role ""grant"", sso_role, <NEW SA LOGIN>

sp_locklogin 'sa', ""lock""

With grant option USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!> FROM <!!--
DATABASE--!!>.<!!--USER--!!> CASCADE

Auditing of failed logins not 
enabled

sp_auditoption 'logins', 'fail'

sp_audit 'login', 'all', 'all', 'fail'

Permissions granted to public USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!> FROM public

Expired logins USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, <!!--LOGIN--!!>

Login granted sa_role USE master

REVOKE sa_role FROM <!!--LOGIN--!!>

Login granted sso_role USE master

REVOKE sso_role FROM <!!--LOGIN--!!>

Guest user exists in sybsecurity USE sybsecurity

sp_dropuser guest

Auditing of successful logins not 
enabled

sp_auditoption 'logins', 'ok'

sp_audit 'login', 'all', 'all', 'pass'

Permissions granted to user USE <!!--DATABASE--!!>

REVOKE <!!--PRIVILEGE--!!> ON <!!--DATABASE--
!!>.<!!--OWNER--!!>.<!!--OBJECT--!!> FROM <!!--
GRANTED TO--!!>
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Event logging USE master

execute sp_configure 'event logging', 1

RECONFIGURE

Objects not owned by dbo USE <!!--DATABASE--!!>

DROP TABLE <!!--DATABASE--!!>.<!!--OWNER--
!!>.<!!--OBJECT--!!>

Remote access allowed USE master

sp_configure 'allow remote access', 0

RECONFIGURE

Roles revoked from the sa login USE master

REVOKE ROLE sa_role FROM sa

REVOKE ROLE sso_role FROM sa

REVOKE ROLE oper_role FROM sa

REVOKE ROLE sybase_ts_role FROM sa

List resource limits USE <!!--DATABASE--!!>

sp_add_resource_limit <!!--LOGIN--!!>, <!!--
APPLICATION--!!>, <!!--RANGE--!!>, <LIMIT TYPE>, 
<!!--LIMIT--!!> <, <ENFORCED> <, <ACTION> <, 
<SCOPE> >>>

Start mail session USE master

execute sp_configure 'start mail session', 0

RECONFIGURE

Unified login required USE master

sp_configure 'unified login required', 1

sp_configure 'use security services', 1

RECONFIGURE

Allow sendmsg USE master

execute sp_configure 'allow sendmsg', 0

RECONFIGURE

Orphaned user USE master

sp_dropuser '<!!--USERNAME--!!>'

sp_droplogin '<CORRESPONDING LOGIN>'

sp_addlogin '<CORRESPONDING LOGIN>', <LOGIN 
PASSWORD>

sp_adduser '<CORRESPONDING LOGIN>', '<!!--
USERNAME--!!>'
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Secure default login exists USE master

execute sp_configure 'secure default login', 0, ''

RECONFIGURE

Roles without passwords USE master

ALTER ROLE <!!--ROLE--!!> ADD PASSWD <NEW 
PASSWORD>

Require message confidentiality 
with encryption

USE master

execute sp_configure 'msg confidentiality reqd', 1

execute sp_configure 'use security services', 1

RECONFIGURE

Event log computer name USE master

sp_configure 'event log computer name', 0, '<YOUR 
SERVER NAME>'

Use security services USE master

sp_configure 'use security services', 1

RECONFIGURE

Default SAP password"USE 
master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, <!!--LOGIN--!!>

Audit queue size USE master

sp_configure 'audit queue size', <NEW VALUE>

Log audit logon success USE master

sp_configure 'log audit logon success', 1

RECONFIGURE

Default password for PortalAdmin USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'PortalAdmin'

Default password for pkiuser USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'pkiuser'

Password same as login name USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, <!!--LOGIN--!!>

Guest user exists in database USE <!!--DATABASE--!!>

sp_dropuser guest
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System-wide password expiration USE master

sp_configure 'systemwide password expiration', 90

RECONFIGURE

Audit logout not set USE master

sp_auditoption 'logouts', <CHOOSE 'on'|'off'>

sp_audit 'logout', 'all', 'all', <CHOOSE 'on'|'fail'|'pass'>"

Permission granted on system 
table

USE <!!--DATABASE--!!>

REVOKE SELECT ON <!!--DATABASE--!!>.<!!--
OWNER--!!>.<!!--OBJECT--!!> FROM <!!--GRANTED 
TO--!!>

xp_cmdshell not removed USE master

sp_dropextendedproc xp_cmdshell

Permission to select from 
syslogins

USE master

REVOKE <!!--PRIVILEGE--!!> ON master.dbo.syslogins 
FROM <!!--GRANTED TO--!!>

xp_cmdshell context USE master

sp_configure 'xp_cmdshell context', 1

RECONFIGURE

Current audit table USE master

sp_configure ""current audit table"", <CURRENT 
AUDIT TABLE> <, ""with truncate"">

Minimum password length USE master

sp_configure 'minimum password length', <NEW 
VALUE>

Maximum failed logins USE master

sp_configure 'maximum failed logins', <NEW VALUE>

Check password for digit USE master

sp_configure 'check password for digit', 1

RECONFIGURE

Default password for PIAdmin USE master

sp_password <CURRENT PASSWORD>, <NEW 
PASSWORD>, 'PIAdmin'

Updates allowed to system tables USE master

sp_configure 'allow updates to system tables', 0

RECONFIGURE
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IBM DB2 FIX SCRIPTS 

Check Script

Permissions to list users REVOKE CONTROL ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE ALTER ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE DELETE ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE INDEX ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE INSERT ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE SELECT ON

Permissions granted to PUBLIC REVOKE <!!--PRIVILEGE--!!> FROM publicthx

Permissions granted to PUBLIC REVOKE <!!--PRIVILEGE--!!> ON <!!--TABLE--!!> 
FROM public

Permissions granted to PUBLIC REVOKE <!!--PRIVILEGE--!!> ON <!!--SCHEMA--!!> 
FROM public

CREATE_NOT_FENCED privilege 
granted

REVOKE CREATE_NOT_FENCED ON DATABASE 
FROM PUBLIC

REVOKE CREATE_NOT_FENCED ON DATABASE 
FROM USER <!!--GRANTED TO--!!>

REVOKE CREATE_NOT_FENCED ON DATABASE 
FROM GROUP <!!--GRANTED TO--!!>

Permissions granted to PUBLIC REVOKE <!!--PRIVILEGE--!!> ON <!!--INDEX--!!> 
FROM public

Permissions granted to PUBLIC REVOKE <!!--PRIVILEGE--!!> ON <!!--COLUMN--!!> 
FROM public

Auditing buffer size UPDATE DATABASE MANAGER CONFIGURATION 
USING AUDIT_BUF_SZ <NEW VALUE>

Permissions granted to user REVOKE <!!--PRIVILEGE--!!> ON INDEX <!!--INDEX--
!!> FROM <!!--GRANTED TO--!!>

Permissions granted to user REVOKE <!!--PRIVILEGE--!!> ON SCHEMA <!!--
SCHEMA--!!> FROM <!!--GRANTED TO--!!>

Permissions granted to user REVOKE <!!--PRIVILEGE--!!> ON <!!--TABLE--!!> 
FROM <!!--GRANTED TO--!!>

Permissions granted to user REVOKE <!!--PRIVILEGE--!!> FROM <!!--GRANTED 
TO--!!>
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AUTHENTICATION parameter 
type

UPDATE DBM CFG USING AUTHENTICATION <NEW 
METHOD>

AUTHENTICATION parameter set 
to DCS

UPDATE DBM CFG USING AUTHENTICATION 
DCS_ENCRYPT

Permissions on system catalog REVOKE CONTROL ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE ALTER ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE DELETE ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE INDEX ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE INSERT ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE SELECT ON

AUTHENTICATION parameter set 
to SERVER

UPDATE DBM CFG USING AUTHENTICATION 
SERVER_ENCRYPT

AUTHENTICATION parameter set 
to CLIENT

UPDATE DBM CFG USING AUTHENTICATION 
SERVER_ENCRYPT

Permissions granted to user REVOKE <!!--PRIVILEGE--!!> ON <!!--COLUMN--!!> 
FROM <!!--GRANTED TO--!!>

Check Script

Permissions to list users REVOKE CONTROL ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE ALTER ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE DELETE ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE INDEX ON <!!--TABLE NAME--!!> TO PUBLIC

REVOKE INSERT ON <!!--TABLE NAME--!!> TO 
PUBLIC

REVOKE SELECT ON
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MYSQL FIX SCRIPTS  

Check Script

Easily-guessed root password UPDATE user SET Password=PASSWORD('<NEW 
PASSWORD>') WHERE user='root';

FLUSH PRIVILEGES;

FILE privileges granted REVOKE FILE ON *.* FROM '<!!--USER--!!>'@'<!!--
HOST--!!>';

FLUSH PRIVILEGES;

PROCESS privileges granted REVOKE PROCESS ON *.* FROM '<!!--USER--
!!>'@'<!!--HOST--!!>';

FLUSH PRIVILEGES;

Password for user same as 
username

UPDATE user SET Password=PASSWORD('<NEW 
PASSWORD>') WHERE user='<!!--USER--!!>'@'<!!--
HOST--!!>';

FLUSH PRIVILEGES;

Sample database not removed DROP DATABASE <!!--SAMPLE DATABASE--!!>

Easily-guessed account 
passwords

UPDATE user SET Password=PASSWORD('<NEW 
PASSWORD>']) WHERE user='<!!--USER--!!>'@'<!!--
HOST--!!>';

FLUSH PRIVILEGES;

Blank root password UPDATE user SET Password=PASSWORD('<NEW 
PASSWORD>') WHERE user='root';

FLUSH PRIVILEGES;

Default passwords for test 
accounts

REVOKE ALL ON  *.* FROM '<!!--USER--!!>'@'<!!--
HOST--!!>';

DELETE FROM user WHERE User='<!!--USER--
!!>'@'<!!--HOST--!!>';

FLUSH PRIVILEGES;

Blank account passwords UPDATE user SET Password=PASSWORD('<NEW 
PASSWORD>') WHERE user='<!!--USER--!!>'@'<!!--
HOST--!!>';

FLUSH PRIVILEGES;

Anonymous user exists DELETE FROM mysql.user WHERE User = '<!!--USER--
!!>'@'<!!--HOST--!!>';
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Appendix K: Backing Up, 
Restoring, Archiving, and 
Purging Alerts
Recording events that produce a heavy volume of data in DbProtect Audit and Threat 
Management may diminish system performance when used for reporting. Also, large 
data collection creates storage issues as Informational Alerts (a/k/a “audit Alerts”) 
consume disk space at a steady rate.

One solution: back up Alerts that are no longer needed from the database into 
another physical archive for storage. The Alerts are available for restoration, but set 
aside so current data analysis performance is expedited. Once you have moved audit 
Alerts to the backup tables, you can purge the data from your database.

This document explains how to archive, restore, purge, and export Alerts. It consists of 
the following topics:

•  Understanding the AppSecInc-provided SQL script, backup tables, and stored 
procedures

•  Setup

•  Backing up your Security and Informational Alerts

•  Restoring your Security and Informational Alerts

•  Archiving and purging Your Security and Informational Alerts

•  Stored procedures for purging Security Alerts and Informational Alerts.

Understanding the
AppSecInc-

provided SQL
script, backup

tables, and stored
procedures

AppSecInc provides a SQL scriptSQL scriptSQL scriptSQL script called appradar_ext_alert_backup.sql (available 
from Application Security, Inc. Customer Support; for more information, see Customer 
Support).

The appradar_ext_alert_backup.sql script creates the following backup tablesbackup tablesbackup tablesbackup tables and 
related indexes:

•  ins_alerts_security_backup

•  ins_alerts_info_backup

•  ins_origins_backup

•  ins_sql_backup

These backup tables are temporary storage areas for Security and Informational Alerts 
that should be archived.
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The appradar_ext_alert_backup.sql script also creates the following stored stored stored stored 
proceduresproceduresproceduresprocedures:

•  appdetective.dbo.arcx_spBackupAlerts @cutoff_end_date

•  appdetective.dbo.arcx_spRestoreAlerts.

Setup BeforeBeforeBeforeBefore you back up your Security and Informational Alerts, do the following: 

1. Run the following SQL script: appradar_ext_alert_backup.sql.

Note:Note:Note:Note: You only need to run this script onceonceonceonce.

Backing up your
Security and
Informational

Alerts

You can back up back up back up back up your Security and Informational Alerts -- based on their event-
generated timestamp -- from the system Alert tables into the backup tables.

This topic consists of the following sub-topics:

•  Backup

•  Backup Example.

BACKUP

To back up back up back up back up your Security and Informational Alerts: 

1. Stop the Message Collector service.

Note:Note:Note:Note: You will notnotnotnot lose any Security and Informational Alert activity. Sensors 
temporarily store new Security and Informational Alerts in the replay logs 
until the Message Collector is ready to accept incoming Security and 
Informational Alerts again.

2. Execute the arcx_spBackupAlerts stored procedures to back up your 
Security and Informational Alerts. Be sure to specify an end date for your 
backup; for more information, see the Backup Example.

3. Restart the Message Collector service.

BACKUP EXAMPLE

If you want to move all Security and Informational Alerts generated any time on or 
before September 1, 2005, execute the arcx_spBackupAlerts stored procedure. The 
time it takes for this procedure to complete depends on the number of Security and 
Informational Alerts that match the date and time criteria.

use appdetective

go

exec appdetective.dbo.arcx_spBackupAlerts '9/1/2005 23:59:59'

go

Note:Note:Note:Note: The date/time parameter is requiredrequiredrequiredrequired.
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Restoring your
Security and
Informational

Alerts

This topic consists of the following sub-topics:

•  Restoration.

•  Restoration example.

Note:Note:Note:Note: This procedure restores allallallall your existing backed-up data.

RESTORATION

To restorerestorerestorerestore your Security and Informational Alerts: 

1. Stop the Message Collector service.

Note:Note:Note:Note: You will notnotnotnot lose any Security and Informational Alert activity. Sensors 
temporarily store new Security and Informational Alerts in the replay logs 
until the Message Collector is ready to accept incoming Security and 
Informational Alerts again.

2. Execute the arcx_spRestoreAlerts stored procedure to restore your 
Security and Informational Alerts; for more information, see the 
Restoration example.

3. Restart the Message Collector service.

RESTORATION EXAMPLE

If you want to restore the Security and Informational Alerts to the DbProtect Audit and 
Threat Management processing tables, execute the arcx_spRestoreAlerts stored 
procedure.

use appdetective

go

exec appdetective.dbo.arcx_spRestoreAlerts

go

This restores all Security and Informational Alerts from the backup tables and returns 
them to the DbProtect Audit and Threat Management processing tables.

Archiving and
purging Your
Security and
Informational

Alerts

Once you have moved Audits to the backup tables, you can archive archive archive archive them using a 
utility such as Microsoft SQL Server’s Data Transformation Services or bcp. Once you 
have archived your data, you can clear the backup tables by purgingpurgingpurgingpurging them, as follows:

•  truncate table ins_alerts_security_backup

•  truncate table ins_alerts_info_backup

•  truncate table ins_origins_backup

•  truncate table ins_sql_backup
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Stored procedures
for purging

Security Alerts and
Informational

Alerts

This topic consists of the following sub-topics:

•  Purging

•  Purging Examples (Required Stored Procedures).

PURGING

The following AppSecInc-provided stored procedures allow you to purge your 
database completely and irreversibly of all Alerts (Security and Informational).

The following stored procedures are requiredrequiredrequiredrequired:

•  appdetective.dbo.arc_spPurgeSecurityAlerts 
@beforeAndIncludingTime

•  appdetective.dbo.arc_spPurgeInfoAlerts @beforeAndIncludingTime

Note:Note:Note:Note: The date/time parameters are requiredrequiredrequiredrequired.

The following stored procedures are optionaloptionaloptionaloptional:

•  arc_spPurgeOrphanOrigins

•  arc_spPurgeOrphanSQLS.

Note:Note:Note:Note: The purging stored procedures are included in the DbProtect installation, 
notnotnotnot in the attached .zip file.

The following table explains each stored procedure used to purge Security and 
Informational Alerts:

Stored Procedure Explanation

appdetective.dbo. 

arc_spPurgeSecurityAlerts 

@beforeAndIncludingTime

You must run this requiredrequiredrequiredrequired stored procedure if you 
want to purge Security Alerts from the 
ins_alerts_security table.

The date/time parameter is requiredrequiredrequiredrequired.

appdetective.dbo. 

arc_spPurgeInfoAlerts 

@beforeAndIncludingTime

You must run this requiredrequiredrequiredrequired stored procedure if you 
want to purge Informational Alerts from the 
ins_alerts_info table.

The date/time parameter is requiredrequiredrequiredrequired.

arc_spPurgeOrphanOrigins If you run either of the stored procedures, above, 
you can run these two optionaloptionaloptionaloptional stored procedures 
to purge related Security and Informational Alert 
data from the ins_origins and ins_sql tables.

arc_spPurgeOrphanSQL
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To run the stored procedures used to purge Security and Informational Alerts (and, 
optionally, related table data): 

1. Stop the Message Collector service.

2. Execute required stored procedures.

If you want to purge:

•  Security Alerts from the ins_alerts_security table, then execute the 
following requiredrequiredrequiredrequired stored procedure: appdetective.dbo. 
arc_spPurgeSecurityAlerts @beforeAndIncludingTime

•  Informational Alerts from the ins_alerts_info table, then execute the 
following requiredrequiredrequiredrequired stored procedure: appdetective.dbo. 
arc_spPurgeInfoAlerts @beforeAndIncludingTime.

Note:Note:Note:Note: The date/time parameters are requiredrequiredrequiredrequired.

For more information, see Purging Examples (Required Stored Procedures).

Execute Execute Execute Execute optionaloptionaloptionaloptional stored procedures. stored procedures. stored procedures. stored procedures.

If you want to purge related Security and Informational Alert data from the:

•  ins_origins table, then execute the following optional stored procedure: 

arc_spPurgeOrphanOrigins

•  ins_sql table, then execute the following optionaloptionaloptionaloptional stored procedure: 
arc_spPurgeOrphanSQL.

3. Re-start the Message Collector service.

PURGING EXAMPLES (REQUIRED STORED PROCEDURES)

If you want to purge Security Alerts generated any time on or before September 1, 
2005 from the ins_alerts_security table, then execute the following requiredrequiredrequiredrequired 
stored procedure:

appdetective.dbo. arc_spPurgeSecurityAlerts '9/1/2005 23:59:59'

If you want to purge Informational Alerts generated any time on or before September 
1, 2005 from the ins_alerts_info table, then execute the following requiredrequiredrequiredrequired stored 
procedure:

appdetective.dbo. arc_spPurgeInfoAlerts '9/1/2005 23:59:59'

The date/time parameters are requiredrequiredrequiredrequired.
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Appendix L: Open Ports (on 
Computers Running Microsoft 
SQL Server) Required to Run 
Discoveries, Pen Tests, and 
Audits
In order to run a Discovery, Pen Test, or Audit against a Microsoft SQL Server 
database, certain ports on the machine running Microsoft SQL Server mustmustmustmust be open. 
This appendix consists of the following topics:

•  Open Ports (on Computers Running Microsoft SQL Server) Required to Run a 
Discovery

•  Open Ports (on Computers Running Microsoft SQL Server) Required to Run a 
Pen Test

•  Open Ports (on Computers Running Microsoft SQL Server) Required to Run an 
Audit.

Open Ports (on
Computers

Running Microsoft
SQL Server)

Required to Run a
Discovery

To Discover Microsoft SQL Server on the default port:

•  TCP: TCP: TCP: TCP: 1433 Microsoft SQL Server default port.

OR:

•  UDP:UDP:UDP:UDP: 1434 Microsoft SQL Monitor.

Note:Note:Note:Note: Microsoft SQL Server 2005/2008 requires the Microsoft SQL Server 
Browser service to run on the target server.

To Discover Microsoft SQL Server on a non-default port:

•  TCP:TCP:TCP:TCP: Any port number for the default instance or named instances.

OR:

•  UDP:UDP:UDP:UDP: 1434 Microsoft SQL Monitor.

Note:Note:Note:Note: Microsoft SQL Server 2005/2008 requires the Microsoft SQL Server 
Browser service to run on the target server.
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Open Ports (on
Computers

Running Microsoft
SQL Server)

Required to Run a
Pen Test

TCP: TCP: TCP: TCP: 1433 Microsoft SQL Server default port or any port number for the default 
instance or named instances.

Open Ports (on
Computers

Running Microsoft
SQL Server)

Required to Run an
Audit

To connect to Microsoft SQL Server via named pipes:

•  TCP: TCP: TCP: TCP: 135 Service Control Manager, 445 Microsoft Directory Service, DCOM 
dynamic ports (1024-65535).

Note:Note:Note:Note: DCOM dynamically allocates TCP and UDP ports in the range 1024-65535.

To connect to SQL Server via TCP/IP:

•  TCP:TCP:TCP:TCP: 135 Service Control Manager, 445 Microsoft Directory Service, 1433 SQL 
Server default port or any port number for the default instance or named 
instances, DCOM dynamic ports (1024-65535).

Note:Note:Note:Note: DCOM dynamically allocates TCP and UDP ports in the range 1024-65535.
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